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Get Started 

The Get Started Dialog 

If the GETSTARTED system variable is ON, the Welcome dialog box displays when you launch 
BricsCAD. Here you can choose the User Profile for the current session. You can choose between a 
number of Presets or user defined profiles. 

The most recently used profile is indicated by a blue frame. 

  

 

  

NOTE The very first time BricsCAD is launched the Get Started option is missing on the 

Welcome dialog. The Profile Presets page is shown instead. After selecting a profile 
preset the Get Started dialog displays with the new profile selected in the Set current 
profile list. 

 

bricscad-sysvar.chm::/00_07_Settings_Manager.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/02_Defining_your_preferences/02_10_User_Profile_Manager.htm
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To start a BricsCAD session 

1. Accept the currently selected profile or select a profile in the Set current profile list. 

2. Do one of the following: 

• Click the New Drawing button to create a new drawing using the default template of the 
current profile. 

• Click the Start from template button to create a new drawing using a template of your 
choice. 

• Click the Open other drawing button to open an existing drawing. 

• Click a drawing in the Open a recent file list. 
The number of files in this list is controlled through the Recent file list (NFILELIST) system 
variable. Up to 20 files can be listed here. 

To select the startup user profile 

Do one of the following: 

• Click a profile in the Set current profile list. 
 

 
 
By default the five most recently used profiles display. If necessary, drag the right hand 
edge of the Welcome dialog box to see more profiles. 

• Click Select other profile..., then select a profile in the All profiles dialog and click the OK 
button. 
 

 
 
The selected profile is added to the Set current profile list. 
 
  

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/20_Managing_Drawings/20_01_Creating_a_new_drawing.htm%23CreateUsingDefaultTemplate
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/20_Managing_Drawings/20_01_Creating_a_new_drawing.htm%23CreateUsingTemplate
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/20_Managing_Drawings/20_01_Creating_a_new_drawing.htm%23CreateUsingTemplate
bricscad-sysvar.chm::/00_07_Settings_Manager.htm
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Using a Profile Preset 

BricsCAD comes with a set of built-in hard coded profiles. You can use these Preset Profiles as 
templates to create your own set of user profiles. Each of the profile presets has the name of the 
Workspace they use.  

1. Click PROFILE PRESETS on the Welcome dialog box. 

 

 

2. Choose either Imperial or Metric in the Units list button to set the MEASUREMENT system 

variable in the profile. 

3. Select a Profile Preset, e.g. 2D Drafting. 
A dialog box displays. 

 

 

4. Type a new name in the Profile name field to create a new profile using the hard-coded 

settings of the selected Profile Preset. 
 
If you type the name of an existing profile a dialog box prompts you to confirm to 
overwrite the existing profile using the hard-coded settings of the selected Profile Preset. 
 
 

 
  

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/02_Defining_your_preferences/04_13_Workspaces.htm


  User Guide 

 24 

The Get Started dialog displays with the new profile selected in the Set current profile list. 

To Start a BricsCAD Session 

1. Accept the currently selected profile or select a profile in the Set current profile list. 

2. Do one of the following: 

• Click the New Drawing button to create a new drawing using the default template of the 
current profile. 

• Click the Start from template button to create a new drawing using a template of your 
choice. 

• Click the Open other drawing button to open an existing drawing. 

• Click a drawing in the Open a recent file list. 
The number of files in this list is controlled through the Recent file list (NFILELIST) system 
variable. Up to 20 files can be listed here. 

To Set the Startup User Profile 

Do one of the following: 

• Click a profile in the Set current profile list. 
 

 
 
By default the five most recently used profiles display. If necessary, drag the right hand 
edge of the Welcome dialog box to see more profiles. 

• Click Select other profile..., then select a profile in the All profiles dialog and click the OK 
button. 
 

 
 
The selected profile is added to the Set current profile list. 
 
  

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/20_Managing_Drawings/20_01_Creating_a_new_drawing.htm%23CreateUsingDefaultTemplate
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/20_Managing_Drawings/20_01_Creating_a_new_drawing.htm%23CreateUsingTemplate
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/20_Managing_Drawings/20_01_Creating_a_new_drawing.htm%23CreateUsingTemplate
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/20_Managing_Drawings/20_08_Opening_and_saving.htm
bricscad-sysvar.chm::/00_07_Settings_Manager.htm
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Using a Profile Preset 

BricsCAD comes with a set of built-in hard coded profiles. You can use these Preset Profiles as 
templates to create your own set of user profiles. Each of the profile presets has the name of the 
Workspace they use.  

1. Click PROFILE PRESETS on the Welcome dialog box. 

 

 

2. Choose either Imperial or Metric in the Units list button to set the MEASUREMENT system 

variable in the profile. 

3. Select a Profile Preset, e.g. 2D Drafting. 
A dialog box displays. 

 

 

4. Type a new name in the Profile name field to create a new profile using the hard-coded 

settings of the selected Profile Preset. 
 
If you type the name of an existing profile a dialog box prompts you to confirm to 
overwrite the existing profile using the hard-coded settings of the selected Profile Preset. 
 
 

 
  

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/02_Defining_your_preferences/04_13_Workspaces.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/03_Drawing_Accurately/03_01_Unit_Settings.htm%23MEASUREMENT
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The Get Started dialog displays with the new profile selected in the Set current profile list. 
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User Interface 

Keyboard Shortcuts 

The following keyboard shortcuts are available: 

  

Keyboard Description 

F1 Opens the BricsCAD Help. 

F2 Toggles the display of the Prompt History window. 

F3 Toggles Entity Snaps. 

F4 Toggles the tablet mode. 

F5 Sets the isoplane (see Using Isometric snap). 

F6 Toggles the Dynamic UCS feature. 

F7 Toggles the display of the grid. 

F8 Toggles the Ortho setting. Disables Polar Tracking, if on. 

F9 Toggles the Snap setting. 

F10 Toggles the Polar Tracking setting. Disables Ortho, if on. 

F11 Toggles the Entity Snap Tracking setting. 

F12 Toggles the Quad display. 

Alt+F8 Launches the VBARUN command. 

Alt+F11 Launches the VBAIDE command. 

Ctrl+1* Toggles the properties bar. 

Ctrl+2* Opens the Drawing Explorer. 

Ctrl+9* Toggles the display of the command bar. 

Ctrl+0* Toggles the display of user interface entities as specified by the 
SCREENCLEANOPTIONS system variable. 

Executes the CLEANSCREENON and CLEANSCREENOFF commands. 

Ctrl+A Selects all entities. 

Ctrl+B Toggles the Snap setting. 

Ctrl+C Copies the selection to the clipboard (COPYCLIP command). 

Ctrl+Shift+C Copies the selection along with a base point (COPYBASE command). 

Ctrl+E Sets the isoplane (see Using Isometric snap). 

Ctrl+F Launches the FIND command. 

Ctrl+G Toggles the display of the grid. 

Ctrl+H Toggles the value of the PICKSTYLE system variable, which controls the 

selection of groups and associative hatches. 

Ctrl+I Sets the readout of the coordinate field in the status bar. 

Ctrl+J Repeats the previously issued command. 

Ctrl+K Attach a hyperlink to an object or modify an existing hyperlink (HYPERLINK 
command). 

Ctrl+L Toggles the Ortho setting. 

Ctrl+M Repeats the previously issued command. 

Ctrl+N Creates a new drawing (NEW command). 

Ctrl+O Opens an existing drawing (OPEN command). 

Ctrl+P Prints the current drawing (PRINT command). 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/03_Drawing_Accurately/03_03_Entity_Snaps.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/30_Input_Devices/Digitizing_Tablet.htm%23TabletMode
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/03_Drawing_Accurately/03_02_Snap_and_Grid.htm%23Using_Isometric_Snap
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/03_Drawing_Accurately/03_07_User_Coordinate_Systems.htm%23DynUCS
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/03_Drawing_Accurately/03_02_Snap_and_Grid.htm%23Using_Isometric_Snap
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/03_Drawing_Accurately/03_05_Polar_Tracking.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/03_Drawing_Accurately/03_02_Snap_and_Grid.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/03_Drawing_Accurately/03_05_Polar_Tracking.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/03_Drawing_Accurately/03_12_Quad.htm
bricscad-cmdref.chm::/V/VbaRun/VbaRun.htm
bricscad-cmdref.chm::/V/vbaide.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/00_06_Properties_Bar.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/20_Managing_Drawings/00_02_Drawing_Explorer.htm
bricscad-sysvar.chm::/00_07_Settings_Manager.htm
bricscad-cmdref.chm::/C/CleanScreenOn.htm
bricscad-cmdref.chm::/C/CleanScreenOff.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/03_Drawing_Accurately/03_02_Snap_and_Grid.htm
bricscad-cmdref.chm::/C/CopyClip.htm
bricscad-cmdref.chm::/C/CopyBase.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/03_Drawing_Accurately/03_02_Snap_and_Grid.htm%23Using_Isometric_Snap
bricscad-cmdref.chm::/F/Find.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/03_Drawing_Accurately/03_02_Snap_and_Grid.htm%23Using_Isometric_Snap
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/01_00_The_Bricscad_Application_Window.htm%23Working_with_the_status_bar
bricscad-cmdref.chm::/H/Hyperlink/Hyperlink.htm
bricscad-cmdref.chm::/N/New.htm
bricscad-cmdref.chm::/O/Open.htm
bricscad-cmdref.chm::/P/Properties.htm
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Ctrl+Shift+P Toggles the properties bar. 

Ctrl+Q Quits the application; prompts to save changes (QUIT command). 

Ctrl+R Iterates through viewports. 

Ctrl+S Saves the current drawing (QSAVE command). 

Ctrl+T Turns the tablet on/off. 

Ctrl+V Pastes the contents of the Clipboard into the drawing (PASTECLIP command). 

Ctrl+Alt+V Pastes the contents of the Clipboard in a specified format (PASTESPEC 
command). 

Ctrl+Shift+V Pastes  the contents of the Clipboard as a block (PASTEBLOCK command). 

Ctrl+X Cuts the selection and puts it on the clipboard (CUTCLIP command). 

Ctrl+Y Redoes the last action undone (REDO command). 

Ctrl+Z Undoes the last action (UNDO command). 

Ctrl+[ Cancels the running command. 

Ctrl+\ Cancels the running command. 

Shift+F2 Toggles the display of the command bar. 

Shift+F3 Turns the Status Bar on/off (STATBAR command). 

Shift+F4 Turns the Scroll Bars on/off (SCROLLBAR command). 

Shift+F8 Launches the Visual Basic Project Manager (VBAMAN command). 

Shift+F11 Launches the VBA COM Add-In Manager (ADDINMAN command). 

PgUp Moves the view up. 

PgDn Moves the view down. 

Shift+Left Arrow Moves the view to the left. 

Shift+Right 
Arrow 

Moves the view to the right. 

Shift+Up Arrow Moves the view up. 

Shift+Down 
Arrow 

Moves the view down. 

* Do not use the numeric keypad.  
On AZERTY-keyboards:  do not press the Shift-key when hitting the number key. 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/00_06_Properties_Bar.htm
bricscad-cmdref.chm::/Q/Quit.htm
bricscad-cmdref.chm::/Q/QSave.htm
bricscad-cmdref.chm::/P/PasteClip.htm
bricscad-cmdref.chm::/P/PasteSpec.htm
bricscad-cmdref.chm::/P/PasteBlock.htm
bricscad-cmdref.chm::/C/CutClip.htm
bricscad-cmdref.chm::/R/Redo.htm
bricscad-cmdref.chm::/U/Undo.htm
bricscad-cmdref.chm::/S/StatBar.htm
bricscad-cmdref.chm::/S/Scrollbar.htm
bricscad-cmdref.chm::/V/vbaman.htm
bricscad-cmdref.chm::/A/AddInMan.htm
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The BricsCAD Application Window 

Overview 

Customizing the Command Prompt  

  

The layout of the BricsCAD application window can be fully customized. 

You can: 

• open / close the command window 

• display / hide the ribbon  

• control the display and position of document tabs 

• open / close the status bar 

• customize the status bar 

• modify drawing settings in the status bar 

• display / hide scroll bars 

• display / hide panels 

• hide / show a selection of user interface elements 

 

 

https://blog.bricsys.com/customizing-command-prompt/
file:///C:/Users/Louis/AppData/Local/Temp/298462/01_User_Interface/01_00_The_Bricscad_Application_Window.htm%23Open___close_command_window
file:///C:/Users/Louis/AppData/Local/Temp/298462/01_User_Interface/01_00_The_Bricscad_Application_Window.htm%23DisplayRibbon
file:///C:/Users/Louis/AppData/Local/Temp/298462/01_User_Interface/01_00_The_Bricscad_Application_Window.htm%23HIdeRibbon
file:///C:/Users/Louis/AppData/Local/Temp/298462/01_User_Interface/01_00_The_Bricscad_Application_Window.htm%23DocumentTabs
file:///C:/Users/Louis/AppData/Local/Temp/298462/01_User_Interface/01_00_The_Bricscad_Application_Window.htm%23Open___close_status_bar
file:///C:/Users/Louis/AppData/Local/Temp/298462/01_User_Interface/01_00_The_Bricscad_Application_Window.htm%23To_customize_the_status_bar
file:///C:/Users/Louis/AppData/Local/Temp/298462/01_User_Interface/01_00_The_Bricscad_Application_Window.htm%23Working_with_the_status_bar
file:///C:/Users/Louis/AppData/Local/Temp/298462/01_User_Interface/01_00_The_Bricscad_Application_Window.htm%23Display_or_hide_scroll_bars
file:///C:/Users/Louis/AppData/Local/Temp/298462/01_User_Interface/01_05_DockablePanels.htm
file:///C:/Users/Louis/AppData/Local/Temp/298462/01_User_Interface/01_00_The_Bricscad_Application_Window.htm%23HideShowUiElements
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Components of the BricsCAD application window: 

1. Menu Bar  
2. Toolbar (docked)  
3. Document tabs  
4. Drawing windows  
5. Drawing viewports  

6. Window tabs  
7. UCS icon  
8. Look From widget  
9. Prompt Menu  
10. Toolbar (floating)  
11. Panel tabs  

12. Properties panel  

13. Command bar  
14. Suggestion list  
15. Status Bar  
16. Ribbon  

To Display the Ribbon 

• Execute the Ribbon command.  

• Right click an empty space in the Layout or Drawing tab area, then choose Ribbon in 
the context menu. 
 

 

To Hide the Ribbon 

• Execute the RibbonClose command. 

• Right click an empty space in the Layout or Drawing tab area, then choose Ribbon in the 
context menu. 

bricscad-cmdref.chm::/R/Ribbon.htm
bricscad-cmdref.chm::/R/RibbonClose.htm
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Document Tabs 

Document tabs allow to: 

• Easily switch between all open drawings. 

• Drag and drop the tabs to change their order. 

• Click the X at the right-hand side of tab to close it. 

• Right click on a document tab to display a context menu:  
 

 
  

Item Description 

Close Closes the current drawing (CLOSE command). 

Close Left Tabs Closes the drawings at the left of the current tab. 

Close All But 
This 

Closes all drawings, but the current drawing. 

Close All Closes all drawings (WCLOSEALL command). 

Open Displays the Open Drawing dialog (OPEN command). 

New Displays the Create New Drawing dialog NEW command. 

Save Saves the current drawing (SAVE command). 

Save All Saves all open drawings (SAVEALL command). 

Save As Launches the SAVEAS command. 

Position 

Lets you choose the position of the document tabs. 

 

bricscad-cmdref.chm::/C/Close.htm
bricscad-cmdref.chm::/W/WCloseAll.htm
bricscad-cmdref.chm::/O/Open.htm
bricscad-cmdref.chm::/N/New.htm
bricscad-cmdref.chm::/S/Save.htm
bricscad-cmdref.chm::/S/SaveAll.htm
bricscad-cmdref.chm::/S/SaveAs.htm
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Duplicate Tab 
Saves a copy of the current drawing in a new tab, while keeping the original 
drawing open. Displays the Save As dialog. 

Restore Last 

Session 
Opens the drawings that were open in the previous BricsCAD session. 

Open Folder Opens the folder of the current drawing. 

Cascade Cascades the windows of the current drawings (WCASCADE command). 

Tile 
Horizontally 

Tiles the windows of the current drawings horizontally (WHTILE command). 

Tile Vertically Tiles the windows of the current drawings vertically (WVTILE command). 

  

The display and location of document tabs is controlled through user preferences. 

In the Settings dialog go to Program Options / Display / Document tabs. 

  

 

  

ShowDocTabs: controls the display of document tabs. 

DocTabPosition: controls the location of the document tabs: top, bottom, left or right. 

Open/Close the Command Bar 

Do one of the following: 

• Choose Command Bar in  the View Menu.  

• Move the cursor to a docked toolbar, then right click and choose Command Bar in the 
context menu.  

• Double click the Status field at the left hand side of the Status Bar.  

The Command Window closes if it was open and vice versa. 

  

 

1. Close button  
2. Press and hold the left mouse button to move the command bar  

3. Command History List  field: the content of the history list field can be copied to the 
command edit field.  

4. Command Edit field 
If the Enable flag of the AUTOCOMPLETEMODE system variable is set, command entries are 
completed automatically as you type.  
All commands and/or system variables and/or user preferences that contain the current 
character string display in the Suggestion list. 

 
 

Do one of the following:  

• Press Enter if the currently completed command displays.  

• Choose a command in the Suggestion list.  

bricscad-cmdref.chm::/W/WCascade.htm
bricscad-cmdref.chm::/W/WhTile.htm
bricscad-cmdref.chm::/W/WvTile.htm
bricscad-sysvar.chm::/00_07_Settings_Manager.htm
bricscad-sysvar.chm::/00_07_Settings_Manager.htm


BricsCAD V18  Help 

 

 33 

 

  

Autocomplete options are: 

  

 

5. Command history scroll buttons  

  

NOTES • You can modify the height of the docked command window by dragging its top 
edge, when docked Lower or bottom edge, when docked Upper.  

• The size of a floating command bar can be adjusted by dragging one of its edges. 

• When the command bar is closed, command options and keyboard entries display 
in the status bar. 

• Use the arrow-up and arrow-down keys of the keyboard to browse the command 
history. 

 

To Set the Command Line Properties 

1. Open the Settings window.  
2. Go to Program Options / User Preferences / Command Line. 

 

 

Open/Close the Status bar 

Do one of the following: 

• Choose Status Bar  in the View Menu.  

• Press the Shift + F3 keyboard shortcut.  

bricscad-sysvar.chm::/00_07_Settings_Manager.htm


  User Guide 

 34 

The Status Bar closes if it was open and vice versa. 

Working with the Status Bar 

 

  

1. Status field:  

• displays the status of the software.  

• when the cursor is in a menu or on a toolbar: gives a brief description of the tool or menu 
item under the cursor.  

• when the command window is closed: displays the command prompts, tool options and 
keyboard entry.  

• double click the status field to open/close the Command Bar.  

2. Field List button: Click the arrow button ( ) to display a list of available Status Bar fields. Click 
an item in the list to toggle the display of the corresponding field in the Status Bar.  

  

 

   

Cursor coordinate values: displays the coordinates of the current cursor position (depending on 
the setting of the COORDS variable).  

• Click to cycle the Coordinate setting. The sequence is Geopgraphic, Relative, Absolute, Off. 

bricscad-sysvar.chm::/00_07_Settings_Manager.htm
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• Right click, then choose an option in the context menu. 
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Current Layer: displays the name of the current layer. 

• Click to open the Layer Explorer. 

• Right click to select the current layer in the context menu. 

• Right click and choose Properties in the context menu to open the Drawing Explorer - Layers. 
Current Color: displays the current color. 

• Click to open the Select Color dialog window. 

• Right click to select one of the basic colors. 
 

 

• Right click and choose Select Color... to select a color. 
Current Linetype: displays the name of the current linetype. 

• Click to open the Linetype Explorer. 

• Right click to select the current linetype. 

• Right click and choose Properties in the context menu to open the Drawing Explorer - 
Linetypes. 

Current Text Style: displays the name of the current text style. 

• Click to open the Styles Explorer. 

• Right click to select the current text style. 

• Right click and choose Properties in the context menu to open the Drawing Explorer - Text 
Styles. 

Current Dimension Style: displays the name of the current dimension style 

• Click to open the Dimensions Settings dialog window. 

• Right click to select the current dimension style. 

• Right click and choose Properties in the context menu to open the Drawing Explorer - 
Dimension Styles. 

Current Work Space: Indicates the current workspace. 

• Click to set the value of the WSCURRENT system variable in the command bar. 

• Right click, then select the current workspace. 
 

 

• Choose Customize in the context menu to open the Customize - Workspaces dialog box. 

bricscad-cmdref.chm::/L/Layer/Layer.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/10_Drawing_Entities/00_Entity_Creation_Settings/10_00_02_Entity_Color.htm
bricscad-cmdref.chm::/L/Linetype/Linetype.htm
bricscad-cmdref.chm::/L/Linetype/Linetype.htm
bricscad-cmdref.chm::/S/Style/Style.htm
bricscad-cmdref.chm::/S/Style/Style.htm
bricscad-cmdref.chm::/Dimension/DimStyle/DimStyle.htm
bricscad-cmdref.chm::/Dimension/DimStyle/DimStyle.htm
bricscad-sysvar.chm::/00_07_Settings_Manager.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/02_Defining_your_preferences/04_13_Workspaces.htm%23ManageWorkspaces
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Snap: Toggles the SNAPMODE system variable. 

• Click to toggle Snap On ( ) / Off ( ). 

• Right click, then choose Settings to edit the Snap and Grid settings. 
 

 
Grid: Toggles the GRIDMODE system variable. 

• Click to toggle the display of the Grid On ( ) / Off ( ) in the current viewport. 

• Right click, then choose Settings to edit the Snap and Grid settings. 
 

 
Ortho: Toggles the ORTHOMODE system variable; turning Orthogonal mode on automatically 
disables Polar Tracking. 

• Click to toggle Orthogonal mode On ( ) /Off ( ).  

• Right click, then choose Settings to edit the Orthomode setting. 
 

 
Polar: Toggles the Polar Tracking option of the AUTOSNAP system variable. 

• Click to toggle Polar Tracking On ( ) / Off ( ). 
Turning Polar Tracking  on automatically disables Orthogonal mode. 

• Right click, then choose Settings  to edit the Polar Tracking settings. 
 

 
Esnap: Toggles the Turn of all snaps option of the OSMODE system variable. 

• Click to toggle Entity Snaps On ( ) / Off ( ). 

• Right click, then choose Settings  to edit the Entity Snaps settings. 
 

 
Strack: Toggles the Entity Snap Tracking option of the AUTOSNAP system variable. 

• Click to toggle Snap Tracking On ( ) / Off ( ). 

• Right click, then choose Settings  to edit the Snap Tracking settings. 
 

 

bricscad-sysvar.chm::/00_07_Settings_Manager.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/03_Drawing_Accurately/03_02_Snap_and_Grid.htm%23Overview
bricscad-sysvar.chm::/00_07_Settings_Manager.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/03_Drawing_Accurately/03_02_Snap_and_Grid.htm%23Overview
bricscad-sysvar.chm::/00_07_Settings_Manager.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/03_Drawing_Accurately/03_04_Ortho_Mode.htm
bricscad-sysvar.chm::/00_07_Settings_Manager.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/03_Drawing_Accurately/03_05_Polar_Tracking.htm
bricscad-sysvar.chm::/00_07_Settings_Manager.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/03_Drawing_Accurately/03_03_Entity_Snaps.htm
bricscad-sysvar.chm::/00_07_Settings_Manager.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/03_Drawing_Accurately/03_06_Entity_Snap_Tracking.htm
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Lineweight (LWT): Toggles the LWDISPLAY system variable. 

• Click to toggle the display of Line Weights On ( ) or Off ( ). 

• Right click, then choose Settings  to edit the Lineweights settings. 
 

 
Paper/Model: Allows to choose between model space and paper space. 

• When working in Model Space, the field reads: Tile  (= Model space with tiled viewports). 

 
Click to switch to the most recently opened paper space layout. 

Right click to select a paper space layout: 
 

 

• When working in a layout, the field reads: 
M:Layout : Model space with floating viewports 
or 

P:Layout : Paper space  
 
Click to toggle between paper space and model space with floating viewports. 
Right click, then choose: 

• Paper Space: Switch to paper space 

• Model Space: Switch to model space with floating viewports 

• Model: Switch to model space with tiled viewports 

• Layout: Switch to the selected paper space layout. 
 

 
Annotation Scale: Displays the value of the CANNOSCALE  (= current annotation scale) system 
variable. Right click:  

• Select an annotation scale in the list. 

• Choose Custom to launch the  SCALELISTEDIT command. 

• Check the Hide Xef scales option to list annotation scales of the current drawing only. 

Autoscale: Click to toggle the ANNOAUTOSCALE system variable.  

   
Tablet: Initializes the use of a drawing tablet.  

bricscad-sysvar.chm::/00_07_Settings_Manager.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/10_Drawing_Entities/00_Entity_Creation_Settings/10_00_03_Lineweight_Display.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/04_Viewing_your_drawing/04_08_Workspaces.htm
bricscad-sysvar.chm::/00_07_Settings_Manager.htm
bricscad-cmdref.chm::/S/ScaleListEdit/ScaleListEdit.htm
bricscad-sysvar.chm::/00_07_Settings_Manager.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/30_Input_Devices/Digitizing_Tablet.htm
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Dynamic UCS (DUCS): Click to toggle the UCSDETECT system variable On ( ) or Off ( ).  
   
Dynamic Input (DYN): Toggles the Switch all off temporarily option of the DYNMODE sytem 
variable.  

• Click to toggle the display of Dynamic Dimensions On ( ) or Off ( ). 

• Right click, then choose Settings  to edit the Dynamic Dimensions settings. 
 

 
Quad: Toggles the Switch off option of the QUADDISPLAY system variable.  

• Click to toggle the display of the Quad On ( ) or Off ( ). 

• Right click, then choose an option in the context menu. 

• Right click, then choose Settings to edit the Quad settings. 
 

 
Rollover tips (RT): Toggles the ROLLOVERTIPS system variable.  

• Click to toggle the display of rollover tips. 

• Right click to select the display options for rollover tips: On hovering entities or No rollover 
tips. 
 

 
Tips: Toggles the TIPS system variable. If TIPS = ON, an assistant widget reveals options 
available using the Ctrl-key.  

  

 

Tips when creating polysolids. 

• Click to toggle the display of the TIPS widget On/off. 

• Right click to display a context menu: 
 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/03_Drawing_Accurately/03_07_User_Coordinate_Systems.htm%23DynUCS
bricscad-sysvar.chm::/00_07_Settings_Manager.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/03_Drawing_Accurately/03_11_Dynamic_Dimensions.htm
bricscad-sysvar.chm::/00_07_Settings_Manager.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/03_Drawing_Accurately/03_12_Quad.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/03_Drawing_Accurately/03_12_Quad.htm%23RolloverTips
bricscad-sysvar.chm::/00_07_Settings_Manager.htm
bricscad-cmdref.chm::/P/PolySolid.htm
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• Click On or Off  to set the display of the the TIPS widget. 

• Click Configure to display the Tips Configuration dialog. 
Select which tips show when TIPS = ON. 
 

 
Lock User Interface: Allows to lock the location and size of toolbars and dockable panels. Press 
Ctrl to override.  
Click the LOCKUI field to toggle the lock. Press Ctrl to override.  
Which user interface elements are affected is controlled through the LOCKUI system variable.  

 
   
   
GIS Coordinate Sytem: Displays the name of the current GIS coordinate system.  

Display/Hide Scroll Bars 

To toggle scroll bars on / off: 

bricscad-sysvar.chm::/00_07_Settings_Manager.htm
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1. (option) Hold down the Shift key, then press the F4 function key.  

2. (option) Choose Scroll Bars in the View menu. 
 

 
3. (option) Type scrollbar in the command bar, then do one of the following:  

• type off in the command bar or choose Off in the context menu.  

• type on in the command bar or choose On in the context menu.  

• type T in the command bar or choose Toggle in the context menu.  

 
  

  

NOTE Use the -TOOLPANEL command to show, hide or toggle the display of the various tool 
panels. 

  

bricscad-cmdref.chm::/T/-ToolPanel.htm
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Hide / show a selection of user interface elements 

The CLEANSCREENON and CLEANSCREENOFF commands allow to hide or show a selection of user 
interface elements simultaneously. 

Which user interface elements are affected by these commands is defined by the 
CLEANSCREENOPTIONS system variable. 

The Ctrl+0 keyboard shortcut toggles the display of user interface elements. On AZERTY-
keyboards: do not use the numeric keypad; do not press the Shift-key when hitting the number 
key. 

bricscad-cmdref.chm::/C/CleanScreenOn.htm
bricscad-cmdref.chm::/C/CleanScreenOff.htm
bricscad-sysvar.chm::/00_07_Settings_Manager.htm
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Toolbars 

Main Toolbars 

The following toolbars are available in BricsCAD. 

Some of the tools are available in BricsCAD Pro and/or BricsCAD Platinum only. Please see the 
Command Reference guide for more information. 

  

2D 

Constraints 

 

3D 

Constraints 

 

3D Entity 

Snaps 

 

3D Solid 

Editing 

 

3D Solids 

 

Arcs 

 

Assembly 

 

BIM  

 

Bricsys 

24/7 

 

Circles 

 

bricscad-cmdref.chm::/C/Commands.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/03_Drawing_Accurately/01_Parametric_Constraints/03_01_00_Overview.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/03_Drawing_Accurately/01_Parametric_Constraints/03_01_00_Overview.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/10_Drawing_Entities/03_Drawing_Solids/10_03_05_3D_Constraints.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/10_Drawing_Entities/03_Drawing_Solids/10_03_05_3D_Constraints.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/10_Drawing_Entities/01_Drawing_2D_Entities/10_01_08_Arcs.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/10_Drawing_Entities/03_Drawing_Solids/Mechanical/Commands_and_Toolbars.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/10_Drawing_Entities/03_Drawing_Solids/BIM/BIM_Concept.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/10_Drawing_Entities/01_Drawing_2D_Entities/10_01_07_Circles.htm
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Compare 

 

Design 
Intent  

 

Dimensions 

 

Direct 
Modeling 

 

Draw 

 

Draw Order 

 

Ellipses 

 

Elliptical 
Arcs 

 

Entity Data 

 

Entity 
Properties 

 

Entity 
Snaps  

 

Images 

 

Insert 

 

bricscad-cmdref.chm::/D/DwgCompare.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/10_Drawing_Entities/03_Drawing_Solids/10_03_04_Design_Intent.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/10_Drawing_Entities/03_Drawing_Solids/10_03_04_Design_Intent.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/10_Drawing_Entities/06_Working_with_Dimensions/10_06_04_Dimensioning_tools_overview.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/10_Drawing_Entities/03_Drawing_Solids/10_03_03_Direct_modeling_operations.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/10_Drawing_Entities/03_Drawing_Solids/10_03_03_Direct_modeling_operations.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/10_Drawing_Entities/01_Drawing_2D_Entities/10_01_00_Drawing_2D_Overview.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/11_Modifying_Entities/02_Rearranging_Entities/11_02_03_Adjusting_Draworder.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/10_Drawing_Entities/01_Drawing_2D_Entities/10_01_09_Ellipses.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/10_Drawing_Entities/01_Drawing_2D_Entities/10_01_10_Elliptical_Arcs.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/10_Drawing_Entities/01_Drawing_2D_Entities/10_01_10_Elliptical_Arcs.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/10_Drawing_Entities/00_Entity_Creation_Settings/10_00_00_Entity_Creation_Settings_Overview.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/10_Drawing_Entities/00_Entity_Creation_Settings/10_00_00_Entity_Creation_Settings_Overview.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/03_Drawing_Accurately/03_03_Entity_Snaps.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/03_Drawing_Accurately/03_03_Entity_Snaps.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/13_Images/00_05_Managing_Images.htm
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Inquiry  

 

Look From Replaced by the Look From control. 

Layout  

 

Mechanical Renamed to Assembly 

Meshes 

 

Modify 

 

Parameters 

 

Ref Edit  

 

Rendering 

 

Sections 

 

Selection 

Modes 

 

Settings 

 

Sheet Metal 

 

Standard 

 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/03_Drawing_Accurately/03_10_Measuring.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/04_Viewing_your_drawing/04_05_View_Rotation.htm%23LookFrom
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/04_Viewing_your_drawing/04_11_Layouts.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/11_Modifying_Entities/00_Overview/11_00_01_Entity_Modification_Commands.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/12_Blocks_Attributes_External_References/12_02_Editing_blocks_and_external_references.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/04_Viewing_your_drawing/04_20_Rendering_General.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/11_Modifying_Entities/01_Selecting_Entities/11_01_00_Selection_Settings.htm%23SELECTIONMODES
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/11_Modifying_Entities/01_Selecting_Entities/11_01_00_Selection_Settings.htm%23SELECTIONMODES
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/10_Drawing_Entities/00_Entity_Creation_Settings/10_00_00_Entity_Creation_Settings_Overview.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/10_Drawing_Entities/03_Drawing_Solids/SheetMetal/Definitions.htm
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Tools 

 

View 

 

Workspaces 

 

 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/04_Viewing_your_drawing/04_00_Overview.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/02_Defining_your_preferences/04_13_Workspaces.htm
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Toolbar Flyouts 

On some tool buttons a small black arrow at the bottom right corner of the icon indicates a flyout 
is available. A flyout holds a group of related tools. Press and hold the left mouse button to expand 
the flyout and choose one of the flyout tools. The tool that was last chosen remains visible in the 
collapsed toolbar. 

Each of the flyouts can be opened as a separate toolbar. Drag the button of a toolbar flyout into 
the drawing area to open it as a floating toolbar. 

  

Parent Flyout   

2D 
Constraints 

Dimensional 
Constraint  

 

  Geometrical 
Constraint  

 

Assembly Assembly 
Visualization 

 

Direct 
Modeling  

Deform 

 

Draw Lines 

 

  Polylines 

 

  Polygon 

  

 

  Boundaries 

 

Meshes 3D Faces 

  

 

  3D Surfaces 

 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/03_Drawing_Accurately/01_Parametric_Constraints/03_01_00_Overview.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/03_Drawing_Accurately/01_Parametric_Constraints/03_01_00_Overview.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/03_Drawing_Accurately/01_Parametric_Constraints/03_01_02_Using_Dimensional_Constraints.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/03_Drawing_Accurately/01_Parametric_Constraints/03_01_02_Using_Dimensional_Constraints.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/03_Drawing_Accurately/01_Parametric_Constraints/03_01_01_Using_Geometric_Constraints.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/03_Drawing_Accurately/01_Parametric_Constraints/03_01_01_Using_Geometric_Constraints.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/10_Drawing_Entities/03_Drawing_Solids/Mechanical/Commands_and_Toolbars.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/10_Drawing_Entities/03_Drawing_Solids/10_03_03_Direct_modeling_operations.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/10_Drawing_Entities/03_Drawing_Solids/10_03_03_Direct_modeling_operations.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/10_Drawing_Entities/03_Drawing_Solids/10_03_03_Direct_modeling_operations.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/10_Drawing_Entities/01_Drawing_2D_Entities/10_01_00_Drawing_2D_Overview.htm
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Modify Arrays 

 

Rendering Lights 

 

Settings 

Entity 
Properties 

Layers 

 

Sheet 
Metal 

Bend 

 

  Flange 

 

  Flange Split 

 

  Junction 

  

 

  Relief 

 

  Unfold 

 

Tools Attributes 

 

View Detail Section 

Types 

 

  Drawing 

Views 

 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/04_Viewing_your_drawing/04_20_Rendering_General.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/04_Viewing_your_drawing/04_22_Rendering_Lights.htm%23DefineLights
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/10_Drawing_Entities/00_Entity_Creation_Settings/10_00_00_Entity_Creation_Settings_Overview.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/10_Drawing_Entities/00_Entity_Creation_Settings/10_00_00_Entity_Creation_Settings_Overview.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/10_Drawing_Entities/00_Entity_Creation_Settings/10_00_00_Entity_Creation_Settings_Overview.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/04_Viewing_your_drawing/04_12_Layer_Utilities.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/10_Drawing_Entities/03_Drawing_Solids/SheetMetal/Definitions.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/10_Drawing_Entities/03_Drawing_Solids/SheetMetal/Definitions.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/12_Blocks_Attributes_External_References/02_Attributes/12_02_00_Working_with_attributes.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/04_Viewing_your_drawing/04_00_Overview.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/04_Viewing_your_drawing/GenerativeDrafting.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/04_Viewing_your_drawing/GenerativeDrafting.htm
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  Hide/Show 

Entities 

 

  Real-Time 
Motion 

 

  Redraw/Regen 

 

  Section Types 

 

  Zoom 

 

  

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/04_Viewing_your_drawing/04_14_Hide_Show_Entities.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/04_Viewing_your_drawing/04_14_Hide_Show_Entities.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/04_Viewing_your_drawing/04_05_View_Rotation.htm%23Real_time_sphere
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/04_Viewing_your_drawing/04_05_View_Rotation.htm%23Real_time_sphere
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/04_Viewing_your_drawing/04_02_Redrawing_and_Regenerating_a_Drawing.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/04_Viewing_your_drawing/04_04_Zooming.htm
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Opening a Toolbar 

1. In Windows: Hover over a toolbar or a blank portion of the toolbar area, then right click. 
In Linux: Hover over a blank portion of  the menu bar, status bar or toolbar area, then 
right click.  

A context menu displays. 

   

 
   

(1) Main CUI file. 
(2) Partial CUI file(s) 

1. In the context menu choose either the Main CUI file  (e.g. BRICSCAD) or one of the Partial 

CUI files (if any). 
A list of available toolbars in the selected CUI file displays. 
Toolbars that are already open are checked. 

If the list does not fit on the screen, click the arrow keys on the top and the bottom to 
scroll.  

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/02_Defining_your_preferences/02_02_Loading_a_CUI_file.htm%23To_load_a_main_CUI_file
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/02_Defining_your_preferences/02_02_Loading_a_CUI_file.htm%23To_load_a_partial_CUI_file
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2. Select the toolbar on the context menu. 
The toolbar opens.  

3. (option) Dock the toolbar by dragging the toolbar by its title bar to one of the edges of the 
BricsCAD application window.  

  

NOTES • If you select a toolbar that was already open, it will be closed. 

• To prevent a toolbar from docking, press and hold the Ctrl key while dragging 
the toolbar. 

• Drag a toolbar by the grip at its left edge (when docked horizontally) ( ) 
or top edge (when docked vertically) edge to undock. 

• To dock a toolbar vertically in Linux, the Position property of the toolbar must 
be set to Left or Right. 

• The LOCKUI system variable allows to lock the location and size of toolbars and 
dockable panels. Press and hold the Ctrl-key to override.  

Click the LOCKUI field in the Status Bar to toggle the locking of the user 

interface. 

 

To set the Icon Size 

You can choose between small (16 x 16) or large (32 x 32) icons on toolbars. 

1. Move the cursor over a toolbar, then right click.  
2. Choose Toolbar size then select either Small Icons or Large Icons.  

To Set the Position and Visible Property 

The Visible property determines whether a toolbar is visible when a cui-file is loaded. 

The Position property determines where a toolbar displays when a cui-file is loaded. 

1. In the Customize dialog click the Toolbars tab.  
2. If necessary, expand the BricsCAD menu group.  

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/01_00_The_Bricscad_Application_Window.htm%23LockUi
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/01_05_DockablePanels.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/01_00_The_Bricscad_Application_Window.htm%23Open___close_status_bar
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/02_Defining_your_preferences/02_01_Understanding_the_Customize_Dialog.htm%23Opening_the_Customize_dialog
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3. Select the toolbar.  

4. Choose Position in the Properties grid on the Customize dialog.  
5. Click the settings field and choose the desired position in the list. 

The options are: Floating, Top, Left, Bottom, Right.  
6. Choose Visible in the Properties grid on the Customize dialog.  
7. Click the settings field and choose either Show or Hide in the options list. 

To Tear off a Flyout Toolbar 

1. Press and hold the left mouse button to drag the visible icon of a flyout toolbar into the 
drawing area.  

2. Release the left mouse button to place the toolbar.  

Closing a Toolbar 

1. In Windows: Place the cursor on a toolbar, then right click. 
In Linux: Place the cursor on the menu bar, then right click. 

A context menu displays.  
2. Choose BRICSCAD on the context menu. 

Toolbars that are open are checked.  
3. In the toolbar list, uncheck the toolbar you want to close.  

 NOTE 
Floating toolbar can be closed by clicking the Close button ( ). 
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Properties Panel 

Overview 

  

In the Properties panel you can: 

• Set the current properties: color, layer, linetype, linetype scale and lineweight 

• Edit the properties of a single entity 

• Edit the shared properties of a selection set 

• Edit endpoints of lines and vertices of polylines graphically 

Open the Properties Panel 

Do one of the following: 

• Click the Properties tool button ( ) on the Standard toolbar. 
The pressed state of the tool button indicates that the Properties panel is currently 
open. 
Click the tool button again to close the Properties panel.  

• Right click when the cursor is on a toolbar. 
A context menu displays.  
The marked items in the context menu are currently open. 
Select Properties in the context menu. 
 

 
• Double click an entity, such as lines, polylines, circles, arcs, ... 

The Properties panel opens, showing the properties of the selected entity. 
Double clicking entities such as texts, blocks or polylines start an editing command (See 
the Mouse tab on the Customize dialog). 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/00_06_Properties_Bar.htm%23Set_current_properties
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/00_06_Properties_Bar.htm%23Edit_Properties
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/00_06_Properties_Bar.htm%23Edit_shared_properties
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/00_06_Properties_Bar.htm%23Edit%20endpoints%20and%20nodes%20graphically
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/02_Defining_your_preferences/02_01_Understanding_the_Customize_Dialog.htm%23Opening_the_Customize_dialog
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• Click the Properties tool button ( ) on the Standard toolbar.  

• Choose Properties  in the Modify  menu.  

• Type properties in the command window, then press Enter.  
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Properties - No selection 

The current entity properties,  

current Elevation, View 
properties and  
Annotation scale display 

Properties - Single entity 
selected 

The properties of the selected 
entity display 

Properties - Multiple entities 
selected 

The shared properties of the 
selected entities display 

  

NOTE The Properties panel is dockable panel. 
To dock the Properties panel, drag it by its title bar to either the left or right hand side of 
the BricsCAD application window or onto another dockable panel. 

  

NOTE Read-only fields display in grey. The content of a read-only field can be copied though. To 

bricscad-cmdref.chm::/E/Elev.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/01_05_DockablePanels.htm
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copy a read-only field, click the field, then press Ctrl C. 

  

Adjust the Size of the Properties Panel 

1. Move the cursor over one of the edges of the Properties (1). 
The cursor turns into a double-headed arrow.  

2. Press and hold the left mouse button to drag the edge of the Properties .  

 

3. Move the cursor over the boundary between the Setting Names and the Setting Fields 
columns (2). 
The cursor turns into a double-headed arrow.  

4. Press and hold the left mouse button to drag the boundary.  

  

NOTE When docked, only the left (or right) edge of the Properties is adjustable. 

 

Setting the current properties in the Properties panel 

1. (option) Click on Color, 
then click the down arrow button to select a color.  

2. (option) Click on Layer,  
then click the down arrow to select a layer.  

3. (option) Click on Linetype. 
then click on the down arrow to select a linetype.  

4. (option) Click on Linetype scale, 

then type the new value in the Linetype scale field.  
5. (option)  Click on Lineweight, 

then click on the down arrow to select a lineweight.  

Edit a Single Entity 

1. Select the entity. 
The entity's properties display in the Properties panel.. 
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Properties of a circle 

2. Click the property you want to modify. 
The settings field of the selected property is activated.  

3. Type a new value in the settings field of the selected property or choose a setting from the 
list box, then press the Enter key or select another property. 
The entity is updated.  

4. (option) repeat steps 2 and 3 to modify another property.  

5. Press the Escape key to stop.  

  

NOTES • Properties of which the value displays in grey cannot be modified. 

• Step 3: Properties (such as the General properties), which are chosen from a list 

are updated instantly. 
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Edit a Selection Set 

1. Select the entities. 
The shared properties display in the Properties Bar.  

2. Click the property you want to modify. 
The settings field of the selected property is activated.  

3. Type  a new value in settings field of the selected property or choose a setting from the list 
box, then press the Enter key or select another property. 

All selected entities are updated simultaneously.  
4. (option) Repeat steps 2 and 3 to modify another property.  
5. Press the Escape key  to stop.  

  

NOTES • *Varies* displays for shared properties which are defined differently. If you edit 

such property, all entities in the selection set will be equally defined for this 
property. 

• Step 3: Properties (such as the General properties), which are chosen from a list 
are updated instantly. 

 

Edit Endpoints and Nodes 

1. Select the line.  
2. On the Properties Bar, under Geometry, do one of the following:  

• Select the X-, Y- or Z- field, then enter a value.  

• Select either Start point or End point. 

 
An X indicates the point being edited.  

• Click the Pick Point button ( ).  

• Specify the point in the drawing.  
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3. Press the Escape key to stop.  

  

NOTE This procedure also applies to edit the insertion point of texts, images, blocks, Xrefs, ... 

To edit the vertices of a polyline 

1. Select the polyline.  
2. On the Properties Bar under Geometry, select Vertex.  
3. Click the Next/Previous arrow buttons to select a vertex. 

 

 
An X indicates the vertex being edited.  

4. Do one of the following:  

• Select the X- or Y- field, then enter a value.  

• Under Vertex select Position and click the Pick Point button ( ), then specify the point 
in the drawing.  

5. Press the Escape key to stop.  

The Quad Cursor Menu 

The Quad cursor menu, aka the Quad is an alternative to grip-editing of entities, offering a (much) 
richer set of editing operations while requiring fewer clicks, without cluttering the screen with loads 
of grip-glyphs.  

While the Quad was initially conceived for easy and fast editing of 3D solids, the Quad is extended 

to allow enhanced editing and creating of all entity types.  
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To Activate the Quad 

Activation of the Quad is controlled by the QUADDISPLAY system variable. 

To toggle the Quad On/Off, do one of the following: 

• Click the QUAD field in the Status bar.  

• Press the F12 function key.  

• Edit the QUADDISPLAY system variable in the Settings dialog.  

• Type quaddisplay in the command bar, then choose an option.  

Editing the Quad Settings 

1. Right click the QUAD field in the Status bar, then choose Settings in the context menu.  

The Settings dialog opens, showing the Quad settings: 

 

• Quad display: Determines when the Quad displays.  

• Negative: Switches the Quad off.  

• 1: When the cursor is over an entity. The entity under the cursor highlights.  

• 2: When entities are selected  

• 4: On right click when no entities are selected and there is no entity under 
the cursor.  

• 8: Suppress the quad when hovering over entities that are not in the current 
selection set; set Show Quad on right click ON to display the Quad.  

• Quad default command launch: Sets the action to launch the default Quad command.  

• 0: Click the button.  

• 1: Right click  

• Quad popup corner: Controls the popup position of the Quad relative to the cursor 

position: Upper, Center or Middle Right.  

• Quad width: Defines the number of commands in a row. Default = 6 commands.  

bricscad-sysvar.chm::/00_07_Settings_Manager.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/01_User_Interface/01_00_The_Bricscad_Application_Window.htm%23Quad
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/01_User_Interface/01_00_The_Bricscad_Application_Window.htm%23Working_with_the_status_bar
bricscad-sysvar.chm::/00_07_Settings_Manager.htm
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• Quad icon size: Small icons (16 x 16 pixels),  Large icons (32 x 32 pixels) or Extra 

Large icons (64 x 64 pixels). 
  

 

 

Small Icons Large Icons 

 

Extra Large Icons 

• Quad icon space: Defines the size of the Quad tool buttons: narrow, normal or large. 

 

 

 

Narrow Normal Wide 

• Quad show delay: Sets the time lap in milliseconds between the highlighting of the 
entity and the Quad display.  

• Quad hide delay: Sets the time lap in milliseconds to hide the Quad when the cursor is 
outside the Quad hide margin limit.  

• Quad hide margin: Sets the distance in pixels the cursor can move away from the 
Quad. If the cursor moves outside this limit, the Quad is hidden.  

• Quad go transparent: Defines whether the Quad becomes transparent when the mouse 
moves outside the Quad, but within the Quad hide margin.  

• Quad tooltip delay: Sets the delay time in milliseconds to display tooltips. If the value is 
negative, no tooltips display.  

• Quad expand delay: Sets the time lap in milliseconds to expand the Quad after mouse-
enter.  

• Quad expand tab delay: Sets the time lap in milliseconds to expand a group tab after 

mouse-enter.  

• Rollover tips: Specifies whether entity properties display in the Quad while hovering.  

• Rollover opacity: Specifies the degree of opacity when the Quad is in rollover state. 
Values between 10 (very transparent) and 100 (fully opaque) are accepted.  

• Rollover selection set: Controls the content of Rollover tips when multiple entities are 
selected.  

2. To edit a setting, select the setting then do one of the following:  

• Type a new value.  

• Click the check box.  

• Choose an option.  

3. Close the Settings dialog.  

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/03_12_Quad.htm%23RolloverTips
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The Quad Layout 

The layout of the Quad cursor menu depends on: 

• The entity type under de cursor.  

• The current Workspace.  

• Geometric events such as intersection or tangency.  

• When the cursor hovers over an entity, the entity highlights and the Quad displays the 
command most recently used with this entity type.  
When multiple entities are under the cursor, hit the TAB key to highlight all entities one 
by one. 
 

 
 

If QUADCOMMANDLAUNCH = 1, right click to launch the command. 
If QUADCOMMANDLAUNCH = 0, click the command button.  

• If Rollover Tips = ON the properties of the entity under the cursor display in the Quad.  

 
 
 
If the Quad display is off, rollover tips display if: 

- SELECTIONPREVIEW = 1 or 3 
- ROLLOVERTIPS =  ON 
 

 
 

Click a property to edit: 

 

 

When the Quad is expanded, click the title bar of the Quad to display the Rollover tips. 
 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/01_User_Interface/01_00_The_Bricscad_Application_Window.htm%23WorkSpace
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/01_User_Interface/01_00_The_Bricscad_Application_Window.htm%23RolloverTips
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Which properties display for each entity type is specified  in the Properties tab of the Customize 

dialog box. 
Select an entity type in the left pane, then check properties in the Rollover pane. 
   

 

• Move the cursor to the Quad to display the most recently used commands with this 

entity type. 
A number of command category tabs display at the bottom.  

 

The number of buttons is controlled by the QuadWidth user preference. 

bricscad-cmdref.chm::/C/Customize.htm#PropertiesTab
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Which command group tabs display depends on the current Workspace. See To edit the workspace 

command groups to switch closed command groups on. 

Click an icon to launch the command. 

• Move the cursor over the tabs to expand the command group under the cursor. 

 

Click an icon to launch the command. 

Using the Quad 

1. Move the cursor to the entity you want to manipulate. 
The entity under the cursor highlights and the Quad displays the most recently used 
command with this entity type.  

2. (option) Select more entities. 

See Selecting multiple entities.  
3. Do one of the following:  

• Depending on the value of the QUADCOMMANDLAUNCH system variable, either right 

click or click the Quad to repeat the most recently used command.  

• Move the cursor to the Quad and select a different command. 
See The Quad Layout.  

4. Execute the command.  

Selecting Multiple Entities 

1. Move the cursor over the first entity, then click when the entity highlights. 
The entity is selected and remains highlighted.  

2. Move the cursor to another entity, then click when the entity highlights. 
The entity is added to the selection set and remains highlighted.  

3. (option) Repeat step 2 to select more entities.  
4. (option) Move the cursor to a selected entity, then press and hold the Shift key and click. 

The entity is removed from the selection set.  

  

NOTES • When the Quad is active, SELECTIONPREVIEW is neglected, unless a command 
prompts for entity selection. 

• When working with solids: 

• The SELECTIONMODES system variable controls which subentities are detected: 
edges, faces and/or boundaries. 
Holding down the Ctrl key inverts the current selection mode. 

• Click a button on the Selection Modes toolbar to toggle an option. A pressed 
button indicates the option is selected. 
  

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/02_Defining_your_preferences/04_13_Workspaces.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/03_12_Quad.htm%23EditCommandGroups
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/03_12_Quad.htm%23EditCommandGroups
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/03_12_Quad.htm%23SelectMulti
bricscad-sysvar.chm::/00_07_Settings_Manager.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/03_12_Quad.htm%23QuadLayout
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/11_Modifying_Entities/01_Selecting_Entities/11_01_00_Selection_Settings.htm%23SELECTIONPREVIEW
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Enable detection of 3D solid edges 

Enable detection of 3D solid faces 

Enable boundary detection 

•  Repeatedly press the TAB key to highlight all (sub)entities under the cursor. 

 

Selecting Edges of Faces or Solids 

Command: DmSelectEdges 

1. Select the faces and or solids. 
See Selecting multiple entities.  

2. In the Direct Modeling command group of the Quad cursor menu, click the Select Edges 

tool ( ). 
All edges of the selected faces and solids are selected.  

3. (option) To remove edges from the selection set: press and hold the Shift key, then click 
the edge(s).  

Using the Quad to Create Entities 

If the flag of the QUADDISPLAY system variable is set, entity creation commands are available in 

the Quad. 

To set the Display the Quad on right click option: Right click the Quad field in the Status Bar and 
check the option in the context menu. 

The available entity creation commands in the Quad: 

• The most recently used commands. The number of available commands depends on the 
QuadWidth user preference. 

• A number of command group tabs, depending on the current workspace. 
 

 
  

NOTE If the cursor is on an entity, hold down the right mouse button longer to display the No 
Selection Quad. 

   

Customizing the Quad 

To open the Customize/Quad dialog box, do one of the following: 

• Right click the Quad field in the Status Bar and choose Customize Quad items... in the context 
menu. 

• Run the Customize command, then select the Quad tab. 
The Customize/Quad dialog box has two section tabs that are involved in customizing the Quad: 

• The Quad section: 
In this section, the name and content of all Quad Tabs can be specified, similar to the way 
Ribbon Tabs are customized. Quad Tabs can be created, copied, renamed and deleted. 

Manage the content of a Quad Tab by dragging buttons from the right side of the dialog, or by 
using the right-click context menu to add, rename, move or delete Quad Buttons. The right 
side of the dialog contains the full list of all buttons which can be shown in the quad. These 

bricscad-cmdref.chm::/DirectModeling/dmSelectEdges.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/03_12_Quad.htm%23SelectMulti
bricscad-sysvar.chm::/00_07_Settings_Manager.htm
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file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/02_Defining_your_preferences/04_13_Workspaces.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/01_User_Interface/01_00_The_Bricscad_Application_Window.htm%23Quad
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include the tools defined in the cui file, plus all internally defined Quad Buttons, which are 

listed under the new 'Built-in' branch at the bottom. These built-in buttons are similar to the 
tools, only they can not be edited: their name, icon, command string etc.. are read-only. The 
condition which specifies whether a certain Quad Button will appear in the quad when the 
cursor hovers on an entity, is specified for each Quad Button individually in the 'Object Filter' 
property, similar to the way Object Context Menu Items are configured. It is not possible to 

modify the Object Filter of a built-in Quad Button.  

• The Workspaces section: 
This section defines which Quad Tabs will be available in the Quad, in which order, and in 

which workspace. In this interface, you can add/move/remove entire Quad Tabs. The contents 
of the Quad Tabs is not shown nor editable in this section, as this is done in the Quad section 
of the dialog. When a new Quad Tab is created in the Quad section, this Quad Tab is 
automatically added to the Quad in all workspaces.  

To Edit the Workspace Command Groups 

1. Move the cursor over a toolbar, then right click and choose Customize in the context 
menu.  

2. Click the Workspace tab on the Customize dialog box.  

3. Expand the workspace you want to edit.  
4. Expand the Quad Tabs list. 

Tabs that are currently switched off display in grey.  
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5. To set the availability of a tab, select the tab then click the Display field in the 
Properties grid and choose Yes or No.  

6. To add a tab do one of the following:  

7. Right click the Quad Tabs node and choose Appand Quad tab in the context menu 
to add a tab at the bottom of the tab list. 

8. Select a tab, then right click and choose Insert in the context menu to add a tab 
above the selected tab. 

On the Select Ribbon Tab dialog select the tab you want to insert and click the OK button. 
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7. To remove a tab, select the tab, then right and choose Delete in the context menu.  
8. To change the tab order: drag and drop the tabs in the list. 

Prompt Menus 

 

The Prompt Menu and Its Many Uses  

  

BricsCAD commands often provide several options. These options appear in the status bar or 
command bar and also in a prompt menu, which initially displays in the top right corner of the 
screen. Choose the appropriate option by clicking in the prompt menu. E.g. click Radius in the 
PLINE prompt menu to define the radius of the current arc segment of a polyline. 

 

https://blog.bricsys.com/tutorials/
https://blog.bricsys.com/customization/prompt-menu-many-uses/


BricsCAD V18  Help 

 

 69 

To control the display of prompt menus 

Whether a prompt menu displays and its location is controlled through the PROMPTMENU system 
variable and the PromptMenuFlags user preference. 

Type promptmenu in the command bar, then type a value of 0 to 5 (see table below) and press 
Enter. 

  

Value Description 

0 No prompt menus 

1 Display prompt menu 

at user defined location 
(*) 

2 Display prompt menu 

at top left corner 

3 Display prompt menu 
at top right corner 

4 Display prompt menu 
at bottom left corner 

5 Display prompt menu 
at bottom right corner 

  

(*) You can move the prompt menu by dragging it; future prompt menus will appear where you 
last placed it.  

  

NOTE The PROMPTMENU  system variable is saved in the registry and therefore applies to all 

drawings. 

The PromptMenuFlags user preference has two options: 

• 1 = Show hidden options. Hidden options display in italics. 

• 2 = Hide the prompt menu when a command prompts to select entities. 

 

Dockable Panels 

The following panels can be docked: Command Bar, BIM Compositions, Content Browser, Layers 

Panel, Mechanical Browser, Properties Bar, Render Materials, Ribbon, Sheet Sets, Structure, Tool 
Palettes 

  

NOTE Use the -TOOLPANEL command to show, hide or toggle the display of the various tool 
panels. 

  

bricscad-sysvar.chm::/00_07_Settings_Manager.htm
bricscad-sysvar.chm::/00_07_Settings_Manager.htm
bricscad-cmdref.chm::/C/CommandLine.htm
bricscad-cmdref.chm::/BIM/BimAttachComposition.htm
bricscad-cmdref.chm::/C/ContentBrowserOpen.htm
bricscad-cmdref.chm::/L/LayersPanelOpen.htm
bricscad-cmdref.chm::/L/LayersPanelOpen.htm
bricscad-cmdref.chm::/Mechanical/BmBrowser.htm
bricscad-cmdref.chm::/P/Properties.htm
bricscad-cmdref.chm::/M/MatBrowserOpen.htm
bricscad-cmdref.chm::/R/Ribbon.htm
bricscad-cmdref.chm::/S/SheetSet.htm
bricscad-cmdref.chm::/T/ToolPalettes.htm
bricscad-cmdref.chm::/T/ToolPalettes.htm
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To open or close a panel 

1. Move the cursor over a toolbar or ribbon panel, then right click. 
A context menu displays. 
 

 
 
Panels that are currently open are checked. 

2. Click a panel in the menu to toggle its display. 

To dock a panel 

Although panels can be docked at either side of the graphical screen, they are best placed at the 
left or right.  

Do one of the following: 

• Drag the panel by its title bar. A rectangle indicates the boundary of the panel.  Release 
the left mouse button when the boundary rectangle is over an edge of the graphical 
screen. 

• Double click the title bar to dock the panel at its previous location. 

 

 

NOTE The LOCKUI system variable controls whether the current position docked and/or floating 

panels is locked or not. 

Press and hold the Ctrl-key to override. Click the LOCKUI field in the Status Bar to toggle 
the locking of the user interface. 

  

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/01_00_The_Bricscad_Application_Window.htm%23LockUi
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To dock a panel with respect to another docked panel 

When another panel is already docked, you can dock another panel at the top, bottom, left or right 
of the docked panel or add the panel as a tabbed panel. 

1. Drag the panel by its title bar over a docked panel. 

The docking location selector displays. The blue zone indicates the selected docking 
position with respect to the docked panel. 
 

 
 
  

2. Move the cursor over the top, right, bottom,  or left side of the docking location selector to 

choose the docking position with respect to the already docked panel and click when the 
appropriate position highlights. 

To stack panels in a tabbed panel 

Panels can be grouped into a tabbed panel. A tabbed panel can be either docked or floating. 

1. Drag a panel by its title bar. 
The docking location selector displays. 
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2. Move the cursor over the center of the docking location selector to add the panel in a new 

tab. 
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Using tabbed panels 

  

 
To select a tabbed panel 

Do one of the following: 

• Click the panel tab. 
Pause over a tab to display a tooltip. 

 

• Click the down arrow button, then select the panel in the list. 
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To modify the order of the tabs 

Drag a tab to its new position. 

To tear off a tabbed panel 

1. Select the tab. 

2. Drag the tab away from the tabbed panels and drop it on the graphic screen. 

To close a tabbed panel 

1. Select the tab. 

2. Click the Close button of the tab (X). 
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Customizing BricsCAD 

Startup Options 

When starting up BricsCAD it is possible to add arguments or switches. E.g. the command line 
"BricsCAD.exe drawing1.dwg drawing2.dwg drawing3.dwg" will start the BricsCAD application and 
load the specified drawings while the command line "bricscad.exe /P MyProfile" will load BricsCAD 
using  user profile MyProfile. 

"/P MyProfile" is called a command line switch. Both a slash or a hyphen are accepted to precede 
the switch, e.g. "-P MyProfile" will also work. The space is optional, e.g. "/PMyProfile" would also 

work, and the switch character is case insensitive, e.g. "-p MyProfile" is also fine. 

  

Switch Description 

/P [userProfileName] Starting without the /P option, BricsCAD re-uses the last used user 
profile (called current user profile), which is not necessarily the Default 
profile. 

If the user profile specified with the /P option doesn't exist at startup, 
a new empty user profile will be created with that name. 

If the /P argument is an .arg file the arg file is used to initialize the 
profile settings on the first run (See Starting BricsCAD with a specific 

profile). 

/B [scriptFileName.scr] Runs a script at startup. 

/L Suppresses the startup splash screen. 

/LD 
[application.arx/brx/drx] 

Loads an application. 

/S [path] Redefines the SRCHPATH system variable. e.g. BricsCAD.exe /S 

C:\BricsCAD\ 

/T [TemplateFileName] Creates a new drawing based on the template drawing specified. 

regserver  

unregserver 

To register/unregister BricsCAD COM. Please note these arguments are 
to be used without a preceding "/". 

  

NOTES • Switch arguments containing spaces should be enclosed by double quotes, e.g. /P 
"My user profile" 

• Switches can be combined, e.g. /P MyProfile /L  /S C:\BricsCAD\  will start BricsCAD using the 
 MyProfile user profile without the splash screen and sets the SRCHPATH system variable to 
C:\BricsCAD\. 

 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/02_10_User_Profile_Manager.htm%23LoadingUserProfile
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Besides these switches, BricsCAD supports file names as command line arguments. 

Supported file types are: 

DWG - to load a drawing 

DXF - to load a drawing 

SCR - to load a script 

LSP - to load a LISP program 

DLL - to load an ADS/SDS or DRX/ARX program 

SLD - to load a slide file 

MNU - to load a menu file 

CUI - to load a menu file 

  

If GETSTARTED = ON when you launch BricsCAD, the Get Started dialog displays, which let you 

choose the workspace and create a new drawing or open an existing drawing. 

What are BricsCAD User Files 

In BricsCAD the preferences of each user are stored in specific folders, which are called the Local 
root folder and the Roamable root folder. 

  

The Local root folder (Windows only) contains the Templates folder, where the drawing templates 
are saved. 

  

The Roamable root folder contains several subfolders: 

• PlotConfig: where the plotter configuration files (*.pc3) are saved 

• PlotStyles: where the plot style table files (*.stb) and plot color table files (*.ctb) are 
saved 

• Support: where the hatch pattern files (*.pat), line style files (*.lin), alias files (*.pgp), 
unit files (*.unt), custom user interface files (*.cui), etc. are saved 

• Templates: (Mac and Linux only) where the drawing templates are saved. 

  

Platform Local / Roamable root folder 

Windows C:\Users\[UserName]\AppData\Local\Bricsys\BricsCAD\V[Version]\en_US 

  

C:\Users\[UserName]\AppData\Roaming\Bricsys\BricsCAD\V[Version]\en_US 

Mac /Users/[UserName]/Library/Preferences/Bricsys/BricsCAD/V[Version]/en_US 

  

Linux /home/[UserName]/Bricsys/BricsCAD/V[Version]/en_US 

  

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/20_Managing_Drawings/20_01_Creating_a_new_drawing.htm%23GetStarted
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Using the BricsCAD User File Manager 

When you install an update of the software, the first time you launch BricsCAD after the update, 
the content of the UserDataCache folder (C:\Program Files\Bricsys\BricsCAD\UserDataCache) is 
compared with the content of the Local root folder and the Roamable root folder of the current 
user. If you have customized the files in these folders and if one or more of the corresponding files 

in the UserDataCache folder are more recent, the BricsCAD user file manager is launched asking 
you to keep your files or to overwrite them with the new version of these files. 

1. Do one of the following:  

• Select a file in the file list, then click the Yes button to overwrite or click the No button 
to keep your file. 
Repeat this procedure for each file in the list.  

• Click the Yes to all button to replace all your files with the more recent files from 
BricsCAD.  

• Click the Stop Copying button to keep all your files.  

 

2. If you have decided not to update one or more files, an alert window displays. 
Do one of the following:  

• Click the Yes button if you want to update one of these files later. 
In this case this procedure is restarted the next time you start BricsCAD.  
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• Click the No button if you don't want to be reminded. 

 

 

What are the CUI Files 

Files with the CUI extension are Customize User Interface files for BricsCAD. These XML format 

files replace the previously used menu definition files (*.mnu *.mns). CUI files can be edited with 
the build-in interactive editor, launched by the CUSTOMIZE command. You can migrate CUI files 
between BricsCAD versions and combine them between different computers. 

  

NOTE The Load partial CUI file ... procedure accepts IntelliCAD menu files (*.mnu *.mns) and 
converts them to CUI files. 

 

Opening the Customize Dialog 

To open the Customize dialog do one of the following: 

• Choose Customize in the Tools menu  

• In Windows: Hover over a toolbar or a blank portion of the toolbar area, then right click 
and choose Customize in the context menu.  

• In Linux: Hover over a blank portion of  the menu bar, status bar or toolbar area, then 
right click and choose Customize in the context menu.  

• Type customize in the command window, then press Enter.  

• Type cui in the command window, then press Enter.  

bricscad-cmdref.chm::/C/Customize.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/02_02_Loading_a_CUI_file.htm%23To_load_a_partial_CUI_file


BricsCAD V18  Help 

 

 79 

 

  

The components of the Customize dialog are: 

1. File menu  
2. Main customization file name and location  
3. Browse for main customization file button  
4. Search field: type a search string then click the looking glass icon, click again for the next 

hit.  

5. Section tabs  
6. Content of the currently selected section  
7. Available tools tree  
8. Properties grid, displaying the properties of the selected item  

9. Reloads default menus, toolbars, etc. overwriting the customized 
default.cui file.  

10. Saves changes and closes the Customize dialog. 

Closes the Customize dialog, without saving changes. 

Working with CUI files 

Commands:  MENULOAD, CUILOAD, MENUUNLOAD and CUIUNLOAD 

  

When you install BricsCAD the default CUI files are copied to the Support folder of your Roamable 
root folder. (e.g. 
C:\Users\<user_name>\AppData\Roaming\Bricsys\Bricscad\Vxx.x\en_US\Support). 

When you launch BricsCAD the first time the default.cui file is loaded automatically. 

There are two procedures to load a CUI file: 

• Load main CUI file, which replaces all existing content with the content of the new CUI file. 

• Load partial CUI file, which appends its content to the content of the currently loaded main 
CUI file. 

  

bricscad-cmdref.chm::/M/MenuLoad.htm
bricscad-cmdref.chm::/C/CuiLoad.htm
bricscad-cmdref.chm::/M/MenuUnload.htm
bricscad-cmdref.chm::/C/CuiUnload.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/02_00_Bricscad_User_Files.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/02_00_Bricscad_User_Files.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/02_02_Loading_a_CUI_file.htm%23To_load_a_main_CUI_file
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/02_02_Loading_a_CUI_file.htm%23To_load_a_partial_CUI_file
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NOTE You can load an IntelliCAD menu file if you select MNU files (*.mnu;*.mns) in the Files of 
Type list box of the Choose a Customization file dialog in the Load main CUI file, Load 
partial CUI file and Manage Customization Groups procedures. The menu file will be 

converted to a CUI file automatically. 

 

To Load a Main CUI File 

1. Do one of the following:  

• Click the Load Menu tool button ( ) on the Tools toolbar.  

• Choose Load Menu in the Tools menu.  

• Type menu in the command bar, then press Enter.  

• Open the Customize dialog, then click the Browse button.  

• Open the Customize dialog, then choose Load main CUI file ... in the File menu.  

The Select main CUI file dialog displays.  

 

2. Do one of the following:  

• Double click a CUI file.  

• Select a CUI file, then click the Open button.  

The selected CUI file is loaded. 

3. Close the Customize dialog.  

To Load a Partial CUI File 

1. Open the Customize dialog, then choose Load partial CUI file ... in the File menu. 
The Choose a Customization file dialog displays.  

2. Do one of the following:  

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/02_02_Loading_a_CUI_file.htm%23To_load_a_main_CUI_file
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/02_02_Loading_a_CUI_file.htm%23To_load_a_partial_CUI_file
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/02_02_Loading_a_CUI_file.htm%23To_load_a_partial_CUI_file
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/02_02_Loading_a_CUI_file.htm%23Managing_customization_groups
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/02_01_Understanding_the_Customize_Dialog.htm%23Opening_the_Customize_dialog
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/02_01_Understanding_the_Customize_Dialog.htm%23Opening_the_Customize_dialog
file:///C:/Users/Louis/AppData/Local/Temp/298462/02_Defining_your_preferences/02_01_Understanding_the_Customize_Dialog.htm%23Opening_the_Customize_dialog
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• Double click a CUI file.  

• Select a CUI file, then click the Open button.  

The partial CUI file is loaded. 

3. (option) Repeat steps 1 and 2 to load another partial CUI file.  
4. Do one of the following:  

• Click the OK button ( ) to confirm the loading of the partial CUI file(s) and 
close the Customize dialog.  

• Click the Cancel button to ( ) close the Customize dialog and unload the 

partial CUI file(s).  

  

NOTE If a CUIX file is selected in step 2 it will be converted to a CUI file on-the-fly. When a 
CUIX file contains bitmaps, they are copied into a .RESZ resource file, which are 
supported as an alternative to resource DLL (zip file containing tool bitmaps; works on all 
platforms). The following image formats are supported: BMP, JPG, PNG, ICO, GIF, TIFF, 
XBM, XPM. 

  

To Unload a Partial CUI File 

1. Open the Customize dialog.  
2. In the Menus, Toolbars or Keyboard section select the partial CUI file you want to unload.  

 

3. Right click and select Unload <selected partial CUI> in the context menu.  

file:///C:/Users/Louis/AppData/Local/Temp/298462/02_Defining_your_preferences/02_01_Understanding_the_Customize_Dialog.htm%23Opening_the_Customize_dialog
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Managing customization groups 

1. Type Menuload in the command bar, then press Enter. 

2. The Customization groups dialog opens. 

 

3. (option) To load a partial CUI file, click the browse button ( ) to select a partial CUI file, 

then click the Load button. 

4. (option) To unload a partial CUI file, select the partial CUI file in the Loaded Customization 

Groups list, then click the Unload button. 

5. Click the Close button to stop. 

Creating Custom Tools 

Overview 

1. Create a Partial CUI file.  
2. (option) Add toolbox(es) in a Menu Group.  
3. (option) Add tools in a toolbox  
4. (option) Add main menu(s)  

5. (option) Add sub menu(s)  
6. (option) Add context menu(s)  
7. (option) Add toolbar(s)  
8. (option) Add flyout(s) to toolbar(s)  

9. (option) Add control(s) to toolbar(s)  
10. (option) Add keyboard shortcuts  
11. (option) Add existing tools to menus, toolbars or shortcuts  

12. (option) Create new tools in menus, toolbars or shortcuts  
13. (option) Change the tool order in menus and toolbars  

Create a Partial CUI File 

1. In the Customize dialog do one of the following:  

• In the File menu, choose Create new partial CUI file ... .  

• Place the cursor on Menu group, then right click an choose Create new partial CUI file 
... in the context menu.  

The Create a Customization File dialog opens. 

By default the new partial CUI file will be created in the Support  folder of  the Roamable root 
folder. 

file:///C:/Users/Louis/AppData/Local/Temp/298462/02_Defining_your_preferences/02_03_Creating_custom_tools.htm%23To_create_a_Partial_CUI_file
file:///C:/Users/Louis/AppData/Local/Temp/298462/02_Defining_your_preferences/02_03_Creating_custom_tools.htm%23To_add_a_toolbox_in_a_menu_group
file:///C:/Users/Louis/AppData/Local/Temp/298462/02_Defining_your_preferences/02_03_Creating_custom_tools.htm%23To_add_tools_in_a_toolbox
file:///C:/Users/Louis/AppData/Local/Temp/298462/02_Defining_your_preferences/02_03_Creating_custom_tools.htm%23To_add_a_main_menu
file:///C:/Users/Louis/AppData/Local/Temp/298462/02_Defining_your_preferences/02_03_Creating_custom_tools.htm%23To_add_a_submenu_to_a_menu
file:///C:/Users/Louis/AppData/Local/Temp/298462/02_Defining_your_preferences/02_03_Creating_custom_tools.htm%23To_add_a_context_menu
file:///C:/Users/Louis/AppData/Local/Temp/298462/02_Defining_your_preferences/02_03_Creating_custom_tools.htm%23To_add_a_toolbar
file:///C:/Users/Louis/AppData/Local/Temp/298462/02_Defining_your_preferences/02_03_Creating_custom_tools.htm%23To_add_a_flyout_to_a_toolbar
file:///C:/Users/Louis/AppData/Local/Temp/298462/02_Defining_your_preferences/02_03_Creating_custom_tools.htm%23To_add_a_control_to_a_toolbar
file:///C:/Users/Louis/AppData/Local/Temp/298462/02_Defining_your_preferences/02_03_Creating_custom_tools.htm%23To_add_a_keyboard_shortcut
file:///C:/Users/Louis/AppData/Local/Temp/298462/02_Defining_your_preferences/02_03_Creating_custom_tools.htm%23To_add_tools_in_a_toolbox
file:///C:/Users/Louis/AppData/Local/Temp/298462/02_Defining_your_preferences/02_03_Creating_custom_tools.htm%23Create_a_new_tool
file:///C:/Users/Louis/AppData/Local/Temp/298462/02_Defining_your_preferences/02_03_Creating_custom_tools.htm%23ChangeToolOrder
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/02_01_Understanding_the_Customize_Dialog.htm%23Opening_the_Customize_dialog
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/02_00_Bricscad_User_Files.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/02_00_Bricscad_User_Files.htm
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2. (option) Select a different folder to save the CUI file.  

3. Type a name for the new CUI file in the File name field.  
4. Click the Save button.  

The newly created Partial CUI file  is loaded and a Menu Group of the same name is created in the 
Menus tree, Toolbars tree, Keyboards tree and Available Tools tree. 

Add a Toolbox to a Menu Group 

1. In the Customize dialog select a menu group.  
2. Right click and choose Append toolbox in the context menu.  

 

4. Type a name for the new toolbox in the Title field of the Add toolbox dialog.  

 

5. Click the OK button. 
The toolbox is added in the Available Tools tree.  

6. Click the Apply button to save the definition.  

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/02_01_Understanding_the_Customize_Dialog.htm%23Opening_the_Customize_dialog
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Add Tools to a Toolbox 

1. In the Customize dialog select a toolbox in the Available Tools tree.  
2. Right click and choose  Append tool in the context menu. 

The Add tool dialog displays.  

 

3. Type a name for the new tool in the Title field of the Add tool dialog.  
4. (option) Type a help string in the Help field of the properties grid.  

5. Type a command or command macro in the Command field of the properties grid.  

6. Click the Browse button ( ), then select an image for the new tool. 
Do one of the following:  

• Select Builtin, then choose one of the built-in icons. 

 

 
• Select Bitmap file, and choose a bmp, gif, jpg, jpeg or png image file.  

7. Click the OK button. 

The tool is added in the toolbox.  

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/02_01_Understanding_the_Customize_Dialog.htm%23Opening_the_Customize_dialog
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In the above example the Command  field contains a macro that makes the InteriorWalls layer 

current, then launches the Mline command. 
If the layer does not exist yet, it is created first. 
  

NOTE • ^c^c is the equivalent of pressing the Esc key twice, which first ends a running 
command if necessary. 

• an underscore (_) in front of a command name ensures that the macro still works 
in a non-English version of BRICSCAD. 

• a point (.) in front of a command name ensures that the macro still works if this 
command is temporarily undefined (see the UNDEFINE  and REDEFINE 

commands). 

• a minus sign (-) in front of a command launches the command line version of a 
command, thus preventing the command dialog window to open. 

• a semicolon (;) is the equivalent of pressing the Enter key 

• a backslash (\) waits for user input, e.g. specifying a point. 

  

Add a Main Menu 

1. In the Customize dialog click the Menus tab.  
2. Do one of the following:  

• Click the Main Menus subgroup of the menu group, then right click and choose Append 
main menu in the context menu.  

• Select an existing menu in the Main Menus subgroup, then right click and choose Insert 
main menu in the context menu.  

New menus are added above the selected existing menu or as the first menu if you select the Main 

Menus subgroup. 

3. Type a name in the Title field of the Add main menu dialog.  

bricscad-cmdref.chm::/U/Undefine.htm
bricscad-cmdref.chm::/R/Redefine.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/02_01_Understanding_the_Customize_Dialog.htm%23Opening_the_Customize_dialog
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4. Click the OK button.  
5. (option) Repeat steps 2 through 5 to add more menus.  
6. Click the Apply button to save the definition(s).  

  

NOTE The new main menu is not added to the Menu bar until at least one menu items is added 

to it. 

 

Add a Submenu to a Menu 

1. In the Customize dialog click the Menus tab.  
2. If collapsed, expand the menu group (e.g. BRICSCAD).  
3. If collapsed, expand the Main menus group of the menu group.  

4. Do one of the following:  

• Select the menu, then right click and choose Append submenu in the context menu.  

• Select an existing item in the menu, then right click and choose Insert submenu in the 
context menu.  

New submenus are added above the selected existing item or as the first item if you select the 
menu. 

5. Type a name in the Title field of the Add submenu dialog.  
6. Click the OK button.  

Add a Context Menu 

1. In the Customize dialog click the Menus tab.  
2. Do one of the following:  

• Select the Context Menus subgroup of the menu group, then right click and choose 

Append context menu in the context menu.  

• Select an existing context menu, then right click and choose Insert context menu in the 
context menu.  

New context menus are added above the selected existing context menu or as the first context 
menu if you select the Context Menus subgroup. 

3. Select a menu in the menu list of the Add context menu dialog.  

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/01_User_Interface/01_00_The_Bricscad_Application_Window.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/02_01_Understanding_the_Customize_Dialog.htm%23Opening_the_Customize_dialog
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/02_01_Understanding_the_Customize_Dialog.htm%23Opening_the_Customize_dialog
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4. (option) Select As regular context menu, then click the Add Context... button. 
The Add context alias dialog box displays: 

 

 
 
Choose:  

• CMCOMMAND: to replace the default Command context menu.  

• CMDEFAULT: to replace the default Default context menu.  

• CMEDT: to replace the default Edit context menu.  

• GRIPS: to replace the default Grips context menu.  

• SNAP: to replace the default Entity Snap context menu.  

Click the OK button to confirm. 

Optionally repeat the previous step to add another alias. 

Select an alias, then click the Remove button to remove the alias. 
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5. (option) Select As context menu on specific entities:, then click the Add Entity Type(s)... 

button. 
The Add Entity Alias dialog box displays: 
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Do one of the following: 

• Check the One entity option: the context menu applies if one entity is selected 
only..  

• Check Multiple entities: the context menu applies in multiple entities are 
selected only.  

• Check both options: the context menu applies if one or more entities are 
selected.  

Select one or more entity types in the list. 

Click the OK button to confirm. 

6. Type a name in the Menu title field.  
7. Click the OK button to save the context menu.  

8. (option) Repeat steps 2 through 5 to add more context menus.  

Add a Toolbar 

1. In the Customize dialog click the Toolbars tab.  
2. Do one of the following:  

• Select a menu group, then right click and choose Append toolbar in the context menu.  

• Select an existing toolbar in a menu group, then right click and choose Insert toolbar in 
the context menu.  

New toolbars are added above the selected existing toolbar or as the first toolbar if you select the 
menu group. 

4. Type a name in the Title field of the Add toolbar dialog.  

 

5. Click the OK button.  
6. (option) Adjust the Toolbar properties.  

 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/02_01_Understanding_the_Customize_Dialog.htm%23Opening_the_Customize_dialog
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• Title: The toolbar name must include alphanumeric characters with no punctuation 

other than a dash (&endash;) or an underscore (_). The Title along with the Alias 
enables the toolbar to be referenced programmatically.  

• Position: Defines the display position of the toolbar when the CUI file is loaded.  
The options are: Floating, Top, Left, Bottom or Right. The latter four refer to the 
window edge where the toolbar will be docked.  

• Display: Defines whether the toolbar displays or not when the CUI file is loaded.  

• Rows: Specifies the number of rows when the toolbar position is floating. 
View bars with controls cannot have multiple rows.  

• Xval: When the position is Floating, specifies the X coordinate in pixels, measured from 
the left edge of the screen to the left side of the toolbar.  

• Yval: When the position is Floating, specifies the Y coordinate in pixels, measured from 
the top edge of the screen to the top of the toolbar.  

6. Click the Apply button to save the definition(s).  

  

NOTES The new toolbar is loaded only if the Display property is set to Show. See Opening a 
Toolbar for more information on opening toolbars. 

  

Add a Flyout to a Toolbar 

1. In the Customize dialog click the Toolbars tab.  
2. If collapsed, expand the menu group (e.g. BRICSCAD).  
3. Do one of the following  

• Select a toolbar, then right click and choose Append Flyout in the context menu, to add 
the flyout at the end of the toolbar.  

• Expand the toolbar, right click a tool then choose Insert flyout in the context menu, to 

add the flyout above the selected tool.  

The Add flyout dialog box displays: 

 

4. Type a name in the Title field of the Add flyout dialog, then click the OK button.  

A new empty toolbar is created and inserted as a flyout in the selected toolbar: 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/01_User_Interface/01_01_Toolbars.htm%23Opening_a_toolbar
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/01_User_Interface/01_01_Toolbars.htm%23Opening_a_toolbar
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5. Do one of the following:  

• Click the Target Alias field, then click the settings field and select an existing toolbar in 
the drop-down list.  

• Add tools to the new toolbar.  

Add a Control to a Toolbar 

1. In the Customize dialog click the Toolbars tab.  
2. If collapsed, expand the menu group (e.g. BRICSCAD).  
3. Do one of the following:  

• Select the toolbar, then right click and choose Append control in the context menu. 
The new control will be added as the first item in the toolbar.  

• Select an existing item in the toolbar, then right click and choose Insert control in the 
context menu. 
The new control will be added above the selected existing item.  

4. Select a control in the Add control dialog.  

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/02_01_Understanding_the_Customize_Dialog.htm%23Opening_the_Customize_dialog
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5. Click the OK button.  
6. To specify the width of the control, do one of the following:  

• Accept the Default width.  

• Type the width in pixels in the Width field.  

 
  

NOTE Type Default or 0 (zero) in the Width field to restore the default width of the control field. 

  

Add a Keyboard Shortcut 

1. In the Customize dialog click the Keyboard tab.  
2. If collapsed, expand the menu group (e.g. BRICSCAD).  
3. Do one of the following:  

• Select the menu group, then right click and choose Append shortcut in the context 

menu. 
The new shortcut will be added at the end of the shortcut list.  

• Select an existing shortcut in the toolbar, then right click and choose Insert shortcut in 
the context menu. 
The new shortcut will be added above the selected existing shortcut.  

6. Do one of the following:  

• Proceed with the Add an existing tool procedure.  

• Proceed with the Add a new tool procedure.  

5. In the Properties grid of the new shortcut select the Key field, then press the key 
combination you want to assign to the shortcut.  

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/02_01_Understanding_the_Customize_Dialog.htm%23Opening_the_Customize_dialog
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/02_03_Creating_custom_tools.htm%23Add_an_existing_tool
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To add an existing tool to a menu, toolbar or shortcut 

1. In the Customize dialog select the item you want to add an existing tool to.  
2. In the Available Tools pane, expand the toolbox that contains the tool you want to add.  
3. Drag the tool to the target item:  

• Drop the tool on top of the item name to append the tool.  

• Drop the tool on top of another tool to insert the new tool above the existing tool.  

4. (option) Edit the tool in the settings grid, e.g. to add a diesel expression in the Diesel field. 
 

 

  To change the order of the tools in a menu or toolbar 

1. In the Customize dialog select the menu or toolbar.  
2. Drag the tool to its new position:  

• Drop the tool on top of the item name to move it to the last position.  

• Drop the tool on top of another tool to move the tool above this tool. 

Create a New Tool 

1. In the Add dialog choose Create new tool.  
2. Select the Toolbox in which you want to create the new tool.  

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/02_01_Understanding_the_Customize_Dialog.htm%23Opening_the_Customize_dialog
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3. Type a name for the new tool in the Title field of the Add tool dialog.  
4. (option) Type a help string in the Help field of the properties grid.  
5. Type a command or command macro in the Command field of the properties grid. 

In the screenshot above the Command  field contains a macro that makes the 

InteriorWalls layer current, then launches the Mline command. 
If the layer does not exist yet, it is created first.  

6. Click the Browse button ( ), then select an image for the new tool. 
Do one of the following:  
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• Select Builtin, then choose one of the built-in icons. 

 

 
• Select Bitmap file, and choose a bmp, gif, jpg, jpeg or png image file.  

7. Click the OK button to create the new tool.  

Ribbon 

Commands: RIBBON and RIBBONCLOSE  
   

A ribbon organizes tools in a series of Panels  (2) which are grouped in different Tabs (1).  
The number of tabs and their order depends on the current workspace and is defined in the Ribbon 
node of the workspace (see Editing a Workspace).  
   

   
   
The RIBBONDOCKEDHEIGHT system variable stores the preferred height of the Ribbon bar. Values 
between 0 and 500 are accepted. Set the value to 0 (zero) for automatic height calculation.  

Ribbon Panels 

A ribbon panel is composed of one or more rows. In a row you can add one or more command 
buttons or row panels, which in turn can hold one or more command buttons. 

  

 

  

Ribbon Panel 

bricscad-cmdref.chm::/R/Ribbon.htm
bricscad-cmdref.chm::/R/RibbonClose.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/04_13_Workspaces.htm%23EditWorkspace
bricscad-sysvar.chm::/00_07_Settings_Manager.htm
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Structure of the Ribbon Panel in the Customize dialog 

  

The Entity Snaps ribbon panel above is composed of: 

• a launcher  (1) 

• a single row, holding three command buttons (2), a row panel (3) with three rows of four 

command buttons each, two command buttons (4) and a row panel (5) with three rows of 
one command each. 

Ribbon Buttons 

 The following button types are available:  

• Command button (2): launches a command 

• Split button (1): groups a series of command buttons, much like a flyout toolbar. 

• Toggle button (3): toggles a setting; shows the current status of setting 
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Creating a Ribbon Tab 

1. Open the Customize dialog. 

2. Click the Ribbon tab on the Customize dialog. 

3. Right click the Ribbon tabs group and choose Append ribbon tab in the context menu. 

4. Fill out the fields in the Add Ribbon Tab dialog box: 
 

 
 
Label: Caption on the ribbon  tab. 
Title: Used in the Select Ribbon Tab dialog when selecting ribbon tabs for a workspace 
(see Editing a Workspace). 

ID: A unique name to identify the ribbon tab. 

5. Click the OK button. 

Editing a ribbon tab 

1. Open the Customize dialog. 

2. Click the Ribbon tab on the Customize dialog. 

3. Expand the Ribbon tabs group. 

 

To add a panel to a ribbon tab 

1. Do one of the following: 

Right click the ribbon tab and choose Append panel in the context menu, to add a panel 

at the end. 

Right click an existing panel and choose Insert panel in the context menu, to ad a panel 
above the existing panel. 

file:///C:/Users/Louis/AppData/Local/Temp/298462/02_Defining_your_preferences/02_01_Understanding_the_Customize_Dialog.htm%23Opening_the_Customize_dialog
file:///C:/Users/Louis/AppData/Local/Temp/298462/02_Defining_your_preferences/04_13_Workspaces.htm%23EditWorkspace
file:///C:/Users/Louis/AppData/Local/Temp/298462/02_Defining_your_preferences/02_01_Understanding_the_Customize_Dialog.htm%23Opening_the_Customize_dialog
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2. Select the panel in the Select Ribbon Panel dialog, then click the OK button. 

 

 

3. (option) Drag the panel to a different position. 
 

To remove a panel from a ribbon tab 

1. Select the panel. 

2. Do one of the following: 

Press the Delete key. 

Right click and choose Remove in the context menu. 

To add a row panel to a row 

Do one of the following: 

• Right click the row and choose Append Row Panel in the context menu. 
The row panel is added at the bottom of the row tree. 

• Right click an existing row panel and choose Insert Row Panel in the context menu. 
The row panel is inserted above the existing row panel. 

To add a command button to a row 

• Drag and drop a tool from the Available Tools list onto the row. 
Drop the tool on the row to add a command button at the bottom of the row tree. 
Drop the tool on an existing command button to add a command button above an 
existing command button. 

• Set the Button Style in the Command Button grid. 
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The options are: 
  

Icon Style 

 

Small 

 

Small with text 

 

Large 

 

Large with text 

• (option) Drag the command button to a different position in the same row or onto a 
different row.   

 

To add a split button to a row 

• Select the row, then right click and choose Append split button in the context menu. 
The split button is added at the bottom of the row tree. 

• Drag a series of related tools from the Available Tools list onto the split button. 

• Set the Button Style in the Split Button grid. 
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• The options are: 

Icon Style 

 

Small 

 

Small with text 

 

Large 

 

Large with text 

• Type a label text in the Label field. 

• (option) Set the Behavior to Split with recent (static text): always display the split 
button label, instead of the label of the most recently used tool. 

• (option) Drag the split button to a different position in the same row or onto a different 
row.  

• Drag and drop tools from the Available Tools list onto the split button. 

 

To add a toggle button to a row 

• Select the row, then right click and choose Append Toggle Button in the context menu. 

• Either select an available tool or Create a New Tool, then click the OK button. 
 

 
  

file:///C:/Users/Louis/AppData/Local/Temp/298462/02_Defining_your_preferences/02_03_Creating_custom_tools.htm%23Create_a_new_tool
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• The toggle button is added at the bottom of the row tree. 

• (option) Drag the toggle button to a different position in the same row or onto a 
different row.  

 

To add a control to a row 

Drag a control from the controls list onto the row. 

• Drop the control on the row to add it at the bottom of the row tree. 

• Drop the control on a existing command button to add it above the command button. 

Creating a Ribbon Panel 

1. Open the Customize dialog. 

2. Click the Ribbon tab on the Customize dialog. 

3. Right click the Ribbon Panels group and choose Append ribbon panel in the context menu. 

4. Fill out the fields in the Add Ribbon Panel dialog box: 
 

 
 
Label: Caption of the panel in the ribbon. 

Title: Used in the Select Ribbon Panel dialog when selecting the panels for a ribbon tab 
ID: A unique name to identify the ribbon panel. 

5. Click the OK button. 

Editing a Ribbon Panel 

1. Open the Customize dialog. 

2. Click the Ribbon tab on the Customize dialog. 

3. Expand the Ribbon Panels group. 

4. Expand the ribbon panel. 

 

To add a row to a ribbon panel 

Do one of the following: 

• Right click the ribbon panel and choose Append Row in the context menu. 
The row is added at the bottom of the ribbon panel tree. 

• Right click an existing row and choose Insert Ribbon Row in the context menu. 
The row is added above the existing row. 

• (option) Drag the row to a different location in the ribbon panel tree. 

 

To add a launcher to a ribbon panel 

• Right click the ribbon panel and choose Add launcher in the context menu. 

• Either select an available tool or Create a New Tool, then click the OK button. 
 

file:///C:/Users/Louis/AppData/Local/Temp/298462/02_Defining_your_preferences/02_01_Understanding_the_Customize_Dialog.htm%23Opening_the_Customize_dialog
file:///C:/Users/Louis/AppData/Local/Temp/298462/02_Defining_your_preferences/02_01_Understanding_the_Customize_Dialog.htm%23Opening_the_Customize_dialog
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Editing a Panel Row 

1. Open the Customize dialog. 

2. Click the Ribbon tab on the Customize dialog. 

3. Expand the Ribbon panels group. 

4. Expand the ribbon panel. 

5. Expand the ribbon rows and ribbon row panels. 

 

To add a row panel to a row 

Do one of the following: 

• Right click the row and choose Append Row Panel in the context menu. 
The row panel is added at the bottom of the row tree. 

• Right click an existing row panel and choose Insert Row Panel in the context menu. 
The row panel is inserted above the existing row panel. 

 

To add a command button to a row 

• Drag and drop a tool from the Available Tools list onto the row. 
Drop the tool on the row to add a command button at the bottom of the row tree. 
Drop the tool on an existing command button to add a command button above an 
existing command button. 

• Set the Button Style in the Command Button grid. 
 

file:///C:/Users/Louis/AppData/Local/Temp/298462/02_Defining_your_preferences/02_01_Understanding_the_Customize_Dialog.htm%23Opening_the_Customize_dialog
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The options are: 
  

Icon Style 

 

Small 

 

Small with text 

 

Large 

 

Large with text 

• (option) Drag the command button to a different position in the same row or onto a 
different row.   

 

To add a split button to a row 

• Select the row, then right click and choose Append split button in the context menu. 
The split button is added at the bottom of the row tree. 

• Drag a series of related tools from the Available Tools list onto the split button. 

• Set the Button Style in the Split Button grid. 
 

 
 
The options are: 

Icon Style 

 

Small 

 

Small with text 

 

Large 

 

Large with text 
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• Type a label text in the Label field. 

• (option) Set the Behavior to Split with recent (static text): always display the split 
button label, instead of the label of the most recently used tool. 

• (option) Drag the split button to a different position in the same row or onto a different 
row.  

• Drag and drop tools from the Available Tools list onto the split button. 

 

To add a toggle button to a row 

• Select the row, then right click and choose Append Toggle Button in the context menu. 

• Either select an available tool or Create a New Tool, then click the OK button. 
 

 
  

• The toggle button is added at the bottom of the row tree. 

• (option) Drag the toggle button to a different position in the same row or onto a 
different row.  

To add a control to a row 

Drag a control from the controls list onto the row. 

• Drop the control on the row to add it at the bottom of the row tree. 

• Drop the control on a existing command button to add it above the command button. 

file:///C:/Users/Louis/AppData/Local/Temp/298462/02_Defining_your_preferences/02_03_Creating_custom_tools.htm%23Create_a_new_tool
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Tool Palettes 

Command: TOOLPALETTES, TOOLPALETTESCLOSE, TPNAVIGATE 

  

The ToolPalettes command opens the Tool Palettes bar. 

The ToolPalettesClose command closes the Tool Palettes bar. 

The Tpnavigate command displays a tool palette or a tool palette group. 

  

On a tool palette you can add blocks, hatches and commands in a tabbed window. 

Drag a tool from the palette to the graphic screen to launch the related tool. 

To Open the Tool Palettes Bar 

Do one of the following: 

• Hover over a toolbar (Windows) or an empty toolbar area (Windows and Linux), then right 
click and choose Tool Palettes Bar in the context menu. 

• Type toolpalettes in the command bar, then press Enter. 

  

 

bricscad-cmdref.chm::/T/ToolPalettes.htm
bricscad-cmdref.chm::/T/ToolPalettesClose.htm
bricscad-cmdref.chm::/T/Tpnavigate.htm
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To Set the View Options 

1. Right click in an empty space of the icon area on the Toolpalettes Bar and choose View 
Options... in the context menu. 
The View Options dialog displays. 
 

 
2. Drag the Image Size slider to adjust the image size.  
3. Select either Icon with text, Icon only or List view.  
4. Choose either Current Palette or All Palettes from the Apply to list button.  
5. Click the OK button to confirm.  

Adding a New Tool Palette 

1. Move the cursor to the icon area of the Tool Palettes Bar, then right click. 
A context menu displays:  

 

2. Choose New Palette in the context menu. 

A new tab is added.  
3. Type a name for the new palette in the Name field.  



BricsCAD V18  Help 

 

 107 

To open the customize dialog box 

1. Move the cursor to the icon area of the Tool Palettes Bar, then right click. 
A context menu displays:  

 

2. Choose Customize Palettes in the context menu. 
The Customize dialog box displays: 
 

 

Importing a Tool Palette 

1. Open the Customize dialog box.  
2. In the Palettes pane on the Customize dialog box, right click and choose Import in the 

context menu.  
3. On the Import Palette dialog, select a folder, then select a palette file (*.btc or *.xtp).  

4. Click the Open button or double click to import the palette. 
The palette is added in the Palettes list.  

5. Click the Close button to close the Customize dialog box.  

file:///C:/Users/Louis/AppData/Local/Temp/298462/02_Defining_your_preferences/02_05_Toolpalettes.htm%23OpenCustomizeDialog
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Working with Palette Groups 

To create a palette group 

1. Open the Customize dialog box.  
2. Place the cursor on the Palette Groups root folder name.  
3. Right click and choose New Palette in the context menu. 

A new group folder is added at the bottom of the palette groups tree. 
 

 
4. Type a name for the new group.  

To create a palette subgroup 

1. Open the Customize dialog box.  
2. Place the cursor on an existing group name.  
3. Right click and choose New Palette in the context menu. 

A new group folder is added as a subgroup of the selected group.  
4. Type a name for the new group.  

To add a palette to a group 

1. Open the Customize dialog box.  

2. Place the cursor on a palette.  
3. Press and hold the left mouse button, then drag the palette onto a palette group name.  

4. Release the left mouse button to add the palette to the group.  

To remove a palette from a group 

1. Open the Customize dialog box.  
2. Select the palette in the group.  
3. Right click and choose Remove in the context menu.  

To set a palette group current 

1. Open the Customize dialog box.  

2. Select the palette group in the palette groups tree.  
3. Right click and choose Set Current in the context menu.  

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/02_05_Toolpalettes.htm%23OpenCustomizeDialog
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/02_05_Toolpalettes.htm%23OpenCustomizeDialog
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/02_05_Toolpalettes.htm%23OpenCustomizeDialog
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/02_05_Toolpalettes.htm%23OpenCustomizeDialog
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To delete a palette group 

1. Open the Customize dialog box.  
2. Select the palette group in the palette groups tree.  
3. Right click and choose Delete in the context menu.  

To Rename a Tool Palette 

1. Right click tool palette tab and choose Rename Palette in the context menu.  
2. Type a new name for the palette in the Name field.  
3. Press Enter to confirm.  

To Delete a Tool Palette 

1. Right click tool palette tab and choose Delete Palette in the context menu.  
2. Click the OK button on the Confirm Palette Deletion box.  

Adding a Hatch Pattern 

1. Select the palette you want to add a hatch pattern to.  
2. Open the Hatch and Gradient dialog box.  
3. Select either Predefined or Custom from the Type list button.  
4. Double click the Swatch field on the Hatch and Gradient dialog box. 

The Hatch Pattern Palette displays.  
5. Select the hatch pattern you want to add, then right click and Choose Add to Current Tool 

Palette. 
The hatch pattern is added on the current tool palette.  

 

6. (option) Repeat steps 5 and 6 to add more hatch patterns.  
7. (option) Drag-and-drop patterns to change their order on the palette.  

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/02_05_Toolpalettes.htm%23OpenCustomizeDialog
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/10_Drawing_Entities/04_Working_with_Hatches/10_04_01_Using_Boundary_Hatch.htm%23GeneralHatchProcedure
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Adding blocks 

Blocks can be added from the current drawing or from any drawing. 

Adding Blocks from the Current Drawing 

1. Choose Drawing Explorer - Blocks in the Tools menu.  
2. On the Drawing Explorer - Blocks dialog box select the block or blocks you want to add.  
3. Right click and choose Add to Current Tool Palette in the context menu.  

Adding Blocks from Any Drawing 

1. If not already available, add the containing folder to the Folders list on the Drawing 
Explorer - Drawings dialog box.  

2. Select the drawing in the containing folder on the  Drawing Explorer - Drawings dialog 

box.  
3. Click the Expand icon (+) of the containing drawing. 

The Blocks icon of the drawing displays.  
4. Click the Blocks icon of the containing drawing. 

The blocks in the drawing display in the Details pane.  
5. Select the block or blocks you want to add. 

Press and hold the Ctrl key to select multiple blocks.  

6. Right click and choose  Add to Current Tool Palette in the context menu.  

 

7. (option) Drag-and-drop blocks to change their order on the palette. 

bricscad-cmdref.chm::/E/Explorer.htm#Folders
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Adding a Drawing as a Block 

1. If not already available, add the containing folder to the Folders list on the Drawing 
Explorer - Drawings dialog box.  

2. Select the drawing in the containing folder on the  Drawing Explorer - Drawings dialog 
box.  

3. Right click and choose Add to Current Toolpalette as block in the context menu.  

 
 

When placing a block from a toolpalette the -Insert command is launched. 

Adding All Blocks from Multiple Drawings 

This procedure collects all blocks in each of the drawings of the selected folder and add them to a 
palette of the drawing name. New palettes are created if necessary.  

1. If not already available, add the containing folder to the Folders list on the Drawing 

Explorer - Drawings dialog box. 

2. Select the folder, then right click and choose Add blocks to Tool Palettes in the context 
menu. 

bricscad-cmdref.chm::/E/Explorer.htm#Folders
bricscad-cmdref.chm::/I/Insert/-Insert.htm
bricscad-cmdref.chm::/E/Explorer.htm#Folders
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To add a drawing as a component. 

1. If not already available, add the containing folder to the Folders list on the Drawing 
Explorer - Drawings dialog box.  

2. Select the drawing in the containing folder on the  Drawing Explorer - Drawings dialog 
box.  

3. Right click and choose Add to Current Toolpalette as component in the context menu. 
 

 
 
When placing a component from the tool palette, the -BmInsert command is launched.  

Adding a Component 

1. Choose Customize in the Tools menu.  
2. Under Available Tools on the Customize dialog, expand the containing toolbox, then select 

the command in the commands list.  
3. Right click and choose  Add to Current Tool Palette in the context menu.  

bricscad-cmdref.chm::/E/Explorer.htm#Folders
bricscad-cmdref.chm::/Mechanical/BmInsert.htm
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4. (option) Drag-and-drop commands to change their order on the palette. 
  

NOTE See the topic Creating Custom Tools to create your own tools, which you can then add to 
a tool palette. 

 

Adding a Command 

1. Choose Customize in the Tools menu.  
2. Under Available Tools on the Customize dialog, expand the containing toolbox, then select 

the command in the commands list.  

3. Right click and choose  Add to Current Tool Palette in the context menu.  

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/02_03_Creating_custom_tools.htm
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4. (option) Drag-and-drop commands to change their order on the palette. 
  

NOTE See the topic Creating Custom Tools to create your own tools, which you can then add to 
a tool palette. 

 

Editing a Tool 

General procedure to edit a tool on a tool palette:  

1. Right click the tool, then choose Properties in the context menu.  

The Tool Properties dialog box displays.  

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/02_03_Creating_custom_tools.htm
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Hatch tool properties 
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Block tool properties 
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Command tool properties 

2. Edit the tool properties.  
3. Click the OK button to confirm.  

Managing tools 

To manage the tools on a tool palette do the following: 

1. Right click the tool. 
A context menu displays: 
 

 
2. Choose an option in the context menu.  

To Specify a Tool Image 

1. Right click the tool and choose Specify Image in the context menu. 
A file dialog box displays.  

2. Select the image file, then click the Open button.  
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NOTE To restore the original tool image: Right click the tool and choose Remove Image in the 

context menu. 

 

To Move a Tool 
Drag-and-drop tools to re-arrange tools on a palette: drag the tool to the desired location and drop 
the tool on top of the existing tool. 

   

To move a tool from one palette to another, do the following: 

1. Right click the tool on the source palette and choose Cut in the context menu.  
2. Select the target palette.  
3. Right click and choose Paste in the context menu. 

The tool is added at the bottom of the palette.  

To Copy a Tool 
To copy a tool from one palette to another, do the following: 

1. Right click the tool on the source palette and choose Copy in the context menu.  
2. Select the target palette.  
3. Right click and choose Paste in the context menu. 

The tool is added at the bottom of the palette. 
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Command Aliases 

Command aliases are alternative names for BricsCAD commands. You can launch the LINE 
command by entering L at the command prompt. There is no need to type the complete name. 
After typing the command alias at the command prompt the command is executed. Some 

commands have more than one alias: e.g. REC, RECT and RECTANGLE are all aliases for RECTANG, 
whereas the last alias is even longer than the command name. In general, command aliases can 
increase your speed in entering the commands at keyboard.  

Command aliases are saved in a *.pgp file (ProGram Parameters file). By default the default.pgp 
file in the Support folder of the Roamable Root folder is used.  

If a command can be executed transparently (= while another command is being executed), the 

alias can also be used transparently. To execute a command or an alias transparently, precede the 
command name or alias with an apostrophe ('). 

  

  

NOTES • Unlike commands, aliases are only local and cannot be used as global (preceded by 
a underscore (_). 

• Command aliases cannot be used in scripts (*.scr). 

  

To Edit the Alias File in a Text Editor 

In order to modify existing aliases or to create new ones, the default.pgp file can be edited using 
an ASCII text editor (e.g. Notepad). 

The first section of the default.pgp file defines the Shell commands. The second section of the 
default.pgp file defines command aliases.  

The following syntax is used to define a command alias:  

alias,                   *command 

alias = the character string to be entered at the command prompt. The command alias must be 
followed by a comma (,). 

command = the BricsCAD command. The command name must be preceded by an asterisk (*). 

Comment lines must be preceded by a semicolon (;). Comment lines can be used to add additional 
information, e.g. when the file was last edited and by whom. 

Some commands, such as HATCH or BOUNDARY, can be preceded by a hyphen (-) to access the 

command line version of the command instead of the dialog box version. Command aliases can be 
created for these commands also, e.g.: 

vi,                     *-view 

Execute the REINIT command to reload the alias file when it was externally edited. 

bricscad-cmdref.chm::/R/Rectang.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/02_00_Bricscad_User_Files.htm
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Using the Customize Dialog to Edit the Alias File 

1. Open the Customize dialog.  
2. Click the Aliases tab on the Customize dialog. 

 

 
3. (option) To create a new alias:  

• Click the Add button. 
The Add Alias dialog box displays: 
 

 
• Click the down arrow at the right hand side of the Command field, then select a 

command. 
You can start typing the command name in the Command field to easily find the 
command in the list.  

• Type the command alias for the command in the Alias field.  

• Click the OK button.  

4. (option) To edit an existing alias:  

file:///C:/Users/Louis/AppData/Local/Temp/298462/02_Defining_your_preferences/02_01_Understanding_the_Customize_Dialog.htm%23Opening_the_Customize_dialog
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• Select the alias in the list.  

• Click the Edit button. 
The Edit Alias dialog box displays: 
 

 
• Type a new alias in the Alias field. 

If the alias already exists you are prompted to overwrite the existing alias.  

• Click the OK button.  

5. (option) To delete an alias:  

• Select the alias in the list.  

• Click the Delete button. 
A Confirm box displays.  

• Click the OK button on the Confirm box to delete the alias.  

6. Click the OK button on the Customize dialog to stop.  

  

NOTE If you use the Customize dialog to edit the alias file, it is not necessary to execute the 
REINIT command. 

 

bricscad-cmdref.chm::/R/ReInit.htm
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User Profile Manager 

Content of a User Profile 

User profiles save many settings that control the drawing environment. Once you start BricsCAD 

using a user profile, it automatically tracks and stores changes that you make to your drawing 
environment. 

• Main Cui file. 

• Current Workspace: BricsCAD has five stanard workspaces: 2D Drafting, 3D Modeling, 
Mechanical, Sheet Metal and BIM. 

• Configuration settings: all system variables which are saved in the Registry ( ) and user 
preferences.  

• Default plot settings. 

• Settings in dialog windows, e.g. search options in the Settings dialog. 

• Project settings 

• Recent paths 

• Status bar settings 

• Properties Bar settings 

• Toolbar and menu configuration 

• Worksets. 

Launch the User Profile Manager 

Do one of the following: 

• When BricsCAD is running: choose User Profile Manager in the Tools menu. 

• From the Windows Start menu, choose All Programs > Bricsys > BricsCAD > User Profile 
Manager. 

• Double click userprofilemanager.exe in the BricsCAD program folder (e.g. C:\Program 
Files\Bricsys\BricsCAD Vx). 

 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/20_Managing_Drawings/02_11_Projects.htm
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In the User Profile Manager dialog: 

• The Current Profile is marked.  

• Create: Creates a new profile, using default settings.  

• Set Current: Sets the selected profile as the current profile, which will be used the next 
time you start BricsCAD.  

• Copy: Click to make a copy of the selected profile.  

• Delete: Click to delete the selected profile.  

• Export... : Click to save the selected profile to a file on your computer, disk, or network. 
The file is saved with an .arg extension.  

• Import... : Click to open a profile that has been saved to .arg file).  

• Start: Starts BricsCAD with the selected user profile.  

• OK: Closes the User Profile Manager dialog  

• Double click a profile in the list of the available profiles to start BricsCAD using this 

profile.  

Creating User Profiles 

To create a new user profile: 

1. Launch the User Profile Manager. 

2. Click the Create button on the User Profile Manager dialog window. 
The Create Profile dialog opens. 
 

 

3. Type a name for the new profile in the Profile name field. 

4. (option) Type a description for the new profile in the Description field. 

5. Click the OK button to create the profile. 

The new profile is added in the available profiles list. 
The new profile is created using default hard-coded values for all settings. 

  

NOTE Use the Copy option to create a new user profile as a copy of an existing profile. 

 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/02_10_User_Profile_Manager.htm%23LaunchUserProfileManager
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Loading a User Profile 

When you start BricsCAD, the user profile that was current when you closed the previous BricsCAD 
session is used. 

If the GETSTARTED system variable is ON, the GET STARTED page of the Welcome dialog box 
displays on startup. Here you can select the user profile you want to use. 

To create a desktop shortcut to launch BricsCAD using a specific user profile, do one of the 
following: 

• Add the /P option to the Target settings of the BricsCAD shortcut. 
To open the shortcut settings dialog: right click the shortcut icon on the desktop and 
choose Properties in the context menu. 
A typical BricsCAD shortcut could be "C:\Program Files\Bricsys\BricsCAD Vx\bricscad.exe" 
/P <UserProfileName> 
 

 

• Launch the User Profile Manager, then either double click a user profile or select a user 
profile and click the Start button. 
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NOTE • The /P option is case insensitive.  

• If you load a user profile when BricsCAD is already running a second instance of 
BricsCAD is launched, at least on condition that the SINGLETON variable is OFF. This 
variable controls whether multiple BricsCAD  sessions can run simultaneously. See 
the Settings dialog for more information about variables and settings. 

• If the user profile in the argument of the /P option does not exist, the user profile is 
created automatically using default hard-coded values for all settings. 

• If the user profile name contains spaces, use double quotes: e.g. /P "background 
white". 

 

Restarting BricsCAD Using a Different User Profile 

1. Choose User Profile Manager in the Tools menu.  
2. Select the user profile you want to start up with.  
3. Click the Set Current button on the User Profile Manager dialog.  
4. Close and restart BricsCAD.  

NOTE If the GETSTARTED system variable is ON, the GET STARTED page of the Welcome dialog 
box displays on startup. Here you can select the user profile you want to use. 

   

Managing User Profiles 

Once you start using user profiles, you may need to copy, rename or delete them. Copying a 
profile is a quick way to create a new profile based on an existing profile. 

  

Copy a User Profile 

1. Launch the User Profile Manager. 

2. Select the user profile you want to copy. 

3. Click the Copy button. 

The Copy Profile dialog displays. 
 

 

4. Type a name for the new profile in the Profile name field. 

5. (option) Type a description for the new profile in the Description field. 

6. Click the OK button to create the profile. 
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Rename a User Profile 

1. Launch the User Profile Manager. 

2. Select the user profile you want to rename. 

3. Click the name of the selected user profile. 

The Profile name field is active now. 
 

 

4. Type a new name in the Profile name field. 

5. Click outside the Profile name field. 

Delete a User Profile 

1. Launch the User Profile Manager. 

2. Select the user profile you want to delete. 

3. Click the Delete button. 

4. Click the Yes button on the confirmation box to delete the profile. 

  

NOTE The current profile cannot be deleted. 

  

Export a User Profile 

1. Launch the User Profile Manager.  
2. Select the profile you want to export in the profile list.  
3. Click the Export button. 

The Save As dialog displays.  
4. Select a folder to save the user profile in.  

5. (option) Edit the name of the profile in the File name field.  
6. Click the Save button. 

The file is saved with an *.arg extension.  

Edit the User Profile Description 

To edit the Description field: 

1. Select the profile you want to edit the description of.  
2. Edit the Description field.  

Import a User Profile 

1. Launch the User Profile Manager.  

2. Click the Import button. 
The Open dialog displays.  

3. Select a user profile file (*.arg).  
4. Click the Open button. 

The Import Profile dialog displays.  
5. (option) Type a different name in the Profile name field.  
6. (option) Edit the profile description.  
7. Click the OK button on the  Import Profile dialog. 

The profile is added to the profile list.  

Import a Profile from Another User 

When you import a user profile of another user all user dependent search paths (e. g.  the local 
root and roamable root folders - see BricsCAD User Files) still refer to the other user, as a result 

the folders cannot be found and error messages such as "Unable to open program parameters file: 

default.pgp" might pop up when you start BricsCAD.  

To correct this problem do the following: 
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1. Open the exported user profile (*.arg) in a text editor such as Notepad.  

2. Replace the user name dependent references with an environment variable.  

On a Windows XP computer replace C:\\Documents and Settings\\username with 
%USERPROFILE%. 

On a Windows Vista or Windows 7 computer replace C:\\Users\\username with %USERPROFILE%. 

Use the Find/Replace procedure to quickly replace all references. 

3. Save the user profile (*.arg) 

4. Import the user profile. 

5. Start BricsCAD using the imported profile. 
The environment variable %USERPROFILE% will be replaced with: 
C:\\Users\\currentusername. 

  

NOTE Environment variables in profiles, using the %<variable_name>% format, are supported 
in V10.3.11. and higher. 
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Workspaces 

Definition 

The Workspace command sets the current workspace and lets you create, modify and save 

workspaces. 

The WsSave command saves the current workspace under a different name, thus creating a new 
workspace. 

  

Workspaces define settings and preferences regarding a specific working environment. 

The following workspaces are available: 

• 2D Drafting  

• 3D Modeling  

• Mechanical  

• Sheet Metal  

• BIM (Building Information Model)  

The name of the workspace is stored in the WSCURRENT system variable of the current User 
Profile. 

If the GETSTARTED system variable is ON, the GET STARTED page of the Welcome dialog box 
displays on startup. Here you can select the user profile you want to use. 

Managing Workspaces 

Workspaces are defined in the Workspace tab page on the Customize dialog. 

  

Do one of the following: 

• Open the Customize dialog, then select the Workspace tab.  

• Right click the Current Workspace field in the Status Bar, then choose Customize 
Workspaces... in the context menu.  
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A workspace definition is composed of: 

• Menus: defines which menus are available.  

• Toolbars: defines which toolbars display by default.  

• Palettes: controls the visibility of various palettes. 

 
Right click a palette then choose an option in the context menu:  

• Show:  

• Hide:  

• Don't change:  



  User Guide 

 130 

• Ribbon: defines the available ribbon tabs.  

• Quad Group Order: defines the order and availability of the Quad command groups.  

• On Switch: defines the system variables and user preferences to be set and the 
commands to be executed when switching to the workspace.  

Setting the Current Workspace 

Do one of the following: 

• Right click the Current Workspace field in the Status Bar, then select a workspace  in 

the context menu. 
 

 
• Choose a workspace in the Workspaces toolbar. 

 

 
• Type wscurrent at the command prompt. 

You are prompted: New value for WSCURRENT, or . for none/<"2d DRAFTING">:  

Type the name of the new current workspace, then press enter.  

NOTES • If the WSAUTOSAVE system variable is On, upon switching to another workspace, 
the toolbar positions of the current workspace are saved in the CUI file. The default 

value for WSAUTOSAVE is ON. 

• It is not recommended to alter the workspace if the name of the user profile refers 
to a workspace. 

  

Creating a Workspace 

1. Right click the Current Workspace field in the Status Bar, then choose Customize 
Workspaces... in the context menu.  

2. Do one of the following:  

• Select Workspaces, then right click and choose Append Workspace in the context 
menu.  

• Select an existing workspace, then right click and choose Insert Workspace in the 
context menu.  

3. Type a name for the new workspace, then click the OK button.  
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When appending a workspace, the new workspace is created below the last existing workspace. 

When inserting a workspace, the new workspace is created above the selected workspace. 

  

 

  

A newly created workspace contains the following items: 

• A standard menu set  

• A standard toolbar set  

• All palettes set to Don't change  

• An empty ribbon  

• A default Quad group order  

• An empty On Switch sequence  

Editing a Workspace 

1. Right click the Current Workspace field in the Status Bar, then choose Customize... in the 
context menu.  

2. Click the Expand button (+)  of the workspace.  

3. Edit the menu set:  

• Change the order: Drag a menu to another location.  

• Delete a menu: select the menu, then right click and choose Remove in the context 
menu.  

• Insert a menu:  

• Right click a menu in the list and choose Insert menu in the context menu. 
The File menu is inserted by default.  

• In the Workspace Menu grid, select the ID field and select the desired menu 
in the list.  
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4. Edit the toolbar set:  

• Change the order: Drag a toolbar to another location.  

• Delete a toolbar: select the toolbar, then right click and choose Remove in the context 
menu.  

• Insert a toolbar:  

• Right click a toolbar in the list, and choose Insert toolbar in the context 
menu. 
The Standard toolbar is inserted by default.  

• In the Workspace Toolbar grid, select the ID field and select the desired 
toolbar in the list.  

5. Edit the visibility of the palettes:  

• Select the palette.  

• Click the Display property in the  Workspace Palette grid, then set the desired 'on 
switch' behavior: Show, Hide or Don't change.  

6. Edit the composition of the ribbon:  

• To add a tab: right click an existing tab, then choose Insert tab in the context menu 
and select the tab in the Select Ribbon Tab dialog.  

• To remove a tab: right click the tab and choose Remove in the context menu.  

• To change the position of a tab: press and hold the left mouse button, then drag the tab 
to the desired place.  

7. Edit the Quad settings:  

• To change the order of the Quad command groups: press and hold the left mouse 
button, then drag a command group to its new position.  

• Right click a Quad command group, then choose Switch off in the context menu to 
remove the command group from the Quad cursor menu.  

• Right click a currently switched off Quad command group then choose Switch on in the 
context menu to add the command group to the Quad cursor menu.  

8. Edit the On Switch procedure: 
To add a command to the On Switch sequence: select the command in the available 
commands pane and drag it to the On Switch node. 
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NOTE See To create a new tool if you want to add a custom tool to the On Switch sequence. 

  

Deleting a Workspace 

1. Right click the Current Workspace field in the Status Bar, then choose Customize 
Workspaces... in the context menu.  

2. Right click the workspace, then choose Delete in the context menu. 
A Confirm dialog box displays: 
 

 
3. Press the Yes button to delete the selected workspace.  

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/02_03_Creating_custom_tools.htm%23Create_a_new_tool
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/01_User_Interface/01_00_The_Bricscad_Application_Window.htm%23Working_with_the_status_bar


  User Guide 

 134 

Importing a Workspace 

The option in the File menu on the Customize dialog box can import workspaces from another CUI 
file into the current main CUI. 

1. Open the Customize dialog. 

2. In the File menu choose Import Workspace(s)...  
The Choose a Customization File dialog displays. 

3. Browse to the folder where the CUI file, you want to import the workspace from, is saved. 

By default BricsCAD saves CUI files in the Support folder of the Roamable Root folder. 
e.g. C:\Users\<user_name>\AppData\Roaming\Bricsys\Bricscad\Vxx\en_US\Support\ 

4. Select the CUI file. 
A dialog box, listing all workspaces in the selected CUI file, displays: 
 

 

5. Select the workspace to import in the list, then click the OK button. 

Press and hold the Ctrl-button to select multiple workspaces. 
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Managing Drawings 

Creating a Drawing 

In BricsCAD you can create new drawings: 

• Using a default template drawing. 

• Starting from scratch. 

• Using a template drawing of your choice. 

• Using a wizard. 

• Double clicking a *.dwt file in a Windows Explorer window. 

Using the Welcome Dialog Box 

When you launch BricsCAD and the value of the GETSTARTED system variable is ON, the GET 
STARTED page of the Welcome dialog box displays. 

Check the Don't show this window again option to suppress the display of the Welcome dialog. 
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On the GET STARTED page, do one of the following: 

• Select a profile in the Set current profile list, then click New Drawing to start BricsCAD 
with a new drawing using the default template of the selected profile.  
Default template drawings in the Profile Presets are: 
  

Profile 
Template 

Imperial Metric 

2D Default-imperial.dwt Default-mm.dwt 

3D Default3D-imperial.dwt Default3D-metric.dwt 

Mechanical Mechanical-imperial.dwt Mechanical-metric.dwt 

Sheet Metal Mechanical-imperial.dwt Mechanical-metric.dwt 

BIM BIM-imperial.dwt BIM-metric.dwt 

• Select a profile in the Set current profile list, then click Start from template to start 
BricsCAD with a new drawing using a template, different from the current default 
template of the selected profile. 
The selected template becomes the default template of the selected profile. 

To create a drawing using a default template drawing 

First method: 

1. Do one of the following:  

• Choose New wizard... in the File menu.  

• Type newwiz in the command window, then press Enter.  

2. On the Create New Drawing dialog choose Start from Default template, then click the Next 
button. 
The drawing is created as a copy of the default template. 

 

 

Second method: 

Do one of the following: 

• Click the QNew tool button ( ) on the Standard toolbar.  

• type qnew in the command bar, then press Enter.  
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The drawing is created as a copy of the default template defined by the BASEFILE system variable. 

If the default template drawing is not specified, the Create New Drawing wizard is launched if the 
STARTUP system variable is ON, otherwise the Select Template dialog displays. 

Setting the Default Template Drawing 

1. Open the Settings dialog.  
2. Under Program Options / Files / Templates select Template (BASEFILE)  
3. Click the Browse button.  

4. On the Choose a File dialog, select a drawing file (*.dwg) or drawing template (*.dwt), 
then click the Open button.  

Creating a Drawing from Scratch 

1. Do one of the following:  

• Choose New wizard... in the File menu.  

• Type newwiz in the command window, then press Enter.  

2. On the Create New Drawing dialog choose Start from Scratch, then click the Next button. 
 

 
3. Choose between either Imperial or Metric default settings. 

 
Click the Finish button to create the drawing.  

  

NOTE Using the above procedure it depends on the status of the BASEFILE and PSTYLEPOLICY 
variables whether CTB (Color table) or STB  (Named plot style table) will be used to set 
up plotter configurations in the newly created drawing. 

 

BASEFILE PSTYLEPOLICY CTB or STB? 

not specified OFF STB 

not specified ON CTB 

specified ON or OFF as defined in the 
template drawing 

  

 

bricscad-sysvar.chm::/00_07_Settings_Manager.htm


  User Guide 

 138 

Setting the Plot Style Policy 

1. Open the Settings dialog.  
2. Under Program Options / Plot and publish select Plot style policy (PSTYLEPOLICY).  
3. Do one of the following:  

• Choose Associate an entity's plot style with its color for Color dependent plot styles.  

• Choose No association between color and plot style for Named plot styles.  

Creating a Drawing Using a Template Drawing 

1. Do one of the following:  

• Choose New wizard... in the File menu.  

• Type newwiz in the command window, then press Enter.  

2. On the Create New Drawing dialog choose Start from template, then click the Next button. 
 

 
3. Do one of the following:  

• Choose a template drawing in the Select a template list. 
By default this is the content of the Template folder in the Local root folder. 
Edit the Template Path variable to set your template folder differently.  

• Click the Browse... button to select a template drawing. 
You can choose between *.dwg and *.dwt file types.  

The drawing is created as a copy of the selected template. 

Creating a Drawing Using the New Command 

1. Do one of the following:  

• Choose New... in the File menu.  

• Type new in the command bar, then press Enter.  

The Select template dialog opens showing the content of the Template folder as defined in the 
Template Path variable. 

2. Select the template drawing, then click the Open button. 

The drawing is created as a copy of the selected template.  
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Setting the Template Path Variable 

1. Open the Settings dialog.  
2. Under Program Options / Files / Templates select Template Path (templatePath)  
3. Click the Browse button.  
4. On the Browse for folder dialog, select a folder , then click the OK button.  

Creating a Drawing Using a Wizard 

1. Do one of the following:  

• Choose New wizard... in the File menu.  

• Type newwiz in the command window, then press Enter.  

2. On the Create New Drawing dialog choose Use a Wizard, then click the Next button. 

 

 
3. Choose between either Imperial or Metric default settings, then click the Next button. 

 
Select the Unit of measurement and the display Precision, then click the Next button. 
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4. Select the Angle of measurement and the display Precision, then click the Next button. 

 

 
5. Choose between Color Dependent plot styles (CTB) or Named plot styles (STB), then click 

the Next button. 
 

 
6. Select the default Color and Linetype. 
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7. Define the Grid, Snap, UCS icon and Marker Blips settings. 

 

 
8. Click the Finish button to create the drawing.  
9. (option) Choose Save As... in the File menu to save the drawing as a template in the 

Templates subfolder of the Local root folder. 

Drawing Explorer 

Commands: EXPLORER, LAYER, LAYERSTATE, LINETYPE, MLSTYLE, MLEADERSTYLE, STYLE, 
DIMSTYLE, TABLESTYLE, EXPUCS, VIEW, VISUALSTYLES, LIGHTLIST, MATERIALS, 

RENDERPRESETS, EXPBLOCKS, XREF, IMAGE, PDF, eTRANSMIT, PAGESETUP, 
SECTIONPLANESETTINGS 

  

The Drawing Explorer window consists a number of sub-windows or panes: 

• Drawings:  

• Open Drawings: a list of all drawings that are currently open.  

• Folders:  your favorite drawing folders  

• Details: the details of the selected drawing or the details of the selected category in a 
drawing, e.g. layers, blocks, images, ...  

• Preview: a preview of the selected drawing, layer, block, view, dimension style, table 
style, XRef,  image or material. 

Use the arrow keys to browse through the items.  

• Editor: to define or edit the properties of Multiline Styles, Multileader Styles, Table 
Styles, Views, Visual Styles, Sunlight settings, Materials, Render Presets and Section 
Planes.  

You can select which panes you want to have open or closed in the View menu. 

BricsCAD remembers the display settings for each category. 
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To Open the Drawing Explorer 

To open the Drawing Explorer window do one of the following: 

• Click the Drawing Explorer tool button ( ) on the Standard toolbar. 
The Drawing Explorer window opens showing the details of the most recently used 
category.  

• Click the Layer, Linetype, Text Style or Dimension Style field in the Status Bar. 

The Drawing Explorer window opens showing the details of the clicked definitions 

category in the current drawing. 
(See Customizing the Status Bar to enable/disable fields in the Status Bar.)  

• Choose a Drawing Explorer  in the Tools menu, then select a category in the flyout. 
The Drawing Explorer window opens showing the details of the selected category. 
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• Type explorer in the command bar, then press Enter. 
The Drawing Explorer window opens showing the details of the most recently used 
category.  

To Control the Drawing Explorer Layout 

• In the View menu, check/uncheck the sub-window you want to open or close. 
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• If you click a settings category in the Drawings sub-window when the Details sub-

window is closed, the Details window is re-opened, showing the content of the selected 
settings category.  

• To close a sub-window,  click the close button ( ) in its title bar.   

• To restore the default layout choose Restore Default Explorer Layout in the Settings 
menu.  

Opening a Drawing 

To open a drawing using the Drawing Explorer do the following 

1. Launch the Drawing Explorer.  
2. In the Drawings > Folders  sub-window browse to the folder of the drawing.  

 

3. Double click the drawing. 
The drawing opens, while the Drawing Explorer window stays open.  

4. (optional) Repeat steps 2 and 3 to open more drawings.  
5. Close the Drawing Explorer.  

  

NOTE When you select a drawing, a preview displays in the Preview  sub-window. 

  



BricsCAD V18  Help 

 

 145 

Adding a Drawing Folder 

1. In the Drawings > Folders  sub-window of the Drawing Explorer main window click the 
 Add local folder... button. 
 
The Browse For Folder window opens.  

2. In the Browse For Folder window do one of the following:  

• To add an existing folder:  select the folder you want to add.  

• To create a new folder: click the Make New folder button.  

3. Click the OK button. 
The folder is added.  

NOTE • Drawings in the subfolders of the selected folder can be opened too. 

• The parent folder(s) of the selected folder is (are) greyed out in the drawing folder 
tree. Drawings in such folders cannot be opened. 

 

To Insert a Block from an Unopened Drawing 

The Block Manager feature of the Drawing Explorer allows to insert blocks in the current drawing 
 from unopened drawings. 

Copy Definitions Between Drawings 

1. Open both the source and the target drawing.  
2. Launch the Drawing Explorer.  
3. In the source drawing select the category you want to copy items from, e.g. Blocks.  

4. (option) In the Details toolbar, click the Icon View button ( )  
5. Select the item(s) you want to copy, e.g. a series of blocks. 

Press and hold the Ctrl key to select multiple items.  
6. Press and hold the left mouse button to drag the selection set to the Open Drawings 

section of the Drawing Explorer.  

7. Release the left mouse button when on the target drawing name. 
The selected items are copied to the target drawing. 
You will be prompted to overwrite items of the same name.  

Merging Layers 

1. Open the Drawing Explorer > Layers dialog window.  
2. Select the layer you want to merge into another layer.  
3. Choose Merge to... in the Edit menu. 

The Merge Layers dialog box displays.  

bricscad-cmdref.chm::/E/Explorer.htm#BlockManager
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/00_02_Drawing_Explorer.htm%23How_to_open_the_drawing_explorer
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4. Select the layer you want to merge to. 

 

 
5. Click the Merge button. 

The content of the first layer is merged to the second layer. 
The first layer is purged from the drawing. 

Drawing Properties 

The Dwgprops command opens the Drawing Properties dialog box, showing the general 

information and user defined properties stored with a drawing.  

Drawing properties include: general information, summary, statistics and user defined custom 
properties.  

Drawing properties can be referenced in a field in multiline text entities or tables. 

To Open the Drawing Properties Dialog 

do one of the following: 

• Choose Drawing Properties... in the File menu.  

• Type dwgprops in the command bar and press Enter.  

 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/10_Drawing_Entities/05_Working_with_Text/10_05_08_Working_with_Fields.htm
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Defining Default Properties 

1. Open the Drawing Properties dialog.  
2. Open the Summary tab page. 

 

 
 

3. Fill out the property fields  
4. Click the OK button.  

Adding Custom Properties 

1. Open the Drawing Properties dialog.  
2. Open the Custom tab page. 

 

 
3. Click the Add button. 

The Custom Property dialog displays. 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/20_2_Drawing_Properties.htm%23OpenDrawingPropertiesDialog
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/20_2_Drawing_Properties.htm%23OpenDrawingPropertiesDialog
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4. Type a name in the Name field. 

The custom property name is listed under Document in the Field dialog.  
5. Type a value in the Value field. 

The value displays in multiline texts where the custom property is inserted as a field. 

Drawing Security Options 

Command 

The Securityoptions command allows to protect your drawings with a password. Password 
protected drawings cannot be opened without entering the password first. 

To Set a Password 

1. Do one of the following:  

• Choose Security Options... in the File | Drawing Utilities menu.  

• Type securityoptions in the command bar, then press Enter.  

The Security options dialog opens: 
 

 

2. Type the password in the Enter Password field.  

3. Choose a crypt provider from the Crypt Provider list. 
 

 
4. Set the Key Length to 40, 48 or 56.  
5. Click the OK button or press Enter. 

The Security options dialog closes. 
The Password dialog opens.  

6. Type the password in the Confirm Password field.  
7. Click the OK button or press Enter. 

The password is defined.  

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/10_Drawing_Entities/05_Working_with_Text/10_05_03_Creating_text.htm%23To_create_multiline_text
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To Remove a Password 

1. Type securityoptions in the command bar, then press Enter. 
The Security options dialog opens.  

2. Empty the Enter Password field.  
3. Click the OK button or press Enter. 

A message box displays to confirm that the password is removed. 
 

 
4. Click the OK button or press Enter  to close the message box. 

Opening and Saving Drawings 

Commands: OPEN, SAVE, SAVEAS, SAVEALL, SAVEFILEFOLDER 

The way BricsCAD opens and saves drawings is controlled through a series of system variables and 
user preferences. 

In the table below the SYSTEM VARIABLES are fully capitalized. 

  

Name Title Description 

ShowFullPathInTitle 

Display full 

path in 
title 

Controls wether the full path of a drawing displays in the 
title bar, or the file name only. 

DrawingPath 
Drawings 

path 

Specifies an additional folder in the file dialog for the Open 
and SaveAs commands. 

On the Windows platform: the fifth folder in the Open File 
dialog's Places bar. 

PlacesBarFolder1 - 
4 

First, 
Second, 
Third and 

Fourth 
 folder 

Sets the folders 1 through 4 in the Places bar of the non-
standard Open File dialog (Windows platform only). Values 

between 0 and 5 are accepted: 0=Desktop, 1=My 
Computer, 2= My Documents, 3= Favorites, 4=Network, 
5=My Recent Documents. 

Tip: Place shortcuts to your favorite drawing folders on 
your desktop or in your Favorites folder. 

 

bricscad-cmdref.chm::/O/Open.htm
bricscad-cmdref.chm::/S/Save.htm
bricscad-cmdref.chm::/S/SaveAs.htm
bricscad-cmdref.chm::/S/SaveAll.htm
bricscad-cmdref.chm::/S/SaveFileFolder.htm
bricscad-cmdref.chm::/O/Open.htm
bricscad-cmdref.chm::/S/SaveAs.htm
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THUMBSIZE 
Thumbnail 
preview 

image size 

Range is 0 - 8; Default = 1 

0 (64 x 64) 

1 (128 x 128) 

2 (256 x 256) 

3 (512 x 512) 

4 (1024 x 1024) 

5 (1440 x 1440) 

6 (1600 x 1600) 

7 (1920 x 1920) 

8 (2560 x 2560) 

INDEXCTL 
Index 
Control 

Determines whether layer and/or spatial indexes are 
created and saved. 

The layer index lists all entities in the drawing and what 
layer they are on. The spatial index stores the location of 
all the entities in 3D space. The indexes are used to load 
Xrefs if demand loading is enabled. If a layer index exists, 

entities on layers which are Off or Frozen are not loaded. If 
a spatial index exists, entities in clipped Xrefs which are 
outside the clipping boundary are not loaded. The demand 

loading of Xrefs is controlled through the XLOADCTL 
system variable). 

Creating indexes slows down the saving of a drawing, but 
increases the speed of Xrefs. Therefore create indexes only 

for drawings that will be used as an external reference. 

0 = No indexes, 1 = Layer index only, 2 = Spatial index 
only, 3 = Layer index and spatial index. 

XLOADCTL 
Xref load 

control 

Controls demand loading of entities in external references. 

If demand loading is turned on you will experience a 
performance increase: 

• When clipping external references which are saved 
with a spatial index (INDEXCTL = 2 or 3), entities in 
the external reference within the clipped area are 

loaded only. If the clipping area is modified, more or 
less entities are loaded from the reference drawing. 

• When freezing layers in external references which are 
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saved with a layer index (INDEXCTL = 1 or 3), entities 

in the external reference on thawed layers are loaded 
only. If xref-dependent layers are thawed more 
entities are loaded. 

0: Demand loading is OFF - The entire external reference is 
loaded. 

1: Demand loading is ON - Referenced drawings are kept 
open and locked. Other users can open such drawings only 

as read-only. 

2: Demand loading is ON - Temporary copies of referenced 
drawings are kept open and locked. Other users can open 
and modify the referenced drawings. 
  

ISAVEBAK 
Increment
al save 
backup 

Controls the creation of a backup file (BAK). Improves the 

speed of incremental saves if switched off, especially for 
large drawings. 

Please notice that in some cases (i.e. a power failure during 
a save), it might be possible drawing data are lost. 

ISAVEPERCENT 
Save 

percent 

This system variable controls how often BricsCAD performs 
a full save. A full save reorganizes all the data in the 
drawing database and creates a compact file. A partial save 
stores all changes a the end of the drawing data base. A 
full save takes longer to be executed than a partial save. If 

ISAVEPERCENT = 0, each save is a full save. The higher 
the value of ISAVEPERCENT, the longer the time between 
two full saves. 

NFILELIST 
Recent File 

List 

Specifies the number of files shown in the Recent Files 
flyout of the File menu. Values between 0 and 20 are 

accepted. Default =10. 

PROXYGRAPHICS 
Proxy 

graphics 

Determines whether images of proxy entities(1) are saved 
in the drawing. If switched off, a bounding box displays 
instead.  

PROXYNOTICE 
Proxy 
notice 

Displays a notice when you open a drawing containing 
proxy entities(1) created by an application that is not 

present. 

PROXYSHOW 
Proxy 
show 

Controls how proxy entities(1) display in a drawing. 

0 = Not displayed, 1 = Graphic images, 2 = Bounding box. 

PROXYWEBSEARCH 
Proxy web 

search 

Determines whether BricsCAD checks for object enablers: 0 
= Never, 1 = If a live Internet connection is present. 

SaveFormat 
Save 
format 

Sets the default dwg version to save a drawing.  

SAVEFILEPATH 
Save file 
path 

Specifies the path and folder where automatic saves and 
temporary files are stored. 

The SaveFileFolder command opens the SAVEFILEPATH 

location in the system file browser. 

SAVETIME 
Save time 

interval 

Sets the interval in minutes for automatic saves. If set to 

zero, automatic saves are turned off. Automatic saves are 
created with a .SV$ extension in the folder defined by the 
SAVEFILEPATH system variable. 

WorspaceSecurity 
Enable 
macros 

Defines whether macros are enabled when loading a VBA-
project. 

 

bricscad-cmdref.chm::/S/SaveFileFolder.htm
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AutosaveChecksOnl

yFirstbitDBMOD 

Ignore all 
but first bit 

of 
DBMOD(2) 
for 
autosave 

If this user preference is switched on, no autosave file will 

be created for files that are viewed only. 

CloseChecksOnlyFir
stBitDBMOD 

Ignore all 
but first bit 

of 
DBMOD(2) 
for close 

If this user preference is switched on, you can view a file, 
then close it without getting a request to save the file. 

(1) Proxy entities are custom entities which are created by an add-on application. If the add-on is 

currently not loaded or not installed, such entities cannot be displayed properly.  

(2) DBMOD: Stores the status of the drawing modification as a bit-code as the sum of the following 
values: 1 = Object database modified, 4 = Database variable modified, 8 = Window modified,  16 
= View modified, 32 = Field modified. 

  

Using the Drag-and-Drop option menu 

1. Select a file in a Windows Explorer dialog, then hold down the right mouse button and 
drag the file onto the drawing area of the BricsCAD application window. 

A context menu displays 

When a drawing file is selected: 

 

  

When another file type is selected: 
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2. Do one of the following: 

• Choose Default by File Extension to  

• open a drawing file (*.DWG, *.DXF or *.DWT) 

• attach a PDF 

• attach a raster image file 

• insert a file as an OLE object (e.g. an Excel spreadsheet) 

• Choose Insert Here to: 

• insert a drawing file (*.DWG, *.DXF or *.DWT) as a block in the current 
drawing. 

• attach a PDF 

• attach a raster image file 

• insert the file as an OLE object 

• Choose Open to open a drawing file (*.DWG, *.DXF or *.DWT). 

• Choose Create Xref to attach a drawing file (*.DWG, *.DXF or *.DWT) as an external 
reference to the current drawing. 

• Choose Create Hyperlink Here to create an hyperlink to  the selected file. 

  

NOTE When multiple files are selected, the files are processed one after the other. 

 

 



  User Guide 

 154 

Getting Drawing Information 

You can retrieve two types of information from a drawing: 

• General information about the drawing. 

• Information about the entities in the drawing 

General drawing information 
Commands: DWGPROPS, SETVAR, STATUS, TIME 

The Dwgprops command opens the Drawing Properties dialog box, showing the general 
information and user defined properties stored with a drawing. 

The Setvar command displays or changes the values of system variables (short for "set 

variables"). 

The Status command reports the status of the drawing: drawing name, the status of the most 
important system variables and the total number of entities in the drawing. 

The Time command reports on time in the drawing: current time, creation time, last update, total 
editing time and user elapsed time. 

Information about Entities 
Commands: STATUS, AREA, MASSPROP, ID, LIST 

The Status command reports the total number of entities in the drawing. 

Using Quick Select you can see the number of entities for each category. 

The Area command finds the area and perimeter (or length) of 2D entities. 

The Massprop command reports the area, perimeter, and other mathematical properties of 3D 
solids and 2D regions (short for "mass properties"). 

The ID command reports the x,y,z coordinates of picked points. 

The List command lists the properties of selected entities. 

bricscad-cmdref.chm::/D/dwgprops.htm
bricscad-cmdref.chm::/S/SetVar.htm
bricscad-cmdref.chm::/S/Status.htm
bricscad-cmdref.chm::/T/Time.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/20_2_Drawing_Properties.htm
bricscad-cmdref.chm::/S/Status.htm
bricscad-cmdref.chm::/A/Area.htm
bricscad-cmdref.chm::/M/massprop.htm
bricscad-cmdref.chm::/I/Id.htm
bricscad-cmdref.chm::/L/List.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/11_Modifying_Entities/01_Selecting_Entities/11_01_03_Using_Quick_Select.htm
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Comparing Drawings 

The DwgCompare command  compares a selected drawing with the current drawing during a 
comparison session. 

The EndCompare command concludes a comparison session. 

The KeepMe command allows to merge the compared drawings visually. 

Comparison System Variables 

Name Title Description 

CMPCLRMISS 
Compare missing entities 
display color 

Sets the color for displaying entities which are 

missing in the other drawing. 

The default color is Red . 

CMPCLRMOD1 
Compare modified entites 

display color 1 

Sets the color for displaying modified entities in 
the current drawing. 

The default color is index color 253. 

CMPCLRMOD2 
Compare modified entities 
display color 2 

Sets the color for displaying modified entities in 
the other drawing. 

The default color is Yellow. 

CMPCLRNEW 
Compare new entities display 
color 

Sets the color for displaying entities which are 
new in the other drawing. 

The default color is Green. 

CMPDIFFLIMIT 
Maximal number of output 
entities 

Sets the limit for entities comparison. The 
comparison will be aborted after reaching the 
difference limit. 

Values between 1 and 10 000 000 are 

accepted.  

  

Executing a Comparison Session 

1. Launch the DWGCOMPARE command. 
You are prompted: CMPDIFFLIMIT = 10000000. Select the file to compare with or  [Limit]: 

2. (option) Choose the Limit option to set a new value for entities comparison. 

3. Press Enter to display File dialog box. 
 

 

bricscad-cmdref.chm::/D/DwgCompare.htm
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4. Select the drawing to be compared with the current drawing, then click the Open button or 

double click the drawing name. 
The differences between the two drawings display using the Compare Display Colors. 
The Compare toolbar displays: 
 

 

5. To check the Diff Type of an entity, do one of the following: 

• If Rollover Tips are active, hover over the entity: 
 

 

• Select the entity and check the Diff type field in the Properties panel. 
 

 

6. Analyze the comparison in the Structure panel. 

7. Merge the compared drawings. 

8. Click the Endcompare tool button ( ) on the Compare toolbar to conclude the comparison 

session. 

Analyzing the Comparison in the Structure Panel 

1. Open the Structure panel. 

2. Load the Default.cst configuration. See Load a Structure configuration file. 

3. Expand the Comparison node. 
Four subnodes display: Missing, Modified (Original), New and Modified (Compared).  
The number of entities in each subnode is indicated between brackets. 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/20_10_Comparing_Drawings.htm%23ComparisonSystemVariables
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/01_User_Interface/01_00_The_Bricscad_Application_Window.htm%23RolloverTips
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/01_User_Interface/00_06_Properties_Bar.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/20_10_Comparing_Drawings.htm%23AnalyseDwgComparison
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/20_10_Comparing_Drawings.htm%23MergeComparedDrawings
bricscad-cmdref.chm::/S/StructurePanel.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/11_Modifying_Entities/01_Selecting_Entities/11_01_04_Structure_Panel.htm%23LoadConfiguration
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4. Click a subnode to select the corresponding entities in the drawing (see also the note 

below).  

5. Expand a subnode, then click an entity to highlight the corresponding entity in the drawing. 
Press and hold the Ctrl-key to select multiple entities. 

6. Right click, then choose Zoom in the context menu to zoom onto the selected entity or 

entities. 

NOTE When selecting entities in the Structure panel, entities are either selected or highlighted 
in the drawing, or tree selection is ignored. See setting the options in the Structure panel. 

 

Merging the Compared Drawings 

1. Missing entities only exist in the current drawing; do one of the following: 

• Select the entities you want to keep, then click the Keep Me tool button ( ) on the 
Compare toolbar. 

• Select the entities you don't want to keep, then click the Delete tool button ( ). 

2. Modified entities exist in both drawings; do the following: 

• In the Modified (Original) node: select the entities you want to keep, then click the Keep 

Me tool button ( ) on the Compare toolbar. 
The corresponding entities in the Modified (Compared) node are removed. 

• In the Modified (Compared) node: select the entities you want to keep, then click the Keep 

Me tool button ( ) on the Compare toolbar. 
The corresponding entities in the Modified (Original) node are removed. 

3. New entities exist in the compared drawing only. Do the following: 

• Select the entities you want to keep, then click the Keep Me tool button ( ) on the 
Compare toolbar. 

• Select the entities you don't want to keep, then click the Delete tool button ( ). 

The merge is complete when the Comparison node in the Structure panel disappears. 

A message displays in the Command bar: No more differences to show. Session is closed 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/11_Modifying_Entities/01_Selecting_Entities/11_01_04_Structure_Panel.htm%23StructurePanelOptions
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Repairing a Drawing 

The Audit command analyzes the integrity of the current drawing and optionally tries to fix errors. 

The Recover command repairs a damaged drawing, then opens the drawing. 

To Analyze the Integrity of the Current Drawing 

Do one of the following:  

• Choose Audit in the File | Drawing Utilities menu.  

• Type audit in the command bar, then press Enter.  

You are prompted: Fix any errors detected? Yes/<No> 

Do one of the following:  

• Choose Yes in the context menu or type Y, then press Enter to analyze the integrity of 
the current drawing and fix the errors detected.  

• Choose No in the context menu or type N, then press Enter to analyze the integrity of 
the current drawing.  

The drawing is analyzed. 

(option) Press F2 to open the Prompt History window in order to read the audit report:  

# objects audited 

Total errors found during audit #, fixed #. 

  

NOTE • Set the AUDITCTL settings variable to 1, to let Audit create an ASCII file describing 
problems and the action taken. This report, with the file extension .adt, is placed in 
the same directory as the current drawing . 

• Use the Recover command to repair the errors that Audit cannot fix. 

 

To Repair a Drawing 

1. Do one of the following:  

• Choose Recover in the File | Drawing Utilities menu.  

• Type recover in the command bar, then press Enter.  

The Open Drawing dialog window displays. 

2. Select the drawing, then press the Open button on the Open Drawing dialog window.  
The drawing is repaired and -  if the repair succeeded - opened.  

3. (option) Press F2 to open the Prompt History window in order to read the recover report. 
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Exporting Drawings 

eTransmit 

Command: ETRANSMIT 

The Etransmit command creates a package of a drawing file and all its dependencies, such as: 
external references, images, font files, plot configuration files, plot style tables and font map files. 

The root drawing and all its dependencies can be copied to a folder are compressed in a ZIP file. 

Optionally you can send the ZIP file attached to an email. 

  

 

Package Your Drawings with eTransmit  

Export to PDF 

Drawing files can be saved as a PDF file, optionally including layers. 

Export to PDF Settings 

Choose PDF Export Options... in the File menu to display the PDF Export settings in the Settings 
dialog. 

  

 

• Pdf embedded fonts: Controls whether True Type Fonts are embedded in the PDF export. 

• Pdf TTF text as geometry: If selected, TTF text is exploded to geometry. 

• Pdf SHX text as geometry: If selected, SHX text is exploded to geometry. 

• Pdf text is searchable: If selected, it is possible to search text strings in the PDF 
document. 

• Pdf simple geometry optimization: Enable simple geometry optimization: e.g. separate 
segments to one polyline, use of Bezier curve control points. 

• Pdf zoom to extents mode: If exporting model space, zoom to extents first, if the current 
model space view is zoomed in. 

• Pdf merge control: Controls the appearance of crossing lines. 
The options are: 

bricscad-cmdref.chm::/E/Etransmit.htm
https://blog.bricsys.com/tutorials/
https://blog.bricsys.com/package-drawings-etransmit/
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Lines Overwrite: The topmost line obscures the line(s) under it. 

Lines Merge: The colors of crossing lines are merged. 

• Pdf layer support: Controls whether layers are included in the PDF export.  
The options are: do not export layers, export layers which are on only, export all layers. 

• Pdf layouts to export: Controls which layouts are exported.  
The options are:  
Active: only the active layout or model space is exported as a single-page pdf. 
All: All layouts, including model space are exported as a multi-page pdf. 

• Pdf papersize override: If on, the papersize as defined in the BricsCAD Print settings is 
overridden. The papersize width and height defined by PdfPaperWidth and PdfPaperHeight 
is used instead. 

• Pdf overridden paper width: Width (in mm) of the PDF paper, if PdfPaperSizeOverride is 
on. 

• Pdf overridden paper height: Height (in mm) of the PDF paper, if PdfPaperSizeOverride is 
on. 

• Export solid hatches: Controls the export of solid hatches. The options are: as bitmap, use 
vectorizer, use PDF paths. 

• Pdf use plotstyles: If on, the plotstyle of the layout controls the color and lineweight in the 
PDF export. 

• Image anti-aliasing: Enables anti-aliasing for images that require upscaling when 
exporting. 

• Image compression: Defines the compression for exported images: None or JPEG. 

• Vector Resolution DPI: Controls the resolution of vector graphics when exporting to PDF. 
Default is 600 DPI. 

• Image DPI: When a raster image is exported, this value controls the minimal resolution for 
the image. 

• Render DPI: Resolution of a rendering when exporting. 

• Hatch to bitmap DPI: Defines the resolution of hatch patterns and gradient fills in DPI (= 
dots per inch). 

Export a Drawing To PDF 

 

Output as PDF  

1. (option) Adjust the Export to PDF settings.  
2. Choose Export... in the File menu. 

The Export Drawing As dialog opens.  
3. In the Save as type: list select Adobe PDF (*.pdf).  

4. Select a folder to save the PDF file.  
5. (option) Type a name in the File name field to replace the default <DRAWING_NAME>.pdf 

name.  
6. Click the Save button to create the PDF. 

https://blog.bricsys.com/category/tutorials/printing-plotting/
https://blog.bricsys.com/output-as-pdf/
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Projects 

Projects are especially useful to manage xrefs and images when exchanging drawings. If external 
references (xrefs) and images are not found in the saved path, the project search paths are used 
to find the external references and images.  

Projects are saved in the registry and contain one or more search paths. 

Opening the Projects Settings 

1. Click the Settings tool button ( ) on the Standard toolbar. 
or 
Choose Settings... in the Settings menu. 
 
The Settings dialog opens. 

2. Go to Program Options > Files > Projects > Project search paths. 

Creating Projects 

To create a project: 

1. Open the Project settings. 

2. Click the Browse button at the right hand side of the Project search paths settings field. 
 

 

 
The Project Settings dialog opens. 
 

 
  

3. To create the first project: 

• Click the New button ( ) on the Project Settings dialog. 
 

 

• Type a name to replace the NewProject1 default name. 

4. To create additional projects. 

5. Click Projects (on top of the projects tree) then click the New button ( ) . 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/02_11_Projects.htm%23Opening_the_Projects_settings
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6. Type a name to replace the NewProject1 default name. 

Adding Search Paths to a Project 

To add a search path to a project: 

1. Open the Project settings. 

2. Select the project in the Projects tree. 

3. Click the Browse button ( ). 
The Browse for folder dialog opens. 
 

 

4. Do one of the following: 

• Select a folder. 

• Select a parent folder, then click the Make New Folder button to create a new folder. 

5. Click the OK button to add the selected folder to the project search paths. 

Changing the Order of the Search Paths 

1. Open the Project settings. 

2. Click the expand button (+) of the project you want to edit. 

3. Select a search path, then click the up ( ) or down ( ) buttons to change the order of 
the search paths. 

Assigning a Project to the Current Drawing 

1. Open the Project settings. 

2. Type the name of an existing project in the Project name settings field (PROJECTNAME 
system variable). 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/02_11_Projects.htm%23Opening_the_Projects_settings
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Drawing Accurately 

 

Snap and Grid  

  

In BricsCAD the following drawing aids are available: 

• Entity Snaps 

• Dynamic dimensions 

• Polar Tracking 

• Entity Snap Tracking 

• Coordinate Input 

• Snap and Grid 

• Drawing Limits 

• Ortho Mode 

• User Coordinate Systems 

• Direct Distance Entry 

Orthogonal Mode 

Orthogonal Mode restricts the movement of the cursor to be parallel to the X-axis or the Y-axis of 
the current coordinate system. For example, with the default 0-degree orientation (angle 0 at the 

"three o'clock" or "east" position), when the Orthogonal Mode setting is enabled, lines are 
restricted to 0 degrees, 90 degrees, 180 degrees, or 270 degrees. As you draw lines, the rubber-
banding line follows either the horizontal or vertical axis, depending on which axis is nearest to the 

cursor: type the length of the line in the command bar, then press Enter. 

  

NOTES • When you enable the Isometric snap style, cursor movement is restricted to 
orthogonal equivalents within the current isometric plane. 

• You can rotate the Orthogonal Mode axes using the Snap Angle setting. 

• Press and hold the Shift key to reverse the Orthogonal Mode setting. 

•  Orthogonal Mode is overruled by entity snaps. 

• Turning on Ortho Mode automatically disables Polar Tracking and vice versa. 

To toggle Orthogonal Mode 

Do one of the following: 

• Click the ORTHO  field in the Status Bar. 

• Press the F8 function key. 

• Press and hold the Shift key. 

• Type ortho in the command bar, then choose the appropriate setting. 

• Set the Orthogonal Mode in the Settings dialog. 

https://blog.bricsys.com/tutorials/
https://blog.bricsys.com/drawing-accurately-part-1/
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/03_03_Entity_Snaps.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/03_11_Dynamic_Dimensions.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/03_05_Polar_Tracking.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/03_01_Coordinate_Input.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/03_02_Snap_and_Grid.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/03_02_Snap_and_Grid.htm%23Setting_the_drawing_limits
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/03_07_User_Coordinate_Systems.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/03_07_User_Coordinate_Systems.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/03_02_Snap_and_Grid.htm%23Using_Isometric_Snap
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/03_02_Snap_and_Grid.htm%23Setting_the_Snap_Angle
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/03_05_Polar_Tracking.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/01_User_Interface/01_00_The_Bricscad_Application_Window.htm%23Working_with_the_status_bar
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Direct Distance Entry 

Direct Distance Entry (DDE) means that you can type the length of lines, polyline segments, circle 
radii and diameters, movement vectors in commands such as Move, Copy and Stretch, etc. in the 
command bar.  

When combined with either Orthogonal Mode or Polar Tracking, Direct Distance Entry is a 

particularly efficient  method  to draw lines of a specified length and direction, and to move or copy 
objects over a specified distance. 

To help you keep track of the position of the cursor it is recommended to set the readout of the 
coordinate field in the Status Bar to Relative. 

To define the Coordinates setting 

Do one of the following: 

• Right click the  then choose Relative in the context menu. 

• Click the Coordinates field in the status bar to cycle the Coordinate setting. The 
sequence is Off, Relative, Absolute. 

• Press the F6 function key or use the Ctrl + I keyboard shortcut to  cycle the Coordinate 
setting. The sequence is Off, Relative, Absolute. 

• Type coords in the command bar, then press Enter. 
Type 2 and press Enter. 

• Open the Settings dialog and expand the Display/Viewing settings sub-category under 
Drafting in the Drawing settings class. 
Set the Coordinates setting to Coordinates in polar form for point, distance and angle 

selection. 

 

Unit Settings 

Commands: UNITS and -UNITS 

The Units command sets units of linear and angular measurements through the Settings dialog 
box. 

The -Units command sets units of linear and angular measurements in the command bar. 

  

The INSUNITS (Insertion Units) system variable defines a drawing units value for automatic scaling 

when inserting blocks or attaching Xrefs. 

Any length, area or volume property can be displayed using the unit(s) preferred by the user. 

The unit defined by INSUNITS is used as the base unit for any requested unit conversions. If 
INSUNITS = 0 (undefined) the PROPUNITS mechanism is disabled because the base drawing unit is 
undefined.  

  

NOTES • When LUNITS = 3 (Engineering) or 4 (Architectural), property values will be 
formatted in imperial notation. 

• Automatic unit conversion during length input can be used when bitcode 1 of 
PROPUNITS (Format length properties) is set. E.g. when INSUNITS is set to "mm", 

entering "2m" in a length property field will result in entering [2000.0000 mm]. 
Entering "1ft" will give [304.8000 mm]. 

  

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/03_05_Polar_Tracking.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/01_User_Interface/01_00_The_Bricscad_Application_Window.htm%23Working_with_the_status_bar
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/01_User_Interface/01_00_The_Bricscad_Application_Window.htm%23Working_with_the_status_bar
bricscad-sysvar.chm::/00_07_Settings_Manager.htm
bricscad-cmdref.chm::/U/Units/Units.htm
bricscad-cmdref.chm::/U/Units/-Units.htm
bricscad-sysvar.chm::/00_07_Settings_Manager.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/12_Blocks_Attributes_External_References/01_Blocks/12_01_02_Inserting_Blocks.htm%23Insunit
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/12_Blocks_Attributes_External_References/01_Blocks/12_01_02_Inserting_Blocks.htm
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Name Title Description 

INSUNITS Insertion Units 

Defines the value of 1 Drawing Unit (DU), which is used for 

automatic scaling when inserting or attaching blocks, images 
or Xrefs. 

When both INSUNITS and PROPUNITS are ON, Length, Area, 
Volume and/or Inertia properties will be formatted with a 
dedicated unit. 

MEASUREMENT Measurement 
Sets drawing units as Imperial or Metric. The MEASUREMENT 
system variable controls whether ANSI or ISO hatch pattern 
and linetype files are used. 

PROPUNITS Property Units 

Defines which property values are automatically formatted 
with a dedicated unit when INSUNITS is not zero. The value 

is stored as a bitcode, using the sum of the values of all 
selected options. 

LUPREC 
Linear Unit 
Precision 

Sets the number of decimal places displayed for linear units. 

AREAPREC Area Precision 

Sets the number of decimal places displayed for areas when 
the Area bit of PROPUNITS is ON. 

If set negative,  the value of LUPREC is used. 

VOLUMEPREC 
Volume 
Precision 

Sets the number of decimal places displayed for volumes 
when the Volume bit of PROPUNITS is ON. 

If set negative,  the value of LUPREC is used. 

LENGTHUNITS Length Units 

Defines a list of units used for displaying lengths when the 
Length bit of PROPUNITS is ON. 

If empty, all lengths display in the current drawing unit, as 

defined by INSUNITS.  

If multiple units are selected, the unit that fits best is used. 

AREAUNITS Area Units 

Defines a list of units used for displaying areas when the 
Area bit of PROPUNITS is ON. 

If empty, all lengths display in the current drawing unit, as 
defined by INSUNITS.  

If multiple units are selected, the unit that fits best is used. 

VOLMEUNITS Volume Units 

Defines a list of units used for displaying volumes when the 
Volume bit of PROPUNITS is ON. 

If empty, all lengths display in the current drawing unit, as 

defined by INSUNITS.  

If multiple units are selected, the unit that fits best is used. 

UNITMODE Unit Mode Specifies how Imperial units display. 

Entering angles 

The AUNITS system variable defines the angular unit type. 

You can enter angles in any of 5 formats: 

• Decimal degrees: 37.456 (AUNITS = 0) 

• Degrees / Minutes / Seconds: 37°27'22" or 37d27'22" (AUNITS = 1) 

• Gradians: 41.6178g (AUNITS = 2) 

• Radians: 0.6537r (AUNITS = 3) 

• Surveyor's Units: N52°32'38"E or N52d32'38"E  (AUNITS = 4) 
Surveyor's units are measured from the North (N) or the South (S) to the East (E) or to 
the West (W). 



  User Guide 

 166 

 

Coordinate Reference System 

Command: GEOGRAPHICLOCATION 

  

A Coordinate System is a set of mathematical rules for specifying how coordinates are to be 
assigned to points. The coordinate system is unrelated to the Earth. A Coordinate Reference 
System (CRS) is a coordinate system related to the Earth through a "Datum". A Geodetic Datum is 
a model of the Earth that specifies a reference surface (Ellipsoid or Spheroid). 

A projected coordinate reference system is the result of the application of a map projection to a 
geographic coordinate reference system. A map projection is a type of coordinate conversion. It 

uses an identified method with specific formulas and a set of parameters specific to that coordinate 
conversion method. 

Coordinates may be changed from one CRS to another through the coordinate operation. Two 
types of coordinate operation may be distinguished: 

• coordinate conversion, where no change of datum is involved and the parameters are 

chosen and thus error free. 

• coordinate transformation, where the target CRS is based on a different datum to the 
source CRS. Transformation parameters are empirically determined and thus subject to 
measurement errors. (Geodetic, Seven paramets, Molodenksy & etc.) 

Geographic datasets are defined in geodatabase.xml that is placed in <User 
folder>\AppData\Roaming\Bricsys\BricsCAD\<RELEASE>\en_US\Support for Windows. The 
content of this file is composed of the 5 sections: 

• CoordinateReferenceSystems 

• Datums 

• Ellipsoids 

• Transformations 

• Locations 

• ProjectionCode 

• Methods 

 

bricscad-cmdref.chm::/G/Geographiclocation.htm
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1. CoordinateReferenceSystems 

This section is the main xml node where all Coordinate Reference Systems are defined. It has 
many sub-nodes called CRS, each xml node must define a unique projected coordinate reference 
system and the necessary projected parameters. 

The supported CRS projection types are described in the ProjectionCode and Methods sections. 

   
CRS node attributes: 
Follow Table 1 of OGP Geomatics Guidance Note No 7, part 2  

Attribute 
name  

Description  Units  

epsg  Unique EPSG database id. Integer  

name  
Human-readable name of CRS, Example: "WGS 84 -- WGS84 - 

World Geodetic System 1984, used in GPS"  
String  

codeSpace  Owner of CRS. It is option.  String  

x, y  
Orientation of projected direction. Possible values: "Westing", 
"Easting", "Southing" and "Northing". Directions MUST be defined.  

String  

xAxis, yAxis  
Orientation of geographic direction. Possible values: "Latitude" and 
"Longitude".  

String  

Greenwich  Greenwich Meridian relation.  Degree  

proj  

Projection method of CRS. Possible values: 

"LL", "LatLon", "LonLat" is a Geodetic Latitude-Longitude. 

"MercA", "Mercator_1SP" is a Mercator (variant A). 
"MercB", "Mercator_2SP" is a Mercator (variant B). 
"MercC" is Mercator (variant C). 
"MercSp" is a Mercator (Spherical). 
"MercPv" is a Popular Visualisation Pseudo Mercator. 
"TMerc" is a Transverse Mercator. 

"TMercSO" is a Transverse Mercator South Orientated. 
"LCC_1SP" is a Lambert Conic Conformal 1SP. 
"LCC_2SP" is a Lambert Conic Conformal 2SP. 
"LCC_2SP_BE" is a Lambert Conic Conformal 2SP Belgium.  

String  

AngleSG  Angle from Rectified to Skew Grid  Degree  

Azimuth  Azimuth of initial line  String  

FE  Easting at false origin, False easting  

Float-Point 

value in CRS 
units  

EC  Easting at projection center  
Float-Point 
value in CRS 
units  

FN  Northing at false origin, False northing  

Float-Point 

value in CRS 
units  

FC  Northing at projection center  
Float-Point 
value in CRS 

units  

LonI  The longitude of the western limit of the first zone of a Transverse Degree  
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Mercator zoned grid system  

Lat  
Latitude of natural origin, Latitude of standard parallel. It depends 
on Projection method.  

Degree  

Lat1  Latitude of 1st standard parallel  Degree  

Lat2  Latitude of 2nd standard parallel  Degree  

LatF  Latitude of false origin  Degree  

LatC  Latitude of projection center  Degree  

Lon  Longitude of natural origin, Longitude of origin  Degree  

LonF  Longitude of false origin  Degree  

LonC  Longitude of projection center  Degree  

SF  Scale factor at natural origin  
Float-Point 
value, unity  

SFIL  Scale factor on initial line  
Float-Point 
value, unity  

SFPSP  Scale factor on pseudo standard parallel  
Float-Point 
value, unity  

W  Zone width in longitude  Degree  

zone  Zoned Grid System  Degree  

units  
Units of conversion result from geographic coordinates to 
projected. Example: "Meter", unit "Degree" means no conversion, 
Geographic Coordinate System  

String  

 

Example: common attributes for all map projections based on EPSG:31468. 

 
    <CRS epsg="31468" codeSpace="OGP" name="DHDN / 3-degree Gauss-Kruger zone 4" 
y="Easting" x="Northing" Greenwich="0" proj="TMerc" Lon="12" Lat="0" SF="1" 
FE="4500000" FN="0" zone="4" units="Meter"> 
 
For each node CRS there should be at least one sub-node Datum that refers via epsg or alias 

attributes to sub-node Datum in the Datums section. The sub-node Datum MUST have the id 
attribute of a unique CRS name. At least one of the epsg code and the alias of Datum must be 
valid. 

Attribute 
name  

Description  Units  

epsg  Unique EPSG database id. Example: "4326"  Integer  

alias  Unique Datum name. Example: "WGS 84"  String  

id  
Unique CRS name: combination of Projected method and Datum. 

Example: "WORLD-MERCATOR". It related to CS-MAP, AutoCAD names.  
String  

pjcode  Indicate code for the coordinate reference system projection method 
types. Corresponded to AutoCAD projection codes. 

Integer  
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For instanse, 3 - Transverse Mercator, 44 - UTM, 45 - Transverse Mercator 

of Snyder formulation and etc. 

Example: there are unique CRS definitions according to Datums inside CRS node: 

 
    <Datum epsg="6314" alias="DHDN/3" id="DHDN/3.Gauss3d-4"  pjcode="3" /> 
    <Datum epsg="6314" alias="DHDN/2" id="DHDN/2.Gauss3d-4"  pjcode="3" /> 
    <Datum epsg="6314" alias="DHDN"   id="DHDN.Gauss3d-4"  pjcode="3" /> 
 

2. Datums 

This section is a main node where all Datums are stored. Datum is a combination of the Earth 
model (Ellipsoid or Spheroid) and the transformation method to model WGS84. A Datum node 
specifies common parameters and contains at leat one inner sub-nodes Datum exactly one sub-
node Ellipsoid. Each inner sub-node Datum should define a unique name within the id attribute 

and may specify transformation parameters to WGS84 model via sub-node Transformation that 

refers via epsg or alias attributes to a sub-node Transformation in the Transformations 
section. 

Attribute 
name  

Description  Units  

alias  Unique id. Example: "DHDN/3". It related to CS-MAP, AutoCAD names.  String  

epsg  Unique EPSG database id. Example: "6314"  Integer  

name  
Human-readable name of Datum, Example: "Deutsches 
Hauptdreiecksnetz"  

String  

codeSpace  Owner of CRS. It is option.  String  

Example: 

 
<Datums> 
    <Datum epsg="6314" codeSpace="OGP" name="Deutsches Hauptdreiecksnetz "> 
        <Datum id="DHDN/3"> 
            <Transformation epsg="1777" alias="DHDN/3_to_WGS84" /> 
        </Datum> 
        <Datum id="DHDN/2" name="Deprecated - Replaced by DHDN/3"> 
            <Transformation epsg="1777" alias="DHDN/2_to_WGS84" /> 
        </Datum> 
        <Datum id="DHDN"   name="Deprecated - Replaced by DHDN/2"> 
           <Transformation epsg="1673" alias="DHDN_to_WGS84" /> 
        </Datum> 
        <Ellipsoid epsg="7004" alias="BESSEL" /> 
    </Datum> 
    â€¦ 
</Datums> 
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3. Ellipsoids 

The Ellipsoids section is the main section where models of the Earth are defined. Each Ellipsoid 
node should define an identification by a unique name (alias) and a semi-major axis (a) and one 
of the following attributes at least: flattering (f), semi-minor axis (b) or eccentricity (e). 

Attribute 
name  

Description  Units  

alias  
Unique id. Example: "WGS84". It related to CS-MAP, 

AutoCAD names.  
String  

epsg  Unique EPSG database id. Example: "7030"  Integer  

name  Human-readable name of Datum, Example: "WGS 84"  String  

codeSpace  Owner of CRS. It is option.  String  

a 
Length of the semi-major axis of the ellipsoid, the radius of 
the equator  

Float-Point value, 
strongly in Meter  

b  
Length of the semi-minor axis of the ellipsoid, the distance 

along the ellipsoid axis between equator and pole  

Float-Point value, 

strongly in Meter  

f Flattening  
Float-Point value, 
unity  

e Eccentricity  
Float-Point value, 
unity  

Example: 

 
<Ellipsoid epsg="7008" alias="CLRK66" name="Clarke 1866, Benoit Ratio" 
a="6378206.4000000004" b="6356583.7999999998"  f="294.9786982139" e="0.0822718542" 
/> 

4. Transformations 

This section is a main node where all transformation methods are defined. Supported 
Transformation methods are described in the ProjectionCode and Methods sections. 

  

Attribute 
name  

Description  Units  

alias  
Unique id. Example: "DHDN_to_WGS84". It related to CS-MAP, AutoCAD 

names.  
String  

epsg  Unique EPSG database id. Example: "1673"  Integer  

codeSpace  Owner of Transformation. It is option.  String  

source Source Datum  String  

target Target Datum  String  

use  

Transformation method. Supported transformations using geocentric 
methods: Geocentric translations, Four/Six/Seven Parameter 

Transformation, Similarity Transformation, Position Vector transformation 
and Coordinate Frame rotation.  

String  

method 
Methods of building of rotation matrix, if applicable, "PVT" is Position 
Vector Transformation, "CFR" is Coordinate Frame Rotation  

String  
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tX  X-axis translation  Meter  

tY  Y-axis translation  Meter  

tZ  Z-axis translation  Meter  

rX  X-axis rotation  Degree  

rY  Y-axis rotation  Degree  

rZ  Z-axis rotation  Degree  

dS  Scale difference  Unity  

xp  Coordinate 1 of evaluation point  Meter  

yp  Coordinate 2 of evaluation point  Meter  

zp  Coordinate 3 of evaluation point  Meter  

dtX  Rate of change of X-axis translation  Unity  

dtY  Rate of change of Y-axis translation  Unity  

dtZ  Rate of change of Z-axis translation  Unity  

drX  Rate of change of X-axis rotation  Unity  

drY  Rate of change of Y-axis rotation  Unity  

drZ  Rate of change of Z-axis rotation  Unity  

ddS  Rate of change of scale difference  Unity  

t0  The reference epoch for time-dependent parameters.  
Float 
point 
value  

fallback  Alias of transformation from target datum to WGS84 datum.  String  

Example: 

 
<Transformation epsg="1679" alias="Pulkovo42/2_to_WGS84" src="Pulkovo42/2" 
trd="WGS84" use="Param7" method="CFR" tx="-40.595" ty="-18.55" tz="-69.339" ds="-
4.299" rx="-2.508" ry="-1.832" rz="2.611" accuracy="9" /> 
 

5. ProjectionCode and Methods 

These sections describe the ProjectionCode and Methods that are mapped to AutoCAD 
definitions of projections and transformations types. They are used to store the definitions in an 
XML file of coordinate reference system definition inside the AcDbGeoData object that represents 
a geographic location. 
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Parametric Constraints 

 

Transform a smartphone into a tablet - Using 2D Dimensional constraints  

  

Parametric constraints are used to maintain relationships and control dimensions of 2D geometry. 

There are two types of constraints: 

• Geometrical constraints control relationships between entities. 

• Dimensional  constraints are used to control the dimensions of an entity, such as 
length, angle, radius or diameter. 

In the example below: 

• The width and opening angle are controlled by dimensional constraints. 

• Coincident geometrical constraints ( ) are applied to the endpoints of the arc and the 
polyline and to the center point of the arc and the polyline vertex. 

• The polyline segments have an equal ( ) geometrical constraint. 

• One segment of the polyline has a horizontal ( ) geometrical constraint. 

• The polyline vertex has a fix ( ) geometrical constraint. 

 
  

Parametric constraints allow to: 

• Maintain geometric design intent. 

• Make multiple versions of a design by applying different values to dimensional 
constrains. 

https://blog.bricsys.com/tutorials/
https://blog.bricsys.com/transform-smartphone-tablet/
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Two versions of the same fully constrained drawing representing a roundabout 

  

  

NOTE It is recommended to first apply geometric constraints, then dimensional constraints. 

  

When using constraints a drawing can be in one of three states: 

• Unconstrained: no entities are constrained. The drawing can be modified using 

modification commands and procedures. 

• Underconstrained: some entities are constrained. It might be impossible to apply some 
changes using modification commands and procedures. 

• Fully constrained: all possible and relevant geometric and dimensional constraints are 
applied to the design geometry. The drawing can be modified only by changing the 
values of the dimensional constraints. 
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Commands and toolbars 

2D parametric constraints tools sit on the 2D Constraints toolbar: 

  

 

  

Tools to control the display of constraintbars and geometrical constraints sit on two flyout toolbars: 

Dimensional Constraint: 

 

and Geometric Constraint: 

 

  

  

Command Icon Description 

Geometric Constraints 

DcDisplay 

 

Allows to set dimensional constraints to be displayed or hidden. 

  
 

Shows all dimensional constraints. 

  
 

Hides all dimensional constraints. 

GeomConstraint   
Applies geometric relationships between entities and/or valid 
constraint points on entities. 

GcFix 

 

Constrains points and entities at a fixed position. 

GcCoincident 

 

Applies a coincident geometrical constraint to two points or constrains 

a point to an entity. 

GcConcentric 

 

Constrains the center points of circles, arcs, ellipses or elliptical arcs to 

coincide. 

GcCollinear 

 

Forces lines or polyline segments to be collinear. 

GcParallel 

 

Forces two lines or linear polyline segments to be parallel to each 
other. 

GcPerpendicular 

 

Constrains two lines or polyline segments to lie perpendicularly to each 
other. 

GcTangent  

 

Constrains two entities to maintain a point of tangency to each other 
or their extensions. 

The following entities are accepted: lines, polyline segments, circles, 
arcs, ellipses or elliptical arcs. 

GcHorizontal 

 

Constrains lines, linear polyline segments or pairs of points to lie 
parallel to the X-axis of the current coordinate system. 

GcVertical 

 

Constrains lines, linear polyline segments or pairs of points to lie 
parallel to the Y-axis of the current coordinate system. 

GcSmooth 

 

Forces a spline to maintain fluid geometric continuity with another 
spline, line, arc or polyline. 

bricscad-cmdref.chm::/D/DcDisplay.htm
bricscad-cmdref.chm::/G/GeomConstraint.htm
bricscad-cmdref.chm::/G/GcFix.htm
bricscad-cmdref.chm::/G/GcCoincident.htm
bricscad-cmdref.chm::/G/GcConcentric_.htm
bricscad-cmdref.chm::/G/GcCollinear.htm
bricscad-cmdref.chm::/G/GcParallel_.htm
bricscad-cmdref.chm::/G/GcPerpendicular.htm
bricscad-cmdref.chm::/G/GcTangent.htm
bricscad-cmdref.chm::/G/GcHorizontal.htm
bricscad-cmdref.chm::/G/GcVertical.htm
bricscad-cmdref.chm::/G/GcSmooth.htm
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GcSymmetric 

 

Constrains two entities or points to lie symmetrically with respect to a 

selected line. 

GcEqual  

 

Constrains arcs and circles to the same radius, or lines and polyline 
segments to the same length. 

Dimensional Constraints 

ConstraintBar 

 

Controls the display of the constraint bar of entities. 

Constraint bars are always hidden when opening a drawing. 

  
 

Shows all constraintbars. 

  
 

Hides all constraintbars. 

Dimconstraint   

Applies a dimensional constraint to an entity or between constraint 
points on entities. 

Converts associative dimensions to dynamic dimensions. 

DcHorizontal 

 

Constrains the horizontal distance (X-distance) between two points 
with respect to the current coordinate system. 

DcVertical 

 

Constrains the vertical distance (Y-distance) between two points with 
respect to the current coordinate system. 

DcLinear 

 

Constrains the horizontal distance (X-distance) or vertical  distance (Y-
distance) between two points with respect to the current coordinate 
system. 

DcAligned 

 

Constrains the distance between two points or the length of a line or 
polyline segment. 

DcRadius 

 

Constrains the radius of a circle, an arc or an arc polyline segment. 

DcDiameter 

 

Constrains the diameter of a circle, an arc or an arc polyline segment. 

DcAngular 

 

Constrains the angle between two lines or linear polyline segments; 
the total angle of an arc or an arc polyline segment; or the angle 
between three points on entities. 

DcConvert  

 

Converts an associative dimension to a dimensional constraint. 

  

Delconstraint 

 

Removes all dimensional and geometrical constraints from an entity. 

  

  

NOTE The PARAMETERCOPYMODE system variable controls copying of constraints and related 
parameters when entities are copied. 

0: Do not copy 2D constraints. 

1: Replace all expressions with constants. 

2: Use existing parameters; if a parameter is missing, replace it with a constant. 

3: Use existing parameters; create a new parameter if a parameter is missing. 

4:  Use existing parameters; create a new parameter if a parameter is missing, or has a 
different value. 

 

bricscad-cmdref.chm::/G/GcSymmetric.htm
bricscad-cmdref.chm::/G/GcEqual.htm
bricscad-cmdref.chm::/C/ConstraintBar.htm
bricscad-cmdref.chm::/D/DimConstraint.htm
bricscad-cmdref.chm::/D/DcHorizontal.htm
bricscad-cmdref.chm::/D/DcVertical.htm
bricscad-cmdref.chm::/D/DcLinear.htm
bricscad-cmdref.chm::/D/DcAligned.htm
bricscad-cmdref.chm::/D/DcRadius.htm
bricscad-cmdref.chm::/D/DcDiameter.htm
bricscad-cmdref.chm::/D/DcAngular.htm
bricscad-cmdref.chm::/D/DcConvert.htm
bricscad-cmdref.chm::/D/DelConstraint.htm
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Using Dimensional Constraints 

Commands: DIMCONSTRAINT, DCALIGNED, DCANGULAR, DCCONVERT, DCDIAMETER, 
DCDISPLAY, DCHORIZONTAL, DCLINEAR, DCRADIUS, DCVERTICAL, DELCONSTRAINT 

  

The dimensions of the geometry can be controlled by dimensional constraints: 

• Horizontal distance between points (1).  

• Vertical distance between points (2).  

• Distance between points or the length of lines and polyline segments (3).  

• Radius of arcs, circles and arc polyline segments (4).  

• Diameter of arcs, circles and arc polyline segments (5).  

• Angle between entities or between points and entities (6).  

 

  
  

NOTE Dimensional constraints are created using the 
current dimension style. 

  

To Edit Dimensional Constraints 

Dimensional constraints can be edited: 

• using the DDEDIT command 

• in the Properties bar 

• in the Mechanical Browser 

To edit dimensional constraints in the Properties bar. 

1. Select the dimensional constraint. 
The properties of the entity display in the Properties bar.  

2. Type a new value or expression in the Expression field, then press Enter. 
The readout of the Value field changes accordingly.  

bricscad-cmdref.chm::/D/DimConstraint.htm
bricscad-cmdref.chm::/D/DcAligned.htm
bricscad-cmdref.chm::/D/DcAngular.htm
bricscad-cmdref.chm::/D/DcConvert.htm
bricscad-cmdref.chm::/D/DcDiameter.htm
bricscad-cmdref.chm::/D/DcDisplay.htm
bricscad-cmdref.chm::/D/DcHorizontal.htm
bricscad-cmdref.chm::/D/DcLinear.htm
bricscad-cmdref.chm::/D/DcRadius.htm
bricscad-cmdref.chm::/D/DcVertical.htm
bricscad-cmdref.chm::/D/DelConstraint.htm
file:///D:/BricsCAD%20Training/manuals/10_Drawing_Entities/06_Working_with_Dimensions/10_06_03_Working_with_dimension_styles.htm%23To_set_a_dimension_style_current
bricscad-cmdref.chm::/D/Ddedit.htm
file:///D:/BricsCAD%20Training/manuals/01_User_Interface/00_06_Properties_Bar.htm
file:///D:/BricsCAD%20Training/manuals/10_Drawing_Entities/03_Drawing_Solids/Mechanical/Mechanical_Browser.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/03_01_02_Using_Dimensional_Constraints.htm%23Expressions
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3. (option) Edit the Name field.  
4. (option) Edit the Description field.  
5. (option) Edit the Text rotation field.  

6. Press the  Esc key to unselect.  

  

NOTE Select multiple dimensional constraints simultaneously to 
set their value equally. 

  

To edit dimensional constraints in the Mechanical Browser: 

1. If not already open, open the Mechanical Browser.  

 

2. Select a parameter. 
The properties the selected parameter display in bottom part of the Mechanical Browser.  

3. (option) Select the Name field, then type a new name.  
4. (option) Select the Expression field, then type a new value or expression.  

5. (option) Select the Description field, then type a new description.  
6. (option) Set the Exposed field, which specifies whether the parameter is exposed when the 

drawing is inserted  in another drawing using BmInsert.  

file:///D:/BricsCAD%20Training/manuals/10_Drawing_Entities/03_Drawing_Solids/Mechanical/Mechanical_Browser.htm
bricscad-cmdref.chm::/Mechanical/BmInsert.htm
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The options are: 

• Auto: the parameter is exposed only if it does not depend on other parameters.  

• ON = the parameter  is always exposed. 

• OFF = the parameter is never exposed. 

7. (option) Set the Units property: Undefined, 1-dimensional (linear), 2-dimensional (planar) 
or 3-dimensiona (volume)l. 

 Select the field, then click the down-arrow button and choose an option.  

To edit a single dimensional constraint: 

Double click the dimensional constraint. 

You are prompted: _ddedit 

The Edit Text dialog box displays.  

 

Type a new value in the Text field, then press Enter or click the OK button. 
The new value is applied and the geometry is rebuild accordingly.  

To edit multiple dimensional constraints: 

1. Type ddedit or ed in the command bar, then press Enter. 
You are prompted: Select entity to modify:  

2. Click the a dimensional constraint. 
The Edit Text dialog box displays.  

 

2. Type a new value in the Text field, then press Enter or click the OK button.  
3. (option) Repeat steps 2 and 3 to edit more dimensional constraints.  
4. Press Enter or right click to stop editing dimensional constraints. 

All edited dimensional constraints are updated simultaneously. 
The geometry is rebuild accordingly.  
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To Set the Visibility of Dimensional Constraints 

Tools to control the display of dimensional constraints sit on the Dimensional Constraint toolbar. 

Dimensional constraints are hidden when a drawing is closed and reopened. 

To set the display of dimensional constraints of a selection of entities 

1. Do one of the following: 

Click the Show/Hide Dimensional Constraint tool button ( ) on the 2D Constraints or 
Dimensional Constraint toolbar. 

Choose Show/Hide Dimensional Constraint in the Parametric menu. 

Type dcdisplay in the command bar. 

You are prompted: Select Entities: 

2. Select the entities, then right click or press Enter. 

BricsCAD reports the number of selected entities. 

You are prompted: Enter an option [Show/Hide] <Show>: 
 
A prompt menu displays: 
 

 

3. Do one of the following: 

Press Enter to display the dimensional constraints of the selected entities. 

Choose Hide or Show in the context menu. 

Type H or S in the command bar, then press Enter. 

 

To set the visibility of the dimensional constraints of all entities 

Do one of the following: 

• Click the Show All tool button ( ) on the Dimensional Constraint toolbar to display the 

dimensional constraints of all entities. 

• Click the Hide All tool button ( ) on the Dimensional Constraint toolbar to hide the 
dimensional constraints of all entities. 

NOTE The DYNCONSTRAINTMODE system variable controls the visibility of hidden dimensional 
constraints when selecting entities: 

• ON: Display dimensional constraints when entities are selected. 

• OFF: Dimensional constraints remain hidden when entities are selected. 

  

The DYNCONSTRAINTMODE system variable controls the visibility of hidden dimensional 
constraints when the constrained entity is selected. When hovering over an entity with a 
dimensional constraint, the blue constraint glyph ( ) displays if the SELECTIONPREVIEW system 
variable is set to 1 or 3 

bricscad-sysvar.chm::/00_07_Settings_Manager.htm
bricscad-sysvar.chm::/00_07_Settings_Manager.htm
file:///D:/BricsCAD%20Training/manuals/11_Modifying_Entities/01_Selecting_Entities/11_01_00_Selection_Settings.htm%23SELECTIONPREVIEW
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Using expressions to define dimensional constraints 

Each dimensional constraint is named automatically upon its creation. 

  

The naming is as follows: 

distance: d1, d2, d3, ... 

radius: rad1, rad2, rad3, ... 

diameter: dia1, dia2, dia3, .. 

angular: ang1, ang2, ang3, .. 

  

The name of a constraint can be used as a parameter in a mathematical expression to define 
another dimensional constraint. 

The dimensions of the bracket below are controlled through the rad1 radius, d1 distance and ang1 

angular dimensional constraints. 

The radius of the hole (rad2) and the length of the second leg (d2) are defined by expressions. 

Geometrical constraints force the width of the second leg and the hole in it to be equal to the first 
leg. 

  

 

  

Creating a New Parameter 

1. Select either the part name or Parameters in the Mechanical Browser, then right click. 
A context menu displays.  

2. Select Add new parameter in the context menu. 
A new parameter is created.  

3. Edit the properties of the new parameter. 
 

 



BricsCAD V18  Help 

 

 181 

  

NOTES • The constants Pi and e can be used in expressions. 

• The CLEANUNUSEDVARIABLES command purges parameters that are not used in 
constraint expressions or linked to dimensions. 

 

Using Operators in Expressions 

The following operators can be used in expressions: 

  

Operator Description 

+ Addition 

- Subtraction or Negative 

* Multiplication 

/ Division 

^ Exponentiation 

% Modulo or Remainder operator 

The expression "5 % 2" would evaluate to 1, because 5 divided by 2 leaves a quotient 
of 2 and a remainder of 1 . 

  

Expressions are evaluated according to the standard mathematical rules of precedence: 

1. Expressions within brackets; innermost sets first.  
2. Standard operations order:    

1. exponent  

2. multiplication and division  
3. addition and subtraction  

3. Operators of equal precedence from left to right.  

bricscad-cmdref.chm::/C/CleanUnusedVariables.htm
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Using Functions in Expressions 

The following functions can be used in expressions: 

  

Function Syntax 

Cosine cos(expression) 

Sine sin(expression) 

Tangent tan(expression) 

Arc cosine acos(expression) 

Arc sine asin(expression) 

Arc 

tangent 

atan(expression) 

Hyperbolic 

cosine 

cosh(expression) 

Hyperbolic 

sine 

sinh(expression) 

Hyperbolic 
tangent 

tanh(expression) 

Arc 
hyperbolic 
cosine 

acosh(expression) 

Arc 
hyperbolic 
sine 

asinh(expression) 

Arc 
hyperbolic 
tangent 

atanh(expression) 

Square 
root 

sqrt(expression) 

Signum 
function (-

1,0,1) 

sign(expression) 

Round to 

nearest 
integer 

round(expression) 

Truncate 
decimal 

trunc(expression) 

Round 
down 

floor(expression) 

Round up ceil(expression) 

Absolute 
value 

abs(expression) 

Largest 
element in 
array 

max(expression1;expression2) 1 

Smallest 
element in 
array 

min(expression1;expression2) 1 

Degrees 

to radians 

d2r(expression) 

Radians to 
degrees 

r2d(expression) 
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Logarithm, 

base e 

ln(expression) 

Logarithm, 
base 

10 log(expression) 

Exponent, 
base e 

exp(expression) 

Exponent, 
base 10 

exp10(expression) 

Power 
function 

pow(expression1;expression2) 1 

Random 
decimal, 
0-1 

Random 

  

(1) Use the list separator character as defined on your system: , (comma) or ; (semicolon). 
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Using Geometric Constraints 

Commands:  GEOMCONSTRAINT, GCCOINCIDENT, GCCOLLINEAR, GCCONCENTRIC, GCCENTER, 
GCEQUAL, GCFIX, GCHORIZONTAL, GCPARALLEL, GCPERPENDICULAR, GCSMOOTH, 
GCSYMMETRIC, GCTANGENT, GCVERTICAL 

  

A geometric constraint is a non-numerical relationship between the parts of a geometric figure.  

Geometric constraints: 

• associate geometric entities together two by two (coincident, concentric, collinear, 
parallel, perpendicular, tangent, smooth, symmetric, equal)  

• specify a fixed angle (horizontal, vertical)  

• specify a fixed location (fix)  

When a geometric constrained is applied to an entity: 

• the position of the entity is adjusted according to the applied constraint.  

• an icon displays next to the entity, to indicate the applied constraint. If multiple 
geometric constraints are applied, the icons are joined to a constraint bar.  

• If the SELECTIONPREVIEW system variable is set to 1 or 3, a blue constraint glyph ( ) 
displays next to the cursor when you move the cursor over entities that have 

constraints applied to them.  

 

In the image below the endpoints of the three lines and the arc are joined by coincident 
constraints. The midpoint of the circle and the arc are made concentric. Two lines are forced to be 

tangent to the arc. One line has a vertical constraint (= parallel to the Y-axis of the current 
coordinate system), one line has a horizontal constraint (= parallel to the X-axis of the current 
coordinate system) 

 

  

bricscad-cmdref.chm::/G/GeomConstraint.htm
bricscad-cmdref.chm::/G/GcCoincident.htm
bricscad-cmdref.chm::/G/GcCollinear.htm
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bricscad-cmdref.chm::/G/GCE.htm
bricscad-cmdref.chm::/G/GcEqual.htm
bricscad-cmdref.chm::/G/GcFix.htm
bricscad-cmdref.chm::/G/GcHorizontal.htm
bricscad-cmdref.chm::/G/GcParallel.htm
bricscad-cmdref.chm::/G/GcPerpendicular.htm
bricscad-cmdref.chm::/G/GcSmooth.htm
bricscad-cmdref.chm::/G/GcSymmetric.htm
bricscad-cmdref.chm::/G/GcTangent.htm
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To Set the Display of Constraints Bars 

Tools to control the display of constraintbars sit on the Geometric Constraint toolbar. 

Constraint bars are hidden when a drawing is closed and reopened. 

To set the display of constraint bars of a selection of entities 

1. Do one of the following:  

Click the Show/Hide Geometric Constraint tool button ( ) on the 2D Constraints or 
Geometric Constraint toolbar. 

Choose Show/Hide Geometric Constraint in the Parametric menu. 

Type constraintbar in the command bar. 

You are prompted: Select Entities. 

2. Select the entities, then right click or press Enter. 
BricsCAD reports the number of selected entities. 
You are prompted: Select option for constraints [Show/Hide/Reset] <Show>: 
 

A prompt menu displays: 
 

 
3. Do one of the following:  

• Press Enter to display the constraint bar of the selected entities.  

• Choose Hide or Show in the context menu.  

• Type H or S in the command bar, then press Enter.  

To set the display of constraint bars of all entities 

Do one of the following: 

• Click the Show All tool button ( ) on the Geometric Constraint toolbar to display all 
constraint bars. 

• Click the Hide All tool button ( ) on the toolbar Geometric Constraint to hide all 
constraint bars. 

  

NOTE The value of the CONSTRAINTBARDISPLAY system variable controls the visibility of 
geometric constraints: 

• 1: Display constraint bars when geometrical constraints are added. 

• 2: Display hidden dimensional constraints when the constrained entities are 
selected. 

 

bricscad-sysvar.chm::/00_07_Settings_Manager.htm
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To Control the Position of a Constraints Bars 

By default constraint glyph bars are created close to the midpoint of the entity and are kept at that 
relative position when the entity position changes. You can drag the constraint bar to a different 
location. This new relative position is then maintained until the Reset option of the 
CONSTRAINTBAR command restores the default position of the constraint bar. 

To relocate a constraint bar: 

1. Place the cursor on the constraint bar.  
2. Press and hold the left mouse button to move the constraint bar.  
3. Release the left mouse button at the desired location.  

To restore the default position of the constraint bars: 

1. Do one of the following:  

Click the Show/Hide Geometric Constraint tool button ( ) on the 2D Constraints or 
Geometric Constraint toolbar. 

Choose Show/Hide Geometric Constraint in the Parametric menu. 

Type constraintbar in the command bar. 

You are prompted: Select Entities. 

2. Select the entities, then right click or press Enter. 
BricsCAD reports the number of selected entities. 

You are prompted: Select option for constraints [Show/Hide/Reset] <Show>: 
 
A prompt menu displays: 

 

 
3. Do one of the following:  

• Choose Reset in the context menu.  

• Type R in the command bar, then press Enter.  

bricscad-cmdref.chm::/C/ConstraintBar.htm
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Working with the Constraints Bar 

Using the  constraint bar you can: 

• Control a constraint. 
 
Move the cursor over a constraint icon. 

 
A tooltip displays, indicating the constraint type (1) 
The associated entity highlights (2) 
The corresponding icon on the constraint bar of the associated entity highlights (3) 
 
 

 
• Delete a constraint. 

 
Move the cursor over the constraint icon, then right click. 
Click Delete. 
The constraint is deleted and the icon is removed from this constraint bar and from the 

constraint bar of the corresponding entity. 
 

 
• Hide the constraint bar of an entity. 

 

Move the cursor of the constraint bar, then click the Close button. 
 

 

Deleting Constraints 

To delete a single constraint: right click the constraint icon, then click the Delete button. 

To delete all constraints from a selection set: 

1. Click the Delete 2D Constraints icon ( ) on the 2D Constraints toolbar. 
You are prompted: Select entities to delete all constraints:  

2. Select the entities you want to delete the constraints from.  
3. Right click to stop selecting entities and delete all constraints from the selection set.  

file:///D:/BricsCAD%20Training/manuals/11_Modifying_Entities/01_Selecting_Entities/11_01_01_Selection_Methods.htm
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Using Fix Constraints 

A fix geometric constraint ( ) forces a point or an entity to a fixed location.  

• If a fix geometric constraint is applied to a line or a polyline segment, the angle of the 
line or polyline segment is fixed. The endpoints can still be moved.  

• If you fix an arc or a circle, the center point is fixed too.  

NOTE It is recommended to apply a fix constraint to important geometric features in your 
design. This prevents the geometry from moving unexpectedly when you edit the design. 

  

Using Coincident Constraints 

A coincident geometric constraint can be applied to two points or to a point and an entity. The 

endpoints of lines, polylines, splines, rays and arcs (circular and elliptical) and the center point of 
circles, ellipses and arcs (circular and elliptical) are accepted. These points can be made coincident 
(= to lie on the entity or on the extension of the entity) with a line, a polyline segment, a circle or 
an arc  (circular and elliptical). 

  

 

Coincident constraints between the endpoint of a line and two circles 

  

If the endpoints or center points of entities already coincide, the Autoconstraint option of the 
GcCoincident command automatically applies coincident constraints to such points. 

To apply a coincident constraint between a point and an entity: 

1. Click the Coincident tool button ( ) on the 2D Constraints toolbar. 
You are prompted: Select first point or [Entity/Autoconstrain] <Entity>: 
 

A prompt menu displays: 
 

 
2. Do one of the following:  

• Press Enter.  

• Choose Entity in the prompt menu.  

You are prompted: Select an entity: 

3. Select the entity. 

The entity highlights. 
You are prompted: Select point or [Multiple]:  
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4. Snap to the endpoint of an entity or the center point of a circle or an arc. 

The selected point is forced to lie on the selected entity (or its extension).  

NOTE If you choose Multiple in step 3, you can 
select multiple points. 

  

Usage of a coincident constraint between a point and an entity 

 

By applying coincident constraints between the pentagon vertices and the circle, and equal 

constraints between one side and the four other sides, the circle radius defines the size of the 
pentagon. 

  

  

 

Coincident constraints between the endpoints of the tangent lines and the circles prevent the 
tangent lines to extend beyond the tangent points. 
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Coincident constraints are used to: 

- force the endpoints of the red line to lie on the bold lines;  

- force the midpoint of the red line to lie on the dash-dot line. 

The bold lines and the dash-dot line have a perpendicular constraint with the red line. 

As a result the dash dot line will always lie in the middle of the two bold lines. 

  

Using Horizontal and Vertical Constraints 

Horizontal and vertical geometric constraints force two points, a line or a polyline segment to be 

parallel to the X-axis (horizontal) or the Y-axis (vertical) of the current coordinate system. 

Therefore these constraints can be used to keep lines at a fixed angle, rather than only horizontal 
or vertical. 

To Constrain a Line to a Fixed Angle 

1. Align the X-axis of the coordinate system to the desired angle.  

• Type UCS in the command bar, then press Enter.  

• Choose Z in the prompt menu or type Z, then press Enter.  

• Type the angle, then press Enter.  

2. Click the Horizontal tool button ( ) on the 2D Constraints toolbar. 
You are prompted: Select an entity or [2Points] <2Points>:  

3. Click the line or polyline segment. 
The selected entity is constrained to be parallel to the X-axis of the current UCS.  

4. (option) Restore the WCS: Type UCS in the command bar, then press Enter twice.  

NOTE Use the Vertical tool in the above procedure to constrain entities to be parallel to the Y-
axis of the current UCS. 
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Dynamic Dimensions 

Dynamic dimensions provide an interface at the cursor position to specify the length and angle of 
the linear entity being created or grip-edited. As such dynamic dimensions help you to focus on the 
drawing area.  

The behavior and appearance of dynamic dimensions is controlled through a series of system 
variables and user preferences. 

  

 

  

Defining Dynamic Dimensions 

1. Right click the DYNMODE field in the Status Bar, then choose Settings in the context 
menu.  

The Dynamic input settings in the Settings dialog display: 

 

2. Define the DYNMODE system variable, to switch the display of dynamic dimensions and/or 
dynamic input on/off. 

Please notice that dynamic input at the pointer is not implemented yet.  
3. Define the DYNDIGRIP system variable, to select the dynamic dimension types to be 

displayed. 
Distance fields have a blue background; angle fields have a green background.  

https://blog.bricsys.com/tutorials/
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/01_User_Interface/01_00_The_Bricscad_Application_Window.htm%23Working_with_the_status_bar
bricscad-sysvar.chm::/00_07_Settings_Manager.htm
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• Resulting length: total length of the line or polyline segment  

 

• Extended length: incremental length of the line  

 

• Absolute angle: angle relative to the X-axis of the current UCS  
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• Relative angle: angle relative to the original angle of the linear entity  

 

• Arc radius: radius of arcs and circles  

 

5. Define the DYNDIVIS system variable to choose the number of dynamic dimensions that 
display simultaneously.  

• Only the first dynamic dimension (DYNDIVIS=0): hit the TAB key to display and edit 
 the next dynamic dimension, as defined by the DYNDIGRIP system variable.  

• Only the first two dynamic dimension (DYNDIVIS=1): hit the TAB key to edit the next 

dynamic dimension, as defined by the DYNDIGRIP system variable and display the next 
plus one.  

• All dynamic dimensions as defined by DYNDIGRIP (DYNDIVIS=2): hit the TAB key to 
edit the next dynamic dimension  

6. Set the dynamic dimensions user preferences to define the appearance (color, linetype and 
position) of dynamic dimensions.  

NOTE If bitcode 16 (= format dynamic dimensions) of the PROPUNITS system variable is set, 
dynamic dimensions are formatted using a dedicated unit. 
  

 

Automatic unit conversion during length input can be used when bitcode 1 of PROPUNITS 
(Format length properties) is set. E.g. when INSUNITS is set to "mm", entering "2m" in a 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/03_01_Unit_Settings.htm%23PROPUNITS
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/03_01_Unit_Settings.htm%23PROPUNITS
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/03_01_Unit_Settings.htm%23INSUNITS
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length property field will result in entering [2000.0000 mm]. Entering "1ft" will give 

[304.8000 mm]. If no unit is specified in the entry field, the unit as specified by 
INSUNITS is used. 

   

Create Entities 

1. Launch the command to create a 2D entity (e.g. Line and DYNDIVIS = 1 or 2).  
2. Specify the first point, then move the cursor to display the dynamic dimensions. 

The Length dynamic dimension highlights.  
3. Do one of the following:  

• Type the desired length of the line, then hit the TAB key to jump to the Angle dynamic 
dimension. 
The  Length dynamic dimension is locked and displays in red and the Angle dynamic 
dimension is selected.  

• Type the desired length of the line, then click to create the line at the angle defined by 
the cursor position.  

• Hit he TAB key to jump to the Angle dynamic dimension.  

4. Do one of the following:  

• Type the desired angle, then hit the Enter key to create the line.  

• Type the desired angle, then hit the TAB key to return to the Length dynamic 
dimension.  

• Hit the Enter key to create the line at the angle defined by the cursor position.  

• Hit the TAB key to return to the Length dynamic dimension.  

  

NOTE • If DYNDIVIS = 0, only one dynamic dimension displays.  Hit the TAB key to display 
the next field. 

• If you type a value in the Length field, and add a comma (,) the content of the 
Length field is copied to the command line and the @-character is placed in front 
automatically, which allows you to specify the next point using relative coordinates 
with respect to the previous point. 

 

Grip-edit Entities 

1. Select the entity or entities. 
All grips on the selected entities display.  

2. Click the grip you want to edit, then move the cursor. 
Depending on the value of the DYNDIVIS system variable one, two or all dynamic 

dimensions display simultaneously . 

The first dynamic dimension highlights.  
3. Do one of the following:  

• Type the desired value for the currently highlighted dynamic dimension, then hit the 
TAB key to jump to the next dynamic dimension. 

The dynamic dimension is locked and displays in red.  

• Type the desired value for the currently highlighted dynamic dimension, then press 
Enter to stop.  

• Hit the TAB key  to jump to the next dynamic dimension.  

4. Repeat step 3 or press Enter to stop.  

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/03_01_Unit_Settings.htm%23INSUNITS
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/03_01_Coordinate_Input.htm%23RelativeCoordinates
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Measure Entities 

1. Select the entity or entities. 
All grips on the selected entities display.  

2. Hover the cursor over a grip. 
The grip highlights and all dimensions related to the selected grip display.  

 

 

Dynamic dimensions used to measure a rectangle (left) and a line (right). 

(option) Click to start editing the selected grip.  

NOTE Dynamic dimensions when hovering over a non-selected grip display in 2DWireframe 
visual style only. 

   

Using Dynamic Dimensions with Tracking Points 

If the Tracking dynamic dimensions option of the DYNMODE system variable is set, dynamic 
dimensions display when entity snap tracking points or temporary tracking points are acquired. 

bricscad-sysvar.chm::/00_07_Settings_Manager.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/03_06_Entity_Snap_Tracking.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/03_03_Entity_Snaps.htm%23TemporaryTrackingPoints
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Coordinate Input 

When you create entities in a drawing, they are located in relation to the drawing's underlying 
Cartesian coordinate system. Every drawing has a fixed coordinate system called the World 
Coordinate System (WCS).  

You can also define arbitrary coordinate systems located anywhere in three-dimensional space. 
These are called user coordinate systems (UCS) and can be located anywhere in the WCS and 
oriented in any direction. 

To specify points and distances using the keyboard you can use the following formats: 

• Cartesian coordinates: x,y,z 

• Cylindrical coordinates: R<alpha,z 

• Spherical coordinates: R<alpha<beta 

Relative Coordinates 

If you place the @-character in front of the entry, the coordinates are calculated with respect to 
the previous point. This technique is called: Relative Coordinates. 

When Dynamic Dimensions are active and you type a value in the Length field and add a comma 
(,) the content of the Length field is copied to the command line and the @-character is placed in 
front automatically, which allows you to specify the next point using relative coordinates with 

respect to the previous point. 

Absolute Coordinates 

When a user defined coordinate system is active you can enter absolute coordinates (World 
coordinates) if you place an asterisk (*) in front. E.g. *0,0 refers to the origin of the WCS (World 
Coordinate System). 

Cartesian Coordinates 

In the Cartesian coordinate system we use three perpendicular axes: the x-axis, the y-axis and the 
z-axis. All axes originate in the origin point of the coordinate system.  The x-axis and the y-axis 
define a horizontal plane, while the x-axis and the z-axis and the y-axis and the z-axis define 
vertical planes. A point is defined by its distances to the yz-, xz- and xy- planes. These distances 
are called the xyz-coordinates of a point. 

 

If you want to enter the absolute Cartesian coordinates of a point, type the x-, y- and z- 
coordinates separated by commas: 45.5,57.3,60 

If you omit the z-coordinate, the point is placed in the xy-plane (Z = 0). 

If you place the @-character in front of the entry (@x,y), the coordinates are calculated with 
respect to the previous point. This technique is called Relative Cartesian coordinates. 
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Using relative Cartesian coordinates to draw a rectangle 

1. Launch the RECTANGLE command.  
2. Specify the first corner of the rectangle.  
3. In the command bar type: @<width>,<height>  

• <width> = the width of the rectangle in drawing units,  measured along the x-axis  

• <height> = the height of the rectangle in drawing units, measured along the y-axis  

Cylindrical Coordinates 

In a cylindrical coordinate system we use three perpendicular axes: the x-axis, the y-axis and the 
z-axis. All axes originate in the origin point of the coordinate system.  The x-axis and the y-axis 
define a horizontal plane, while the x-axis and the z-axis and the y-axis and the z-axis define 

vertical planes.  

A point is defined using the following format: R<alpha, z.  

• R = distance to the origin in the xy-plane 

• <alpha = the angle between R and the x-axis (positive angles are measured counter 
clockwise) 

• z = the height above the xy-plane. 
If the z-coordinate is omitted, cylindrical coordinates are referred to as polar coordinates. 

If you place the @-character in front of the entry, the coordinates are calculated with respect to 

the previous point. This technique is called Relative Cylindrical coordinates. 
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Spherical Coordinates 

In a cylindrical coordinate system we use three perpendicular axes: the x-axis, the y-axis and the 
z-axis. All axes originate in the origin point of the coordinate system.  The x-axis and the y-axis 
define a horizontal plane, while the x-axis and the z-axis and the y-axis and the z-axis define 
vertical planes.  

A point is defined using the following format: R<alpha<beta 

• R = distance from the origin 

• <alpha = angle in the xy-plane (positive angles are measured counter clockwise) 

• <beta = angle measured from the xy-plane (positive angles are measured counter 
clockwise, above the xy-plane) 
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Snap and Grid 

  

 

Snap and Grid  

  

Grid and snap help you to draw fast and accurately.  

A grid is a set of evenly spaced lines or dots  that serve as a visual distance reference.  

The GRIDSTYLE system variable controls whether grid lines or dots display. 

The GRIDDISPLAY system variable controls the display of the grid. The grid can also indicate how 

far the drawing limits extend.  

 

  

  

The snap feature creates a set of evenly spaced, invisible magnetic points, which make the 
crosshairs move in even increments. Both grid and snap are like the intersection points of the lines 

on a piece of grid paper. Grid points are for visual reference only and they do not print. Snap 
constrains the points that you can pick with the mouse. 

• Click the Grid tool ( ) on the Settings toolbar or the Grid field in the Status Bar, or press 

Ctrl+G to toggle grid display on/off. 

• Click the Snap tool ( ) on the Settings toolbar or the Snap field in the Status Bar, or 
press Ctrl+B to toggle snap on/off. 

• Both snap and grid can be set differently in each viewport. 

• The Snap option of the Grid command equals the grid spacing to the current snap spacing. 

• Grid lines or dots do not print. 

https://blog.bricsys.com/tutorials/
https://blog.bricsys.com/drawing-accurately-part-1/
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Snap and Grid Settings 

Do one of the following: 

• In the Status Bar, right click on the Snap field, then choose Settings in the context 
menu. 
 

 
• Open the Settings dialog, then click the Drawings button. 

Under Drafting, expand Coordinate Input and Snap/Grid.  

To Synchronize Snap and Grid Spacing 

1. Type Grid  in the command bar, then press Enter. 
You are prompted: Grid is on:  OFF/Aspect/<Grid spacing (synced with snap)>:  

2. Type s, then press Enter.  
3. Type Snap in the command bar, then press Enter. 

You are prompted: Snap is on, x and y = 0.2000:  OFF/Rotate/Style/Aspect/<Snap 
spacing>:  

4. Type a new value for the snap spacing, then press Enter. 
The value is applied to both snap and grid.  

  

NOTE The grid spacing remains in sync with the snap spacing until you set the grid spacing 
differently using the Grid command or in the Settings dialog. 
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To set the Drawing Limits 

Click the  Drawing Limits tool button ( ) on the Settings toolbar to toggle the LIMCHECK system 
variable on/off. 

If LIMCHECK = ON, it is not possible to draw outside the drawing limits. 

The appearance (pressed or unpressed) of the Drawing Limits tool button reflects the current 
status of the Drawing Limits. 

The Display beyond LIMITS area option of the GRIDDISPLAY system variable defines wether or not 

the grid display indicates the drawing limits. 

Using Isometric Snap 

You can use the Isometric snap and grid option to create two-dimensional isometric drawings. With 
the isometric option, you can draw a simulated three-dimensional view on a two-dimensional 
plane, much the same as you might draw on a piece of paper. Do not confuse isometric drawings 

with three-dimensional drawings.  

The isometric option always uses one of three preset planes, which are denoted as Left, Right  and 
Top. You cannot alter the arrangement of these planes. If the Snap Angle is 0, the three isometric 
axes are 30 degrees, 90 degrees, and 150 degrees. 

When you set the Snap Style setting to Isometric Snap and then set the Snap Isometric Pair 
setting to Left, Top or Right, the snap intervals, grid, and crosshairs align with the selected plane. 
The grid is always shown as isometric and uses y-coordinates to calculate the grid spacing. If the 

Orthogonal Mode is active, the movement of the crosshairs is constrained to the current isometric 
plane. Press the F5 function key to toggle  the Snap Isometric Pair setting. 

1. Display the Snap/Grid settings in the Settings dialog: 
 

 
2. Turn on the Orthogonal Mode.  
3. Use the SNAP command to set the Snap Style setting to Isometric Snap.  

bricscad-sysvar.chm::/00_07_Settings_Manager.htm
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4. Press the F5 function key to set the appropriate drawing plane: Top, Left or Right. 

 

Setting the Snap Angle 

You can rotate a dotted grid using the Snap Angle setting (if Snap Angle is different from zero, grid 
lines do not display). 

1. Display the Snap/Grid settings in the Settings dialog:  
2. Select the Snap Angle setting.  
3. Type a new value in the Snap Angle setting field.  

4. Close the Settings dialog.  

  

NOTE You can also set the Snap Angle by typing snapang  in the command bar.  

When in a command, type 'snapang (with an apostrophe in front), to set the Snap Angle 
variable transparently (= without interrupting the running command). 
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Entity Snaps 

Commands: 2DINTERSECTION, 3DINTERSECTION, NEAREST, CENTER, ENDPOINT, EXTENSION, 
FROM, GCENTER, INSERTION, INTERSECTION, MIDPOINT, MTP, NONE, PARALLEL, 
PERPENDICULAR, POINT, QUADRANT, TANGENT 

  

Entity snaps enable you to quickly select exact geometric points on existing entities without having 
to know the exact coordinates of those points. With entity snaps, you can select the end point of a 
line or arc, the center point of a circle, the intersection of any two entities, or any other 
geometrically significant position. You can also use entity snaps to draw entities that are tangent 
or perpendicular to an existing entity. You can use entity snaps any time you need to specify a 

point.  

You can work with entity snaps in one of two ways 

• Enable a running entity snap that remains in effect until you turn it off by choosing an 

entity snap when no other command is active.  

• Enable a one-time entity snap for a single selection by choosing an entity snap when 
another command is active. You can also use a one-time entity snap to override a running 
entity snap.  

When using entity snaps, the program recognizes only visible entities or visible portions of entities. 
You cannot snap to entities on layers that have been turned off or to the blank portions of dashed 
lines. 

If the APBOX system variable is on, the entity Snap Aperture Box is added to the crosshairs when 
one or more entity snaps are active.  

When you move the cross hairs, the program snaps to the snap point closest to the center of the 
Snap Aperture Box. The Snap Marker indicates the current snap point. 

The DRAGSNAP system variable controls the snap behavior while 'dragging', providing an increased 
WYSIWIG experience. DRAGSNAP controls whether rubberband dynamics are displayed at the 

current cursor location or at the current entity snap location. DRAGSNAP applies to all modify 
commands that display dynamics, such as COPY, PASTECLIP, PASTEBLOCK, MOVE, ROTATE, 

MIRROR, SCALE and STRETCH. 

• DRAGSNAP = 0 (Default),:dragged entities display at the cursor location. 

• DRAGSNAP = 1: dragged entities display at the current entity snap location. 
The OSOPTIONS system variable suppresses entity snaps on certain entity types. The value is 
stored as a bitcode using the sum of the values of the selected options. 

• 1: Entity snapping is disabled for hatch entities. 

• 2: Entity snapping is disabled for geometry with negative Z values when using a dynamic 
UCS. 

• 4: Entity snapping is disabled for endpoints of dimension extension lines. 

NOTE Press the TAB key, without moving the mouse, to cycle through all possible entity snaps.  

If the DYNMODE variable has a positive value (Dynamic Dimensions switched ON) entity 

snap cycling is not possible. Click the DYNMODE field in the Status Bar to toggle the 
display of dynamic dimensions. 
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To Define the Entity Snap Settings 

1. Open the Settings dialog. 

2. In the Settings dialog, expand the Program Options settings class. 

3. Under Program Options expand the Display settings group, then scroll down to the Entity 

Snap settings. 

 

  

User Preference Title Description 

SnapMarkerSize Snap 
marker 
size 

Sets the size of the snap marker. (default size is 
6) 

SnapMarkerThickness Snap 
marker 
thickness 

Sets the thickness of the snap marker. (default 
thickness is 2) 

SnapMarkerColor Snap 

marker 
color 

Sets the color of the snap marker. (default color 

= 20) 

3dSnapMarkerColor 3d snap 
marker 

color 

Sets the color of the 3d snap marker (default 
color = 5 (Blue)). 

The 3d snap marker (1) displays the identified 3d 
point, the snap marker (2) displays at the current 
Elevation height. 

The 3d snap marker displays only if OSNAPZ = 1 

(  Ignore entity snap elevation). 
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DisplaySnapMarkerInAllViews Snap 

marker 
in all 
views 

If multiple viewports are open, enables the 

display of the snap marker in all viewports. 

DisplayTooltips Snap 
tooltips 

Enables the display of the Entity Snap tooltips. 

  

4. Under Drawing expand the Drafting settings group then go to Coordinate Input > Entity 

Snaps. 

 
 
  

System Variable Title Description 

OSMODE Entity snap 

mode  

Sets the entity snap modes and toggles entity 

snap on/off. 

3DOSMODE 3D entity snap 
mode 

Sets the entity snap modes for 3D entity features 
such as the midpoint of an edge or the center of a 
face.  

OSNAPCOORD Entity snap 
coordinates 

Determines whether entity snaps override 
keyboard coordinate entry. 

OSNAPZ Ignore entity 
snap elevation 

Replaces the Z-coordinate of the snapping point 
with the current value of the ELEVATION system 
variable. 

OSOPTIONS Entity snap 

options 

Suppresses entity snaps on hatches and/or 

dimension extension lines or negative z-values in 
dynamic UCS mode. 

APBOX Entity snap 
aperture box 

Toggles the display of the aperture box (2). 

APERTURE Entity snap 
aperture 

Sets the size of the Autosnap aperture box. 
(default size is 10). 

DGNOSNAP DGN entity snap Enables entity snapping to entities in DGN 
underlay files. 

DWFOSNAP DWF entity snap Enables entity snapping to entities in DWF 
underlay files. 

PDFOSNAP PDF entity snap Enables snapping to the geometry in PDF 

underlay files. 

 



  User Guide 

 206 

To Set the Entity Snaps 

Do one of the following: 

• Click the buttons on the Entity Snaps toolbar. 
The buttons of the currently active entity snap modes are pressed. 
 

 
• Press and hold the Shift key, then right click and select the Entity Snap mode in the 

context menu. 
The icons of the currently active Entity Snap modes are outlined. 
 

 

When no command is active, the above procedures toggle the Entity Snap modes on/off. 

When a command is active, the above procedures set a 'one shot' override of the current Entity 

Snap modes. 

Alternatively you can type a single letter shortcut as indicated in the table below. 
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Entity Snap Modes 

  

Name Icon Marker 
Context 
menu 
shortcut* 

Transparent 

shortcut** 
Description 

TK 
 

   tk 

Use temporary tracking 
points. Prompts you to 
identify temporary points; 
press Enter to accept the 

last temporary point. 

MTP  

 

  2 mtp 

Snaps to a point in the 
middle between two points. 
Prompts you to identify two 
points. 

            

ENDPOINT  

 

 

E end 

Snaps to the nearest 
endpoint of an entity or 
polyline segment. 

MIDPOINT  

 

 

M mid 
Snaps to the midpoint of an 
entity or polyline segment. 

NEAREST  

 

 

N nea 
Snaps to the nearest point 
on an entity. 

CENTER  

 
 

C cen 

Snaps to the center point of 
an arc, circle, polygon, 

ellipse or elliptical arc. 

Snaps to the center of 

gravity of a closed polyline. 

GEOMETRIC 

CENTER  

 
 

G gce 

Snaps to the centroid of 
any closed polylines and 
splines, planar 3d polylines, 
regions and planar faces of 
3D solids. 

PERPENDICULAR  

 

 

P per 

Snaps to the perpendicular 
point of another entity. You 

can snap to an arc, circle, 
ellipse, line, polyline, 
infinite line, ray, spline or 
edge of a plane to form a 
perpendicular alignment 
with that entity or with an 

extension of that entity.  

PARALLEL  

 

 

L par 

Displays a tracking line 

parallel to the selected 
entity. 

TANGENT  

  

T tan 

Snaps to the point on an 
arc, ellipse, spline or circle 
that, when connected to the 
previous point, forms a line 
tangent to that entity. 

QUADRANT  

 
 

Q qua 

Snaps to the closest 
quadrant of an arc, circle, 
ellipse, or elliptical arc. 

INSERTION  

 
 

I ins 

Snaps to the insertion point 

of an attribute, block or text 

entity. 
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POINT  

 

 

O 
poi 

nod 
Snaps to a point entity. 

INTERSECTION  

 

 

R int 
Snaps to the intersection of 

any combination of entities.  

APPARENT 

INTERSECTION  

 
 

A app 

Snaps to the apparent 
 intersection in the current 
view of two entities that do 
not intersect in three-
dimensional space. 

EXTENSION  

 

 X ext 

Snaps to the extension of 
an entity or to the 
intersection of the 
extension of two entities. 

NONE  

 

  Y non 
Turns off all entity snap 

modes. 

* Type this letter to quickly select the entity snap mode in the right click context menu. 

** Type the transparent shortcut in the command bar when a command prompts for a point. Other 
running entity snaps are temporarily disabled. 

  

System 

Variable 
Icon Description 

OSNAPZ 
 

Ignore entity snap elevation: replaces the Z coordinate of the snapped 
point with the current value of the ELEVATION system variable. 

OSOPTIONS 
 

Entity snap to hatches: allows to snap to hatches. 

OSOPTIONS 
 

Entity snap to negative-z: allows entity snaps with a negative z-value 

when a Dynamic UCS is active, 

  

  

NOTE You can toggle the Entity Snaps on/off: 

• by clicking the ESNAP field in the Status Bar. 

• by hitting the F3 function key. 

  

Working with Multiple Entity Snap Modes 

1. Move the cursor to the entity you want to snap. 
One of the active Entity Snap modes markers display.  

2. Do not move the mouse; press the TAB key. 

The entity the snap point is on highlights.  
3. Do one of the following:  

• Click to accept the snap point.  

• Press the TAB key. 
The next possible Entity Snap mode marker displays. 
The entity the snap point is on highlights.  

4. (option) Repeat step 3 until the right snap point is found.  

  

NOTES • Do not move the mouse while pressing the TAB key. 

• Entity snap cycling is not possible when Dynamic Dimensions are active. Click the 

DYNMODE field in the Status Bar to toggle Dynamic Dimensions on/off. 
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To Snap to the Extension of Two Entities 

1. If not already on, turn on the Extension Entity Snap mode ( ).  
2. Launch a drawing tool, e.g. Draw Line.  
3. Move the cursor over the endpoint of the first entity (1). 

A small cross ( ) indicates the entity is marked for extension.  
4. Move the cursor over the endpoint of the second entity (2). 

A small cross ( ) indicates the entity is marked for extension.  
5. Move the cursor near the intersection of the extensions of the two entities. 

An X indicates the intersection (3).  

 

6. Click to accept the snap point.  

  

NOTE You can snap to the extension of lines, polylines, arcs and elliptical arcs 

  

Using Temporary Tracking Points 

When using temporary tracking points, Polar Tracking must be on and it is recommended to have 

dynamic dimensions active as well. 

1. Whenever a command prompts for a point, do one of the following:  

• Click the mouse wheel.  

• Click the Temporay tracking points tool button ( ) on the Entity Snaps toolbar.  

• Hold down the Shift key, then right click and choose Temporay tracking points in the 
context menu.  

• Type TK in the command bar, then press Enter.  

The command is suspended temporarily. 

You are prompted: Specify first temporary tracking point: 

2. Enter a point, e.g. use an entity snap to specify a point. 
You are prompted: Specify next temporary tracking point (press ENTER to end)  

3. Do one of the following:  

• Enter a point.  

• Press Enter to accept the last temporary tracking.  

The command resumes. 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/03_05_Polar_Tracking.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/03_11_Dynamic_Dimensions.htm


  User Guide 

 210 

Using 'Middle of 2 Points' Snap 

1. When prompted to specify a point, do one of the following:  

• Click the Snap to the middle of 2 points button ( ) on the Entity Snaps toolbar.  

• Type mtp or m2p in the command bar, then press Enter.  

• Press and hold the Shift key, then right click and choose Snap to middle of 2 points in 
the context menu.  

You are prompted: First point of mid: 

Specify the first point 
You are prompted: Second point of mid:  

Specify the second point. 
The point in the middle of the two points is snapped.  

Using Parallel Entity Snap 

1. Make sure Entity Snap Tracking is active.  
2. Launch an entity create command to create a linear entity (e.g. Line).  

3. Specify the first point of the entity. 
The line displays dynamically.  

4. Do one of the following:  

• Press and hold the Shift key, then right click and choose Snap to parallel in the context 
menu.  

• Click the Snap to parallel tool button ( ) in the Entity Snaps toolbar.  

5. Hover the cursor over the entity you want to draw parallel to. 

The Parallel Entity Snap marker ( ) displays on the selected entity. 
Wait until a small cross (+) indicates the entity is recognized.  

6. Move the cursor in order to place the dynamics of the line more or less parallel to the 
selected entity. 
A tracking line displays from the start point of the line.  

7. Do one of the following to specify the second point while the tracking line displays:  

• Click a point.  

• Enter the desired length and press Enter.  

• Use a second entity snap tracking point, then move the cursor to the intersection of the 
parallel tracking line and the second entity snap tracking line. 
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Polar Tracking 

Polar tracking assists you to draw at exact angles: 

• at fixed intervals, starting from 3 O'clock (or East) 

• at specific additional angles  
A polar tracking path line displays from the origin point when you move the cursor close to one of 
the polar tracking angles. The tracking path lines display as long as the Snap Aperture box 
overlaps the polar tracking line.  

In 3D views an additional tracking line displays parallel to the Z-axis of the current UCS.  

Snap track lock: to lock a snap track path hit the Shift key. To unlock a track path, hit Shift again: 
it works as a toggle. Locked tracking paths display in the color defined by the SnapMarkerColor 
user preference.. 

  

NOTE The display of the tracking path line is controlled through the TRACKPATH system 

variable. 

The color of the tracking path line is controlled through the AutoTrackingVecColor user 
preference. 

Tracking paths parallel to the X-, Y- or Z-axis of the current coordinate system (WCS or 
UCS) display in the color of the axis they are parallel with (defined by COLORX, COLORY 
or COLORZ variables).. 

  

To Define the Polar Tracking Settings 

1. Do one of the following: 

2. Right click on the POLAR  field in the Status Bar, then right click and choose Settings in 

the context menu. 

3. Open the Settings dialog, then expand the Coordinate input sub-category under 

Drafting in the Drawing settings class. 
Expand the Snap Tracking settings group. 

 

2. Adjust the settings: 

3. 1: Autosnap marker (not used, required for AutoCad® compatibility only) 

4. 2: Autosnap tooltips (not used, required for AutoCad® compatibility only) 

5. 4: Autosnap magnet (not used, required for AutoCad® compatibility only) 

6. 8: If checked, Polar Tracking is on. 

7. 16: If checked, Object Snap Tracking is on. 

8. 32: If checked, tooltips display for polar tracking and entity snap tracking. 

9. Polar angle: Sets the polar angle increment. 

bricscad-sysvar.chm::/00_07_Settings_Manager.htm
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10. Polar add angles: Sets the additional polar angles. Separate angles by semicolons. 

11. 1: If checked, polar angles are measured relatively from selected entities. 

12. 2: If checked, the polar angles (interval and additional angles) are also used in entity 

snap tracking. 

13. 4: If checked, the additional angles for polar tracking are used. 

14. 8: If checked, press and hold the Shift key to acquire entity tracking points. 

• Track path: Controls the display of the polar and entity snap tracking paths. 
 

 

Using Polar Tracking to Draw a Line 

1. (option) Check the Polar Tracking settings. 

2. (option) If not already on, click the POLAR field in the Status Bar. 

3. Launch the Draw Line tool. 

4. Specify the start point of the line. 

Polar tracking lines display at the specified intervals and additional angles. 

If the cursor is on or next to a tracking line:  

• The current distance and angle from the start point display next to the cursor when 

• A cross marker (X) indicates the current point. 

5. Do one of the following to define the endpoint of the line. 

When the appropriate tracking line displays: 

6. Click when the cursor is at the desired position. 

7. Type the length of the line in the command bar and press Enter. 

NOTE Turning on Polar Tracking automatically disables Orthogonal Mode. 

 

Using Snap Track Lock 

Hit the Shift key while a snap track marker line is displayed to lock a tracking path, any 
(snap)point that is picked will be projected perpendicularly onto the tracking path. Hit the Shift key 

again to unlock. 

A locked tracking path changes to the color defined by the SnapMarkerColor user preference. 

Using Temporary Tracking Points 

When Polar Tracking is ON, temporary tracking points can be used to pick points at locations 
where no existing geometry is available to snap directly to, while you know the desired offset 
distance(s) from snap points on existing geometry in the neighborhood.  

TT option: whenever prompted to enter a point, type TT on the command line, then press Enter to 
define a single temporary tracking point. After the tracking point has been picked, normal 
command execution continues. Repeat typing TT to enter additional temporary tracking points. 

TK option: whenever prompted to enter a point, type TK on the command line, then press Enter to 
define one or more temporary tracking points. When eventually the desired location has been 
reached, enter the point by pressing the Right Mouse button or the Enter key. 

Using the TT option 

1. Launch a draw command, e.g. Line. 
You are prompted: ENTER to use last point/Follow/<Start of line>: 

2. Type TT in the command bar, then right click or press Enter. 

You are prompted: Specify temporary tracking point: 

3. Use an Entity Snap to pick a point on existing geometry. 
A small red cross indicates the temporary tracking point. 
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4. Move the cursor in the desired direction. 

Depending on the value of the POLARANG and POLARADDANG system variables tracking 
lines display from the first temporary tracking point. 

5. When a tracking line in the appropriate direction displays, type the distance from the 

temporary tracking point. 

6. Specify the endpoint of the line. 

 

Using the TK option 

1. Launch a draw command, e.g. Line. 
You are prompted: ENTER to use last point/Follow/<Start of line>: 

2. Type TK in the command bar, then right click or press Enter. 

You are prompted: Specify first temporary tracking point:  

3. Use an Entity Snap to pick a point on existing geometry. 

A small red cross indicates the temporary tracking point. 
You are prompted: Specify next temporary tracking point (press ENTER to end): 

4. Move the cursor in the desired direction. 

Depending on the value of the POLARANG and POLARADDANG system variables tracking 
lines display from the first temporary tracking point. 

5. When a tracking line in the appropriate direction displays, type the distance from the 

temporary tracking point. 
A small red cross indicates the second temporary tracking point. 
You are prompted: Specify next temporary tracking point (press ENTER to end): 

6. Do one of the following: 

Right click or press Enter to accept the second tracking point as the start point of the 

line. 

Repeat steps 4 and 5 until the desired point is specified, then right click or press Enter 

to accept the point. 

7. Specify the endpoint of the line. 

Snap Tracking 

Entity Snap Tracking assists you to draw entities with respect to other entities. 

When Entity Snap Tracking is turned on, BricsCAD displays temporary alignments based on entity 
snap points. Entity Snap Tracking works in combination with Entity Snap tools. At least one Entity 
Snap mode must be on if you want to use Entity Snap Tracking. 

Click the STRACK field in the Status bar to enable/disable Entity Snap Tracking. 

Entity Snap Tracking alignments are parallel to the X- and Y-axis of the current UCS by default.  

If the Polar mode > 0x0002 setting is checked, the polar angles used in Polar Tracking (interval 
and additional angles) are also used in Entity Snap Tracking. 

Alignment points are acquired when you hover over a point, using entity snaps.  Acquired points 

display a small plus sign (+). To remove an acquired point, hover over the point again. The small 
plus sign (+) is then removed. If the Polar mode > 0x0008 is checked, you must press and hold 
the Shift key to acquire entity tracking points. Alignments relative to an acquired point are 
displayed as you move the cursor over their tracking paths. You can then define points either on 
the alignments or at the intersection of two alignments. 

Esnap track markers: to distinguish between regular esnap markers and markers drawn together 
with related snap tracking lines, esnap track markers display in the color of the tracking lines. 

Hitting the Shift key when a tracking line displays, locks the tracking line. Locked tracking lines 
display in red (1). Entity snaps (2) or specified points are projected perpendicularly onto the 
tracking line (3). Hit the Shift key again to unlock a tracking line. 
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More options with locked tracking lines are: 

• If the Intersection entity snap is active, it is possible to snap to the intersections of a 
locked tracking line and entities in the drawing. 

• Acquire additional tracking lines and snap to the locations where these intersect with the 
locked tracking line. 

Using Entity Snap Tracking 

1. Launch a drawing tool, e.g. Draw Line. 

2. Hover the cursor over the first tracking point (1). 

A small plus sign (+) displays to indicate the tracking point is active. 

3. Hover the cursor over the second tracking point (2) 
A small plus sign (+) displays to indicate the tracking point is active. 

4. Move the cursor close to position 4. 

• Tracking lines display from both tracking points (3). 

• A cross marker (X) indicates the intersection of the tracking lines. 

• Snap markers display at the tracking points. 

• An Entity Snap Tracking tooltip at the intersection of the tracking lines shows the 
angles and distances from the tracking points. 
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5. Click to accept the Entity Snap Tracking point. 
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User Coordinate Systems 

When you create entities in a drawing, they are located in relation to the drawing's underlying 
Cartesian coordinate system. Every drawing has a fixed coordinate system called the World 
Coordinate System (WCS).  

You can also define arbitrary coordinate systems located anywhere in three-dimensional space. 
These are called user coordinate systems (UCS) and can be located anywhere in the WCS and 
oriented in any direction. 

To specify points and distances using the keyboard you can use the following formats: 

• Cartesian coordinates: x,y,z 

• Cylindrical coordinates: R<alpha,z 

• Spherical coordinates: R<alpha<beta 

To Move the Origin of the Current Coordinate System 

1. Type ucs at the command prompt. 
You are prompted: Specify origin of UCS or [Face/NAmed/Entity/Previous/View/X/Y/Z/Z 
Axis/Move/World] <World>: 

2. Identify the new origin, then press Enter to confirm. 

To Define a User Coordinate System 

1. Choose Drawing Explorer > Coordinate Systems in the Tools menu. 
The Drawing Explorer - Coordinate Systems dialog opens.  

2. Click the New tool button ( ) on the Drawing Explorer dialog. 
The BricsCAD Explorer dialog closes. 
You are prompted: Current/Entity/Origin/View/X/Y/Z/ZAxis<3point>: 
A prompt menu displays: 

 

 

2. Press Enter to define the UCS using points. 
You are prompted: New origin <current origin>:  

3. Specify the origin point of the UCS. 

You are prompted: Point of positive X axis <current point>:  
4. Specify a point to define the positive X-axis. 

The command window reads: Point in X-Y plane with positive Y value <current point>:  
5. Specify a point to define the positive Y-axis. 

The UCS is defined. 
The BricsCAD Explorer dialog reopens.  

6. Click in the UCS Name field of the newly defined UCS to replace the <NewUCS> default 
name.  

7. Close the BricsCAD Explorer dialog.  

Command Options 

See the EXPUCS  and UCS commands. 
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To Restore the WCS 

1. Type UCS in the command bar, then press Enter. 
You are prompted: 
?/3point/Delete/Entity/Origin/Previous/Restore/Save/View/X/Y/Z/Zaxis/<World>: 
A prompt menu displays.  

2. Do one of the following:  

• Press Enter to accept the default option.  

• Choose World in the prompt menu.  

• Type W in the command bar and press Enter.  

To Restore a UCS 

1. Choose Drawing Explorer > Coordinate Systems in the Tools menu. 
The Drawing Explorer - Coordinate Systems dialog opens. 

2. Click the blank tile in front of the UCS name to make it current. 
3. Close the BricsCAD Explorer dialog.  

  

NOTE If no UCS is marked, the WCS is the current coordinate system. 

 

To Set a Relative UCS 

1. Do one of the following:  

• Click the UCS... tool button ( ) on the Settings toolbar.  

• Choose UCS... in the Settings menu.  

The User Coordinate System dialog opens. 
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Choose one of the following:  

• Set the selected UCS relative to the Current UCS.  

• Set the selected UCS relative to the World coordinate system (WCS).  
3. (option) Enable the Change view to plan view of the selected UCS option.  

4. Click one of the Planar UCS's buttons. 
The User Coordinate System dialog closes.  

NOTES • If the UCSORTHO system variable is ON an orthographic UCS is restored 
automatically when the related orthographic view is restored by the -VIEW 
command or selected on the Look From control. 
An orthographic UCS has its origin at the WCS origin. 

• The UCSVP (UCS viewports) system variable controls whether the UCS in a 
viewport is fixed (UCSVP = ON) or changes to match the UCS in the current 
viewport (UCSVP = Off). As a result, in a multiple viewport drawing, the UCS of all 
viewports that have UCSVP = Off matches the orthographic UCS of the current 
viewport if UCSORTHO = On. 

Command Options 

See the SETUCS command. 
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Dynamic UCS 

With the Dynamic UCS feature enabled, the coordinate system is aligned automatically with a face 
of a 3D solid under the cursor when drawing entities.  

This feature is controlled by the UCSDETECT system variable. 

The RedHilite_DUCSLocked_Face_Color user preference controls the highlight color for the face to 

which the Dynamic UCS has been locked by pressing the Shift key. 

The RedHilite_DUCSLocked_Face_Alpha user preference controls the highlight transparency for the 
face to which the Dynamic UCS has been locked by pressing the Shift key. 

To  toggle the dynamic  UCS  

Do one of the following: 

• Press the F6 function key.  

• Click the DUCS field in the status bar.  

Using the Dynamic UCS 

1. With the Dynamic UCS feature active, launch a Draw command.  
2. Move the cursor over the face of a 3D solid.  

 

• The face highlights.  

• If ON, the grid is aligned with the selected face.  

• If  the UCSICON system variable = 3 (On at Origin), the UCS icon displays in the 

selected face.  

• The dynamic UCS is oriented according to the edge by which the cursor 'entered' the 
hovered face, thus providing users a way to manipulate the orientation of the DUCS. 
The origin of the DUCS is set to the start point of this edge and the X-axis is chosen 
codirectional to the tangent at the start point of the edge.  

bricscad-sysvar.chm::/00_07_Settings_Manager.htm
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Bottom Left Curved 

 

 

  

Top Right   

  

3. (option) Hit the Shift key to lock the DUCS, which allows you to start drawing outside the 
highlighted face. 
Hit the Shift key again to unlock the DUCS.  

4. Pick a point to start drawing.  
5. When the drawing command concludes, the WCS or previously defined UCS is restored. 
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Measuring 

The Dist command reports the distance and angle between two points. 

The Area command finds the area and perimeter (or length) of 2D entities. 

The Massprop command reports the area, perimeter, and other mathematical properties of 3D 

solids and 2D regions (short for "mass properties"). 

The ID command reports the x,y,z coordinates of picked points. 

The List command lists the properties of selected entities. 

Measuring Distances 

To measure a distance between two points: 

1. Do one of the following:  

• Click the Distance tool button ( ) on the Inquiry toolbar.  

• Type dist in the command bar and press Enter.  

You are prompted: Starting point for distance: 

2. Identify the first point. 
You are prompted: End point:  

3. Identify the second point. 
If DRAGSNAP = 1, the distance displays in the dynamic dimension field.  

The following information displays in the command bar (see image below): 

Distance, Angle in XY Plane (alpha), Angle from XY Plane (beta), 
Delta X, Delta Y, Delta Z. 

The values are calculated with respect to the current coordinate system. 
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Measuring Lengths 

To measure the length of single linear entity, click the entity then read the Length field in the 
Properties Bar. 

To add the lengths of a series of linear entities: 

1. Do one of the following:  

• Click the Area tool button ( ) on the Inquiry toolbar.  

• Type area in the command bar and press Enter.  

You are prompted: Entity/Add/Subtract/<First point>: 

A prompt menu displays: 

 

2. Do one of the following:  

• Choose Add areas together in the prompt menu.  

• Type A in the command bar and press Enter.  

You are prompted: Adding: Entity/Subtract/<First point>: 

A prompt menu displays: 

 

4. Do one of the following:  

• Choose Add entities to area in the prompt menu.  

• Type E in the command bar and press Enter.  

You are prompted: Adding area<Select entities>: 

5. Click the first entity. 
The area and length of the first entity display in the command bar. 
You are prompted: Adding area<Select entities>:  

6. Click the second entity. 
The area and length of the second entity and the total area and total length display in the 

command bar. 
Optionally press the F2 function key to display the Prompt History window; press F2 again 
to close the Prompt History window. 
You are prompted: Adding area<Select entities>:  

7. Repeat step 5 to add more entities 
or 
press the Esc key to stop.  
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Measuring Areas 

To measure the area and length of single closed entity, click the entity then read the Area and 
Length fields in the Properties Bar. 

To measure areas and perimeters by specifying points in a drawing: 

1. Do one of the following:  

• Click the Area tool button ( ) on the Inquiry toolbar.  

• Type area in the command bar and press Enter.  

You are prompted: Entity/Add/Subtract/<First point>: 

A prompt menu displays: 

 

3. Do one of the following:  

• Choose Add areas together in the prompt menu.  

• Type A in the command bar and press Enter.  

You are prompted: Adding: Entity/Subtract/<First point>: 

A prompt menu displays: 

 

4. Click the first corner point of the area. 
A dashed line displays dynamically from the first corner point. 
You are prompted: Adding: <Next point>:  

5. Click the second corner point of the area. 
A dashed polygon displays dynamically, indicating the currently defined area. 
You are prompted: Adding: <Next point>:  

6. Click the third corner point of the area. 

You are prompted: Adding: <Next point>:  
7. Repeat step 5 to add more corner points 

or 
Right click to stop adding corner points. 
The Total length and Total area display in the command bar. 
Optionally press the F2 function key to display the Prompt History window; press F2 again 
to close the Prompt History window.  

8. Do one of the following:  

• Repeat steps 3 through 6 to add another area.  

• Press the Esc key to stop. 
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Viewing your Drawing 

BricsCAD provides various tools to control the display and view orientation of your drawing.  

These tools can be found either in the View menu or the View toolbar or both. 

  

 

 

 

 

View toolbar and its flyouts 

 

The Look From control 

  

  

Icon Tool name Command Description 

 

Redraw REDRAW  

Refreshes the screen display in the current 
viewport. 

 

Redraw All  REDRAWALL  

Refreshes the screen display in all open viewports. 

 

Regenerate REGEN  

Recalculates the screen display in the current 

viewport. 

 

Regenerate All REGENALL 

Recalculates the screen display in all open 
viewports. 

 

Update Fields UPDATEFIELD 

Updates the selected fields. 

 

Real Time Pan RTPAN  

Pans the view dynamically. 

 

Pan  PAN  

Pans the view. 

 

Real Time 

Zoom 

RTZOOM  

Zooms in/out dynamically. 

 

Zoom In  ZOOM + I(*) Zooms in on the center of the window by a factor of 
2. 

 

Zoom Out  ZOOM + O(*) Zooms out from the center of the window by a 
factor of 1/2. 
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Zoom Extents ZOOM + E(*) Displays all the entities  in the drawing (referred to 

as the drawing extents). 

 

Zoom Window ZOOM + W(*) You are prompted to pick two corners of a box on 
the existing view in order to enlarge that area to fill 
the display. 

 

Zoom Previous ZOOM + P(*) Restores the displayed view prior to the current 
one. 

 

Zoom All ZOOM + A(*) Displays the whole drawing as far as its drawing 
limits or drawing extents (whichever is the greater 
of the two). 

 

Zoom Left ZOOM + L(*) Pick the lower left corner of the next view, then 
specify the magnification factor or the view height. 

 

Zoom Center  ZOOM + C(*) Pick the center of the next view, then specify the 

magnification factor or the view height. 

 

Zoom Right ZOOM + R(*) Pick the upper right corner of the next view, then 
specify the magnification factor or the view height. 

  
Look Around RTLOOK 

Look around in a 3D scene. 

  
Look Up and 

Down 

RTUPDOWN  

Move up / down and left / right in a 3D scene. 

  
Walk RTWALK  

Walk left / right and  forward / backward in a 3D 
scene. 

 

Real-Time 

Constrained 

Sphere 

RTROT  

Rotates the view dynamically in 3D.  

• Moving the mouse horizontally (parallel to 

the screen x-axis) rotates the view about 
the world z-axis.  

• Moving the mouse vertically (parallel to the 
screen y-axis) rotates the screen x-axis. 

  
Real-Time 
Sphere Center 

RTROTCTR  

Rotates the view dynamically in 3D about a user-
defined center point. Behaves like RTROT. 

 

Real-Time Free 
Sphere 

RTROTF  

Rotates the view dynamically in 3D.  

• Moving the mouse horizontally (parallel to 
the screen x-axis) rotates the view about 
the screen y-axis.  

• Moving the mouse vertically (parallel to the 

screen y-axis) rotates the view about the 
screen x-axis. 

 

Real-Time X RTROTX  

Rotates the view dynamically about the screen x-

axis. 

 

Real-Time Y RTROTY  

Rotates the view dynamically about the screen y-

axis. 

 

Real-Time Z RTROTZ  

Rotates the view dynamically about the screen z-

axis. 

 

Set View Point  DDVPOINT  

Opens the Preset Viewpoints dialog. 

 

Plan View  PLAN 

Restores the plan view with respect to the WCS, the 
current UCS or a saved UCS. 

 

Define View DVIEW  

Defines parallel and visual perspective views. 
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Save/Restore 
view 

VIEW  

Saves and restores named views. 

 

Viewports VPORTS  

Manages viewports in model space. 

 

Paper Space 

Views 

MVIEW  

Creates viewports in paper space. 

 

Generate 
Drafting Views 

BMGENDRAFT  

Generates associative orthographic and standard 
isometric views of a 3D solid model in a paper space 
layout. 

 

Generate 
Section 

BMGENSECTION  

Creates a cross section view based on a standard 
drafting view generated by the BmGenDraft 
command in a paper space layout.  

 

2D Context 2DCONTEXT  

Switches the drawing to a 2D drafting context. 

 

3D Context 3DCONTEXT  

Switches the drawing to a 3D modeling context. 

  

 (*) <command> <option>: type zoom followed by Enter, then type the command option letter, 
followed by Enter. 
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Layer Utilities 

The layer utility commands help you to easily manipulate the On/Off, Thaw/Freeze and 
Unlocked/Locked layer properties by selecting entities. You can then save the result in a Layer 
State. 

 

  

Command Icon Description 

LAYON  
 

Turns on all layers that have been turned off 

LAYOFF  
 

Turns off layers associated with selected entities. 

LAYFRZ  
 

Freezes layers associated with selected entities. 

LAYTHW  

 

Thaws all frozen layers. 

LAYLCK  
 

Locks layers associated with selected entities. 

LAYULK  
 

Unlocks layers associated with selected entities. 

LAYISO  
 

Isolates layers associated with selected entities.  
If no entity on the current layer is selected, the layer of the entity that is 
selected first temporarily becomes the current layer until the LAYUNISO 
command is executed. 

LAYUNISO  
 

Restores layers isolated by the LAYISO command. 

  

See also Hide and Show Entities. 
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Hide and Show Entities 

The tools on the Hide/Show Entities toolbar allow to temporarily hide or isolate a selection of 
entities. 

 

  

Command Icon Description 

UNISOLATEOBJECTS 
 

Brings back all previously hidden entities. 

HIDEOBJECTS 
 

Hides the selected entities. 

ISOLATEOBJECTS 
 

Displays the selected entities only. 

  

The OBJECTISOLATIONMODE system variable controls whether hiding and isolating entities is 
saved or not. 

See also Layer Utilities. 
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Redrawing and Regenerating a Drawing 

Commands: REGEN, REGENALL, REGENAUTO, REDRAW and REDRAWALL 

The Regen command regenerates the current viewport (short for "regenerate"). 

The Regenall command regenerates all viewports (short for "regenerate all"). 

The Regenauto command controls when BricsCAD regenerates the drawing automatically. 

The Redraw command redraws the current viewport to clean it up. 

The Redrawall command redraws all viewports to clean them up. 

As a matter of fact the screen display of a drawing is a simplified version of the drawing database. 
From time to time it is necessary to synchronise the screen display and the drawing database.  

The REGENMODE system variable controls whether BricsCAD regenerates the drawing 
automatically. You can change the status of REGENMODE through the RegenAuto command. If 
REGENMODE is ON BricsCAD regenerates the display automatically, but in a few cases a forced 

regeneration of the drawing might be necessary. This is done by the Regen command. 

Don't confuse the Regen command with the Redraw command, which simply repaints the screen, 

without attempting to synchronize the screen display with the drawing database. 

  

Redraw All 

Do one of the following: 

• Click the Redraw All tool button ( ) on the View toolbar.  

• Type ra or redrawall in the command bar, then press Enter.  

All viewports are refreshed. 

Regenerate All 

Do one of the following: 

• Click the Regenall tool button ( ) on the View toolbar.  

• Type rea or regenall in the command bar, then press Enter.  

All viewports are regenerated. 

Regenerate 

Do one of the following: 

• Click the Regen tool button ( ) on the View toolbar.  

• Choose  Regen in the View menu.  

• Type re or regen in the command bar, then press Enter.  

The current viewport is regenerated. 

Redraw 

Do one of the following: 

• Click the Redraw tool button ( ) on the View toolbar.  

• Choose  Redraw in the View menu.  

• Type r or redraw in the command bar, then press Enter.  

The current viewport is refreshed. 

bricscad-cmdref.chm::/R/Regen.htm
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Panning 

  

The Pan command moves the drawing in any direction: horizontally, vertically, or diagonally. The 
magnification of the drawing remains the same, as does its orientation in space. The only change is 

the portion of the drawing being displayed. The cursor changes to a hand ( ) when a Pan tool is 
active. 

The Rtpan command pans the drawing in real-time. 

  

See also: View manipulation using the mouse. 

Real Time Pan Command 

1. To launch the Real-time Pan command do one of the following:  

• Click the Real-Time Pan tool button ( ) on the Real-Time Motion toolbar  

• Choose Real-Time Motion > Real-Time Pan in the View menu.  

• Type rtpan in the command bar, then press Enter.  

You are prompted: >>ENTER, Right click or Esc to complete... 

2. Press and hold the left mouse button to pan the view.  
3. To abort the Real-Time Pan command, do one of the following:  

• Right click.  

• On the keyboard, press Enter, space bar or Esc. 

Pan Command 

1. To launch the Pan command do one of the following:  

• Click the Pan tool button ( ) on the View toolbar (Zoom flyout).  

• Choose Zoom > Pan  in the View menu.  

• Type p or pan in the command bar, then press Enter.  

You are prompted: Left/Right/Up/Down/PGLeft/PGRight/PGUp/PGDown/<Pan base point>: 

A prompt menu opens: 

 

2. Specify the Pan base point. 
You are prompted: Pan displacement point:  

3. Specify the Pan displacement point. 

The display shifts over the specified distance and in the specified direction.  
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Zooming 

The Zoom command visually changes the size of the drawing within the current viewport. 

The Rtzoom command zooms the drawing in real-time. 

You can change the magnification of your drawing at any time by zooming. The cursor changes to 

a magnifying glass ( ) when a Zoom tool is active. Zoom out to reduce the magnification so you 
can see more of the drawing, or zoom in to increase the magnification so you can see a portion of 
the drawing in greater detail. Changing the magnification of the drawing affects only the way the 

drawing is displayed; it has no effect on the dimensions of the entities in your drawing. 

See also: View manipulation using the mouse. 

Zoom Command 

Do one of the following:  

• Choose zoom in the View menu.  

• Type zoom in the command bar.  

• Type Z in the command bar.  

You are prompted: In/Out/All/Center/Dynamic/Extents/Left/Previous/Right/Window/<Scale 
(nX/nXP)>: 

A prompt menu opens: 

 

Do one of the following:  

• Type the zoom factor, followed by X. E.g. type 2x to magnify the display 2 times; typing 
0.5x changes the display to half its original size.  

• In paper space viewports, type the zoom factor followed by XP to define the zoom factor 
relative to the viewport, thus defining the scale of the viewport content.  

• Pick two corners of a box on the existing view in order to enlarge that area to fill the 
display.  
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Real Time Zooming 

1. Do one of the following:  

• Click the Real-Time Zoom tool button ( ) in the View toolbar.  

• Type rtzoom in the command bar, then press Enter.  

You are prompted: >>ENTER, Right click or Esc to complete... 

2. Press and hold the left mouse button. 
Move the mouse forward to zoom in. 
Move the mouse backward to zoom out.  

3. To abort the Real-Time Zoom command, do one of the following:  

• Right click.  

• On the keyboard, press Enter, space bar or Esc.  

Dynamic zooming 

1. Do one of the following:  

• Choose zoom in the View menu.  

• Type zoom in the command bar.  

• Type Z in the command bar.  

A prompt menu displays. 

You are prompted: In/Out/All/Center/Dynamic/Extents/Left/Previous/Right/Window/<Scale 

(nX/nXP)>: 

2. Do one of the following:  

• Choose Dynamic in the prompt menu.  

• Type D, then press Enter.  

A view extents or view limits (if larger) is executed first. 

A view box displays. The original size of the view box matches the size of the previous view.  

 

A dashed rectangle indicates the area of the previous view. 
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3. (option) To resize the view box:  

• Click to switch to resize mode. A right pointing arrow indicates you are in resize mode.  

 

• Move the mouse to adjust the size.  

• Click to leave resize mode.  

4. Move the view box to the area you want to enlarge, then right click.  
The drawing is zoomed in on the selected area.  

5. Repeat steps 1 through 4 to zoom in on another part of the drawing. 
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View Manipulation Using the Mouse and Keyboard 

In BricsCAD you can navigate through a 3D model  using the mouse and keyboard shortcuts. 

In perspective mode you can walk inside the 3D model. In isometric mode you can only zoom in 
very close, but not go inside. 

  

Mouse / Key Action Result 

Wheel scroll Zoom in / out. 

The incremental change in zoom with each mouse-
wheel action is controlled through the Zoom Factor 

variable (ZOOMFACTOR). Default = 60. Values 
between 3 and 100 are accepted. 

When zooming in the incremental step decreases 
gradually allowing to focus on a particularly detail 

easily. 

In a 3D model the entity under the cursor has the 

zoom focus. 

The ZOOMWHEEL system variable controls the 
zoom direction: 

• 0 or OFF: scrolling forwards zooms in, 
backwards zooms out. 

• 1 or ON: scrolling forwards zooms out, 
backwards zooms in. 

Middle Button or 
wheel (**) 

press and hold while 
moving the mouse 

Real-time pan (RTPAN command) 

Middle Button or 
wheel (**) 

double click Zoom extents 

Ctrl + Shift + Left 
Button 

press and hold while 
moving the mouse 

Real-time zoom in / out (RTZOOM command) 

Ctrl + Shift + Right 
Button 

press and hold while 
moving the mouse 

Real-time pan (RTPAN command) 

Ctrl + Shift + 
Middle Button or 
wheel 

press and hold while 
moving the mouse 

Real-time sphere (RTROTF command) 

Shift + Middle 
Button or wheel 

press and hold while 
moving the mouse 

Real-time constrained sphere (RTROT command) 

Ctrl + Right Button press and hold while 
moving the mouse 

Real-time rotate about the screen Z-axis 
(RTROTZ command) 
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Walk Through Navigation 

Alt + Left Button  

press and hold while moving the mouse  

Walk left / right and  forward / backward (RTWALK command)  

Alt + Middle Button  

press and hold while moving the mouse  

Move up / down and left / right (RTUPDOWN command)  

Ctrl + Middle Button  

press and hold while moving the mouse  

Look around (RTLOOK command)  

Ctrl + Arrow Keys  

press the arrow keys while holding the Ctrl key  

Walk left / right and  forward / backward (RTWALK command)  

Ctrl + Shift + Arrow Keys  

press the arrow keys while holding the Alt + Ctrl keys  

Look up / down and left / right (RTUPDOWN command)  

Ctrl + Home  

   

Sets the view direction horizontal  

Alt + Home  

   

Moves target point to center of scene  

Alt + plus/minus  

   

Increase / decrease movement speed  

Ctrl + plus/minus  

   

Increase / decrease rotation speed  

  

(**) On condition the Middle Button Pan (MBUTTONPAN) variable is set ON. 
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Zoom Factor Variable 

1. Type zoomfactor in the command bar, then press Enter. 
You are prompted: New current value for ZOOMFACTOR (3 to 100) <current value>:  

2. Type a value between 3 and 100 in the command bar, then press Enter.  

or 

1. In the Settings dialog, open the Drawing category, then expand the Display/Viewing sub-
category. 
In the Viewing group, select the ZOOMFACTOR variable.  

2. Type a value between 3 and 100 in the zoomfactor field.  

  

NOTE Increase the zoom factor to speed up scroll wheel zooming in large drawings. 

 

Middle Button Pan Variable 

1. Type in mbuttonpan the command bar, then press Enter. 
You are prompted: New current value for MBUTTONPAN (Off or On) <current value>:  

2. Type On or Off in the command bar.  

or 

1. In the Settings dialog, open the Program Options category, then expand the User 
Preferences sub-category and select the MBUTTONPAN variable.  

2. Choose either Support panning or Support action defined in menu file. 

bricscad-sysvar.chm::/00_07_Settings_Manager.htm
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View Rotation 

Commands: LOOKFROM, RTROT, RTROTCTR, RTROTF,  RTROTX, RTROTY, RTROTZ, DDVPOINT, -
VIEW, PLAN and VPOINT 

The LookFrom command controls the display of the Look From control. 

The Rtrot (Real-Time Constrained Sphere) command rotates 3D drawings in real-time. 

The Rtrotctr (Real-time Sphere Center) command freely rotates 3D drawings in real-time about a 
user-defined center point. 

The Rtrotf (Real-time Free Sphere) command freely rotates 3D drawings in real-time. 

The Rtrotx , Rtroty and Rtrotz commands rotates 3D drawings in real-time about the x, y or z 
screen axis. 

The Ddvpoint command sets 3D viewpoints or plan view, through a dialog box (short for "dynamic 
dialog view point"). 

The Plan command displays the plan viewpoint of drawings. 

The Vpoint command changes the 3D viewpoint. 

  

In order to view your 3D drawings from any angle, you can rotate a view. The Real-Time Motion 
tools of BricsCAD allow you to rotate a view in real-time. You can rotate the view about the X, Y or 

Z screen axis or in any direction (real-time sphere). If the Continuous Motion variable is set, the 
view rotation continues until you conclude the Real-Time Motion command. 

See also: View manipulation using the mouse. 

  

NOTE 'Real-time' commands should not be used when drawing in 2D. Use the Plan View tool to restore top view. 

 

View Transition Options 

• VTENABLE: determines whether animated view transitions are enabled for zoom/pan and/or 
for view rotation operations. 

• VTDURATION: determines the duration of view transition animations in milliseconds. 

• VTFPS: defines the minimum frame rate required to allow animation. That is 7 by default, 
which means that the redraw time should take less than 143 (=1000/7) milliseconds. If the 
computer is not capable to redraw the view fast enough, no animation will be available. 

Restoring Orthographic and Isometric Views 

The Look From control allows to select a number of preset views such as orthographic views and 
isometric views. By default the Look From control displays in the top right corner of the graphic 

screen.  

If the UCSORTHO system variable is ON an orthographic UCS is restored automatically when the 
related orthographic view is chosen on the Look From control. 

System variables and user preferences 

The behavior of the Look From control depends on a number of system variables and user 

preferences 
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Name Title Description / Options 

NAVVIEWCUBEDISPLAY Look From Display 
Controls whether the Look From control 

displays. 

NAVVIEWCUBELOCATION Look From Location 

Controls the location of the Look From control 
in the drawing area. 

The options are: 

0: Top right corner. 

1: Top left corner 

2: Bottom left corner 

3: Bottom right corner 

NAVVIEWCUBEOPACITY Look From Opacity 

Sets the opacity of the Look From control 

when not active. 

Values between 1 (invisible) and 100 (no 
dimming) are accepted. 

NAVVIEWCUBEORIENT 
Look From 
Orientation 

Specifies the view orientation reference: 
either the WCS (World Coordinate System or 
the current UCS (User Coordinate System). 

LookFromFeedback 
Look From 
Feedback 

Controls the display and location of tooltips. 

0: No tooltips 

1: Tooltips next to the Look From control. 

2: Tooltips in the status bar. 

LookFromDirectionMode 
Look From Direction 

Mode 

Specifies the number of available view 
directions. 

Holding down the Ctrl-key switches between 
top-down and bottom-up view directions 

0: Orthogonal views only (6 directions). 

 

1: 6 Orthogonal views and 8 Isometric views 
(14 directions). 

 

2: 4 Rotated orthogonal, 6 Orthogonal and 8 
Isometric views (18 directions) 

 

3: 8 Rotated isometric, 4 Rotated orthogonal, 

6 Orthogonal and 8 Isometric views (26 
directions). 
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LookFromZoomExtents 
Look From Zoom 

Extents 

Determines whether a 'zoom extents' is 
performed whenever a  new view direction is 
selected. 

  

Setting the Look From mode 

1. Move the cursor to the Look From control.  
2. Right click, then select either Isometric Mode or Twist Mode in the context menu. 

 

 

Using the Look From control in Isometric mode 

Isometric mode is best used in 3D models. 

1. Move the cursor to the Look From control. 
The  Look From control becomes active.  

2. Position the cursor on the Look From control to choose a view orientation. 
A preview image and a tooltip indicate the currently selected view orientation.  

 

3. Click to confirm. 
The view is updated.  

NOTE VTENABLE setting determines whether animated view transitions are enabled for 
zoom/pan and/or for view rotation operations. 

VTDURATION setting determines the duration of view transition animations in 

milliseconds. 

VTFPS setting defines the minimum frame rate required to allow animation. That is 7 by 

default, which means that the redraw time should take less than 143 (=1000/7) 
milliseconds. If the computer is not capable to redraw the view fast enough, no animation 
will be available. 
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Using the Look From control in Twist mode 

Twist mode is best used in 2D drawings. 

In Twist mode, the Look From control allows to rotate the view around the screen Z-axis 

1. Move the cursor to the Look From control. 
The  Look From control becomes active.  

2. Do one of the following:  

• Move the cursor on the edge of the the Look From control. Left half for 
counterclockwise, right half for clockwise rotation. Click when the arrow is at the desired 
rotation angle. 
The following angles are available: 15°, 30°,45°, 60°, 90°, 120°, 135° and 180°, both 
clockwise and counterclockwise.  

If LookFromFeedback = 1, the angle displays in a tooltip. 

Click again to rotate over the same angle again. 
 
 

 
• Move the cursor to the center of the Look From control, then click to restore the view 

(= unrotated state). 
 

 

Real Time Sphere 

1. Do one of the following:  

• Click the Real-Time Constrained Sphere tool button ( )  

or the Real-Time Sphere tool button ( ) on the Real-Time Motion toolbar.  

• Choose Real-Time Motion > Real-Time Constrained Sphere  
or Real-Time Motion > Real-Time Sphere in the View menu.  

• Type rtrot , rtrotf or rtrotctr in the command bar, then press Enter.  

You are prompted: >> Press ENTER or Esc to complete, or right click to display context menu ... 

3. Press and hold the left mouse button. 
Move the mouse to rotate the view.  

• Using the Real-Time Constrained Sphere command horizontal mouse movement 
(parallel to the screen X-axis) rotates the 3D model about the world Z-axis.  

• Using the Real-time Sphere Center command you are prompted to specify a center 
point for the rotation first.  

4. (option) Right click to display a context menu:  



BricsCAD V18  Help 

 

 241 

 

5. To abort the Real-Time Sphere commands, do one of the following:  

• Right click, then choose Exit in the context menu..  

• Press Enter, space bar or Esc.  

Real Time X 

1. Do one of the following:  

• Click the Real-Time X tool button ( ) on the  Real-Time Motion toolbar.  

• Choose Real-Time Motion > Real-Time X in the View menu.  

• Type rtrotx in the command bar, then press Enter.  

You are prompted: >> Press ENTER or Esc to complete, or right click to display context menu ... 

2. Press and hold the left mouse button. 
Move the mouse to rotate the view.  

3. (option) Right click to display a context menu:  

 

4. To abort the Real-Time X command, do one of the following:  

• Right click.  

• Press Enter, space bar or Esc.  

Real Time Y 

1. Do one of the following:  

• Click the Real-Time Y tool button ( ) on the  Real-Time Motion toolbar.  

• Choose Real-Time Motion > Real-Time Y in the View menu.  

• Type rtroty in the command bar, then press Enter.  

You are prompted: >> Press ENTER or Esc to complete, or right click to display context menu ... 

2. Press and hold the left mouse button. 
Move the mouse to rotate the view.  

3. (option) Right click to display a context menu:  
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4. To abort the Real-Time Y command, do one of the following:  

• Right click.  

• Press Enter, space bar or Esc.  

Real Time Z 

1. Do one of the following:  

• Click the Real-Time Z tool button ( ) on the  Real-Time Motion toolbar.  

• Choose Real-Time Motion > Real-Time Z in the View menu.  

• Type rtrotz in the command bar, then press Enter.  

You are prompted: >> Press ENTER or Esc to complete, or right click to display context menu ... 

2. Press and hold the left mouse button. 
Move the mouse to rotate the view.  

3. (option) Right click to display a context menu:  

 

4. To abort the Real-Time Z command, do one of the following:  

• Right click.  

• Press Enter, space bar or Esc.  
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Preset Viewpoints 

1. Do one of the following:  

• Click the Set Viewpoint ... tool button ( ) on the View toolbar.  

• Choose Set Viewpoint ... in the View menu.  

• Type ddvpoint in the command bar, then press Enter.  

The Preset Viewpoint dialog opens. 

2. Click the Angle Precision button ( ) to choose a different display mode for the Set 
Viewpoint dialog.  

Then choose either 45°, 15° or 5°. 

  

 

45° display mode 

  

  

In 15° or 5° mode click in the inner area of the Horizontal and Vertical fields to choose a 45° 

display mode viewpoint. 
Click in the outer area of the Horizontal and Vertical fields to choose another angle. 

3. To set the Vertical view angle, do one of the following:  

• Skip this step to accept the default vertical view directions:  

• Horizontal for East, North, West and South. 

• Downwards for the other directions. 
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If both  the down- and left-arrow show in the Vertical field, the default vertical view directions are 

active. 

• Select a 45° mode angle in the inner area, then click to confirm your choice. 
A single arrow indicates the selected vertical view direction.  

• If in 15° or 5° mode in, select a view direction in the outer area, then click to confirm 
your choice. 
The selected angle displays in bold.  

 

The view is updated as you click. 

4. To set the Horizontal view angle, do one of the following:  

• Select a 45° mode angle in the inner area, then click to confirm your choice. 
An arrow indicates the selected horizontal view direction.  
The perspective of the arrow reflects the vertical view direction.  

 

• If in 15° or 5° mode in, select a view direction in the outer area, then click to confirm 
your choice. 
The selected angle displays in bold.  

The view is updated as you click. 

  

NOTE Use the Isometric Views toolbar for standard view rotations: top, front, back, left, right 
and isometric views. 
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Plan View 

Do one of the following:  

• Click the Plan View tool button ( ) on the View toolbar.  

• Choose Plan View in the View menu.  

• Type plan in the command bar, then press Enter.  

You are prompted: Plan view of: UCS/World/<current UCS>: 

A prompt menu opens: 

 

Press Enter to restore the plan view with respect to the current coordinate system.  

  

NOTES • If the WCS is the current coordinate system, the Current and World options 
have the same result. 

• If the UCSFOLLOW variable is set to ON, the plan view is generated whenever 

the UCS changes. 
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Layer States 

 

 

Use Layer States instead of Clicking Bulbs  

  

Layer states let you save and restore configurations of layer properties and states. You might want 
a layer to display in blue sometimes and green at other times, or you need some layers to be off or 
frozen or locked when editing a specific part of a drawing. After spending a lot of time adjusting all 
layer settings you can use layer states to save your settings. You can save multiple layer states in 

a each drawing. Layer states can be copied between drawings and you can save a layer state to an 
external file, which can then be imported in another drawing. 

To easily create layer states, the Layer Utility commands might be useful. 

  

 

Drawing Explorer: Layer States (Detail view) 

 

https://blog.bricsys.com/tutorials/
https://blog.bricsys.com/use-layer-states-instead-clicking-bulbs/
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/04_12_Layer_Utilities.htm
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Opening the Layer States Explorer 

1. In the Tools > Drawing Explorer menu choose Layer States... .  
2. (option) Do one of the following:  

• Click the Detail View button ( ). 
 

 

• Click the Icon View button ( ). 
 

 

Save the Current Layer State 

1. Open the Layer States explorer.  

2. Click the New button. ( ). 
A new layer state is created.  

3. Type a name for the layer state, replacing the NewLayerState1 default name.  
4. (option) When in Detail View type a description in the Description field.  
5. Select the Layer Properties to restore. 

Click the check box to select a layer property, click again to remove the selection. 

file:///C:/Users/Louis/AppData/Local/Temp/298462/04_Viewing_your_drawing/00_08_Layer_States.htm%23Opening_the_Layer_States_Explorer
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NOTE By default in a new layer state all layer properties are selected to be restored. 

 

Edit a Layer State 

1. Open the Layer States explorer.  

2. (option) Click the Overwrite button ( ) to overwrite the layer state with the current layer 
settings.  

3. If necessary, click the Tree View button ( ).  
4. Click the expand button of the layer state.  
5. (option) Rename the layer state.  
6. (option) Edit the layer state description.  

7. (option) Expand the Layer Properties to restore list. 
Click the check box to select a layer property, click again to remove the selection.  

file:///C:/Users/Louis/AppData/Local/Temp/298462/04_Viewing_your_drawing/00_08_Layer_States.htm%23Opening_the_Layer_States_Explorer
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Restore a Layer State 

1. Open the Layer States explorer.  
2. Select the layer state you want to restore.  
3. Select a Restore Option.  

The restore option applies to layers which are added after the selected layer state was 
created. 
The options are:  

• Turn Off.  

• Freeze.  

• Do nothing.  
4. Optionally check the Apply properties as viewport overrides option, which applies the layer 

state as viewport overrides (VP layer properties) to the current layout viewport. 
This option is available only on a layout within a layout viewport.  

5. Do one of the following:  

• Click the Restore button ( ).  

• Right click, then choose Restore in the context menu.  

4. Click the Regen button ( )  

  

NOTES • If REGENAUTO is on ( ), it is not necessary to press the Regen button in step 4. 

• Layer states can be restored using the Layer State control on the Layers panel. 
You can add the Layer State control to a toolbar. 

 

Copy Layer States to Another Drawing 

1. Open both, the source and the target drawing.  
2. Make the source drawing the current drawing.  

3. Open the Layer States explorer.  

4. If the layer states display in Tree View, choose either Detail View ( ) or Icon View ( ).  
5. Do one of the following  

• Select the layer state you want to copy.  

• Press and hold the Ctrl key to select multiple layer states.  

6. With the cursor on a selected layer state, press and hold the left mouse key, then drag the 
selection to the target drawing in the Open Drawings section of the Drawing Explorer 
dialog window.  

7. When on the target drawing, release the left mouse button. 
The selected layer states are copied to the target drawing.  

Export a Layer State 

1. Open the Layer States explorer.  
2. Select the layer state.  

3. Click the Export button ( ). 
The Export Layer States dialog opens.  

4. In the File Name field, type a name for the layer state.  
5. Choose a folder to save the layer state in.  

6. Click the Save button.  

file:///C:/Users/Louis/AppData/Local/Temp/298462/04_Viewing_your_drawing/00_08_Layer_States.htm%23Opening_the_Layer_States_Explorer
bricscad-cmdref.chm::/L/Layer/Layer.htm#ViewportLayerProperties
bricscad-cmdref.chm::/L/LayersPanelOpen.htm#LayerState
bricscad-cmdref.chm::/L/LayersPanelOpen.htm
file:///C:/Users/Louis/AppData/Local/Temp/298462/02_Defining_your_preferences/02_03_Creating_custom_tools.htm%23To_add_a_control_to_a_toolbar
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/00_08_Layer_States.htm%23Opening_the_Layer_States_Explorer
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/20_Managing_Drawings/00_02_Drawing_Explorer.htm
file:///C:/Users/Louis/AppData/Local/Temp/298462/04_Viewing_your_drawing/00_08_Layer_States.htm%23Opening_the_Layer_States_Explorer
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Import a Layer State 

1. Open the Layer States explorer.  

2. Click the Import button ( ). 
The Import Layer States dialog opens.  

3. Browse to the folder where you have saved the layer state file.  
4. Select the layer state.  
5. Click the Open button. 

The layer state is imported.  

  

NOTE If a layer state of the same name already exists in the drawing a warning displays. It is 
not possible to overwrite a layer state definition. 

 

Named Views 

Exploring Views 

You can save the view in the current window as a named view. Saved views can be restored at any 
time. 

A Background can be assigned to a named view, which will be used when the view is rendered. 

Exploring views 

1. Do one of the following:  

• Choose Drawing Explorer > Views... in the Tools menu.  

• Type either view or V in the command bar, then press Enter.  

The Drawing Explorer - Views window opens. 

2. (option) Click the blank tile in front of the View Name to restore a saved view. 
The current view is marked ( ). 
 

 

3. (option) Click the New button ( ) in the Drawing Explorer toolbar to save the current 
view.  

4. (option) Click the Delete button ( ) in the Drawing Explorer toolbar to delete the selected 
view.  

5. (option) Click the View Name, then right click and choose Rename in the context menu. 
Type a new name for the saved view.  

file:///C:/Users/Louis/AppData/Local/Temp/298462/04_Viewing_your_drawing/00_08_Layer_States.htm%23Opening_the_Layer_States_Explorer
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/04_07_Named_Views.htm%23BackgroundDefine
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/04_20_Rendering_General.htm
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6. (option) Check the Perspective property to make the view a visual perspective view.  

If not checked the view is a parallel perspective view. 
See also Define a View.  

7. (option) Click the Background column of a view to choose a background. 
The background definition of the view is applied during rendering.  

Saving a View 

1. Do one of the following:  

• Click the Save/Restore View tool button ( ) on the View toolbar.  

• Choose Save/Restore View in the View menu.  

• Type -view in the command bar, then press Enter.  

You are prompted: View: ? to list saved views/Delete/Restore/Save/Window: 

 

3. Do one of the following:  

• Choose Save in the View prompt menu.  

• Type S in the command bar, then press Enter  

4. Type a name for the view in the command bar, then press Enter. 
The current view is saved.  

  

NOTE If you type a name that is already used, the current view is saved, replacing the 
previously saved view. There is no warning when overwriting a saved view. 

 

Restoring a View 

1. Do one of the following:  

• Click the Save/Restore View tool button ( ) on the View toolbar.  

• Choose Save/Restore View in the View menu.  

• Type -view in the command bar, then press Enter.  

You are prompted: View: ? to list saved views/Delete/Restore/Save/Window: 

 

3. Do one of the following:  

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/04_06_Define_a_View.htm
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• Choose Restore in the View prompt menu.  

• Type R in the command bar, then press Enter  

4. Type the name of the saved view you want to restore in the command bar, then press 

Enter. 
The saved view is restored.  

Defining the View Background 

1. In the Drawing Explorer - Views dialog window, select Background in the Edit grid of the 
view.  

2. Click the settings field to display the Background options. 
 

 
3. Choose an option in the list. 

The Background dialog box displays: 

 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/04_07_Named_Views.htm%23Exploring_views
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4. (option) Select Solid in the Type list. 
Click the Color button  to define the color.  

5. (option) Select Gradient  in  the Type list.  

• Set the rotation angle  

• Choose Two or Three colors.  

• Click the Top, Middle and Bottom color buttons to define the color.  

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/10_Drawing_Entities/00_Entity_Creation_Settings/10_00_02_Entity_Color.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/10_Drawing_Entities/00_Entity_Creation_Settings/10_00_02_Entity_Color.htm
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6. (option) Select Image in the Type list. 

 

 

• Click the browse button next to the Image settings field to select a raster image file.  

• Choose an alignment. The options are: Center, Stretch and Tile.  

7. (option) Right click, then choose Set Current in the context menu if you want to use the 
newly defined background in a rendering right away.  

To Edit the View Background 

1. In the Drawing Explorer - Views dialog window, select Background in the Edit grid of the 
view..  

2. Click the settings field to display the Background options. 

 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/04_07_Named_Views.htm%23Exploring_views
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3. Choose Edit...  in the list to edit the current settings. 

The Background dialog box displays.  
4. Edit the settings needed, then click the OK button. 

Perspective Views 

Commands 

The Define View command dynamically defines parallel perspective or visual perspective views of 
your 3D models.  

The Camera command creates perspective views. 

  

The projection method of a view is controlled by the Perspective property of the view: 

• If ON, the view is a visual perspective view. 

• If OFF, the view is a parallel perspective view. 
  

  

Parallel Perspective View Visual Perspective View 

  

The following parameters are used in the Define View procedure: 

• Target Point: Defines the center of the view (1) 

• Camera Point: Defines the view point and view direction (2). 

• Distance to Target: Distance between the camera position an the target point (3). 
  

 

  

  

NOTE View manipulation tools, such as zoom, pan, real-time motion, are not available in visual 

perspective views. However, you can use the mouse to manipulate the view. 

 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/04_01_View_manipulation_using_the_mouse.htm
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Defining a Camera View 

The Camera command creates a named view. 

1. Do one of the following:  

• Click the Camera tool button ( ) on the View toolbar.  

• Choose Camera  in the View menu.  

• Type Camera  in the command bar.  

You are prompted: Specify camera location: 

2. Do one of the following:  

• Click a point in the drawing.  

• Type the coordinates of the camera location in the command bar and press Enter.  

You are prompted: Specify target location: 

3. Do one of the following:  

• Click a point in the drawing.  

• Type the coordinates of the target location in the command bar and press Enter.  

You are prompted: Enter an option: ?/Name/LOcation/Height/Target/LEns/Clipping/View/<eXit>: 

4. Do one of the following:  

• Press Enter to create the camera view using a default name (e.g. Camera1).  

• Enter an option:  

• Name: 
Prompts you: Enter name for new camera <Camera1>: 
Type a name at the command prompt, then press Enter.  

• Location: 
Prompts you: Specify camera location <current location>:  
Click a point or enter new coordinates of the camera location, then press 
Enter.  

• Height: 
Prompts you: Specify camera height <current height>: 
Enter a new height (Z-coordinate) for the camera location.  

• Target: 

Prompts you: Specify target location <current location>:  
Click a point or enter new coordinates of the target location, then press 
Enter.  

• Lens: 
Prompts you: Specify lens length in mm <50.00>: 
Enter an new lens length, then press Enter.  

• Clipping: 
Prompts you: Enable front clipping plane? <Yes>/No: 
Choose Yes to define the front clipping plane. 
Prompts you: Specify front clipping plane offset from target plane <0.00>:  
Type value in the command bare or specify the distance by clicking two 
points. 
 

Prompts you: Enable back clipping plane? Yes/<No>: 
Choose Yes to define the front clipping plane. 

Prompts you: Specify front clipping plane offset from target plane <0.00>:  
Type value in the command bare or specify the distance by clicking two 
points.  

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/04_07_Named_Views.htm
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• View: 

Prompts you: Switch to camera view? Yes/<No>: 
Choose Yes to display the camera view. 
This option concludes the Camera command.  

  

NOTE Choose Drawing Explorer > Views... in the Tools menu to edit a camera view. 

  

Toggle the Perspective Property of a View 

Do one of the following 

• Click the Perspective tool button ( ) on the View toolbar. 
The state of the tool button, pressed or not, indicates the current value of the 

PERSPECTIVE system variable.  

• Choose Perspective in the View menu.  

• Type perspective in the command bar. 
You are prompted: New current value for PERSPECTIVE (Off or On) <On>: 
A prompt menu displays. 
Do one of the following:  

• Type off or on in the command bar, then press Enter.  

• Choose Off or On in the prompt menu.  

  

NOTE In named views you can set the Perspective property in the Drawing Explorer - Views 

dialog. 

 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/04_07_Named_Views.htm
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Model Space and Paper Space 

When you start a drawing session, your initial working area is called Model Space. Model Space is 
an area in which you create two-dimensional and three-dimensional entities based on either the 
World Coordinate System (WCS) or a user coordinate system (UCS). You view and work in model 

space while using the Model tab. 

In general model space consists of a single view that fills the screen. If needed, you can create 
additional views, called viewports, which can show different views of your drawing or 3D model. All 
viewports are displayed in a tiled manner. You can work in only one of these viewports at a time 
but all viewports are updated simultaneously. Click in a viewport to make it the current viewport. 
You can print the current viewport only. The Viewports command lets you manage your viewports 

in model space. 

BricsCAD provides an additional work area, called Paper Space. Paper space represents a paper 
layout of your drawing. In this work area, you can create and arrange different views of your 

drawing similar to the way you arrange drawings on a sheet of paper. In paper space you can also 
add keynotes, annotations, borders, title blocks, and other print-related entities, which you don't 
want to see in model space.  

Each drawing has at least one Layout in which you can have one or more Layout Viewports. Such 

layout viewports are to be considered as a view window on your drawing in model space. Layout 
viewports can be placed anywere in a paperspace layout. Each viewport has its own scale and layer 
visibility. All viewports in the same layout can be printed simultaneously. 

The Mview command lets you manage your viewports in paper space. 

Although not necessary to print your drawing, paper space offers a lot of advantages: 

• Create multiple layouts to print the same drawing with different print settings, such as pen 
widths, printer configuration files, lineweight settings, drawing scale, and more.  

• Add print-related entities that are not essential to the model itself, such as keynotes, 
annotations, title blocks, etc. 

• For a single layout, create multiple layout viewports to print multiple views of your drawing 
at different scales. 

Switching between Model Space and Paper Space 

• To switch between Model Space and Paper Space Layouts use the Model and Layout tabs at 
the bottom of the drawing window.  

• When working in a layout, use the MSPACE and PSPACE commands to toggle between 
paper space and model space. 

Using the Model and Layout Tabs 

1. To open model space, click the Model tab (2) at the bottom of the drawing window.  
2. To open a paper space layout, click the corresponding Layout tab (3) at the bottom of the 

drawing window.  

3. Use Ctrl-PgUp or Ctrl-PgDn to switch to the previous or next layout tab.  

4. Click the navigation buttons to shift the tab display (1):  

5. : Display the model tab. 

6. : Shift one tab to the left. 

7. : Shift one tab to the right. 

8. : Shift to the last tab. 

 

  

  

NOTE A drawing contains at least one layout, which is named Layout1 by default. 

  

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/04_09_Model_Space_Viewports.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/04_10_Paper_space_viewports.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/04_08_Workspaces.htm%23Using_the_model_and_layout_tabs
bricscad-cmdref.chm::/M/MSpace.htm
bricscad-cmdref.chm::/P/PSpace.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/04_08_Workspaces.htm%23Toggle_between_model_space_and_paper_space
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/04_08_Workspaces.htm%23Toggle_between_model_space_and_paper_space
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Toggle between Model Space and Paper Space 

Commands:  MSPACE and PSPACE 

1. (option) When in model space (Model Space, with floating viewports) do one of the 
following to switch to paper space:  

• Type either pspace or ps, then press Enter  

• Double click outside a viewport.  

2. (option) When in paper space do one of the following to switch to model space (Model 
Space, with floating viewports):  

• Type either mspace or ms, then press Enter.  

• Double click inside a viewport.  

  

NOTE MSPACE and PSPACE commands are available 
when working in a layout only. 

 

bricscad-cmdref.chm::/M/MSpace.htm
bricscad-cmdref.chm::/P/PSpace.htm


  User Guide 

 260 

Model Space Viewports 

The display in model space (Model Space, with tiled viewports) can be divided into multiple 
viewports, each of which can contain a different view of the current drawing. All viewports are 
displayed in a tiled manner. You can work in only one of these viewports at a time but all viewports 

are updated simultaneously. When no command is active click in a viewport to make it the current 
viewport. You can print the current viewport only.  

The following settings can be defined differently for each viewport: 

• grid display and snap 

• coordinate system: WCS or UCS 

 

Model Space divided in 3 viewports 

  

Creating Viewports in Model Space 

1. Do one of the following:  

• Click the Viewports tool button ( ) on the Views toolbar.  

• Choose Viewports in the Views  menu.  

• Type vports in the command bar.  

You are prompted: Viewports: ? to list/Save/Restore/Delete/SIngle/Join/2/3/4/<3>: 

A prompt menu opens. 

 
  

2. (option) To create 2 viewports, do one of the following:  

• Choose Create 2 viewports in the prompt menu.  
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• Type 2 in the command bar, then press Enter.  

You are prompted. Two viewports: Horizontal/<Vertical>: 

  

Option Result 

Horizontal 

 

Vertical 

 

  

3.  (option) To create 3 viewports, do one of the following:  

• Choose Create 3 viewports in the prompt menu.  

• Type 3 in the command bar, then press Enter.  

You are prompted. Three viewports: Horizontal/Vertical/Above/Below/Left/<Right>:  

  

Option Result 

Horizontal 

 

Vertical 

 

Above   

 

Below   

 

Left   

 

Right   
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4. (option) To create 4 viewports, do one of the following:  

• Choose Create 4 viewports in the prompt menu.  

• Type 4 in the command bar, then press Enter.  

  

Option Result 

4 

 

  

   

Drawing in Multiple Viewports 

1. Click in a viewport to make it current. 
The border of the current viewport highlights.  

2. Draw the entities in the current viewport.  
3. (option) Repeat step 1 to make a different viewport current.   

NOTES • The crosshairs show in the current viewport only. 

• You can start a command in the current viewport, and finish the operation in a 
different viewport.  

 

Joining Viewports 

1. Launch the Viewports command.  
2. Select the Join command option. 

You are prompted: Select inside dominant viewport <Current>:  
3. Click in the dominant viewport or press Enter to choose the current viewport. 

The border of the selected viewport highlights. 
You are prompted. Select inside viewport to  join:  

4. Click the viewport to join again to confirm. 

The two selected viewports are joined.   

NOTE You can join viewports which share an edge of equal length only. 
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Paper Space Viewports 

The Mview command creates one or more viewports in layout tabs (short for "make viewports"). 

The MvSetup command creates multiple viewports; in model space the command creates a 
rectangle, representing a paper sheet with respect to a specified scale. 

The AlignSpace command adjusts viewport angle, zoom factor and pan position based on 
alignment points specified in model space and paper space. 

The Vpclip command clips viewports in layouts (short for "view port clipping"). 

In a layout you can create multiple viewports each of which displays a unique view of the entities 
created in model space. Each layout viewport functions as a window into your model space 
drawing. You can control the view, scale, and content of each layout viewport separately. 

A layout viewport is created as a separate entity that you can copy, delete, move, scale, and 
stretch as you would any other drawing entity. You can snap to the viewport borders using entity 

snap. When you are working in model space with floating viewports (see Toggle between model 
space and paper space), click any layout viewport to make it the current viewport, and then add or 
modify model space entities in that viewport. Any changes you make in one layout viewport are 
immediately visible in the other viewports (if the other layout viewports are displaying that portion 
of the drawing). Zooming or panning in the current viewport affects only that viewport.  

Each viewport has its own layer visibility settings. You can also turn off the display of the content 
of a viewport. 

To preserve the scaling of a viewport you can lock the display. It is no longer possible to zoom or 
pan in a locked viewport. 

Apart from viewports, you can add print-related entities in a paper space layout that are not 
essential to the model itself, such as keynotes, annotations, title blocks, etc. Such entities are part 
of a specific paper space layout and do not appear in other layouts or in model space. 

When you are working in a layout, either Model Space or Paper Space is your current workspace. 
The Workspace field in the Status Bar indicates which workspace is current: M:<Layout Name> 

indicates you are working in Model Space, while P:<Layout Name> means Paper Space is the 
current workspace. 

  

 

Model Space, with floating 
viewports of layout PLAN 

 

Paper Space of layout PLAN 

 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/04_08_Workspaces.htm%23Toggle_between_model_space_and_paper_space
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Displaying Paper Sheet and Printable Area 

 

1. Viewport  
2. Printable area. 

The display of the printable area is controlled through the DISPPAPERMARGINS system 
variable.  

3. Paper sheet. 
The display of the paper sheet is controlled through the DISPPAPERBKG system variable.  

  

bricscad-sysvar.chm::/00_07_Settings_Manager.htm
bricscad-sysvar.chm::/00_07_Settings_Manager.htm
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Creating Viewports in a Layout 

Command: MVIEW  

1. Click the appropriate layout tab at the bottom of the drawing window.  
2. Do one of the following:  

• Click the Paper Space Views tool button ( ) on the Views toolbar.  

• Choose Paper Space Views in the Views menu.  

• Type mview at the command prompt, then press Enter.  

You are prompted: Viewports. ON/OFF/Fit/2/3/4/<First corner>: 

A prompt menu opens: 

 

(option) To add 1 viewport. do one of the following:  

• Click to specify the first corner of the viewport, then specify the opposite corner. 
A single viewport which fits in the specified rectangle is created.  

• Choose Fit to view in the prompt menu or type F, then press Enter. 
A single viewport which fits in the current drawing display window is created.  

(option) To create 2 viewports, do one of the following:  

• Choose Create 2 viewports in the prompt menu.  

• Type 2 in the command bar, then press Enter.  

You are prompted. Two viewports: Horizontal/<Vertical>: 

  

Option Result 

Horizontal 

 

Vertical 

 

  

bricscad-cmdref.chm::/M/MView.htm
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You are prompted: Fit to screen/<First corner of bounding rectangle>: 

• Click to specify the first corner of the bounding rectangle, then specify the opposite 
corner. 
Two viewports which fit in the specified bounding rectangle are created.  

• Choose Fit to view in the prompt menu or type F, then press Enter. 
Two viewports which fit in the current drawing display window are created.  

5. (option) To create 3 viewports. do one of the following:  

• Choose Create 3 viewports in the prompt menu.  

• Type 3 in the command bar, then press Enter.  

You are prompted. Three viewports: Horizontal/Vertical/Above/Below/Left/<Right>: 

  

Option Result 

Horizontal 

 

Vertical 

 

Above 

 

Below 

 

Left 

 

Right 

 

   

You are prompted: Fit to screen/<First corner of bounding rectangle>: 

• Click to specify the first corner of the bounding rectangle, then specify the opposite 
corner. 
Three viewports which fit in the specified bounding rectangle are created.  

• Choose Fit to view in the prompt menu or type F, then press Enter. 

Three  viewports which fit in the current drawing display window are created.  
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6. (option) To create 4 viewports. do one of the following:  

• Choose Create 4 viewports in the prompt menu.  

• Type 4 in the command bar, then press Enter.  

  

Option Result 

Create 4 
viewports 

 

  

You are prompted: Fit to screen/<First corner of bounding rectangle>: 

• Click to specify the first corner of the bounding rectangle, then specify the opposite 
corner. 
Four viewports which fit in the specified bounding rectangle are created.  

• Choose Fit to view in the prompt menu or type F, then press Enter. 
Four viewports which fit in the current drawing display window are created.  

7. (option) To create a non-rectangular (clipped) viewport using an existing polyline or circle, 
do one of the following:  

• Choose Object in the prompt menu.  

• Type O in the command bar, then press Enter.  

You are prompted: Select Object to clip viewport. 

Select a closed polyline or a circle in the layout. 

8. (option) To create a non-rectangular (clipped) viewport, do one of the following:  

• Choose Polygonal in the prompt menu.  

• Type P in the command bar, then press Enter.  

You are prompted: Specify start point: 

Specify the vertices of the non-rectangular viewport. Right click or press Enter to create the 

viewport. 
  

NOTES • Make sure no other viewports display when choosing the Fit to view option 
because they will be hidden behind the newly created viewport. 

• Each newly created viewport shows all entities on the layers which are currently 
visible in model space. 

• Since a new viewport is created on the current layer it is recommended to use a 
dedicated layer for viewport entities. Make this layer current when you want to 
add a new viewport. If you don't want the viewport outlines to be printed, set 
the Do Not Plot property of the viewport layer. 

• Only circles and closed polylines can be used to create a clipped viewport. If you 
want to create an elliptical viewport, use the Polyline Ellipse variable to create a 
polyline representation of an ellipse. 

• To select a clipped viewport do the following: Click the viewport border. Both 
the viewport and the clipping polygon are selected then, as indicated in the 

Properties Bar: the list button caption reads: All (2). Press the list button and 

select Viewport to see the properties of the viewport. 

 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/10_Drawing_Entities/01_Drawing_2D_Entities/10_01_09_Ellipses.htm%23Setting_the_Polyline_Ellipse_variable
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/01_User_Interface/00_06_Properties_Bar.htm
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  User Guide 

 268 

Creating an Array of Layout Viewports 

Command: MVSETUP 

1. Type mvsetup in the command bar. 
You are prompted: Enter an option [Align/Create/Scale viewports/Undo]:  

2. Do one of the following:  

• Type C in the command bar, then press Enter.  

• Choose Create in the context menu.  

You are prompted: Enter an option [Delete objects/Create viewports/Undo] <Create>: 

3. Press Enter to accept the default option. 
You are prompted: Enter choice for layout options <0-3> [none(0)/single(1)/std. 
engineering(2)/array of viewports(3)] <0>:  

4. Do one of the following:  

• Type 3 in the command bar, then press Enter.  

• Choose Array of Viewports in the prompt menu.  

You are prompted: Specify first corner of bounding area for viewport(s):  

5. Pick a point in the layout. 
You are prompted: Other corner of rectangle:  

6. Pick a second point in the layout. 
You are prompted: Enter number of viewports in X direction <1>:  

7. Specify the number columns in the array. 
You are prompted: Enter number of viewports in Y direction <1>:  

8. Specify the number of rows in the array. 

You are prompted: Specify distance between viewports in X direction <0.000>:  
9. Do one of the following:  

• Press Enter, to create contiguous viewport columns.  

• Specify the horizontal distance between the viewports.  

You are prompted: Specify distance between viewports in Y direction <horizontal distance>: 

Do one of the following:  

• Press Enter to set the vertical spacing equal  to the horizontal spacing.  

• Type 0 (zero) to create contiguous viewport rows.  

• Specify the vertical spacing between the viewports.  

The viewports are created. 

Press Enter to conclude the command.  

bricscad-cmdref.chm::/M/MvSetup.htm
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To Clip a Viewport 

Command: VPCLIP 

1. Type vpclip in the command bar, then press Enter. 
You are prompted: Select viewport to clip:  

2. Select the viewport. 
You are prompted: Polygonal <Select clipping object>: 
A prompt menu displays.  

 

Do one of the following:  

• Select the clipping object.  

• Choose Polygonal in the prompt menu or type P, then press Enter. 
You are prompted to draw a polyline.  

The viewport is clipped. 
  

NOTE • Only closed polylines and circles are accepted as clipping boundaries. 

• If you want elliptical viewports, use the polyline representation to create the 
ellipses. 

 

To Remove the Clipping Boundary of a Viewport 

Command: VPCLIP 

1. Type vpclip in the command bar, then press Enter. 
You are prompted: Select viewport to clip:  

2. Select a clipped viewport. 

You are prompted: Polygonal/Delete<Select clipping entity>:  
3. Do one of the following:  

• Type D, then press Enter.  

• Choose Delete in the prompt menu.  

bricscad-cmdref.chm::/V/VpClip.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/10_Drawing_Entities/01_Drawing_2D_Entities/10_01_04_Polylines.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/10_Drawing_Entities/01_Drawing_2D_Entities/10_01_09_Ellipses.htm%23Setting_the_Polyline_Ellipse_variable
bricscad-cmdref.chm::/V/VpClip.htm
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Defining Viewport Properties 

1. Select the viewport. 
The viewport properties display in the Properties Bar.  

 

2. Click the settings field of a property to modify.  

Properties 

Name Description 

Center 

XYZ coordinates of the center point of the viewport. 

To specify the center of the viewport graphically, drag the center handle of the 
viewport. 

Height (*) 

Height of the viewport in drawing units. 

To specify the height of the viewport graphically, drag the top or bottom handle of 
the viewport. 

Width (*) 

Width of the viewport in drawing units. 

To specify the width of the viewport graphically, drag the left or right handle of the 
viewport. 

On Controls the display of the content of the viewport. 

Clipped Allows to create non-rectangular viewports.  

 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/01_User_Interface/00_06_Properties_Bar.htm
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Display 

locked 
Locks the scaling of the viewport content to preserve the scaling factor. 

Scale 

The SCALELISTEDIT command allows to edit the available scales in the current 
drawing. 

  

Annotation scale 

Sets the annotation scale for the viewport. 

If the ANNOALLVISIBLE system variable is OFF, annotative entities which do not 
supoort the annotation scale do not display. 

  

Standard scale 

The Standard scale field automatically matches the Annotation scale field. Although 
you can set the Standard scale field different from the Annotation scale field 

manually, it is not recommended if annotative entities exist in the drawing. 

The Standard scale field reads 'Custom' if the value in the Custom scale field is not 
available in the drawings scale list. 

  

Custom scale 
Displays the viewport scale factor. 

Allows to set the viewport scale to a scale which is not available in the drawings 
scale list. 

Standard 
scale (*) 

Lets you choose a standard scaling factor. 

  

Custom 

scale (*) 

Lets you define the scaling factor in a decimal format. Displays the current scaling 

factor. 

UCS per 

viewport 
If Yes, lets you define a UCS for this viewport. 

Shade Plot Defines how the viewport will be plotted. 

The options are: 

 

(*) You must choose the width and height of a paperspace viewport with respect to the viewport 
scale.  

bricscad-cmdref.chm::/S/ScaleListEdit.htm
bricscad-sysvar.chm::/00_07_Settings_Manager.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/10_Drawing_Entities/08_AnnotativeEntities/10_08_00_Overview.htm
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Navigating in a Paper Space Layout 

View manipulation commands, such as zoom, pan and view manipulation using the mouse, act 
slightly different in a paper space layout compared to model space (with tiled viewports). 

If you are working in paper space (no viewport selected), view manipulation commands act on the 
complete paper space layout. 

If you are working in a viewport (model space with floating viewports), view manipulation 
commands act on the active viewport only. Except if the display of the current viewport is locked, 
then the view manipulation commands act on the complete paper space layout. 

  

NOTE It is not possible to rotate the display of a paper space layout.  

View Rotate commands are available in viewports of which the display is not locked only. 

 

Setting the Layer Visibility in a Viewport 

1. Do one of the following: 

• If Paper Space is the current workspace: double click inside the viewport to make it the 
current viewport.  

• If Model Space with floating viewports is the current workspace: click inside the 
viewport to make it the current viewport.  

2. Select the layer in the layer list of the Entity Properties toolbar. 
 

 
 

  

3. Do one of the following: 

4. Click the Thawed icon ( ) of the layer(s) you want to freeze in the current viewport. 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/04_05_View_Rotation.htm
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5. Click the Frozen icon ( ) of the layer(s) you want to thaw in the current viewport. 

6. (option) Repeat the previous steps to set the layer visibility in another viewport. 

 

Using the Drawing Explorer / Layers dialog 

1. Do one of the following:  

• If Paper Space is the current workspace: double click inside the viewport to make it the 
current viewport.  

• If Model Space with floating viewports is the current workspace: click inside the 
viewport to make it the current viewport.  

2. Do one of the following.  

• Click the Layers... tool button on the Settings toolbar.  

• Choose Layers... in the Settings menu.  

• Type layer in the command bar, then press Enter.  

The Drawing Explorer - Layers window opens. 

3. In the VP Freeze column:  

• Click the Thawed icon ( ) of the layer(s) you want to freeze.  

• Click the Frozen icon ( ) of the layer(s) you want to thaw.  

4. Close the Drawing Explorer - Layers window.  
5. (option) Repeat the previous steps to set the layer visibility in another viewport.  

  

NOTE Use the Viewports / Vpfreeze option of the LAYOFF and LAYFRZ commands to freeze 
layers in a viewport by clicking entities. 

  

Setting the Scale of a Viewport 

1. Make sure the Plot Scale property of the layout is set correctly.  
2. Switch to paperspace. 

(See Toggle between model space and paper space)  
3. Click the viewport border. 

The viewport properties display in the BricsCAD Properties Bar.  
4. Do one of the following:  

• Select the Annotation scale field, then click the Browse button ( ) and select a scale 
in the scale list. 
The Standard scale and Custom scale fields are updated automatically.  

• Select the Standard scale field, then click the Browse button ( ) and select a scale in 
the scale list. 
The Custom scale field is updated automatically.  

• Select the Custom scale field and type the scale factor. 
If the scale factor is not available in the drawings scale list, the Standard scale field 
reads 'Custom'.  

5. (option) If necessary, adjust the size of the viewport to the new scale.  
6. (option) Set the Display Locked property to Yes. 

The scale fields are greyed out and cannot be edited anymore.  

 

bricscad-cmdref.chm::/L/LayOff.htm
bricscad-cmdref.chm::/L/LayFrz.htm
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NOTE In a locked viewport it is impossible to: 

• zoom, pan or rotate the view 

• modify the scale 

 

Setting the Scale of a Selection of Viewports 

Command: MVSETUP 

1. Make sure the Plot Scale property of the layout is set correctly.  
2. Type mvsetup in the command bar. 

You are prompted: Enter an option [Align/Create/Scale viewports/Undo]:  
3. Do one of the following:  

• Type S in the command bar, then press Enter.  

• Choose Scale viewports in the prompt menu.  

You are prompted: Select entities 

4. Select the viewports.  
5. Press Enter or right click to stop selecting viewports. 

You are prompted: Set the scaling mode of viewports: Interactively/<Uniform>:  
6. Do one of the following:  

• Press Enter to set the scale of the selected viewports uniformly. 
You are prompted: Enter the number of paper space units <1.0>:  

• Press Enter to accept the number of paper space units. 
You are prompted: Enter the number of model space units <1.0>:  

• Type the desired scaling factor: e.g. 50 to apply a 1/50 scale.  

• Press Enter to apply the scale to all selected viewports.  

• Press Enter to conclude the command.  

• Choose Interactively in the prompt menu or type I, then press Enter. 
The first viewport in the selection set highlights. 
You are prompted: Enter the number of paper space units <1.0>:  

• Press Enter to accept the number of paper space units. 
You are prompted: Enter the number of model space units <1.0>:  

• Type the desired scaling factor: e.g. 50 to apply a 1/50 scale.  

• Press Enter to apply the scale to the viewport. 
The next viewport highlights. 
You are prompted: Enter the number of paper space units <1.0>:  

• Repeat the previous steps for each of the selected viewports.  

7. Press Enter to conclude the command.  

Rotating the Display in a Viewport 

The display of a layout viewport can be rotated only if the display of the viewport is not locked. 

If the VPROTATEASSOC system variable is ON, the ROTATE command rotates the content of a 
viewport over a specified angle. 

The Align > Rotate option of the MVSETUP command rotates the content of a viewport relative to 
the X-axis of  the world coordinate system (WCS). 

Rotating the viewport display 

1. Select the viewport, then right click and choose 2D Rotate in the context menu. 
You are prompted: Rotation point.  

2. Use the Center (  ) entity snap to select the center point of the viewport as the rotation 
point. 

You are prompted: Copy/Base angle/<Rotation angle> <0>:  
3. Type the rotation angle, then press Enter.  
4. The content of the viewport is rotated over the specified angle.  

bricscad-cmdref.chm::/M/MvSetup.htm
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Defining the rotation angle of the viewport display 

1. Type mvsetup in the command bar. 
You are prompted: Enter an option [Align/Create/Scale viewports/Undo]:  

2. Do on of the following:  

• Type A in the command bar, then press Enter.  

• Choose Align in the prompt menu.  

You are prompted: Enter an option [Angled/Horizontal alignment/Vertical alignment/Rotate 
view/Undo]: 

3. Do one of the following:  

• Type R in the command bar, then press Enter.  

• Choose Rotate view in the prompt menu.  

You are prompted: Specify basepoint in the viewport to be rotate: 

4. Specify the rotation point in the viewport. 

You are prompted: Specify rotation angle:  

5. Type the rotation angle in the command bar, then press Enter. 
The viewport display is rotated over the specified angle with respect to the X-axis of the 

WCS. 
  

NOTE Type 0 (zero) in the final step of the above procedure to undo the rotation of the viewport 
display. 

 

To Align Viewports 

Command: MVSETUP 

1. Type mvsetup in the command bar. 
You are prompted: Enter an option [Align/Create/Scale viewports/Undo]:  

2. Do on of the following:  

• Type A in the command bar, then press Enter.  

• Choose Align in the prompt menu.  

You are prompted: Enter an option [Angled/Horizontal alignment/Vertical alignment/Rotate 
view/Undo]: 

3. Do one of the following:  

• To align two viewports horizontally:  

• Choose Horizontal alignment in the context menu or type H in the command 
bar, then press Enter. 
You are prompted: Specify basepoint:  

• Pick a point in the reference viewport. 
You are prompted: Specify point in viewport to be panned:  

• Pick a point in the viewport to be aligned. 
The display in the viewport is moved vertically to align the two points 

horizontally.  

• To align two viewports vertically:  

• Choose Vertical alignment in the context menu or type V in the command 
bar, then press Enter. 
You are prompted: Specify basepoint:  

• Pick a point in the reference viewport. 

You are prompted: Specify point in viewport to be panned:  

bricscad-cmdref.chm::/M/MvSetup.htm
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• Pick a point in the viewport to be aligned. 

The display in the viewport is moved horizontally to align the two points 
vertically.  

To Align Model Space and Paper Space Points 

Command: ALIGNSPACE 

Aligning 1 point 

1. Type alignspace in the command bar, then press Enter. 
You are prompted: First alignment point in Model space:  

2. Click inside a layout viewport, then pick a point. 
You are prompted: Second alignment point in Model space or <Return> for none:  

3. Right click or press Enter. 
You are prompted: Alignment point in Paper space:  

4. Pick a point in the layout. 

You are prompted: Activate the viewport which will be used for alignment.  
5. Click inside the viewport you want to align.  
6. Right click or press Enter to confirm. 

The display in the selected viewport is moved to make the two points coincident.  

Aligning 2 points 

1. Type alignspace in the command bar, then press Enter. 
You are prompted: First alignment point in Model space:  

2. Click inside a layout viewport, then pick a point. 
You are prompted: Second alignment point in Model space or <Return> for none:  

3. Pick a second point in the layout viewport. 

You are prompted: First alignment point in Paper space:  

4. Pick a point in the layout. 
You are prompted: Second alignment point in Paper space:  

5. Pick a second point in the layout. 
You are prompted: Activate the viewport which will be used for alignment.  

6. Click inside the viewport you want to align.  
7. Right click or press Enter to confirm. 

The display in the selected viewport is moved, rotated and/or scaled to make the points 
two by two coincident. 

bricscad-cmdref.chm::/A/AlignSpace.htm
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Layouts 

In BricsCAD, you can create up to 255 layouts in a single drawing. Each layout represents a sheet 
of paper. For each layout you can specify the print area, print scale, lineweight scale, pen 
mappings, and add viewports, dimensions, a title block, and other geometry specific to the layout. 

The entities you add to a layout in paper space do not appear in model space. 

Each layout requires at least one layout viewport. If the CREATEVIEWPORTS system variable is ON 
a viewport is added automatically in a new layout. If this variable is OFF, newly created viewports 
are empty. To add new layouts you can either define them yourself or your can import layouts 
from another drawing: template file (.dwt), drawing file (.dwg) or drawing interchange file (.dxf). 

Viewports can display all or part of  the drawing’s model space entities. 

The CACHELAYOUT system variable controls whether the content of layouts is cached. The extra 
memory required for caching is made up for by improvements to the memory requirements for 
displaying entities, the net result being that the memory needed to display drawings has been 
reduced. As a result of this switching between layouts is up to 10 times faster now.  

The Ctrl-PgUp or Ctrl-PgDn keyboard shortcuts allow to open the next or previous layout. 

Creating a new Layout 

1. Do one of the following:  

• Click the New Layout tool button ( ) on the Layout or the  Insert toolbar.  

• Choose New Layout in the Insert menu.  

• Type layout in the command bar, press Enter, then type N and press Enter.  

You are prompted: Enter a layout name. <Layout1>: 

2. Do one of the following:  

• Type a unique name for the layout, then press Enter. 
The name can be up to 255 characters in length and can contain letters, numbers, the 
dollar sign ($), hyphen (-), and underscore (_), or any combination.  

• Right click or press Enter to accept the default name (e.g. Layout1).  

The new layout tab is added. 

3. Create at least one viewport (see Creating viewports in a layout).  

If the CREATEVIEWPORTS system variable is ON a viewport is added automatically in a new layout. 

Copying Layouts 

1. Right click the layout tab you want to copy. 

A context menu displays.  
2. Choose Copy in the context menu. 

You are prompted: Enter new layout name:  
3. Type a new unique name in the command bar, then press Enter. 

A copy of the selected layout is added.  

bricscad-sysvar.chm::/00_07_Settings_Manager.htm
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file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/04_10_Paper_space_viewports.htm%23Creating_viewports_in_a_layout
bricscad-sysvar.chm::/00_07_Settings_Manager.htm


  User Guide 

 278 

Importing Layouts 

1. Right click the Model tab or one of the layout tabs. 
A context menu displays.  

2. Choose From Template... in the context menu. 
The  Select Template From File window opens.  

3. Browse to the drawing that you want to import layouts from.  
4. Click the Open button on the  Select Template From File window. 

The Insert Layout(s) window opens.  
5. Select the layout(s) you want to import. 

Press and hold the Ctrl key to select multiple layouts.  
6. Click the OK button on the Insert Layout(s) window. 

The selected layouts are imported.  

Renaming Layouts 

1. Double click the layout tab you want to rename. 
The Rename Layout dialog opens.  

2. Type a new unique name in the Name field of the Rename Layout dialog.  
3. Click the OK button on the Rename Layout dialog.  

Arranging Layout Tabs 

Drag the layout tab to the desired position 

or 

1. Right click the layout tab you want to move. 
A context menu displays.  

2. Do one of the following:  

• Choose Move Right.  

• Choose Move Left.  

3. To move the selected layout tab do one of the following:  

• Select the number of tab positions.  

• Choose Move to Last Layout or Move to First Layout.  
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Deleting a Layout 

1. Right click the layout tab you want to move. 
A context menu displays.  

2. Choose Delete in the context menu. 
The selected layout is deleted.  

Deleting Multiple Layouts 

1. Do one of the following: 

2. Choose Drawing Explorer > Page Setups... in the Tools menu. 

3. Choose Page Setup... in the File menu. 

The Drawing Explorer - Page Setups dialog displays. 

2. Select the layouts you want to delete. 
To select a series of layouts: select the first layout, then press and hold the Shift key and 
select the last layout. 
Press and hold the Ctrl-key to add/remove layouts. 
 

  

3. Click the Delete tool button ( ) in the toolbar on the Drawing Explorer - Page Setups 
toolbar. 
An alert box displays: 
 

 

4. Press the Yes button on the Delete Layouts alert box. 
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Generated Drawing Views 

Commands: VIEWBASE, VIEWSECTION, VIEWSECTIONSTYLE, VIEWPROJ, VIEWDETAIL, 
VIEWDETAILSTYLE, VIEWUPDATE, VIEWEXPORT and VIEWEDIT 

  

The Generated Drawing Views functionality allows to automatically  generate associative 
orthographic and standard isometric views of a 3D solid model. All drawing views are placed in a 
paper space layout, they are not visible in model space. 

Analytical hidden line removal (HLR) procedures are used to create the drawing views using 
standard 2D entities, mostly lines and arcs. Much like the result of the FlatShot command. Drawing 
views created in V14.1 will be automatically converted into HLR geometry by the ViewUpdate 

command. 

  

 

  

The ViewBase command generates associative orthographic and standard isometric views of a 3D 

solid model in a paper space layout. 

The ViewSection command creates a cross section view based on a standard drawing view 
generated by the ViewBase command in a paper space layout. 

The ViewSectionStyle command allows to modify the appearance of the section views created by 
the ViewSection command. 

The ViewProj command generates additional projected views from an existing generated drawing 

view. 

The ViewDetail command creates a detail view of a portion of a standard generated drawing, at a 
larger scale. 

bricscad-cmdref.chm::/V/ViewBase.htm
bricscad-cmdref.chm::/V/ViewSection.htm
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The ViewdetailStyle command allows to modify the appearance of the detail views created by the 

ViewDetail command. 

The ViewUpdate command Updates a selection of drawing views obtained by ViewBase and 
ViewSection when VIEWUPDATEAUTO = 0. 

The ViewExport command exports the content of drawing views obtained by ViewBase and 
ViewSection to the Model Space of the drawing. This command can be used in paper space only. 

The ViewEdit command allows changing the scale and the hidden line visibility of drawing views. 

  

NOTE Drawing views generated in V14.2 or higher will show correctly in BricsCAD V13. The 
most recent V13.2 version is recommended. 

Drawing views generated in V14.2 or higher do not display in V12 and older BricsCAD 

versions. 

  

Commands and Toolbars 

Tools to generate drawing views of your 3D solid model are available on: 

  

The Drawing Views toolbar, which is a flyout of the View toolbar:  

 

  

The Section Types and Detail Section Types toolbars: 

 

 

  

The View | Drawing Views  menu: 
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The Drawing Views panel of the Annotate Ribbon tab. 

  

 

  

Standard Drawing Views 

Standard views include multiview orthographic and isometric projections. 

In a technical drawing, a multiview orthographic projection is an illustration technique in which up 
to six images of an object are generated, with each projection plane parallel to one of the 

coordinate axes of the object. 

Isometric projection is a method represent three-dimensional objects in two dimensions in 
technical and engineering drawings. It is an axonometric projection in which the three coordinate 
axes appear equally foreshortened and the angles between any two of them are 120 degrees. 

To generate the standard views of your 3D solid model, run the ViewBase command from model 
space.  

You can choose between first angle (European) projection or third angle (American) projection. 

Orthographic projection (or orthogonal projection) is a means of representing a three-dimensional 
object in two dimensions. It is a parallel projection, where all the projection lines are orthogonal to 
the projection plane, resulting in every plane of the scene appearing in affine transformation on 
the viewing surface. It is further divided into multiview orthographic projections and axonometric 
projections. 

Two projection planes, one horizontal (H.P.) and one vertical (V.P.) divide the space in four 

quarters.  

• In the first angle projection system the model is placed in the first quarter space (first angle). 

• In the third angle projection system the model is placed in the third quarter (third angle). 

bricscad-cmdref.chm::/V/ViewBase.htm
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With multiview orthographic projections, up to six pictures of a 3D model are produced, with each 
projection plane parallel to one of the coordinate axes of the model. The views are positioned 
relative to each other according to either of two schemes: first-angle or third-angle projection. In 
each, the appearances of views may be thought of as being projected onto planes that form a 6-
sided box around the model. 
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The projection type is set by the Projection Type option of the ViewBase command or by editing 
the PROJECTIONTYPE system variable: 

• 0 = First angle projection 

• 1 = Third angle projection 
The value of the PROJECTIONTYPE system variable is saved in the drawing. 

Generated drawing view lines are created on default layers: 

• BM_Isometric_Hidden 

• BM_Isometric_Visible 

• BM_Ortho_Hidden 

• BM_Ortho_Visible 
The display of the BM_Isometric_Hidden layer is turned off by default. 

  

Additional projected views can be added using the ViewProj command. A projected view inherits 
the scale, display settings and alignment from the parent view.  

Generating Cross Section Views 

A cross section is the intersection of a 3D solid model with a section plane. In technical drawings, 
the internal parts of the 3D model are hatched in cross sections. 

To generate section views of a 3D solid model, run the ViewSection command from the paper 
space layout where the standard drawing views exist. 

  

bricscad-cmdref.chm::/V/ViewBase.htm
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Updating Drawing Views 

By default BricsCAD checks whether the source 3D solid model was modified and automatically 
recalculates the drawing when: 

• opening a paper space  layout containing out-of-date views if the VIEWUPDATEAUTO system 
variable is ON. 

• running the ViewUpdate command. 

• running the BmUpdate command (BricsCAD Platinum only). 
  

NOTES • Hidden line removal calculation might take some time for complex 3D models. In 
such cases it is recommended to set VIEWUPDATEAUTO = OFF. The viewport 
border of out-of-date drawing views turns red to indicate an update is needed. 
When executing the ViewUpdate command, BricsCAD prompts you to either select 
the drawing views to be updated or update all drawing views. 

• If GENERATEASSOCVIEWS = ON, associative dimensions will be updated according 
to the modified 3D geometry. 

  

bricscad-cmdref.chm::/V/ViewUpdate.htm
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Exporting Views to Model Space 

The associativity mechanism  of drawing views in a paper space layout allow limited control by the 
user. Such views can be moved or scaled, but you cannot edit the geometry. In order to get the 
full control to the drawing views geometry the ViewExport command allows to move or copy 
drawing views to model space or to a separate drawing.  Exported drawing views loose their 

associativity with the 3D model and become standard blocks, which can be exploded, edited, 
erased, etc&ldots; 

Customizing drawing Views 

The first time the ViewBase command is launched, four new layers are created: 

• BM_Ortho_Hidden: hidden lines in drawing views 

• BM_Ortho_Visible: visible lines in drawing views 

• BM_Tangent_Hidden: hidden tangent lines in drawing views 

• BM_Tangent_Visible: visible tangent  lines in drawing views 
Use the ViewEdit command to change the visibility of these layers for all view or for selection of 

views only. 

• Edit the properties of these layers, such as linetype, lineweight or color, to modify the display 
of the drawing views.  

• Use ViewSectionStyle command to adjust different properties of section views such as:style, 
color, and height of identifier text 

• start and end symbols, their colors, size and direction of arrows scale, patter, color, and angle 
of hatches 

• color, type, and weight of a line representing a cutting plane 
Use the ViewDetailStyle command to adjust different properties of details views such as: 

• style, color, height of identified text, and the type of identifier 

• symbol, and its color and size 

• color, type, and weight of detail view boundary 

bricscad-cmdref.chm::/V/ViewExport.htm
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Creating Entities 

In a drawing you can create a variety of different entity types. Drawing entities can be very simple 

such as lines, circles, arcs, points and rays or complex such as polylines, splines and planes. Apart 
from 2D entities you can also create 3D surface entities or 3D solids in BricsCAD.  

To further complete your drawing BricsCAD provides a series of tools to add text, hatching and 
dimensions. 

To create an entity you can choose between selecting the command in the Draw menu, using the 
tools on the Draw, Draw 3D and Solids toolbars or typing the command in the command bar. 

When you use a tool or a drawing command, the program prompts you to enter coordinate points, 
such as endpoints or insertion points. You can enter the points or distances either using a mouse 
or by typing coordinate values in the command bar. As you draw, BricsCAD also displays a context-
sensitive prompt menu with appropriate additional options for the type of entity you are drawing. 

New entities are created on the current layer, using the current color, linetype and lineweight. 

Entity Creation Settings Overview 

The following settings control the display and/or creation of entities. 

  

Name 
Command 
or System Variable 

Description 

Creation 

Current Entity 
Color 

COLOR 

Sets the color of new entities. 

Current Layer  CLAYER Sets the layer for new entities. 

Current Entity 
Linetype 

CELTYPE Sets the linetype for new entities. 

Current Entity 
Linetype Scale 

CELTSCALE Sets the linetype scaling factor for new entities. 

Current Entity 
Lineweight 

CELWEIGHT Sets the lineweight for new entities. 

Transparency  CETRANSPARENCY Sets the transparency level for new entities. 

Elevation ELEVATION 
Specifies the current elevation for new entities 
relative to the current UCS. 
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Display 

Lineweight 

Display 

LWDISPLAY Controls whether lineweights display on the screen. 

Default 
Lineweight 

LWDEFAULT Defines the default lineweight. 

Lineweight 
Units 

LWUNITS 
Defines whether lineweights are expressed in 
millimeters or inches. 

Linetype Scale LTSCALE 
Sets the linetype scaling factor for all entities in the 
drawing (global linetype scale). 

Transparency 

Display 
TRANSPARENCYDISPLAY 

Specifies whether entity transparencies display in 
2DWireFrame visual style. 

Rendered visual styles always display entity 
transparency. 

Whip Arcs WHIPARC 

Determines whether circles, arcs, ellipses, elliptical 
arcs and arc segments of polylines display as true 
curves or as a series of vectors. 

Fill mode FILL 

Specifies whether multilines, traces, solids, hatches 
(including solid-fill) and wide polylines are filled in. 

  

The current properties display in the Properties Bar and in the Entity Properties toolbar. 

  

 

  

Properties Bar 

 

Entity Properties toolbar 
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Entity Creation Settings 

Fill Mode 

Command: FILL 

The Fill command toggles the display of filled and hatched areas. Specifies whether multilines, 

traces, solids, hatches (including solid-fill) and wide polylines are filled in.  

If FILLMODE is OFF, all filled entities display and print as outlines.  

You can reduce the time it takes to display or print a drawing by turning FILLMODE off. 

  

  Polyline Donut Trace Plane (Solid) 

Fil
l 
On 

   

 

Fil

l 
Of
f 
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Setting Fill Mode 

1. To toggle Fill Mode on / off do one of the following: 

• Choose Fill in the Settings Menu. 

• Type fill or fillmode in the command bar, then type T + Enter. 

2. Regenerate the viewport. 

  

NOTE If multiple viewports are open, click the Regen All tool button ( ) on the View toolbar 
(Redraw/Regen flyout) to regenerate all open viewports simultaneously. 

 

Entity Color 

The Color command specifies the current color, through a dialog box. 

The -Color command sets the current color, through the command bar. 

An entity's color determines how it is displayed and how it prints. Entities are created in the 
current color.  

You can choose between 255 index colors or define a true color.  

Index color 
Index color is the specification of the color of a pixel on a display screen using a an 8-bit color 
value, allowing up to 256 possible colors.  

Each of the Index Colors has a unique number from 1 to 255. Seven of the index colors can also be 
referred to by name: red (1), yellow (2), green (3), cyan (4), blue (5), magenta (6) and 
white/black (7). Index color 7 displays white on a black screen background and black on a white 

screen background. Index color 7 always prints in black. 

The two additional color properties are BYLAYER and BYBLOCK. These color properties cause an 
entity to adopt the color either of the layer or of the block in which it is a member. BYLAYER is 
color number 256, and BYBLOCK is color number 0. In all commands where you would use a color, 
you can indicate BYLAYER and BYBLOCK as well as by numbers 256 and 0, respectively. 

Color BYLAYER: 

Entities which have a color BYLAYER adopt the color of their layer. This allows you to change the 
color of all such entities by adjusting the color of the layer. 

Color BYBLOCK: 

Entities which have a color BYBLOCK are drawn in index color 7 (black or white, depending on the 
screen background color). When included in a block definition, such entities adopt the color of the 
block. 

  

NOTE Whether entities using an index color will print in this color, depends on the Color Table 

(CTB) or Style Table  (STB) that is used for printing. Only if the Color setting in the CTB 

or STB definition file is set to Use Object Color, the printed color matches the entity 
color. 
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Index color dialog 

 

1. Colors 10 - 249  
2. Colors 1 to 9  

3. Colors 250 - 255  
4. Current Color  
5. Color Number field  
6. 'Color By Block' button  
7. 'Color By Layer' button  

True Colors 
True color is the specification of the color of a pixel on a display screen using a 24-bit value, which 

allows up to 16 777 216 possible colors.  

The number of bits used to define a pixel's color shade is its bit-depth. True color is sometimes 
known as 24-bit color. Some new color display systems offer a 32-bit color mode. The extra byte, 
called the alpha channel, is used for control and special effects information.  

True colors use a RGB color definition (Red, Green, Blue). Each of these parameters has a range 
from 0 to 255. The RGB definition for black is (0,0,0), the RGB definition for white is 

(255,255,255). 

  

NOTE • In drawings that use Style Tables (STB) to set up plotting configurations, entities 
in a true color will only be printed in this color if the Color setting in the STB 
definition file is set to Use Object Color. 

• In drawings that use Color Tables (CTB) to set up plotting configurations, entities 
in a true color always print in this color. 
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True color dialog 

 

1. Color Selection pane  
2. Color Picker  

3. Luminosity slider  
4. Current Color  
5. Color Parameter fields  

To Set the Current Entity Color 

1. To open the Select Color dialog, do one of the following:  

• In the Color field of the Entity Properties toolbar, choose Select Color.  

• Click the Select Color tool button ( ) on the Settings toolbar.  

• In the BricsCAD Properties Bar click Color, then choose Select Color in the drop down 
list.  

• Double click the Color Field in the Status Bar.  

• Type color in the command bar,  then press Enter.  

2. (option) To select an index color, click the Index Color tab on the Select Color dialog, then 
do one of the following:  

• Click one of the colored tiles.  

• Type the color number in the Color Number field.  

3. (option) To define a true color, click the True Color tab on the Select Color dialog, then do 

one of the following:  

• Click the in Color Selection pane.  

• Set the color parameters in the Color Parameter fields.  

4. Click the OK button to confirm. 

file:///D:/BricsCAD%20Training/manuals/01_User_Interface/00_06_Properties_Bar.htm%23Set_current_properties
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Lineweight 

Lineweights determine how thick or thin entities appear on the screen and / or when printed.  

The following lineweights are available: BYLAYER, BYBLOCK, DEFAULT and many additional 
lineweights in millimeters or inches, depending on the Lineweight Units (LWUNITS) system 
variable.. 

You cannot assign lineweights to planes, points, TrueType fonts, and raster images. 

New entities are drawn using the current lineweight. 

Lineweight BYLAYER: 
When you create an entity, it is created using the current lineweight. By default, the current 
lineweight for a new entity is BYLAYER. This means that the entity lineweight is determined by the 
current layer. When you assign BYLAYER, changing a layer’s lineweight changes the lineweight of 

all such entities on that layer.  

Lineweight BYBLOCK: 
Entities created using lineweight BYBLOCK, are drawn using the DEFAULT lineweight until include 
them into a block. The entities then inherit the block’s lineweight setting when you insert the block 
into a drawing. 

DEFAULT lineweight: 
The default lineweight is saved in the Default Lineweight (LWDEFAULT) system variable. Entities 
created using the default lineweight will be adjusted if the Default Lineweight setting is redefined. 

  

NOTE For entities using an index color, lineweights will be used for printing only if the Color 

Table (CTB) or Plot Style (STB) is defined as 'Use object lineweight'. Otherwise the line 
weight is defined by the objects color or plot style. 

Entities which are created in a true color always use the object line weight when printed. 

 

Setting Current Lineweight 

1. (option) On the BricsCAD Properties Bar, select Lineweight. 
Make sure, no entity is selected.  

Choose a lineweight in the drop down list. 
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2. (option) On the Entity Properties toolbar, click the down arrow next to the 

Lineweight field, then choose a lineweight in the drop down list.  

Defining the Lineweight Settings 

1. Choose Settings  in the Settings menu. 
The Settings dialog opens.  

2. Select the Drawing settings category.  
3. Expand the Display/Viewing settings sub-category.  
4. Expand the Lineweights settings group. 

 

 
   

5. (option) Select the Default Lineweight (LWDEFAULT) system variable, then select a 

lineweight in the drop down list.  
6. (option) Select the Lineweight Display (LWDISPLAY) system variable, then click the 

checkbox to toggle the display of lineweights.  
7. (option) Select the Lineweight Units (LWUNITS) system variable, then choose Millimeters 

or Inches.  
8. Close the Settings dialog.  

  

NOTE Click the lineweight field (LWT) in the Status Bar to  toggle the display of lineweights 
on/off. 
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Linetype 

You use different linetypes to differentiate the purpose of one line from another. A linetype consists 
of a repeating pattern of dots, dashes, or blank spaces. Linetypes determine the appearance of 
entities both on the screen and when printed. By default, every drawing has at least three 
linetypes: CONTINUOUS, BYLAYER and BYBLOCK. Your drawing may also contain an unlimited 

number of additional linetypes. Linetype definitions are saved in the drawing. New linetypes are 
either imported from other drawings or loaded from a linetype file (*.lin).  Which linetype file is 
used is controlled by the MEASUREMENT system variable: 

• MEASUREMENT = ON uses Iso.lin: Linetype definitions are expressed in mm.  

• MEASUREMENT = OFF: Default.lin: Linetype definitions are expressed in inch. 
New entities are drawn using the current linetype. 

Linetype BYLAYER: 
Entities which have a linetype BYLAYER adopt the linetype of their layer. This allows you to change 

the linetype of all such entities by adjusting the linetype of the layer. 

Linetype BYBLOCK: 
Entities created using linetype BYBLOCK, are drawn as continuous lines until you include them into 
a block. The entities then inherit the block’s linetype setting when you insert the block into a 
drawing. 

Linetype scale (LTSCALE) 
Non-continuous linetypes consist of lines, gaps and dots put together in a variety of patterns. In 
complex linetypes also text or shapes can be included.  

In the linetype definition the length of the lines and gaps are either defined in inch (default.lin) or 
mm (iso.lin). If the drawing units are different from inch or mm, linetypes need to be scaled. The 
linetype scaling is controlled by the Linetype Scale (LTSCALE) system variable, which must be set 
with respect to the drawing units (DU): 

  

Drawing 
Unit 

LTSCALE 

Imperial (MEASUREMENT = 

OFF) 

Inch 1 

Foot 1/12 

Metric (MEASUREMENT = ON) 

mm 1 

cm 0.1 

m 0.001 

  

BricsCAD will always put a dash at the start and end of a line, polyline, arc or spline. The linetype 
pattern is also nicely centered, so that both ends of the entity look the same. 

Polyline Generation (PLINEGEN) 
Linetypes are normally generated from vertex to vertex. Polylines of which the vertices are very 
close together might be rendered as a continuous line, if the linetype pattern does not fit between 
two subsequent vertices. The Polyline Generation (PLINEGEN) system variable addresses this 
problem: when set to 1 or ON, the linetype is drawn from one end of the polyline to the other end, 

instead of from vertex to vertex. 
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The same polyline drawn with PLINEGEN on (left) and off (right). 

  

Paper space linetype scale (PSLTSCALE) 
PSLTSCALE controls linetype scaling in paperspace layouts. If ON, linetype scaling is independent 

from the viewport scale. 

In general, PSLTSCALE is best set ON. Remember that this variable can be set per layout. 

  

Model space linetype scale (MSLTSCALE) 
If MSLTSCALE is ON, the current annotation scale (CANNOSCALE) is applied to linetypes in model 
space. 

MSLTSCALE is best set OFF. It might be usefull to switch it ON when printing from model space. 

Current Linetype 

Do one of the following: 

• On the BricsCAD Properties Bar, select Linetype. 
Make sure, no entity is selected.  

Choose a linetype in the drop down list. 

 

• On the Entity Properties toolbar, click the down arrow next to the Linetype field, then 
choose a linetype in the drop down list.  
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• Right click on the Linetype field in the Status Bar, then choose a linetype in the context 

menu.  

Add a New Linetype 

1. In the Tools > Drawing Explorer choose Linetype... 

The Drawing Explorer - Linetypes dialog displays. 

 

2. Click the New tool button ( ) in the Details toolbar. 
The Linetypes dialog opens. 
 

 

3. (option) Click the File button on the Linetypes dialog to load a different linetype file (*.lin).  
4. Select a linetype, then click the OK button. 

The linetype is added.  
5. (option) Click the linetype name to rename the linetype.  
6. (option) click the linetype description to edit the description of the linetype.  
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Entity Linetype Scale 

The CELTSCALE system variable sets the value of the Linetype Scale property for new entities. This 
variable is best set to 1, except for special linetypes, such as BATTING or GAS_LINE, which most 
likely need to be scaled.  

1. On the BricsCAD Properties Bar, select Linetype scale. 
Make sure, no entity is selected.  

2. Type a new value in the Linetype scale field.  

 

Global Linetype Scale 

1. Choose Settings  in the Settings menu. 
The Settings dialog opens.  

2. Select the Drawing settings category.  
3. Expand the Entity Creation settings sub-category.  
4. Select the Linetype Scale setting (LTSCALE). 
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5. Type a new value in the Global Linetype Scale field, then press Enter. 

The drawing is regenerated.  
6. Close the Settings dialog.  

Current Layer 

When you create new entities, they are drawn on the current layer. To draw new entities on a 

different layer, you must first make that layer the current layer. 

Setting the current layer 

Do one of the following: 

• On the BricsCAD Properties Bar, select Layer. 

Make sure, no entity is selected. 

Choose a layer in the drop down list. 
   

 

• On the Entity Properties toolbar, click the down arrow next to the Layer field, then 

choose a layer in the drop down list. 

• Right click on the Layer field in the Status Bar, then choose a layer in the context menu. 

NOTES • It is possible to turn the display of the current layer off ( ). As a result, everything 

you draw will be invisible until the display of the current layer is turned on ( ) 
again. A warning displays if you try to turn off the current layer. 

• The LAYISO command allows to isolate layers by either lock or turn off other layers. 
If no entity on the current layer is selected, the layer of the entity that is selected 
first temporarily becomes the current layer until the LAYUNISO command is 
executed. 

• It is not possible the freeze ( )  the current layer. 

 

file:///D:/BricsCAD%20Training/manuals/01_User_Interface/00_06_Properties_Bar.htm
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Transparency 

The Transparency property allows to control the transparency of drawing entities. You can set the 
transparency for a selection of entities or for all entities on the same layer. The default 
transparency for new entities is controlled by the CETRANSPARENCY system variable. The default 
transparency for Hatches and Gradient Fills is controlled by the HPTRANSPARENCY system 

variable. 

Transparency can be used to enhance the display of your drawings, e.g. to de-emphasize less 
important details or entities that are used for reference only. 

Transparencies will only be printed if the Plot Transparencies option is checked on the Print or Page 
Setup dialog boxes.  

The options to set the Transparency are: 

• ByLayer - apply the value of the transparency property of the layer. 

• ByBlock - the transparency value is controlled by block. 

• Value -  values between 0 (fully opaque) and 90 are accepted. 
The transparency level is limited to 90 % to avoid confusion with layers that are frozen or 
turned off. 
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Drawing 2D Entities 

Drawing 2D Overview 

All tools to create 2D entities can be found either on the Draw toolbar or in the Draw menu. 

Toolbars Menu 

  

 

Draw flyouts: 

Lines 

 

Polylines 

 

Polygons 
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Icon 
Tool 

Name 

Command Description 

 

Line LINE  

Creates single lines or a series of connected lines. 

 

Ray RAY  

Creates a line that starts at a point and extends to 
infinity. 

 

Infinite 
Line 

XLINE  

Creates a line through a given point, oriented at a 
specified angle and extending to infinity in both 
directions. 

 

Polyline PLINE  

Creates a single open or closed entity, composed of 
lines and/or arcs. 

 

3D 

Polyline 

3DPOLY 

Creates 3D polylines. 

 

Boundary 
Polyline 

BOUNDARY  

Calculates a closed polyline from a boundary set. 

 

Spline SPLINE  

Creates open or closed curved lines. 

 

Helix HELIX  

Creates a 2D spiral or a 3D helix. 

 

Sketch SKETCH  

Creates lines as if you were sketching, using a 
pencil. 

 

Rectangle RECTANG  

Creates Rectangles. 

 

Polygon POLYGON 

Creates equal sided polygons 

 

Solid SOLID  

Creates planes (solids). 

 

Trace TRACE  

Creates traces. 

 

Arc ARC  

Creates circular arcs. 

 

Circle CIRCLE  

Creates circles. 

 

Donut DONUT 

Creates donuts. 

 

Elliptical 
Arc 

ELLIPSE+A Creates elliptical arcs. 

 

Ellipse ELLIPSE  

Creates ellipses. 

 

Point POINT  

Creates points. 

 

Hatch HATCH  

Fills closed areas with repeating patterns. 

 

Gradient 
Fill 

GRADIENT  

Fills closed areas with solid fills in nine different 
patterns and one or two colors. 

 

Region REGION  

Creates regions from 2D entities. 

 

Wipeout WIPEPOUT  

Creates wipeouts, blank areas in the drawing. 

 

Revision 

Cloud 

REVCLOUD  

Creates revision clouds. 

 

Table TABLE  

Creates a table entity in the drawing through a 
dialog box. 

 

Text TEXT  

Places single lines of text in the drawing. 

 

Multiline 
Text 

MTEXT  

Places multi-line text in the drawing through a 
dialog box. 
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Lines 

Command: LINE 

A line consists of two points: a start point and an endpoint. Using the Line command you can draw 
a series of connected lines, but each line is considered a separate line entity. 

1. Do one of the following 

• Click the Line tool button ( ) on the Draw toolbar. 

• Choose  Line in the Draw menu. 

• Type line in the command bar, then press Enter. 

• Type L in the command bar, then press Enter. 

You are prompted: ENTER to use last point/Follow/<Start of line>: 

A prompt menu displays: 

 

2. Specify the start point. 
The line displays dynamically. 

3. Specify the end point. 
The line is drawn and the following line displays dynamically starting in the endpoint of the 
first line. 

• Using Ortho Mode or Polar Tracking you can type the length of the line in the command 
bar. 

• Using Snap Tracking you can position the end point with respect to the start point and 
one or two snap points on entities in the drawing. 

The prompt menu changes: 

 

4. (option) Repeat step 3  to draw a series of connected lines. 

When the second line is drawn, the options in the prompt menu are: 

 

After the third line, the options in the prompt menu are: 

bricscad-cmdref.chm::/L/Line.htm
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4. Right click to stop drawing lines. 
5. (option) Right click to restart. 

Rays 

Command: RAY 

A Ray is a line that starts at a point and extends to infinity. Because rays extend to infinity, they 
are not calculated as part of the drawing extents.  

The default method for drawing a ray is to select the start point of the ray, and then specify its 
direction.  

Rays and Infinite Lines or sometimes referred to as construction lines. 

1. Do one of the following: 

• Click the Ray tool button ( ) on the Lines flyout of the Draw toolbar. 

• Choose  Ray in the Draw menu. 

• Type ray in the command bar, then press Enter. 

You are prompted: Infinite ray: Bisect/Horizontal/Vertical/Angle/Parallel/<Start of Ray>: 

A prompt menu opens: 

 

2. Specify the start point of the ray. 
The ray displays dynamically. 

3. Specify the direction of the ray. 
The next ray displays dynamically. 

4. (option) Keep specifying directions to draw a series of rays, starting from the same point. 
5. Right click to stop drawing rays. 

bricscad-cmdref.chm::/R/Ray.htm
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Infinite Lines 

Command: XLINE 

The Xline command creates infinite lines. 

An Infinite Line is a line through a given point, oriented at a specified angle and extending to 
infinity in both directions. Because infinite lines extend to infinity, they are not calculated as part of 

the drawing extents. The default method for drawing an infinite line is to select a point and then 
specify its direction.  

Rays and Infinite Lines or sometimes referred to as construction lines. 

1. Do one of the following: 

• Click the Infinite Line tool button ( ) on the Lines flyout of the Draw toolbar. 

• Choose  Infinite Line in the Draw menu. 

• Type xline in the command bar, then press Enter. 

You are prompted: Xline: Bisect/Horizontal/Vertical/Angle/Parallel/<Point along line>: 

A prompt box displays: 

 

2. Specify the start point of the infinite line. 
The infinite line is created. 
A new infinite line through the same start point displays dynamically. 

3. (option) Specify the direction of the infinite line. 
The infinite line is created. 
A new infinite line through the same start point displays dynamically. 

4. (option) Repeat step 3 to draw a series of infinite lines, through the same start point. 

5. Right click to stop drawing infinite lines. 
6. (option) Right click to restart. 

bricscad-cmdref.chm::/X/XLine.htm
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Polylines 

A polyline is an open or closed sequence of connected line and/or arc segments, which are treated 
as a single entity. Each segment of a polyline can have a width that is either constant or tapers 
over the length of the segment.  

The Pline command interactively creates open and closed polylines entering points. 

The Boundary and - Boundary commands create closed polylines from an enclosed area, defined 
by other entities. 

The THICKNESS system variable specifies the height of a polyline. If THICKNESS = 0 (zero) there 
is no visual difference between polylines and a series of lines and/or arcs. 

  

 

 THICKNESS = 0 (left),  THICKNESS = 50 (middle),  ELEVATION = 50 

(right) 

  

When a polyline is edited, you can modify the entire polyline or change individual segments and 

you can add or remove vertices. 

  

 

 

zero width polyline constant width polyline 

 

tapered width polyline 

  

NOTE When Fill Mode  is turned OFF, all filled entities, such as wide polylines and planes, 
display and print as outlines. 
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Depending on the value of the GRIPS system variable have grips on their endpoints and vertices 

and/or at the midpoint of each segment. 

The value of GRIPS can be 0, 1 or 2 

  

Value Grips display 

0 No grips 

1 Endpoint grips only 

2 Endpoint and 
midpoints grips 

 

Drawing Polylines 

1. Do one of the following  

• Click the Polyline tool button ( ) on the Draw toolbar.  

• Choose  Polyline in the Draw  menu.  

• Type pline in the command bar, then press Enter.  

• Type PL in the command bar, then press Enter.  

You are prompted: ENTER to use last point/Follow/<Start of polyline>: 

A prompt menu displays: 

 

2. Specify the start point of the polyline. 
The prompt menu changes: 

 
3. Specify the second point of the polyline. 

The prompt menu changes: 

 
4. (option) Repeat step 3 to add more straight segments.  
5. (option) Do one of the following to start drawing arc segments:  

• Type A, then press Enter.  

• Choose Draw arcs in the prompt menu.  

bricscad-sysvar.chm::/00_07_Settings_Manager.htm
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The prompt menu changes: 

 

An arc segment displays dynamically. The arc is tangent to the previous line segment. 

6. Specify the endpoint of the arc.  
7. (option) Repeat step 6 to add more arc segments.  

8. (option) Do one of the following to start drawing line segments:  

• Type L, then press Enter.  

• Choose Draw lines in the prompt menu.  

9. Specify the endpoint of the line segment.  
10. Right click or choose Done in the prompt menu to stop.  

11. (option) Right click to restart.  

Boundary Polylines 

1. Do one of the following  

• Click the Boundary Polyline tool button ( ) on the Draw toolbar.  

• Choose  Boundary Polyline in the Draw menu.  

• Type boundary in the command bar, then press Enter.  

The Boundary dialog box opens. 
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2. (option) Click the Select button ( ) 
The Boundary dialog closes. 
Select the boundary entities in the drawing, then Press Enter. 
The Boundary dialog opens.  

3. Click the Pick points in boundaries button on the Boundary dialog box. 
The dialog box closes.  

4. Click in the area where you want to create the boundary polyline: point 1 in the image 
below. 

 
5. The boundary polyline displays in dashed lines.  

6. (option) Keep picking points to create more boundary polylines.  
7. Right click to accept the polyline(s). 

The Boundary dialog box opens again.  
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8. Click the OK button on the Boundary dialog box. 

The polyline(s) is (are) created. 

 

  

NOTES • If you select the boundary entities before launching the Boundary Polyline tool, 

you can make the selection set active by pressing the Select button ( ) in step 
2. 

• If you type -boundary (don't forget the "minus" sign) in the command bar, you 
are prompted to click the area where you want to create the polyline(s) 
immediately (no dialog opens) then right click to create the polyline(s). 

 

Splines 

Command: SPLINE 

A spline is an open or closed smooth curve defined by a set of points. You can use splines to draw 
curved shapes, which cannot be drawn as a polyline. 

1. Do one of the following 

• Click the Spline tool button ( ) on the Draw toolbar. 

• Choose Spline in the Draw menu. 

• Type spline in the command bar, then press Enter. 

You are prompted: First point of spline: 

2. Specify the first point of the spline. 
3. Define the second point of the spline. 

You are prompted: Close/Fit Tolerance/<next point>: 
A prompt menu displays. 
 

 
  

4. (option) Repeat step 3 to define more points. 
5. Right click to stop adding more points. 

You are prompted: Select starting tangent point: 

bricscad-cmdref.chm::/S/Spline.htm
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A line that is tangent to the spline displays dynamically from the start point of the spline. 

 
6. Click to define the curve of the spline. 

You are prompted: Select ending tangent point: 
A line that is tangent to the spline displays dynamically from the start end of the spline. 

 
7. Click to conclude the spline command. 

 
8. (option) Right click to restart. 

  

NOTES • The red dashed lines in the above images represent the polyline through the 
control points of the spline. 

• The SPLFRAME (Spline Frame) settings variable defines whether the control 
polygon displays for splines and spline-fit polylines. 
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Sketch 

Command: SKETCH 

A freehand sketch consists of a series of straight line segments, created either as individual line 
entities or as a polyline. Before you begin creating a freehand sketch, you must set the length, or 
increment, of each segment. The smaller the segments, the more accurate your sketch, but small 

segments increase the file size.  

After you specify the length of the sketch segments, the crosshairs change to a pencil tool ( ).  

A freehand sketch line is not added to the drawing until you "write" the sketch into your drawing. 

Setting the Sketch Poly (SKPOLY) system variable 

Whether a chain of individual lines or a polyline is created by the Sketch tool is controlled through 
the Sketch Poly (SKPOLY) system variable. When the setting is ON the Sketch tool creates 

polylines 

  

Do one of the following: 

• In the command bar type skpoly, then press Enter. 

• In the Settings dialog, go to Drawing > Drafting > Entity Creation > Freehand 
Sketches. 
  

.  
  

  

Creating a freehand sketch 

1. Do one of the following 

• Click the Sketch tool button ( ) on the Draw toolbar. 

• Choose  Sketch in the Draw menu. 

• Type sketch in the command bar, then press Enter. 

You are prompted: Length of segments <current length>: 

2. Do one of the following to define the length of the segments:: 

• Press Enter to accept the current length. 

• Type a new value in the command bar. 

• Click two points to define the length graphically. 

The length of the segments is saved to the Sketch Increment (SKETCHINC) system variable. 

3. Click to start sketching (pen down). The crosshairs are replaced by  the Pencil tool ( ) 
You are prompted: Press ENTER or click to toggle Pen/Quit without save/Record 
(save)/Erase/Connect/Straight/eXit with save:: 
A prompt menu displays: 

bricscad-cmdref.chm::/S/Sketch.htm
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4. Move the cursor to sketch. 

The sketched line displays in light green. 

5. (option) Click to stop sketching (pen up), then click again (pen down) to resume. 
6. (option) Choose Erase on in the prompt menu or type E + Enter in the to start erasing 

sketch lines. 

The cursor changes to the Erase tool ( ). 

• Move the cursor to the end of a sketch line to start erasing. 

• Click to stop erasing and resume sketching. 
  

7. (option) Choose Record (save) in the prompt menu or type R + Enter to save the sketch 
lines, and keep sketching. 

8. (option) Choose save and eXit in the prompt menu or type X + Enter to save the sketch 
lines and exit the sketch command. 

9. (option) Choose Quit no save in the prompt menu or type Q + Enter to exit the sketch 

command without saving. 

Circles 

The default method for drawing a circle is to specify a center point and radius. 

Other methods to draw circles can be found in the Circle submenu of the Draw menu and in the 
Circles toolbar. 

The Ai_CircTan command draws circles tangent to three entities. 

General Procedure to Draw a Circle 

1. Do one of the following.  

• Click the Circle tool button ( ) on the Draw toolbar.  

• Type circle in the command bar, then press Enter.  

• Type C in the command bar, then press Enter.  

You are prompted: 2Point/3Point/RadTanTan/Arc/Multiple/<Center of circle>: 

A prompt menu displays: 

 

2. Specify the center point of the circle. 

You are prompted: Diameter/<Radius> <current radius>: 
The prompt menu changes: 
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3. Do one of the following:  

• Press Enter to accept the current radius.  

• Type a new radius and press Enter.  

• Click to define the radius graphically.  

Drawing a Circle Tangent to Three Entities 

1. Type ai_circtan in the command bar. 

You are prompted: Enter Tangent spec:  

2. Click a linear entity. 
Lines, arcs, circles, polyline segments, xlines and rays are accepted. 
You are prompted: Enter second Tangent spec:  

3. Click the second linear entity. 
You are prompted: Enter third Tangent spec:  

4. Click the third linear entity. 
A circle tangent to the three selected entities is created. 

   

Editing a Circle 

1. Select the circle. 
The properties of the circle display in the Properties bar.  

 

2. Type a new value in the Center, Radius, Diameter, Circumference or Area field, 
then press Enter.  

3. Press the Esc key to stop editing the circle. 
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Arcs 

The default method for drawing circular arcs is to specify three points: the start point, a second 
point and the endpoint.  

Other methods to draw arcs can be found in the Arc submenu of the Draw menu and in the Arcs 
toolbar. 

 General Procedure to Draw an Arc 

1. Do one of the following.  

• Click the Arc tool button ( ) on the Draw toolbar.  

• Type arc in the command bar, then press Enter.  

• Type A in the command bar, then press Enter.  

You are prompted: Enter to use last point/Center/Follow/<Start of arc>: 

A prompt menu displays: 

 

3. Specify the start point of the arc. 
You are prompted: Angle/Center/Direction/End/Radius/<Second point>: 

The prompt menu changes:  

 

4. Specify the second point of the arc. 
You are prompted: End point:  

5. Specify the end point of the arc.  

  

file:///D:/BricsCAD%20Training/manuals/01_User_Interface/01_01_Toolbars.htm


  User Guide 

 316 

Editing an Arc 

1. Select the arc. 
The properties of the arc display in the Properties bar. 
 

 

2. Type a new value in the Center, Radius, Start angle or End angle, then press Enter.  
3. Press the Esc key to stop editing the arc. 

Ellipses 

The default method for drawing an ellipse is to specify the endpoints of one axis of the ellipse and 
then specify a distance representing half the length of the second axis. The endpoints of the first 
axis determine the orientation of the ellipse. The longer axis of the ellipse is called the major axis, 

and the shorter one is the minor axis. The order in which you define the axes does not matter. The 
program determines the major and minor axes based on their relative lengths. Half the major axis 

is called the major radius, half the minor axis is the minor radius. The ratio (minor radius divided 
by the major radius) defines the eccentricity of the ellipse. A circle is an ellipse with an eccentricity 
of 1. 

Other methods to draw ellipses can be found in the Ellipse submenu of the Draw menu and in the 
Ellipses toolbar. 

The Polyline Ellipse (PELLIPSE) settings variable: controls whether real ellipses or a polyline 
representation is created. 

If the variable is ON, the Ellipse tool creates a closed polyline, if the variable is OFF real ellipses 
are created. 

The difference between a real ellipse and a polyline representation of an ellipse is visible when you 
select the ellipse. A real ellipse has five handles: center point and the endpoints of the axes. A 

polyline representation of an ellipse is a closed polyline composed of arc segments. 
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real ellipse (left) and the polyline representation of an ellipse (right) 

  

NOTE Since ellipses cannot be used as a clip boundary for external references or to create 
clipped paperspace viewports, you must use a polyline representation to do these jobs. 

 

Setting the Polyline Ellipse Variable 

Do one of the following: 

• In the command bar type pellipse, then press Enter.  

• In the Settings dialog, go to Drawing > Drafting > Entity Creation > Other entities.  

  

 

General Procedure to Draw an Ellipse 

1. Do one of the following.  

• Click the Ellipse tool button ( ) on the Draw  toolbar.  

• Type ellipse in the command bar, then press Enter.  

• Type EL in the command bar, then press Enter.  

You are prompted: Arc/Center/<First end of ellipse axis>: 

A prompt menu displays: 

 

2. Specify the the first end of the ellipse axis. 
You are prompted: Second end of axis:  

3. Specify the second end of the ellipse axis. 
You are prompted: Rotations/<Other axis>: 
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A prompt menu displays: 

 
4. Specify the length of half the other axis of the ellipse.  

  

NOTE If the Polyline Ellipse variable is off, the Arc option is not available. 

 

Editing an Ellipse 

1. Select the ellipse. 

The properties of the ellipse display in the Properties bar. 

 

 

2. Type a new value in the Center, Major radius, Minor radius, Radius ratio, Start angle or 
End angle field, then press Enter.  

3. Press the Esc key to stop editing the ellipse. 
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Elliptical Arcs 

An elliptical arc is a portion of an ellipse. The default method for drawing an elliptical arc is to 
specify the endpoints of one axis of the ellipse, and then specify a distance representing half the 
length of the second axis. Then you specify the start and end angles for the arc, measured from 
the center of the ellipse in relation to its major axis. 

Other methods to draw elliptical arcs can be found in the Ellipse submenu of the Draw menu and in 
the Elliptical Arcs toolbar. 

General Procedure to Draw an Elliptical Arc 

1. Do one of the following.  

• Click the Elliptical Arc tool button ( ) on the Draw toolbar.  

• Launch the Ellipse command using the Arc option.  

You are prompted: Center/<First end of ellipse axis>: 

A prompt menu displays: 

2.  
3. Specify the first end or the ellipse axis. 

You are prompted: Second end of axis:  
4. Specify the second end of the ellipse axis. 

You are prompted: Rotation/<Other axis> 
A prompt menu displays:  
 

 
5. Specify the length of half the other axis of the ellipse. 

You are prompted: Parameter/<Start angle of arc>: 
The prompt menu changes: 

 

 
6. Specify the start angle of the elliptical arc. 

The elliptical arc is drawn dynamically when you move the crosshairs. 

You are prompted: Parameter/Included/<End angle>: 

The prompt menu changes: 
 

 
7. Specify the end angle of the elliptical arc.  
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Editing an Elliptical Arc 

1. Select the elliptical arc. 
The properties of the elliptical arc display in the Properties bar.  

 

2. Type a new value in the Center, Major radius, Minor radius, Radius ratio, Start angle or 
End angle field, then press Enter.  

3. Press the Esc key to stop editing the elliptical arc. 
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Rectangles 

Command: RECTANG 

A rectangle is created as a closed, four sided polyline.  

A rectangle is drawn by specifying two opposite corners.  The Dimensions option allows to specify 
the width and height of the rectangle. 

Unless the Rotated option is chosen, the sides of a rectangle are always parallel to the x-axis and 
y-axis of the current coordinate system. 

  

NOTE When Fill Mode  is turned off, all filled entities, such as wide polylines and solids, display 

and print as outlines. 

General Procedure to draw a rectangle 

1. Do one of the following 

• Click the Rectangle tool button ( ) on the Draw toolbar. 

• Choose  Rectangle in the Draw menu. 

• Type rectang  in the command bar, then press Enter. 

• Type rec in the command bar, then press Enter. 

You are prompted: 
Chamfer/Elevation/Fillet/Rotated/Square/Thickness/Width/Area/Dimensions<select first corner of 

rectangle>: 

A prompt menu opens: 

 

2. Specify the first corner of the rectangle. 
The rectangle displays dynamically when you move the cursor. 

3. Specify the opposite corner of the rectangle. 
The rectangle is created. 

4. (option) Right click to draw more rectangles. 

  

NOTE Because a rectangle is created as a closed polyline, rectangles have a direction. The 
direction of a closed polyline is positive if it is drawn counter-clockwise and negative if it 
is drawn in a clockwise direction. Rectangles have a counter-clockwise direction if both 
the X- and Y-coordinate of the second point are higher or lower than the coordinates of 
the first point (= movement of the cursor is positive or negative along both X- and Y-

axis). Rectangles have a clock-wise direction if the X- or Y-coordinate is higher or lower 
than the X- or Y-coordinate of the first point (= movement of the cursor is positive along 
the X-axis and negative along the Y-axis or vice versa). 

The Reverse Direction option of the Edit Polyline tool changes the direction of a polyline. 

  

bricscad-cmdref.chm::/R/Rectang.htm
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Using Dynamic Dimensions 

Using Dynamic Dimensions the width and length of the rectangle can be controlled dynamically. 

1. Launch the Rectang command. 
You are prompted: 
Chamfer/Elevation/Fillet/Rotated/Square/Thickness/Width/Area/Dimensions<select first 
corner of rectangle>: 

2. Specify the first corner of the rectangle. 

The rectangle displays dynamically when you move the cursor. 
The width and height display in the dynamic dimension fields. 

3. Type a value in the Height field. 
4. Press the TAB key. 

The Height field is locked and turns red. 
5. Type a value the Width field. 

 
6. Do one of the following 

• Press Enter to create the rectangle. 

• Press the TAB key until the desired field is active, then type a different value. 

7. Press Enter to create the rectangle. 

Polygons 

Command: POLYGON 

Polygons are closed polylines comprised of a minimum of three and a maximum of 1,024 equal-
length sides.  

In BricsCAD you can draw polygons using the following methods: 

• Centre - Vertex  ( ): first define the center point, then the vertex (= radius of the 
circumscribed circle method). 

• Center - Side ( ): first define the center point, then the midpoint of a side (= radius of 
the inscribed circle method). 

• Edge ( ): define the length of the side of the polygon. 

1. Do one of the following 

• Click the Polygon, Center - Vertex tool button ( ) on the Polygons flyout of Draw 
toolbar. 

• Choose  Polygon in the Draw menu. 

• Type polygon in the command bar, then press Enter. 

You are prompted: Polygon: Multiple/Width of line/<Number of sides> <4>: 

A prompt menu opens: 
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2. Specify the number of sides, then press Enter. 
You are prompted: Specify by: Edge/<Center of polygon>: 
The prompt menu changes: 
 

 
3. Specify the center of the polygon. 

You are prompted: Specify by: Side/<Select vertex point>: 
the prompt menu changes: 
 

 
4. Specify a vertex point of the polygon. 

The polygon is created. 

  

NOTE When Fill Mode  is turned off, all filled entities, such as wide polylines and planes, display 

and print as outlines. 

 

Traces 

Command: TRACE 

Traces are 4-sided filled entities, created with two parallel sides. When you create a series of 
traces, they are L-connected to each other.  

1. Do one of the following 

• Click the Trace tool button ( ) on the Polygons flyout of the Draw toolbar. 

• Choose  Trace in the Draw menu. 

• Type trace in the command bar, then press Enter. 

You are prompted: Width of trace <current width>: 

2. Do one of the following: 

• Right click to accept the current width. 

• Type a new current width in the command bar. 

• Define a new current width graphically by clicking two points. 

You are prompted: Start of trace: 

3. Specify the start point of the trace. 
You are prompted: Next point: 

4. Specify the end point of the first trace. 

A line indicates the direction of the first trace. The direction of the second trace displays 
dynamically. 

5. Do one of the following: 
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• Right click to create the trace. 

• Specify the endpoint of the next trace. 

6. (option) Repeat step 5 to keep adding traces. 

  

NOTE When Fill Mode  is turned off, all filled entities, such as traces, display and print as 
outlines. 

 

Donuts 

Command: DONUT 

Donuts are solid, filled circles or rings created as closed, 2-segment, wide polylines. The default 
method to draw donuts is to specify its inside and outside diameters, and then specify its center. If 

the inside diameter is zero, a filled circle is created. 

1. Do one of the following: 

• Click the Donut  tool button ( ) Draw toolbar. 

• Choose Donut  in the Draw menu. 

• Type donut in the command bar, then press Enter. 

You are prompted: 2Point/3Point/RadTanTan/<Inside diameter of donut> <current inside 
diameter>: 

A prompt menu opens: 

 

2. Do one of the following: 

• Right click to accept the current inside diameter. 

• Type a new inside diameter in the command bar. 

• Define a new inside diameter graphically by clicking two points. 

You are prompted: Outside diameter of donut <current outside diameter>: 

3. Do one of the following: 

• Right click to accept the current outside diameter. 

• Type a new outside diameter in the command bar. 

• Define a new outside diameter graphically by clicking two points. 

You are prompted: Center of donut: 

4. Specify the center of the donut. 
The donut is created. 

5. (option) Specify the center point of another donut. 

6. Right click to conclude the donut command. 
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NOTE • When Fill Mode  is turned off, all filled entities, such as wide polylines and planes, 

display and print as outlines. 

• Set the inside diameter to 0 (zero) to create filled circles. 

 

Solids 

Command: SOLID 

2D Solids are rectangular, square, triangular or quadrilateral areas filled with a solid color. 

  

 

Left to right: quadrilateral, rectangular, square and triangular solids 

1. Do one of the following: 

• Click the Solid tool button ( ) on the Polygons flyout of Draw toolbar. 

• Choose  Solid in the Draw menu. 

• Type solid in the command bar, then press Enter. 

You are prompted: Rectangle/Square/Triangle/<First point of solid>: 

A prompt menu displays: 

 

2. Specify the first point of the solid. 
3. Specify the second point of the solid. 
4. Specify the third and fourth point of the solid. 

The solid is created. 
5. (option) Repeat step 4 to add more solids. 

A series of connected solids is created. 
6. Right click to conclude. 
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NOTE When Fill Mode  is turned off, all filled entities, such as wide polylines and solids, display 
and print as outlines. 

 

Revision Clouds 

Command: REVCLOUD 

A Revision Cloud is an open or closed polyline composed of arcs. Revisions clouds are used to for 

reviewing or redlining purposes to indicate the parts of the drawing that need to be adjusted or 
annotated. 

Before you start drawing revision clouds, first define the Arc length and Style. 

1. Do one of the following: 

• Click the Revision Cloud tool button ( ) on the Draw toolbar. 

• Choose  Revision Cloud in the Draw menu. 

• Type revision cloud in the command bar, then press Enter. 

You are prompted: Specify start point or [Arc length/Object/Style] <Object>: 

A prompt menu opens: 

 

2. (option) To define the Arc length, do one of the following: 

• Choose Arc length in the prompt menu. 

• Type A in the command bar, then press Enter. 

You are prompted: Specify minimum length of arc <current minimum length>: 

Do one of the following: 

• Press Enter or right click to accept the current minimum length. 

• Type a new value in the command bar, then press Enter. 

• Define a new minimum length graphically by specifying two points. 

You are prompted: Specify maximum length of arc <current maximum length>: 

Do one of the following: 

• Press Enter or right click to maximum length equal to the minimum length. 

• Type a new value in the command bar, then press Enter. 

• Define a new maximum length graphically by specifying two points. 

3. (option) To define the revision cloud Style, do one of the following: 

• Choose Style in the prompt menu. 

• Type S in the command bar, then press Enter. 

You are prompted: Select arc style [Normal/Calligraphy] <current style>: 

A prompt menu opens: 
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Do one of the following: 

• Press Enter or right click to accept the current style 

• Select a new style in the prompt menu. 

• Type N or C in the command bar, then press Enter. 

4. (option) To convert an existing polyline, arc or circle to a revision cloud, do one of the 
following: 

• Press Enter, then select the entity you want to convert. 

• Choose Object in the prompt box, then select the entity you want to convert. 

5. (option) To draw the revision cloud, click where you want to start and move the cursor. 
Each time the cursor movement exceeds the minimum length, an arc is added. 

To stop do one of the following: 

• Move the cursor over the start point to close the revision cloud. 

• Right click. 

You are prompted: Reverse direction [Yes/No] <No>: 

A prompt menu opens: 

 

6. To create the revision cloud, do one of the following: 

• To accept the revision cloud, right click. 

• To reverse the direction, type Y or choose Yes in the prompt menu. 

• To leave the command without creating the revision cloud, choose Cancel in the prompt 
menu or press the Esc key. 

  

 

Revision Clouds: 1. Normal 2. Calligraphy 3. Reversed calligraphy  (based on a 

rectangle) 
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Points 

Since points are dimensionless, a single pixel should be the (nearly) correct representation on the 
screen. But this is hardly visible, especially in a complex drawing. Therefore you can choose 
between a number of possible display styles. 

The point display style is chosen by means of the Point Display Mode (PDMODE) system variable. 

The size of the point representation style is controlled through the Point Display Size (PDSIZE) 
system variable. 

Defining the Point Display Settings 

1. Open the Settings dialog. 
2. In the Drawing settings category, expand the Entity Creation sub-category.  
3. Expand the Points settings group, then expand the Point display mode setting. 

 

 

  

 

Point display modes 

  

4. Set the Point Display Mode setting:  

• Choose the point location marker style: point, none, X or |  

• Choose to add a circle and/or a square.  

5. Set the Point Display Size setting.  
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• Relative: Type 0 (zero) to scale the point display style at 5% of the screen.  

• Absolute: Type the size of the point display style in drawing units.  

6. Close the Settings dialog.  

  

NOTE If you need to draw a 'dot', use a Donut with a zero inside diameter instead of a point 
entity. 

 

Drawing Points 

Do one of the following  

• Click the Point tool button ( ) on the Draw toolbar.  

• Choose Point in the Draw menu.  

• Type point in the command bar, then press Enter.  

You are prompted: Settings/Multiple/<Location of point>: 

A prompt menu displays: 

  

 

Specify the location of the point. 
The point is created.  

  

NOTE If the  Point Display Size setting is set to 0 (zero), use the Regen tool to resize the 

display of the points to 5% of the screen size after zooming in or out. 
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Wipeouts 

A wipeout is a polygonal area that hides the underlying objects using the current background color. 
Most commonly wipeouts are used to mask part of a drawing for clarity. For example, you may 
want to add text to a complicated part of a drawing. A wipeout could be used then to mask an area 
behind the text to increase the readability of the text. 

The Frames option of the wipeout command determines whether the edges of all wipeout entities 
in the current drawing are displayed or hidden. 

To Create a Wipeout Using Points 

1. Do one of the following:  

• Click the Wipeout tool button ( ) on the Draw toolbar.  

• Choose Wipeout in the Draw menu.  

• Type wipeout in the command bar, then press Enter.  

You are prompted: Frames/Polylines/<Start point>: 

2. Specify the first vertex of the wipeout. 
You are prompted: Next point.  

3. Specify the second vertex of the wipeout. 
You are prompted: Undo/<Next Point>:  

4. Do one of the following:  

• Specify the third vertex of the wipeout.  

• Type U, then press Enter or choose Undo in the context menu to delete the previous 
vertex.  

You are prompted: Undo/Close/<Next Point>: 

5. Do one of the following:  

• Specify the next vertex of the wipeout.  

• Type U, then press Enter or choose Undo in the context menu to delete the previous 
vertex.  

• Type C, then press Enter or choose Close in the context menu to create the wipeout.  

• Right click to create the wipeout.  

6. Repeat step 5 to create more vertices of the wipeout.  

To Create a Wipeout from a Polyline 

1. Do one of the following:  

• Click the Wipeout tool button ( ) on the Draw toolbar.  

• Choose Wipeout in the Draw menu.  

• Type wipeout in the command bar, then press Enter.  

You are prompted: Frames/Polylines/<Start point>: 

The Wipeout  context menu displays: 
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2. Do one of the following:  

• Choose Polyline in the context menu.  

• Type P, then press Enter.  

You are prompted: Select a closed polyline: 

3. Click a closed polyline.  
Only polylines composed of line segments can be selected. 
You are prompted: Delete selected polyline? Yes/<No>:  

4. Do one of the following:  

• Type Y, then press Enter or choose Yes in the context menu to create the wipeout and 

delete the selected polyline.  

• Press Enter or choose No in the context menu, to create the wipeout and delete the 
selected polyline.  

To Control the Display of the Edges of Wipeouts 

1. Do one of the following:  

• Click the Wipeout tool button ( ) on the Draw toolbar.  

• Choose Wipeout in the Draw menu.  

• Type wipeout in the command bar, then press Enter.  

You are prompted: Frames/Polylines/<Start point>: 

The Wipeout  context menu displays: 

   

 

2. Do one of the following:  

• Choose Frames in the context menu.  

• Type F, then press Enter.  

You are prompted: Enter display mode: OFF/<ON>: 

3. Do one of the following:  

• Choose OFF in the context menu or type off, then press Enter, to hide the edges of all 
wipeouts in the drawing.  

• Choose ON in the context menu or type on, then press Enter, to display the edges of all 
wipeouts in the drawing. 



  User Guide 

 332 

Direct Modeling 

BricsCAD provides advanced easy-to-use functions for working with ACIS solid and surface 
geometry, including: 

• The creation of solid and surface geometry using Extrude (dmExtrude) and Revolve 

(dmRevolve) commands applied to 2D contours, 3D curves and edges of existing solids. 

• The creation of fillets (dmFillet) and chamfers (dmChamfer) on existing solid and 
surface geometry. 

• Modifying (dmPushPull) or deletion (Erase) of fillets and chamfers. 

• Direct interactive manipulation of solid and surface faces using PushPull (dmPushPull), 
Move (dmMove) and Rotate (dmRotate) operations. 

• The creation or removing of a volume when 2D contour attached to a face of a solid is 
being pushed or pulled. 

• The removing of holes in surfaces by deleting its edges (Erase). 

• Deletion (Erase) and copying (dmCopyFaces) of protrusion or depression features, such 
as holes, pockets, extrusions, ribs, and their combinations within the same 3D solid or 

from one 3D solid to another. 

All these operations are performed in interactive mode: the intermediate result of the operation is 

shown dynamically, according to user input defined by mouse movement. 

Depending on the value of the DELOBJ (Delete Entity) system variable, the defining entities are 
either retained or deleted or you are prompted whether to keep or delete the source entities (see 
table below) 

  

Value Result 

0 Retain defining entities 

1 Delete profile entities; retain paths and guide curves 

2 Delete all defining entities  

-1 Prompt to delete profile entities; retain paths and guide curves 

-2 Prompt to delete all defining entities 

  

The key feature of direct editing capabilities provided by BricsCAD consists in preserving of design 
intent. Design intent can be expressed by 3D dimensional and geometrical constraints which can 
be explicitly specified by user (see 3D Constraints. 3D dimensional constraints (Distance, Radius 
and Angle) imposed for faces and edges give user full parametric control over the solid model, 
different configurations and scales of the model can be obtained simply by changing the parameter 
of a dimensional constraint. Geometrical constraints (Coincident, Tangent, Parallel and others) 

define how these changes influence the geometry of the model. However, there is no need to 
introduce all the geometrical constraints manually since most of them can be recognized 

automatically by BricsCAD (see Design Intent) to provide the expected result. 

Another feature of Direct Editing operations is that they can be easily applied with the Quad cursor 
menu. This tool provides a set of operations for the currently selected entities. At the same time 
the Quad provides the other basic solid editing operations such as copy, boolean union and 
subtract.  

Direct modeling operations apply to all ACIS solid geometry, whether created in BricsCAD or 
imported, and can be combined with regular solid modeling operations, for example SOLIDEDIT. 

3D Constraints 

Commands: BMBROWSER, DMUPDATE, DMFIX3D, DMCOINCIDENT3D, DMCONCENTRIC3D, 
DMPARALLEL3D, DMPERPENDICULAR3D, DMTANGENT3D, DMDISTANCE3D, DMRADIUS3D, 
DMANGLE3D 
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Variational Direct Modeling 

BricsCAD offers powerful tools for parametric direct solid and surface modeling using geometric 
constraints solving (aka variational direct modeling). Solid and surface models can be modified by 
defining constraints between their elements (edges and faces), as soon as constraint is added 
BricsCAD automatically modifies the model accordingly, and these constraints are kept satisfied 

upon following modifications of the model. The key advantage of variational direct modeling is that 
all constraints are taken into account simultaneously and the model behavior does not depend on 
the constraints creation order. It allows you to parameterize any feature of the 3D model and to do 
not care about the model creation history. 

Dimensional constraints allow controlling the dimensions of the model, when such constraint is 
introduced or the value of its parameter is changed BricsCAD automatically updates the solid and 
surface geometry to satisfy the constraint. For example, the dimensions of a box can be controlled 

by the parameters of three distance constraints applied to its opposite faces. 

Constraints can be created using the 3D Constraints toolbar, the Parametric/3D Constraints menu 

or the Constraints command group in the Quad. 

 

BricsCAD provides the following 3D constraints: 

• Geometrical constraints: Fix ( ), Coincident ( ), Concentric ( ), Parallel ( ), 

Perpendicular ( ), Tangent ( ) and Rigid Set ( ). 

• Dimensional 3D constraints: Distance ( ) , Radius ( ), Angle ( ), Cone Angle ( ). 

Mechanical Browser 

The Mechanical Browser ( ) allows to navigate through all the constraints in the model and to 
edit dimensional constraints. 

See the BmBrowser command to learn more about the Mechanical Browser. 

3D Constraints types 

The following entities are supported for constraints creation: 

• Faces of ACIS solids and surfaces of planar, cylindrical, spherical, toroidal and conical 
geometry.  

• Linear and circular edges of ACIS solids and surfaces. 

• Lines, rayes, xlines, circles and arcs. 

3D Constraints and Direct Modeling 

3D Constraints are taken into account when direct modeling operations are applied. If there is a 3D 

constraint which fixes the placement of faces or edges this constraint will be preserved during 
Push/Pull, Move and Rotate operations. The dynamically presented result of the operation respects 
existing constraints as well. 

If some faces or edges disappear in a direct modeling or in a Boolean solid editing operation 3D 
constraints applied to such entities are removed. However, if there is an exact correspondence 
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between the initial faces and the faces obtained in a result of a Boolean operation 3D constraints 

are automatically applied to new entities. 

If 3D constraints prevent modification of the model with a particular direct modeling operation 
(e.g. a Push/Pull operation applied to a face with a Fix constraint) the status line of the 3D 
Constraints Bar receives a No Solution status. 

Depending on the value of the DMRECOGNIZE system variable, BricsCAD automatically recognizes 

geometrical relations between surfaces of a solid and preserves them during direct modeling 
operations (see Design Intent Recognition).  

Design Intent 

Direct modeling operations allow to change geometry of 3D solid models easily: when a single face 
of a solid is modified with a particular operation other faces are modified accordingly in order to 
keep design intent of the model and its topological and geometrical validity. For example, consider 

a model with a number of holes of the same radius. When the radius of a cylindrical face is 
modified with a push/pull operation or by changing the value of a radial constraint other faces that 

share the same diameter are recognized by BricsCAD and modified automatically to keep the radii 
synchronized. 

  

 

Apart from the recognition of equal radii, BricsCAD automatically recognizes other geometrical 
relations between surfaces of a solid and preserves them during direct modeling operations.  

To define the design intent recognition, click the buttons on the Design Intent toolbar. A pressed 
button indicates the feature is selected. An unpressed button indicates the feature is not active. 

 

• tangent surfaces (planes, cylinders and cones) ( ) 

• coincident planes ( ) 

• parallel planes ( ) 

• perpendicular planes ( ) 

• cylinders perpendicular to planes ( ) 

• coaxial surfaces (cylinders and cones) ( ) 

• surfaces of equal radius (cylinders and spheres) ( ) 

• vertices between 4 or more faces ( ) 

• edges between coincident faces ( ) 

• switch off/on all ( ) 
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The design intent options can also be set by editing the DMRECOGNIZE system variable in the 

Settings dialog. 

Click the Options tool button ( ) on the 3D Constraints toolbar to set the Automatic 3D geometry 
constraints recognition. The state of tool buttons on the Design Intent toolbar (pressed or 
unpressed) is adjusted accordingly. 

  

 

  

NOTE 3D Constraints which are explicitly defined by the user are taken into account when solid model 
is being modified with direct modeling commands. These constraints  have a higher priority than 
automatically recognized ones and allow the user to better control the behavior of solid model 
modifications. 

  

The following examples show the difference in the behavior whether automatic 3D geometry 
constraints are recognized or not.  

  

  

tangent surfaces recognized ( ) tangent surfaces not recognized ( ) 

  

  

bricscad-sysvar.chm::/00_07_Settings_Manager.htm
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coincident planes recognized ( ) coincident planes not recognized ( ) 

  

  

  

parallel planes recognized ( ) parallel planes  not recognized ( ) 

  

  

  

perpendicular planes recognized ( ) perpendicular planes  not recognized ( ) 
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perpendicular cylinders recognized ( ) perpendicular cylinders not recognized ( ) 

  

  

  

coaxial surfaces recognized ( ) coaxial surfaces not recognized ( ) 

  

  

  

equal radius recognized ( ) equal radius not recognized ( ) 
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Direct Modeling Operations 

This section describes direct modeling operations offered by BricsCAD. These operations are 
available from the Quad tool. 

Alternatively you can use Direct Modeling Menu or Direct Modeling and Deform toolbars: 

  

 

  

 

The Align UCS tool ( ) launches the UCS command with the Face option selected. 

If the UCSDETECT system variable is ON, the UCS is aligned automatically to the currently 
highlighted face. The UCS-icon changes accordingly. Press the TAB key to select an obscured face. 
Click the DUCS field in the Status Bar to toggle the dynamic UCS feature. 

  

The following direct modeling operations are available in BricsCAD: 

  

Icon  Command Applies to Description 

 

dmPushPull  

Any face of a 3D solid or 

surface 

Adds volume to, or removes volume 

from the solid by cursor movement or 

direct distance input. 

 

dmMove 

Cylindrical, spherical, 
conical and toroidal faces 
of a 3D solid or surface. 

Linear and circular edges 
of a 3D solid or surface. 

Whole 3D solids, surfaces 

and other entities. 

Moves the selected geometry using a 
vector in the XY- plane of the current 
UCS. When a face or an edge of a solid 
or surface is moved,  adjacent faces and 
edges are adjusted to preserve the 
correct solid/surface topology. 

  

 

dmRotate 

Planar, cylindrical, 

spherical, conical and 
toroidal faces of a 3D 
solid or surface 

Whole 3D solids, surfaces 

and other entities. 

Rotates the selected geometry around 

an axis. When a face of a solid or 
surface is rotated,  adjacent faces and 
edges are adjusted to preserve the 
correct solid/surface topology. 

  

 

dmSimplify 

3D solids, surfaces and 
their faces 

Simplifies geometry and topology of 
selected entities or their subentities. 

 

dmStitch 

Surfaces Stitches disjoint surfaces into a single 

3D solid or a single surface. 

 

dmAudit 

3D solids and surfaces Checks and fixes geometrical and 

topological errors in ACIS solids and 
surfaces.  

        

 

UCS  

Planar faces of 3D solids 
and surfaces 

Aligns the UCS to the selected face. 

 

dmExtrude  

Closed 2D entities and 
detected closed 

Creates solids by extruding the selected 
2D entities or boundary.  

file:///D:/BricsCAD%20Training/manuals/03_Drawing_Accurately/03_12_Quad.htm
bricscad-cmdref.chm::/U/Ucs.htm
bricscad-sysvar.chm::/00_07_Settings_Manager.htm
file:///D:/BricsCAD%20Training/manuals/01_User_Interface/01_00_The_Bricscad_Application_Window.htm%23Working_with_the_status_bar
file:///D:/BricsCAD%20Training/manuals/03_Drawing_Accurately/03_07_User_Coordinate_Systems.htm%23DynUCS
bricscad-cmdref.chm::/DirectModeling/dmPushPull.htm
bricscad-cmdref.chm::/DirectModeling/dmMove.htm
bricscad-cmdref.chm::/DirectModeling/dmRotate.htm
bricscad-cmdref.chm::/DirectModeling/dmSimplify.htm
bricscad-cmdref.chm::/DirectModeling/dmStitch.htm
bricscad-cmdref.chm::/DirectModeling/dmAudit.htm
bricscad-cmdref.chm::/U/Ucs.htm#Face
bricscad-cmdref.chm::/DirectModeling/dmExtrude.htm
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boundaries* 

Planar faces of 3D solids 
and surfaces. 

Adds volume to, or removes volume 
from the solid. Optionally the added 
volume is created as a separate solid 

Closed 2D entities and 

detected closed 
boundaries on a planar 
face of a solid 

Creates solids or surfaces by extruding 

the selected 2D entities or boundary. 

Optionally the created volume is unified 
with or subtracted from the solid. 

 

dmRevolve 

Closed 2D entities and 
detected closed 
boundaries* 

Creates a solid or a surface by revolving 
a 2D entity about an axis. 

Planar faces of solids and 
surfaces 

Adds volume to, or removes volume 
from the solid. Optionally the added 

volume is created as a separate solid. 

Closed 2D entities and 
detected closed 
boundaries on a planar 

face of a solid 

Creates solids or surfaces by revolving 
the selected 2D entities or boundary. 

Optionally the created volume is unified 

with or subtracted from the solid. 

 

xFaces 

Faces of 3D solids and 

surfaces 

Extracts a set of 3D solid or surface 

faces as a new 3D surface object. 

 

dmCopyFaces 

A set of 3D solid faces Copies a feature (protrusion or 

depression) represented by the selected 
faces from one 3D solid to another, or to 
a different location on the same 3D 
solid. 

 

dmThicken  

Faces of 3D solids and 
surfaces 

Creates new 3D solids by thickening 
faces by a given value. 

Surfaces Creates a new 3D solid by thickening 
the whole surface. 

Wire entities (lines, 
polylines, circles, 
ellipses, arcs, helices, 

splines) 

Creates a new 3D solid by sweeping a 
circle along the selected wire. 

  

 

dmFillet 

Sharp edges of a 3D solid 
or surface. 

Creates a fillet between adjacent faces 
sharing a sharp edge(s). 

 

dmChamfer  

Sharp edges of a 3D solid 

or surface 

Creates a chamfer between adjacent 

faces sharing a sharp edge(s). 

 

Erase 

Faces of a solid or a 
surface. 

Whole 3D solids and 
surfaces. 

Deletes the selected entities. When 
faces of a solid entity are deleted, the 
gap is filled by extending the adjacent 
faces. 

When faces of a surface entity are 

deleted, the gap is filled only if the faces 
form a fillet. 

Free edges of a surface 
(a surface edge is called 
free if it has only one 
adjacent face) 

If the selected free edges belong to one 
or more holes in the surface, then these 
holes are deleted and the gap if filled 
automatically. 

Edges between coplanar 
faces. 

Deletes the edges between coplanar 
faces, thus unifying the faces. 

  

bricscad-cmdref.chm::/DirectModeling/dmRevolve.htm
bricscad-cmdref.chm::/X/XFaces.htm
bricscad-cmdref.chm::/DirectModeling/dmCopyFaces.htm
bricscad-cmdref.chm::/DirectModeling/dmThicken.htm
bricscad-cmdref.chm::/DirectModeling/dmFillet.htm
bricscad-cmdref.chm::/DirectModeling/dmChamfer.htm
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dmExtrude  

3D curves and edges of 

3D solids and surfaces 

Creates surfaces by extruding the 

selected curves and edges in a particular 
direction, which is defined heuristically, 
but can also be set by the user. 

 

dmRevolve 

3D curves and edges of 
3D solids and surfaces 

Creates surfaces by revolving the 
selected curves and edges around the 

selected axis. 

  

 

dmDeformPoint 

Faces of a 3D solid or a 
surface 

Deforms the selected set of faces by 
moving a point lying on one of them 

 

dmDeformMove 

Edges of a 3D solid or a 
surface 

Deforms faces by moving and rotating 
their edges. 

 

dmDeformCurve  

Edges of a 3D solid or a 

surface 

Deforms faces by changing the 

geometry of their edges. 

 

dmTwist  

3D solids, surfaces or 
regions 

Command to modify an object by 
twisting a portion around a given axis by 
a certain angle. 

  

  dmSelect 

Edges and faces of 3D 
solids and surfaces 

Selects edges and faces of 3D solids or 
surfaces based on their geometric and 
topologic properties; i.e. selects faces of 
a smooth side of a given solid or selects 
a set of faces forming a protrusion or 
depression feature. 

* If the Select detected boundaries option of the SELECTIONMODES system variable is ON, 
boundaries which are enclosed by 2D linear entities in the XY-plane of the current UCS, are 

detected automatically. 

bricscad-cmdref.chm::/DirectModeling/dmExtrude.htm
bricscad-cmdref.chm::/DirectModeling/dmRevolve.htm
bricscad-cmdref.chm::/DirectModeling/dmDeformPoint.htm
bricscad-cmdref.chm::/DirectModeling/dmDeformMove.htm
bricscad-cmdref.chm::/DirectModeling/dmDeformCurve.htm
bricscad-cmdref.chm::/DirectModeling/dmTwist.htm
bricscad-cmdref.chm::/DirectModeling/dmSelect.htm
bricscad-sysvar.chm::/00_07_Settings_Manager.htm
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Selection Preview 

When the Quad cursor menu is active, the SELECTIONPREVIEW system variable is neglected, 
unless a command prompts to select an entity (see Selection Settings). 

Selecting Geometry 

• Hit the TAB key to select obscured geometry. 

• The SELECTIONMODES system variable controls which subentities highlight: edges, faces 
and/or detected boundaries. 

• If a direct modeling command is entered at the command prompt or selected in a menu or 
toolbar, you need to press the Enter key (or right click) to conclude the selection 
procedure.  

• If launched from the Quad cursor menu, the command is executed when you click to 
confirm the selection of the currently highlighted geometry.  

• Window selection: Pressing the Ctrl key during window selection allows to select faces or 
edges of 3D solids and surfaces. An icon next to the cursor indicates what will be selected. 

• The dmSelect command allows to select edges and faces based on their geometrical and 
topological properties: 

• Edges of particular length 

• Edges forming a concave/convex network 

• Edge loops representing the border of a set of connected faces 

• Faces of particular area 

• Smoothly connected faces (G1 - tangent faces, or G2 - curvature continuity)  

 
G0: No continuity (left), G1: Tangent Faces (middle) and G2: Curvature continuity 
(right) 

• Fillets of particular radius 

• Cylindrical protrusions of particular radius 

• Protrusion or depression features, such as holes, pockets, extrusions or ribs 

The value of a particular length, area or radius can be taken from a selected edge/face. 

bricscad-sysvar.chm::/00_07_Settings_Manager.htm
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To Control Dimensions 

When using the dmPushPull command a dynamic dimension displays. 

Make sure the Quad and Dynamic Dimensions or ON. 

1. Hover the cursor over the face you want to move. 
The face highlights.  

2. Choose PushPull ( ) in Direct Modeling command group of the Quad cursor menu. 
The selected face is attached to the cursor and a dynamic dimension field displays the 
relative distance.  

 

3. (Option) repeatedly hit the TAB key to see the distance with respect to an internal face, 
parallel to the selected face (left) or the bottom face (right). 
Press and hold the Shift key while hitting the TAB key to reverse the display order of reference 
faces.  

 

  

file:///D:/BricsCAD%20Training/manuals/03_Drawing_Accurately/03_11_Dynamic_Dimensions.htm
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4. Type a value in the dynamic dimension field, then press Enter.  

Making Holes 

Typically holes are made using the SUBTRACT command.  

When pushpulling a closed 2D entity that lies on a face of a solid, a hole is created when you push 
the 2D entity through the solid. 

To make a (circular) hole through a solid 

1. Make sure Dynamic UCS is active.  
2. Launch the Circle command.  
3. Move the cursor to the face of the solid you wan to create the circular hole in. 

The UCS automatically aligns to the face the cursor is on.  
4. Draw a circle on the face of the solid.  

5. Hover over the circle, then choose Extrude ( ) in the Model command group of the Quad 
cursor menu.  

 

4. Push the circle inside the solid.  

bricscad-cmdref.chm::/S/subtract.htm
file:///D:/BricsCAD%20Training/manuals/03_Drawing_Accurately/03_07_User_Coordinate_Systems.htm%23DynUCS
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5. Do one of the following:  

• Type a distance in the dynamic field to define the depth of the hole.  

• Push the circle through the solid to create a through-hole.  

6. (option) Choose Push/Pull ( ) in the Model command group of the Quad cursor menu to 
modify the radius of the hole.  

7. (option) Use the dmDistance3d command to apply distance constraints between the side 

faces of the solids and the center of the cylindrical surface of the hole to control the 
position of the hole.  

8. (option) Use the dmRadius3d command to control the radius of the hole.  

To make a hole in a surface 

1. Create a 2D closed entity, e.g. an ellipse. 
 

 

2. Hover over the 2D entity. 

file:///D:/BricsCAD%20Training/manuals/03_Drawing_Accurately/03_12_Quad.htm
bricscad-cmdref.chm::/DirectModeling/dmDistance3d.htm
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3. Choose Extrude ( ) in the Model command group of the Quad cursor menu. 

4. Extrude the 2D entity in the direction of the surface. 
 

 

5. Press the Ctrl-key twice to select the Subtract option of the DmExtrude command. 
 

 

6. Click to create the opening. 

file:///D:/BricsCAD%20Training/manuals/03_Drawing_Accurately/03_12_Quad.htm
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Deleting Features 

To delete a hole, you must delete all internal faces and/or surfaces of the hole. 

To delete a circular hole 

1. Hover over the cylindrical surface of the hole.  

2. Choose Delete ( ) in the Model command group of the Quad cursor menu.  

 

To delete a rectangular hole 

1. Hover over one of the visible internal faces of the hole. 
The face highlights.  

2. Choose PushPull ( ) in the Model command group of the Quad cursor menu.  

 

3. Drag the selected face to close the hole. 

file:///D:/BricsCAD%20Training/manuals/03_Drawing_Accurately/03_12_Quad.htm
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To delete a niche or recess 

1. Hover over the back (bottom) face of the recess. 
If the face is obscured in the current view, hit the TAB key untill the face highlights. 

2. Choose PushPull ( ) in the Model command group of the Quad cursor menu. 

 

 

3. Drag the face outside the solid. 

To delete a hole in a surface 

1. Hover over the edge of the opening. 
The edge highlights. 

2. Choose Erase ( ) in the Model command group of the Quad cursor menu.. 

 
  

  

To delete a depression (hole or pocket) or a protrusion feature (extrusion or 

rib) 

1. Select one or more faces of the feature you want to delete. 

2. Click the Protrusion (  ) or Depression ( ) tool button in the Select panel of the Solid 
ribbon tab or in the Select command group of the Quad (not supported yet!). 

3. Click the Erase ( ) tool button. 

 

file:///D:/BricsCAD%20Training/manuals/03_Drawing_Accurately/03_12_Quad.htm
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Removing Edges Between Coplanar Faces 
When two or more faces are made coplanar, e.g. using the PushPull command, it might be 
necessary to remove the shared edges. 

  

 

 

Two depressed faces ... ... moved to the top face, creating 

three coplanar faces. 

  

1. Select the three faces. 

2. Choose Delete ( ) in the Model command group in the Quad. 
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The shared edges are deleted and the  three selected faces are unified. 

 

 
  

Copying Features 

the dmCopyFaces command allows to copy one or more features of a 3D solid, such as depressions 
(holes, grooves, pockets) or protrusions (extrusions, ribs) to a new location on the same or a 
different 3D solid. 

To copy a feature do the following: 

1. Select all faces of the entire feature(s) (see Selecting Geometry). 

2. Make sure  dynamic UCS is enabled.   
It is recommend to always keep DUCS enabled when using the Direct Modeling toolset. 

3. Click the Copy Faces ( ) tool button: 

• on the ribbon:  Solid | Edit | Copy Faces . 

• on the Direct Modeling toolbar. 

• in the menu bar:  Model | Direct Modeling | Copy Faces 

You are prompted: Enter base point: 

4. Specify the base point. 
You are prompted: Select insertion point or [Rotate/mUltiple/MOde]: 

5. Optionally:    

• Use the Rotate option to rotate the faces around Z axis of the UCS. 

bricscad-cmdref.chm::/DirectModeling/dmCopyFaces.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/10_03_03_Direct_modeling_operations.htm%23SelectingGeometry
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• Use the  Multiple option to insert the multiple copies of the selected feature. 

6. Specify the insertion point. 

The feature is copied from the base point to the insertion point taking into account the 
dynamic UCS used to select both points.  

 

 

Select the faces of the entire feature Specify base point 

 

 

Specify insertion point The feature is copied 

  

Deformable Modeling 

 

  

Using the tools on the Deform toolbar, you can create complex aesthetic shapes from simpler ones 
by deforming a set of adjacent faces of 3d solid or a surface.  

The faces are always deformed under the following conditions: 

• Their external boundary (= edges, which are adjacent to only one of the selected faces) 
remain unchanged 

• Their internal boundaries (= edges, which are adjacent to two of the selected faces) is 
deformed together with the faces 

• The initial continuity between deformed faces (G1 &endash; tangent faces, or G2 &endash; 
curvature continuity) is kept during deformation 

For a twist deformation it is possible to specify the continuity between the deformed and the fixed 

portion of the entities. 

Deformation can be defined in several ways: 

• By twisting the whole entity or its portion 

• By moving a point lying on a face in any direction in 3D space 

• By moving or rotating one or more edges 

• By replacing an edge with a given 3D curve 
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Working with Sections 

Commands: SECTION, SECTIONPLANE, LIVESECTION, SECTIONPLANESETTINGS, 
SECTIONPLANETOBLOCK. 

The Section command creates section planes of 3D solids; the results are region entities.  

The Sectionplane command creates a section entity that creates sections of 3D solids, surfaces 
and meshes.  

The Livesection command toggles the Live Section property of a section plane. 

The Sectionplanesettings command defines the properties of a section plane entity in the Drawing 
Explorer - Section Planes dialog. 

The Sectionplanetoblock command saves the selected section plane to a 2D cross section / 

elevation block or a 3D cutaway section block. 

  

NOTE The BIMSECTION command creates BIM section entities, which are SectionPlane entities 

with extended properties, such as type (plan, section, elevation)and scale. 

  

SectionPlane command 

Do one of the following: 

• Click the Section Plane tool button ( ) on the Sections toolbar.  

• Choose Sections > Section Plane in the Model menu.  

• Type sectionplane in the command bar.  

You are prompted: Specify start point or [select Face/Draw/Orthographic]: 

Align Section Plane to a Face 

1. Launch the Sectionplane command.  
2. Choose Select Face in the prompt menu or type F in the command bar. 

You are prompted: Select entity:  

3. Select the face of a solid you want to align the section plane to.  

   

Solid Select face Section plane aligned to face 

The section plane is aligned to the selected face. The Clip Display property of the section entity is 
switched on automatically. 

4. (option) Edit the properties of the section plane.  

bricscad-cmdref.chm::/S/section.htm
bricscad-cmdref.chm::/S/SectionPlane.htm
bricscad-cmdref.chm::/L/LiveSection.htm
bricscad-cmdref.chm::/S/SectionPlaneSettings.htm
bricscad-cmdref.chm::/S/SectionPlaneToBlock.htm
bricscad-cmdref.chm::/BIM/BimSection.htm
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To Create a Vertical Section Plane 

1. Make sure the WCS is the current coordinate system.  
2. Launch the Sectionplane command.  
3. Specify two points. 

The section plane is created through these points and perpendicular to the XY-plane of the 
current coordinate system. 
The part of the solid at the right hand side of the section plane is cut away. 

The Clip Display property of the section entity is not switched on automatically.  

  

Specify two points Vertical section plane 

4. (option) Edit the properties of the section plane.  

To Create a Vertical Jogged Section Plane 

1. Make sure the WCS is the current coordinate system.  
2. Launch the Sectionplane command.  

3. Choose Draw in the prompt menu or type D in the command bar. 
You are prompted: Specify start point:  

4. Specify the first point (1). 
You are prompted: Specify next point:  

5. Specify the second point (2): 
You are prompted: Specify next point or ENTER to finish:  

6. Specify the other points (3 - 6) , the right click or press Enter to stop. 

You are prompted: Specify the direction of the section entity:  
7. Click a point (7) to specify the direction of the section entity. 

The part of the solid opposite to the direction of the section entity is cut away. 
The Clip Display  property of the section entity is not switched on automatically.  

  

 

Specify points 
The part of the solid 
opposite to the direction of 
the section entity is cut 

Vertical jogged 

section plane 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/10_03_06_Working_With_Sections.htm%23LaunchSectionplane
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away. 

8. (option) Edit the properties of the section plane.  

To Create a Horizontal Section Plane 

1. Choose Front in the Look From widget.  

 

2. Align the UCS to the front view: 
Type ucs at the command prompt, choose the View option in the prompt menu or type V in 
the command bar. 

If UCSORTH0 = ON, the UCS is aligned with the view automatically.  
3. Launch the Sectionplane command.  
4. Specify two points. 

The section plane is created through these points and perpendicular to the XY-plane of the 
current coordinate system. 
The part of the solid at the right hand side of the section plane is cut away. 
The Clip Display property of the section entity is not switched on automatically.  

  

 

Specify two points 
The part of the solid at the 

right hand side of the 
section plane is cut away. 

Horizontal section plane 

5. (option) Edit the properties of the section plane.  

To Create a Horizontal Jogged Section Plane 

1. Choose Front in the Look From toolbar.  

 

2. Align the UCS to the front view: 

Type ucs at the command prompt, choose the View option in the prompt menu or type V in 
the command bar. 
If UCSORTH0 = ON, the UCS is aligned with the view automatically.  

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/10_03_06_Working_With_Sections.htm%23EditProperties
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3. Launch the Sectionplane command.  

4. Choose Draw in the prompt menu or type D in the command bar. 
You are prompted: Specify start point:  

5. Specify the first point (1). 
You are prompted: Specify next point:  

6. Specify the second point (2): 

You are prompted: Specify next point or ENTER to finish:  
7. Specify the other points (3 - 6) , the right click or press Enter to stop. 

You are prompted: Specify the direction of the section entity:  
8. Click a point (7) to specify the direction of the section entity. 

The part of the solid opposite to the direction of the section entity is cut away. 
The Clip Display property of the section entity is not switched on automatically. 
The section plane gets the Boundary state.  

  

 

Specify points 

The part of the solid 

opposite to the direction 

of the section entity is cut 
away. 

Horizontal jogged 

section plane 

9.   (option) Edit the properties of the section plane.  

To Create a Orthographic Section Plane 

1. Make sure the WCS is the current coordinate system.  
2. Launch the Sectionplane command.  
3. Choose Orthographic in the prompt menu or type O in the command bar. 

You are prompted: Align section to [Front/bAck/Top/Bottom/Left/Right] <Top>:  
4. Pick the orthographic section orientation of your choice in the prompt menu or type the 

corresponding option in the command bar. 
Orthographic section planes are created through the center of the solid, parallel to the XY-

plane (Top and Bottom), YZ-plane (Left and Right) or XZ-plane (Front and Back) of the 
current coordinate system.  

The Clip Display property of the section entity is not switched on automatically. 

  

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/10_03_06_Working_With_Sections.htm%23LaunchSectionplane
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/10_03_06_Working_With_Sections.htm%23EditProperties
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Top Front Right 

5. (option) Edit the properties of the section plane.  

To open the Drawing Explorer - Section Planes dialog 

  Do one of the following: 

• Choose Drawing Explorer > Section Planes in the Tools menu.  

• Choose Sections > Section Plane Settings... in the Model menu.  

• Type sectionplanesettings in the command bar, then press Enter.  

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/10_03_06_Working_With_Sections.htm%23EditProperties
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To edit the properties of a section plane in the Drawing Explorer 

1. Open the Drawing Explorer - Section Planes dialog.  

 

2. (option) Click the Section Plane Name field, then click again to type a new name.  
3. (option) Click the Live Section check box of a section plane to toggle the Live Section 

property of the section plane. 

If necessary, click the Regen tool button ( ) in the Details toolbar to update the display.  
4. (option) Click the State field of a section plane to choose a different state for the section 

plane.  

 

5. (option) click the Plane Transparency field of a section plane to change the transparency of 
the section plane entity in the drawing. 
0 = Opaque, 100 = Transparent (invisible).  

6. (option) Click the Plane Color field, then choose a new color in the Select Color dialog.  

To edit the properties of a section plane in the properties bar: 

Select the section entity in the drawing. 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/10_03_06_Working_With_Sections.htm%23SectionPlanesDialog
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• Name: allows to rename the section entity. 

• State: click, then select Plane, Boundary or Volume. 

• Live Section: click, then select Yes or No. 

• Clip display: click, then select Yes or No. 

• Use lids: click, then select Yes or No. 

• Plane transparency: allows to define the transparency of the section plane. 

• Plane color: allows to define the color of the section plane. 
 

NOTE Difference between Live Section and Clip Display: 

In both statuses all drawing content is sectioned and clipped-away parts are no longer 
displayed.  

Live status: entities in a drawing are temporarily modified, e.g. clipped solids are 
replaced by temporary solids with a different shape.  

Clip Display status: the display of entities is clipped. As in the AutoCAD 3DCLIP 
command, entities are not replaced by temporary versions. Different from the Live 
status, the Clip Display status allows to continue using all modeling and editing 

operations on all drawing content. While the 3DCLIP command allows to clip the display 
by a Front and a Back plane, it is not very useful because these planes must be reset 
whenever the view direction changes. Using a Section entity to control which part of a 
model is displayed, makes it easy to store and repeat display states. Besides the Plane 
state, which typically clips a model in two halves, also the Boundary and Volume state of 
section entity can be used.  

As opposed to the Live status, the Clip Display status can be set for multiple section 
entities simultaneously. Clipped solids can optionally be closed by setting the Use Lids 
option. Althoug it has been made possible to snap to the geometry of these lids, they are 
not actually added to the drawing. If enabled, the hatch pattern defined in the 2dSection 
Intersection Fill settings of the section entity displays on top of the lids. 

   

To Modify the Size and Position of a Section Plane 

1. Select the section plane entity in the drawing. 
Depending on the current state of the section plane entity a number of grips display.  

2. (option) Switch on the Live Section property of the section plane to see the result of the 
modifications dynamically.  

3. (option) To grip edit a Plane state section plane entity:  
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Four grips display.  

• 1  ( ) = origin point: moves the position of the section plane in the XY-plane.  

• 2  ( ) = through point: redefines the through point of the section plane. 
The section plane is rotated around the origin point (1).  

• 3  ( ) = midpoint: moves the section plane parallel in a direction perpendicular to the 
section plane.  

• 4 ( ): click to flip the view direction of the section plane.  

3. (option) To grip edit a Boundary state section plane entity:  
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Ten grips display. 

• 1 ( ) = origin point: moves the position of the section plane in the XY-plane.  

• 2 ( ) = through point: redefines the through point of the section plane. 
The section plane boundary is stretched and rotated around the origin point (1).  

• 3 ( ): stretches the section plane boundary parallel.  

• 4 ( ): modifies the shape of the section plane boundary.  

• 5 ( ): click to flip the view direction of the section plane.  

4. (option) To grip edit a Volume state section plane entity:  

 

Twelve grips display. 

• 1 ( ) = origin point: moves the position of the section plane in the XY-plane.  
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• 2 ( ) = through point: redefines the through point of the section plane. 

The section plane volume is stretched and rotated around the origin point (1).  

• 3 ( ) :stretches the section plane volume parallel.  

• 4 ( ): modifies the shape of the section plane volume.  

Polar Tracking must be on to move grips 5.  

 

• 5 ( ): modifies the height of the section plane volume.  

• 6 ( ): click to flip the view direction of the section plane.  

Using Live Section 

When the Live Section property of a section plane is on, the sectioning of a 3D solid, surface or 
region displays in the drawing. If the section entity is moved or modified, the sectioning is updated 
dynamically. The Live Section Settings of the section entity control the appearance of the live 

section.  

To set the Live Section property of a section plane: 
Method 1: Using the LIVESECTION command. 

1.  Do one of the following:  

• Click the Live Section tool button ( ) on the Sections toolbar.  

• Choose Live Section in the Model > Sections menu.  

You are prompted: Select a section entity: 

2. Click a section entity in the drawing. 
The Live Section property of the selected section plane is toggled.  

Method 2: Using the Properties bar. 

1. Select the section plane entity in the drawing.  
2. In the Properties Bar, under Selection Entity, click the Live Section field and select Yes.  

Method 3: Using the Drawing Explorer - Section Planes dialog. 

1. Select the section plane in the  Drawing Explorer - Section Planes dialog  
2. Click the check box in the Live Section field.  

To define the live section settings 

1. Open the Drawing Explorer - Section Planes dialog.  
2. Select the section plane.  

3. Select Live Section Settings in the Edit pane on the Drawing Explorer - Section Planes 

dialog. 
The live section settings display.  

file:///D:/BricsCAD%20Training/manuals/03_Drawing_Accurately/03_05_Polar_Tracking.htm
bricscad-cmdref.chm::/L/LiveSection.htm
file:///D:/BricsCAD%20Training/manuals/01_User_Interface/00_06_Properties_Bar.htm
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Cut-away Geometry ON Cut-away Geometry OFF 
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To Save a Section 

The SECTIONPLANETOBLOCK command allows you to: 

• Insert a section in the drawing as a 2D section / elevation block or a 3D cutaway block.  

• Replace a section block (e.g. when the section entity has been modified).  

• Save a section to a new drawing.  

To launch the SectionPlaneToBlock command 

Do one of the following: 

• Click the Section Plane to Block tool button ( ) on the Sections toolbar.  

• Choose Section Plane to Block in the Model > Sections menu.  

• Type sectionplanetoblock in the command bar, then press Enter  

The Create Section/Elevation dialog box displays: 

  

 

bricscad-cmdref.chm::/S/SectionPlaneToBlock.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/10_03_06_Working_With_Sections.htm%23Insert2D
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/10_03_06_Working_With_Sections.htm%23Insert3D
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/10_03_06_Working_With_Sections.htm%23ReplaceExistingBlock
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To Insert a Section as a 2D Block 

1. (option) Adjust the 2D Section / Elevation settings of the section plane entity.  
2. Launch the Section Plane to Block command.  
3. Set the Destination to Insert new block.  
4. Under Source Geometry, do one of the following:  

• Choose Include all entities to include all 3D solids in the drawing.  

• Choose Select entities, then click the Select button ( ) to select 3D solids.  

4. Under Section plane, click the Select button ( ), then select a section plane entity in the 
drawing.  

5. Set the Section type to 2D cross section/elevation.  

6. Adjust the Insert options (see Insert a block).  
7. Click the OK button.  

8. The Create Section/Elevation dialog closes. 
The block is attached to the cursor. 
Follow the instructions in the command bar to place the block in the drawing.  

To Insert a Section as a 3D Block 

1. (option) Adjust the 3D cutaway section settings of the section plane entity.  
2. Launch the Section Plane to Block command.  
3. Set the Destination to Insert new block.  
4. Under Source Geometry, do one of the following:  

• Choose Include all entities to include all 3D solids in the drawing.  

• Choose Select entities, then click the Select button ( ) to select 3D solids.  

4. Under Section plane, click the Select button ( ), then select a section plane entity in the 
drawing.  

5. Set the Section type to 3D cutaway section.  
6. Adjust the Insert options (see Insert a block).  
7. Click the OK button.  
8. The Create Section/Elevation dialog closes. 

The block is attached to the cursor. 

Follow the instructions in the command bar to place the block in the drawing.  

To Replace an Existing block 

1. Launch the Section Plane to Block command.  
2. Set the Destination to Replace existing block.  

3. Click the Select button ( ), then select the block to be replaced in the drawing.  

4. Under Source Geometry, do one of the following:  

• Choose Include all entities to include all 3D solids in the drawing.  

• Choose Select entities, then click the Select button ( ) to select 3D solids.  

4. Under Section plane, click the Select button ( ), then select a section plane entity in the 
drawing.  

5. Under Section type, do one of the following:  

• Choose 2D cross section/elevation, to replace the block by a 2D section / elevation 
block.  

• Choose 3D cutaway section, to replace the block by a 3D cutaway section block.  

6. Click the OK button. 

The selected block is replaced.  

bricscad-cmdref.chm::/S/SectionPlaneSettings.htm#2DSectionSettings
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/10_03_06_Working_With_Sections.htm%23PlaneToBlockCommand
file:///D:/BricsCAD%20Training/manuals/12_Blocks_Attributes_External_References/01_Blocks/12_01_02_Inserting_Blocks.htm%23To_insert_a_block
bricscad-cmdref.chm::/S/SectionPlaneSettings.htm#3DSectionSettings
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/10_03_06_Working_With_Sections.htm%23PlaneToBlockCommand
file:///D:/BricsCAD%20Training/manuals/12_Blocks_Attributes_External_References/01_Blocks/12_01_02_Inserting_Blocks.htm%23To_insert_a_block
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To Export a Section to a File 

1. Launch the Section Plane to Block command.  
2. Set the Destination to Export to file.  

3. Click the Browse button ( ), then do the following in the Select export file dialog box:  

• Select a folder.  

• Type a name in the File name field.  

• Click the Save button.  

4. Under Source Geometry, do one of the following:  

• Choose Include all entities to include all 3D solids in the drawing.  

• Choose Select entities, then click the Select button ( ) to select 3D solids.  

5. Under Section plane, click the Select button ( ), then select a section plane entity 
in the drawing.  

6. Under Section type, do one of the following:  

• Choose 2D cross section/elevation, to replace the block by a 2D section / elevation 
block.  

• Choose 3D cutaway section. to replace the block by a 3D cutaway section block.  

7. Click the OK button. 
Section is saved to a drawing. 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/10_03_06_Working_With_Sections.htm%23PlaneToBlockCommand
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Hatches and Gradient Fills 

Commands: HATCH, -HATCH, GRADIENT, HATCHEDIT, -HATCHEDIT 

When you add hatching to a drawing, BricsCAD fills entities or enclosed areas with a predefined 
pattern or lines. First you specify the hatch pattern and other options, and then you choose which 

entities or enclosed areas that you want to hatch. 

  

NOTE

S 
• Depending on the pattern, hatchings are memory intensive and might take a 

considerable amount of time to draw and display. To improve performance, add 
hatching as one of the last steps when you create a drawing, or insert hatches on 
a separate layer that you can freeze as you continue to work on your drawing. Or 
use the FILLMODE system variable to switch off the display of hatches, gradient 

fills and filled entities. 

• The maximum number of dashes is controlled by the MAXHATCH settings 

variable. When the number of dashes is higher than the current MAXHATCH 
value, the hatch cannot be created. 
A warning box displays offering possible choices for subsequent actions: 
 

 

By default the maximum number of dashes is 100 000. 

  

The  predefined and user pattern files sit in the Support  folder of the current user. 

The MEASUREMENT setting controls which predefined hatch pattern file will be used.  

• Imperial: uses Default.pat 

• Metric: uses Iso.pat 

Defining the MEASUREMENT setting 

Do one of the following: 

• In the command bar type measurement, then press Enter. 
Type ON, then press Enter to set measurement to Metric. 
Type OFF, then press Enter to set measurement to Imperial. 

• In the Settings dialog go to Drawing > Drafting > Drawing units. 
Choose either Metric or Imperial in the combo box. 

 

bricscad-cmdref.chm::/H/Hatch/Hatch.htm
bricscad-cmdref.chm::/H/Hatch/-Hatch.htm
bricscad-cmdref.chm::/G/Gradient.htm
bricscad-cmdref.chm::/H/HatchEdit/HatchEdit.htm
bricscad-cmdref.chm::/H/HatchEdit/-HatchEdit.htm
bricscad-sysvar.chm::/00_07_Settings_Manager.htm
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Defining the MAXHATCH setting 

Do one of the following: 

• In the command bar type maxhatch, then press Enter. 
Type a new value and press enter. 

• In the Settings dialog, go to Drawing > Drafting > Entity Creation > Hatches. 
Type a new value in the Maximum hatch dashes settings field. 

 

The Hatch command fills an enclosed area in your drawing with a pattern.  

The Gradient command creates solid fills in nine different patterns and one or two colors. 

The area can either be a single entity such as a circle or a closed polyline or an area enclosed by a 
selection of entities.  

To create the hatch you can click inside the closed perimeter of a boundary or you can select 
entities. 

General procedure to create hatches and gradient fills 

1. Do one of the following:  

• Click the Hatch tool button ( )  or the Gradient tool button ( ) on the Draw toolbar.  

• Choose Hatch... or Gradient... in the Draw menu.  

• Type hatch or gradient in the command bar, then press enter.  

The Hatch and Gradient dialog displays. 

2. Do one of the following:  

• Click the Hatch tab to create a hatch, then define the hatch properties.  

• Click the Gradient tab to create a gradient fill, then define the gradient fill properties.  

3. Define the boundary for the hatch or gradient fill.  
4. Set the options for the hatch or gradient fill.  
5. Click the OK button to create the hatch or gradient fill.  

bricscad-sysvar.chm::/00_07_Settings_Manager.htm
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To Define Hatch Properties 

1. On the  Hatch and Gradient dialog click the Hatch tab. 
 

 

2. (option) Click the Inherit properties button ( ).  

• The Hatch and Gradient dialog closes temporarily. 
Prompts you: Select hatch entity to copy properties from:  

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/10_04_01_Using_Boundary_Hatch.htm%23GeneralHatchProcedure
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• Select a hatch entity. 

The Hatch and Gradient dialog reopens, displaying the properties of the selected hatch 
entity.  

3. (option) Select the Pattern Type.  

 

• User Defined - uses the pattern defined in this dialog box with the Angle, Spacing, and 

Cross Hatch options.  

• Predefined - uses patterns defined in iso.pat (metric units - MEASUREMENT = ON) and 
default.pat (imperial units - MEASUREMENT = OFF).  

• Custom - uses patterns defined in *.pat files (one pattern definition per file).  

BricsCAD searches for *.pat files in the folders that are defined in the SRCHPATH (Support File 
Search Path) system variable. 

4. (option) If the Pattern Type is Predefined or Custom select a Pattern Name in the Hatch 
pattern palette, 
then double click the pattern or click the OK Button.  

 
  

5. (option) If the Pattern Type is Predefined or Custom, do one of the following:  

• Type a scale in the Scale settings field.  

• Choose the scale from the drop down list.  

bricscad-sysvar.chm::/00_07_Settings_Manager.htm
bricscad-sysvar.chm::/00_07_Settings_Manager.htm


BricsCAD V18  Help 

 

 369 

5. (option) Do one of the following:  

• Type an angle in the Angle settings field.  

• Choose the angle from the drop down list.  

6. (option) If the Pattern Type is User defined, specify the Pattern Spacing.  
7. (option) If the Pattern Type is User defined, select the Cross Hatch option.  

8. Define the Hatch Origin. The options are:  

• Use current origin: The origin as defined by the HPORIGIN system variable is reused.  

• Specified origin: Click the Pick new origin button ( ), then pick a point in the drawing. 
The new origin is stored in the HPORIGIN system variable.  

NOTE The BACKGROUNDCOLOR property of a hatch can be modified in the Pattern / 

Background Color field in the Properties panel. 

   

   

bricscad-sysvar.chm::/00_07_Settings_Manager.htm
bricscad-sysvar.chm::/00_07_Settings_Manager.htm
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To Define Gradient Fill Properties 

1. On the  Hatch and Gradient dialog click the Gradient tab.  

 

2. (option) Click the One color radio button to create a 'color to white' or 'color to black' 
gradient fill.  

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/10_04_01_Using_Boundary_Hatch.htm%23GeneralHatchProcedure
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• Click the colored tile to open the Select color dialog, to pick a different base color.  

• The color slider sets the transition from color to white or black. 

Press and hold the left mouse button to move the color slider ( ) . 
Move the slider to the far right to create a 'color to white' gradient fill. 
Move the slider to the far left to create a 'color to black' gradient fill.  

2. (option) Click the Two color radio button to create 'two color' gradient fill. 
Click the colored tiles to open the Select color dialog to pick the base colors.  

3. Select one of the 9 gradient patterns. 
The options are: linear, cylindrical, inverted cylindrical, spherical, hemispherical, curved, 

inverted spherical, inverted hemispherical and inverted curved.  
4. (option) Centered: If centered, the gradient fill is created symmetrical; if not centered, the 

gradient fill is built up from the left of the boundary.  
5. (option) Angle: Specifies the angle of the gradient fill, relative to the current UCS.  

To define the boundary for a hatch or gradient fill 

1. (option) Select the Boundary retention option.  
2. (option) Select an Island option.  

 

3. (option) Adjust the Boundary tolerance.  

 

4. (option) Click the Select button ( )  to select a Boundary set. 
The Hatch and Gradient dialog temporarily closes to let you select entities. 

(see also the note below)  
5. (option) Click the Specified Origin radio button, then click the  Pick a new origin button 

( ). 
The Hatch and Gradient dialog temporarily closes to let you specify a new origin.  

6. Do one or more of the following:  

• Click the Pick Points button ( ). 

The Hatch and Gradient dialog closes. 
You are prompted: Select a point to define a boundary or hatch area:  

• Specify a point in each of the areas you want to hatch. 
You are prompted: Select a point to define a boundary or hatch area: 

• Right click or press Enter to stop adding areas. 
The Hatch and Gradient dialog displays again. 

• Click the Select Boundary Entities button ( ). 
The Hatch and Gradient dialog closes. 
You are prompted: Select entities:  

• Select the entities you want to hatch. 

• Right click or press Enter to stop selecting entities. 
The Hatch and Gradient dialog displays again. 

• Click the Remove Boundary Entities button ( ). 

The Hatch and Gradient dialog closes. 
You are prompted: Select entities: 



  User Guide 

 372 

• Select the current boundary entities to be removed from the selection. 

• Right click or press Enter to stop selecting entities. 
The Hatch and Gradient dialog displays again. 

7. Define the Hatch Origin. The options are:  

• Use current origin: The origin as defined by the HPORIGIN system variable is reused.  

• Specified origin: Click the Pick new origin button ( ), then pick a point in the drawing. 
The new origin is stored in the HPORIGIN system variable.  

  

NOTE If a selection set was active when you launch the Hatch tool, this selection will be used as 

the Boundary Set if you click the New button in step 11 in the above procedure. In this 

case the Hatch and Gradient dialog closes and immediately reopens. 

Set the Hatch and Gradient options 

1. (option) Select the Annotative option to create an annotative hatch.  
2. (option) Select the Associative option to associate the hatch with its boundary.  
3. (option) Select the Create Separate Hatches option. 

In case multiple boundaries are detected or multiple entities are selected in step 9, 
separate hatches are created instead of a single hatch.  

4. (option) Choose a Draw order option. 

 
This option is reset to Send behind boundary when the drawing is closed and reopened. 

bricscad-sysvar.chm::/00_07_Settings_Manager.htm
bricscad-sysvar.chm::/00_07_Settings_Manager.htm
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Editing Hatches and Gradient Fills 

  

If you select a hatch or gradient fill, its properties display in the Properties bar. 

To edit a hatch or gradient fill in the properties bar 

1. Select the hatch or gradient fill in the drawing.  

The properties of the selected entity display in the Properties bar: 

 

Hatch properties 

  

file:///D:/BricsCAD%20Training/manuals/01_User_Interface/00_06_Properties_Bar.htm
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Gradient fill properties. 

2. Select the property you want to modify in the Properties bar. 
The selected property field is activated.  

3. Modify the selected property  

4. Do one of the following:  

• Repeat steps 2 and 3 to modify another property.  

• Press the Esc key to stop editing the hatch.  

NOTES • If you select multiple hatches you can you edit them simultaneously. Properties 
which are different display as *varies* in the BricsCAD Properties bar. If you 

edit such property, all edited hatches will then share this property.  

• Linetype, Linetype scale and Lineweight apply to User Defined pattern types 
only . 

  

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/00_Entity_Creation_Settings/10_00_04_Entity_Linetype_Scale.htm
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Editing Hatches and Gradients in the Properties Bar 
Commands: HATCHEDIT and -HATCHEDIT 

  

If you select a hatch or gradient fill, its properties display in the Properties bar. 

1. Select the hatch or gradient fill in the drawing. 

The properties of the selected entity display in the Properties bar: 

 

Hatch properties 

  

bricscad-cmdref.chm::/H/HatchEdit/HatchEdit.htm
bricscad-cmdref.chm::/H/HatchEdit/-HatchEdit.htm
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Gradient fill properties. 

2. Select the property you want to modify in the Properties bar. 
The selected property field is activated. 

3. Modify the selected property 

4. Do one of the following: 

• Repeat steps 2 and 3 to modify another property. 

• Press the Esc key to stop editing the hatch. 

NOTES • If you select multiple hatches you can you edit them simultaneously. Properties 
which are different display as *varies* in the BricsCAD Properties bar. If you 

edit such property, all edited hatches will then share this property.  

• Linetype, Linetype scale and Lineweight apply to User Defined pattern types 
only . 
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To edit a hatch in a dialog box 

1. Do one of the following: 

• Double click a hatch or gradient fill entity. 

• Type hatchedit at the command prompt, then select a hatch or gradient fill entity. 

The Hatch Edit dialog displays: 

 

2. (option) Select the Gradient tab to turn the Hatch into a Gradient fill. 
3. Edit the Pattern settings. 
4. Edit the Boundary settings. 

5. Click the OK button to apply the changes. 
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To edit a gradient fill in a dialog box 

1. Do one of the following: 

• Double click a hatch or gradient fill entity. 

• Type hatchedit at the command prompt, then select a hatch or gradient fill entity. 

The Hatch Edit dialog displays: 

 

2. (option) Select the Hatch tab to turn the Gradient fill into a Hatch . 
3. Edit the Color settings. 
4. Edit the Boundary settings. 

5. Click the OK button to apply the changes. 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/10_04_01_Using_Boundary_Hatch.htm%23DefineGradientProperties
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To edit a hatch or gradient fill using the Quad 

1. If necessary, hit the F12 function key to activate the Quad cursor menu. 
2. Pause the cursor of the hatch or gradient fill. 

The Quad displays. 
3. Move the cursor to the Quad and expand the 2D Editing command group. 

 

 
4. Do one of the following: 

• Click the Add Loop button ( ). 
You are prompted: Specify internal point or [Select entities]: 
Click inside a closed area, 

or 

Type S, then press Enter to select entities. 

Right click or press Enter to conclude. 

• Click the Remove Loop button ( ). 
The boundaries of the selected hatch highlight. 
You are prompted: Select entities: 
Click the boundaries you want to remove. 

Right click or press Enter to conclude. 

• Click the Associate button ( ). 

You are prompted: Specify internal point or [Select entities]: 
You are prompted: Specify internal point or [Select entities]: 
Click inside a closed area, 
or 

Type S, then press Enter to select entities. 

Right click or press Enter to conclude. 

• Click the Generate Boundary button ( ). 
The boundary of the hatch is generated. 

• Click the Send all hatches to back button ( ). 
You are prompted: # hatch entity(ies) sent to back. 

  

NOTE To repeat  a Quad command, right click when the Quad displays. 

 

  

file:///D:/BricsCAD%20Training/manuals/03_Drawing_Accurately/03_12_Quad.htm
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Dimensions 

All tools to create dimension entities can be found either on the Dimensions toolbar or in the 
Dimensions menu. 

Toolbar 

 

Menu 
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Icon 
Tool 

name 

Command Description 

 

Linear DIMLINEAR  Creates horizontal or vertical linear 
dimensions. 

 

Aligned DIMALIGNED  Creates linear dimensions which are 
aligned with the dimension points. 

 

Arc DIMARC  Creates arc length dimensions 

 

Radius DIMRADIUS  Creates radial dimensions in circles 
and circular arcs. 

 

Diameter DIMDIAMETER  Creates diametrical dimensions in 

circles and circular arcs. 

 

Angular  DIMANGULAR  Creates angular dimensions 

 

Baseline  DIMBASELINE  Creates stacked linear dimensions. 

 

Continue  DIMCONTINUE  Creates a chain of linear dimensions, 
starting from an existing linear 
dimension entity. 

 

Ordinate DIMORDINATE  Creates ordinate dimensions. 

 

Rotated DIMLINEAR  Creates rotated linear dimensions. 

 

Make 
Oblique 

DIMEDIT + O Makes the extension lines of the 
selected dimension(s) oblique. 

 

Multileader MLEADER  Creates Mleaders (multileaders) 

using a multileader style. 

 

Edit 
Multileader 

MLEADEREDIT  Adds leader lines to and removes 
leader lines from a multileader entity. 

 

Multileader 
add 
leaders 

AIMLEADEREDITADD Adds leader lines to a multileader. 

 

Multileader 
remove 

leaders 

AIMLEADEREDITREMOVE Removes leader lines from a 
multileader. 

 

Tolerance TOLERANCE  Defines the layout of geometric 

tolerances. 

 

Center 
Lines 

DIMCENTER  Draws center lines in circles and 
circular arcs. 

 

Edit 
Dimension 
Text  

DIMEDIT+ E Defines the dimension text of the 
selected dimension(s). 

 

Rotate 
Dimension 
Text  

DIMEDIT+ R Rotates the dimension text of the 
selected dimension(s). 

 

Reposition 
Dimension 
Text  

DIMTEDIT  Lets you reposition the dimension 
text. 

 

Restore 
Text 
Position 

DIMEDIT  Undoes the rotation or repositioning 
of the dimension text of the selected 
dimension(s). 

 

Apply 

Style 

-DIMSTYLE + A Applies the current dimension style to 

the selected dimension(s). 

 

Save Style  -DIMSTYLE + S Saves the current dimension settings 
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in a new dimension style. 

 

Restore 
Style 

-DIMSTYLE  Sets the current dimension style. 

 

Dimension 
Variable 
Status 

-DIMSTYLE + ST Displays the status of the dimension 
variables in the command bar and 
the Prompt History window. 

  

 

Leader DIMLEADER  Creates a leader with or without text. 

 

Quick 
Leader 

QLEADER  Draws leaders. Lets you specify the 
properties of the leader through a 
dialog box and reuse them for a 
series of leaders. 

 

Associative Dimensions 

Dimensions created in BricsCAD are associative: if the dimensioned entity is moved or modified, 

the dimensions will update automatically. The associative property of dimensions also applies to 
dimensions which are placed in paperspace and are associated with model space entities. If 
necessary, you can use the DIMREGEN command to update all associative dimensions. 

 

  

The following Entity Snaps can be used to create associative dimensions: 

endpoint, midpoint, center, perpendicular, quadrant, insertion, point, intersection and apparent 
intersection. 

Dimension Styles Explorer 

Command: DIMSTYLE 

A dimension style is a collection of settings and definitions which determine the type of 
arrowheads, text style, color of text, lines and arrowheads, unit type, precision, etc.  Dimension 

styles are saved in the drawing. You can create, edit and delete dimension styles. Dimension styles 
can be copied between drawings. Dimension styles which have the Annotative property create 
annotative dimensions. 

bricscad-cmdref.chm::/Dimension/DimStyle/-DimStyle.htm
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NOTES • You cannot delete the current dimension style. 

• You cannot delete a dimension style that is used in the drawing. 

• Each drawing contains at least one dimension style. 

Exploring dimension styles 

1. To open the Dimension Styles Explorer, do one of the following: 

• Choose Dimension Styles ... in the Tools > Drawing Explorer menu. 

• Double click the Dimension Style field in the Status bar. 

• Right click the Dimension Style field in the Status bar, then choose Properties in the 
context menu. 

• Type dimstyle in the command bar, then press Enter. 

 

The current dimension style is marked in the Current column. 

2. (option) Select a dimension style to see a preview. 

3. (option) Select a dimension style then right click: 

• Choose New to create a new dimension style. 

• Choose Delete to delete the selected dimension style. 

• Choose Cut selected dimension style in the current drawing, then paste it in another 
open drawing. 

• Choose Copy, then paste it in another open drawing. 

• Choose Paste, to copy a previously cut or copied dimension style in the current drawing. 

• Choose Rename, to rename of the selected dimension style. 

• Choose Set current in the context menu to make it the current dimension style. 

• Choose Save overrides to current style, to save all current overrides to the current 
style. 

• Choose Save to new style, to create a new dimension style as a copy of the selected 
dimension style. 

4. (option) Modify a dimension style definition. 
5. (option) Select <overrides> to define override settings for the current dimension style. 
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Comparing Dimstyles 

1. Open the Drawing Explorer > Dimension Styles dialog. 

2. Select 2 or more dimension styles. 
Press and hold the Ctrl-key to add more dimension style to the selection set. 

The properties of the selected styles display in the Editor pane. Properties that are different 
in one of the selected styles display on a yellow background. 
 

 

3. Check the Show only differences option to display the properties that are different for at 
least one of the selected dimension styles only. 
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Exploring Dimension Styles 

1. To open the Dimension Styles Explorer, do one of the following:  

• Choose Dimension Styles ... in the Tools > Drawing Explorer menu.  

• Double click the Dimension Style field in the Status bar.  

• Right click the Dimension Style field in the Status bar, then choose Properties in the 
context menu.  

• Type dimstyle in the command bar, then press Enter.  

 

The current dimension style is marked in the Current column. 

2. (option) Select a dimension style to see a preview.  
3. (option) Select a dimension style then right click:  

• Choose New to create a new dimension style.  

• Choose Delete to delete the selected dimension style.  

• Choose Cut selected dimension style in the current drawing, then paste it in another 
open drawing.  

• Choose Copy, then paste it in another open drawing.  

• Choose Paste, to copy a previously cut or copied dimension style in the current drawing.  

• Choose Rename, to rename of the selected dimension style.  

• Choose Set current in the context menu to make it the current dimension style.  

• Choose Save overrides to current style, to save all current overrides to the current 
style.  

• Choose Save to new style, to create a new dimension style as a copy of the selected 
dimension style.  

4. (option) Modify a dimension style definition.  
5. (option) Select <overrides> to define override settings for the current dimension style.  
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Dimension Settings 

A dimension style consists of six settings groups 

• Lines and Arrows 

• Text 

• Fit 

• Primary Units 

• Alternate Units 

• Tolerances 

To list the current status of the dimension variables 

1. Do one of the following:  

• Click the Dimension Variable Status tool  button ( ) on the Dimensions toolbar.  

• Choose Dimension Variable Status in the Dimensions menu.  

A list of all dimension variables displays in the command bar.  

2. Press the F2 function key to open the BricsCAD Prompt History window.  
3. Press Enter to continue the listing.  
4. Press the F2 function key to close the BricsCAD Prompt History window. 

Dimension Styles 

In the Dimension Styles explorer you can: 

• Create a new dimension style 

• Edit a dimension style 

• Define dimension style overrides 

• Rename a dimension style 

• Set a dimension style current 

• Copy dimension styles between drawings 

• Move dimension styles between drawings 

• Delete a dimension style 

To Create a New Dimension Style 

1. Open the Dimension Styles explorer dialog.  
2. Do one of  the following:  

• Click the New button ( ).  

• Place the cursor on the dimension style list, then right click and choose New in the 
context menu.  

A New Dimension Style is added. 

3. Select the Name field and type a name for the new dimension style.  
4. Define the settings for the new dimension style.  
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NOTE • The New tool creates a new dimension style as a copy of the current dimension 
style. 

• Use the Save to new style option of the context menu to create a new dimension 
style as a copy of the selected dimension style. 

• Use the Save overrides to current style option of the context menu to create a 
new dimension style from the current override settings. This option is available if 
you select <overrides> only. 

• Alternatively you can use the Save Style tool to create a new dimension style. 

To create a dimension child style 

For each dimension style you can create a child style for each dimension type: Linear, Angular, 
Radius, Diameter, Ordinate and Leader.  

If the current dimension style has a child style for a dimension type, the child style will be used 
automatically when such dimension type is created. 

1. Select the parent dimension style, then right click and choose a child style in the context 
menu. 
 

 
 

The name of the child style is: <parent_style>:<child_style> 

2. Select the child style and define the properties that need to be different from the parent 
style. 

To Edit a Dimension Style 

1. Open the Dimension Styles explorer dialog in Tree view mode ( ).  
2. Expand the dimension style.  
3. Adjust the dimension settings.  
4. Close the Dimension Styles explorer dialog.  

To Define Dimension Style Overrides 

1. Open the Dimension Styles explorer dialog in Tree view mode ( ).  
2. Select <overrides>.  
3. Define the dimension override settings.  
4. Close the Dimension Styles explorer dialog.  

  

NOTES • It is not recommended to create dimensions with overrides. 

• Use the dimension override settings to test changes, without modifying the 
current dimension style definition, then use the Save overrides to current style 
or Save to new style option. 

• Setting another style current will discard the existing dimension style overrides. 
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To Rename a Dimension Style 

1. Open the Dimension Styles explorer dialog.  
2. Select the dimension style you want to rename.  
3. Right click, then choose Rename in the context menu.  
4. Type a new name in the Name field, then press enter.  

To Set a Dimension Style Current 

1. Open the Dimension Styles explorer dialog. 
The current dimension style is marked in Tree view and Detail view mode.  

2. Select the dimension style.  
3. Right click and choose Set current in the context menu. 

In Tree view and Detail view mode a mark indicates the selected dimension style is made 

current.  

  

NOTE If dimension style overrides are defined when making another dimension style current, an 
alert box opens saying that setting another style current will discard the existing 
dimension style overrides. 

Using the Status Bar to Set a Dimension Style Current 

1. Place the cursor on the Dimension style field in the Status bar.  
2. Right click. 

A list of available dimension styles displays in the context menu. 
The current dimension style is checked. 

 
3. Select the new current dimension style. 

The selected dimension style name displays in the Dimension style field of the Status bar.  

  

NOTE Alternatively you can use the Restore Style tool to make a dimension style current. 

 

To Copy Dimension Styles Between Drawings 

1. Open the Dimension Styles explorer dialog.  
2. In the source drawing, select the dimension style you want to copy.  
3. Do one of the following:  

• Click the Copy button ( ).  

• Right click, then choose Copy in the context menu.  

4. In the Open Drawings section, expand the target drawing.  
5. Select Dimension Styles in the target drawing. 

The list of the dimension styles in the target drawing displays in the Details section.  
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6. Do one of the following:  

• Click the Paste button ( )  

• Place the cursor on one of the existing dimension style names, then right click and 
choose Paste in the context menu.   

NOTE 
To select multiple dimension styles, choose Detail view ( ) or Icon view ( ) in the 
Drawing Explorer dialog. 

 

To Move a Dimension Style Between Drawings 

1. Open the Dimension Styles explorer dialog.  
2. In the source drawing, select the dimension style you want to move.  

3. Do one of the following:  

• Click the Cut button ( ).  

• Right click, then choose Cut in the context menu.  

4. In the Open Drawings section, expand the target drawing.  
5. Select Dimension Styles in the target drawing. 

The list of the dimension styles in the target drawing displays in the Details section.  
6. Do one of the following:  

• Click the Paste button ( )  

• Place the cursor on one of the existing dimension style names, then right click and 
choose Paste in the context menu.  

  

NOTE • You cannot cut the current dimension style. 

• You cannot cut a dimension style that is used in the drawing. 

• To select multiple dimension styles, choose Detail view ( ) or Icon view ( ) in 
the Drawing Explorer dialog. 

 

To Delete a Dimension Style 

1. Open the Dimension Styles explorer dialog.  
2. Select the dimension style you want to delete.  
3. Do one of the following:  

• Click the Delete button ( ).  

• Right click, then choose Delete in the context menu.  

The selected dimension style is deleted. 
  

NOTE • You cannot delete the current dimension style. 

• You cannot delete a dimension style that is used in the drawing. 

• To select multiple dimension styles, choose Detail view ( ) or Icon view ( ) in 
the Drawing Explorer dialog. 
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Dimension Style Tools 

Command: -DIMSTYLE 

Using the dimension style tools you can: 

• Apply the current dimension style to a selection of dimension entities. 

• Create a new dimension style. 

• Restore a dimension style. 

• List the current status of the dimension settings. 

To apply the current dimension style 

1. Do one of the following: 

• Click the Apply Style tool button ( ) on the Dimensions toolbar. 

• Choose Apply Style in the Dimensions menu. 

• Type -dimstyle in the command window, press Enter then type A or apply and press 
Enter. 

You are prompted: Select dimensions to apply the current style. 

2. Select the dimensions, then press Enter. 

  

NOTE Since the dimension style settings only apply to dimension entities, you can select all 

entities in step 2 to apply the current dimension style to all dimensions in the drawing. 

Creating Linear Dimensions 

Commands: DIMLINEAR, DIMALIGNED, DIMBASELINE, DIMCONTINUE, and DIMARC 

Linear dimensions annotate linear distances or lengths and can be oriented either horizontally, 
vertically or aligned parallel to an existing entity or to the selected origin points.  

Starting from a linear dimension, you can add a baseline dimension or a continued dimension.  

• A baseline dimension inserts an additional dimension from a common first extension line 
origin of a previous linear dimension.  

• A continued dimension continues a linear dimension from the second extension line of a 
previous linear dimension. 

To Create a Horizontal or Vertical Linear Dimension 

1. Do one of the following:  

• Click the Linear tool button ( ) on the Dimensions toolbar.  

• Choose Linear in the Dimensions menu.  

• Type dimlinear in the command bar, then press Enter.  

You are prompted: ENTER to select entity/<Origin of first extension line>: 

2. Do one of the following:  

• Press Enter, then select the line or linear segment of a polyline you want to dimension.  

• Specify the origin of the first extension line, then specify the origin of the second 
extension line.  

The dimension line displays dynamically. 

Move the cross hairs vertically to create a horizontal dimension, or horizontally to create a vertical 

dimension. 

3. Position the dimension line.  
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To Create an Aligned Linear Dimension 

1. Do one of the following:  

• Click the Aligned tool button ( ) on the Dimensions toolbar.  

• Choose Aligned in the Dimensions menu.  

• Type dimaligned in the command bar, then press Enter.  

You are prompted: ENTER to select entity/<Origin of first extension line>: 

2. Do one of the following:  

• Press Enter, then select the line or linear segment of a polyline you want to dimension.  

• Specify the origin of the first extension line, then specify the origin of the second 
extension line.  

3. Do one of the following:  

• Click a point to position the dimension line.  

• Press 0 (zero) to place the dimension line at the dimension points, thus omitting the 
extension lines.  

  

To Create a Rotated Linear Dimension 

1. Do one of the following:  

• Click the Rotated tool button ( ) on the Dimensions toolbar.  

• Choose Rotated in the Dimensions menu.  

You are prompted: ENTER to select entity/<Origin of first extension line>: 

2. Do one of the following:  

• Press Enter, then select the line or linear segment of a polyline you want to dimension.  

• Specify the origin of the first extension line, then specify the origin of the second 
extension line.  

You are prompted: Angle of dimension line <0>: 

3. Do one of the following:  

• Type the rotation angle in the command bar, then press Enter.  

• Enter the rotation angle by specifying two points.  

The dimension line displays dynamically. 
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4. Position the dimension line.  

You can place the dimension line either at the specified rotation angle or perpendicular to this 
direction.  

To Create Baseline Dimensions 

1. Do one of the following:  

• Click the Baseline tool button ( ) on the Dimensions toolbar.  

• Choose Baseline in the Dimensions menu.  

• Type dimbaseline in the command bar, then press Enter.  

You are prompted: Baseline: ENTER to select starting dimension/<Origin of next extension line>: 

A baseline dimension displays dynamically starting from the most recently added linear or angular 
dimension (if any). 

2. (option) Press enter, then select the starting dimension (see note below).  
3. Specify the origin of the next extension line.  

You are prompted: Baseline: ENTER to select starting dimension/<Origin of next extension line>: 

4. Do one of the following:  

• Repeat steps 2 and 3.  

• Press the Esc key to stop creating baseline dimensions.  

  

NOTES • When selecting the starting dimension make sure to click the first extension line or 
the first half of the dimension line in order to use the first origin point of the 

starting dimension as the origin point for the baseline dimension. 

• If you select an angular dimension, stacked angular dimensions are created. 

• The distance between the stacked dimension lines is controlled by the Dim baseline 
spacing setting in the dimension style. 

 

To Create Continued Dimensions 

1. Do one of the following:  

• Click the Continue tool button ( ) on the Dimensions toolbar.  

• Choose Continue in the Dimensions menu.  

• Type dimcontinue in the command bar, then press Enter.  

You are prompted: Continue: ENTER to select starting dimension/<Origin of next extension line>: 

A continued dimension displays dynamically starting from the most recently added linear or 
angular dimension (if any). 

2. (option) Press enter, then select the starting dimension (see note below).  
3. Specify the origin of the next extension line.  

You are prompted: Continue: ENTER to select starting dimension/<Origin of next extension line>: 

4. Do one of the following:  

• Repeat steps 2 and 3.  

• Press the Esc key to stop creating continued dimensions.  
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NOTE • When selecting the starting dimension make sure to click the second extension line 
or the second half of the dimension line in order to use the second origin point of the 
starting dimension as the origin point for the continued dimension. Otherwise the 
new dimension line will partly overlap the starting dimension. 

• If you select an angular dimension, continued angular dimensions are created. 

 

To Create an Arc Length Dimension 

1. Do one of the following:  

• Click the Arc tool button ( ) on the Dimensions toolbar.  

• Choose Arc in the Dimensions menu.  

• Type dimarc in the command bar, then press Enter.  

You are prompted: Select arc or polyline arc segment: 

2. Select the arc or polyline arc segment. 
The arc length dimension displays dynamically.  

3. Position the dimension line. 

Creating Angular Dimensions 

Angular dimensions annotate the angle measured between two lines,  two linear segments of a 
polyline or the angle of a circular arc. You can also dimension an angle by selecting an angle vertex 

and two endpoints.  

Starting from an existing angular dimension, you can add a baseline dimension or a continued 
dimension. An angular baseline dimension inserts an additional dimension from a common first 
extension line origin. An angular continued dimension continues an angular dimension from the 

second extension line of a previous angular dimension. 

  

 

 

 

angular dimension 

measured between two 
lines 

angular 

dimension of 
an arc 

angular dimension 

defined by a 
vertex and two 
endpoints  
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angular baseline dimensions angular continued dimensions 

 

To Dimension an Angle Between Two Lines 

1. Do one of the following  

• Click the Angular tool button ( ) on the Dimensions toolbar.  

• Choose Angular in the Dimensions menu.  

• Type dimangular in  the command bar, then press Enter.  

You are prompted: Press Enter to specify angle/<select line, arc, or circle>: 

2. Select the first line or line segment. 
You are prompted: Other line for angular dimension:  

3. Select the second line or line segment. 
The angular dimension displays dynamically. 
You are prompted: Angle/Text/<Location of dimension arc>:  

4. Do one of the following:  

• Position the dimension arc.  

• Type A and press Enter to define the angle of the dimension text, then position the 
dimension arc.  

• Type T and press Enter to modify the dimension text, then position the dimension arc.  

To Dimension an Angle Encompassed by an Arc 

1. Do one of the following  

• Click the Angular tool button ( ) on the Dimensions toolbar.  

• Choose Angular in the Dimensions menu.  

• Type dimangular in  the command bar, then press Enter.  

You are prompted: Press Enter to specify angle/<select line, arc, or circle>: 

2. Select the arc. 
The angular dimension displays dynamically. 
You are prompted: Angle/Text/<Location of dimension arc>:  

3. Do one of the following:  

• Position the dimension arc.  

• Type A and press Enter to define the angle of the dimension text, then position the 
dimension arc.  

• Type T and press Enter to modify the dimension text, then position the dimension arc.  
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Creating an angular dimension defined by a vertex and two endpoints 

1. Do one of the following  

• Click the Angular tool button ( ) on the Dimensions toolbar.  

• Choose Angular in the Dimensions menu.  

• Type dimangular in  the command bar, then press Enter.  

You are prompted: Press Enter to specify angle/<select line, arc, or circle>: 

2. Right click or press Enter. 
You are prompted: Vertex of angle.  

3. Specify the vertex of the angle. 
You are prompted: first side of angle.  

4. Specify the endpoint of the first side of the angle. 

You are prompted: Other side of angle.  
5. Specify the endpoint of the second side of the angle. 

The angular dimension displays dynamically. 
You are prompted: Angle/Text/<Location of dimension arc>:  

6. Do one of the following:  

• Position the dimension arc.  

• Type A and press Enter to define the angle of the dimension text, then position the 
dimension arc.  

• Type T and press Enter to modify the dimension text, then position the dimension arc. 

Creating Diametrical and Radial Dimensions 

Diametrical and radial dimensions annotate the radii and diameters of circles and circular arcs.  

The DIMCENTER command creates center marks in the center point of circles and circular arcs. 

To Create a Diametrical Dimension 

1. Do one of the following  

• Click the Diameter tool button ( ) on Circles toolbar or the Circles flyout of the 
Dimensions toolbar.  

• Choose Diameter in the Dimensions menu.  

• Type dimdiameter in  the command bar, then press Enter.  

You are prompted: Select arc or circle 

2. Select the arc or circle you want to annotate. 
The diametrical dimension displays dynamically.  

3. Position the dimension line.  

To Create a Radial Dimension 

1. Do one of the following  

• Click the Radius tool button ( ) on Circles toolbar or the Circles flyout of the 
Dimensions toolbar.  

• Choose Radius in the Dimensions menu.  

• Type dimradius in  the command bar, then press Enter.  

You are prompted: Select arc or circle 

2. Select the arc or circle you want to annotate. 

The radial dimension displays dynamically.  
3. Position the dimension line.  

bricscad-cmdref.chm::/Dimension/DimCenter.htm
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Creating Center Marks and Center Lines 

1. Do one of the following  

• Click the Center tool button ( ) on Circles toolbar or the Circles flyout of the 
Dimensions toolbar.  

• Choose Center in the Dimensions menu.  

• Type dimcenter in  the command bar, then press Enter.  

You are prompted: Select arc or circle to dimension: 

2. Select the arc or circle. 
The center marks are created.  

  

NOTE • The Center mark setting of the dimension style controls whether center marks or 
center lines are created.  
The Center mark size settings of the dimension style controls the size of the 
center mark. 

• The center mark settings are saved to the DIMCEN system variable. 

 

Centerlines and Center Marks 

Commands: CENTERLINE, CENTERMARK, CENTERREASSOCIATE, CENTERDISASSOCIATE, 

CENTERRESET 

  

CenterLine command: creates a centerline entity associated with two selected lines. 

CenterMark command: creates a center mark entity associated with a selected circle or arc. 

CenterReassociate command: recreates the association between a centerline entity and two 
selected lines, or between a center mark and a selected circle or arc. 

CenterDisassociate command: breaks the association of centerline and a center mark entities. 

CenteReset command: resets centerline and center mark entities. 

  

Centerlines and Center Marks are drawing reference entities to indicate axes of symmetry and to 
centers of circular openings. Centerlines and Center Marks are associative entities: when the 
referenced lines, circles or circular arcs are modified they are adjusted automatically.  

 

1. Centerline 

2. Center Mark 
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System variables for center entities 

The properties and geometry of centerline and center mark entities are controlled through system 
variables. 

  

 

  

Name Title Description 

CENTERCROSSGAP 
Center 
mark cross 
gap 

Defines the gap between the center mark and its 
centerlines. 

 

Type centercrossgap in the command line; prompts you: 

New value for CENTERCROSSGAP, or . for none/<"0.05x">: 

• Type a value to specify the absolute size of the gap in 
drawing units. 

• Type a value followed by x to set the size of the gap 
relative to the diameter of the circle or circular arc. 
The default value 0.05x creates a gap of 5/100 of the 
diameter. 

• . (dot) creates no gap. 

CENTERCROSSSIZE 
Center 
mark cross 

size 

Defines the size of the associative center mark. 

Type centercrosssize in the command line; prompts you: 

New value for CENTERCROSSSIZE, or . for none/<"0.1x">: 

• Type a value to specify the absolute size of the center 
mark lines in drawing units. 

• Type a value followed by x to set the size of the center 
mark relative to the diameter of the circle or circular 
arc. 

The default value 0.1x creates center marks 1/10th of 
the diameter. 

• . (dot) creates center marks with zero length lines. 

CENTEREXE 

Centerline 

extensions 
length 

Defines the length of the centerline extensions. The value is 
expressed in drawing units. 
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CENTERLAYER 

Default 

layer for 
center 
mark or 
centerline 

Specifies the default layer for new centerlines and center 
marks. 

Type centerlayer in the command line; prompts you: 

New value for CENTERLAYER, or . for none/<"">: 

• Type a name. If such layer not yet exists, the layer will 
be created when a centerline or centemark is created. 

• Type . (dot) to create centerlines and center marks on 
the current layer. 

CENTERLTYPEFILE 

Linetype 
file for 

center 
mark or 
centerline 

Specifies the linetype file used to create centerlines and 
center marks. 

Default in imperial unit drawings: default.lin 

Default in metric unit drawings: iso.lin 

CENTERLTYPE  

Linetype 
for center 
mark or 
centerline 

Specifies the linetype for newly created centerlines and 
center marks. 

Type centerltype in the command line; prompts you: 

New value for CENTERLTYPE, or . for none/<"CENTER2">: 

• Type a new linetype name or press Enter to accept the 
current name. 

• Type . (dot) for continuous lines. 

CENTERLTSCALE  

Linetype 
scale for 
center 
mark or 

centerline 

Specifies the linetype scale for newly created centerlines and 
center marks. 

Type  

CENTERMARKEXE 

Automatic 

extension 
for center 
mark or 
centerline 

Determines whether centerlines extend (left) or not (right) 
from new center marks. 
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Ordinate Dimensions 

Command: DIMORDINATE 

An ordinate dimension annotates the perpendicular distance from an origin or base point (the 
origin of the current user coordinate system [UCS]). Ordinate dimensions consist of an x- or y-
coordinate and a leader. An x-ordinate dimension measures distances along the x-axis, while a y-

ordinate dimension measures distances along the y-axis. 

As you select ordinate points, the program automatically determines whether the point is an x- or 
y-ordinate based on which direction you drag the second point. You can also specify whether the 
ordinate represents an x- or y-ordinate. Ordinate dimension text is always aligned with the 
ordinate leader lines, regardless of the text orientation specified by the current dimension style. 

To create an ordinate dimension 

1. Do one of the following: 

• Click the Ordinate tool button ( ) on the Dimensions toolbar. 

• Choose Ordinate in the Dimensions menu. 

• Type dimordinate in the command bar, then press Enter. 

You are prompted: Select point for ordinate dimension: 

2. Specify the origin point for the ordinate dimension. 
The ordinate dimension displays dynamically. 

3. Position the ordinate dimension. 

  

NOTE Adjust the origin point of the current user coordinate system (UCS) before placing 

ordinate dimensions if necessary. 

 

Leaders and Annotations 

A leader consists of an arrowhead, a line, polyline or a spline and an annotation.  

The general procedure to place an annotation is: 

• Specify the position of the arrowhead. 

• Create the leader line segments. 

• Type the annotation text. 

To Create a Leader and an Annotation 

1. Do one of the following:  

• Click the Leader tool button ( ) on the Dimensions toolbar.  

• Choose Leader in the Dimensions menu.  

• Type leader or dimleader in the command bar, then press Enter.  

You are prompted: Start of leader 

2. Specify the position of the arrowhead. 
You are prompted: Next point.  

3. Specify the endpoint of the first leader segment. 
You are prompted: To point: Format/Undo/<Annotation>: 
A prompt menu displays: 
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4. Add more segments to the leader, then press Enter or right click to stop adding segments. 

You are prompted: First line of annotation text/<options>:  
5. Do one of the following:  

• Type the first line of the annotation text, then press Enter. 
You are prompted: Next line of annotation text: 

Do one of the following:  

• Press Enter or right click to create the leader and annotation.  

• Keep adding lines to the annotation text, then press Enter or right click to 
create the leader and annotation.  

• Press Enter or right click to see the annotation text options. 
You are prompted: Dimension text options: 
Block/Copy/None/Tolerance/<Mtext>: 
A prompt menu displays: 
 

 
• Press the Esc key to abort the Leader tool.  

To Create a Leader only 

1. Do one of the following:  

• Click the Leader tool button ( ) on the Dimensions toolbar.  

• Choose Leader in the Dimensions menu.  

• Type dimleader in the command bar, then press Enter.  

You are prompted: Start of leader 

2. Specify the position of the arrowhead. 
You are prompted: Next point.  

3. Specify the endpoint of the first leader segment. 

You are prompted: To point: Format/Undo/<Annotation>:  
4. Add more segments to the leader, then press Enter or right click to stop adding segments. 

You are prompted: First line of annotation text/<options>:  
5. Press Enter, then choose None in the prompt menu or type N. 
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Multileaders 

Commands: MLEADER, MLEADERSTYLE, MLEADEREDIT and MLEADEREDITEXT 

  

A multileader consists of:  

• an arrowhead (1)  

• one or more leader lines (2), which can be straight or curved 

• optionally a horizontal landing (3) and landing gap (4) 

• content: either a multiline text (5) or a block (6) 

 
Multileaders are created using the current multileader style. Each drawing contains a Default 
leader style, which cannot be renamed or deleted; the Default leader style can be customized 
though. The MLeader command allows to define overrides on the current multileader style. 

Multileaders can  be created arrowhead first, landing first or content first. 

  

 

  

To create a multileader 

1. (option) Launch the MLeaderStyle command, then make a multileader style current. 
2. Do one of the following 

• Click the Multileader tool button ( ) on the Dimensions toolbar. 

• Choose Multileader in the Dimensions menu. 

• Type multileader in the command bar, then press Enter. 
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You are prompted: Specify leader arrowhead location or [leader Landing first/Content 

first/Options] <Options>: 

A prompt menu displays: 

 

3. (option) Select a placement option:  

• arrowhead first 

• landing first  

• content first. 

The most recently used placement option is repeated. 

The default sequence is: arrowhead - landing - content. 

4. (option) Choose Options in the prompt menu or type O, then press Enter, if you want to 
define overrides on the current multileader style. 

You are prompted: Enter an option [Leader type/leader lAnding/Content type/Maxpoints/First 

angle/Second angle/eXit options] <eXit options>: 
A prompt menu displays: 

 

5. Specify a point to define the leader arrowhead location. 
You are prompted: Specify leader landing location:  

6. Specify a point to define the leader landing location. 

Depending on the content type: 

• MText: The MText command is launched. 

• Block: A block is inserted. 

• None: The command is concluded. 

bricscad-cmdref.chm::/M/MText/MText.htm


BricsCAD V18  Help 

 

 403 

Adding vertices to a leader line of a multileader 

1. If necessary press the F12 function key to activate the Quad cursor menu. 
2. Pause the cursor over the leader line you want to add a vertex to. 

The Quad cursor menu displays, showing the most recently used command (*). 
3. Move the cursor to the Quad cursor menu and expand the 2D Editing command group. 

4. Click the Add Vertex tool ( ). 
A new vertex is added dynamically. 

5. Specify the position of the vertex. 
6. (option) Pause the cursor of a leader line, then right click to add another vertex. 

(*) Right click to repeat the most recently used Quad command.  

Removing vertices from a leader line of a multileader 

1. If necessary press the F12 function key to activate the Quad cursor menu. 
2. Pause the cursor over the leader line close to the vertex to be removed. 

The Quad cursor menu displays, showing the most recently used command (*). 
3. Move the cursor to the Quad cursor menu and expand the 2D Editing command group. 

4. Click the Remove Vertex tool ( ). 
The vertex is removed. 

5. (option) Pause the cursor of a leader line close to a vertex, then right click to remove the 
vertex. 

Adding leader lines to a multileader 

1. If necessary press the F12 function key to activate the Quad cursor menu. 
2. Pause the cursor over a leader line of the multileader entity. 

The Quad cursor menu displays, showing the most recently used command (*). 

3. Move the cursor to the Quad cursor menu and expand the 2D Editing command group. 

4. Click the Add Leader tool ( ). 
A new leader line displays dynamically. 

5. Specify the origin of the new leader line. 
Another new leader line displays dynamically. 

4. Do one of the following: 

• Specify the origin of the new leader line. 

• Right click or press Enter to stop adding leader lines. 

(*) Right click to repeat the most recently used Quad command.  

Removing leader lines from a multileader 

1. If necessary press the F12 function key to activate the Quad cursor menu. 
2. Pause the cursor over the leader line you want to remove. 

The Quad cursor menu displays, showing the most recently used command (*). 
3. Move the cursor to the Quad cursor menu and expand the 2D Editing command group. 

4. Click the Remove Leader tool ( ). 
The leader line is removed. 

(*) Right click to repeat the most recently used Quad command. 
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Editing dimensions 

Commands:  

DIMEDIT: Changes the wording and angle of dimension text; changes the angle of extension lines. 

DIMTEDIT: Changes the position of dimension text. 

  

Dimension entities can be edited in the following ways: 

• use grips to edit dimensions 

• edit the dimension text 

• rotate dimension text  

• reposition the dimension text 

• restore the text position 

• make the extension lines oblique 

Using Grips to Edit a Linear Dimension 

1. Select the dimension entity.  

 5 grips display: 

• 2 origin point grips (1)  

• 2 dimension line grips (2)  

• 1 dimension text grip (3)  

 

2. (option) Drag the origin point grips to adjust the dimension origin points. 
The dimension text is adjusted automatically.  

3. (option) Drag dimension line grips to move the dimension line.  

4. (option) Drag the text grip to move the dimension text.  

  

NOTES • Depending on the Text movement setting, the dimension line will move along 

with the text or the text will move independently. A leader will be drawn if the 
Text movement setting is set to  Move text, add leader. 

• If two adjacent dimensions (continued dimensions) are selected both, you can 
move their coinciding grips simultaneously. 

  

Editing the Dimension Text 

Dimension text can be edited: 

• in the MText editor: 

o using the DDEDIT command 

o double clicking the dimension entity 

• in the Text override field in the Properties Bar. 

• using the Edit Dimension Text tool. 
  

bricscad-cmdref.chm::/Dimension/DimEdit.htm
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NOTES The following tags can be used to format the dimension text: 

• type \L (backslash upper case L) to start underlined text, \l (backslash lower 
case L) to stop underlined text 

• type <> to add the default dimension text 

• type [] to add the alternate units, if alternate units is currently switched off in 
the dimension style. 

• type %%d to add the degree symbol (°) 

• type %%c to add the diameter symbol ( ) 

• type %%p to add the plus/minus symbol ( ) 
e.g. if you type %%c\L<> cm in the Text override field, dimension text displays as: 

24,43 cm 

To edit the dimension text in the MText editor 

1. Double click the dimension entity. 
The Text Formatting toolbar displays.  

2. Edit the dimension text.  
3. Do one of the following:  

• Click the OK button on the Text Formatting toolbar.  

• Click outside the dimension text.  

To edit the dimension text in the Properties Bar 

1. Select the dimension entity.  
2. In the Properties Bar, select the Text override field.  

3. Type the new dimension text in the Text override field and press Enter.  

4. Press the Esc key to stop editing the dimension entity.  

To edit the dimension text using the Edit Dimension Text tool 

1. Do one of the following:  

• Click the Edit Dimension Text tool ( ) in the Dimensions toolbar.  

• Choose Edit Dimension Text in the Dimensions menu.  

• Type dimedit in the command bar, press Enter, then type new and press Enter.  

You are prompted: New dimension text <>: 

2. Type the new dimension text and press Enter. 

You are prompted: Select dimensions to replace with new text:  
3. Select the dimensions and press Enter.  

To Rotate the Dimension Text 

1. Do one of the following:  

• Click the Rotate Dimension Text tool ( ) in the Dimensions toolbar.  

• Choose Rotate Dimension Text in the Dimensions menu.  

• Type dimedit in the command bar, press Enter, then type R and press Enter.  

You are prompted: Angle of dimension text: 

2. Type the rotation angle, then press Enter. 

You are prompted: Select entities to rotate text:  
3. Select the dimensions and press enter.  

file:///D:/BricsCAD%20Training/manuals/01_User_Interface/00_06_Properties_Bar.htm
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To Reposition the Dimension Text 

1. Do one of the following:  

• Click the Reposition Dimension Text tool ( ) in the Dimensions toolbar.  

• Choose Reposition Dimension Text in the Dimensions menu.  

• Type dimtedit in the command bar, then press Enter.  

You are prompted: Select dimensions to reposition text: 

2. Select the dimension. 
The dimension text moves dynamically.  

3. Click to reposition the dimension text.  

To Restore the Text Position 

1. Do one of the following:  

• Click the Restore Text Position tool ( ) in the Dimensions toolbar.  

• Choose Restore Text Position in the Dimensions menu.  

• Type dimedit in the command bar, then press Enter.  

You are prompted: Select dimensions to restore text to default position: 

2. Select the dimensions and press enter.  

To Make the Extension Lines Oblique 

1. Do one of the following:  

• Click the Make Oblique tool ( ) in the Dimensions toolbar.  

• Choose Make Oblique in the Dimensions menu.  

• Type dimedit in the command bar, press Enter, then type O and press Enter.  

You are prompted: Select dimensions to make oblique: 

2. Select the dimensions and press enter. 
You are prompted: Enter obliquing angle:  

3. Type the obliquing angle, then press Enter.  

  

NOTE To restore non-rotated extension lines, execute the above procedure and type 0 (zero) 
when asked to enter the obliquing angle. 
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Geometric Tolerances 

Geometric tolerances specify the maximum variation that is allowed in form or position from true 
geometry.   The geometric tolerance is, in essence, the tolerance zone within which a surface or 
axis of hole or cylinder can lie which results in resulting feature being acceptable for proper 

function and interchangeability. 

BricsCAD draws geometric tolerances using a feature control frame, which is a rectangle divided 
into compartments. 

Each feature control frame consists of at least two compartments. The first compartment contains 
a geometric tolerance symbol that indicates the geometric characteristic to which the tolerance is 
applied, such as location, orientation, or form. For example, a form tolerance may indicate the 

flatness or roundness of a surface.  

The second compartment contains the tolerance value. When appropriate, the tolerance value is 
preceded by a diameter symbol and followed by a material condition symbol. The material 

conditions apply to features that can vary in size.  

The tolerance value can then be followed by primary, secondary, and tertiary datum reference 
letters, along with the material conditions of each datum. Datum reference letters are generally 
used as reference tolerances to one of up to three perpendicular planes from which a measurement 

is made, although datum reference letters can also indicate an exact point or axis. 

Geometric Tolerance Symbols 

When two tolerances apply to the same geometry, you can also add a composite tolerance 
consisting of a primary tolerance value followed by a secondary tolerance value. To make a 
tolerance even more specific, it can also contain a projected tolerance consisting of a height value 
followed by a projected tolerance symbol. For example, you can use a projected tolerance to 

indicate the perpendicularity of an embedded part. 

Geometric Tolerance Dialog 

1. Geometric Tolerance Symbol buttons. 
Click to open the Symbol palette. 

 
2. Diameter Symbol option buttons. 

Click to add the diameter symbol.  

3. Material Condition buttons. 

Click to open the Material Condition palette. 

 

To Create a Geometrical Tolerance Frame 

1. Do one of the following  

• Click the Tolerance tool button ( ) in the Dimensions toolbar.  

• Choose Tolerance in the Dimensions menu.  

• Type tolerance in the command bar, then press Enter.  

The Geometric Tolerance dialog opens. 
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2. Compose the geometrical tolerance frame in the Geometric Tolerance dialog.  

3. Click the OK button. 
The Geometric Tolerance dialog closes.  

4. Click to insert the geometric tolerance frame in the drawing.  
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Working with Text 

Text Variables 

System variables can be set using the Settings dialog. 

Some system variables which apply to text entities are: 

  

Variable 

Name 

Variabl

e Title 
Description 

FONTALT 
Alternat
e font 

Defines the font which will be used if a text font cannot be found. 

HIDETEXT 
Hide 
text on 

hide 

Specifies whether the HIDE command processes text entities. 

MIRRTEXT 
Mirror 

text 

Determines whether text is mirrored by the MIRROR command or 
not. 

MTEXTED 
Multiline 
text 
editor 

Sets the primary and secondary text editors to use for multiline text 

entities. 

MTEXTFIXED 
Multiline 

text 
fixed 

Controls whether BricsCAD zooms, rotates and/or pans the view to fit 
the Mtext being edited. 

QTEXTMODE 
Quick 
text 
mode 

Controls how text entities are displayed. If ON, displays text as a 

box. 

TEXTANGLE 
Text 

angle 
Stores the angle of the last added text entity. 

TEXTFILL Text fill 

Determines whether True Type fonts display either filled or outlined. 

 

TEXTQLTY 
Text 

quality 

Defines the smoothness of True Type fonts for plotting and 

rendering. 

TEXTSIZE Text size 
Sets the default height for new text entities. 

TEXTSIZE has no effect if the current text style has a fixed height 

TEXTSTYLE 
text 
style 

Stores the name of the current text style. 

TSPACEFAC 

Text 

space 
factor 

Specifies the line spacing distance of multiline text measured as 
factor of the text height.  

Values between 0.25 and 4 are accepted. 

TSPACETYPE 
Text 
space 
type 

Specifies the type of line spacing used for multiline text. At least: 
adjusts line spacing based on the tallest character(s) in a line. 
Exactly: used the specified line spacing, regardless of in individual 

character sizes. 

TSTACKALIG
N 

Text 

stack 
align 

Determines the vertical alignment of stacked text: bottom, center or 
top. 

TSTACKSIZE 
Text 

stack 
size 

Specifies the percentage a which the stacked text fraction height is 
relative to the current height of the selected text.  

Values between 25 and 125 are accepted. 
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Working With Text Styles 

When you add text to a drawing, it uses the current text style, which determines the font, size, 
angle, orientation and other properties of the new text entity.  

Every drawing has a default text style, named Standard, which initially uses the Arial font. You 
cannot delete or rename the Standard style, but you can modify it.  

If you change the font or orientation of an existing style, all existing text entities created using 
that style are automatically updated to reflect the change. Changing any other property has no 
effect on existing text.  

You can create and use an unlimited number of additional text styles. 

Annotative text styles create annotative text entities. In an annotative text style the Height defines 
the paper space height of the text; the model space height depends on the current annotation 
scale as defined by the CANNOSCALE and CANNOSCALEVALUE system variables. 

Open the Text Style Explorer Dialog 

Do one of the following: 

• In the Tools > Drawing Explorer menu choose Text Styles ...  

• Double click the Style field in the Status Bar.  

• Type style in the command bar and press Enter.  

The Drawing Explorer - Text Styles dialog opens. 

Create a Text Style 

1. Open the Text Style Explorer dialog.  

2. Do one of the following:  

• Click the New tool button ( ) in the Details section of the Drawing Explorer dialog.  

• Select an existing style, then right click and choose New in the context menu.  

A NewStyle text style is created, inheriting the properties of the currently selected style. 

3. Type a name in the Text Style Name field, replacing the NewStyle default name.  
4. Define the text style properties.  
5. Close the Text Style Explorer dialog.  

Edit a Text Style 

1. Open the text style explorer dialog.  

2. Select the text style.  
3. Define the text style properties.  
4. Close the Text Style Explorer dialog.  

Make a Text Style Current 

1. Open the text style explorer dialog.  
2. Do one of the following:  

• When in Detail view ( ), click the blank tile in front of the text style name. 
A blue filled circle indicates the text style is set current.  

• When in Detail view ( ) or Icon view ( ), right click then choose Set current in the 
context menu.  
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NOTE • Alternatively you can right click the Text style field in the Status Bar, then choose 
the new current style. The current style is marked in the style list. 

• When you use the Style option in the create text procedures, the selected style 
will become the current text style. 

 

Delete a Text Style 

1. Open the text style explorer dialog.  
2. Select the text style.  

3. Do one of the following:  

• Click the Delete tool button ( ) in the Details section of the Drawing Explorer dialog.  

• Right click, then choose Delete in the context menu.  

If the text style is not used in the drawing or in a dimension style, the text style is deleted, 
else an alert box displays: 
 

 
  

4. Do one of the following:  

• Click the Delete button to delete the text style and all entities using it.  

• Click the Change... button to delete the text style and assign a different text style to 
the entities, which currently use the selected style.  

• Click the Cancel button to cancel the delete procedure. 

  

NOTE It is not possible to delete the current text style. 
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Creating text 

The Text command creates single line text, while the Mtext command creates text entities which 
consist of multiple lines. 

To Create Single Line Text 

1. Do one of the following:  

• Click the Text tool button ( ) on the Draw toolbar.  

• Choose Text in the Text submenu in the Draw menu.  

• Type text in the command bar, then press Enter.  

You are prompted: Text: Style/Align/Fit/Center/Middle/Right/Justify/<Start point>: 

2. Specify the insertion point of the text. 

You are prompted: Height of text <current height>:  
3. Do one of the following:  

• Press Enter or right click to accept the current text height.  

• Type the new text height in the command bar, then press Enter.  

• Define the new text height graphically by specifying two points in the drawing.  

You are prompted: Rotation angle of text <current angle> 

4. Do one of the following:  

• Press Enter or right click to accept the current angle.  

• Type the new angle in the command bar, then press Enter.  

• Define the now angle graphically by specifying two points in the drawing.  

You are prompted: Text: 

5. Type the text in the command bar, then press Enter. 
The text is placed in the drawing. 
You are prompted: Text:  

6. Do one of the following:  

• Repeat step 5 to create another text entity. 
The new text is placed below the previous one.  

• Press Enter or right click to conclude the Text command.  

  

NOTE If you have already created text, the most recent text entity highlights when you repeat 

the Text command. If you want to place the new text right below the previously created 
text, press Enter in step 2 of the above procedure. 
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To Create Multiline Text 

1. Do one of the following:  

• Click the Multiline Text tool button ( ) on the Draw toolbar.  

• Choose Multiline Text in the Text submenu in the Draw menu.  

• Type mtext in the command bar, then press Enter.  

You are prompted: First corner for block of text: 

2. Specify the first corner (insertion point of the multiline text). 
You are prompted: Justification/Rotation/Style/Height/Direction/Width/<Opposite corner 

for block of text>: 
3. Do one of the following:  

• Specify the opposite corner of the text block to define the maximum width of the 
multiline text.  

• Type @ in the command bar, then press Enter for non-wrapped (zero width) text.  

• If Dynamic Dimensions are active, the height and width of the text field display 
dynamically. 
Type the height and width in the dynamic dimension fields. Press the TAB key to switch; 

press Enter to confirm.  

The Text formatting  toolbar opens right above the text block. 

 

 
  

4. (option) Define the text properties.  
5. Type your text.  
6. To conclude the command and close the Text formatting toolbar do one of the following:  

• Click the OK button.  

• Press Ctrl+Enter.  

• Click outside the MText entity.  
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Text formatting toolbar tools and settings 

Button or setting Name Description 

 

Text Style Sets the text style 

 

Text Font Sets the text font 

 

Text Height Sets the text height 

 

Bold Creates bold text 

 

Italic Creates italic text 

 

Underscore Creates underscored text 

 

Overscore Creates overscored text 

 

Uppercase Converts selected text to uppercase 

 

Lowercase Converts selected text to lowercase 

 

Annotative Toggles the Annotative property 

 

Line 
Spacing 

Sets the line spacing 

 

Columns Arranges the text in columns 

 

Color Sets the color 

 

Oblique 
Angle 

Sets the oblique angle 

 

Width 

Factor 

Sets the width factor 

 

Character 
Spacing 

Sets the character spacing 

 

Undo Undoes recent actions 

 

Redo Redoes previously undone actions 

 

Stacked 
Fraction 

Creates stacked fractions 

 

Special 
Character 

Inserts special characters 

 

Field Inserts a variable field 

 

Justify Sets the text justification 

 

Background 
Mask 

Adds a colored background 

 

Ruler Toggles the display of the ruler 

 

OK Closes the Text formatting toolbar and applies 
the changes 

 

Cancel Closes the Text formatting toolbar and leaves the 
Mtext entity unchanged 

  

NOTE If the line length exceeds the Width of the multiline text, the text will be wrapped. Set 

the Width to zero for non-wrapped multiline text. 
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Multiline Text Justification 

  

(The red dot indicates the insertion point of the multiline text entity) 

   

Top left Top center Top right 

   

Middle left Middle center Middle right 

   

Bottom left Bottom center Bottom right 

 

Special Characters and Symbols 

You can use control codes and unicode strings to include special characters in text entities.  

To include control codes, as you type text, type two percent symbols (%%) followed by the special 
control code or character. A single percent sign is treated as a normal text character. 

 

Special text characters 

Control 

code   

Unicode 

String 

Result 

%%d \U+00B0 Draws a degree 
symbol (º) 

%%p \U+00B1 Draws a plus-or-
minus symbol (±) 

%%c \U+2205 Draws a diameter 

symbol (Ø) 

 



  User Guide 

 416 

Symbols and Unicode strings 

Name Symbol 

(*) 

Unicode 

String 

Almost 
equal 

 

\U+2248  

Angle  

\U+2220  

Center 
line 

 

\U+2104 

Delta 
 

\U+0394 

Electrical 
phase  

\U+0278 

Identity  \U+2261 

Not 
equal 

 

\U+2260 

Omega 
 

\U+03A9 

Squared ² \U+00B2 

Cubed ³ \U+00B3 

(*) If supported by the text font. 

To Add a Background Mask 

1. When creating or editing a multiline text entity, click the Background Mask tool button 

( ) on the Text Formatting toolbar. 
The Background Mask dialog displays:  

 

2. Check the Use background mask option.  
3. Do one of the following:  

• Choose a color in the Fill color drop-down list.  

• Choose Select color... in the Fill color drop-down list and choose an Index color or a 
True color  in the Select color dialog.  

• Check the Use drawing background color option.  

4. Define the Border offset factor, which defines the margin around the text for the 
background.  
The value is based on the text height and must be in the range 1-5. A factor of 1.0 exactly 
fits the multiline text entity.  

5. Click OK to create the background mask. 
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Editing text 

Command: DDEDIT 

You can edit and modify a text entity as you would any other drawing entity. That is, you can 
delete, move, rotate, and scale text. 

You can change the text color or layer in the Properties Bar. 

To edit a multiline text, you can use the built-in text editor or choose an external program, such as 
Wordpad. 

The MTEXTFIXED system variable controls whether the view is zoomed, rotated and/or panned to 
fit the edited Mtext. 

The TEXTED setting controls the text edit behavior:  

• 0 = in-place editor 

• 1 = pop up dialog 

• 2 = in-place editor with repeated input 

To edit a text entity 

1. Do one of the following: 

• Type ddedit in the command bar. 
You are prompted: Select entity to modify: 

• Double click the text entity. 
Then go to step 3.  

2. Do one of the following: 

• Click a single line text entity. 
Depending on the value of the TEXTED system variable: 

 
TEXTED =  1: The Edit Text window opens. 

 

 
 
TEXTED = 0 or 2: The text is edited 'in place'. 
 

 
• Click a multiline text entity 

The Text formatting toolbar opens. 
 

 

3. Edit the text. 
4. Press the OK button on the Edit Text window or Text Formatting toolbar to apply the 

changes. 
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5. Do one of the following: 

• Select another text entity to edit. 

• Right click or press Enter to stop editing text entities. 

To edit a selection of Mtext entities 

1. Select the Mtext entities. 
2. In the Properties bar select Contents. 

3. Press the Browse button ( ) on the right hand side of the Contents field 

 

 
4. The Text formatting toolbar opens for the first Mtext entity in the selection. 

5. Edit the Mtext,  
6. Press the OK button or click in the drawing. 

The next Mtext entity in the selection can be edited now. 
7. Repeat steps 5 and 6 until the last Mtext is edited. 

To select a different multiline text editor 

Edit the MTEXTED system variable under Drawing/Drafting/Texts/Multiline Texts in the Settings 
dialog. 

or 

1. Type mtexted in the command bar, then press Enter. 
You are prompted: New value for MTEXTED, or . for none/<current value>: 

2. Type the file name and full path of the alternate text editor in the command bar, then 

press Enter. 
e.g. C:\Program Files\Windows NT\Accessories\Wordpad.EXE 

  

NOTE To restore the built-in text editor, type a . (period) in step 2 of the above procedure, then 

press Enter. 

 

Exploding text 

Command: TXTEXP 

The TXTEXP command explodes Text and Mtext entities into 2D polylines. 

1. Type txtexp in the command bar, then press Enter. 

You are prompted: Select text to be exploded: 
2. Select a single text entity or multiple text entities, then press Enter. 

The selected text(s) are exploded. 

  

NOTE The solid fill of certain TTF fonts is removed when exploding such text, leaving the text 

outline only. 

 

file:///D:/BricsCAD%20Training/manuals/01_User_Interface/00_06_Properties_Bar.htm
bricscad-sysvar.chm::/00_07_Settings_Manager.htm
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file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/01_Drawing_2D_Entities/10_01_04_Polylines.htm


BricsCAD V18  Help 

 

 419 

Finding and Replacing Text 

The FIND command lets you specify the text you want to find. You can than find or replace the 
text. Optionally you can zoom in on the various instances of the text entities that contain the 
search text. 

To Open the Find and Replace Dialog 

Do one of the following: 

• Choose Find... in the Edit menu.  

• Type find in the command bar, then press Enter.  

 

To Set the Find and Replace Options 

1. Open the Find and Replace dialog.  
2. Click the Options button. 

 

 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/10_05_05_Finding_and_replacing_text.htm%23To_open_the_Find_and_Replace_dialog
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3. Set the Find and Replace options.  

4. Click the OK button.  

To Find Text 

1. Open the Find and Replace dialog.  
2. (option) Set the Find and Replace options.  
3. Type the text in the Find Text String field.  

4. (option) Click the Select Entities button ( ) to compose a selection set.  

• The Find and Replace dialog temporarily closes to let you select entities.  

• Right click to conclude the selection of entities. 
The Search in field reads Current Selection instead of Entire Drawing.  

5. Click the Find Next button. 

The content of the first text entity that contains the search string displays in the Search 
results pane.  

6. (option) Click the Zoom To button. 
The drawing is zoomed in on the text entity.  

7. Do one of the following:  

• Repeat steps 7 and 8 to find more instances of the same search string.  

• Repeat steps 2 through 8 to find another text string.  

• Press the Esc key or click the Close button to stop.  

  

NOTE If a selection is active when you launch the FIND command, only text entities in the 
selection set are searched. 

 

To Replace Text 

1. Open the Find and Replace dialog.  
2. (option) Set the Find and Replace options.  
3. Type the search text in the Find Text String field.  
4. Type the replacement text in the Replace with: field.  

5. (option) Click the Select Entities button ( ) to compose a selection set.  

• The Find and Replace dialog temporarily closes to let you select entities.  

• Right click to conclude the selection of entities. 
The Search in field reads Current Selection instead of Entire Drawing.  

6. (option) Click the Replace All button. 

All instances of the search text are replaced by the replacement text.  

7. (option) Click the Find Next button. 
The content of the first text entity that contains the search text displays in the Search 
results pane.  

• (option) Click the Zoom To button. 
The drawing is zoomed in on the text entity.  

• Do one of the following:  

• Click the Replace button.  

• Repeat this step to find another text entity that contains the search string.  

• (option) Repeat this step until no more occurrences of the search text are found in the 
drawing or selection set.  

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/10_05_05_Finding_and_replacing_text.htm%23To_open_the_Find_and_Replace_dialog
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/10_05_05_Finding_and_replacing_text.htm%23To_set_the_Find_and_Replace_options
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file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/10_05_05_Finding_and_replacing_text.htm%23To_set_the_Find_and_Replace_options
file:///D:/BricsCAD%20Training/manuals/11_Modifying_Entities/01_Selecting_Entities/11_01_01_Selection_Methods.htm


BricsCAD V18  Help 

 

 421 

8. Do one of the following:  

• Repeat steps 2 through 7.  

• Press the Esc key or click the Close button to stop.  

NOTE If a selection is active when you launch the FIND command, only text entities in the 

selection set are searched. 

 

Checking Spelling 

The spelling checker checks the spelling of text in the current drawing. You can check the spelling 
of one or more selected text entities or check the entire drawing.  

During the spelling check,  the Spell command matches the words in the drawing or the current 
selection set to the words in the current main dictionary and the current custom dictionary. If a 

word is not found in either dictionaries you can select the correct spelling in the suggestions field 
or you can add  the word to the current custom dictionary. Custom dictionaries are used for 

discipline-specific words, such as medical or mechanical. 

Dictionary Settings 

Which dictionaries are used by the Spell command is defined by the DCTMAIN (main dictionary) 
and DCTCUST (custom dictionary) system variables. 

  

 

  

  

NOTE We only deliver the English dictionary because of the license type on the dictionary files : 
the English version can be distributed freely ; all other languages are not free. However, 
you can download other languages and use them for free (see To add a main dictionary). 

 

To Open the Spell Checking Dialog 

Do one of the following: 

• Choose Check Spelling in the Tools menu.  

• Type spell in the command bar, then press Enter.  

bricscad-sysvar.chm::/00_07_Settings_Manager.htm
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To Check the Spelling 

1. Open the Spell Checking dialog.  

2. (option) Click the Select button ( ) to compose a selection set.  
3. (option) Change the current dictionaries.  
4. Click the Start button.  

The first possibly misspelled word displays in the Current word section. 
The content of the text entity in which the Current word is found displays in the Context section. 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/10_05_06_Checking_Spelling.htm%23To_open_the_Spell_Checking_dialog
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5. Do one of the following:  

• Click the Ignore button to leave this instance of the Current word unchanged.  

• Click the Ignore All button to leave all instances of the Current word unchanged.  

• Accept the word in the Suggestions field or select a word in the Suggestions list, then 
click the Change button to replace this instance of the Current word by the word in the 
Suggestions field.  

• Accept the word in the Suggestions field or select a word in the Suggestions list, then 
click the Change All button to replace all instances of the Current word by the word in 
the Suggestions field.  

• Click the Add button to add the Current word to the current custom dictionary.  

• Click the Lookup button to list words similar to the word in the Suggestions field.  

6. Repeat step 5 until the Spelling check is complete message displays.  

  

NOTE If a selection is active when you launch the Spell command, only text entities in the 
selection set are checked. 

 

To Change Dictionaries 

1. Open the Spell Checking dialog.  
2. Click the Change Dictionaries... button.  

The Change Dictionaries dialog opens. 
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3. Click the Main dictionary list button to change the main dictionary.  

 

4. Select a new main dictionary.  
5. (option) Click the Browse... button to select a new Custom dictionary.  
6. (option) Type a word in the Custom dictionary words field, then click the Add button to 

add a word to the current custom dictionary.  

7. Click the Apply & Close button.  

  

NOTE • Custom dictionaries are best saved in the Support folder of the Roamable root folder.  

• If you want to share the custom dictionary with MS Word, point to the MS Word 
custom dictionary in step 5 in the above procedure. By default, CUSTOM.DIC is the 
custom dictionary in MS Word, which can be found under C:\Users\<user 

name>\AppData\Roaming\Microsoft\Proof\CUSTOM.DIC.  

 

To Add a New Main Dictionary 

1. Open the Spell Checking dialog.  
2. Click the Change Dictionaries... button.  

3. Click the Download... button.  

Your browser opens: https://extensions.openoffice.org/dictionaries 

4. Scroll down to the language of your choice, then click the link to open the page of the 
selected language.  

5. Click the Download extension button to start downloading the *.oxt file.  

file:///D:/BricsCAD%20Training/manuals/02_Defining_your_preferences/02_00_Bricscad_User_Files.htm
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6. Change the oxt extension to zip.  
7. Extract the *.aff and *.dic files from the ZIP file to the folder C:\Program 

Files\Bricsys\BricsCAD Vx\Support.  

 

  

The dictionary is now available in the Main Dictionary list on the Change Dictionaries dialog box. 
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To Add a New Custom Dictionary 

1. Open a text editor, such as Notepad.  
2. (option) Type the words you want to use in your custom dictionary. 

Each word must be on a separate line.  
3. Save the file to the the Support folder of the Roamable root folder. 

Make sure the file extension is .cus. 

file:///D:/BricsCAD%20Training/manuals/02_Defining_your_preferences/02_00_Bricscad_User_Files.htm
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Working with Fields 

A field is a variable text that. When a field is updated it displays the latest value of the data source 
it refers to. Fields can be used to insert drawing properties, custom properties or object properties 
in multiline texts or tables or as an attribute in a block.  Fields in attributes are especially useful in 

title blocks: using drawing, sheet set, subset and sheet properties title blocks can be filled out 
automatically. 

See the DWGPROPS command to learn more about default and custom drawing properties. 

See the SHEETSET command to learn more about default and custom sheet set, subset and sheet 
properties. 

If no value is available, a field displays hyphens (----).  

If the FIELDDISPLAY system variable is ON, fields display on a light gray background which does 
not print.  

The FIELDEVAL system variable controls when fields are updated. 

  

 

General Procedure to Create Fields 

1. Do one of the following:  

• Click the Insert Field tool button ( ) on the Insert toolbar.  

• Choose Insert Field... in the Insert menu.  

• Type field in the command bar, then press Enter.  

• Click the Field tool button ( ) on the Text Formatting toolbar when creating or editing 
Mtext or a table cell content.  

The Field dialog box displays. 

  

bricscad-cmdref.chm::/D/DwgProps.htm
bricscad-cmdref.chm::/S/SheetSet.htm
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2. Under Field Names, expand a group, then choose a field name. 
The settings for the selected field display.  

3. Adjust the settings, then click the OK button. 
The Field dialog box closes.  

The field is created in the Mtext or table cell being edited 

or 

You are prompted: Specify start point or [Height/Justify]: 
A context menu displays: 
 

 

• (option) Type H or choose Height in the context menu to define the text height.  
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• (option- Type J or choose Justify in the context menu to set the text justification. 

 

 
• Specify the insertion point of the field in the drawing. 

An Mtext entity, containing the field is created.  

To Display an Entity Property in a Field 

1. Launch the Field command.  
2. Expand Objects in the Field names list and select Object.  

3. Click the Select Entity button ( ) on the Field dialog box. 
The Field dialog box closes temporarily. 

You are prompted: Select Entity:  
4. Click the entity you want to display a property of. 

The Field dialog box displays again.  

5. Select the entity property in the Property list.  

file:///C:/Users/Louis/AppData/Local/Temp/298462/10_Drawing_Entities/05_Working_with_Text/10_05_08_Working_with_Fields.htm%23GeneralProcedure
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6. Set the display layout:  

• Format: choose a unit format.  

• Precision: select a precision in the list button  

• Convert: this option allows to recalculate the field value.  

• Choose a formula in the list; e.g. f*#, where f is the factor you type in the 
Convert field and # is the field value.  

• Type a factor in the Convert field; e.g. 0.0001 to express the area of a 
polyline in square meters in a cm drawing.  

• Prefix: type a text string  

• Suffix: type a text string  

• Decimals: select a decimal separator character  

• Thousands: select a thousands separator character  

• Suppress 0: allows to suppress leading and/or trailing zeros  
8. Click the OK button.  
9. Specify a point to place the field in the drawing.  
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To Edit a Field 

1. Edit the table cell or Mtext entity that contains the field.  
2. Do one of the following:  

• Double click the field.  

• Right click the field, then choose Edit Field ... in the context menu.  

• Select the field, then press Ctrl + F.  

The Field dialog box displays. 

3. Adjust the properties of the field.  
4. Click the OK button to apply the changes.  

To Update a Field 

1. Do one of the following:  

• Click the Update Field tool button ( ) on the Redraw / Regen toolbar.  

• Choose Update Fields... in the Tools menu.  

• Type updatefield in the command bar.  

You are prompted: Select field(s) to update:  

2. Select the field(s) you want to update, then right click or press Enter. 
The selected fields are updated.  

Convert Field To Text 

1. Edit the table cell or Mtext entity that contains the field.  
2. Select the field.  
3. Right click, then choose Convert Field to Text in the context menu. 
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Working with Tables 

Commands: TABLE, -TABLE, TABLEDIT, TABLEEXPORT, TABLEMOD, TABLESTYLE 

A table is an entity that is composed of rows and columns, much like a Microsoft Excel 
spreadsheet. A table entity can be created as an empty table or you can import data from a CSV 

(Comma Separated Values) file. The appearance of the table text and gridlines is controlled with a 
table style. Table styles are saved in the DWG file. 

A default table consists of a Title cell (A), a row of Header cells (B) and one or more rows of Data 
cells (C). 

A table can have one of two directions: Down (title row at the top) or Up (title row at the bottom). 

  

 

  

Table with a Down direction (left) and a Up direction (right). 

Table Styles 

The appearance of a table is controlled by a table style. Each drawing contains the Standard table 

style, which cannot be deleted. You can modify the Standard table style to fit your needs or create 
your own table styles. Table styles are created and edited in the Table Styles category of the 

Drawing Explorer dialog.  

In a table there are 3 cell types: Data, Header and Title. Each cell type has its own cell style 
settings. By default all cells in a row share the same cell style settings, but you can edit the 
settings of each cell afterwards. 

To open the Table Styles Explorer 

Do one of the following: 

• Choose Drawing Explorer > Table Styles... in the Tools menu.  

• Type tablestyle in the command bar, then press Enter  

• Click the Explore Table Styles tool button ( ) on the Insert Table dialog.  

To Create a Table Style 

1. Open the Drawing Explorer - Table Styles dialog displays.  
2. In the Drawing Explorer - Table Styles dialog do one of the following:  

• Choose New in the Edit menu.  

• Click the New tool button ( ).  

A new style is created using default settings. 

  

bricscad-cmdref.chm::/T/Table/Table.htm
bricscad-cmdref.chm::/T/Table/-Table.htm
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3. Rename the style, replacing the NewStyle1 default name.  
4. Select a cell type: Data, Header or Title.  
5. Define the cell style settings for the selected cell type.  
6. Repeat the previous steps for each cell type.  

To Edit a Table Style 

1. Open the Drawing Explorer - Table Styles dialog displays.  

2. In the Details pane of the Drawing Explorer - Table Styles dialog, select the table style 

you want to edit.  
3. Select a cell type: Data, Header or Title.  
4. Edit the cell style settings for the selected cell type.  
5. (option) Repeat the previous steps for another cell type.  

To Apply a Table Style 

To edit a table using the Properties bar 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/Table_Styles.htm%23TableStylesExplorer
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To Delete a Table Style 

1. Open the Drawing Explorer - Table Styles dialog displays.  
2. Select the table style you want to delete. 

Press and hold the Ctrl key to select multiple table styles.  
3. Do one of the following:  

• Right click, then choose Delete in the context menu.  

• Click the Delete button in the Details menu on the Drawing Explorer - Table Styles 
dialog  

  

NOTE It is not possible to delete a table style that is being used in the drawing. 

 

To Create an Empty Table 

1. Do one of the following:  

• Click the Table tool button ( ) on the Draw toolbar.  

• Choose Insert Table... in the Draw menu.  

• Type table in the command bar, then press Enter.  

The Insert Table dialog displays: 

 

2. Choose a Table Style from the Table Style list.  
3. (option) Set the cell style for the first, second and other rows. 

By default the cell style for the first row is Title, the cell style for the second row is Header 

and the cell style for the other rows is Data.  

4. Under Table Options, choose Start from Empty Table.  

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/Table_Styles.htm%23TableStylesExplorer
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5. Under Insertion Behavior do one of the following:  

• Choose Specify Insertion Point, then specify the number of columns and  the column 
width and number of data rows and the row height.  

• Choose Specify Window, then do one of the following:  

• Specify the number of columns and data rows.  

• Specify the column width and the row height.  

• Specify the column width and the number of data rows.  

• Specify the number of columns and the row height.  

6. Click the OK button. 

Depending on your choice in step 5 you are prompted to specify an insertion point or a 
window. 
The table is created and the Text Formatting toolbar displays (see Create multiline text).  

7. Do one of the following:  

• Start adding text in the table  (see Edit the table content).  

• Click outside the table to close the Text Formatting toolbar.  

To Create a Table from Data 

When importing data from a CSV (Comma Separated Values) file, please make sure the list 
separator character on your system is the same as the one used in the CSV file (see Defining the 
list separator character). 

1. Do one of the following:  

• Click the Table tool button ( ) on the Draw toolbar.  

• Choose Insert Table... in the Draw menu.  

• Type table in the command bar, then press Enter.  

The Insert Table dialog displays. 

2. Choose a Table Style from the Table Style list.  
3. Under Table Options, choose From Data.  

4. Click the Browse button ( ). 
The Open dialog displays.  

5. Choose a CSV file, then press the Open button.  
6. Click the OK button on the Insert Table dialog. 

The dialog box closes and the table is attached to the cursor.  
7. Click a point in the drawing to place the table. 

The table is created and the Text Formatting toolbar displays (see Create multiline text).  
8. Do one of the following:  

• Start editing the text in the table (see Edit the table content).  

• Click outside the table to close the Text Formatting toolbar.  

9. (option) Select the table and drag the grips to adjust the dimensions of the table.  

To Create a Table from an Excel Spreadsheet 

1. Open the spreadsheet in Microsoft Office Excel.  
2. Select the cells you want to create a table from.  

3. Copy the selection to the clipboard:  

• Press Ctrl + C.  

• Right click and choose Copy in the context menu.  

4. In BricsCAD, choose Paste special... in the Edit menu. 
The Paste Special dialog box displays:  

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/05_Working_with_Text/10_05_03_Creating_text.htm%23To_create_multiline_text
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5. Choose XML Spreadsheet in the As option list.  
6. Click in the drawing to insert the table.  

Editing a Table Using Grips 

When a table is selected, multiple grips display: 

1. Moves the table.  
2. Modifies the width uniformly.  
3. Modifies the height uniformly.  
4. Modifies the width and height uniformly.  

5. Modifies the width of a column.  

 

Editing a Table Using the Table Toolbar 

1. To open the Table toolbar, do one of the following:  

• Click the cell you want to edit.  

• Press and hold the left mouse button then define a rectangle to select multiple cells  

Column letters and row numbers display. 

The column(s) and row(s) of the selection hightlight. 

A rectangle with four handles is drawn around the selection. 
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2. Do one of the following:  

• Click a cell to select it.  

• Press and hold the left mouse button, then drag the cursor to select multiple cells.  

3. (option) Drag the grips of the selection to modify the dimensions.  
4. (option) Click a tool in the Table toolbar.  
5. (option) Right click to display a context menu: 

 

 

• Delete Cell Content: deletes the text in the selected cells.  

• Clear Cell Overrides: resets all cell properties of the selected cells to the Cell Style 
settings as defined in the Table Style.  

• Clear Table Overrides: resets all cell properties of all cells to the Cell Style settings as 

defined in the Table Style.  

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/Table_Styles.htm
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Table tools 

Icon Tool name Description 

 

Insert row 
above 

Inserts an empty row above the 
selection. 

 

Insert row 
below 

Inserts an empty row below the 
selection. 

 

Delete row Deletes the row(s) of the 
selection. 

 

Insert 
column left 

Inserts an empty column at the 
left of the selection. 

 

Insert 
column 
right 

Inserts an empty column at the 
right of the selection. 

 

Delete 
column 

Deletes the column(s) of the 
selection. 

 

Merge Merges the selected cells. 

 

Unmerge Splits previously merged cells. 

 

Border 
style 

Sets the border style of the 
selection (not implemented yet). 

 

Text 
alignment 

Sets the text alignment of the 
selection. 

 

Lock / 
Unlock 

Locks / Unlocks the selection. 

 

Set cell 

format 

Sets the cell format of the 

selection (not implemented yet) 

 

Set cell 
style 

Sets the style of the selected 
cells: Title, Header or Data. 

 

Set cell 
background 

Sets the background color of the 
selection. 

6. (option) Repeat steps 3 and 4 to continue editing the table. 

7. (option) Double click a cell to edit the cell text. 

8. (option) Do one of the following:  

• Click another cell.  

• Press and hold the left mouse button, then drag the cursor to select multiple cells.  

9. Click outside the table to close the Table toolbar. 
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Editing a Table in the Properties Bar 

1. Click one of the grid lines.  

The properties of the table display in the Properties bar. 

 

2. (option) Apply a different Table style.  
3. (option) Change the table direction.  
4. (option) Modify the width and/or height of the table.  
5. (option) Modify the vertical and/or horizontal cell margins.  

6. Press the Esc key to stop editing the table.  

file:///D:/BricsCAD%20Training/manuals/01_User_Interface/00_06_Properties_Bar.htm
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Editing a Cell in the Properties Bar 

1. Click the cell.  

The properties of the cell display in the Properties bar. 

 

2. (option) Modify the width and/or height of the cell. 
The width and height of the column and/or row of the cell are changed.  

3. (option) Modify the text rotation.  

The options are: 0°, 90°, 180° and 270°.  

4. (option) Edit the cell content.  
5. (option) Choose a different text alignment option.  
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Evaluating Formulas 

Currently formulas are supported partially. There are more complex formulas which are not 
supported yet, but in most cases formulas in Excel sheets will remain functional when the Excel 
sheet is imported as a table. Editing and creating formulas through the field dialog is not supported 
yet, but in-place editing/creating is possible. E.g.:  if you type =SUM(A2:A4) in a cell,  it will be 

interpreted as a formula,  and the sum of the valuess in the cells A2 through A4 is calculated. 

To Edit the Table Content 

1. Do one of the following:  

• Double click the cell you want to edit.  

• Type tabledit in the command bar, then press Enter and click the cell you want to edit.  

The Text Formatting toolbar displays above the selected cell (see Create multiline text). 

2. Edit the text in thale cell. 
(option) Press Alt + Enter to create a second line in the same cell.  

3. To edit another cell:  

• Press the TAB key to go to the next cell in the same row.  

• Press Shift + TAB to go to the previous cell in the same row.  

• Press Enter to go the next cell in the same column.  

• Press Shift + Enter to go to the previous cell in the same column.  

• Press one of the Arrow keys.  

4. Click to stop editing the table content.  

To Export a Table 

When exporting data to a CSV (Comma Separated Values) file, the list separator character off your 
system is used in the CSV file (see Defining the list separator character). 

1. Type tableexport in the command bar, then press Enter. 
You are prompted: Select table to export:  

2. Click the table you want to export the data of. 
The Export Data dialog opens.  

3. Select a folder to save the data in.  

4. Type a name in the File name field.  
5. Click the Save button. 

The data in the selected table are saved as a CSV (Comma Separated Values) file.  

Defining the list separator character 

1. Click the Start button in the Windows Taskbar, then choose Control Panel.  
2. Do one of the following:  

• On the Control Panel Home window, choose: Clock, Language and Region > Regional 
and Language Options.  

• On the Control Panel Classic View window, double click the Regional and Language 
Options icon.  

The Regional and Language Options dialog box displays. 

3. On the Regional and Language Options dialog box click the Customize this format... button.  
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The Customize Regional Options dialog box displays: 

  

 

4. On the Numbers page of the Customize Regional Options dialog box, go to List separator, 

then click the down arrow and select either comma (,) or semicolon (;).  
5. Click the OK button on the Customize Regional Options and Regional and Language Options 

dialog boxes. 
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Annotative Entities 

Annotations are all entities in your drawing which are not a model or geometry, such as 
dimensions, texts, symbols, etc. A common problem with annotations is that they are often scale 
dependent. Some annotations must be scaled to the plot scale, or are meant to be shown at 

certain scales only.  

Annotative styles and entities change the way in which they are displayed (size, location, and 
orientation) depending on the current scale factor and the viewport.  

The following entities can have the annotative property:  

• text and multiline text  

• hatches  

• blocks and attributes  

• dimensions and tolerances  

• leaders and multileaders  

The following styles can have the annotative property: 

• text styles (see the STYLE command)  

• dimension styles (see the DIMSTYLE command)  

• multileader styles (see the MLEADERSTYLE command)  

  

NOTES • Entities that are created using an annotative style, get the current annotation scale 
assigned automatically. 

• When an annotative style is applied to a non-annotative entity, the annotative 
property is not assigned automatically. 

  

Commands 

ANNORESET: Resets all scale representations of the selected annotative entities to the location of 

their current scale representation, thus synchronizing all scale representations. 

ANNOUPDATE: Updates the selected annotative entities to match their current style definition. 

OBJECTSCALE: Adds or removes supported scales for annotative entities through a dialog box. 

-OBJECTSCALE: Adds or removes supported scales for annotative entities at the command line. 

SCALELISTEDIT: Edits the scale list of a drawing, used in Plot Scale section of the Print and Page 
Setup dialogs and the Standard scale property of a paper space viewport. Defines the available 

annotation scales for annotative entities. 

-SCALELISTEDIT: Edits the scale list of a drawing at the command line. 

System Variables and User Preferences 

ANNOALLVISIBLE: Toggles the display of annotative enitities that do not support the current 
annotation scale. 

ANNOTATIVEDWG: Specifies whether or not the drawing behaves as an annotative block when 

inserted into another drawing. 

CANNOSCALE: Sets the name of the current annotation scale for the current space. Only scales 
that exist in the current scale list are accepted. The CANNOSCALE setting is saved with model 
space and with each layout viewport in the various layouts. When you create an annotative entity 
the current annotative scale is applied automatically. 

CANNOSCALEVALUE: Displays the value of the current annotation scale. E.g. the value of the 1:2 
scale is 0.5. 

HPANNOTATIVE: Controls whether  new hatch entities are annotative. 

MSLTSCALE: If ON, linetypes in model space are scaled to the current annotation scale. A regen is 

needed when you toggle the value of MSLTSCALE. This variable is the equivalent of the PSLTSCALE 
(Paperspace linetype scale) variable in paper space. 
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MSOLESCALE: Controls the size of an OLE object containing text when pasted in model space. The 

MSOLESCALE system variable only affects the initial scaling. Existing OLE objects are not affected 
if the variable is modified. 

SAVEFIDELITY: Controls whether the current display of the drawing is preserved when opened in a 
program that does not support annotative entities.  

SELECTIONANNODISPLAY: Controls whether all scale representations display when an annotative 

entity is selected. 

  

Setting the Current Annotation Scale 

To set the current annotation scale, do one of the following: 

• Click the Annotation Scale field under Misc in the Properties Bar, then press the down-
arrow button and select a scale in the list.  

• Right click the Annotation Scale field in the Status Bar, then select a scale in the list.  
If the Annotation Scale field is not available, click the down arrow at the right hand side 
of the Status Bar and  choose Annotation Scale in the list.  

NOTE Only scales that exist in the Scale List of the drawing are available. Use the 

SCALELISTEDIT command to edit the Scale List. 

  

Making an Annotation Entity Annotative 

Annotation entities which are created using a non-annotative style can be made annotative using 

the following procedure: 

1. Select the annotation entity.  
2. In the Properties Bar, click the Annotative property.  

3. Select Yes.  

 

The current annotation scale is applied to the selected entity. 

Annotation Scales 

Commands: OBJECTSCALE and SCALELISTEDIT 

Annotation scales are used to calculate the scaling factor for annotative entities. It defines the 
height of annotative text entities or the overall scaling of annotative blocks. In general the 
annotation scale allows to create annotative entities in model space at the correct paper space size 
automatically. 

• Texts, MTexts, Dimensions, MLeaders: The current annotation scale is applied upon creation if 
the current style is annotative. 

• Hatches and Gradient Fills: The current annotation scale is applied if the HPANNOTATIVE 
system variable is ON. 

• Blocks: The current annotation scale defines the scaling of annotative blocks upon insertion. 
 Annotative entities can support multiple annotation scales. When the SELECTIONPREVIEW system 
variable is active or when using the Quad cursor menu, an icon displays next to the highlighted 

entity indicating whether a single annotation scale ( ) applies to an annotative entity or multiple 

( ).  
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To add or remove annotation scales to annotative entities 

Use the following procedure to: 

• Check which annotation scales currently apply. 

• Add annotation scales. 

• Remove annotations scales. 

1. Select the annotative entity or entities. 
2. In the Properties Bar, select the Annotative Scale field. 

3. Click the Browse button ( ) of the Annotative Scale field. 

The Annotation Object Scale dialog displays. 

 

4. (option) If multiple entities were selected, choose whether to list all scales for the selection 
or the common scales only. 

5. (option) Do one of the following: 

• Select one or more scales in the list, then click the Delete button. 
The selected scale(s) are removed from the list. 

• Click the Add... button, then select one or more scales in the list and click the OK 
button. 
The selected scale(s) are added are added to the list. 
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6. Click the OK button to close the Annotation Object Scale dialog. 

The changes are applied to the selection set. 

  

NOTE Only scales that exist in the Scale List of the drawing are available. Use the 
SCALELISTEDIT command to edit the Scale List. 

 

Adding or Removing Annotation Scales to Annotative Entities 

Annotation entities which are created using a non-annotative style can be made annotative using 
the following procedure: 

1. Select the annotation entity.  
2. In the Properties Bar, click the Annotative property.  

3. Select Yes.  

 

The current annotation scale is applied to the selected entity. 

Annotative Texts 

Commands: TEXT, MTEXT and STYLE 

  

Text entities are created using the current text style: 

• If the text style is annotative, the text entity gets the annotative property automatically 
and the current annotation scale is assigned.  

• If the text style is not annotative, you need to make the text entity annotative manually. 
Annotative texts have two height properties: 

• Model text height: the display height on the screen in model space, with respect to the 
current annotation scale. 

• Paper text height : the height on paper if printed on the supported annotation scale. 

To make a text entity annotative 

1. Select the text entity. 

The properties of the selected text entity display in the Properties Bar. 

2. In the Properties Bar, select the Annotative property. 
3. Choose Yes from in the options list. 

The current annotation scale is assigned. 
The text is not scaled: the current text height becomes the Model text height. 

To remove the annotative property 

1. Select the text entity. 
The properties of the selected text entity display in the Properties Bar. 

2. In the Properties Bar, select the Annotative property. 
3. Choose No from in the options list. 

If the text entity supports multiple annotation scales, the text is scaled back to its initial 

scale. 
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Annotative Hatches 

Commands: HATCH, -HATCH, GRADIENT 

The HPANNOTATIVE system variable controls whether new hatch or gradient entities are 
annotative.  

HPANNOTATIVE is OFF by default. The system variable is not saved and is reset to its default value 

when BricsCAD closes. 

To set the HPANNOTATIVE system variable 

Do one of the following: 

• In the Settings dialog, under Drafting / Entity Creation / Hatches. 

• Check the Annotative option on the Hatch and Gradient dialog box of the HATCH or 
GRADIENT command. 

• Choose the Annotative option in the command prompt of the -HATCH command. 

To make a hatch or gradient entity annotative 

1. Select the hatch or gradient fill. 
The properties of the selected entity display in the Properties Bar. 

2. In the Properties Bar, select the Annotative property. 

3. Choose Yes from in the options list. 
The current annotation scale is applied to the selected hatch or gradient entity and the 
hatch is scaled accordingly. 

To remove the annotative property 

1. Select the hatch or gradient fill. 

The properties of the selected entity display in the Properties Bar. 
2. In the Properties Bar, select the Annotative property. 
3. Choose No from in the options list. 

Annotative Blocks 

Commands: BLOCK and EXPBLOCKS 

The annotative property of a block is either set when creating the block definition or afterwards, in 
the Drawing Exlorer / Blocks dialog. 

Annotative blocks can have an optional property to always match the orientation of a layout, 
independent from the rotation of the viewport content. 

To make a block definition annotative 

1. Open the Drawing Explorer / Blocks dialog. 

2. If necessary, choose Detail View. 

Annotative block definitions have the Annotative icon ( ) displayed. 
3. Click in the Annotative field of a block definition to toggle the annotative property on/off. 

To match the orientation of a block to a layout 

1. Open the Drawing Explorer / Blocks dialog. 
2. If necessary, choose Detail View. 
3. Click the checkbox in the Match Orientation field of a block definition to toggle the Match 

Orientation property on/off. 
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Annotative Dimensions 

Dimension entities are created using the current dimension style: 

• If the dimension style is annotative, the dimensions get the annotative property 
automatically and the current annotation scale is assigned.  

• If the dimension style is not annotative, you need to make the dimensions annotative 
manually. 

  

NOTE The Dim Scale Overall (DIMSCALE) setting  is not editable for annotative dimension 
styles, and is neglected for annotative dimensions. 

 It is recommended to set Dim Scale Overall = 1 for annotative dimension styles. 

  

To make a dimension entity annotative 

1. Select the dimension entity. 
The properties of the selected dimension entity display in the Properties Bar. 

2. In the Properties Bar, select the Annotative property. 

3. Choose Yes from in the options list. 
The current annotation scale is assigned. 
The dimension entity is scaled with respect to the current annotation scale. 

To remove the annotative property 

1. Select the dimension entity. 
The properties of the selected dimension entity display in the Properties Bar. 

2. In the Properties Bar, select the Annotative property. 
3. Choose No from in the options list. 

The dimension entity is scaled with respect to the current value of the Dim Scale Overall 
setting. 
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Modifying Entities 

Entity Modification Commands 

All entity modification tools can be found either on the Modify toolbar or in the Modify menu. 

  

Icon Tool name Command Description 

 

Manipulator MANIPULATE  

Launches the Manipulator widget; rotates, 
moves, mirrors and scales entities. Keep the 
Ctrl-key pressed while starting an action to 
manipulate a copy of the selected entities. 

 

Move MOVE  

Moves entities to another location in the same 
drawing or into another drawing. 

 

Copy COPY  

Draws a duplicate or multiple duplicates of the 

selected entities.  

 

Offset  OFFSET  

Creates a parallel or offset copy of curves and 
lines. 

 

Scale SCALE  

Changes the scale of existing entities, either 
enlarging them or reducing them proportionately 
in x, y, and z directions. 

 

Rotate ROTATE  

Rotates entities around a specified point. 

 

3D Rotate ROTATE3D  

Rotates entities around a three-dimensional axis. 

 

Mirror MIRROR  

Moves or copies the reflected image of entities 
about a line. 

 

3D Mirror MIRROR3D  

Moves or copies the reflected image of entities 

about a plane. 

 

Array  ARRAY  

Creates multiple copies of entities in one of two 
symmetrical patterns: rectangular (rows and 
columns) or polar (circular).  

 

3D Array  3DARRAY 

Creates multiple copies of entities in three 
dimensions. Entities are arrayed in a three-
dimensional rectangular (rows, columns and 

levels) pattern or a two-dimensional polar 
(circular) pattern in three-dimensional space.  

 

Break  BREAK  

Splits an entity into two entities. 

 

Join JOIN  

Joins two entities (two or more lines or two or 
more arcs) into one entity. 

 

Trim TRIM  

Erases the portions of selected entities that cross 

a specified boundary. 

 

Align ALIGN  

Aligns selected entities with other entities in 
three-dimensional space. 

 

Extend EXTEND 

Lengthens lines, arcs, polylines or rays to meet 
another entity. 

 

Edit Length LENGTHEN  

Changes the length of a line, polyline, freehand 
entity or arc. 

 

Stretch STRETCH  

Moves a portion of a drawing while retaining 
connections to other parts of the drawing. 

 

Chamfer  CHAMFER  

Creates a chamfer, or a beveled edge, at the 
intersection of two 3D solids, lines, rays, or 
infinite lines.  
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Fillet FILLET  

Creates a fillet, or rounded corner, at the 
intersection of 3D solids, two lines, rays, or 
infinite lines.  

 

Measure MEASURE  

Divides a selected entity into segments by 
placing markers (points or blocks) at specified 

intervals along its length or circumference. 

 

Divide DIVIDE  

Places markers (points or blocks) along a 

selected entity. The markers evenly divide the 
entity into the specified number of equal parts. 

 

Hatch Edit  HATCHEDIT  

Edits hatches and gradient fills in a dialog box 

 

Edit 
Polyline 

PEDIT  

Edits a two-dimensional or three-dimensional 
polyline, or a polygon mesh. 

 

Spline Edit SPLINEDIT 
Edits a two-dimensional or three-dimensional 
spline. 

 

Flatten FLATTEN  

Projects 2D and 3D entities onto the XY-plane of 
the current view. 

 

Explode EXPLODE  

Ungroups a block, polyline, polyface mesh, solid, 
or hatch, creating separate entities for each 

element. 

 

Change  CHANGE  

Changes the location, size, color, elevation, 

layer, linetype, linetype scale, lineweight, and 
three-dimensional thickness of entities. 

 

Properties PROPERTIES  

Opens the BricsCAD Properties Bar (if not 
already open). 
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Entity Modification Settings 

Entity modification settings are found in the Entity modification settings group of the Drawing 
settings category in the Settings dialog. 

  

 

Match Properties 

Command: MATCHPROP 

The Matchprop command assigns the properties of one entity to one or more other entities (short 
for "match properties"). 

To copy properties between entities 

1.  Do one of the following: 

• Click the Match ( ) tool button on the Standard toolbar. 

• Type match in the command bar then press Enter. 

You are prompted:  

Select entity to copy properties from: 

bricscad-sysvar.chm::/00_07_Settings_Manager.htm
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2. Select the source entity. 

You are prompted:  
Active Settings: 'Color' 'Layer' 'Linetype' 'Linetype Scale' 'Lineweight' 'Thickness' 'Plot Style' 
'Dimension' 'Polyline' 'Material' 'Text' 'Shadow Display' 'Hatch' 'Multileader' 
Select entities to copy properties to or [Settings]: 

3. (option) Type S, then press Enter. 

The Match Properties dialog box displays: 

 

The entity properties you are about to copy display in the Match Properties dialog. 

Adjust the settings, then click the OK button 

4. Select the target entities. 
You are prompted: Select entities to copy properties to or [Settings]: 

5. Do one of the following: 

• (option) Repeat step 3 to adjust the settings, then select more target entities. 

• Right click or press Enter to stop. 
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Grips editing 

Grips display as small colored squares at key-points on selected entities.  

 

 

  

Whether grips display or not and the appearance of grips is controlled through a series of grips 

settings. 

When the display of grips is turned on, grips can be dragged using the mouse in order to stretch, 
move, mirror, rotate or scale entities.  

The Copy option of the grips editing commands allows to create multiple copies of the entities 
being edited. 

  

To select a grip, move the mouse over it, then click. Selected grips display in a different color, 

which is defined by the HOTGRIP system variable. A selected grip is called a hot grip. By default 
hot grips display in red. 

The midpoint grip on lines and infinite lines, the startpoint grip on rays,  the center grip on circles, 

arcs, ellipses and elliptical arcs,  the grip on points and the insertion point grip of texts, mtexts, 
blocks and Xrefs can be used to quickly move such entities.  

  

NOTE When DRAGSNAP is ON, dragged entities display at the current entity snap location. 

 

Selecting Multiple Grips 

1. Select all entities you want to edit.  
2. Press and hold the Shift key, then click the first grip. 

The selected grip displays in red.  
3. Keep the Shift key pressed, then click more grips. 

All selected grips display in red. 
 

 
4. Release the Shift key, then click the hot grip you want to use as the base point. 

The hot grips move simultaneously.  
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Grip Edit Command Options 

Keyboard 
Prompt 

Box 
Description 

B 
Base 
Point 

Prompts you to specify a new base point, other than the selected grip. 

C Copy 
Copies the selected entities and keeps the originals. By default, 
multiple copies can be created. Press Enter to stop making copies. 

U Undo If the Copy option is chosen, deletes the latest copy.  

R Reference 
(Applies to Grip Rotate only) Allows to specify a reference angle. 
Type the angle in the command bar or specify two points. 

X Exit Aborts the grip edit command. 

  

The grips editing context menu 

The grips editing commands can either be chosen by repeatedly hitting the space bar or the Enter 
key or in a context menu. 

To display the context menu, do the following: 

1. Select the entities you want to manipulate, then drag one of the grips.  
2. Right click.  

 

To Stretch Entities Using Grips 

1. Select the entity or entities.  
2. Select the grip or grips you want to manipulate.  
3. Click the grip you want to use as the base point. 

All selected grips move simultaneously.  

The GRIP_STRETCH prompt box displays: 
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You are prompted: Enter new point: Base point/Copy/Undo/eXit: 

4. Do one of the following to define the displacement point:  

• Click in the drawing.  

• Enter the coordinates, then press Enter.  

• Key-in the distance, then press Enter. 
Use ORTHO or Polar Tracking to control the angle.  

To Move Entities Using Grips 

1. Select the entity or entities.  
2. Select the grip or grips you want to manipulate.  
3. Click the grip you want to use as the base point for the move. 

The Grip Stretch command is launched.  
4. Do one of the following:  

• Right click, then select Move in the context menu.  

• Hit the Space bar or Enter key to cycle through the Grips Editing commands until Move 
is active.  

The GRIP_MOVE prompt box displays: 
  

 

You are prompted: Enter move point: Base point/Copy/Undo/eXit: 

5. Do one of the following to define the displacement point:  

• Click in the drawing.  

• Enter the coordinates, then press Enter.  

• Key-in the distance, then press Enter. 
Use ORTHO or Polar Tracking to control the angle.  

To copy entities using grips 

1. Select the entity or entities.  
2. Select the grip or grips you want to manipulate.  
3. Click the grip you want to use as the base point for the move. 

The Grip Stretch command is launched.  
4. Do one of the following:  

• Right click, then select Move in the context menu.  

• Hit the Space bar or Enter key to cycle through the Grips Editing commands until Move 
is active.  

The GRIP_MOVE prompt box displays: 
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You are prompted: Enter move point: Base point/Copy/Undo/eXit: 

5. Do one of the following  

• Choose Copy in the context menu.  

• Type C, then hit the Space bar or Enter key.  

6. Do one of the following to define the displacement point:  

• Click in the drawing.  

• Enter the coordinates, then press Enter.  

• Key-in the distance, then press Enter. 
Use ORTHO or Polar Tracking to control the angle.  

7. Repeat the previous step to create more copies or press the Space bar or Enter key to 
stop.  

To Mirror Entities Using Grips 

1. Select the entity or entities.  
2. Select the grip or grips you want to manipulate.  
3. Click the grip you want to use as the base point for the mirroring. 

The Grip Stretch command is launched.  
4. Do one of the following:  

• Right click, then select Mirror in the context menu.  

• Repeatedly hit the Space bar or Enter key to cycle through the Grips Editing commands 
until Mirror is active.  

The GRIP_MIRROR prompt box displays. 
 

 

You are prompted: Enter second point: Base point/Copy/Undo/eXit. 

4. Specify a second point to define the mirror axis. 
The selection is mirrored.  
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To Rotate Entities Using Grips 

1. Select the entity or entities.  
2. Select the grip or grips you want to manipulate.  
3. Click the grip you want to use as the base point for the rotation. 

The Grip Stretch command is launched.  
4. Do one of the following:  

• Right click, then select Rotate in the context menu.  

• Repeatedly hit the Space bar or Enter key to cycle through the Grips Editing commands 
until Rotate is active.  

The GRIP_ROTATE prompt box displays. 
  

 

You are prompted: Enter rotation angle: Base point/Copy/Undo/eXit. 

5. Do one of the following to rotate the selection:  

• Specify a point to define the rotation angle.  

• Type the rotation angle in the command bar, then press Enter  

To Scale Entities Using Grips 

1. Select the entity or entities.  
2. Select the grip or grips you want to manipulate.  

3. Click the grip you want to use as the base point for the scaling. 
The Grip Stretch command is launched.  

4. Do one of the following:  

• Right click, then select Scale in the context menu.  

• Repeatedly hit the Space bar or Enter key to cycle through the Grips Editing commands 
until Scale is active.  

The GRIP_SCALE prompt box displays. 
 

 

You are prompted: Enter scale factor: Base point/Copy/Undo/eXit. 

5. Type the scale factor in the command bar, then press Enter to scale the selection. 
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Selecting Entities 

Selection settings sit in the Selection settings group of the Program Options settings category in 
the Settings dialog.  

  

 

  

  

Name System Variable Description 

Highlight HIGHLIGHT 
Determines wether or not entities highlight on screen 
when selected. 

Image highlight IMAGEHLT 
Determines whether the entire raster image highlights 
or only the raster image frame when selected. 

Pick add PICKADD 

Controls whether subsequent selections replace the 
current selection set or add to it. 

ON: The selection set is extended if you select 
additional entities. Press and hold the Shift key to 

remove entities from the selection set. 

OFF: You cannot add entities to a selection set. The 
newly selected entity or entities replace the existing 
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selection set. However, if you press and hold the Shift 

key, you can add entities. If you select an entity that 
was already selected while pressing the Shift key, this 
entity is removed from the selection set. 

Pick automatic PICKAUTO 

Controls automatic window selection (inside or 
crossing) when selecting entities.  

The value is stored as a bitcode using the sum of the 
selected options. 

• negative: Disables window selection, saving 
current value. 

• 1 = draws a selection window if the mouse is 
over a blank area of the drawing when clicked. 

• 2 = draws a selection window if the mouse is 

over an entity when dragged.   

Pick box PICKBOX 

Defines the size of the small square at the end of the 

selection cursor ( ) . If you select an entity by 
clicking the Pick Box must touch or overlap the entity. 

The default size of the Pick Box is 3. 

Pick drag PICKDRAG 

Controls the method of drawing a selection window. 

ON: Allows to define a selection window by 
dragging:press and hold the left mouse button to 
define the first corner of the rectangle, then move the 
mouse to define the size of the selection window and 
release the mouse button to define the opposite 
corner. 

OFF: Define the selection window by clicking two 

opposite corners. 

Pick first PICKFIRST 

Controls whether you select objects before or after you 
issue a modification command. 

ON: Allows to first compose a selection set, then 
launch a modification command. 

OFF: You must first start the command, then compose 
the select entities. 

Pick style PICKSTYLE 

Controls the selection of groups and associative 
hatches. 

• 0 = No group selection, nor associative hatch 
selection. 

• 1 = Group selection: if a member of a 

selectable group is selected, all members of the 
group are selected. 

• 2 = Associative hatch selection: the hatch and 
its boundary are selected, no matter what is 

picked: the hatch or the boundary (not supported 
yet). 

• 3 = Group selection and Associative hatch 
selection. 
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Match options for 
SELECTSIMILAR  

SELECTSIMILARMODE 

Controls which properties must match for an entity 
of the same type to be selected with the 
SELECTSIMILAR command. 

 

Selection area SELECTIONAREA Controls the display of selection area effects. 

Selection area 
opacity 

SELECTIONAREAOPACI
TY 

Controls the transparency of the selection area: 
the higher the value the more opaque the 
selection area. 

Crossing area 
color 

CROSSINGAREACOLOR Specifies the color for crossing selection areas. 

Window area 
color 

WINDOWAREACOLOR Specifies the color for window selection areas. 

Selection preview 
display 

SELECTIONPREVIEW 

Controls when entities highlight when the cursor 

hovers over them:  

• 0 = never;  

• 1 = when no commands are active;  

• 2 = when a command prompts for entity 
selection;  

• 3 =  both, when no commands are active and 
when a command prompts for entity selection. 

When the QUAD cursor menu is active, 
SELECTIONPREVIEW is neglected, unless a 
command prompts for entity selection. 

Selection preview 
effect 

PREVIEWEFFECT 

Controls the appearance of highlighted entities: 
0=dashed lines; 1=thickened lines; 2=dashed and 

thickened lines (not yet supported). 

Selection preview 
filter 

PREVIEWFILTER 

  

Controls which entity types are excluded from 

selection previewing.  
The options are:  

• Entities on locked layers 

• Entites in Xrefs 

• Tables 

• Mtext entities 

• Hatches 

• Groups 

GL Selection 
 Highlight Style 

HIGHLIGHTEFFECT 
Specifies the highlight method: 0=dashed lines; 

1=use different color; 2=use thickened line; 
3=use different color and thickened line. 

Selection 
Highlight color 

HIGHLIGHTCOLOR 
Specifies the highlight color to be used when 
HIGHLIGHTEFFECT is 1 or 3. 

Selection Modes SELECTIONMODES 

Defines which subentities should highlight in 
selection preview. 

The variable is stored as a bitcode using the sum 
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of the values of all selected options. 

Click the buttons on the Selection Modes toolbar 
to set the value of SELECTIONMODES. A pressed 

button indicates the option is selected. 

 

 

• 1 = Enable detection of 3D solid edges ( ) 

• 2 = Enable detection of 3D solid faces ( )* 

• 4 = Enable boundary detection ( ).  
Controls whether closed boundaries in XY-

plane of the current coordinate system or on 
the face of 3D solids highlight when no 
commands are active. 
The BOUNDARYCOLOR system variable 
specifies the color for highlighting detected 
boundaries. 

* Hold down the Ctrl-key to invert the status of 

the Select Faces option: if ON allows to select 3D 
solids, if OFF allows to select solid faces. 

  

Repeatedly pressing the TAB key, while keeping 
the cursor at the same position, highlights all 
included subentity types one by one. 

See also window selection. 

Constraint Bar 

Display 

CONSTRAINTBARDISPL

AY 

Controls the visibility of a geometric constraint at 

its creation or selection. 

Dynamic 

Constraint Mode 
DYNCONSTRAINTMODE 

Controls the visibility of hidden dimensional 
constraints when the constrained entity is 
selected. When the cursor is over an entity with a 
dimensional constraint, the blue constraint glyph 

displays. 

  

  User Preference   

Preview selection 

delay 
PreviewDelay 

Specifies how many milliseconds to wait before 
highlighting the (sub)entities under the cursor. 
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Grips Settings 

If the Grips system variable is different from zero, grips display on selected entities. 

Grips settings sit under Display/Viewing in the Drafting settings group of the Drawing settings category in the Settings 

dialog. 

Grips can be used to manipulate entities (see Grips Editing) 

  

 

  

  

Name System Variable Description 

Grips GRIPS 

The value of GRIPS can be 0, 1 or 2 

• 0: No grips. 

• 1: Display grips. Polyline endpoint and midpoint 
grips. 

• 2: Display grips. No midpoint grips on polyline 
segments. 

Grips in blocks GRIPBLOCK Toggles the display of grips on entities in blocks on/off. 

Grip color GRIPCOLOR 
Sets the color of unselected grips. Default value is green 
(index color no. 72). 

Selected grip 

color 
GRIPHOT 

Sets the color of selected grips, so called 'hot grips'. 
Default value is red (index color no. 240). 

Hover grip 
color 

GRIPHOVER 

Sets the color of an unselected grip when the cursor 

pauses over it. Default value is blue (index color no. 
150). 

Grip size GRIPSIZE 
Sets the size of the grip box, expressed in pixels. 

Default value = 4. 

Grip object 

limit 
GRIPOBJLIMIT 

Suppresses the display of grips if the number of 
selected objects exceeds the value of GRIPOBJLIMIT. If 
set to 0 (zero) grips always display. 

Grip tips GRIPTIPS 

(Not supported yet) Determines whether grip tips 
display when the cursor hovers hover grips on custom 
entities or dynamic blocks that support grip tips. 

Grips 
attraction 

EnableAttraction (*) Toggles the magnetism of grips on/off. 

Grips 

attraction 
distance 

AttractionDistance 
(*) 

Sets the grips attraction distance: if the cursor is within 

this distance the cursor is attracted by the grip and 
jumps to it. 

  

(*) User Preference 

bricscad-sysvar.chm::/00_07_Settings_Manager.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/11_10_00_Grips_editing.htm


BricsCAD V18  Help 

 

 463 

Selection Methods 

Before you start to use modification commands, you need to know how to compose a selection set. 
If the PICKFIRST variable is ON you can build the selection set before starting the command, else 
you are prompted to select the entities after you launched the modification command. 

Using QUICK SELECT you can specify filters, such as entity type, color, linetype or any other entity 

property,  to compose a selection set.  

The SELECTIONPREVIEW and PREVIEWEFFECT system variables facilitate the selection procedure. 

Composing a Selection Set Before (pre- pick) 

To compose a selection set before launching a modification command do one or more of the 
following: 

• Click an entity. 
The entity highlights and grips show. 
  

NOTE If the Quad cursor menu is active you must press and hold the Ctrl key while selecting 
entities. 
Click again to unselect. 

• Window selection:  

• Click to define the first corner of a selection window. 
Move the mouse to the left to define a Crossing Window: 

 
All entities which overlap the window or are completely inside the window are 
added to the selection set. 
The selection window displays in dashed lines with a green background.  

• Click to define the first corner of a selection window. 
Move the mouse to the right to define a Window-Inside: 

 
All entities which are completely inside the window are added to the selection 
set. 
The selection window displays in continuous lines with a blue background.  

• Pressing the Ctrl key during window selection allows to select faces or edges 
of 3D solids and surfaces.  
The icon next to the cursor indicates the selection mode:  

• : Solids (Default)  

• : Faces  

• : Edges  

Depending on the value of the TIPS system variable, the Hotkey Assistant widget 
displays to indicate the current selection mode: 

 

 

• Press an hold the Shift key, then use one of the above methods to select entities that 

you want to remove from the selection set.  

NOTE If the PICKADD system variable is OFF, you cannot add entities to a selection set. 
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Composing a Selection Set Afterwards (post-pick) 

Command: SELECT 

If you launch a modification command when no selection set is active, you are prompted to select 

entities. BricsCAD provides a range of selection methods to let you compose your selection set 
easily. 

The various selection methods are: 

• Add to set: Selected entities are added to the selection set.  

• Subtract from set: Selected entities are removed from the selection set.  

• Picking: Place the pickbox over a part of the object and click.  

• Select all entities: Select all entities in the entire drawing, including entities which are 
on hidden layers. Entities on frozen layers are not selected.  

• Previous selection: Re-use the previous selection set.  

• Last entity in drawing: Select the most recent entity.  

• Window: All entities which are inside, overlap or are completely outside a window are 
selected. You can choose between a rectangle, polygon or a circle.  

• Fence: All entities that cross a multi-segment line are selected.  

• Point: Click a point to select all closed entities which enclose this point.  

• Select by Properties: Displays the Select by Properties context menu to select entities 
by Color, Layer, Linetype, Name, Thickness, Type, Value, Width or Handle.  

• Undo: Undoes the last selection action.  

• Location: Displays the Select Location context menu.  

  

  

Select Location and Select By Properties 

context menus 
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Selecting Overlapping Entities 

When entities are close together or lie on top of each other it is difficult or sometimes impossible to 
select the entities needed. 

Cycling through the overlapping entities, highlighting each entity one by one, helps you to select 
such entities. 

Make sure SELECTIONPREVIEW is ON and/or the Quad cursor menu is active. 

1. Place the cursor over the overlapping entities. 
One of the entities highlights.  

2. Repeatedly hit the TAB key. 
The overlapping entities highlight one by one.  

3. Click when the desired entity highlights.  
4. Repeat the previous steps to select more entities.  

NOTES • Do not move the mouse while hitting the TAB key, because this will restart the 
highlight order. 

• Hold down the Shift key to cycle the overlapping entities in reverse order. 

 

Using Quick Select 

 

Use smart filters to compose a selection set  

  

Using Quick Select you can specify filters, such as entity type, color, linetype or any other entity 
property,  to compose a selection set.  

After composing the filter criteria you can choose to add the matching entities to a new selection 

set,  add the entities to the current selection set  or remove them from the current selection.  

Quick Select applies to the entire drawing or to a previously created selection. 

To create a selection set 

1. Click the Quick Select tool button ( ) on the Properties bar. 
The Properties bar mode is set to Quick Select. 
 

 
 

The Apply to current selection set option is checked if a selection set exists. 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/11_01_00_Selection_Settings.htm%23SELECTIONPREVIEW
file:///D:/BricsCAD%20Training/manuals/03_Drawing_Accurately/03_12_Quad.htm
https://blog.bricsys.com/tutorials/
https://blog.bricsys.com/use-smart-filters-compose-selection-set/
file:///D:/BricsCAD%20Training/manuals/01_User_Interface/00_06_Properties_Bar.htm
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2. Click the Selection List button, to see a list of all entity types in the current drawing or 

current selection set (see previous step). 
A list of all entities in the drawing and the number of entities of each type displays. 
 

 
3. Select an entity type in the list, e.g. Line. 

Line properties show in the Properties Bar. 
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4. Specify the property filters, e.g. Color, Layer and Linetype. 

 

 
5. (option) Specify a different selection operator for each entity property: 

Click the = sign, then select an operator in the list. 
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7. Do one of the following: 

• Click the Add to new selection set button ( ). 
The entities that match the selected criteria are selected. 
 

 

• Click the Add to the current selection set button ( ). 

The entities that match the selected criteria are added to the current selection. 

• Click the Remove from current selection set button ( ). 
The entities that match the selected criteria are removed from the current selection. 

8. (option) Repeat the above procedure to further refine the selection set. 
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The Structure Panel 

The dockable Structure panel displays a structured tree view of the drawing content. This 
structured view is fully configurable and configurations can easily be saved and recalled. The *.cst 
configuration files are stored in the Support folder by default. Entities selected in the structure tree 
can optionally be simultaneously highlighted and selected in the drawing, and vice versa, when 

selecting entities in the drawing they optionally can become selected and highlighted in the 
structure tree. 

To open the Structure panel 

1. To open the Structure panel do one of the following: 

• Place the cursor over a toolbar or ribbon panel, then right click and choose Structure in the 
context menu. 

• Type structurepanel in the command bar, then press Enter. 

2. Click the down-arrow button and load a configuration file in the list; e.g. bim. 
 

 
 
The BIM model is organized in a tree-structure: 

file:///D:/BricsCAD%20Training/manuals/02_Defining_your_preferences/02_00_Bricscad_User_Files.htm
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3. Do the following: 

• Click the expand/collapse icon of a node to expand or collapse the node. 

• Right click a node then choose Expand All or Collaspe All  in the context menu to expand 

or collapse all branches.  
If you do this on the drawing name the whole tree structure expands or collapses. 

• Select an entity in the tree. Depending on the selected option in the current configuration 
file, entities are either selected or highlighted in the model. 
e.g. if you click a story, all entities on that story are selected. You can then use 

IsolateObjects ( ) or HideObjects ( ) to isolate or hide the selected story in the model. 

• Right click an entity, then choose Zoom in the context menu, to zoom onto the entities. 

• Select an entity in the model: the entity is selected in the tree. 

• ... 

bricscad-cmdref.chm::/I/IsolateObjects.htm
bricscad-cmdref.chm::/H/HideObjects.htm
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To configure the tree-structure on the Structure panel 

The tree structure on the Structure panel is a hierarchical set of rules. Each rule has a grouping 
property and a sorting property. The structure configurations are saved to *.cst files. By default 
*.cst files are saved in the Support subfolder of the Roamable Root folder (e.g. 
C:\Users\<UserName>\AppData\Roaming\Bricsys\BricsCAD\V17x64\en_US\Support). The name 

of the *. cst configuration file is saved in the drawing through the StructureTreeConfig user 
preference. BricsCAD searches for *.cst configuration files in the folders defined by the SRCHPATH 
configuration variable. 

1. Right click a node, then choose Configure in the context menu. 
The Configure Structure Tree dialog box opens: 
 

 
2. To add a rule, do the following: 

• Select an existing rule, then click the Add icon ( ) or right click and choose Add Rule in 

the context menu. 
The new rule is added below the selected rule. 

• Select the newly created group, then click the name or right click and choose Rename in 
the context menu and type a new name for the rule. 

• Select the Group node of the rule, then click the Add icon ( ) or right click and choose 
Add Grouping Property in the context menu. 
The Select Property dialog box displays. 

file:///D:/BricsCAD%20Training/manuals/02_Defining_your_preferences/02_00_Bricscad_User_Files.htm
bricscad-sysvar.chm::/00_07_Settings_Manager.htm
bricscad-sysvar.chm::/00_07_Settings_Manager.htm
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• Select a property, then double click or click the OK button. 

Optionally, type a search string in the Search field, then click the Up ( ) or Down ( ) 

arrow buttons to look up the properties containing the search string. 

• Repeat the previous step to add more grouping properties. 

• Select the Sort node, then click the Add icon ( ) or right click and choose Add sorting 
property in the context menu. 
The Select Property dialog box displays. 

• Select a property, then double click or click the OK button. 

Optionally, type a search string in the Search field, then click the Up ( ) or Down ( ) 
arrow buttons to look up the properties containing the search string. 

• Repeat the previous step to add more grouping properties. 

3. Click the Show/Skip tab: 
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Select an option and the select the entity types to show or to exclude. 

3. Click the Options tab: 
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• Choose what happens in the model when entities are selected in the structure tree: 

 

 
• Select what happens in the structure tree when an entity is selected / deselected in the 

model: 
 

 

4. (option) To move an item in the tree: select the item, then click the Move Up ( ) or Move 

Down ( ) button. 
5. Do one of the following: 

• Click the OK button to save the configuration and close the dialog box. 

• Click the File menu on the dialog box and choose an option: 
 

 
 
Open...: opens a file dialog to select another *.cst configuration file. 

Save: save the current configuration  and keep the file dialog open. 

Save As...: save the current configuration under a different name and keep the file dialog 
open. 
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Rearranging Entities 

Draw Order 

Commands: DRAWORDER, HATCHTOBACK, TEXTTOFRONT 

If new entities overlap existing entities, they will display and print on top of the previously drawn 
entities. The Draw Order tool can change the order in which overlapping entities are displayed and 
printed. You can move entities to the front or the back, or above or under another entity. 

Using Draw Order 

1. Do one of the following: 

• Click the Draw Order  tool button ( ) on the Draw Order toolbar. 

• Choose Draw Order in the Tools menu. 

• Type draworder in the command bar. 

You are prompted: Select entities to change the draw order: 

2. Select the entities, then right click or press enter. 
You are prompted: Change draw order: Above/Under/Clear/Front/<Back>: 

3. Choose the appropriate draw order tool option. 
4. Depending on your choice: 

• If you have chosen Above or Under, the command bar reads: Select reference entity: 
Identify the reference entity. The display of the selection set is changed with respect to 

the reference entity. 

• If you have chosen Front or Back, the display of the selection set is changed 
accordingly. 

Using Draw Order tools 

1. Select the entities you want to change the draw order of. 
2. Do one of the following.  

• Click the appropriate tool button on the Draw Order toolbar. 

• Right click, then choose Draw Order in the context menu and select the appropriate 
tool. 

 

 

  

bricscad-cmdref.chm::/D/DrawOrder.htm
bricscad-cmdref.chm::/H/HatchToBack.htm
bricscad-cmdref.chm::/T/TextToFront.htm
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Tool 

Button 
Tool Name Description 

 

Bring To Front Places the selection set on top. 

 

Bring Above Places the selection set above the reference entity. (*) 

 

Send Under Places the selection set under the reference entity. (*) 

 

Send to Back Moves the selection set to the back. 

 

Hatch to Back Sends all hatch entities to the back. 

 

Text and 
Dimensions to 
Front 

Brings all texts and/or dimension entities to front. 

Options: Text / Dimensions / Both can be chosen either in the 
command bar or in the prompt menu. The default option is Both. 

(*) You are prompted to select the reference entity. 

Manipulator 

Command: MANIPULATE 

The manipulator is a versatile grip tool to swiftly move, rotate, scale and mirror selected entities. 
Holding down the Ctrl-key when starting the action keeps the original entities, thus creating a 
copy. Upon selecting an entity, the manipulator is displayed at a user-controlled location and 

orientation. The location and orientation are controlled in a similar way as for a dynamic UCS. 
When multiple entities are selected simultaneously, the manipulator initially is placed at their 
geometric center. When a selection is built up step by step, the initial location of the manipulator is 
preserved. The manipulator can easily and directly be dragged to any desired location or 
orientation using its handles. 

Depending on the operation type and if dynamic dimensions are active, a dynamic entry field is 
available to set the distance, angle or scale factor. 

When the current view is parallel to one of the main axes of the coordinate system, as in a plan 
view, the manipulator is simplified to a 2D version. 

The manipulator settings 

To display the manipulator settings in the Settings dialog: 

1. Right click the manipulator. 

2. Choose Manipulator Settings in the context menu. 
 

 
  

bricscad-cmdref.chm::/M/Manipulate.htm
bricscad-cmdref.chm::/M/Manipulate.htm#MoveAlongAxis
bricscad-cmdref.chm::/M/Manipulate.htm#Rotate
bricscad-cmdref.chm::/M/Manipulate.htm#3dScale
bricscad-cmdref.chm::/M/Manipulate.htm#3dMirror
file:///D:/BricsCAD%20Training/manuals/03_Drawing_Accurately/03_11_Dynamic_Dimensions.htm
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Name Description 

Manipulator Controls the display of the manipulator widget. 

0: The manipulator is not displayed. 

1: Display the manipulator whenever entities are selected. 

2: Display the manipulator is the left mouse button was pressed longer than the 

current value of MANIPULATORDURATION. 

Manipulator 

duration 
Specifies how long the left mouse button should be pressed during entity 

selection to trigger the display of the manipulator. The value is expressed in 
milliseconds. 

Size of 
manipulator 

Specifies the size of the manipulator relative to the default. Values between 0.5 
and 2.0 are accepted. 

To control the location and orientation of the manipulator 

The initial location and orientation of the 3D manipulator tripod depends on: 

• The selected entity type 

• The point the entity is selected with 
 

Entity Type Selection point Manipulator 

Anchor point Orientation 

Line Near endpoint At endpoint X-axis through the other 

endpoint 

Near midpoint At midpoint X-axis through the nearest 

endpoint 

Polyline 
Line Segment 

Near vertex At vertex X-axis through the other 
vertex of the selected line 
segment 

Near segment 

midpoint 

At the segment midpoint X-axis through the nearest 

vertex 

Polyline  

Arc Segment 

On the arc 

segment 

At the arc center X-axis through the nearest 

vertex 

Arc Random At the arc center X-axis through the nearest 
endpoint 

Circle Random At the circle center X-axis Parallel with the X-
axis of the current 

coordinate system 

Spline Random At the nearest endpoint Through the other endpoint 

Region On a line 
segment 

At the nearest endpoint of 
the line segment 

X-axis through the other 
endpoint 
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On a arc segment At the center of the arc 
segment 

X-axis through the nearest 
endpoint of the arc segment 

Text, MText 

Block, Xref 

Random At the origin of the entity X-axis at the rotation angle 

of the entity. 

3D Solid* 
3D Solid Face* 

On a face of the 
solid 

At the nearest vertex X-axis along the nearest 
edge 

XY-plane in the selected 
face. 

Multiple Entities  Random At the geometric center of 

the selection set** 

Parallel with the axes of the 

current coordinate system 

* See Selection Modes to learn how to select a 3D solid face or the entire solid. 

** The position of the manipulator does not change when more entities are added to the selection 
set. 

 

To display the manipulator when multiple entities are selected 

Do one of the following: 

• Select the entities one by one or use window selection, then click to select the last entity 

• Set the value of the MANIPULATOR system variable to 1: Display the manipulator 
whenever entities are selected. 

• Compose the selection set, then launch the MANIPULATE command.  
 

The manipulator layout 

  

Default Manipulator Classic Manipulator 

  

4 handles: 1 anchor handle (1) and 3 axis handles (2). 

12 command trigger zones: 3 axes (3), 3 arrowheads (4), 3 plane swatches (5) and 3 rotation arcs 
(6) 

To move the manipulator 

Do one of the following: 

• Drag the manipulator by its anchor handle (1). Specify the new location using entity snaps. 
The anchor handle stands out to avoid overlap with entity grips. 

• Place the cursor over the manipulator then right click and choose Move in the context 
menu. Specify the new location using entity snaps 

To rotate the manipulator 

Drag one of its axis handles (2) to rotate the manipulator. Pick a point or type a value in the 
dynamic entry field to specify the rotation angle. 

bricscad-cmdref.chm::/M/Manipulate.htm
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To reorient the manipulator 

1. Place the cursor over the manipulator, then right click and choose Reorient in the context 
menu. 
You are prompted: Specify origin of manipulator:  

2. Pick a point. 

The anchor point of the manipulator is placed at the specified point. 
You are prompted: Point on X-axis or <Accept>: 

3. Pick a point. 
The manipulator rotates about its X-axis. 

You are prompted: Point on the XY-plane with positive Y value or <Accept>: 

4. Pick a point to define new position of the manipulator. 

To align the manipulator with a coordinate system 

Move the cursor over the manipulator, then right click and select an option in the context menu: 

• Align with WCS: the manipulator axes are forced parallel with the corresponding axes of 
the World Coordinate System 

• Align with UCS: if a UCS is currently the active coordinate system, the manipulator axes 
are forced parallel with the corresponding axes of the UCS. 

To align the manipulator with the face of a solid 

1. Place the cursor over the manipulator then right click and choose Move in the context 
menu. 

2. Hover over the face of a solid. 
The XY-plane of the manipulator aligns with the solid face under the cursor. 

3. Do one of the following: 

4. Snap to a point on the selected face or on one of its edges. 

5. Hit the Shift-key to lock the XY-plane to the selected face, then snap to a point outside 

the face. 
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Moving Entities 

Commands: MOVE, CUTCLIP, PASTECLIP, PASTEORIG and PASTEBLOCK 

The Move command moves entities in the drawing. 

The Cutclip  command copies entities to the Clipboard, and then erases them from the drawing. 

The Pasteclip command pastes entities from the Clipboard into the current drawing (short for 

"paste clipboard"). 

The Pasteorig command pastes entities from the Clipboard into another drawing, using the 
coordinates of the source drawing. 

The Pasteblock command pastes entities from the Clipboard as a block into the current drawing. 

Use Cutclip  then either Pasteclip, Pasteorig or Pasteblock to move entities to another drawing. 

The Copy option of the Grips Editing commands allows to create multiple copies of the entities 
being stretched, moved, rotated, mirrored or scaled. 

  

NOTE When DRAGSNAP is ON, dragged entities display at the current entity snap location. 

Moving entities in a drawing 

The default method is to create a selection set and then specify a starting point (base point0 and 
an endpoint (displacement point) to define the relocation of the entities. You can also move the 
entities using a direction vector. 

Some entities can be moved using grips. The grip you select depends on the type of entity. For 

example, to move a line entity, select the midpoint grip. To move a curved entity, such as an arc, 
circle, or ellipse, select the center point grip. Not all entities can be moved using grips. 

1. Do one of the following:  

• Click the Move tool button ( ) on the Modify toolbar.  

• Choose Move in the Modify menu.  

• Type move or M in the command bar.  

You are prompted: Select entities to move: 

2. Select the entities, then right click or press Enter. 
You are prompted: Vector/<Base point>:  

3. Specify the base point. 

The selection set is now attached to the cross hairs. 
You are prompted: Displacement point.  

4. Do one of the following to specify the displacement point.  

• Click the displacement point.  

• Use Direct Distance Entry: type the displacement distance, then press Enter. 

The distance is measured in the cursor direction.  
Use ORTHO or POLAR TRACKING to constrain the movement of the cross hairs.  

The selection set is moved. 

Moving Entities Using Grips 

1. Select the entity.  
2. Click the grip. 

The selected grip displays in the Selected Grip Color (defined by the GRIPHOT system 
variable, default = RED). 
The entity moves with the cross hairs. 

bricscad-cmdref.chm::/M/Move.htm
bricscad-cmdref.chm::/C/CutClip.htm
bricscad-cmdref.chm::/P/PasteClip.htm
bricscad-cmdref.chm::/P/PasteOrig.htm
bricscad-cmdref.chm::/P/PasteBlock.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/11_10_00_Grips_editing.htm%23GripsEditOptions
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/11_10_00_Grips_editing.htm
file:///D:/BricsCAD%20Training/manuals/03_Drawing_Accurately/03_03_Entity_Snaps.htm%23DragSnap
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/01_Selecting_Entities/11_01_01_Selection_Methods.htm%23Composing_a_selection_set_afterwards__post_pick_
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3. Click to relocate the entity.  

  

NOTE The following entities can be moved using grips: 

• lines, infinite lines and rays 

• circles and circular arcs 

• ellipses and elliptical arcs 

• 3D solids 

• text and multi-line text 

• blocks 

Moving entities between drawings 

Entities can be moved between drawings in one of three ways: 

Use CUTCLIP  to cut the entities from the source drawing, then either PASTECLIP, PASTEORIG or 

PASTEBLOCK to paste the entities into the target drawing. 

  

NOTE Use Ctrl + Tab (press and hold the Ctrl key, then press the Tab key) to cycle between 

open drawings. 

 

1. Do one of the following:  

• Right click, then choose Cut in the context menu.  

• Choose Cut in the Edit menu.  

• Press Ctrl + X (press and hold the Ctrl key, then press X).  

The entities are deleted in the source drawing and copied to the Clipboard. 

3. Switch to the target drawing.  
4. Do one of the following:  

• Right click, then choose Paste in the context menu.  

• Choose Paste in the Edit menu.  

• Press Ctrl + V (press and hold the Ctrl key, then press V).  

The bottom left corner of the bounding rectangle of the selection is attached to the cross hairs in 
the target drawing. 
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5. Do one of the following:  

• Specify the displacement point.  

• Press Enter or choose Paste to Original Coordinates in the Edit menu 
to paste the selection set using the coordinates of the source drawing.  

  

NOTE If you choose Undo in the Edit menu in the source drawing, the deletion of the selection 

set is undone. 

 

Move a Selection as a Block 

1. In the source drawing, select the entities you want to move.  
2. Do one of the following:  

• Right click, then choose Cut in the context menu.  

• Choose Cut in the Edit menu.  

• Press Ctrl + X (press and hold the Ctrl key, then press X).  

The entities are deleted in the source drawing and copied to the Clipboard. 

3. (option) Switch to the target drawing.  
4. Choose Paste as a Block in the Edit menu or press Ctrl+Shfit+V. 

The bottom left corner of the bounding rectangle of the selection is attached to the cross 
hairs in the target drawing.  

5. Specify the insertion point. 

Rotating Entities 

You can rotate entities about a specified point at a specified rotation angle or by an angle 

referenced to a base angle. The default method rotates the entities using a relative rotation angle 
from their current orientation. 

By default, angles start at 3 o'clock and increase in a counter-clockwise direction. If you want to 
rotate in a clockwise direction you can enter a negative angle by using a minus sign. 

 

  

NOTES • The Angular Base is controlled by the ANGBASE system variable, which in turn 
refers to the current UCS. 

• The Angle Direction is controlled by the ANGDIR system variable, which sets the 
positive angle direction from angle 0 with respect to the current UCS. 

  

The Copy option of the Grips Editing commands allows to create multiple copies of the entities 
being stretched, moved, rotated, mirrored or scaled. 

Rotating a Selection Set 

1. Do one of the following:  

• Click the Rotate tool button ( ) on the Modify toolbar.  

• Choose Rotate in the Modify menu.  

• Type rotate or RO in the command bar.  

You are prompted: Select entities to rotate: 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/01_Selecting_Entities/11_01_01_Selection_Methods.htm%23Composing_a_selection_set_before__pre_pick_
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/11_10_00_Grips_editing.htm%23GripsEditOptions
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2. Select the entities, then right click or press Enter. 

You are prompted: Rotation point:  
3. Specify the rotation point. 

You are prompted: Copy/Base angle/<Rotation angle>: 
A prompt menu displays: 
 

 
4. (option) Choose Copy in the prompt menu or type C, then press Enter to create a rotated 

copy of the selection set.  
5. Specify the rotation angle. 

The selection set is rotated.  

  

NOTE Use the Center option of the Array command if you want to keep the original entities. 

 

Rotating a Selection Set in Reference to a Base Angle 

1. Do one of the following:  

• Click the Rotate tool button ( ) on the Modify toolbar.  

• Choose Rotate in the Modify menu.  

• Type rotate or RO in the command bar.  

You are prompted: Select entities to rotate: 

2. Select the entities, then right click or press Enter. 
You are prompted: Rotation point:  

3. Specify the rotation point. 
You are prompted: Copy/Base angle/<Rotation angle>: 

A prompt menu displays: 
 

 
4. (option) Choose Copy in the prompt menu or type C, then press Enter to create a rotated 

copy of the selection set.  

5. Do one of the following:  

• Choose Base angle in the prompt menu.  

• Type B in the command bar, then press Enter.  

You are prompted: Base angle <0>: 

6. To specify the base angle do one of the following:  

• Type the base angle in the command bar.  

• Click the rotation point again, then click a second point.  

You are prompted: New Angle. 

7. Do one of the following:  

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/01_Selecting_Entities/11_01_01_Selection_Methods.htm%23Composing_a_selection_set_afterwards__post_pick_
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• Type the new angle in the command bar.  

• Click a point to define the new angle.  

Rotating in 3D 

1. Do one of the following.  

• Click the 3D Rotate tool button ( ) on the Modify toolbar.  

• Choose 3D Rotate in the Modify menu.  

• Type rotate3d in the command bar.  

You are prompted: Select entities to rotate: 

2. Select the entities, then right click or press Enter. 
You are prompted: Select axis by [Entity/Last/View/Xaxis/Yaxis/Zaxis/2points] <2points>:  

3. Press Enter to define the rotation axis by specifying two points.  
4. Specify the first rotation axis point.  
5. Specify the second rotation axis point. 

You are prompted: Rotation angle or [Base angle/Copy]:  

6. Specify the rotation angle. 
The selection set is rotated clockwise, looking in the rotation axis direction. 

Mirroring Entities 

The Mirror command creates a mirror image of a selection set. The selection is mirrored about a 
mirror line, which you define by specifying two points. You can choose to either delete or retain the 
original entities. 

The Mirror3d commands creates a mirror image of selected entities in three-dimensional space. In 

this case the selection is mirrored about a mirror plan, which can be defined by either specifying 

three points, selecting an existing two-dimensional planar entity, aligning the plane parallel to the 
xy, yz, or xz plane of the current UCS or aligning the plane with the current view. You can choose 
to either delete or retain the original entities. 

The Copy option of the Grips Editing commands allows to create multiple copies of the entities 
being stretched, moved, rotated, mirrored or scaled. 

  

NOTE Whether text is mirrored or not by the Mirror command is controlled by the Mirror Text 
(MIRRTEXT) system variable. 

 

Mirroring Entities about a Line 

1. Do one of the following:  

• Click the Mirror tool button ( ) on the Modify toolbar.  

• Choose Mirror in the Modify menu.  

• Type mirror or MI in the command bar.  

You are prompted: Select entities to mirror: 

2. Select the entities then right click or press Enter. 
You are prompted: Start of mirror line.  

3. Specify the start point of the mirror line.  
4. Specify the endpoint of the mirror line. 

You are prompted: Delete the original entities? <N>  

5. Do one of the following:  

• Press Enter to keep the original entities.  

• Type Y, then press Enter to delete the original entities.  
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• Choose Yes-Delete entities in the context menu.  

Mirroring Entities about a Plane 

1. Do one of the following:  

• Click the 3D Mirror tool button ( ) on the Modify toolbar.  

• Choose 3D Mirror in the Modify menu.  

• Type mirror3d  in the command bar.  

You are prompted: Select entities: 

2. Select the entities then right click or press Enter. 
You are prompted: Define mirror plane by: Entity/Last/View/Zaxis/XY/YZ/ZX/<3points>:  

3. Specify the first point of the mirror plane.  

4. Specify the second point of the mirror plane.  
5. Specify the third point of the mirror plane. 

You are prompted: Delete the original entities? <N>  
6. Do one of the following:  

• Press Enter to keep the original entities.  

• Type Y, then press Enter to delete the original entities.  

• Choose Yes-Delete entities in the context menu. 

Aligning Entities 

The Align command lets you reposition a selection set with respect to an existing entity in the 
drawing. The selection set is moved and rotated in a single action. If necessary you can even scale 
the selection to fit in its new location. 

The command can be used both in a 2D and 3D environment.  

  

 

How to Align Entities  

  

Aligning an Entity in 2D 

1. Do one of the following:  

• Click the Align tool button ( ) on the Modify toolbar.  

• Choose Align in the Modify menu.  

• Type align in the command bar, then press Enter.  

You are prompted: Select entities: 

2. Select the entities, then right click or press Enter. 
You are prompted: Specify first source point:  

3. Snap to the first source point in the selection set (1). 
You are prompted: Specify first destination point:  

4. Snap to the first destination point on the reference entity (2). 
A witness line is drawn between the source point and the target point. 
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You are prompted: Specify the second source point: 

 
5. Snap to the second source point in the selection set (3). 

You are prompted: Specify second destination point:  
6. Snap to the second destination point on the reference entity (4). 

A witness line is drawn between the source point and the target point. 
You are prompted: Specify the third source point:  

7. Right click to skip the third source point. 
You are prompted: Scale objects based on alignment points [Yes/No] <No>:  

8. Do one of the following:  

• Press Enter if you don't want to scale the selection set.  

• Type Y and press Enter to scale the selection set.  

 

Result of the Align procedure with scaled selection 
set. 

 

Aligning an Entity in 3D 

1. Do one of the following:  

• Click the Align tool button ( ) on the Modify toolbar.  

• Choose Align in the Modify menu.  

• Type align in the command bar, then press Enter.  

You are prompted: Select entities: 

2. Select the entities, then right click or press Enter. 
You are prompted: Specify first source point:  
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3. Snap to the first source point in the selection set (1). 

You are prompted: Specify first destination point:  
4. Snap to the first destination point on the reference entity (2). 

A witness line is drawn between the source point and the target point. 
You are prompted: Specify the second source point: 

 
5. Snap to the second source point in the selection set (3). 

You are prompted: Specify second destination point:  
6. Snap to the second destination point on the reference entity (4). 

A witness line is drawn between the source point and the target point. 
You are prompted: Specify the third source point:  

7. Snap to the third source point in the selection set (5). 
You are prompted: Specify third destination point:  

8. Snap to the third destination point on the reference entity (6). 
A witness line is drawn between the source point and the target point. 
The entity is moved. 
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Changing Entities 

The Change command lets you change the insertion point and orientation of texts and block 
inserts.  

The Properties option of the command can also change the layer, line type, line type scale, line 
weight, etc. but the BricsCAD Properties bar is much more versatile to do such things. 

To Change Text Entities 

1. Type change in the command bar, then press Enter. 
You are prompted: Select entities to change:  

2. Select the text entities, then right click or press Enter. 
You are prompted: Change: Entities/Properties/<Change point>:  

3. Right click or press Enter to accept the default option. 
You are prompted: New point for text, or Enter for no change: 
The first text entity is attached to the cursor.  

4. Specify the new insertion point for the text or right click to accept the current location. 
You are prompted: New text style <current style>:  

5. Type a new text style and press Enter or right click to keep the current style. 
You are prompted: New height <current height>:  

6. Type a new height and press Enter or right click to keep the current height. 
You are prompted: New rotation angle <current angle>:  

7. Type a new angle and press Enter or right click to keep the current angle. 

You are prompted: New text <current text>:  
8. Type the new text and press Enter or right click to keep the current text.  
9. (option) If multiple text entities were selected in step 2, steps 3 through 8 are repeated for 

each text.   

NOTE The Change command cannot change Multi-Line text (Mtext) entities. 

 

To Relocate Blocks 

1. Type change in the command bar, then press Enter. 
You are prompted: Select entities to change:  

2. Select the blocks, then right click or press Enter. 
You are prompted: Change: Entities/Properties/<Change point>:  

3. Right click or press Enter to accept the default option. 

You are prompted: New point for block, or Enter for no change: 
The first block is attached to the cursor.  

4. Specify the new insertion point or right click to accept the current orientation.  
You are prompted: New rotation angle <current angle>:  

5. Do one of the following:  

• Right click to accept the current rotation angle.  

• Type a new rotation angle in the command bar, then press Enter.  

• Click to specify the new rotation angle graphically.  

6. (option) If multiple blocs were selected in step 2, steps 3 through 5 are repeated for each 
block. 
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Copying Entities 

Copying Entities in a Drawing 

Commands: COPY, COPYCLIP, COPYBASE, PASTECLIP and PASTEBLOCK 

You can duplicate entities within the current drawing using the Copy command. The default 
method is to create a selection set and then specify a starting point (base point) and an endpoint 
(second point) for the copy. You can also specify the displacement as a direction vector (X,Y,Z). 

Depending on the COPYMODE system variable  you can create multiple copies of the selection set 
or just one. 

Copybase and Pasteblock pastes the selection as a block. 

The Copy option of the Grips Editing commands allows to create multiple copies of the entities 
being stretched, moved, rotated, mirrored or scaled. 

To Copy a Selection Set 

1. Do one of the following:  

• Click the Copy tool button ( ) on the Modify toolbar.  

• Choose Copy in the Modify menu.  

• Type copy or CO in the command bar.  

You are prompted: Select entities to copy: 

2. Select the entities, then right click or press Enter. 
If Copy Mode is Multiple: 
You are prompted: Enter base point: mOde/<Displacement>: 
If Copy Mode is Single: 
You are prompted: Enter base point: mOde/Multiple/<Displacement>:  

3. Specify the base point. 

The selection set is now attached to the cross hairs. 
You are prompted: Enter second point: <Enter to use the base point as displacement>:  

4. Do one of the following:  

• Click the second point.  

• Use Direct Distance Entry: type the displacement distance, then press Enter. 
The distance is measured in the cursor direction.  
Use ORTHO or POLAR TRACKING to constrain the movement of the cross hairs.  

• Press <Enter>: the first point is interpreted as a relative X,Y,Z displacement.  
E.g. if the coordinates of the base point are 2,3,0, the selection set is copied 2 units in 
the X direction and 3 units in the Y direction from their current position.  

The selection set is copied. 

If Copy Mode is Single, the copy command is completed. 

If Copy Mode is Multiple, you are prompted to create the next copy. See To make multiple copies. 

  

To Make Multiple Copies 

1. Do one of the following:  

• Click the Copy tool button ( ) on the Modify toolbar.  

• Choose Copy in the Modify menu.  

• Type copy or CO in the command bar.  

You are prompted: Select entities to copy: 

2. Select the entities, then right click or press Enter. 
If Copy Mode is Multiple: 
You are prompted: Enter base point: mOde/<Displacement>: 
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If Copy Mode is Single: 

You are prompted: Enter base point: mOde/Multiple/<Displacement>:  
3. (Option) If Copy Mode is Single, do one of the following:  

• Choose Multiple in the prompt menu  

• Type M, then press Enter  

You are prompted: Enter base point: mOde/<Displacement>: 

4. Specify the base point. 
The selection set is now attached to the cross hairs. 

You are prompted: Enter second point: <Enter to use the base point as displacement>:  
5. Do one of the following to specify the second point.  

• Click the second point.  

• Type the displacement distance, then press Enter. 
The distance is measured in the cursor direction.  
Use ORTHO or POLAR TRACKING to constrain the movement of the cross hairs.  

The first copy of the selection set is created. 

You are prompted: Enter second point: Undo/Repeat/Exit: 

6. (option) Repeat step 5 to create additional copies. 
Right click or press Enter to conclude the command.  

7. (option) Choose the Repeat option. 
You are prompted: Select end point (<ENTER> to key in number of repeats) 
The number of repeats increases when you move the cursor away from the source 

selection set.  

 

Do one of the following: 

• Click when the desired number of copies displays.  

• Press Enter or right click, then type the desired number of copies.  

To Paste a Selection Set as a Block 

1. Do one of the following:  

• Choose Copy with Base Point in the Edit menu.  

• Type copybase in the command bar, then press Enter.  

• Press and hold the Ctrl and Shift keys, then press C.  

You are prompted: Select base point: 
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2. Specify the base point (origin point). 

You are prompted: Select entities to copy to the clipboard:  
3. Select the entities.  
4. Press Enter to conclude the selection of entities.  
5. Do one of the following:  

• Choose Paste as Block in the Edit menu.  

• Type pasteblock in the command bar, then press Enter.  

• Press and hold the Ctrl and Shift keys, then press V.  

The selection set is attached to the cursor. 

The command window reads: Select insertion point. 

6. Specify the insertion point. 

The selection is pasted as a block.  
7. (option) Repeat steps 5 and 6 to paste another copy as a block.  

  

NOTE If you paste multiple copies of the same selection set, each block is named differently. 

 

Copying Entities Between Drawings 

Commands: COPYCLIP, COPYBASE, PASTECLIP, PASTEORIG and PASTEBLOCK 

Entities can be copied between drawings in several ways: 

• Copyclip and Pasteclip pastes the selection using a default base point.  

• Copyclip and Pasteorig pastes the selection using the coordinates of the source 

drawing.  

• Copybase and Pasteclip pastes the selection using a user-defined base point.  

• Copybase and Pasteblock: pastes the selection as a block in the target drawing.  

  

NOTE Use Ctrl + Tab (press and hold the Ctrl key, then press the Tab key) to cycle between 

open drawings. 

  

 

Copy Between Drawings  

  

Using Copy and Paste  

1. In the source drawing, select the entities you want to Copy.  
2. Do one of the following:  

• Right click, then choose Copy in the context menu.  

• Choose Copy in the Edit menu.  

• Press Ctrl + C (press and hold the Ctrl key, then press C).  

The entities are copied to the Clipboard. 

3. Switch to the target drawing.  
4. Do one of the following:  

• Right click, then choose Paste in the context menu.  

• Choose Paste in the Edit menu.  

• Press Ctrl + V (press and hold the Ctrl key, then press V).  
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The bottom left corner of the bounding rectangle of the selection is attached to the cross hairs in 

the target drawing. 

5. Do one of the following:  

• Specify the displacement point.  

• Press Enter to paste the selection set using the coordinates of the source drawing.  

Using Copy and Pasteorig 

1. In the source drawing, select the entities you want to Copy.  
2. Do one of the following:  

• Right click, then choose Copy in the context menu.  

• Choose Copy  in the Edit menu.  

• Press Ctrl + C (press and hold the Ctrl key, then press C).  

The entities are copied to the Clipboard. 

3. Switch to the target drawing.  
4. Do one of the following:  

• Choose Paste to Original Coordinates in the Edit menu.  

• Type pasteorig in the command bar, then press Enter.  

The selection is pasted using the coordinates of the source drawing. 
  

Using Copybase and Paste 

1. In the source drawing do one of the following:  

• Choose Copy with Base Point in the Edit menu.  

• Type copybase in the command bar, then press Enter.  

• Press and hold the Ctrl en Shift keys, then press C.  

You are prompted: Select base point: 

2. Specify the base point (origin point). 
You are prompted: Select entities to copy to the clipboard:  

3. Select the entities.  
4. Press Enter to conclude the selection of entities.  
5. Switch to the target drawing.  

6. Do one of the following:  

• Choose Paste  in the Edit menu.  

• Press Ctrl + V (press and hold the Ctrl key, then press V).  

The selection set is attached to the cursor. 

You are prompted: Select insertion point: 

7. Specify the insertion point to paste the selection set.  
8. (option) Repeat step 7 to create more copies of the selection set.  
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Paste as a Block 

1. In the source drawing do one of the following:  

• Choose Copy with Base Point in the Edit menu.  

• Type copybase in the command bar, then press Enter.  

• Press and hold the Ctrl en Shift keys, then press C.  

You are prompted: Select base point: 

2. Specify the base point (origin point). 
You are prompted: Select entities to copy to the clipboard:  

3. Select the entities.  
4. Press Enter to conclude the selection of entities.  
5. Switch to the target drawing.  

6. Do one of the following:  

• Choose Paste as Block in the Edit menu.  

• Type pasteblock in the command bar, then press Enter.  

• Press and hold the Ctrl and Shift keys, then press V.  

The selection set is attached to the cursor. 

The command window reads: Select insertion point. 

6. Specify the insertion point. 
The selection is pasted as a block.  

7. (option) Repeat steps 5 and 6 to paste another copy as a block.  

NOTE If you paste multiple copies of the same selection set, each block is named differently. 

 

Making Parallel Copies 

Command: OFFSET 

The Offset command creates a copy of linear entities and aligns them parallel to the original 

entities at a specified distance. You can make parallel copies of arcs, circles, ellipses, elliptical arcs, 
lines, two-dimensional polylines, rays and infinite lines.  

Depending on the selected options in the Selection Modes toolbar, the Offset command allows to 
create a parallel copy of: 

• an edge of a 3D solid if the Select Edges option ( ) is set. 

• the edges of a 3D solid face if the Select Faces option ( ) is set. 

• detected boundaries if the Select Detected Boundaries option ( ) is set. 
Making parallel copies of curved entities creates larger or smaller curves, depending on which side 
of the original entity you place the copy. For example, placing a parallel copy of a circle outside the 
circle creates a larger concentric circle; positioning the copy inside the circle creates a smaller 
concentric circle. 

  

NOTE The OFFSETGAPTYPE settings variable controls how potential gaps between segments are 
treated when closed polylines are offset. 

Making a parallel copy at a specified distance 

1. Do one of the following: 

• Click the Offset tool button ( ) on the Modify toolbar. 

• Choose Offset in the Modify menu. 

• Type offset in the command bar. 

bricscad-cmdref.chm::/O/Offset.htm
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You are prompted: Offset: Through point/Erase/<Distance> <current distance>: 

 
A prompt menu displays: 
 

 

2. (Option) Choose Erase in the prompt menu or type E, then press Enter. 
Respond Yes at the command prompt to erase the source entity. 

3. Do one of the following: 

• Press Enter to accept the current distance. 

• Type a new distance in the command bar. 

• Define a new distance by specifying two points. 

You are prompted: Select Entity. 

4. Select the entity. 
You are prompted: Both sides/<Side for parallel copy>: 

5. Click the side for the parallel copy. 
The parallel copy is created. 
You are prompted: Select Entity. 

6. Do one of the following: 

• Repeat steps 4 and 5 to create more parallel copies. 

• Right click or press Enter to stop. 

Making a parallel copy through a point 

1. Do one of the following: 

• Click the Offset tool button ( ) on the Modify toolbar. 

• Choose Offset in the Modify menu. 

• Type offset in the command bar. 

You are prompted: Offset: Through point/<Distance> <current distance>: 

2. Choose Through point in the context menu or type T, then press Enter. 

You are prompted: Select entity: 

3. Select the entity. 
You are prompted: Through point: 

4. Specify the point to create the parallel copy through. 
The parallel copy is created. 
You are prompted: Select entity: 

5. Do one of the following. 

• Repeat steps 3 and 4 to create more parallel copies. 

• Right click or press Enter to stop. 
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Making a parallel copy of a 3D solid edge 

Make sure the Quad is active and the Select edges button ( ) in the Selection Modes toolbar is 
pressed. 

1. Move the cursor over the edge of the solid. 

When the edge highlights, choose Parallel ( ) in either the 2D Editing or the Direct 
Modeling command group in the Quad. 

The parallel copy is created dynamically. 

2. Do one of the following: 

3. Type a distance in the dynamic entry field. 

4. Snap to a point. 

Making a parallel copy a 3D solid face 

Make sure the Quad is active and the Select Faces button ( ) in the Selection Modes toolbar is 
pressed. 

1. Move the cursor over the face of the solid. 

When the face highlights, choose Parallel ( ) in either the 2D Editing or the Direct 
Modeling command group in the Quad. 
The parallel copy is created dynamically. 

2. Do one of the following: 

3. Type² a distance in the dynamic entry field. 

4. Snap to a point. 

Making a parallel copy of a detected boundary 

Make sure the Quad is active and the Select Detected Boundaries button ( ) in the Selection 
Modes toolbar is pressed. 

1. Move the cursor inside the boundary. 

When the boundary highlights, choose Parallel ( ) in either the 2D Editing or the Direct 
Modeling command group in the Quad. 
The parallel copy is created dynamically. 

2. Do one of the following: 

3. Type a distance in the dynamic entry field. 

4. Snap to a point. 

Arraying Entities 

Commands: ARRAY , -ARRAY, ARRAYCLASSIC, ARRAYRECT, ARRAYPATH, ARRAYPOLAR, 
ARRAYEDIT, 3DARRAY 

The Array commands copy a selection set in a rectangular or polar (circular) pattern or along a 
linear entity. For a rectangular array you must specify the number of rows and columns and also 

the spacing between subsequent rows and columns. To create a polar array you will be prompted 
to specify the center point of the array, the rotation step and the number of items in the array or 

the angle to fill. You can choose to rotate the selection set about the center point or to keep its 
original orientation. 

  

The ArrayClassic command creates a static polar or rectangular array of entities through a dialog 
box. 

The -Array command creates a static polar or rectangular array of entities. 

The 3DArray command constructs static 3D rectangular arrays and rotated polar arrays  

  

The Array command distributes entity copies in an evenly spaced associative rectangular, polar or 
path array. 

The ArrayRect command associatively distributes entity copies into any number of rows, columns, 

and levels. 

The ArrayPolar command associatively distributes entity copies evenly in a circular pattern about a 
center point or axis of rotation,  using multiple rows, and levels. 
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The ArrayPath command associatively distributes entity copies evenly along a path into multiple 

rows, and levels. 

The ArrayEdit command allows editing associative arrays and their source entities. 

Creating a Rectangular Array 

1. Type arrayclassic in the command bar, then press Enter.  

A dialog box displays: 

  

 

2. Under Array Type choose Rectangular.  

3. Click the Select Entities button ( ). 
The Array dialog box closes temporarily to let you select entities.  

4. Select the entities, then right click or press Enter. 
The Array dialog box reopens.  

5. Fill out the Settings fields or press the Pick Points buttons ( ) to define the settings 
graphically. 
The Array dialog box closes temporarily to let you pick point in the drawing. 
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Row offset (A) and column offset (B) can be defined by the spacing rectangle 
(red). 

6. Click the OK button to create the array.  

  

  

NOTE Positive values in steps 4 and 5 are measured along the positive X- and Y-axis of the 

current UCS. Negative values are measured in the opposite direction. 
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Creating a Polar Array 

1. Type arrayclassic in the command bar, then press Enter.  

A dialog box displays: 

  

 

2. Under Array Type choose Polar.  

3. Click the Select Entities button ( ). 
The Array dialog box closes temporarily to let you select entities.  

4. Select the entities, then right click or press Enter. 
The Array dialog box reopens.  

5. Choose a Calculate option: Angle between, Angle to fill or Number of items. 
The settings field of the selected option is dimmed.  

6. Fill out the Settings fields or press the Pick Points buttons ( ) to define the settings 
graphically. 

The Array dialog box closes temporarily to let you pick point in the drawing.  

7. (option) Check the Rotate items as copied option. 
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Entities rotated (left) or not (right) about the center point of the array. 

8. (option) Define an Entity base point. 

 
  

 

Polar array with base point (dot) and center point (cross). 

 

Creating a 3D Rectangular Array 

1. Do one of the following:  

• Click the 3D Array tool button ( ) on the Modify toolbar.  

• Choose 3D Array in the Modify menu.  

• Type 3darray in the command bar, then press Enter.  

You are prompted: Select entities to array: 

3. Select the entities, then right click or press Enter. 
You are prompted: Type of array: Polar/<Rectangular>:  

4. Choose Rectangular in the prompt menu or type R in the command bar and press Enter.  

You are prompted: Number of rows in the array <1>: 

4. Type the number of rows in the command bar, then press Enter. 
You are prompted: Number of columns <1>:  

5. Type the number of columns in the command bar, then press Enter. 

You are prompted: Number of levels <1>:  
6. Type the number of levels in de command bar, then press Enter. 

You are prompted: Vertical distance between rows:  
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7. To define the distance between rows of the array, do one of the following:  

• Type the distance in the command bar and press Enter.  

• Specify the distance by clicking two points.  

You are prompted: Horizontal distance between columns: 

8. To define the distance between the columns of the array, do one of the following:  

• Type the distance in the command bar and press Enter.  

• Specify the distance by clicking two points.  

You are prompted: Depth between levels: 

9. To define the distance between the levels of the array, do one of the following:  

• Type the distance in the command bar and press Enter.  

• Specify the distance by clicking two points.  

The array is created. 

 

Rectangular 3D Array:row spacing A, column 

spacing B, level spacing C 

  

NOTE Positive values in steps 7, 8 and 9 are measured along the positive X-, Y- and Z-axis of 
the current UCS. Negative values are measured in the opposite direction. 

 

Creating a 3D Polar Array 

1. Do one of the following:  

• Click the 3D Array tool button ( ) on the Modify toolbar.  

• Choose 3D Array in the Modify menu.  

• Type 3darray in the command bar, then press Enter.  
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You are prompted: Select entities to array: 

3. Select the entities, then right click or press Enter. 
You are prompted: Type of array: Polar/<Rectangular>:  

4. Choose Polar in the prompt menu or type P in the command bar and press Enter.  

You are prompted: ENTER to specify angle between items/<Number of items to array>: 

4. Type the number of items you want in the array, then press Enter. 
You are prompted: Angle to array (+ for ccw, - for cw) <360>:  

5. Do one of the following:  

• Type the angle to array, then press Enter.  

• Press Enter to create a 360° array.  

You are prompted: Rotate entities around the array? No/<Yes> 

6. Do one of the following:  

• Press Enter to rotate the entities about the array axis.  

• Type N and press Enter to keep the original orientation of the entities.  

You are prompted: Center of polar array. 

7. Specify the first point of the array axis. 
You are prompted: Specify second point along central axis of array:  

8. Specify the second point of the array axis. 

The array is created.  

 

Polar 3D array about a horizontal axis (red). 
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Resizing Entities 

Extending Entities 

Command: EXTEND and TRIM 

The Extend command lets you extend entities to a boundary, which is defined by one or more 
other entities.  

If the Edge Mode setting (EDGEMODE) is On, you can extend entities to an implied edge of the 
boundary entities. 

If the boundary entity is not in the same plane as the entity you want to extend, the Projection 
Mode setting (PROJMODE) lets you choose how the intersection is to be calculated. The options 

are: 

• Project to the XY plane of the current UCS 

• Project to the current view plane 

• True 3D mode (No projection). 
When extending entities, first select the boundary edges, and then specify the entities to extend, 
selecting them either one by one or using the fence selection method. 

The following entities can be extended: arcs, lines, two-dimensional polylines, rays. 

Boundary entities can be: arcs, circles, ellipses, lines, splines, polylines, rays, infinite lines, layout 

viewports. 

To extend entities 

1. Do one of the following: 

• Click the Extend tool button ( ) on the Extend/Stretch flyout of Modify toolbar. 

• Choose Extend in the Modify menu. 

• Type extend or EX in the command bar, then press Enter. 

You are prompted: Select boundary entities for extend <ENTER to select all>: 

2. Select the boundary entities, then press Enter or right click. 
You are prompted: Fence/Crossing/Edge mode/Projection/eRase/Undo/<Select entity to 

extend or shift-select to trim>: 
A prompt menu displays. 
 

 
3. Click the entity you want to extend near the end that can make the extension. 

The entity is extended. 
or 
Press and hold the shift key to trim the entity. 

4. Repeat step 3 to extend more entities. 

5. Right click or press Enter to conclude the Extend command. 

  

NOTES • Entities which are selected when you launch the Extend command will be used 

as boundary entities. 

• If you select an entity near the end that cannot make an extension to one of the 
boundary entities, the Extend command is aborted. 

bricscad-cmdref.chm::/E/Extend.htm
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Trimming Entities 

Command: TRIM and EXTEND 

The Trim command lets you clip or trim entities by cutting entities. 

If the Edge Mode (EDGEMODE)  system variable is On, you can trim entities by an implied edge of 

the cutting entities. 

If the cutting entity is not in the same plane as the entity you want to trim, the Projection Mode 
(PROJMODE) system variablele defines how the intersection is to be calculated. The options are: 

• Project to the XY plane of the current UCS 

• Project to the current view plane 

• True 3D mode (No projection). 
When trimming entities, you first select the cutting edges, and then specify the entities to trim, 

selecting them either one by one or using the fence selection method. 

The following entities can be trimmed: lines, two- and three dimensional polylines, arcs, circles, 
ellipses, elliptical arcs, splines, rays and infinite lines. 

Cutting entities can be: lines, splines, polylines, arcs, circles, elliptical arcs, ellipses, rays, infinite 
lines, layout viewports. 

Entities in a block can be selected as cutting entities. 

To trim entities 

1. Do one of the following: 

• Click the Trim tool button ( ) on the Modify toolbar. 

• Choose Trim in the Modify menu. 

• Type trim or TR in the command bar, then press Enter. 

You are prompted: Select cutting entities for trim <ENTER to select all>: 

2. Select the cutting entities, then press Enter or right click. 
You are prompted: Fence/Crossing/Edge mode/Projection/eRase/Undo<Select entity to 
trim or shift-select to extend>: 
A prompt menu displays. 

 

 
3. Click the entity you want to trim, the part of the entity that you click will be removed. 

The entity is trimmed. 
or 
Press and hold the shift key to extend the entity. 

4. Repeat step 3 to trim more entities. 
5. Right click to conclude the Trim command. 

  

NOTES Entities which are selected when you launch the Trim command will be used as cutting 

entities. 
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Changing the Length of an Entity 

The Lengthen command lets you change the length of lines, open polylines and arcs. You can also 
modify the included angle of arcs. 

1. Do one of the following:  

• Click the Lengthen tool button ( ) on the Modify toolbar.  

• Choose Lengthen  in the Modify menu.  

• Type lengthen in the command bar, then press Enter.  

You are prompted: Edit length: DYnamic/Increment/Percent/Total/<Select entity to list length>: 

A prompt menu displays: 

 

2. (option) Click an entity. 
The current length of the selected entity displays in the command bar. 
In case an arc is selected, the current length and the included angle display in the 

command bar.  
3. Do one of the following:  

• Choose Dynamic in the prompt box.  

• Type DY in the command bar, then press Enter.  

You are prompted: Mode/<Select entity to change>: 

4) Click the entity near the end you want to change. 
The length of the entity changes dynamically.  

5) Click to define the new length.  

To Modify the Included Angle of an Arc 

1. Do one of the following:  

• Click the Edit Length tool button ( ) on the Modify toolbar.  

• Choose Edit Length in the Modify menu.  

• Type editlen in the command bar, then press Enter.  

You are prompted: Edit length: DYnamic/Increment/Percent/Total/<Select entity to list length>: 

2. Choose Total in the prompt menu or type T and press Enter. 
You are prompted: Angle/<Enter total Length (0.00)>: 
A prompt menu displays: 
 

 
3. Choose Angle in the prompt menu or type A and press Enter. 

You are prompted: Enter total angle <00° 0' 0">:  
4. Type the new angle in the command bar and press Enter. 

You are prompted: Mode/<Select entity to change>: 
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A prompt menu displays: 

 

 
5. Click the arc at the end you want to lengthen or shorten. 

The arc is modified. 
You are prompted: Mode/Undo/<Select entity to change>: 
A prompt menu displays: 
 

 
6. Do one of the following:  

• Select another arc.  

• Choose Undo in the prompt menu or type U and press Enter to undo the previous 
action.  

• Choose Edit mode in the prompt menu or type M and press Enter to choose a different 
Edit Length command option.  

• Choose Cancel in the prompt menu to conclude the Edit Length command.  

  

NOTE In the Properties bar you can edit the start angle, end angle and radius of an arc. 

 

Stretching Entities 

The size and shape of entities can be changed by stretching them. You select an area in your 
drawing using either a rectangular window or a polygon, then you specify a base point and a 
displacement point. All points and nodes inside the selected area will be moved over the specified 
distance. As a result, entities that cross the window or polygon boundary are stretched; those 
completely within the window or polygon are simply moved. 

The Copy option of the Grips Editing commands allows to create multiple copies of the entities 
being stretched, moved, rotated, mirrored or scaled. 

1. Do one of the following:  

• Click the Stretch tool button ( ) on the Extend/Stretch flyout of the Modify toolbar.  

• Choose Stretch in the Modify menu.  

• Type stretch or S in the command bar and press Enter.  

You are prompted: Select entities to stretch by crossing-window or crossing-polygon: 

A prompt menu displays: 

 

2. (option) Choose Crossing window in the Stretch prompt menu, then define the stretch area 
by a rectangular window.  
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3. (option) Choose Crossing polygon in the Stretch prompt menu, then define the stretch 

area by a polygon.  
4. (option) Repeat steps 2 and 3 to expand the stretch area.  
5. (option) Choose Remove in the Stretch prompt menu to select entities in the stretch area 

that must not be stretched.  
6. (option) Choose Add in the Stretch prompt menu to add previously remove entities to the 

selection of entities that must be stretched.  
7. Right click to conclude the selection of entities. 

You are prompted: Base point of displacement.  
8. Specify the base point. 

The selection stretches dynamically. 
You are prompted: Second point of displacement.  

9. Do one of the following to specify the second displacement point.  

• Click the displacement point.  

• Use Direct Distance Entry: type the displacement distance, then press Enter. 
The distance is measured in the cursor direction.  
Use ORTHO or POLAR TRACKING to constrain the movement of the cross hairs.  

The selection is stretched. 
  

NOTES To add or remove entities from the selection set in steps 5 and 6 you can use any 
selection method: picking, window inside or crossing window. 

 

Stretching Entities using Grips 

Click the entity you want to stretch. 
The entity grips display.  

Do one of the following:  

Click a grip to activate it. 
The grip is attached to the drawing cursor.  

Press and hold the Shift key to select multiple grips, then release the Shift key and move 
one of the selected grips.  

Click to relocate the grip. 
The grip is released from the drawing cursor.  

  

NOTES • Use Ortho Mode, Polar Tracking or Snap Tracking to constrain the movement of the 
drawing cursor. 

• If you select two (or more) entities with coinciding grips, the shared grips move 
simultaneously.  
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Scaling Entities 

The Scale command resizes a selection set in relation to a base point. You can specify the scale 
factor by selecting a base point and a length or by typing an explicit scale factor in the command 
bar.  The scale factor can also be defined with respect to a base scale factor. E.g. when the base 
scale factor is 2 and the new scale is 3, the new size is 3/2 of the original. The base scale and the 

new scale can also be defined graphically in the drawing. 

The Copy option of the Grips Editing commands allows to create multiple copies of the entities 
being stretched, moved, rotated, mirrored or scaled. 

Scaling an Entity Using a Base Scale 

Select the entity.  

Do one of the following:  

Click the Scale tool button ( ) on the Modify toolbar  

Choose Scale in the Modify menu.  

Type scale or SC in the command bar.  

You are prompted: Base point: 

Specify the base point (1). 
You are prompted: Base Scale/<Scale Factor>:  

 

Choose Base in the prompt menu of type B or R and press Enter. 
You are prompted: Base scale <1>:  

Click point 1, then point 2 to define the base scale. 

The pentagon scales dynamically.  

Click point 3. 
The edge of the pentagon now equals the side of the square. 
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To Scale a Selection Set 

Do one of the following:  

Click the Scale tool button ( ) on the Modify toolbar  

Choose Scale in the Modify menu.  

Type scale or SC in the command bar.  

You are prompted: Select entities to scale: 

Select the entities, then right click or press Enter. 
You are prompted: Base point:  

Specify the base point for the scaling. 

The selection set scales dynamically. 
You are prompted: Base scale/<Scale Factor>:  

Type the scale factor in the command bar and press Enter. 
The selection set is scaled.  

  

NOTE The length of the vector between the base point and the current cursor position is used 
as the dynamic scale factor in step 3. 

 

Breaking Entities 

Command: BREAK 

The Break command remove a portion of an entity, thus breaking it into two parts.  

You can break arcs, circles, ellipses, lines, polylines, rays and infinite lines. Breaking a circle 

converts it to an arc. A ray is broken into a ray and a line, an infinite line is broken into two rays. 

When breaking entities, you must specify two points for the break. By default, the point you use to 

select the entity becomes the first break point; however, you can use the First option to select a 
break point different from the one that selects the entity. 

Do one of the following: 

Click the Break tool button ( ) on the Modify toolbar. 

Choose Break in the Modify menu. 

Type break or BR in the command bar, then press Enter. 

You are prompted: Select entity to break: 

Click the entity you want to break. 

You are prompted: First break point/<Second break point>: 
A prompt menu displays: 
 

 

Click a second point on the entity. 
The entity is broken. The portion between the two break points is removed. 

Joining Entities 

Command: JOIN 

The Join command joins lines, LW polylines, 2D polylines, 3D polylines, circular arcs, elliptical arcs, 

splines and helixes at their common endpoints. 

The type of the resulting entity depends on the types of the input entities and on their coplanarity. 
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To join colinear lines 
When you join colinear lines, the farthest endpoints remain at their existing locations; BricsCAD 
draws a new line between these points.  

Do one of the following: 

Click the Join tool button ( ) on the Modify toolbar. 

Choose Join in the Modify menu. 

Type join in the command bar, then press Enter. 

You are prompted: Select source entity or multiple entities to join at once: 

Select the lines. 

You are prompted: Select entities to join: 

Right click or press Enter. 
The lines are joined. 

To join two arcs 
Coplanar arcs, sharing midpoint and radius, are joined counterclockwise, therefore the result 
depends on the selecting order. 

Do one of the following: 

Click the Join tool button ( ) on the Modify toolbar. 

Choose Join in the Modify menu. 

Type join in the command bar, then press Enter. 

You are prompted: Select source entity or multiple entities to join at once: 

Select the first arc. 
You are prompted:  Select entities to join: 

Select the second arc and press Enter. 
You are prompted: 2 entities joined into 1 arc 
  

 

Joining two arcs: start situation (left) and result when selecting A first (middle) or 
B first (right). 

  

NOTE If more arcs share the same center point and radius, you can select them in step 3. Press 

Enter after selecting the last arc. 
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Chamfering and Filleting 

The Chamfer command connects two non-parallel entities by extending or trimming them and then 
joining them with a line to create a beveled edge. 

In BricsCAD you can choose between two chamfer methods: 

distance-distance: specify how far to trim the entities back from their intersection 

distance-angle: specify the length of the chamfer and the angle it forms along the first entity. 
The following entities can be chamfered: lines, polylines, rays and infinite lines. When chamfering a 
polyline, you can create a chamfer between two polyline segments or you can chamfer the entire 
polyline. 

Chamfering Using the Distance Distance Method 
Do one of the following:  

Click the Chamfer tool button ( ) on the Chamfer/Fillet flyout of the Modify toolbar.  

Choose Chamfer in the Modify menu.  

Type chamfer or CHA in the command bar, then press Enter.  

You are prompted: Chamfer (<current chamfer settings>): 

Settings/Polyline/Angle/Distance/mEthod/Trim/Undo/Multiple/<Select first entity>: 

A prompt menu displays: 

 
(option) Choose Chamfer Settings ... in the prompt menu or type S and press Enter. 

In the Settings dialog window:  

Specify the Chamfer first distance.  

Set the Chamfer second distance.  

Set the Chamfer mode to Distance-Distance.  
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Close the Settings dialog window. 

You are prompted: Chamfer (<current chamfer settings>): 
Settings/Polyline/Angle/Distance/mEthod/Trim/Undo/Multiple/<Select first entity>: 
Select the first entity or polyline segment. 
The command window reads: Select second entity.  

Select the second entity or polyline segment. 

The chamfer is created.  

Chamfering Using the Length Angle Method 
Do one of the following:  

Click the Chamfer  tool button ( ) on the Chamfer/Fillet flyout of the Modify toolbar.  

Choose Chamfer  in the Modify menu.  

Type chamfer or CHA in the command bar, then press Enter.  

You are prompted: Chamfer (<current chamfer settings>): Settings/Polyline/<Select first entity>: 

A prompt menu displays. 
Choose Chamfer Settings ... in the prompt menu or type S and press Enter.  

In the Settings dialog window:  

Specify the Chamfer length.  

Set the Chamfer angle.  

Set the Chamfer mode to Length-Angle.  

 

Close the Settings dialog window. 
You are prompted: Chamfer (<current chamfer settings>): Settings/Polyline/<Select first 
entity>:  

Select the first entity or polyline segment. 
The command window reads: Select second entity.  

Select the second entity or polyline segment. 
The chamfer is created.  

Chamfering All Vertices of a Polyline 
 

Do one of the following:  

Click the Chamfer tool button ( ) on the Chamfer/Fillet flyout of the Modify toolbar.  

Choose Chamfer in the Modify menu.  

Type chamfer or CHA in the command bar, then press Enter.  

You are prompted: Chamfer (<current chamfer settings>): Settings/Polyline/<Select first entity>: 
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A prompt menu displays: 

 

(option) Adjust the Chamfer Settings.  

Choose Polyline in the prompt menu or type P and press Enter. 
You are prompted: Select 2D polyline to chamfer:  

Select a polyline. 
All vertices of the selected polyline are chamfered.  

  

NOTE When the chamfer method is distance-angle, the direction of the polyline defines which is 
the first entity of a vertex. See drawing rectangles for more information about the 
direction of closed polylines. 

 

Filleting Entities 

The Fillet command connects two entities with an arc of a specified radius to create a rounded 
edge.  

You can fillet pairs of line segments, straight polyline segments, arcs, circles, rays, and infinite 
lines. You can also fillet parallel lines, rays, and infinite lines. 

When filleting a polyline, you can fillet multiple segments between two selected segments or you 
can fillet the entire polyline. 

Filleting Two Entities or Polyline Segments 
 

Do one of the following:  

Click the Fillet tool button ( ) on the Chamfer/Fillet flyout of the Modify toolbar.  

Choose Fillet in the Modify menu.  

Type fillet or F in the command bar, then press Enter.  
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You are prompted: Fillet (<current fillet settings>): 

Settings/Polyline/Radius/Trim/Undo/Multiple/<Select first entity>: 

A prompt menu displays: 

 

(option) Choose Fillet Settings ... in the prompt menu or type S and press Enter. 
Specify the Fillet radius in the Settings dialog window:  

 
Close the Settings dialog window. 
You are prompted: Fillet (<current fillet settings>): 

Settings/Polyline/Radius/Trim/Undo/Multiple/<Select first entity>: 

Select the first entity or polyline segment. 
The command window reads: Select second entity.  

Select the second entity or polyline segment. 
The fillet is created.  

Filleting all Vertices of a Polyline 
Do one of the following:  

Click the Fillet tool button ( ) on the Chamfer/Fillet flyout of the Modify toolbar.  

Choose Fillet in the Modify menu.  

Type fillet or F in the command bar, then press Enter.  

You are prompted: Fillet (<current fillet settings>): Settings/Polyline/<Select first entity>: 

A prompt menu displays: 
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(option) Adjust the Fillet Settings.  

Choose Polyline in the prompt menu or type P and press Enter. 
You are prompted: Select 2D polyline to chamfer:  

Select a polyline.  

All vertices of the selected polyline are filleted. 

Filleting two Parallel Lines 
 

Do one of the following:  

Click the Fillet tool button ( ) on the Chamfer/Fillet flyout of the Modify toolbar.  

Choose Fillet in the Modify menu.  

Type fillet or F in the command bar, then press Enter.  

You are prompted: Fillet (<current fillet settings>): 
Settings/Polyline/Radius/Trim/Undo/Multiple/<Select first entity>: 

Select the first entity (line or ray). 
The command window reads: Select second entity:  

Select the second entity (line, ray or infinite line). 
The fillet is executed at the endpoint closest to the point were the first entity is selected. 

The length of the second entity is adjusted. 



  User Guide 

 516 

Editing Polylines 

Command: PEDIT 

The PEDIT command modifies any type of two-dimensional or three-dimensional polyline: such as 
rectangles, polygons and donuts, as well as three-dimensional entities such as pyramids, cylinders 

and spheres. 

Editing a polyline can be:  

• opening or closing a polyline; 

• changing its overall width or the widths of individual segments; 

• converting a polyline with straight line segments into a flowing curve or an approximation of a 
spline;  

• editing individual vertices, adding, removing or moving vertices; 

• adding new segments to an existing polyline; 

• reversing the direction or order of the vertices; 

• merging a series of polylines, lines or arcs, which are connected endpoint to endpoint,  into a 
single polyline;  

• turning a line or an arc into a polyline; 
To modify a polyline, you first select the polyline, and then select a polyline editing option. The 

available options vary depending on whether the selected polyline is a two-dimensional or three-
dimensional entity.  

 

Converting an entity into a polyline 

Do one of the following: 

Click the Edit Polyline tool button ( ) on the Modify toolbar. 

Choose Edit Polyline in the Modify menu. 

Type editpline or pedit in the command window, then press Enter. 

You are prompted: Select polyline to edit. 

Select a line or arc. 
You are prompted: The entity selected is not a polyline. Turn it into one? <Y> 

A prompt menu displays: 

 

Do one of the following: 

Press Enter to accept the default option. 

Choose Yes-Turn into polyline in the prompt menu. 

Press Enter to conclude the Edit Polyline command. 

  

NOTE The Explode tool turns a single segment polyline back into a line or arc. 

 

Opening and Closing Polylines 

Command: PEDIT 

When you close a polyline, a straight polyline segment is drawn from the last vertex of the polyline 
to the first vertex. Opening a polyline removes the closing segment.  

When you select a polyline for editing, the prompt menu displays either the Open or Close option, 

depending on whether the polyline you select is closed or open. 

The following entities are created as closed polylines: 

rectangles 

bricscad-cmdref.chm::/P/PEdit.htm
bricscad-cmdref.chm::/P/PEdit.htm
bricscad-cmdref.chm::/P/PEdit.htm


BricsCAD V18  Help 

 

 517 

polygons 

donuts 

revision clouds 

You can open or close a polyline using the Edit Polyline tool or in the BricsCAD Properties bar. 

To close or open a polyline 
Do one of the following: 

Click the Edit Polyline tool button ( ) on the Modify toolbar. 

Choose Edit Polyline in the Modify menu. 

Type editpline or pedit in the command window, then press Enter. 

You are prompted: Select polyline to edit. 

Click the polyline you want to close or open. 
You are prompted: Edit polyline: Edit vertices/Close (or Open)/Decurve/Fit/Join/Linetype-
Mode/Reverse/Spline/Taper/Width/Undo/<eXit>: 

A prompt menu displays. 

To close (or open) a polyline do one of the following: 

Type C (or O) in the command bar, then press Enter. 

Choose Close (or Open) in the prompt menu. 

Opening and closing a polyline using the BricsCAD Properties bar 
Select the polyline. 
The current properties of the selected polyline display in the BricsCAD Properties bar. 

Select Closed  in the Misc settings category in the BricsCAD Properties bar. 

Click the down arrow and select Yes (or No). 

 

file:///D:/BricsCAD%20Training/manuals/01_User_Interface/00_06_Properties_Bar.htm
file:///D:/BricsCAD%20Training/manuals/01_User_Interface/00_06_Properties_Bar.htm


  User Guide 

 518 

Joining Polylines 

Commands: PEDIT and JOIN 

Using the Join option of the Edit Polyline tool you can add an arc, a line or a polyline entity to an 
existing open polyline, forming one continuous polyline entity. 

To join an entity to a polyline, that entity must already share an endpoint with an end vertex of the 

selected polyline. 

When you join an entity to a polyline, the width of the new polyline segment depends on the width 
of the original polyline and the type of entity you are joining to it: 

A line or an arc inherits the width from the polyline segment to which it is joined.  

A polyline joined to a tapered polyline retains its own width values.  

A polyline joined to a uniform-width polyline inherits the width from the polyline to which it is 
joined. 

The Join command joins lines, LW polylines, 2D polylines, 3D polylines, circular arcs, elliptical arcs, 

splines and helixes at their common endpoints. 

The type of the resulting entity depends on the types of the input entities and on their coplanarity. 

 

To join an arc, line, or polyline to an existing polyline 
 

Do one of the following: 

Click the Edit Polyline tool button ( ) on the Modify toolbar. 

Choose Edit Polyline in the Modify menu. 

Type editpline or pedit in the command window, then press Enter. 

You are prompted: Select polyline to edit. 

Select the parent polyline. 

You are prompted: Edit polyline: Edit vertices/Close (or Open)/Decurve/Fit/Join/Linetype-
Mode/Reverse/Spline/Taper/Width/Undo/<eXit>: 

A prompt menu displays. 

Choose Join in the prompt menu or type J and press Enter. 
You are prompted: Select entities to join: 

Select the entities to join. 
The number of already selected entities displays in the command bar. 

Right click or press Enter to stop selecting entities and add the selection to the polyline. 

Do one of the following: 

Continue editing the selected polyline. 

Choose Exit in the prompt menu or press Enter to conclude the Edit Polyline tool. 

  

NOTE You can select multiple entities in step 3 on condition they form one chain with the parent 

polyline. 

 

To Apply a Uniform Width to Polyline 

Do one of the following:  

Click the Edit Polyline tool button ( ) on the Modify toolbar.  

Choose Edit Polyline in the Modify menu.  

Type editpline or pedit in the command window, then press Enter.  

You are prompted: Select polyline to edit. 

Select the polyline. 
You are prompted: Edit polyline: Edit vertices/Close (or Open)/Decurve/Fit/Join/Linetype-
Mode/Reverse/Spline/Taper/Width/Undo/<eXit>: 

A prompt menu displays.  

Choose Width in the prompt menu or type W and press Enter. 
You are prompted: Enter new width for all segments:  
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Type a new width in the command bar and press Enter. 

The new width is applied to the entire polyline.  

Do one of the following:  

Continue editing the selected polyline.  

Choose Cancel in the prompt menu or press Enter or right click  to conclude the Edit 
Polyline tool.  

To Taper a Polyline Uniformly along its Length 

Do one of the following:  

Click the Edit Polyline tool button ( ) on the Modify toolbar.  

Choose Edit Polyline in the Modify menu.  

Type editpline or pedit in the command window, then press Enter.  

You are prompted: Select polyline to edit. 

Select the polyline. 

You are prompted: Edit polyline: Edit vertices/Close (or Open)/Decurve/Fit/Join/Linetype-
Mode/Reverse/Spline/Taper/Width/Undo/<eXit>: 
A prompt menu displays.  

Choose Taper in the prompt menu or type T and press Enter. 
You are prompted: Enter new starting polyline width <current starting width>:  

Type a new starting width in the command bar and press Enter. 
You are prompted: Enter new ending polyline width <current ending width>:  

Type a new ending width in the command bar and press Enter. 
The polyline is tapered uniformly along its length.  

Do one of the following:  

Continue editing the selected polyline.  

Choose Cancel in the prompt menu or press Enter or right click  to conclude the Edit 

Polyline tool. 
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Editing a Polyline Segment 

The Edit vertices option of the Pedit command modifies individual polyline vertices.  

When you select this option, the program switches into a special vertex editing mode and places 
an X on the first vertex. The X indicates the vertex you are editing. The Next and Previous options 
move the X to the next or previous vertex. You can edit only one vertex at a time. 

When editing vertices, you can modify the polyline in the following ways: 

Convert a straight polyline segment into a curve.  

Break a polyline into two separate polylines.  

Insert a new vertex in a polyline.  

Move a vertex in a polyline.  

Delete vertices in a polyline.  

Change the width of a polyline segment. 

The Peditext command is used in 2D Editing command group of the Quad cursor menu 

Editing a Polyline Using the Quad 
Move the cursor over the polyline. 
If currently ON, the TIPS widget displays: 
 

 
 
The available commands in the Quad apply to the entire polyline. 

Press the Ctrl-key to switch to segment mode. 

 

 
 
The available commands in the Quad apply to the segment under the cursor. 

When the Quad cursor menu displays, do one of the following:  

Right click to execute the default Quad command.  

Move the cursor to the Quad and move to the Edit command group.  

 

Select a command:  

Add vertex: adds a vertex to the segment under the cursor.  

Add vertex at end: adds as a new vertex at the end of the polyline. 
This option is only available if the cursor is on one of the endpoints of a polyline.  

Adjust Bulge: Modifies the bulge factor of the segment under the cursor.  

Delete segment: deletes the segment under the cursor.  
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Stretch segment: moves the segment under the cursor.  

Stretch vertex: moves the vertex closest to the cursor.  

 

Starting the Polyline Vertex Editing Mode 
 

Do one of the following:  

Click the Edit Polyline tool button ( ) on the Modify toolbar.  

Choose Edit Polyline in the Modify menu.  

Type editpline or pedit in the command window, then press Enter.  

You are prompted: Select polyline to edit. 

Select the polyline. 
You are prompted: Edit polyline: Edit vertices/Close (or Open)/Decurve/Fit/Join/Linetype-

Mode/Reverse/Spline/Taper/Width/Undo/<eXit>: 
A prompt menu displays.  

Choose Edit vertices in the prompt menu or type E and press Enter. 
You are prompted: 

Next/Previous/Angle/Break/Insert/Move/Regen/SElect/Straighten/Width/eXit/<Next>: 
The Editpline prompt menu changes:  

 

A triangle indicates the start point of the polyline. The first vertex of the polyline is selected. 

Converting a Straight Polyline Segment into a Curve 

Start the polyline vertex editing mode.  

Select the start vertex of the segment you want to convert. 

Choose Next vertex / Previous vertex  in the prompt menu to select a vertex. 

The X indicates the currently selected vertex.  

Choose Angle in the prompt menu or type A and press Enter. 
The prompt menu closes. 
You are prompted: Included angle for segment (>0 is ccw, 0 is straight, <0 is cw) <current 
angle>:  

Type a new included angle for the segment and press Enter. 
The direction of an arc segment is as follows:  

positive angles: counter clockwise  

negative angle: clockwise direction  

0° for straight segments  

Choose Exit in the prompt menu or type X and press Enter to leave the Polyline vertex editing 
mode.  
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Do one of the following:  

Continue editing the selected polyline.  

Choose Exit in the prompt menu or press Enter to conclude the Edit Polyline tool.  

Breaking a Polyline into two Separate Polylines 

Start the polyline vertex editing mode.  

Select the start vertex where you want to break the polyline. 
Choose Next vertex / Previous vertex  in the prompt menu to select a vertex. 
The X indicates the currently selected vertex.  

Choose Break in the prompt menu or type B and press Enter.  

You are prompted: Next/Previous/Select/Go/eXit/<Next>: 

The prompt menu changes: 

 

(option) Do one of the following  to select a second vertex:  

Choose Next vertex / Previous vertex  in the prompt menu.  

Choose Select in the prompt menu or type S and press Enter. 

You are prompted to select a vertex.  

Choose Go in the prompt menu or type G and press Enter. 
The polyline s broken into two polylines. 
If a second point is selected in step 4 the segment(s) between the selected vertices is (are) 
deleted.  

Choose Exit in the prompt menu or type X and press Enter to leave the Polyline vertex editing 
mode.  

Do one of the following:  

Continue editing the selected polyline.  

Choose Exit  in the prompt menu or press Enter to conclude the Edit Polyline tool.  

Inserting a New Vertex 

Start the polyline vertex editing mode.  

Select the start vertex of the segment where you want to insert a vertex. 
Choose Next vertex / Previous vertex  in the prompt menu to select a vertex. 
The X indicates the currently selected vertex.  

Choose Insert vertex in the prompt menu or type I and press Enter. 
You are prompted: Location for new vertex:  

Specify the location for the new vertex. 
The new vertex is inserted.  

Choose Exit in the prompt menu or type X and press Enter to leave the Polyline vertex editing 
mode.  
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Do one of the following:  

Continue editing the selected polyline.  

Choose Exit in the prompt menu or press Enter to conclude the Edit Polyline tool.  

Moving a Vertex 

Start the polyline vertex editing mode.  

Select the vertex you want to move. 
Choose Next vertex / Previous vertex  in the prompt menu to select a vertex. 
The X indicates the currently selected vertex.  

Choose Move in the prompt menu or type M and press Enter. 
You are prompted: New location for vertex.  

Specify the new location for the selected vertex. 
The vertex is moved.  

Choose Exit in the prompt menu or type X and press Enter to leave the Polyline vertex editing 
mode.  

Do one of the following:  

Continue editing the selected polyline.  

Choose Exit in the prompt menu or press Enter to conclude the Edit Polyline tool.  

Deleting Vertices 

Start the polyline vertex editing mode.  

Select the vertex before the first vertex you want to delete. 

Choose Next vertex / Previous vertex  in the prompt menu to select a vertex. 
The X indicates the currently selected vertex.  

Choose Straighten in the prompt menu or type S and press Enter. 
You are prompted: Straighten: Next/Previous/Select/Go/eXit/<Next>:  

Do one of the following to select the vertex after the last vertex you want to delete:  

Choose Next vertex / Previous vertex  in the prompt menu.  

Choose Select in the prompt menu or type S and press Enter. 
You are prompted to select a vertex.  

Choose Go in the prompt menu or type G and press Enter. 
The vertices between the selected vertices are removed.  
A straight segment is drawn between the selected vertices.  

Choose Exit in the prompt menu or type X and press Enter to leave the Polyline vertex editing 
mode.  

Do one of the following:  

Continue editing the selected polyline.  

Choose Exit in the prompt menu or press Enter to conclude the Edit Polyline tool.  

Changing the Width of a Polyline Segment 

Start the polyline vertex editing mode.  

Select the start vertex of the segment you want to change the width of. 
Choose Next vertex / Previous vertex  in the prompt menu to select a vertex. 
The X indicates the currently selected vertex.  

Enter starting width <current width>:  
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Do one of the following:  

Type the new width in the command bar and press Enter.  

Click to define the width graphically.  

You are prompted: Enter ending width <current width>: 

Do one of the following:  

Type the new width in the command bar and press Enter.  

Click to define the width graphically.  

Choose Exit in the prompt menu or type X and press Enter to leave the Polyline vertex editing 
mode.  

Do one of the following:  

Continue editing the selected polyline.  

Choose Exit in the prompt menu or press Enter to conclude the Edit Polyline tool.  

  

NOTE The new width is applied when you conclude the Edit Polyline tool in step 6. 

 

Curving and Decurving Polylines 

Command: PEDIT 

The Fit or Spline options of the Edit Polyline tool convert a multi-segment polyline into a smooth 

curve. The Fit option creates a smooth curve connecting all the vertices. The Spline option 
computes a smooth curve that is pulled toward the vertices but passes through only the first and 
last vertices. 

The Decurve option removes Fit or Spline curves and arcs, leaving straight segments between the 
vertices. 

To fit a curve to a polyline 

Do one of the following: 

Click the Edit Polyline tool button ( ) on the Modify toolbar. 

Choose Edit Polyline in the Modify menu. 

Type editpline or pedit in the command window, then press Enter. 

You are prompted: Select polyline to edit. 

Select the polyline. 
You are prompted: Edit polyline: Edit vertices/Close (or Open)/Decurve/Fit/Join/Linetype-
Mode/Reverse/Spline/Taper/Width/Undo/<eXit>: 
A prompt menu displays. 

Do one of the following: 

Choose Fit in the prompt menu of type F and press Enter. 

Choose Spline in the prompt menu or type S and press Enter. 
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Original polyline After applying Fit After applying Spline 

Do one of the following: 

Continue editing the selected polyline. 

Choose Done in the prompt menu or press Enter to conclude the Edit Polyline tool. 

  

NOTES • Use the Decurve option in step 3 of the above procedure to restore the original 
polyline. 

• The SPLINESEGS (Spline Segments) settings variable controls the number of 
segments (lines or arcs) to be generated for spline-fit polylines. 

 

Setting the Linetype Mode 

Command: PEDIT 

The Linetype mode option of the Edit Polyline tool lets you change the way how a dashed linetype 
is applied to a multi-segment polyline. 

Do one of the following: 

Click the Edit Polyline tool button ( ) on the Modify toolbar. 

Choose Edit Polyline in the Modify menu. 

Type editpline or pedit in the command window, then press Enter. 

You are prompted: Select polyline to edit. 

Select the polyline. 
You are prompted: Edit polyline: Edit vertices/Close (or Open)/Decurve/Fit/Join/Linetype-
Mode/Reverse/Spline/Taper/Width/Undo/<eXit>: 

A prompt menu displays. 

Choose Linetype mode in the prompt menu or type L and press Enter. 
You are prompted: Linetype continuous along polyline: ON/OFF <current setting>: 
The Editpline prompt menu changes: 
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Do one of the following: 

Choose Continuous on or Continuous off in the prompt box. 

Type ON or OF in the command bar, then press Enter. 

  

 

The same polyline with Continuous On (left) and Continuous Off (right) 

Do one of the following: 

Continue editing the selected polyline. 

Choose Cancel in the prompt menu or press Enter or right click  to conclude the Edit 

Polyline tool. 

Editing Polylines in the Properties Bar 

When you select polyline, its current properties display in the BricsCAD Properties bar. 

In the BricsCAD Properties bar the following polyline properties can be edited: 

Move vertices (1) 

Change the  width of polyline segments (2) 

Convert straight segments into a curve (3) 

Change the global width (4) 

Change the Elevation (5) 

Open / close the polyline (6) 

Change the Linetype generation mode (7) 
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To move polyline vertices 

Select the polyline. 

Click the Vertex field in the Properties bar, then press the arrow buttons to select the vertex you 
want to move. 
A X indicates the currently selected vertex in the drawing. 

 

Do one of the following: 

Adjust the X- and/or Y-field and press Enter. 

Click the Vertex Position field and press the Position button to move the vertex in the 
drawing. 

 

Continue editing the polyline or press the Esc key to stop. 
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To change the  width of polyline segments 

Select the polyline. 

Click the Vertex field in the Properties bar, then press the arrow buttons to select the start vertex 
of the segment you want to modify. 
A X indicates the currently selected vertex in the drawing. 

 

Type a new width in the Start width field and press Enter. 

Type a new width in the End width field and press Enter. 

Continue editing the polyline or press the Esc key to stop. 

To convert straight segments into a curve 

Select the polyline. 

Click the Vertex field in the Properties bar, then press the arrow buttons to select the start vertex 

of the segment you want to modify. 
A X indicates the currently selected vertex in the drawing. 

 

Type a new value in the Bulge field and press Enter. 

 

Continue editing the polyline or press the Esc key to stop. 

  

NOTE The bulge is the tangent of one fourth the included angle for an arc segment.  

A positive bulge creates a counter clockwise arc, while a negative bulge creates an arc 

with a clockwise direction.  

Straight segments have a zero bulge. 

 

Bulge = 2H/D 

Bulge = tg / 4 
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Converting Entities 

Exploding Entities 

Commands: EXPLODE and TXTEXP 

The Explode command converts complex entities, such as blocks, polylines, solids or dimensions 
into their component parts. 

Exploding a polyline or dimension reduces it to a collection of individual line and arc entities that 
you can then modify individually.  

Blocks are converted to the individual entities, possibly including other, nested blocks that 
composed the original entity. 

Multiline texts explode into single line text entities. 

In general exploding entities will have no visible effect in the drawing, except for: 

If the original polyline had a width, the width information is lost when you explode it. The 
resulting lines and arcs follow the centerline of the original polyline.  

If you explode a block containing attributes, the attributes are lost, but the original attribute 

definitions remain.  
Colors and linetypes assigned BYBLOCK may appear different after exploding an entity, 
because they will adopt the default color and linetype.  

The TxtExp command explodes text into polylines (short for "text explode"). 

To explode entities 

Do one of the following: 

Click the Explode tool button ( ) on the Modify toolbar. 

Choose Explode in the Modify menu. 

Type explode in the command bar, then press Enter. 

The command window reads: Select entities to explode. 

Select the entities, then right click or press Enter. 

  

NOTE If you select the entities first, then launch the Explode tool, the selected entities are 
exploded immediately. 

 

Creating Regions 

Command: REGION 

The Region command converts closed entities into a solid entity. 

You can create regions from closed entities, such as polylines, polygons, circles, ellipses, closed 
splines and donuts.  

Creating regions typically has no visible effect on a drawing. However, if the original entity had a 

width or lineweight, that information is lost when you create the region.  

Do one of the following: 

Click the Region tool button ( ) in the Draw toolbar. 

Choose Region in the Draw menu. 

Type region in the command bar, then press Enter. 

You are prompted: Select objects: 

Select the entities, then right click or press Enter. 
The command bar displays how many regions have been created. 
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Measuring and Dividing Entities 

Measuring Entities 

Command: MEASURE 

The Measure command places markers - points or blocks - at a specified interval along the length 
or circumference of an entity. The Measure tool starts placing markers at the closes endpoint to 
where you select the entity. 

You can measure lines, polylines, arcs, circles, ellipses, elliptical arcs and splines. You cannot 
measure rays and infinite lines.  

You measure a circle along its circumference starting from the Angle Base value as defined in the 

Settings dialog. If Angle Base is set to zero, a circle is measured starting at 3 o'clock (east). 

To measure an entity using points 

Do one of the following: 

Click the Measure tool button ( ) on the Modify toolbar. 

Choose Measure in the Modify menu. 

Type measure in the command bar, then press Enter. 

You are prompted: Select entity to measure: 

Click the entity you want to measure. 
You are prompted: Block/<Segment length>: 

To define the measurement interval, do one of the following: 

Type the measurement interval and press Enter. 

Specify two points in the drawing. 

Points are placed along the selected entity at the specified interval. 
  

NOTE It might be necessary to adjust the Point display mode settings to display the points 

correctly. 

To place blocks a specified interval along an entity 

Do one of the following: 

Click the Measure tool button ( ) on the Modify toolbar. 

Choose Measure in the Modify menu. 

Type measure in the command bar, then press Enter. 

You are prompted: Select entity to measure: 

Click the entity you want to measure. 
You are prompted: Block/<Segment length>: 
A prompt menu displays: 
 

 

Choose Insert blocks in the prompt menu or type B and press Enter. 
You are prompted: Name of block to insert: 
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Type the name of the block in the command bar and press Enter. 

You are prompted: Align blocks with entity? <Y>: 
A prompt menu displays: 
 

 

Do one of the following: 

Choose Yes-Align blocks in the prompt menu or press Enter to align the blocks with the 
selected entity. 

Choose No-Do not align  in the prompt menu or type N and press Enter to place the blocks 
not rotated. 

You are prompted: Segment length: 

To define the measurement interval, do one of the following: 

Type the measurement interval and press Enter. 

Specify two points in the drawing. 

The blocks are placed along the selected entity at the specified interval. 

  

 

Blocks aligned (top) or not aligned (bottom) 

 

Dividing Entities 

Command: DIVIDE 

The Divide command places markers - points or blocks - along a selected entity. The markers 
evenly divide the entity into the specified number of equal parts. 

You can divide lines, polylines, arcs, circles, ellipses, elliptical arcs and splines.  

Do one of the following: 

Click the Divide tool button ( ) on the Modify toolbar. 

Choose Divide in the Modify menu. 

Type divide in the command bar, then press Enter. 

You are prompted: Select entity to divide: 
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Click the entity you want to divide. 

You are prompted: Blocks/<Number of Segments>: 

Type the number of segments in the command bar and press Enter. 

Points are placed along the selected entity to divide the entity. 

  

NOTE It might be necessary to adjust the Point display mode settings to display the points 
correctly. 

To divide an entity using blocks 

Do one of the following: 

Click the Divide tool button ( ) on the Modify toolbar. 

Choose Divide in the Modify menu. 

Type divide in the command bar, then press Enter. 

You are prompted: Select entity to divide: 

Click the entity you want to divide. 
You are prompted: Blocks/<Number of Segments>: 
A prompt menu displays: 
 

 

Choose Insert blocks in the prompt menu or type B and press Enter. 
You are prompted: Name of block to insert: 

Type the name of the block in the command bar and press Enter. 
You are prompted: Align blocks with entity? <Y>: 

A prompt menu displays: 
 

 

Do one of the following: 

Choose Yes-Align blocks in the prompt menu or press Enter to align the blocks with the 

selected entity. 

Choose No-Do not align  in the prompt menu or type N and press Enter to place the blocks 
not rotated. 

The blocks are placed along the selected entity to divide the entity. 
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Blocks aligned (top) or not aligned (bottom) 
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Blocks, Attributes and External References 

Working with Blocks 

Commands: BLOCK, -BLOCK,  WBLOCK, PASTEBLOCK and SECTIONPLANETOBLOCK 

The Block command groups entities into a block using a dialog box. The -Block commands prompts 
you in the command bar. 

The Wblock command writes blocks and other drawing parts to a separate drawing file (short for 

"write block"). 

The Pasteblock command pastes entities from the Clipboard as a block in the current drawing (see 
Paste a selection as a block). 

The SectionPlaneToBlock command saves the selected section plane to a 2D cross section / 
elevation block or a 3D cutaway section block. 

  

 

Creating blocks quickly on the fly  

  

General procedure to create a block 

Specify the name. 

Specify the insertion point. 

The insertion point is the base point for the block and serves as the reference point when you later 
insert the block into a drawing. 

Select entities. 

To Create a Block in a Drawing 

Do one of the following:  

Click the Create Block tool button ( ) on the Tools toolbar.  

Choose Create Block in the Tools menu.  

Type block in the command bar, then press Enter.  
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The Block Definition dialog displays: 

 

Type a name for the new block in the Name field.  

Do one of the following to specify the Base Point:  

Check the Specify On-screen option. 

You will be prompted to specify the base point after clicking the OK button.  

Click the Pick point button ( ). 
The Block Definition dialog closes temporarily to let you pick a point in the drawing.  

Type the coordinates of the base point in the X-, Y- and Z-field.  

 

Do one of the following to select the entities to be included in the block definition:  

Check the Specify On-screen option. 
You will be prompted to select the entities after clicking the OK button.  

Click the Select entities button ( ). 
The Block Definition dialog closes temporarily to let select the entities in the drawing.  

 

Set the block properties:  

Annotative: creates an annotative block.  

Match block orientation to layout: if checked, the orientation of an annotative block is preserved in 
a rotated viewport.  

Scale uniformly: if checked, the X-, Y- and Z-scaling cannot be set differently.  

Allow exploding: if not checked, prevents the block from being exploded.  

Block unit: set the insertion unit for the block (see also: To insert a block).  

 

Set the behavior of the selected entities after the block is created:  

Retain: The selected entities remain in the drawing.  

Convert to block:  The selected entities are replaced by the newly created block.  

Delete: The selected entities are deleted.  

file:///D:/BricsCAD%20Training/manuals/10_Drawing_Entities/08_AnnotativeEntities/10_08_03_AnnotativeBlocks.htm
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Click the OK button to create the block.  

  

NOTE If the Delete option in step 6 was set, the OOPS command brings back the erased block 

entities. 

  

To Create a Block Using the Blocks Explorer 

Do one of the following:  

Choose Blocks...  in the Settings menu.  

Type explblocks in the command bar, then press Enter.  

The Drawing Explorer - Blocks dialog opens. 

In the  Drawing Explorer dialog do one of the following:  

Click the New button ( ) on the Details toolbar.  

Choose New in the Edit menu.  

The Drawing Explorer dialog closes. 

You are prompted: Insertion point for new block: 

Specify the insertion point of the new block. 

You are prompted: Select entities for block.  

Select the entities for the new block.  

Right click to create the block. 
The selected entities are removed from the drawing. 
The  Drawing Explorer dialog reopens. 
The Name field of the new block is selected.  

Type a name in the Name field, replacing the default NewBlock1 name.  

Close the Drawing Explorer dialog.  

(option) Type oops in the command bar, then press Enter  to bring back the selected block 
entities.  

To Save a Block to a Separate File 

Do one of the following:  

Click the Save Block... tool button ( ) on the Tools toolbar.  

Choose Save Block... in the Tools menu.  

Type wblock in the command bar, then press Enter.  

bricscad-cmdref.chm::/O/Oops.htm
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The Write Block to File dialog opens. 

 

Click the browse button ( ) next to the Name and path field. 
The Save Block dialog opens.  

On the Save Block dialog, select a folder and type a name in the File name field, then click the 
Save button. 
The Save Block dialog closes.  

Insert units: set the insertion unit for the block (see also: To insert a block).  

To select the source entities for the new block, do one of the following:  

Click the Block radio button, then select a block from the drop-down list.  

Click the Model space radio button, to select all the entities in the model space of the 
current drawing.  

Click the Entities radio button, then click the Select Entities button ( ). 
The Write Block to File dialog temporarily closes to let you select entities in the drawing. 
Right click to stop selecting entities. 

Click the Pick point button ( ) to define the Base point of the new drawing 
or 
Type the coordinates of the base point in the X-, Y- and Z-field. 
Set the behavior of the selected entities after the block is created:  

Retain: The selected entities remain in the drawing. 

Convert to block:  The selected entities are replaced by the newly created block. 

Delete: The selected entities are deleted. 

Click the OK button to create the drawing file.  

 

NOTE If the Delete option in step 5 was set, the OOPS command brings back the erased block 

entities. 

 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/12_01_02_Inserting_Blocks.htm%23To_insert_a_block
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Inserting Blocks 

Commands: INSERT,  -INSERT, INSERTALIGNED and MINSERT 

The Insert command lets you insert blocks through a dialog box.  

The -Insert command inserts blocks by prompting in the command bar. BricsCAD will lookup the 
block name in the block definitions in the current drawing. If the block is not found in the current 

drawing, the paths defined by the SRCHPATH system variable are searched. If the block is not 
found there either, BricsCAD responds 'Could not find file <blockname>' 

The Insertaligned command inserts a block entity, with easy alignment on existing entities. The 
Insertaligned command is similar to the Insert command, but during the placement the block will 
be dynamically aligned with existing lines, polylines, arcs or circles. The block is aligned with the 
entity to which the cursor snaps. If no entity is snapped, the block is aligned with the X-axis of the 
WCS. 

The Minsert command Inserts a block as a rectangular array; combines the -Insert and Array 
commands (short for "multiple insertion"). 

You can choose to select an existing block definition or to insert an entire drawing as a block. 
When you insert a drawing, a new block definition is created in the current drawing. If you change 
the original drawing file, those changes have no effect on the current drawing unless you redefine 
the block by reinserting the changed drawing. When a block is inserted in a drawing, it is treated 
as a single entity. 

  

 

Manage blocks with the Drawing Explorer  

  

General procedure to insert a block: 

Specify a block definition or drawing file. 

Specify the insertion point. 

Specify the scale. 

Specify the rotation angle. 
  

NOTES • When inserting a drawing as a block, the base point, as defined by the INSBASE 
system variable, of the inserted drawing is the origin point of the block. The 
INSBASE system variable is set by the BASE command. 

• If a block contains attributes you will be prompted to fill out the text for each 
attribute in the command bar. 

• If the DRAGOPEN system variable is set to zero (OFF), drawings can be inserted as 
a block by dragging them from the Windows Explorer dialog into the current 
drawing; if DRAGOPEN = 1 (ON), the drawing will be opened instead. 

• The INSUNITS system variable defines a drawing units value for automatic scaling 
when inserting blocks or attaching Xrefs. 

In the Insert Block dialog: 

The Unit field under Block Unit is set by the INSUNITS (Insertion Units) system variable in the 

source drawing or the Block Unit property of a block definition (see To create a block in a 
drawing). 

The Factor field expresses the relation between the value of the INSUNITS variable in the source 
drawing and the target drawing. E.g. if INSUNITS is Millimeters in the source and the target, 
the value of the Factor field is 0.1. 

If INSUNITS in the source drawing is Unspecified, INSUNITSDEFSOURCE is used instead. 

If INSUNITS in the target drawing is Unspecified, INSUNITSDEFTARGET is used instead. 
The values of  INSUNITSDEFSOURCE and  INSUNITSDEFTARGET are saved in the registry and 

therefore apply to all drawings in which INSUNITS is unspecified (unitless). 

  

bricscad-cmdref.chm::/I/Insert/Insert.htm
bricscad-cmdref.chm::/I/Insert/-Insert.htm
bricscad-cmdref.chm::/I/InsertAligned.htm
bricscad-cmdref.chm::/M/MInsert.htm
https://blog.bricsys.com/tutorials/
https://blog.bricsys.com/manage-blocks-drawing-explorer/
bricscad-cmdref.chm::/B/Base.htm
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To Insert a Block 

Do one of the following  

Click the Insert Block... tool button ( ) on the Insert  toolbar.  

Choose Insert Block... in the Insert menu.  

Type insert in the command bar, then press Enter.  

The Insert Block dialog opens. 

 

In the Insert Block dialog, do one of the following:  

Select an existing block definition in the Name list.  

Click the Browse button and select a drawing file.  

(option) Check the Explode option to explode the block after insertion.  

(option) Uncheck the Specify On-Screen option, then specify the Insertion Point by keying in the 

coordinates in the X, Y and Z fields.  

(option) Uncheck the Specify On-Screen option, then specify the Scale by keying in the scaling 
factors in the X, Y and Z fields. 
Check the Uniform Scale option to equal the X, Y and Z scale factors.  

(option) Check the Specify On-Screen option to specify the Rotation angle when inserting the 
block.  

Click the OK button. 

You are prompted: Insertion point for block. 
A prompt menu displays. 

file:///D:/BricsCAD%20Training/manuals/11_Modifying_Entities/08_Converting_Entities/11_08_01_Exploding_entities.htm
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Specify the insertion point. 
You are prompted: Corner/XYZ/X scale factor <1.000000>: 
A prompt menu displays. 
 

 

Right click or press Enter to accept the default X scale factor. 
You are prompted: Y scale factor: <Equal to X scale (1.000000)>:  

Right click or press Enter to set the Y scale factor equal to the X scale factor. 
The block is inserted.  

To Insert a Block Using the Blocks Explorer 

Open the Drawing Explorer - Blocks dialog.  

(optional) Choose either Detail View ( ) or Icon View ( ).  

(option) Edit the insert options:  

Choose Options... in the Settings menu or select a block, then right click and choose Options ... in 

the context menu.  

Set the insert options in the Drawing Explorer Options dialog box. 
 

 

Do one of the following:  

Select a block, then do one of the following: 

Click the Insert Block button ( ) on the Details  toolbar.  

Right click and select Insert from the context menu  

When in Icon View, double click the block.  

To select an external drawing, do one of the following: 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/00_03_Managing_Blocks.htm%23Open_the_Blocks_Explorer
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Click the Insert External tool button ( ) on the  Details  toolbar.  

Choose Insert External in the Edit menu.  

Right click, then choose Insert External in the context menu.  

The Drawing Explorer - Blocks window closes. 

You are prompted: Multiple blocks/Scale/<Insertion point for block>: 

A prompt menu displays 

 

Follow the instructions in the command bar to insert the block.  
The Drawing Explorer - Blocks window reopens.  

(option) Insert more blocks.  

Close the Drawing Explorer - Blocks window.  

 

Inserting blocks from another drawing 

Open the Drawings Explorer.  

In the Drawings pane, click the Folders tab.  

(option) If not yet available in the Local Folders tree, add the folder of the drawing.  

Expand the folder.  

Click the Expand icon (+) in front of the drawing. 
The Blocks icon of the drawing displays. 

 

Click the Blocks icon. 
The blocks in the drawing display in the Details pane. 

If necessary, click the Icon View button ( ) in the Details toolbar to see thumbnail images of the 
blocks.  

(option) Edit the insert options:  

Choose Options... in the Settings menu or select a block, then right click and choose 
Options ... in the context menu.  

file:///D:/BricsCAD%20Training/manuals/20_Managing_Drawings/00_02_Drawing_Explorer.htm%23How_to_open_the_drawing_explorer
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Set the insert options in the Drawing Explorer Options dialog box. 

 

 

The available options are: 

Align: If checked, launches the InsertAligned command to insert the block. 
When the Align option is checked, the Fixed Scale and Fixed Rotation options are not 
available.  

Fixed Scale: If checked, allows to insert the block at a fixed scale.  

Fixed Rotation: If checked, allows to insert the block at a fixed rotation.  

To insert a block, do one of the following:  

Click the Insert Block button ( ) on the Details  toolbar.  

When in Icon View, double click the thumbnail image of the block.  

When in Detail view, double click the number in front of the block name.  

The Drawing Explorer dialog closes temporarily to let you insert the block in the drawing. 
 

You are prompted: Multiple blocks/<Insertion point for block>: 

A prompt menu displays 

 

Follow the instructions in the command bar to insert the block.  
The Drawing Explorer window reopens.  

(option) Insert more blocks.  

Close the Drawing Explorer - Blocks window.  

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/InsertAligned.htm
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To Insert a Block Aligned with an Entity 

Make sure the appropriate Entity Snaps are active.  

Type insertaligned or insal in the command bar, then press Enter. 
You are prompted: ? to list blocks in drawing/~ to open the file dialog/<Block to insert> <name>:  

Do one of the following:  

Press Enter or right click to insert the most recently placed block again.  

Type the name of an existing block definition in the command bar, then press Enter.  

Type the name of an external block file in the command bar, then press Enter.  

Type ~ (tilde) then press Enter to open the file dialog.  

You are prompted: Multiple blocks/<Insertion point for block>: 

A prompt menu displays. 

 

Snap to an entity. 

The block is aligned with the entity.  

Click to define the insertion point. 
When you move the crosshairs, the block is mirrored about the selected entity or a about a line 
tangent to the selected entity.  

Click to specify the mirroring of the block.  

  

NOTE If you type the name of block in step 3, BricsCAD will lookup the block in the block 
definitions in the current drawing. If the block is not found in the current drawing, the 
paths defined by the SRCHPATH system variable are searched. If the block is not found 
there either, BricsCAD responds 'Could not find file <blockname>' 

  

NOTE The block is aligned as follows: The block is rotated so that its local Z-axis is parallel with 
the Z-axis of the active UCS, and its local X-axis should be parallel with the tangent to 

the entity at the position of the snap point. When you click a point on an entity the block 
is aligned with the entity. Then, by moving the mouse pointer around the insertion point, 
you can choose how the block should be mirrored. The origin point of the block lies on the 

entity. 

 

To Insert Multiple Instances of a Block in a Rectangular Array 

Type minsert in the command bar, then press Enter. 

You are prompted:  
? to list blocks in drawing/~ to open the file dialog/<Block to insert>:  

Do one of the following:  

Type ~  (press and hold the alt gr key, then press the ~ key), then press Enter. 
The Insert Block file dialog displays. 

Select the drawing file you want to insert and press the Open button (or double click the 
file name).  

Press Enter to accept the <Block to insert>.  

file:///D:/BricsCAD%20Training/manuals/03_Drawing_Accurately/03_03_Entity_Snaps.htm%23To_set_the_Entity_Snaps
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Type a block name, then press Enter. 

Optionally, type ? to display search for existing block definitions.  

The block is attached to the cursor. 
You are prompted: Multiple blocks/<Insertion point for block>: 

 

Specify the insertion point. 
You are prompted: Corner/XYZ/X scale factor <1.00>:  

To define the X scale factor, do one of the following:  

Press Enter to accept the default .  

Type the X scale factor, then press Enter.  

Click to define the X scale factor graphically.  

You are prompted: Y scale factor: <Equal to X scale (current X scale)>: 

Repeat step 5 to define the Y scale factor. 
You are prompted: Rotation angle for block <0>:  

Do one of the following:  

Press Enter to set the rotation angle to 0°.  

Type a rotation angle, then press Enter.  

Click to define the rotation angle graphically. 

You are prompted: Number of rows in the array <1>: 

Type the number of rows, then press Enter or press Enter for one row. 
You are prompted: Number of columns <1>:  

Type the number of columns, then press Enter or press Enter for one column. 
You are prompted: Vertical distance between rows, or spacing rectangle:  

Type the row spacing distance, then press Enter. 

You are prompted: Horizontal distance between columns:  

Type the column spacing distance, then press Enter. 
The block array is created as a single entity.  

  

NOTES • If you choose Multiple blocks in step 3, you are prompted to create multiple 
instances of the  block array. 

• It is not possible to explode a MInsert Block entity.. 

• If you type the name of block in step 2, BricsCAD will lookup the block in the block 
definitions in the current drawing. If the block is not found in the current drawing, 
the paths defined by the SRCHPATH system variable are searched. If the block is 
not found there either, BricsCAD responds 'Could not find file <blockname>' 
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Redefining Blocks 

To redefine a block that was created in the current drawing, you create a new block using the 
same name.  

If the block was inserted from a separate drawing, reinsert that block. 

When a block definition is redefined all instances of that block in the current drawing are updated 

automatically. 

See also: Editing blocks and external references. 

To Redefine an Internal Block Definition 
Type -block in the command bar, then press Enter. 
You are prompted: Name for new block, or ? to list existing blocks:  

Type the name of the block in the command bar and press Enter. 

You are prompted: The block <name> already exists. Do you want to redefine it? <N>. 
A prompt menu displays. 

 

 

To redefine the block definition, do one of the following:  

Type Y, then press Enter.  

Choose Yes-Redefine block in the prompt menu.  

You are prompted: Insertion point for new block: 

Specify the insertion point of the new block. 
You are prompted: Select entities for block.  

Select the entities for the new block.  

Right click to create the block. 

The selected entities are removed from the drawing. 
All existing instances of the block are updated.  

(option) To bring back the selected block entities, type oops in the command bar, then press 
Enter.  

To Reload an External Drawing as a Block 
Do one of the following  

Click the Insert Block... tool button ( ) on the Draw toolbar.  

Choose Insert Block... in the Draw menu.  

Type insert in the command bar, then press Enter.  

The Insert Block dialog opens. 

On the Insert Block dialog click the Browse button, then select the external drawing file.  

Click the Insert button. 
An alert box displays.  

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/12_02_Editing_blocks_and_external_references.htm
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Click the Yes button to redefine the existing block definition. 
You are prompted: Insertion point for block:  

Continue with step 3 of the Inserting Blocks procedure. 

 

Exploring Blocks 

The Explblocks command opens the Blocks section of the Drawing Explorer dialog box (short for 
"explorer blocks"). 

In the Blocks Explorer you can: 

Create new blocks ( ) 

Delete blocks ( ) 

Purge unused block definitions ( ) 

Insert blocks ( ) in the current drawing 

Insert  external block files ( ) 

Save a block as a (new) drawing ( ) 

Cut ( ) or Copy ( ) a block definition, then Paste ( ) the block definition in another 

drawing 

Rename a block. 

Open the Blocks Explorer 
To open the Blocks Explorer do one of the following: 

Choose Drawing Explorer > Blocks... in the Tools menu. 

Type expblocks in the command bar. 

The Blocks Explorer display options 
You can choose between Detail View (list) and Icon View (thumbnails) to see the blocks in the 
current drawing. 

Open the Detail View of the Blocks Explorer 

Click the Detail View button ( ) in the Drawing Explorer toolbar. The Detail View button is now 
pressed indicating the block details are displayed. 

A preview of the selected block displays in the Preview sub-window of the Drawing Explorer. 
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Detail view of the Blocks Explorer 

Open the Icon View of the Blocks Explorer 

Click the Icon View button ( ) in the Drawing Explorer toolbar. The Icon View  button is now 
pressed indicating the block icons are displayed. 
A preview of the selected block displays in the Preview sub-window of the Drawing Explorer. 

  

 

Icon View of the blocks in the current drawing 
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To rename a block 

Open the Blocks Explorer dialog.  

Select the block, then click the Block Name field.  

Type a new name in the Block Name field and press Enter. 

Exploding Blocks 

Command: EXPLODE 

If the Explodable property of a block is set, you can explode an inserted block to its original 
component entities. Exploding a block affects that single instance of the block only. The original 
block definition remains in the drawing and you can still insert additional copies of the original 
block. If you explode a block that contains attributes, the attributes are lost, but the original 
attribute definitions remain. 

Do one of the following: 

Click the Explode tool button ( ) on the Modify toolbar. 

Choose Explode in the Modify menu. 

Type explode in the command bar, then press Enter. 

You are prompted: Select entities to explode. 

Select the block(s). 

Press Enter or right click to explode the blocks. 

NOTE Exploding dissociates component entities to their next simplest level of complexity: 

nested blocks or polylines in a block become blocks or polylines again. 

  

Setting the Explodable property of a block 

Do one of the following: 

Choose Drawing Explorer > Blocks... in the Tools menu. 

Type expblocks in the command bar, then press Enter 

The Drawing Explorer - Blocks dialog displays. 

If necessary, click the Detail View tool button ( ) in the Drawing Explorer - Blocks toolbar. 

Click  the checkbox in the Explodable field of a block to toggle the property. 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/00_03_Managing_Blocks.htm%23Open_the_Blocks_Explorer
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Dynamic Blocks 

BricsCAD partly supports dynamic blocks, you can:  

insert dynamic blocks from your existing dynamic blocks libraries 

edit the custom properties in the Properties Bar 

grip edit dynamic blocks 
The creation of new dynamic blocks is not possible yet. 

  

 

Dynamic Grips and Tips  

  

Edit a Dynamic Block 

Select the dynamic block in the drawing. 
The properties of the selected block display in the Properties Bar.  

 

Under Attributes > Custom: edit the properties needed. 
The dynamic block is updated automatically.  

 

file:///D:/BricsCAD%20Training/manuals/01_User_Interface/00_06_Properties_Bar.htm
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Grip Editing Dynamic Blocks 
Select the dynamic block in the drawing. 
The following grip types display:  

Point  

XY  

Linear  

Polar  

Rotation  

Flip  

Visibility  

Drag a grip to edit the block. 
In the example below:  

Rotate the block (1): drag the grip to rotate the block dynamically or type a value in the 
dynamic entry field.  

Show/hide entities (2): click to select an optin.  

Flip (3): click to mirror the block  

Edit the length (4): select the grip to dynamically edit the length or type a value in the 
dynamic entry field.  
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Working with attributes 

An attribute is a particular entity that you can save as part of a block definition. Attributes consist 

of text-based data. You can use attributes to track such things as part numbers and prices. 
Attributes have either fixed or variable values. When you insert a block containing attributes, the 
program adds the fixed values to the drawing along with the block, and you are prompted to 
supply any variable values. 

After you insert blocks containing attributes, you can extract the attribute information to a 
separate file and then use that information in a spreadsheet or database to produce a parts list or 

bill of materials. You can also use attribute information to track the number of times a particular 
block is inserted into a drawing. 

Attributes can be visible or hidden. Hidden attributes are neither displayed nor plotted, but the 
information is still stored in the drawing and written to a file when you extract it. 

General procedure to work with attributes 

Define the attributes. 

Create a block. 

You can attach attributes to a block. Include the attributes when the program prompts you to 
select the entities to be included in the block definition. If a block contains attributes, the program 

prompts you each time you insert the block, so you can specify different values for the attributes 
each time you insert it into a new drawing. 
Insert the block in a drawing. 

(option) Edit the attributes in a block. 

Extract attribute information. 

 

The Attdef command defines how a block's attributes will be created through a dialog box. 

The -Attdef command creates block's attribute definitions at the command prompt. 

General procedure to define attributes: 

specify the characteristics of the attribute, including its name, prompt, and default value;  

specify the location  

define the text formatting 

optionally: set the attribute flags (hidden, fixed, validate or predefined). 

To Define an Attribute 
Do one of the following:  

Click the Define Attributes... tool button ( ) on the Tools toolbar.  

Choose Define Attributes...  in the Tools menu.  

Type attdef in the command bar, then press Enter.  

The Define Attribute dialog opens. 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/12_02_01_Defining_Attributes.htm
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Define the Attribute:  

Type a name in the Tag field. 
The Tag Identifies each occurrence of an attribute in the drawing. The name you type in 
the Tag field can be any combination of characters except spaces. Lowercase letters are 
automatically converted to uppercase.  

Type a prompt in the Prompt field. 

The attribute prompt displays when you insert a block containing the attribute. If a prompt 
is omitted, the Tag is used as the prompt instead.  

Do one of the following:  

Type a default value in the Default text field. 
For variable attributes, the default value is replaced by the actual value when you insert a 
block containing the attribute.  

Click the Insert Field button ( ) to assign a field value to the attribute (see Using sheet 
set and sheet properties in a title block).  

If the Multiple lines flag is checked, the Default text field is dimmed. 
 

 
Click the button next to the Default text field. 
The Define Attribute dialog temporarily closes to let you create a Mtext entity.  

Do one of the following:  

Specify the x-, y-, and z-coordinates for the attribute insertion point.  

Click the Pick Point button ( ) to specify the insertion point in the drawing. 

You are prompted: Select insertion point. 
The Define Attribute dialog closes temporarily.  

file:///D:/BricsCAD%20Training/manuals/10_Drawing_Entities/05_Working_with_Text/10_05_08_Working_with_Fields.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/12_02_01_Defining_Attributes.htm%23SheetPropsInTitleBlocks
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/12_02_01_Defining_Attributes.htm%23SheetPropsInTitleBlocks
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(option) Set the Invisible attribute flag. 

Attributes with the Invisible flag set do not display nor print. 
If the ATTMODE (Attribute Display Mode) variable is set to 2, all attributes display, including 
Hidden attributes.  

(option) Set the Constant attribute flag. 
Attributes with the Constant flag set cannot be edited.  

(option) Set the Verify attribute flag. 
Attributes with the Verify flag set must be explicitly validated when a block containing such 
attributes is inserted.  

(option) Set the Preset attribute flag. 
When inserting a block you are not prompted to define attributes of which the Preset flag is set. 
You can edit attribute afterwards though.  

(option) Set the Lock Position attribute flag to lock the position of the attribute within the block 

reference.  

Unlocked attributes can be moved relative to the rest of the block using grip editing and multiline 
attributes can be resized.  

Define the Text properties: Text Style, Justification, Annotative, Text height and Rotation.  

Click the OK button to create the attribute in the drawing. 
The Define Attribute dialog closes.  

(option) Right click to reopen the Define Attribute dialog, then repeat steps 2 and 3 to create 
another attribute.  

Sheet Set Properties in a Title Block 

Create the sheet set.  

Define the custom sheet set and sheet properties.  

Open a sheet (layout) from the sheet set.  

Create the title block source entities in the paper space layout:  

Create the borders, line work and fixed texts.  

Create attributes with fields that refer to sheet set, subset and sheet properties (see To 
define an attribute).  

See the SHEETSET command to learn more about default and custom sheet set, subset and sheet 

properties. 

Custom sheet set properties: 

 

  

Sheet properties and sheet custom properties: 

file:///D:/BricsCAD%20Training/manuals/10_Drawing_Entities/05_Working_with_Text/10_05_08_Working_with_Fields.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/12_02_01_Defining_Attributes.htm%23DefineAttribute
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/12_02_01_Defining_Attributes.htm%23DefineAttribute
bricscad-cmdref.chm::/S/SheetSet.htm
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Create a block from the title block source entities.  

Copy the block to drawing in one of your block folders (see To insert a block form another 
drawing).  

Delete the title block source entities.  

The title block can be inserted in the other sheets of the sheet set and in any other sheet set 
where the same custom sheet set and sheet properties exist. All fields that refer to default or 

custom sheet set, subset or sheet properties are filled out automatically. If no value is available, a 

field displays hyphens (----) (see also Placing blocks with attributes). 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/01_Blocks/12_01_01_Creating_Blocks.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/01_Blocks/12_01_02_Inserting_Blocks.htm%23InsertBlockFromOtherDrawing
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/01_Blocks/12_01_02_Inserting_Blocks.htm%23InsertBlockFromOtherDrawing
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Editing Attribute Definitions 

Command: DDEDIT 

The Ddedit command edits single-line text, multi-line text, attribute definitions, and attribute text 
(short for "dynamic dialog editor"). 

You can edit an attribute definition only before it is saved as part of a block definition. 

Do one of the following: 

Type ddedit in the command bar, then press Enter and select the attribute. 

Double click the attribute. 

The Edit attribute definition dialog opens. 

 
(option) Type a new name in the Tag field. 
Lowercase letters are converted to uppercase automatically. 

(option) Type a new prompt in the Prompt field. 
If you leave the Prompt field empty, the attribute Tag will be used as the prompt instead. 

(option) Type a new text in the Default field. 

Press the OK button to save your changes. 

To edit an attribute definition 

Click the attribute. 
The attribute properties display in the Properties Bar. 

bricscad-cmdref.chm::/D/Ddedit.htm
file:///D:/BricsCAD%20Training/manuals/01_User_Interface/00_06_Properties_Bar.htm
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Modify the attribute properties in the Properties Bar fields. 

Press the Esc key to stop editing. 

  

NOTE Make sure the Properties Bar is open before starting this procedure. 

 

Using the Attribute Editor 

Command: EATTEDIT 

The Eattedit command edits the attributes in blocks. You are prompted to select a block with 

editable attributes. When you select such block, the Attribute Editor dialog displays. If the selected 
block does not contain attributes or if the selected entity is not a block you are prompted to select 
another block. 

Do one of the following 

Click the Edit Block Attributes... tool button ( ) on the Attributes toolbar. 

Choose Edit Block Attributes... in the Tools | Attributes menu. 

Type eattedit in the command bar, then press Enter. 

You are prompted: Select a block: 

or 

Double click a block containing attributes, then go to step 3. 

Select a block with attributes. 
The Attribute Editor dialog opens. 

file:///D:/BricsCAD%20Training/manuals/01_User_Interface/00_06_Properties_Bar.htm
bricscad-cmdref.chm::/E/EAttEdit.htm
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Select an attribute in the list. 
The current value of the selected attribute displays in the Value field. 

(option) Type a new value in the Value field. 

(option) Click the Properties tab to modify Layer, Color, Lineweigth and/or Linetype. 

(option) Click the Text Options tab to edit the text properties. 

 

(option) Click the Apply button to apply the changes. 

(option) Repeat steps 3 through 6 to edit another attribute. 

Do one of the following: 

Click the OK button to close the  Attribute Editor dialog and apply the changes. 

Click the Apply button to apply the changes and keep the  Attribute Editor dialog open. 

Click the Cancel button to close the Attribute Editor dialog. Changes that are not applied 
yet are not saved. 

Click the Select button ( ) to select another block. 
The Attribute Editor dialog temporarily closes to let you select another block in the drawing. 



  User Guide 

 558 

Editing attributes in the Properties bar 

Select a block containing attributes. 
The current value of the attributes display in the Properties bar. 

Click the attribute you want to edit. 
The settings field of the selected attribute is active. 

 

 

Type a new value, then press enter or select another attribute. 

Placing Blocks with Attributes 

Commands: INSERT and -INSERT 

When you place a block which contains attributes, you will be prompted to define the attributes in 
the command bar or through a dialog box. 

If the ATTDIA system variable is ON, attributes display in a dialog box. 

If the ATTDIA system variable is OFF, you are prompted in the command bar to define the 
attributes. 

To place a block with attributes 

Launch the Insert Block... tool. 

Position the block in the drawing. 

All block entities are placed in the drawing, except the attributes. 

You are prompted: <Attribute Prompt> <Default Text>: 

file:///D:/BricsCAD%20Training/manuals/01_User_Interface/00_06_Properties_Bar.htm
bricscad-cmdref.chm::/I/Insert/Insert.htm
bricscad-cmdref.chm::/I/Insert/-Insert.htm
bricscad-sysvar.chm::/00_07_Settings_Manager.htm
bricscad-sysvar.chm::/00_07_Settings_Manager.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/01_Blocks/12_01_02_Inserting_Blocks.htm%23To_insert_a_block
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A dialog box displays: 

  

 
Do one of the following: 

In the command bar: The command bar reads: <Attribute Prompt> <Default Text>: 

Press Enter or right click to accept the default text. 

Type a new text in the command bar, then press Enter and define the next attribute. 

In the Edit Attributes dialog box: 

Select an attribute in the list. 
The current value displays in the Value field. 

Type a new value in the Value field. 

Press OK when all attributes are properly defined. 

Extracting Attribute Information 

Command: ATTEXT and - ATTEXT, DATAEXTRACTION 

The Attext command copies data from attributes to a text file via a dialog box. 

The -Attext command copies data from attributes to a text file via the command line. 

The text file can the be imported in a database or a spreadsheet. 

You can save the file in any of the following formats: 

Comma Delimited Format (CDF): Contains one line for each instance of a block, with 
individual attribute fields separated by commas. Character string fields are enclosed with 
single quotation marks. You must specify a template file when extracting to a CDF file.  

Space Delimited Format (SDF): Contains one line for each instance of a block. Each 

attribute field has a fixed length; there are no separators or character string delimiters. 
You must specify a template file when extracting to a SDF file.  

Drawing Exchange Format (DXF): Creates a subset of a standard DXF file (a *.dxx file) 
containing all the information about each block, including the insertion points, rotation 
angles, and attribute values. No template file is required.  

Before extracting attributes to a CDF or SDF file, you must create a template file. The template file 
is an ASCII text file that specifies the attribute data fields to be written in the extract file. Each line 
of the template file specifies one attribute field. BricsCAD recognizes 15 different fields, which 

contain elements such as the block name, the x-, y-, and z-coordinates of its insertion point, the 
layer on which it is inserted, etc. You can include any of these fields. The template file must include 
at least one attribute name. 

Each line in the template file must start with the field name. Block name and insertion-point values 
must begin with BL:. The next nonblank character must be either a C (indicating a character string 
field) or an N (indicating a numeric field). This character is then followed by three digits indicating 

the width of the field (in characters). The final three digits indicate the number of decimal places 

(for numeric fields). In the case of character fields, the last three digits must be zeros (000). A 
typical template file is similar to the one shown here: 

bricscad-cmdref.chm::/A/AttExt/AttExt.htm
bricscad-cmdref.chm::/A/AttExt/-AttExt.htm
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A. Field name 

B. Field format 

1. Block name (must be preceded by BL:) 

2. Coordinate fields (must be preceded by BL:) 

3. Attribute tags 

4. Indicates the field data type: C for character fields, N for numeric fields 

5. Field width (number of characters) 

6. Number of decimal places for numeric fields, 000 for character fields 

To extract attribute information 

Do one of the following: 

Click the Extract Attributes tool button on the Tools toolbar. 

Choose Extract Attributes in the tools menu. 

Type attext in the command bar, then press Enter. 

The Extract Attributes dialog opens. 
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Click the Select button. 

The Extract Attributes dialog closes temporarily. 

Select the blocks, then press Enter or right click. 
The Extract Attributes dialog reopens. 

Select the text file format: DXF (drawing exchange format), CDF (comma delimited format) or SDF 
(space delimited format). 

Select the Template file. 

Specify the Output file name. 

Click the Extract button. 
You are prompted: <number> records extracted. 
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Working with external references 

You can link entire drawings to the current drawing as external references. Unlike inserting a 

drawing as a block, in which you add all the entities from the separate drawing into the current 
drawing, external references attach a pointer to the external file. The entities in the external 
reference appear in the current drawing, but the entities themselves are not added to the drawing. 
Thus, attaching an external reference does not significantly increase the size of the current 
drawing file. 

External references provide additional capabilities not available when you insert a drawing as a 

block. When you insert a drawing as a block, the entities are stored in the drawing. Any changes 
you make to the original drawing are not reflected in the drawing in which you inserted it. When 
you attach an external reference, however, any changes you make to the original drawing file are 
reflected in the drawings that reference it. These changes appear automatically each time you 
open the drawing containing the external reference. If you know that the original drawing was 

modified, you can reload the external reference anytime you're working on the drawing. 

External references are useful for assembling master drawings from component drawings. Use 

external references to coordinate your work with others in a group. External references help 
reduce drawing file size and ensure that you are always working with the most recent version of a 
drawing. 

  

Commands: XREF, -XREF, XATTACH and XCLIP 

The Xref command attaches DWG files to the current drawing through the Drawing Explorer (short for 
"external reference"). 

The -Xref command attaches DWG files to the current drawing through the command bar. 

The Xattach command attaches externally-referenced drawings through a dialog box (short for 
"external attach"). 

The Xclip command clips externally-referenced drawings, and adjust front and rear clipping planes 

(short for "xref clip"). 

The XDWGFADECTL system variable controls the fading of exnternal references. Values between 0 
(no fading) and 90 are accepted. 

The fading factor affects the screen display only, not the printing. 

 

 

External References (elevations) display faded: XDWGFADECTL + 50 
 

bricscad-cmdref.chm::/X/XRef/XRef.htm
bricscad-cmdref.chm::/X/XRef/-XRef.htm
bricscad-cmdref.chm::/X/XAttach.htm
bricscad-cmdref.chm::/X/XClip.htm
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The XNOTIFYTIME system variable defines the frequency to check for modified externally 

referenced resources: xrefs, images and pdf attachments if XREFNOTIFY, IMAGENOTIFY and/or 
PDFNOTIFY  is ON. 

  

 

Command: XATTACH 

The Xattach command attaches a drawing as an external reference (xref). The attached xref 
appears as an insert in the current drawing. Like blocks, attached xrefs can be nested. The 
attached drawing is based on the most recently saved version. 

The origin point used when attaching an external reference is controlled by the INSBASE (insertion 

base point) settings variable. Use the BASE command to define the INSBASE variable in the 
external reference drawing.  

To attach an external reference 

Do one of the following 

Click the Attach Xref... tool button ( ) on the Insert toolbar. 

Choose  Attach Xref... in the Insert menu. 

Type xattach in the command bar, then press Enter. 

Click the Attach Xref tool button ( ) on the Details  toolbar on the Drawing Explorer / 
Xrefs window. 

The Attach External Reference dialog window displays. 

Select the drawing you want to attach, then press the Open button on the Open dialog window. 
The Attach External Reference dialog window opens: 

bricscad-cmdref.chm::/X/XAttach.htm
bricscad-cmdref.chm::/B/Base.htm
file:///D:/BricsCAD%20Training/manuals/20_Managing_Drawings/00_02_Drawing_Explorer.htm%23How_to_open_the_drawing_explorer
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The full path to the selected drawing displays in the Path field. 

(option) Select the Path Type:  

 

 

 

Choose the External Reference Type: 

Attachment: If the current drawing is attached as an xref to another drawing, an 
attachment becomes a nested xref. 

Overlay: An overlay is ignored when the drawing to which it is attached is then attached as 
an xref to another drawing.  

Choose whether to specify the Insertion Point  on screen or in the X-, Y-, Z-fields. 

Choose whether to specify the Scale on screen or in the X-, Y-, Z-fields. 

Check the Uniform Scale option to specify the scale in the X-field. 

Choose whether to specify the Rotation angle on screen or in the Angle field. 

Click the OK button to attach the Xref. 
Depending on the options in steps 5, 6 and 7 you are prompted to specify the insertion point, scale 
and/or rotation angle. 

 

NOTE The Unit field under Block Unit is set by the INSUNIT (Insertion Units) system variable in 
the external reference. The Factor field expresses the relation between the value of the 
INSUNIT system variable in the xref and the parent drawing. 

 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/01_Blocks/12_01_02_Inserting_Blocks.htm%23Insunit
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Managing Xrefs 

Command: XREF 

The Xref  command opens the External References section of the Drawing Explorer dialog box. 

  

 

  

The Drawing Explorer - External References dialog allows to: 

Attach a drawing as an external reference ( ). 

Detach an external reference ( ). 

Reload an external reference ( ). 

Unload an external reference ( ). 

Bind an external reference ( ). 

Insert an external reference ( ). 

Modify the attachment type: Attach or Overlay. 

Modify the Saved Path of an xref. 

Modify the Found Path of an overlay. 

bricscad-cmdref.chm::/X/XRef/XRef.htm
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To detach external references 

Select the xref(s) you want to detach. 
Press and hold the Ctrl key to select multiple xrefs or to unselect a selected xref. 

Click the Detach Xref tool button ( ) on the Details toolbar. 
The selected xref(s) are detached. You are not prompted to confirm the detachment. 

To unload external references 

Do one of the following: 
Click the Loaded column of a loaded Xref. 

Select the Xref(s), then either click the Unload Xref tool button ( ) on the Details toolbar 
or click the Loaded column of one of the selected Xrefs. 

To reload external references 

Do one of the following: 

Click the Loaded column of an unloaded Xref. 

Select the Xref(s), then either click the Reload Xref tool button ( ) on the Details toolbar 
or click the Loaded column of one of the selected Xrefs. 

Editing Blocks and External References 

Commands: REFEDIT, -REFEDIT, REFSET and REFCLOSE 

  

The Refedit command edits block references and externally-referenced drawings (Xrefs) through a 
dialog box (short for "reference editor"). Refedit is referred to as in-place reference editing. 
RefEdit either works on a portion of the reference or on the entire drawing or all entities in the 
block. 

The -Refedit command edits block references and externally-referenced drawings through the 
command bar. 

The Refset command adds and removes entities from the reference being edited. 

The Refclose command closes the reference editor. 

The XFADECTL system variable sets the fading level for the entities which are not in the working in 
the current refedit session. Values between 0 (no fading) and 90 are accepted. 

  

To edit Xrefs or blocks 

Do one of the following: 

Click the Refedit tool button ( ) on the Refedit toolbar. 

Type refedit in the command bar, then press Enter. 

You are prompted: Select reference: 

Click the Xref or block. 

Double click the Xref or block. 

bricscad-cmdref.chm::/R/RefEdit/RefEdit.htm
bricscad-cmdref.chm::/R/RefEdit/-RefEdit.htm
bricscad-cmdref.chm::/R/RefSet.htm
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The Reference Edit dialog opens. 

 

 

The Reference Edit dialog helps you to visually identify the reference to edit and controls how the 
reference is selected. 

Path: Location of the selected reference; if the reference is a block, no path is displayed. 

Reference Name: The name of the currently selected reference and any references, that 
are nested within the selected reference.  

Preview: Displays the reference as it was last saved in the drawing. Please note that the 

preview image is not updated when changes are saved back to the reference. 

(option) If multiple nested references display in the Reference name tree, select a reference to 
modify.  
Click the expand/collapse button to show/hide nested references. 
You can edit only one reference a time. 

Select one of the following to Select nested entities ...: 
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Automatically: All the entities and nested blocks in the selected reference are  included in 

the reference editing session. 

Prompt: After you close the Reference Edit dialog, you are prompted to select the enties 
and nested blocks in the reference that you want to edit. Only these entities will be 
temporarily extracted and be made available for modification within the context of the 
current drawing.  

This temporary working set of entities can be edited and then saved back to update the reference 
being edited. To distinguish 'current drawing' from 'editing set' BricsCAD displays all the entities of 
the current drawing as faded. The fading level is controlled through the XFADECTL settings 
variable, of which the default value is set to 50. 
 

Check the Settings: 

Enable unique layer and symbol names:  

If selected, named objects in xrefs are altered, adding a $#$ prefix.  

If cleared, the names of layers and other named objects remain the same as in the 
reference drawing. 

Display attribute definitions for editing: Controls whether attribute definitions in blocks are 
extracted and displayed during reference editing.  

Lock entities not in working set: Entities in the reference being edited that are not 
included in the temporary working set (see step 5) cannot be manipulated, nor entities in 
the host drawing or other Xrefs.  This behavior is similar to objects on locked layers. 

Click the OK button to start editing the working set (see step 5). 
The Reference Edit dialog closes. 

(option) Click the Add to Refedit tool button ( ) to add entities to the working set. 
The selected entities will be removed from the host drawing and added to the reference being 
edited when the working set is saved back. 

(option) Click the Remove from Refedit tool button ( ) to remove entities from the working set. 

The selected entities will be removed from the reference being edited when the working set is 
saved back. These entities are added to the host drawing. 

Do one of the following: 

Click the Refclose and Save button ( ) to save the changes back to the Xref source 
drawing or the block definition in the current drawing. 

Click the Refclose and discard button ( ) to stop the refedit session without saving. The 
source drawing or block definition is left unchanged. 
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Working with Groups 

To Create a Group 

Do one of the following:  

Click the Group tool button ( ) on the Tools toolbar.  

Choose Group in the Tools menu.  

Type group in the command bar, then press Enter.  

The Entity Grouping dialog window opens: 

 

Do one of the following:  

Type a name in the Name field.  

Check the Unnamed option to create an unnamed group.  

(option) Type a description in the Description field.  

(option) Check / uncheck the Selectable option.  

Click the Select entities and create group button. 
The Entity Grouping dialog temporarily closes to let you select entities.  

Select the entities you want to include in the new group.  

Right click to conclude the selection of entities. 

The Entity Grouping dialog reopens. 

The newly created group is added.  

Click the OK button to close the Entity Grouping dialog  

file:///D:/BricsCAD%20Training/manuals/11_Modifying_Entities/01_Selecting_Entities/11_01_01_Selection_Methods.htm
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To Modify a Group 

Do one of the following:  

Click the Group tool button ( ) on the Tools toolbar.  

Choose Group in the Tools menu.  

Type group in the command bar, then press Enter.  

The Entity Grouping dialog window opens. 

Select the group you want to modify.  

(option) Double click in the Name field to edit the group name.  

(option) Double click in the Description field to edit the group description.  

(option) Click in the Selectable column to toggle the Selectable option on/off.  

(option) Click the Add entities to group button to add new entities to the group. 
The Entity Grouping dialog temporarily closes to let you select the new group entities.  

(option) Click the Remove entities from group button to remove entities from the group. 

The Entity Grouping dialog temporarily closes to let you select the entities.  

Click the OK button to close the Entity Grouping dialog  

To Ungroup Entities 

Do one of the following:  

Click the Group tool button ( ) on the Tools toolbar.  

Choose Group in the Tools menu.  

Type group in the command bar, then press Enter.  

The Entity Grouping dialog window opens. 

Select the group or groups you want to delete.  

Click the Un-group selected groups button. 

The selected groups are removed.  

  

NOTE When you ungroup entities, the entities remain in the drawing but the group is deleted 

from the drawing. 

 

To Change the Order of Entities 

Do one of the following:  

Click the Group tool button ( ) on the Tools toolbar.  

Choose Group in the Tools menu.  

Type group in the command bar, then press Enter.  

The Entity Grouping dialog window opens. 

Click the Re-Order entities button. 
The Order Group dialog opens:  
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(option) Click the Highlight button to see the current position of each entity. 
The Object Grouping box opens. 

 

 
   

(option) Click the Reverse Order button to reverse the order of all entities in the group.  

(option) To change the order of a single entity do the following:  

In the Remove from position field type the current position of the entity you want to move.  

In the Enter new position number for the object field type the new position.  

(option) Type the number  of objects you want to reorder in the Number of objects field.  

 

Click the Re-Order button. 
A message box displays. 

 



  User Guide 

 572 

Working with Underlays 

Do one of the following:  

Click the Attach pdf tool button ( ) on the Insert toolbar.  

Click the New tool button ( ) on the Details toolbar of the Drawing Explorer - PDF 
Underlays dialog.  

Type PDFattach in the command bar, then press Enter.  

The Select PDF Underlay File dialog opens. 

Select the file, then double click the file or click the Open button on the Select PDF Underlay File 
dialog. 
The Attach PDF Underlay dialog opens.  

 

In case of a multi-page PDF, click the down arrow in the Name field, then select the page of the 
PDF you want to load.  

Click the Path option button, then select either:  

Full path: The full path will be searched when the drawing is loaded. If the overlay is not 
found there, the folder of the parent drawing is searched. If the overlay file is not found 
there either, "Missing or invalid reference" displays at the insertion point of the PDF 
overlay.  

Relative path: The relative path, with respect to the folder of the parent drawing, will be 
searched when the drawing is loaded. If the overlay is not found there, the folder of the 
parent drawing is searched. If the overlay file is not found there either, "Missing or invalid 

reference" displays at the insertion point of the PDF overlay.  

No path: Only the folder of the parent drawing is searched when the drawing is loaded. If 
the overlay file is not found there, "Missing or invalid reference" displays at the insertion 
point of the PDF overlay.  

Choose whether you want to specify the Insertion Point, Scale and the Rotation angle on-screen or 
not.  

Click the OK button. 

The Attach PDF Underlay dialog closes.  

Depending on the insertion options chosen in the previous step you are prompted to specify the 
Insertion Point, Scale and/or Rotation angle.  

file:///D:/BricsCAD%20Training/manuals/20_Managing_Drawings/00_02_Drawing_Explorer.htm
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Inserting a PDF Underlay 

If you want to insert a second instance of a PDF that is already attached or another page of such 
underlay do the following: 

Choose Drawing Explorer > PDF Underlays... in the Tools menu. 
The Drawing Explorer - PDF Underlays dialog opens.  

Select the PDF underlay.  

Do one of the following:  

Right click and choose Insert in the context menu.  

Choose insert in the Edit menu on the Drawing Explorer - PDF Underlays dialog.  

The Drawing Explorer - PDF Underlays dialog closes. 

Continue with steps 3 through 7 of the previous procedure.  

Controlling  the Display of a PDF Underlay 

Click the frame of the PDF underlay. 
The frame of the selected PDF highlights. 
The properties of the underlay display in the Properties Bar.  

Under Misc, click Show underlay in the Properties Bar, then select Yes or No.  

Setting the Layer Display in a PDF Underlay 

Type PDFlayers in the command bar, then press Enter. 
You are prompted: Select PDF underlay.  

Click the frame of the PDF underlay. 
The frame of the selected PDF highlights. 
The Underlay Layers dialog opens.  

 

The icon in the On column indicates the current state of the layers On ( ) or Off ( ). 

Click the icon in the On column to toggle the display of a layer.  

(option) Click the Search for layer field, then type a layer name to search for a layer. 
Use wildcard characters (? or *)  to limit the number of layers in the list:  

file:///D:/BricsCAD%20Training/manuals/01_User_Interface/00_06_Properties_Bar.htm
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Layernames starting with 'S_' only. 

 

Layernames of which the second and third character is '_F' only. 

 

Do one of the following:  



BricsCAD V18  Help 

 

 575 

 

Clipping a PDF Underlay 

Type pdfclip in the command bar, then press Enter. 
You are prompted: Select PDF underlay:  

Click the frame of the PDF underlay. 

The frame of the selected PDF highlights. 
You are prompted: Enter PDF clipping option [ON/OFF/Delete/New] <New>: 
A prompt menu displays:  

 

Do one of the following:  

Choose New boundary in the prompt menu.  

Press Enter to accept the New default command option.  

You are prompted: Enter PDF clipping type [Polygonal/Rectangular] <Rectangular>:  

Do one of the following:  

Press Enter to accept the Rectangular default command option to define a rectangular 
clipping boundary.  

Type P, then press Enter to define a polygonal clipping boundary.  

Define the clipping boundary. 
The defining points must lie inside the frame of the PDF underlay. If you click outside the PDF 

underlay the point is placed on the PDF underlay frame.  

To Toggle the Display of the Clipped Part 

Click the frame of the PDF underlay. 

The frame of the selected PDF highlights. 
The properties of the underlay display in the Properties Bar.  

Under Misc, click Show clipped  in the Properties Bar, then select Yes or No.  

Deleting a Clipping Boundary 

Type pdfclip in the command bar, then press Enter. 

You are prompted: Select PDF underlay:  

Click the frame of the PDF underlay. 
The frame of the selected PDF highlights. 
You are prompted: Enter PDF clipping option [ON/OFF/Delete/New] <New>: 

A prompt menu displays:  

 

Do one of the following:  

Choose Delete boundary in the prompt menu.  

Type D in the command bar, then press Enter.  

The clipping boundary is deleted and the complete PDF underlay displays. 

  

file:///D:/BricsCAD%20Training/manuals/01_User_Interface/00_06_Properties_Bar.htm
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To adjust the display settings of a PDF underlay 

The PDFADJUST command allows to adjust the Fade, Contrast and Monochrome settings of a PDF-
underlay in the command bar. 

Select the PDF underlay, then adjust the display settings under Underlay Adjust the Properties 
Bar: 

 

bricscad-cmdref.chm::/P/PdfAdjust.htm
file:///D:/BricsCAD%20Training/manuals/01_User_Interface/00_06_Properties_Bar.htm
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Managing Images 

Open the Images Explorer 

To open the Images Explorer do one of the following: 

Choose Drawing Explorer > Images in the Tools menu.   

Click the Image Management tool button ( ) in the Images toolbar. 

Type image in the command bar, then press Enter. 

Select Images in the Open Drawings sub-window of the Drawing Explorer.   

In the Images Explorer you can: 

See a preview of the attached images 

Place images ( ) or ( ) 

Load / Unload inserted images 

Detach images ( ) 

Open the Detail View of the Images Explorer 

Click the Detail View button ( ) in the Drawing Explorer toolbar. The Detail View button is now 
pressed, indicating the image details are displayed. 

The selected image displays in the Preview sub-window of the Drawing Explorer. 

  

 

Detail View of the images in the current drawing 

  

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/20_Managing_Drawings/00_02_Drawing_Explorer.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/00_05_Managing_Images.htm%23Images_Display_Options
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/00_05_Managing_Images.htm%23Placing_images_in_a_drawing
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/00_05_Managing_Images.htm%23Load___Unload_Images
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/00_05_Managing_Images.htm%23Detach_Images
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Open the Icon View of the Images Explorer 

Click the Icon View button ( ) in the Drawing Explorer toolbar. The Icon View button is now 
pressed, indicating the image icons are displayed. 
The selected image displays in the Preview sub-window of the Drawing Explorer. 

  

 

Icon View of the images in the current drawing 

  

Open the Tree View of the Images Explorer 

Click the Tree View button ( ) in the Drawing Explorer toolbar. The Tree View button is now 
pressed, indicating the image tree is displayed. 
The selected image displays in the Preview sub-window of the Drawing Explorer. 
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Tree View of the images in the current drawing 

  

Placing Images in a Drawing 

Do one of the following:  

Launch the Image Explorer, then click the New tool button ( ) in the Drawing Explorer - 
Images toolbar.  

Launch the Image Explorer, select a raster image file in the list,  then click the Insert tool 

button ( ) in the Drawing Explorer - Images toolbar.  

Click the Attach Raster Image tool button ( ) in the Insert toolbar.  

The Attach Raster Image dialog opens. 
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Do one of the following:  

Accept the currently selected image file.  

Click the down arrow button in the Name field to select a different raster image file in the 
list. 
Raster images which are already attached are listed.  

Click the Browse button to select a new raster image file in the Select Raster Image dialog.  

(option) Check the Use Geocoding Information option, then click the Browse button to open an 
appropriate world file to be used with the selected raster image. 
If the Use Geocoding Information option is checked, the Insertion Point, Scale and Rotation 
settings fields are not available. 

(option) Do the following:  

Specify an insertion point or select the Specify on-screen check box.  

Specify scale or select the Specify on-screen check box.  

Specify rotation angle or select the Specify on-screen check box.  

Click the OK button.  

If none of the Specify on-screen options is selected, the image is inserted at the desired insertion 
point, scale and rotation angle; 
else 
You are prompted to specify the insertion point, scale and/or rotation angle on-screen.  

Load/Unload Images 

When an image is attached and then inserted in the drawing, you can unload the image to 
temporarily remove it. Unloaded images are still inserted in the drawing, but they no longer 
display. If the Imageframe setting is ON, the frame around the image still displays though. 

Launch the Image Explorer.  
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For the image you want to load or unload, click the check box in the Loaded column. 

 

 

If the Regen On/Off button ( ) is not pressed, click the Regen tool ( ) in the Images Explorer 
toolbar.  

  

NOTE It is not necessary to select the image first in step 2. 

  

Load / Unload multiple images 

Launch the Image Explorer.  

Select the images you want to load or unload.  

For one of the selected images, click the check box in the Loaded column.  

 
All selected images will be loaded or unloaded simultaneously. 

If the Regen On/Off button ( ) is not pressed, click the Regen tool ( ) in the Images Explorer 
toolbar.  

  

NOTE Press and hold the Ctrl key to select multiple images. 
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Removing images 

Since an image is first attached, then inserted in the drawing, you can delete an image, without 
detaching it.  

Detach Images 

Launch the Image Explorer.  

Select the image(s) that you want to detach.  

Do one of the following  

Click the Delete tool button  ( ) in the Images Explorer toolbar.  

Right click and select Delete in the context menu.  

  

NOTE Press and hold the Ctrl key to select multiple images. 

 

Image Transparency 

Do one of the following:  

Click the Image Transparency tool button ( ) on the Images toolbar.  

Choose Image Transparency in the Images menu.  

Type transparency in the command bar, then press Enter.  

You are prompted: Select images. 

Select the images you want to set the Transparency property of. 
You are prompted: Enter transparency mode [ON/OFF]<current mode>: 

A prompt menu displays. 
 

 

Do one of the following:  

Press Enter to accept the current mode.  

Choose On in the prompt menu or type ON  in the command bar, then press Enter to 
switch the Transparency property of the selected images on.  

Choose Off in the prompt menu or type OFF  in the command bar, then press Enter to 
switch the Transparency property of the selected images off.  

 

Transparency OFF (left) and Transparency ON (right) 

 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/11_Modifying_Entities/01_Selecting_Entities/11_01_01_Selection_Methods.htm
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Image Frame Setting 

Click the Image Frame tool ( ) in the Images toolbar. 
You are prompted: Enter image frame setting <1>:  

Do one of the following:  

Type 1 + Enter to display the image frame. 

Type 0 + Enter to hide the image frame. 

To Clip an Image 

Make sure image frames display.  

Do one of the following:  

Click the Clip Image tool button ( ) on the Image toolbar.  

Type imageclip in the command bar, then press Enter.  

You are prompted: Select image: 

Click the image frame. 
You are prompted: Enter image clipping option [ON/OFF/Delete/New] <New>:  

Press Enter to accept the New Boundary default option. 
You are prompted: Enter image clipping type [Polygonal/Rectangular] <Rectangular>:  

Press Enter to accept the Rectangular default option. 
You are prompted: Specify first corner  

Click a point to define the first corner of the clipping rectangle. 
The clipping rectangle displays dynamically. 

You are prompted: Specify opposite corner:  

Click a point to define the clipping rectangle. 

The image is clipped.  

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/13_01_Image_Utilities.htm%23ImageFrameSetting
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To Toggle the Clipping Boundary of an Image 

Make sure image frames display.  

Click the image frame. 
The properties of the image display in the Properties Bar.  

Under Misc / Show clipped choose Yes or No. 

Printing and Plotting 

The Plot command plots drawings to printers and to files, through prompts at the command bar; 

this command is meant for scripts and routines. 

The Print command prints drawings to plotters and files through a dialog box. 

The Qprint command prints the drawing with the default plot configuration, without displaying the 

Print dialog box (short for "quick print"). 

The PageSetup command creates and edits page setups for plotting drawings in the Drawing 
Explorer. 

  

 

Printing a layout  

Creating page setups and layouts  

  

A standard print procedure consists of the following steps: 

Choose either a Layout tab or the Model tab. 

Open the Print dialog. 

Select a Page Setup name. (1) 

The following steps are optional and only necessary if you want to use overrides on the selected 
page setup definition. 

Choose a Printer or Plotter Configuration. (2) 

Choose a Plot style table. (3) 

Choose a Paper Size. (4) 
The image reflects the position and orientation of the drawing on the selected paper size. 

Choose the Paper Units. (5)  

Choose the Drawing Orientation.(6) 

Define the Plot offset. (7) 

Specify the Area to plot. (8) 

Define the Plot Scale. (9) 

Check the Plot Options. (10) 

When printing model space, choose a Shade Plot mode. (11) 
This option is disabled when printing a paper space layout. 

Check/uncheck the Print to file option (12) 

Specify the Number of copies. (13) 

Click the Preview button to see a preview of the plot output. 

When in a layout, click the Apply button to update the layout. 

Click the Print button to start printing. 

  

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/13_01_Image_Utilities.htm%23ImageFrameSetting
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/01_User_Interface/00_06_Properties_Bar.htm
https://blog.bricsys.com/category/tutorials/printing-plotting/
https://blog.bricsys.com/printing-in-bricscad-part-1/
https://blog.bricsys.com/printing-in-bricscad-part-2/
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/04_Viewing_your_drawing/04_11_Layouts.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/04_Viewing_your_drawing/04_09_Model_Space_Viewports.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/15_00_General_procedure_for_printing.htm%23To_open_the_Print_dialog
bricscad-cmdref.chm::/P/PageSetup.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/15_01_Plotter_Configuration.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/15_05_Assign_a_plot_style_table_to_a_drawing.htm
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NOTE All print settings and options are saved in the Model and each of the Layouts. 

  

 

To Open the Print Dialog 

Do one of the following: 

Choose Print...  in the File menu.  

Type print in the command bar, then press Enter.  

Press Ctrl + P  

Select the Model tab or a Layout tab, then right click and choose Print in the context menu.  

  

NOTE If you click the Print ( ) button in the Standard toolbar, the Qprint command is 
launched, which will start printing the currently selected view tab using previously saved 
print settings. 
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To Choose the Paper Size 

Press the down arrow, then select the paper size in the Paper Size list. 

The available sizes depend on the selected printer. 

To Choose the Paper Units 

Select either Inches or Millimeters. 
 

 

The paper size image indicates the size, position and orientation of the plot area on the selected 
paper size. 
  

NOTE The Scale and Plot offset setting units are changed according to the chosen Paper units. 

 

To Choose the Paper Orientation 

Select either Portrait or Landscape. 

• Portrait: The drawing or layout x-axis is aligned with the shortest edge of the selected 
paper size.  

• Landscape: The drawing or layout x-axis is aligned with the longest edge of the selected 
paper size.  

The paper size image changes accordingly. 

When in a layout, click the Apply button to update the display. 

To Define the Plot Offset 

Select either Center on page 

or 

type the plot offset in the X: and Y: fields. 

The offset is calculated from the bottom left corner of the paper. 

  

 

When in a layout, click the Apply button to update the display. 
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To Specify the Area to Plot 

Option Result 

View 
Prints the portion of the drawing that displays in the current viewport or a saved 
view. 

Extents Prints all entities in the drawing 

Limits 
Prints to the limits defined in the drawing 

This option is only available when printing in Model space. 

Layout 
Prints the current layout. 

This option is only available when printing in Paper space. 

Window 

Prints the portion of the drawing contained in a user defined window, maintaining 
the aspect ratio of the windowed area to the drawing.  

Click the Select print area button ( ), then specify the two corners of the print 
area in the drawing. 

or   

Type the the X- and Y-coordinates of the corners of the print area in the X:  and 
Y: fields. 

  

 

  

To Define the Plot Scale 

NOTE The SCALELISTEDIT command allows to edit the list of available scales in the Print dialog 
and the Standard Scale property of a paper space viewport. 

... when printing in paper space: 

If you print in paper space, the final scale of the plot output is the product of the viewport scale 
and the plot scale.  

In order to keep control over the scale of the plot output: 

Specify the width and height of the viewports in drawing units.  

Set the scale of each viewport to the scale you want in the plot output.  

The plot scale reflects the relationship between paper units and drawing units. (see table below)  

Paper units 

  

Drawing units 

  

Plot scale 

  

Printed  

Millimeters  
or Inches 

Drawing Units 

mm mm 1:1 1 1 

mm cm 10:1 10 1 

mm m 1000:1 1000 1 

inches inches 1:1 1 1 

inches feet 12:1 12 1 

  

... when printing in model space: 

If you print in model space, the scale of the plot output equals the plot scale, on condition your 

drawing units equal the paper units. Otherwise you need to multiply the plot scale with respect to 

the relationship between paper units and drawing units. E.g. if you want to plot at a 1/50 scale in a 
drawing of which 1 DU = 1 cm, the plot scale = 1/5, if 1 DU = 1 m the plot scale = 20/1 or 1/0.05 

bricscad-cmdref.chm::/S/ScaleListEdit.htm
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To Set the Plot Options 

Click to toggle the plot options On / Off. 

 
  

Option Result 

Plot object lineweights If Plot with plot styles is off, object lineweights are plotted. 

Plot with plot styles Settings of the assigned STB or CTB file are used. 

Plot transparencies Plots entities using the value of the Transparency property. 

Plot paperspace last Entities in Model space are plotted first, paperspace entities last. 

Hide paperspace 
entities 

Removes hidden lines from 3D entities in paper space. 

This option is disabled when printing model space. 

Plot stamp 
Adds a header and / or footer.  

Click the Edit plot stamp button ( ) to define the plot stamp. 

Save changes to layout 
All changes made in the Print dialog are saved in the layout.  

This option toggles the Save changes to layout variable 

  

To Set the Shade Plot Mode 

Under Shade viewport options, click the list button, then select an option: 

 
  

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/10_Drawing_Entities/00_Entity_Creation_Settings/Transparency.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/15_00_General_procedure_for_printing.htm%23To_define_the_plot_stamp
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NOTE This option applies to model space printing only. 

The Shade Plot mode of a paper space viewport is defined in the Shade Plot property of 
the viewport. 

   

To Define the Plot Stamp 

Click the Edit plot stamp button ( ). 
The Plot stamp dialog opens. 
 

 

In the Header field, do one of the following:  

Type the header text.  

Click the down arrow button, then choose a variable in the drop down list.  

Type one or more variable names.  

Leave the field empty.  

In the Footer field, do one of the following:  

Type the footer text.  

Click the down arrow button, then choose a variable in the drop down list.  

Type one or more variable names.  

Leave the field empty.  

Select a font in the Font list button.  

Enter a value in the Font Size field  

Set the unit type to Millimeters or Inches.  

Click the OK button to confirm.  

The plot stamp settings are saved to a series of user preferences in the current user profile, which 
can be edited in the Settings dialog under Program Options / Plot and Publish / Plot Stamp: 

 

  

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/04_Viewing_your_drawing/04_10_Paper_space_viewports.htm%23ShadePlot
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/02_Defining_your_preferences/02_10_User_Profile_Manager.htm
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Variables 

Name Description 

$Name 
Adds the name of the current user, as definied in the User Name field of the 
License Information. 

$Company 
Adds company name of the current user, as definied in the Company  field of 
the License Information. 

$Date Adds the current date. 

$DateTime Adds the current date and time. 

$DwgName Adds the file name and path of the drawing. 

  

  

NOTE The header and footer text consists of three parts (left, center and right), separated by 
commas. 

By default the header and footer text is centered. 

The header and footer text can be outlined left center and/or right by separating the 
text with commas.  
e.g. $Name,$Company,$Date  places your name left, company name centered and the 

current date at the right. 

Type a space before one of the commas to leave one of the parts empty, thus outlining 
the header or footer left or right. 

$Company, ,  ($Company,<space>,<space>) outlines the company name left. 

 , ,$Company (<space>,<space>,$Company) outlines the comapny name right. 

 

To Specify the Number of Copies 

Do one of the following: 

Type the desired number in the Number of copies field.  

Click the up-arrow and the down-arrow buttons to specify the number of copies.  

 

To See a Preview of the Plot Output 

Do one of the following:+  

Click the Preview button on the Print or Page Setup dialogs.  

Choose Print Preview... in the File menu.  

Type preview in the command bar, then press Enter.  

(option) Use the mouse scroll wheel to zoom. Double click the middle mouse button to zoom 
extents.  

To close the Print Preview window, do one of the following:  

Click the Close button to return to the drawing window.  

Click the Print Settings... button to open the Print dialog.  

Click the Print button to start printing. 
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Plotter Configurations 

  

 

Plotter configuration  

  

Configurations for Windows system printers are stored in plotter configuration files (.PC3 files). 
Unlike in AutoCAD®, PC3 plotter configuration files in BricsCAD™ apply to Windows system 
printers only.  

In a plotter configuration file, you override one or more settings of the system printers installed on 

your computer. You can configure BricsCAD for many plotting/printing devices and keep multiple 
configurations for each single device. 

Each plotter configuration file contains information such as: 

The device driver and model 

The output port to which the device is connected 

Various device-specific settings (not supported on the Linux platform).  
PC3 files are saved in the Plotconfig subfolder of your Roamable root folder. 

After creating a PC3 file, it is available in the list of plotter configuration names in the Printer / 

Plotter configuration list on the Print or Page Setup dialog boxes. 

  

 

To Configure the Built-in PDF Printer 

Open the Print dialog. 

Click the Printer/Plotter configuration list button and choose Print As PDF.pc3 in the list. 
 

 

Click the Edit Plotter Configuration button ( ). 
The Plotter Configuration Editor dialog displays withe the Print As PDF.pc3 configuration file 
loaded. 
The default path for plotter configuration files (*.pc3) is: 
C:\Users\<User_Name>\AppData\Roaming\Bricsys\BricsCAD\Vxx\en_US\PlotConfig 

https://blog.bricsys.com/category/tutorials/printing-plotting/
https://blog.bricsys.com/printing-in-bricscad-part-4/
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/02_Defining_your_preferences/02_00_Bricscad_User_Files.htm
file:///C:/Users/Louis/AppData/Local/Temp/298462/15_Printing/15_00_General_procedure_for_printing.htm%23To_open_the_Print_dialog
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Click the Settings tab on the Plotter Configuration Editor dialog. 

 

 

(Option) Edit the Graphics settings. 

(Option) Execute the Scale Calibration. 

Click the Custom Properties button. 
The Print As PDF - Custom Properties dialog displays. 
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(Option) Adjust the Output quality and Layers support settings. 

Click the Manage Custom sizes ... button. 
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To create a custom paper size do the following: 

Click the Add button. 
A new paper size is added.  

Double click the newly created papersize.  

Type a name for the new paper size, then click the OK button. 
 

 

Define Width an Height for the new paper size.  

Define the Paper Margins. 
Paper margins define the printable area of paper sheet. 
If the DISPPAPERMARGINS system variable is ON, dashed lines indicate the paper margins on the 

paper sheet* in a layout. 
 

 
 

* The paper sheet background displays if the DISPPAPERBKG system variable is ON.  

Click the OK button to create the custom paper size.  

Click the OK button on each of the previously opened dialogs. 
 
The custom paper size(s) can now be selected in the Paper Size list button. 
 

 

To Create a Plotter Configuration File 

Choose Plotter Manager... in the File menu, then double click Create a Plotter Configuration 
shortcut.  

bricscad-sysvar.chm::/00_07_Settings_Manager.htm
bricscad-sysvar.chm::/00_07_Settings_Manager.htm
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The Plotter Configuration Editor dialog opens. 

  

 
In the Printer name list, select the printer you want to create a plotter configuration (PC3) for.  
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Click the Settings tab on the Plotter Configuration Editor dialog. 

 

 

Click the Custom Properties... button. 

The <Selected Printer> Properties dialog opens. 
The layout of this dialog is different for each printer. 
Custom Properties are not supported on the Linux platform.  

On the Properties dialog of the selected printer, adjust the printer settings, then click the OK 
button to confirm. 
The <Selected Printer> Properties dialog closes.  

Click the OK button on the Plotter Configuration Editor dialog. 

The Save Plotter Configuration As file dialog displays. 
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(option) Adjust the PC3 file name. 
The default name is <Selected Printer>.pc3.  

Click the OK button on the Changes to a Printer Configuration File dialog. 
The PC3 file is created.  

  

NOTE If you want to create multiple plotter configurations for the same printer, you must adjust 
the default name in step 7. If you accept the default name, the existing plotter 

configuration will be overwritten. 

 

To Edit a Plotter Configuration 

Do one of the following:  

Choose Page Setup in the File menu.  

Type pagesetup in the command bar, then press Enter.  

Select a plotter configuration (PC3) in the Printer / Plotter configuration list.  

Click the Edit Plotter Configuration button ( ) on the Print or Page Setup dialogs. 
The Plotter configuration editor dialog opens.  

Proceed in the Create a plotter configuration procedure starting from step 3.  

  

NOTE If you select a system printer in step 2, a new plotter configuration is created for the 
selected printer.   

When you click the Edit Plotter Configuration button ( ) in step 3, the Properties dialog 
of the selected printer opens first.  

After clicking the OK button on the Properties dialog the Plotter configuration editor 
dialog opens.   

You can then complete the Create a plotter configuration procedure. 

  

 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/15_01_Plotter_Configuration.htm%23To_create_a_plotter_configuration_file
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To Assign a Plotter Configuration 

Choose Model or the Layout to which you want to assign a specific plotter configuration file.  

Do one of the following:  

Choose Page Setup in the File menu.  

Type pagesetup in the command bar, then press Enter.  

Choose one of the following from the Printer / Plotter configuration list:  

A system printer  

A configuration file (PC3 file)  

None (uses Default)  

Click the OK button.  

  

NOTE • When BricsCAD™ cannot find the plotter configuration file assigned to the drawing, it 
changes the configuration file assigned to your drawing to None. 

• The None printer device has its own set of paper sizes that can be stored in the 
drawing very much the same as for any 'real' printer. If a layout is opened and the 
stored printer is absent, the printer switches to None  while the paper size is 
maintained. The missing printer and the previous paper size are indicated upon 

opening the Print dialog. The previous paper size can be saved in the drawing, 

• PREVIOUS PAPER SIZE: drawings created by other parties are often set up for a 

printer that is not available in your office. In such case, BricsCAD resets the printer 

device to None , which results in using the default printer. Instead of resetting the 
paper size to a default, BricsCAD shows the Previous Paper size, in order to inform 
you about the intended paper size and allow to choose a similar size on any of the 
available printers. 

 

Plot Style Tables 

 

Control the Color and Lineweight with Plot Style Tables  

  

The Plot Style Table Editor can be opened, even if BricsCAD is not open. 

To open the Plot Style Table editor 

Do one of the following: 

Click the Edit Plot Style button ( ) on the Print dialog. 

Choose Plot Style Manager... in the File menu, then double click a CTB or STB file. 

In a Windows Explorer window, double click a CTB or STB file. 

https://blog.bricsys.com/category/tutorials/printing-plotting/
https://blog.bricsys.com/printing-in-bricscad-part-3/
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The Plot Style Table Editor displays the plot styles contained in the specified plot style table.  

The Plot Style Table Editor includes the following tabs:  

The General tab 

The Form View tab 

the Lineweights tab 

The General tab 
The General tab lists general information about the plot style table. 
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Name Description 

Plot style table 

file name 
Displays the name of the plot style table file you are editing. 

Description  Displays a description you want to include about the plot style table. 

File Info 

Displays information about path, number of plot styles and the version 

number of the Plot Style Table Editor. 

Note:  A color-dependent plot style table always contains 255 plot styles. 

Apply global 
scale factor to 
non-ISO 
linetypes 

Specifies whether or not you want to scale all non-ISO linetypes in the plot 
styles 

of entities controlled by the plot style table. 

Scale factor Specifies the factor by which to scale non-ISO linetypes and fill patterns. 

The Form View tab 
The Form View tab lists the plot styles contained in the plot style table and their settings. Plot 
styles are style overrides for your drawings that occur during plotting. 

The first plot style in a Named Plot Style table is NORMAL and represents an entity's default 
properties (no plot style applied). You cannot modify or delete the NORMAL style. 

  

 

  



  User Guide 

 602 

  

Property Description 

Plot styles 

Displays the names of plot styles contained in the selected  plot style table. 

Color-dependent plot style table: 

• Always contains 255 styles (1 for each color).  

• They are tied to entity color.  

• You cannot add nor delete a plot style.  

• You cannot rename a plot style.  

Named plot style table: 

• Contains one or more plot styles.  

• You can add or remove plot styles, except for the Normal style, which 

cannot be deleted. 

• Plot styles can be renamed, except for the Normal style, which cannot be 
renamed. 

Description Displays a description for the selected plot style. 

Color 

Specifies the plotted color for an entity.  

The default setting for plot style color is Use Object Color.  

If you assign a plot style color, the color overrides the entity's color in the plot 
output.  

• Choose Other... to  select one of 255 colors from the Select Color dialog 
box.  

• Choose True color to select a color from the Color dialog box. 
If the plot device does not support the color you have specified, the nearest 
available color will be used. When you have a monochrome device, black will 

be used.  

Dither 

Depending on the capabilities of your plotter, dithering approximates the colors 
with dot patterns. When this option is not active, the colors are mapped to the 
nearest color, resulting in a smaller range of colors when plotting.  

Dithering is available only whether you select  the object’s color or assign a 
plot style color.  

By default, this option is active. Setting it to Off has no effect in BricsCAD. 

Grayscale 
Depending on the capabilities of your plotter, converts the colors to grayscale 
in the plot output. 

Pen # 
Specifies a pen to use when plotting entities that use this plot style.  

You can select a pen number from 1 to 32. 

Virtual pen # 

Specifies a virtual pen number between 1 and 255.   

Choose Automatic to specify that BricsCAD should make the virtual pen 
assignment from the BricsCAD Color Index.  

The virtual pen setting in a plot style is used only by non-pen plotters and only 
if they are configured for virtual pens (select 255 Virtual Pens under Color 

Depth under Vector Graphics on the Settings tab in the Plotter Configuration 
Editor). 

Screening 

Specifies the color intensity of the plot on the paper.  

The valid range is 0 through 100.  

If you select 100 the drawing will plotted with its full color intensity. In order 
for screening to work, the Dithering option must be active. 

Linetype  

Displays a list with an example and a description of each linetype.  

The default setting for plot style linetype is Use Object Linetype.  

The selected linetype overrides the entity's linetype in the plot output. 
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Adaptive 

Adjusts the scale of the linetype to complete the linetype pattern.  

You can activate this  property if a complete linetype pattern is more important 
than a correct linetype scaling. 

Lineweight  

Displays a sample of the lineweight as well as its numeric value.  

You can modify an existing lineweight if the one you need is not available.  

The default setting for plot style lineweight is Use Object Lineweight.  

The selected lineweight overrides the entity's lineweight in the plot output. 

Line end style 

Displays a list of several end styles for the lines.  

By default, the option Use Object End Style is selected.  

If you select a line end style, the object's line end style will be overridden in 
the plot output. 

Line join style 

Displays a list of several join styles for the lines.  

By default, the option Use Object Join Style is selected.  

If you select a line join style, the object's line join style will be overridden in 
the plot output. 

Fill style 

Displays a list of several fill styles.  

By default, the option Use Object Fill Style is selected.  

If you select a fill style, the object's fill style will be overridden  in the plot 

output. 

  

NOTE Objects which are created in true color are always plotted using their own object 
properties (color, lineweight, ...). 

  

The Lineweights tab 

The Lineweights  tab lists the available lineweights. 

Lineweights with a tick are used in the Lineweight field on the Form View tab. 

To edit a lineweight, select the lineweight in the list, then click the Edit button. 
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Assigning Plot Style Tables 

In BricsCAD you can assign plot style tables to model space and to each of the layouts in a 
drawing. By assigning different plot style tables to each layout in your drawing, you can control 
how entities in the layout are plotted. The plot style table affects both model space and paper 
space entities. To plot the drawing without applying plot style properties, choose 'None (use 
Default)' from the list of plot style tables.  

In STB-type drawings, each entity in the drawing either is assigned a plot style explicitly or By 
Layer. 

Missing plot style table 
If a plot style table is not found, the text "(missing)" is added to the plot style table name. When 
you print the drawing, the settings of the default plot style file Default.ctb or Default.stb will be 
used instead. 

To Assign a Plot Style Table 
Choose Model or the layout to which you want to assign a different plot style table.  

Do one of the following:  

Choose Print... in the File menu.  

Type print in the command bar, then press Enter.  
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Select a Plot style table from the list box in the Plot Style Table (pen assignments) section.  

 

 

Click the OK button.  

To Toggle the Plot Style Table on/off 
When you turn off plot style tables, entities print according to their own properties. However, all of 

the plot style information is saved so you can easily turn on plot styles again. Actual plot style 
table files are not deleted, and for drawings that use named plot style tables, entities and layers 
retain their assigned plot styles. 

 

Choose Model or the layout in which you want to turn the plot style table on/off.  

Do one of the following:  

Choose Print... in the File menu.  

Type print in the command bar, then press Enter.  

Click the Plot with plot styles plot option. 
 

 

The Plot Styles Manager 

The Plot Styles Manager is a window that lists plot style table files (CTB and STB files). 

The Plot Styles Manager allows you to: 

Create Color-dependent Plot Style (CTB) and Named Plot Style files (STB) using the Create 
a Plot Style Table wizard. 

Edit existing Plot Style Table files. 

To Open the Plot Styles Manager 
Do one of the following: 

Choose Plotstyle manager... in the File menu.  

Type stylesmanager in the command bar then press Enter.  

To Create a New Plot Style Table 
Open the Plot Styles Manager.  

Double click the Create a Plot Style Table shortcut. 
 

file:///C:/Users/Louis/AppData/Local/Temp/298462/15_Printing/15_03_The_Plot_styles_manager.htm%23To_open_the_Plot_Styles_Manager
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The Add Plot Style Table Editor dialog opens. 
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Choose Create new from scratch. 

 

 

Do one of the following:  

Select either CTB or STB from the Table type selection button.  

CTB (Color-dependent Plot Style Table) - bases plots on entity colors. Plotting parameters, 
such as pen thickness and linetype, are matched to the color of entities. This system is 
older and less flexible than named plot styles, but is the default in all new drawings. 
Creates a CTB file. 

STB (Named Plot Style Table) - bases plots on plot styles. Plotting parameters can be 
given to every entity and every layer. This system is new and more flexible, but may be 
incompatible with other software that reads DWG files. Creates an STB file. 

Choose Create from existing table, then choose a file in the drop down list box or click the 
browse button to select an existing CTB or STB file.  

 
Type a name in the Table name field, then click the OK button.  

The Plot Style Table Editor dialog displays. 

file:///C:/Users/Louis/AppData/Local/Temp/298462/15_Printing/15_04_The_Plot_Style_Table_editor.htm
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To Create a New Plot Style Table in the Print Dialog 
    

Open the Print dialog. 

Click the Create new plot style button ( ) on the Print dialog. 
The Add Plot Style Table dialog displays. 
 

 

Type a name in the Table name field, then click the OK button. 
If the Launch Editor option is chosen, the Plot Style Table Editor dialog displays. 
If the Use this plotstyle for the current drawing option is chosen, the new plot style table is used 
in the current layout.  

   

NOTE The above procedure creates a CTB file in CTB-type drawing and a STB file in a STB-type 

drawing. 

 

To Edit a Plot Style Table 
Open the Plot Styles Manager.  

Double click the plot style table you want to edit.  

The Plot Style Table Editor dialog displays. 

To Edit a Plot Style Table in the Print Dialog 
Open the Print dialog.  

Select a plot style table from the Plot Style Table list button.  

Click the edit Edit plot style button ( ).  

The Plot Style Table Editor dialog displays. 

Batch Plotting 

Commands: PUBLISH, -PUBLISH, SHEETSET 

The Publish command allows to print a sheet list (= a list of model space or paper space layouts) 
to a printer. A sheet list can be saved to a DSD (Drawing Set Description) file. 

The SheetSet command manages sheet sets and allows to print, publish or etransmit a sheet set 
as a whole or a selection of sheets. A sheet set is saved to a DST file (Sheet Set Data) file. 

file:///C:/Users/Louis/AppData/Local/Temp/298462/15_Printing/15_00_General_procedure_for_printing.htm%23To_open_the_Print_dialog
file:///C:/Users/Louis/AppData/Local/Temp/298462/15_Printing/15_04_The_Plot_Style_Table_editor.htm
file:///C:/Users/Louis/AppData/Local/Temp/298462/15_Printing/15_03_The_Plot_styles_manager.htm%23To_open_the_Plot_Styles_Manager
file:///C:/Users/Louis/AppData/Local/Temp/298462/15_Printing/15_04_The_Plot_Style_Table_editor.htm
file:///C:/Users/Louis/AppData/Local/Temp/298462/15_Printing/15_00_General_procedure_for_printing.htm%23To_open_the_Print_dialog
file:///C:/Users/Louis/AppData/Local/Temp/298462/15_Printing/15_04_The_Plot_Style_Table_editor.htm
bricscad-cmdref.chm::/P/Publish/Publish.htm
bricscad-cmdref.chm::/P/Publish/-Publish.htm
bricscad-cmdref.chm::/S/SheetSet.htm
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Rendering 

Commands: RENDER,  SHADEMODE, RENDERPRESETS, ANIPATH 

Rendering is the process of generating an image from a 3D model. The model contains the 
geometry, viewpoint, texture, lighting and shading information. The result is a digital image which 
can be saved as a raster image file: bmp, jpeg or png. 

Rendering in BricsCAD is based on the Redway3d rendering engine. By default the rendering 
engine will try to leverage the hardware on the graphics card. If experiencing problems, please 
switch off the RenderUsingHardware user preference. It is recommended to install the most recent 

drivers for your graphics card. The IsRedSdkHardwareRenderingSupported user preference 
reports if Red SDK hardware rendering is fully supported and the initial value of 
RenderUsingHardware user preference is set accordingly. 

The RenderPresets command allows to create and edit render presets, and to set the current 
render preset through a dialog box. 

Setting the Render Preferences 

Open the Settings dialog.  

Under Program Options expand the Rendering settings category.  

 

Current material: Specifies the material for new entities. By default the Global material is used. 

Lighting units:  

0: No lighting units are used. Enables generic lighting. 

1: Enables American lighting units: Foot-Candles 

2: Enables International lighting units: Lux.  

Web lights can be created only if the LIGHTINGUNITS system variable is set to 1 or 2. 

  

Default lighting: A distant light that follows the view direction. This setting can be different per 
viewport. 

0: Default lighting is used if no lights are switched ON. 

1: Default lighting is used instead of the light sources defined in the drawing. 

Linear contrast: Specifies the ambient light intensity. Values between -10 and 10 are accepted. A 
value of -10 results in maximum ambient light. A value of 10 results in no ambient light. 

Linear brightness: Specifies a scaling factor for the light intensity. Values between -10 and 10 
are accepted. The default value is 0 (no scaling). Negative values decrease the light intensity, 
positive values increase the light intensity. This setting can be different per viewport. 

Render using hardware: Choose User software only (slower) if hardware rendering fails. It 

might be necessary to restart BricsCAD after changing the setting. 

Real world scale: Controls the rendering of materials with units set to real-world scale 

Sky status:Specifies whether sky illuminiation is computed at render time. (Not implemented yet)  

bricscad-cmdref.chm::/R/Render/Render.htm
bricscad-cmdref.chm::/S/ShadeMode.htm
bricscad-cmdref.chm::/R/RenderPresets.htm
bricscad-cmdref.chm::/A/AniPath.htm
https://www.redway3d.com/
bricscad-sysvar.chm::/00_07_Settings_Manager.htm
bricscad-sysvar.chm::/00_07_Settings_Manager.htm
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Texture map path: Defines the search path for texture map images. In the BricsCAD program 

folder exist three subfolders under Textures, each containing a number of texture files of the same 
name. Images in folder 1 have a size of 256 x 256 pixels, folder 2 contains images of 512 x 512 
pixels, images in folder 3 have a size of 1024 x 1024 pixels. If the Diffuse map setting of a 
material uses the image name only (not path), you can control the quality of a rendered image by 
setting the TextureMapPath user preference to folder 1, 2 or 3. 

Render material directory path: Specifies the path of the folder where the render materials for 
the Material Browser are installed. 

Render material static directory path: Specifies the path of the folder which contains read-only 

resources for predefined materials, such as their previews. 

Tile mode light synch: Controls the synchronization of lighting in all model space viewports. 
(Internal use only)  

Render Tools 

Icon Tool 

Name 

Keyboard Description 

 

Render render Photorealistic rendering using materials and lights 

 

Hide hide Hidden line view (*).  

If the previous shademode option was 2Dwireframe, 
wireframe representation is restored if you zoom or 
pan. If the previous shademode option was other 
than 2Dwireframe, the hidden line representation is 
kept until a different shade mode is chosen. 

 

Shade shade Shades the entities between the polygon faces. 

Curved surfaces are segmented. 

 

2D 

Wireframe 

shademode + 2 Wireframe representation 

 

3D 

Wireframe 

shademode + 3 Wireframe representation 

 

Hidden shademode + H Hidden line view (*) 

 

Flat shademode + F Shades the entities between the polygon faces. 
Curved surfaces are segmented 

 

Gouraud shademode + G Shades the entities between the polygon faces. 
Curved surfaces are smoother and more realistic 

 

Flat + 
Edges 

shademode + L Combines flat shading and wireframe lines and curves 

 

Gouraud + 
Edges 

shademode + O Combines gouraud shading and wireframe lines and 
curves 

 

Materials materials Opens the Drawing Explorer - Materials 

 

Material 
Map 

materialmap Allows to adjust how a texture image is mapped to 
faces of a 3D solid and filled entities such as 3D 

faces, wide polylines and polygon meshes. 

 

Light List lightlist Opens the Drawing Explorer - Lights 

 

Sun 
Properties 

sunproperties Opens the sun properties editor 

 

Geographic 
Location 

  

geographiclocation Opens the Geographic Location dialog. 

  

 

bricscad-sysvar.chm::/00_07_Settings_Manager.htm
bricscad-cmdref.chm::/M/MatBrowserOpen.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/04_21_Rendering_Materials.htm
bricscad-cmdref.chm::/M/MaterialMap.htm
bricscad-cmdref.chm::/M/MaterialMap.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/04_22_Rendering_Lights.htm%23OpenLightList
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/04_22_Rendering_Lights.htm%23DefineSunProps
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/04_22_Rendering_Lights.htm%23DefineSunProps
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/04_22_Rendering_Lights.htm%23DefineGeographicLocation
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/04_22_Rendering_Lights.htm%23DefineGeographicLocation
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Animation 
Path 

anipath Records the animation of a camera moving along a 
path or panning in a 3D model and saves it to a 
movie file. 

  

(*) Set the  DISPSILH system variable On to display silhouette lines instead of a polygon mesh for 
curved surfaces.  

  

 

 

Hidden line of a cone, a cylinder and a sphere with DISPSILH Off (left) and On (right). 

  

Creating a rendered image of a model 

The rendered image displays in the current viewport, in a separate window or can be exported to a 

file. 

The background of a rendered view can be controlled by the Background property of the current 
named view. 

The ANTIALIASRENDER system variable controls the amount of anti-aliasing (edge smoothing) 
applied during the rendering generation. The default value is 1, maximum value is 5.  

Note: high anti-alias values incur a high calculation cost. 

  

NOTE The values of the lighting system variables influence the rendering result. 

  

To Render a Viewport 

Do one of the following  

Click the Render tool button ( ) on the Rendering toolbar.  

Type render in the command bar, then press Enter.  

bricscad-cmdref.chm::/A/AniPath.htm
bricscad-cmdref.chm::/A/AniPath.htm
bricscad-sysvar.chm::/00_07_Settings_Manager.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/04_07_Named_Views.htm%23BackgroundDefine
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/04_07_Named_Views.htm
bricscad-sysvar.chm::/00_07_Settings_Manager.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/04_22_Rendering_Lights.htm%23SystemVariables
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The Render dialog displays: 

 
Click the Viewport option.  

Click the OK button. 

The view is rendered.  

To Render in a Window 

Do one of the following  

Click the Render tool button ( ) on the Rendering toolbar.  

Type render in the command bar, then press Enter.  

The Render dialog displays: 

 

Click the Window option.  

Click the OK button. 
The view is rendered in a popup window.  
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To Save a Rendering to a File 

Do one of the following  

Click the Render tool button ( ) on the Rendering toolbar.  

Type render in the command bar, then press Enter.  

The Render dialog displays. 

Click the File radio button (1) on the Render dialog.  

 

Click the File option.  

Click the Browse button ( ), at the right hand side of the File field. 
The Render output file dialog displays.  

Select a folder and type a name for the output file in the File name field.  

Click the Save as type button to select the file type. 
The options are: bmp, jpg and png.  

Click the OK button 
The Render Output File dialog closes.  

Do one of the following:  

Type the desired resolution for the output size in the Width and Height fields. 

Check the Same as viewport size option to set the outsize to the size of the current viewport. 

Click the OK button to create the file. 

Render Materials 

Command: MATERIALS, MATBROWSEROPEN, MATBROWSERCLOSE, MATERIALMAP 

The Materials command creates materials and edits their properties through the Drawing Explorer. 

The MatBrowserOpen command opens the materials browser, which shows an overview of 

available high-resolution render materials. 

The MatBrowserClose command closes the materials browser. 

The MaterialMap command allows to adjust how a texture image is mapped to faces of a 3D solid 
and filled entities such as 3D faces, wide polylines and polygon meshes. 

  

Material definitions are saved in the drawing. Each drawing contains the Global material. It is not 
possible to delete or rename the Global material. You can edit the properties of the Global material 

though. 

bricscad-cmdref.chm::/M/Materials.htm
bricscad-cmdref.chm::/M/MatBrowserOpen.htm
bricscad-cmdref.chm::/M/MatBrowserClose.htm
bricscad-cmdref.chm::/M/MaterialMap.htm
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Glossary 

Diffuse color: the  color that the object reveals under pure direct, white light. It is perceived as 
the color of the object itself.  

Ambient color: the color of the object in the shadow, under ambient light rather then direct light.  

 

Highlights: highly reflective highlights in the color of the material.  

   

Metallic Highlights (left) and Non-metallic Highlights (right) 

Shading: how the color and brightness of a surface varies with lighting.  

Texture-Mapping: adds detail to a surface which is not included in the 3D model itself.  

Diffuse map: adds a structure or pattern to a surface to simulate a material. 

Transparency map: sets the transparency of a texture from 0% (black) to 100% (white) and 
anything between (grey scales). 
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transparency map: 

 

transparency map: 

 

transparency map: 

 

Bump map: simulates a certain roughness or bumpiness on surfaces. 

  

brick pattern: diffuse map only brick pattern: diffuse map and bump 
map applied  

Reflectivity: the property of a surface to reflect light.  

Transparency: sharp transmission of light through solid objects.  

Translucency: scattered transmission of light through solid objects.  

Refraction: bending of light when passing through  transparent objects.  
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Refraction index = 1.000 Refraction index = 2.000 

self-illumination: it appears as if a surface is emitting its own light. No light is cast on other 

objects.  

Defining Materials 

See the Materials command.  

Assigning Materials 

Materials can be assigned to a layer and to entities. If the Material property of an entity is 

BYLAYER. The material assigned to the layer of the entity will be used. 

By default new entities get the BYLAYER material setting. 

To assign a material to entities 

Method 1: Using the Properties Bar. 

Select the entities or subentities (e.g. a faces a 3D solids).  

In the Properties bar, under 3D Visualization > Material, click the down arrow and select the 

material in the Material list.  

 

bricscad-cmdref.chm::/M/Materials.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/01_User_Interface/00_06_Properties_Bar.htm
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Method 2: Using the Render Materials panel 

To assign a material to a single entity: 

Select the material in the Render Materials panel. 

Press and hold the left mouse button, then drag the material onto the entity. 

To assign a material to multiple entities: 

Select the entities. 

Select the material in the Render Materials panel. 

Press and hold the left mouse button, then drag the material onto one of the selected entities. 

To assign a material to a layer 

Do one of the following  

Click the Explore Layers tool button ( ) in the Entity Properties toolbar.  

Choose  Layers > Layers... in the Settings menu.  

Type layer in the command bar, then press Enter.  

The Drawing Explorer - Layers dialog opens. 

In the  Drawing Explorer - Layers dialog click the Detail view tool button ( ).  

Click the Material column of the layer you want to assign a material to.  

Click the down arrow and select the material in the Material list. 

Lights 

Commands: DISTANTLIGHT, GEOGRAPHICLOCATION,  LIGHT, LIGHTLIST, POINTLIGHT, 

SPOTLIGHT, SUNPROPERTIES, WEBLIGHT 

Lighting is the key to make the viewer believe to look at a realistic scene. 

Glossary 

Ambient light: light from an unspecified source.  

Back light: light that adds depth and dimension by creating highlights.  

Distant light: light that is cast evenly throughout a scene with shadows all in the same direction.  

Fall-off: the attenuation or decrease in brightness the further from the light source.  

Fill light: the light that brightens dark areas and softens shadows from the main light.  

Point light: light that shines in all directions from a central spot.  

Spot light: focusable light that is aimed in one area.  

Photometric web: a 3D representation of the light intensity distribution of a light source.  

Web light: approximates real-world light distribution using a 3D representation of the light 
intensity. Web lights can be created only if the LIGHTINGUNITS system variable is set to 1 

(American lighting units) or 2 (International lighting units).  

Attenuation: the fall-off in brightness the further from the light source.  

System Variables 

LIGHTINGUNITS (Lighting units):  

0: No lighting units are used. Enables generic lighting. 

1: Enables American lighting units: Foot-Candles 

2: Enables International lighting units: Lux.  

  

DEFAULTLIGHTING (Default lighting): A distant light that follows the view direction. This setting 
can be different per viewport. 

0: Default lighting is used if no lights are switched ON. 

bricscad-cmdref.chm::/M/MatBrowserOpen.htm
bricscad-cmdref.chm::/M/MatBrowserOpen.htm
bricscad-cmdref.chm::/D/Distantlight.htm
bricscad-cmdref.chm::/G/Geographiclocation.htm
bricscad-cmdref.chm::/L/Light.htm
bricscad-cmdref.chm::/L/Lightlist.htm
bricscad-cmdref.chm::/P/Pointlight.htm
bricscad-cmdref.chm::/S/Spotlight.htm
bricscad-cmdref.chm::/S/Sunproperties.htm
bricscad-cmdref.chm::/W/Weblight.htm
bricscad-sysvar.chm::/00_07_Settings_Manager.htm
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1: Default lighting is used instead of the light sources defined in the drawing. 

LINEARCONTRAST (Linear contrast): Specifies the ambient light intensity. Values between -10 and 
10 are accepted. A value of -10 results in maximum ambient light. A value of 10 results in no 
ambient light. 

LINEARBRIGHTNESS (Linear brightness): Specifies a scaling factor for the light intensity. Values 
between -10 and 10 are accepted. The default value is 0 (no scaling). Negative values decrease 

the light intensity, positive values increase the light intensity. This setting can be different per 
viewport. 

General Properties 

The general properties are common to all lights: 

 

Name: a user defined name for the light.  

Type: defines the type of light: spot, point, web or distant.  

On/Off: specifies whether the light is turned on or off.  

Shadows: specifies whether the light casts shadows or not. Turning shadows off to increases 
performance.  

Intensity factor: multiplies the Lamp Intensity property, the result is the Resulting Intensity.  

Filter color: defines the color of the light.  

Plot glyph: if on, the light glyph is plotted.  

Glyph display: controls the display of the light glyph  

 

Photometric Properties 

LIGHTINGUNITS = 1 (American units) or 2 (International units). 

 

Lamp intensity: Defines the brightness of the light. The lamp intensity is expressed in candela 
(cd) which is the SI base unit of luminous intensity: the power emitted by a light source in a 
particular direction, weighted by the luminosity function (a standardized model of the sensitivity of 
the human eye to different wavelengths, also known as the luminous efficiency function)  

Resulting intensity: the product of the lamp intensity and and intensity factor.  

Lamp color: defines the inherent color of the light or color temperature in Kelvin or standards.  



BricsCAD V18  Help 

 

 619 

 

 

color temperatures lamp color list 

Resulting color: this is the final color of the light: a combination of the lamp color and the filter 
color.  

Photometric web: If the light type is Web, Photometric Web and Web offsets are available (not 
implemented yet).  

Geometry Properties 

Position:  controls the location of the light.  

Target: defines the target point for point lights, spotlights and weblights  

Targeted: switches the target property on/off.  

 

Attenuation Properties 

 

In the real world, an object appears darker if it is farther away from the light source. The 
attenuation properties define how the light diminishes over distance.  Attenuation does not apply 
to photometric lights. 

An alternative method to control the distance a light shines is the use of limits, which define the 

points from where a light starts to shine and where it stops. Using limits decreases the time 
needed to calculate the illumination of a scene. 

Attenuation properties apply to spot lights and point lights. 

Type: the options are none, inverse linear and inverse square  

None: no attenuation. The distance to the light source has no influence.  

Inverse Linear: the attenuation is the inverse of the linear distance from the light: at a distance 
of 2 units from the light source, light is half as strong; at a distance of 4 units, light is one quarter 
as strong.  

Inverse Square: the attenuation is the inverse of the square of the distance from the light: at a 

distance of 2 units, light is one quarter as strong; at a distance of 4 units, light is one sixteenth as 
strong.     

Use Limits: if this property is set to Yes, the Start limit offset and End limit offset fields become 
active.  

Start limit offset: defines the point where the light starts to shine, measured from the center of 
the light.  

End limit offset: defines the point where the light stops to shine, measured from the center of 

the light.  
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No attenuation Inverse linear attenuation Inverse square attenuation 

   

The Attenuation properties apply to generic lights only (LIGHTINGUNITS = 0). 

Inverse square attenuation is applied automatically for photometric lights ( LIGHTINGUNITS = 1 
 or 2). 

 

Rendered Shadow Details 

 

Type: Sets the shadow type.  

Sharp (raytraced): generates sharp edged shadows. 

Soft (shadow map): generates realistic shadows with soft edges. 

Soft (sampled): Not supported yet 

Map size: specifies the amount of memory for shadow calculation. Click the field, then select a 

value in the drop-down list (64/128/256/512/1024/2048/4096). 

Softness: sets the softness of the shadow map. Enter a value between 1 and 10. 

 

Spotlight Properties 

 

  

When a surface is illuminated by a spotlight, there is an area of maximum illumination (hotspot = 

1) that is surrounded by an area of lesser intensity (falloff  = 2). 
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Hotspot angle: angle of the central light cone (defines the hotspot)  

Falloff angle: angle of the full light cone  

  

  

Hotspot angle = 55, Falloff angle = 60 Hotspot angle = 30, Falloff angle = 60 

  

The difference between the hotspot angle and the falloff angle defines the area of lesser light 
intensity.  

If the falloff angle and the hotspot angle are almost equal  the edge of light cone is rather sharp 
(left).  

The greater the difference between both angles, the softer the edge of the light cone (right).  
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Open the Light List 

Do one of the following: 

Click the Light List...  button ( ) on the Lights toolbar.  

Choose Drawing Explorer > Lights  in the Tools menu.  

Choose Light List.. in the View | Rendering | Lights menu  

Type lightlist or LL in the command bar, then press Enter.  

 

  

Icon Tool name Description 

 

New 

light 

Closes the Drawing Explorer - Lights dialog, then 
guides you to the creation of a new light in the 

drawing. 

 

Delete 

light 

Deletes the selected light. 

 

Select 
in 
drawing 

  

Closes the Drawing Explorer - Lights dialog and 
selects the light's glyph in the drawing.  

The properties of the light display in the Properties 
Bar. 

 

Light 
ON 

Click to switch light off. 

 

Light 
OFF 

Click to switch light on. 

 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/01_User_Interface/00_06_Properties_Bar.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/01_User_Interface/00_06_Properties_Bar.htm
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To Define a Light 

Type light in the command bar, then press Enter.  

You are prompted: Enter light type [Point/Spot/Web/Distant] <Point>: 

A prompt menu displays: 

 

Choose a light type in the prompt menu. 

Click the tool button of the light type you want to create on the Lights toolbar:  

New spot light  

New point light  

New distant light  

New web light  

Do one of the following:  

Specify the source position in the drawing.  

Type the coordinates of the source position in the command bar and press Enter.  

Press Enter to accept the default coordinates.  

You are prompted: Specify target position <0,0,-10>: 

Do one of the following:  

Specify the target position in the drawing.  

Type the coordinates of the target position in the command bar and press Enter.  

Press Enter to accept the default coordinates.  

You are prompted: Enter an option to change: Name/Intensity 
factor/Status/Photometry/Hotspot/Falloff/shadoW/Attenuation/filterColor/<eXit>:  

A prompt menu displays: 

 

Do one of the following:        

Select Name  in the prompt box.  

Type N in the command bar and press Enter.  

You are prompted: Enter light name <Spotlight1>: 

Do one of the following:  

Type a name in the command bar and press Enter.  

Press Enter to accept the default name.  
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You are prompted: Enter an option to change: Name/Intensity 

factor/Status/Photometry/Hotspot/Falloff/shadoW/Attenuation/filterColor/<eXit>: 

Do one of the following:  

Click a light property in the prompt menu.  

Type the capitalized letter of a light property in the command bar and press Enter.  

You are prompted to define the selected property in the command bar. 

Do one of the following to conclude the creation of the light:  

Choose Exit in the prompt menu.  

Press Enter.  

  

NOTE It is not possible to define a web light if the LIGHTINGUNITS system variable is zero (No 

lighting units). 

  

To Edit a Light 

Select the light in the drawing. 

If the Properties bar is not open yet, double click the light.  

The properties of the selected light display in the Properties Bar: 
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Generic light properties Photometric light properties 

  

  

To edit a property:  

Expand the settings group if needed.  

Select the property  

Edit the selected property.  



  User Guide 

 626 

To Define the Sun Properties 

Do one of the following:  

Click the Sun Properties... tool button ( ) on the Render toolbar.  

Type sunproperties or sun in the command bar, then press Enter.  

The Drawing Explorer - Lights dialog displays, showing the sun properties in the Editor pane. 

 
To edit a property:  

Expand the settings group if needed.  

Select the property  

Edit the selected property.  

 

NOTE When LIGHTINGUNITS = 1 or 2, the Color property of the sun cannot be edited. 

   

To Define the Geographic Location 

Do one of the following:  

Click the Geographic location... tool button ( ) on the Render toolbar.  

Click the Geographic location... tool button ( ) on Editor pane of the Drawing Explorer - 
Lights dialog.  

Type geographiclocation or geo in the command bar, then press Enter.  

bricscad-sysvar.chm::/00_07_Settings_Manager.htm
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The Geographic Location dialog displays: 

 
(option) Check the Store geographic location information in drawing option.  

(option) Check the Use Map Grid coordinate system option.  

Do one of the following:  

Type the latitude and longitude of the location in the Latitude and Longitude fields and 
select the appropriate hemisphere for each setting.  

Click the Choose location... button, then select a city and timezone and click the OK 
button.  
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(option) If you did not select a time zone in the previous step, choose a time zone in the Time 
Zones list.  

(option) Specify the Coordinates of the corresponding location in the drawing.  

Define the direction of the north.  

Click the OK button. 
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Digitizing Tablet 

The Tablet command configures and calibrates a digitizing tablet and toggles tablet mode. 

This command requires that Wintab32.dll from Wacom Technology, Corp. be installed on the 
computer. Download Wintab32.dll from the internet, then place the file in your system directory: 
C:\Windows\System32. 

A digitizing tablet, also called a graphics tablet, a graphics pad or drawing tablet, is a computer 
input device that allows you to hand-draw images and graphics, similar to the way one draws 
images with a pencil and paper. In a CAD program a digitizing  tablet can be used to trace paper 

drawings into a drawing file or to launch drawing commands from a digitizing tablet overlay. 

  

Using a digitizing tablet in BricsCAD 

In order to prepare BricsCAD for using a digitizing tablet do the following: 

Install the appropriate driver for your tablet. 

Make sure Wintab32.dll exists in C:\Windows\System32. 

Download the tablet overlay and CUI files. 

Print the BricsCAD tablet overlay. 

Load the overlay CUI file. 

Start BricsCAD, then initialize the tablet. 

Configure the tablet: part of the tablet surface is used as the menu area, another part as 
the screen pointing area. 

Calibrate the tablet: a calibrated tablet can be used to trace the geometry of a paper 

drawing or image into a drawing. 

  

To download the tablet overlay and CUI files 

Download the file Tablet.zip. 

  

The ZIP file contains the following files: 

overlay.png: an image of the tablet overlay 

overlay(A3).pdf: to print the tablet overlay on a A3 paper size. 

overlay(cm).dwg: a DWG in which the overlay.png is attached as an image. 
The drawing contains two layouts to print the overlay using decimal units. 

overlay(inch).dwg: a DWG in which the overlay.png is attached as an image. 
The drawing contains two layouts to print the overlay using imperial units. 

tablet.cui: a partial cui file to be used with a tablet. 

tablet(acadLike).cui: an AutoCAD-like partial cui file to be used with a tablet.  

  

To load the overlay CUI file 

Extract the overlay CUI files to the Support folder of the roamable root folder (see BricsCAD User 
Files).  
E.g. C:\Users\[user name]\AppData\Roaming\Bricsys\BricsCAD\V[version 
nummer]\en_US\Support\. 

Load Tablet.cui as a partial CUI (see To load a partial CUI file). 
The next time you start BricsCAD, Tablet.cui will be loaded automatically. 

 

NOTES Please make sure the overlay.png image file is extracted to the same folder as the 
DWG's. 

It might be necessary to repeat the above procedure after upgrading BricsCAD. 

  

  

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/Digitizing_Tablet.htm%23ConfigureTablet
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/Digitizing_Tablet.htm%23CalibrateTablet
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/Digitizing_Tablet.htm%23TabletMode
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/Digitizing_Tablet.htm%23DownloadTabletFiles
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/Digitizing_Tablet.htm%23LoadOverlayCUI
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/Digitizing_Tablet.htm%23TabletMode
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/Digitizing_Tablet.htm%23ConfigureTablet
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/Digitizing_Tablet.htm%23CalibrateTablet
https://www.bricsys.com/bricscad/tools/Tablet.zip
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/02_Defining_your_preferences/02_00_Bricscad_User_Files.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/02_Defining_your_preferences/02_00_Bricscad_User_Files.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/02_Defining_your_preferences/02_02_Loading_a_CUI_file.htm%23To_load_a_partial_CUI_file
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To switch the tablet ON / OFF 

Do one of the following: 

Click the TABLET field in the Status Bar. 

Press the F4 function key to toggle the tablet mode. 

Choose Tablet On or Tablet Off in the Settings menu. 

Type tablet in the command bar, press Enter,  then type ON or OFF ; 
or  
click ON or OFF in the prompt box. 

  

To configure the tablet 

Do one of the following: 

Choose Tablet  in the Settings menu, then choose Configure... in the flyout menu. 

 

+ 

Type tablet in the command bar and press Enter. 
You are prompted: Tablet: ON/OFF/CALibrate/ConFiGure/<On>: 
a prompt menu displays: 
 

 
Type cfg in the command bar and press Enter or choose Configure in the prompt menu. 

You are prompted: Do you want to align the tablet overlay? Yes/No/<No>: 

Type Y in the command bar and press Enter or choose Yes in the prompt menu. 
You are prompted: Digitize upper left corner of the overlay: 

Click on the mark in the upper left corner (1) of the digitizing tablet overlay. 
 

 
 
You are prompted: Digitize the lower left corner of the overlay. 

Click on the mark in the lower left corner (2)  of the digitizing tablet overlay. 
You are prompted: Digitize the lower right corner of the overlay. 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/01_User_Interface/01_00_The_Bricscad_Application_Window.htm%23Working_with_the_status_bar
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Click on the mark in the lower right corner (3)  of the digitizing tablet overlay. 

You are prompted: Digitize the lower left corner of the screen pointing area: 

Click on the mark at position (4) on the of the digitizing tablet overlay. 
You are prompted: Digitize the upper right corner of the screen pointing area: 

Click on the mark at position (5) on the of the digitizing tablet overlay. 
You are prompted: Tablet configured.  

To calibrate the tablet 

To calibrate the digitizing tablet you must specify at least two points. The more additional points 
you specify, the more accurate the digitizing process. Additional points are particularly 
recommended when digitizing a non-orthogonal image, such as an aerial photograph. 

Do one of the following: 

Choose Tablet  in the Settings menu, then choose Calibrate... in the flyout menu. 

 

+ 

Type tablet in the command bar and press Enter. 
You are prompted: Tablet: ON/OFF/CALibrate/ConFiGure/<On>: 

a prompt menu displays: 
 

 
Type cal in the command bar and press Enter or choose Calibrate in the prompt menu. 

You are prompted: Digitize point #1: 

Click a point on the digitizing tablet . 
You are prompted: Enter coordinates for point #1: 

Do one of the following: 

Click a point in the BricsCAD drawing window. 

Enter the coordinates (x,y) in the command bar. 

You are prompted: Digitize point #2: 

Repeat step 3 to specify the following calibration point. 
You are prompted: Digitize point #3 (or ENTER to end): 

Do one of the following: 

Repeat step 4 to specify an additional calibration point. 
(You can  specify up to 10 calibration points). 

Press Enter to conclude the calibration process. 
You are prompted:  
if 2 calibration points are specified: Tablet calibrated. 
if 3 or more than 4 calibration points are specified: Select transformation type 
Orthogonal/Affine: 
if 4 calibration points are specified: Select transformation type 

Orthogonal/Affine/Projective: 
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Select the transformation type. 

Transformation refers to the calculation of the points on the screen that correspond to points you 

digitize on the tablet. 

 

  
Orthogonal (left): To be used with accurate paper drawings. Orthogonal transformation maintains 
all angles and preserves relative distances. If only two calibration points are specified orthogonal 

transformation is generated automatically. 

Affine (middle): Maintains parallel lines, but not necessarily the angles between intersecting lines. 

Projective (right): Does not maintain parallel lines, nor angles. 
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Mechanical 

Commands and Toolbars 

Icon Command Description 

 

BmNew  

Creates a new mechanical component as a new drawing file 

 

BmMech  

Convert the current drawing into a mechanical main component. 

 

BmInsert  

Inserts an existing mechanical component into the current 
drawing. 

 

BmHardware  

Inserts a standard hardware part as a mechanical component in 
the current drawing. 

 

BmForm 

Creates a new mechanical component and inserts it into the 

current drawing. 

 

BmReplace 

Replaces a component insert. 

 

BmLocalize 

Switches external components to local components. 

 

BmExternalize  

Switches local components to external components. 

 

BmOpen 

Opens the source drawing of an external mechanical component. 

 

BmOpenCopy 

Opens a copy of a component insert as a new drawing. 

 

BmDissolve 

Dissolves a mechanical component inserted into the current 
drawing. 

    

 

BmHide  

Hides a mechanical component or subcomponent in the current 

drawing. 

 

BmShow  

Shows a previously hidden mechanical component or 
subcomponent in the current drawing. 

 

BmVStyle  

Applies a visual style to a mechanical component 

    

 

BmBom 

Inserts the Bill-of-Materials (BOM) table in the current drawing 

 

BmMassProp  

Computes mass properties for the current model using densities 
assigned to its components. 

 

BmUpdate 

Reloads all referenced components from external files and 

updates BOM tables. 

 

BmUpdate 

Reloads all selected referenced components from external files 
and updates BOM tables. 

 

BmExplode Creates an exploded representation for an assembly by moving 
components to make them all visible, stores it in a new block 
and inserts the block in the Model Space. 

 

MechanicalBrowserOpen 

Toggles the display of the Mechanical Browser window. 

 

BmDependencies 

Lists all files, containing component definitions inserted in the 
assembly, in the command window. 

 

BmRecover 

Recovers a  broken mechanical structure 

 

BmUnmech  

Converts the current mechanical component into a plain 
drawing. 

 BmXConvert  

Converts X-Hardware solids in the current drawing to mechanical 

components. 

  

Tools to work with mechanical components are available on the Assembly toolbar and its Assembly 

Visualization flyout toolbar, the Assembly menu and on the Assembly tab of the Mechanical 
workspace Ribbon: 

bricscad-cmdref.chm::/Mechanical/BmNew.htm
bricscad-cmdref.chm::/Mechanical/BmMech.htm
bricscad-cmdref.chm::/Mechanical/BmInsert.htm
bricscad-cmdref.chm::/Mechanical/BmHardware/BmHardware.htm
bricscad-cmdref.chm::/Mechanical/BmForm.htm
bricscad-cmdref.chm::/Mechanical/BmReplace.htm
bricscad-cmdref.chm::/Mechanical/BmLocalize.htm
bricscad-cmdref.chm::/Mechanical/BmExternalize.htm
bricscad-cmdref.chm::/Mechanical/BmOpen.htm
bricscad-cmdref.chm::/Mechanical/BmOpenCopy.htm
bricscad-cmdref.chm::/Mechanical/BmDissolve.htm
bricscad-cmdref.chm::/Mechanical/BmHide.htm
bricscad-cmdref.chm::/Mechanical/BmShow.htm
bricscad-cmdref.chm::/Mechanical/BmVStyle.htm
bricscad-cmdref.chm::/Mechanical/BmBom.htm
bricscad-cmdref.chm::/Mechanical/BmMassProp.htm
bricscad-cmdref.chm::/Mechanical/BmUpdate.htm
bricscad-cmdref.chm::/Mechanical/BmUpdate.htm
bricscad-cmdref.chm::/Mechanical/MechanicalBrowserOpen.htm
bricscad-cmdref.chm::/Mechanical/BmDependencies.htm
bricscad-cmdref.chm::/Mechanical/BmRecover.htm
bricscad-cmdref.chm::/Mechanical/BmUnmech.htm
bricscad-cmdref.chm::/Mechanical/BmXConvert.htm
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Toolbars 

  

 

  

Ribbon 

 

  

Menu 
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Components and Inserts 

Definitions 

Assembly modeling consists in using mechanical components to group geometric entities in 

hierarchies, representing the structure of a designed product. Assembly modeling is commonly 
used in Mechanical Computer-Aided Design (MCAD) applications, because it simplifies the design of 
complex products containing thousands and millions of geometric entities. 

A mechanical component is a named group of entities. A mechanical component can be any .dwg 
file or a standard hardware part. Users can define their own components. A component can be 
inserted once or several times into one or more other components. If the component is modified, 

all instances of the component will reflect these changes automatically. Components cannot be 
self-referencing. 

A component insert is a named entity, of which the default name is composed of the name of the 

component and the serial number of the insert.   

An assembly is a mechanical component that contains other components. 

An assembly with inserted components (which in turn can be assemblies with other inserted 
components) forms a tree that is called a mechanical structure of the drawing. This tree is 

displayed in the Mechanical Browser.  

Users can create mechanical components from scratch or add them to an existing .dwg 

External and local components 

Mechanical components can be either local or external. A local component is stored in the .dwg file 

with the assembly. An external component is stored in a separate .dwg file. All inserts of external 
components are updated automatically when the corresponding .dwg file is modified. If you use 
external components in your assembly, always remember to transfer all related files when you 
want to share your model. The ETRANSMIT command creates a package of a drawing file and all 

its dependencies, such as: external references, images, font files, plot configuration files, plot style 
tables and font map files. 

You can always convert a local component to an external one and vice versa. 

To edit a local component it needs to be converted to an external component using the 
BMEXTERNALIZE command. Alternatively you can use the BMOPENCOPY command to open a copy 
of a component, edit and save it, and then use the BmReplace command to replace the original 
with the copy. 

You can choose the default insertion type for your component: Local or External. To change the 
type select the root node in the Mechanical Browser and select Local or External from Insert as 

properties: 

  

 

Depending on the value of BMAUTOUPDATE, inserts of external components are updated 
automatically on opening the assembly document or manually with the BmUpdate command. You 
can change this value in the Settings dialog: 

  

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/Mechanical_Browser.htm
bricscad-cmdref.chm::/E/Etransmit.htm
bricscad-cmdref.chm::/Mechanical/BmExternalize.htm
bricscad-cmdref.chm::/Mechanical/BmOpenCopy.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/Mechanical_Browser.htm
bricscad-sysvar.chm::/00_07_Settings_Manager.htm
bricscad-cmdref.chm::/Mechanical/BmUpdate.htm
bricscad-sysvar.chm::/00_07_Settings_Manager.htm
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Converting Components 

Do one of the following: 

Click the Switch Component to External ( ) or Switch Component to Local  tool on the 
 Assembly ribbon tab. The tools are also available on the Assembly toolbar and in the 
Assembly menu. 

Right click on the component insert in the Mechanical Browser and select Switch to 
External or Switch to Local in the context menu. 

Hover your mouse cursor over a component insert in a drawing window and select Switch 

to External ( ) or Switch to Local ( ) in the Assembly Modeling  command group in the 
Quad. 

Type BmExternalize or BmLocalize in the command bar. 

When you convert an external component to local, the .dwg file with the component definition is 
not deleted, but its future changes will not affect your assembly. 

You can always distinguish between inserts of local components ( ) and inserts of external 

components ( ) by their icons in the Mechanical Browser: 

  

 

Parametric Components 

BricsCAD allows users to make parametric changes of inserted components at assembly level. A 

component is considered as parametric if it contains at least one 2D or 3D dimensional constraint. 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/Mechanical_Browser.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/Mechanical_Browser.htm
file:///D:/BricsCAD%20Training/03_Drawing_Accurately/01_Parametric_Constraints/03_01_02_Using_Dimensional_Constraints.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/10_03_05_3D_Constraints.htm
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NOTES BricsCAD automatically maintains associativity between the definition of a parametric 
component and its inserts. So you can open the parametric component for editing, 
modify its geometry, save it, and  then execute the BmUpdate command to update the 

mechanical structure of your assembly see the result. 

If you need to go back to the default value of a component’ parameter, just edit the 
Expression field and delete its content. 

   
You can control whether a particular component parameter will be available for editing in a drawing 
containing the inserts of this components (at the assembly level). To do that, select the 
corresponding parameter in the Mechanical Browser and change the value of the Exposed field in 
the properties grid of the parameter:  
   

 
   
The options are:  

Off:Hides the parameters at the assembly O 

On: Makes the parameter visible at the assembly level.  

Auto: Hides all parameters which values are controlled by expressions, and exposes all 
other parameters. 

bricscad-cmdref.chm::/Mechanical/BmUpdate.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/Mechanical_Browser.htm


  User Guide 

 638 

You can associate units with a parameter. If you assign a value, directly or via an expression,  to a 

component parameter at the assembly level, it is automatically converted from drawing units of 
the assembly drawing to the units of the parameter. Values assigned to unitless parameters are 
not converted. 

 

By default all parameters are unitless except parameters of dimensional constraints and 
parameters, which are used as expressions for dimensional constraints. BricsCAD automatically 
assigns drawing units to such parameters. 

To edit the parameters of a parametric component insert 

When a parametric component is inserted in a model, you can edit the parameters either in the 
Mechanical Browser or in the Properties Bar. 

The component insert immediately updates according to the new value of a parameter. Please note 
that this does not modify the definition of the parametric component, which is a separate drawing 
file. As a result, multiple inserts of the same parametric component can exist in the same model, 
with different values for each of  their parameters: 

  

 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/Mechanical_Browser.htm
file:///D:/BricsCAD%20Training/01_User_Interface/00_06_Properties_Bar.htm
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To edit a parameter in the Mechanical Browser 
Expand the Parameters node of the component.  

Select the parameter.  

In the Parameter section, type a new value in the Expression field . 
 

 

 

To edit a parameter in the Properties Bar 
Select the component in the drawing.  

Expand the Parameters settings group.  

Type a new value for one of the available parameters. 
 

 

NOTES In the Properties Bar always the current value displays. In case this value is controlled 

through an expression, the expression will be overwritten by the newly entered value. 

If multiple parametric components are selected, the shared parameters can be edited 
simultaneously. The settings fields of parameters that currently have different values 

read *Varies*. 

 

 
 

Replacing Components 

Component inserts can be replaced with another component using the BmReplace command. Only 
top-level inserts can be replaced. 

Do one of the following: 

Click Replace Component tool ( ) on the Assembly ribbon tab.  The tool is available on 

the Assembly toolbar and in the Assembly menu. 

Right click on the component insert in the Mechanical Browser and select Replace&ldots; or 
Replace all inserts&ldots; in the context menu 

Hover over a component insert in a drawing window and select the Replace tool ( ) in the 
Quad menu. 

Type BmReplace in the command bar 

A File open dialog displays.  

Select a .dwg file for the replacement component and press the Open button. 
You are prompted: Replace file for all similar inserts [Yes/No] <Yes>:  

Do one of the following: 

Yes: Replace all inserts of the same name. 

No: Replace the selected insert only. 

bricscad-cmdref.chm::/Mechanical/BmReplace.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/Mechanical_Browser.htm
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NOTE Parameter values which are shared between the replacement component and the 
replaced component are copied automatically, which allows intelligent replacement of 
parametric components. 

 

Components Blocks and Xrefs 

Drawings with blocks and external references can be converted to mechanical assemblies: block 
references are converted to inserts of local components, and external references are converted to 
inserts of external components.  

Do one of the following: 

Click the Initialize Mechanical Structure tool ( ) in the  ribbon tab. The tool is also 
available in the Assembly toolbar and in the Assembly menu. 

Type BmMech in the command bar 

You are prompted: Name for new mechanical component <test>: 

Type a name for the mechanical component or press Enter to accept the current name or the 
default Component_1 name. 
You are prompted: Convert blocks and external references to mechanical components? [No/Yes] 

<Yes>: 

Press Enter to convert blocks and external references to mechanical components. 

Mechanical components can be converted back to blocks and external references.  

Do one of the following: 

Click  The Remove Structure tool ( ) on Assembly ribbon tab.  The tool is also available in 
the Assembly toolbar and in the Assembly menu. 

Type BmUnmech in the command bar. 

You are prompted:  

Warning: this command removes all mechanical structure from the current document. Proceed? 
No/<Yes>: 

Press Enter to: 

Convert external components to External References (Xrefs). 

Convert local components to blocks. 

A feature is a physical constituent of a part, which has engineering significance. Examples of 
features are holes, ribs, slots, pockets, forms. Being applied to a 3D solid, a feature removes 

and/or adds some volumes to it. You can create your own features using BricsCAD component 
extension technology. 

An extended component has BC_SUBTRACT and/or BC_UNITE layers. When you insert such a 
component on a face of any 3D solid using the BmInsert command, this target solid is modified as 
follows:  

all 3D solids located on BC_SUBTRACT layer of the component are subtracted from the target 3D 

solid; 

all 3D solids located on BC_UNITE layer of the component are united with the target 3D solid. 

All faces created after these Boolean operations form a component based feature, which is updated 
when you change the component insert &endash; by moving it along a target 3d solid or by 
modifying its parameters (if the extended component was parametric). When the insert is deleted, 
the feature is deleted as well. 

Some examples of parametric component-based features are included into your BricsCAD 

installation. You can use them as samples for creating your own features. 

bricscad-cmdref.chm::/Mechanical/BmInsert.htm
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Assigning a Physical Material 

A mechanical component may have an assigned physical material.  

To assign a material: 

Select the root component in the Mechanical Browser. 

Select Material property and press the Browse button (  ). 

 

 

In the Physical Materials dialog select a  material in the In Project or the the In Library list. 
If a material from the In Library list is chosen, it will be copied to the In Project database 

automatically. 

Click the OK button to save changes and to assign the selected material to the component.  

To remove the material from the component: 

Select the root component in the Mechanical Browser. 

Select Material property and press the Clear button (X) 

If a mechanical component does not have an assigned material, it will inherit the material from its 

parental component. If the parental component also does not have an assigned material, the 

material of the closest component with an assigned material in the hierarchy will be used. It means 
that you can assign a material to several components having a common parent at once by 
assigning the material to their common parent component. 

Inserting a component with a physical material 
If you insert a mechanical component into a document, all materials used in this component will be 
automatically copied to the document material library. Only materials assigned to the components 

will be copied. However, if the current document already has a material with the same name, this 
material will be used instead. It means that the properties of the material defined in the document 
library will be used rather than properties of the material from the inserted component. 

  

NOTE Materials which are copied to the document material library will not be erased in Undo 

operations.   

 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/BIM/Database/Materials.htm
bricscad-cmdref.chm::/Mechanical/BmBrowser.htm
bricscad-cmdref.chm::/Mechanical/BmBrowser.htm
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Organizing Geometry 

There are two main ways to design mechanical products: top-down and bottom-up approaches. It 
is also possible to add mechanical structure to existing geometry (designed in BricsCAD or 
imported from another source). 

BmNew command is called to create a new document for a new mechanical component. 

Bottom-Up Design 

With bottom-up approach users start to design a product with detailing its low-level component. 
These components are then grouped into higher-level components. The process is continued till the 
very top component (corresponding to the product itself) will be designed. 

The main command for bottom-up design is BmInsert, which is used to insert an existing 
component into the current drawing. 

Top-Down Design 

With top-down approach users start to design a product with defining  (but not detailing) its first-
level components. Each component is then refined in more details by defining its sub-components. 
The process is continued till all low-level components will be defined and detailed. 

BmForm command allows to create a new subcomponent for an existing component. 

Adding Mechanical Structure to Existing Geometry 

BricsCAD users can add component hierarchy to any existing drawing created in BricsCAD or 
imported from a different CAD format. 

BmForm converts a selected set of geometric entities to a subcomponent of the current drawing. 

Changing Mechanical Structure 

During design process users may realize than a particular component should be moved up or down 
in the component hierarchy. 

BmForm command forms a new subcomponent for the current drawing that will contain a selected 

set of component. 

BmDissolve deletes a component and moves all its subcomponents to the level of the dissolved 
component. 

Using Standard Hardware 

Standard hardware (screws, nuts, washers, bearings, etc.) can be considered as a mechanical 
component. 

BricsCAD supplies a huge library of standard hardware (more than 30,000 details of different size). 
Users can significantly increase the design performance by using standard parts. 

BmHardware inserts a standard part into the existing component. 

Assembly Constraints 

Assembly constraints are ordinary 3D Constraints, which link faces and edges of bodies that 
represent the components of an assembly. 3D Constraints can link not only top-level components, 

but also any their subcomponents. 

Component Visibility 

A particular component of a complex product can be invisible due to other components surrounding 
it. For example, a piston is invisible inside a cylinder block. To make such component visible users 
may hide some other components. 

Users can hide any subcomponent inserted into the current drawing or any its subcomponent on 
any level of nesting. 

There is also a possibility to make a component transparent to visualize it in wireframe model. 

BmHide hides a particular subcomponent. 

BmShow unhides a hidden subcomponent. 

bricscad-cmdref.chm::/Mechanical/BmNew.htm
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bricscad-cmdref.chm::/Mechanical/BmHardware.htm
bricscad-cmdref.chm::/Mechanical/BmHide.htm
bricscad-cmdref.chm::/Mechanical/BmShow.htm


BricsCAD V18  Help 

 

 643 

Mechanical Browser 

 

Introduction to Standard Parts  

Working with Standard Parts  

  

Commands:  MECHANICALBROWSEROPEN, MECHANICALBROWSERCLOSE, REPORTPANELOPEN, 
REPORTPANELCLOSE, STANDARDPARTSPANELOPEN, STANDARDPARTSPANELCLOSE 

  

The Mechanical Browser allows navigation on the hierarchy of mechanical components for the 
current drawing and calling different commands for the inserts. 2D and 3D Constraints also display 

in the Mechanical Browser. 

With the mechanical browser you can: 

click a component to highlight its geometric entities in the drawing window 

click a component to change its name 

right click a component to run a command for it 

edit 2D and 3D constraints 

To open the Mechanical Browser: 

Do one of the following 
Choose Mechanical Browser in the Assembly menu. 

Place the cursor on a toolbar, then right click and choose Mechanical Browser in the context 
menu. 

 

https://blog.bricsys.com/category/tutorials/mechanical/
https://blog.bricsys.com/introduction-standard-parts/
https://blog.bricsys.com/working-standard-parts/
bricscad-cmdref.chm::/Mechanical/MechanicalBrowserOpen.htm
bricscad-cmdref.chm::/Mechanical/MechanicalBrowserClose.htm
bricscad-cmdref.chm::/Mechanical/ReportPanelOpen.htm
bricscad-cmdref.chm::/Mechanical/ReportPanelClose.htm
bricscad-cmdref.chm::/Mechanical/StandardPartsPanelOpen.htm
bricscad-cmdref.chm::/Mechanical/StandardPartsPanelclose.htm
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Bill of Materials 

Command: BMBOM 

Engineering Bill of Materials (BOM) is a list of unique mechanical components used in a drawing. 
The list is represented as a BricsCAD table entity (see Tables), and can be placed at any location in 
the drawing area. Each entity has its serial number (starting with 1), name, and the number of 

occurrences. 

 

There are two options for BOM: listing top-level components only or bottom-level (parts) only. 

  

By default the BOM table contains only three columns: number of a component, its name, and the 
number of inserts of this component in the assembly. The Configure option of the BmBom 

command allows to add more columns: Description, Density, Volume, Mass, Material, Thickness 

(for sheet metal parts) and Parameters (for inserts of parametric components). 

bricscad-cmdref.chm::/Mechanical/BmBom.htm
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Multiple inserts of the same parametric component are grouped in separate BOM rows depending 

on the values of their parameters. 

 

3D Comparison 

Command: 3DCOMPARE 

You can compare two 3D models, i.e. 3D solids and surfaces stored in two .dwg files, including 
ones imported in BricsCAD from other file formats. The tool efficiently processes large models and 

reports differences in the Mechanical Browser. Several visualization modes are supported. 

Definitions 

A 3D model is a .dwg file with one or more 3D solids or surfaces. When comparing two 3D models, 
BricsCAD first tries to automatically align them in 3D space to obtain the maximal similarity. Then 
all faces of these 3D solids and surfaces are compared geometrically with a given tolerance. If for 
every face in the first file an equal face in the second file exists and vice versa, such models are 
considered as equal. However, if for a particular face in one file there is no equal face found in 

another file, or if only part of this face is equal to a part of a face in the other file, then a difference 
is detected. Therefore a difference is a full face or a part of a face of a 3D solid or a surface, for 
which there are no equal parts of full faces found in the other file. Two or more differences are 

grouped together if they are geometrically adjacent to each other.  

A difference node is created in Mechanical Browser for every group of adjacent differences. If you 
expand this node, you can see the particular differences it consists of. When you select the 
difference in the Mechanical Browser the corresponding feature highlights in the drawing. 

 

bricscad-cmdref.chm::/3/3dCompare.htm
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Toolbars 

The 3D Comparison procedure can be accessed using the tools on the Compare 3D ribbon panel on 
the Tools ribbon tab 

 

 

Visualization 

The 3DCOMPARE command creates a new .dwg document named 
Compare_<File_1>_<File_2>.dwg. The compared models are attached as external references to 
this drawing, A special layout named Comparison. in which  two viewports exist, one for each of 

the two models. 

 

  

The display is controlled through the 3DCOMPAREMODE system variable. If the value of 

3DCOMPAREMODE is different from 0 (zero), the corresponding model becomes semi-transparent, 
while the differences are displayed using different colors (each difference is painted in its individual 
color). Using the Mechanical Browser context menu you can zoom in on a particular difference. 

  

To display the differences, do one of the following: 

Click the Left Viewport ( ) and/or the Right Viewport ( ) tool button. 
 

bricscad-cmdref.chm::/3/3dCompare.htm
bricscad-sysvar.chm::/00_07_Settings_Manager.htm
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Double click in one of the viewports, then use the mouse/keyboard shortcuts to manipulate the 
display (e.g. zoom in/out or rotate). The display in the other viewport is synchronized 
automatically, allowing to compare the same part in both models in detail. 

Click the Single ( ) tool button to see the differences in model space. 
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Exploded Representations 

The exploded representation functionality allows to create associative exploded representations of 
assemblies without modifying the assembly itself. Exploded representations are stored in dedicated 
blocks which can be edited and inserted according to the user’s needs. It is possible to generate 
drawing views using exploded representations as well.  

Exploded representations are associative. Each part in an exploded representation is linked with 
the corresponding part in assembly. It is possible to update exploded representations to the 
current state of the assembly as well as to place balloon annotations on corresponding drawing 
views using the BMBALLOON command.     

 

Levels of the Exploded Representation 
Exploded representations contain references to the components which makes them quite 

lightweight. You can choose between two levels of the exploded representation: top or bottom.  

Top Level: The exploded representation contains references to top level components. Top level 
components are components inserted directly into the main assembly. They can consist of several 
parts and/or subassemblies but are not parts of any subassembly by themselves. 

Bottom level: The exploded representation contains references to bottom level components. 
Bottom level components are basic parts, which do not contain other parts or subassemblies.  

NOTE If Bottom Level is selected and there are some middle-level components containing not 
only inserts of components but also other entities, such entities will be lost in the 
exploded representation, because it is not possible to reference them correctly. Those 
entities should be converted into corresponding bottom-level components first. 

  

Algorithms 

BricsCAD provides two algorithms to automatically create exploded representations and a Manual 
mode to create customized exploded representations.  

The Table by Level algorithm creates a table of parts where each table row contains parts which 
are on the same level in the assembly tree. It means that the first row corresponds to parts 
inserted in the assembly, the second row contains subassemblies which contain parts only, the 
third row contains subassemblies of subassemblies, etc.  

The Table by Type algorithm creates a table where parts of the same type are grouped in same 
rows.  

The Manual algorithm creates an exact copy of the assembly which is ready for custom editing. In 

this mode, it is possible to create a custom exploded representation without changing the main 
assembly.  

Example: the Cabin Roof assembly: 

  

bricscad-cmdref.chm::/Mechanical/BmBalloon.htm
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Structure tree in the 

Mechanical Browser panel 

Assembly 

 

'Table by Level' Exploded Representation 
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Table by Type' Exploded Representation 

  

Creating an Exploded Representation 

The BMEXPLODE command allows to create an exploded representation of the current assembly. 
Note that it is necessary to have at least one insert of a part in the assembly for the command to 
work. 

To launch the BMEXPLODE command, do one of the following: 

Click the Explode tool button (  )on Tools panel of  the Assembly ribbon tab 

Click the Explode tool button ( )on the Assembly toolbar 

Select Explode in the Assembly menu 

Type bmexplode in the command bar. 

You are prompted: Select explosion algorithm [Table by Level/Table by Types/Manual/Settings]: 

(Option) Set the Level and the Name of the exploded representation using the Settings option. 

Select the algorithm.  
You are prompted: Select position of the exploded body: 

Select the position to insert the exploded representation. 
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Generating Drawing Views 

Select the exploded representation in the model space 

Launch the VIEWBASE command and select the exploded representation. 
You are prompted: Enter new or existing layout name to make current <Layout1>: 

Accept the default layout name or type a new name. 

Position the generated drawing views of the exploded representation in the paper space layout. 

 

NOTE To be able to use balloons (see BMBALLOON command) with drawing views of exploded 
representations, the GENERATEASSOCVIEWS system variable must be ON.  

 

Updating an Exploded Representation 

Execute the BMUPDATE command to synchronize exploded representations with the current state 

of the assembly. 

If necessary, adjust the exploded representation. Such adjustments, for example, may be required 

because of addition and/or deletion of some parts. 

  

NOTE The position of parts in exploded representations created in Manual mode are not 
updated automatically, even if no editing has been done.   

 

bricscad-cmdref.chm::/V/ViewBase.htm
bricscad-cmdref.chm::/Mechanical/BmBalloon.htm
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Assembly Mass Properties 

BmMassProp Command 

An assembly can consist of multiple parts made from different materials. To correctly compute the 
mass, center of  gravity (centroid), and inertia of such assemblies, BricsCAD supports individual 

densities for components. 

A physical material for a mechanical component is defined in the Material property in the 
Mechanical Browser. 

By default, a component inherits the density of the assembly, in which it was inserted into or 
formed from.  

To Set the Mass Units 

Open the Settings dialog box. 

Expand the Property units settings under Drawing / Drafting / Drawing units. 
 

 

Check the Format mass properties checkbox to enable formatting of mass values with appropriate 
units. 

Select the Mass units field, then click the Browse button ( ) and specify the desired mass units 

in the MASSUNITS dialog box. 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/Components.htm%23AssignMaterial
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Specify the desired precision in the Mass precision field. 

Close the Settings dialog box. 

 

NOTE The Mass units setting affects the mass values only . Other mass properties such as 
density or moments of inertia will be formatted in SI units for the metric system and in 
imperial units for the imperial system, regardless of the value of the Mass units setting. 

 

To Compute the Mass Properties 

Execute the BmMassProp command. 

You can compute mass properties for the entire model or for a selection of 3D solids and/or 
subcomponents. The values of mass, volume, centroid, moments of inertia, products of inertia, 

radii of gyration, principal monents and X-Y-Z directions about centroid are reported in the 
command bar. 

Optionally you can align the User Coordinate System with the inertia axes, as a result the center of 
masscentroid of the component lies at the origin of UCS, which can be useful to investigate the 
behavior of a product under gravity force. 

bricscad-cmdref.chm::/Mechanical/BmMassProp.htm
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Parametric Modeling 

BricsCAD provides a rich toolset to control 2D and 3D geometric model via parameters of different 
kinds, including: 

global parameters, which includes parameters of 2D/3D dimensional constraints, user-defined 

parameters, and configuration parameters of design table, 

local parameters, which includes parameters of arrays and constrained entities inside arrays, and 
parameters of inserts of parametric components. 

All parameters and their current values are displayed under different sections in the Mechanical 
Browser. Parameter values can be linked together via expressions. When the value of a parameter 
is changed, the geometric model is updated automatically. This toolset allows BricsCAD users to 

add parametric behavior to any geometry and easily explore design variants. 

Note that in BricsCAD there are no parent-child dependencies between geometric elements: for 
example, if you change a sketch used to create an extruded 3d solid, the solid is not changed 

accordingly. But you can always create any kind of dependencies using parameters and 
expressions. 

Global and local parameters 

Commands: -PARAMETERS, MECHANICALBROWSEROPEN, CLEANUNUSEDVARIABLES 

  

Parameters in BricsCAD can be global and local. Local parameters are attached to a particular 
entity: an associative array or a mechanical component. Global parameters are not attached to a 
particular entity; they are subdivided into three groups: 

parameters of 2D dimensional constraints (see User Guide/Drawing Accurately/Parametric 
Constraints/Using Dimensional Constraints to learn how to use 2D dimensional constraints), 

parameters of 3D dimensional constraints (see User Guide/Creating Entities/Direct Modeling/3D 
Constraints to learn more about 3D dimensional constraints), 

user-defined parameters, 

configuration parameters of design tables. 

To learn how to create 2D dimensional constraints, please read User Guide/Drawing 
Accurately/Parametric Constraints/Using Dimensional Constraints. 

To learn how to create 3D dimensional constraints, see User Guide/Creating Entities/Direct 
Modeling/3D Constraints. 

To create a user-defined parameter, follow the procedure described in User Guide/Drawing 
Accurately/Parametric Constraints/Using Dimensional Constraints/Creating a New Parameter. 

To create a configuration parameter for a design table, see User Guide/Creating 
Entities/Parametric Modeling/Design Tables. 

Setting an expression to a parameter 

You can set an expression to any parameter, being it global or local. A simplest expression is just a 

number of a name of a global parameter (local parameters cannot be referenced by names in 
expressions). A more complex expression can also include standard operators and functions (see 
below). 

To set an expression to a parameter, click on the parameter name in the Mechanical Browser, and 
fill out the Expression field: 

  

bricscad-cmdref.chm::/P/-Parameters.htm
bricscad-cmdref.chm::/Mechanical/MechanicalBrowserOpen.htm
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NOTE You can also set an expression to a parameter in command line using the -PARAMETERS 
command. 

  

You can use operators and functions to compose an expression. 

Driving and driven parameters 

In expressions, you can use not only numbers, but also the names of global parameters. Such 
expressions are called non-constant. If a non-constant expression is set to a parameter, its icon, 

an open padlock ( ) in the Mechanical Browser changes to the closed padlock ( ): 

 

This means that the parameter becomes driven by other (driving) parameters: its value will be 
automatically recalculated when the values of the driving parameters will be changed. 

bricscad-cmdref.chm::/P/-Parameters.htm
file:///D:/BricsCAD%20Training/manuals/03_Drawing_Accurately/01_Parametric_Constraints/03_01_02_Using_Dimensional_Constraints.htm%23Operators
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bricscad-cmdref.chm::/Mechanical/MechanicalBrowserOpen.htm
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You can create a chain of parameters, where every next element is driven by the previous ones. 

The length of such chain is not limited. Obviously you cannot create a loop, where the next 
element in a chain drives one of the previous elements, because it can result in infinite evaluation 
of expressions in the loop. BricsCAD automatically detects such expressions and therefore does not 
accept expressions, which lead to a parametric loop. 

Parameters of Associative Arrays 

Commands: ARRAY, ARRAYRECT, ARRAYPOLAR, ARRAYEDIT. 

  

Properties of associative arrays that can be controlled by an expression: 

Rectangular arrays: Number of columns, Column spacing, Number of rows, Row spacing, Row 
elevation increment, Number of levels, Level spacing, Axis angle. 

Polar arrays: Radius, Number of Items, Angle between items, Fill angle, Number of rows, Row 

spacing, Row elevation increment, Number of Levels, Level spacing.  

To set an expression to any of these properties, select the corresponding array entity, either in the 
drawing area or directly in the Mechanical Browser and enter the expression in the corresponding 
properties field in the Mechanical Browser or in the Properties bar. 

 

If an associative array contains entities constrained with 2D or 3D dimensional constraints, then 
parameters of these constraints can also be evaluated with expressions. These nested parameters 

are listed in the Mechanical Browser, and if you select any of them, you can set an expression to it: 

bricscad-cmdref.chm::/A/Array/Array.htm
bricscad-cmdref.chm::/A/ArrayRect.htm
bricscad-cmdref.chm::/A/ArrayPolar.htm
bricscad-cmdref.chm::/A/ArrayEdit.htm
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bricscad-cmdref.chm::/Mechanical/MechanicalBrowserOpen.htm
file:///D:/BricsCAD%20Training/manuals/01_User_Interface/00_06_Properties_Bar.htm


BricsCAD V18  Help 

 

 657 

 

Parameters of Mechanical Components 

Commands: -BMPARAMETERS, BMUPDATE, 

The BMUPDATEMODE system variable controls whether external assembly components are always 

reloaded or only in case they are modified. 

If you insert a mechanical component or just a plain .dwg file into your drawing with BMINSERT 
command, and the insert contains global exposed parameters, then such parameters become local 
in the current drawing. They are associated with the corresponding component insert and are 

visible in the Mechanical Browser under the name of this insert. Click such parameter to edit: 

 

bricscad-cmdref.chm::/Mechanical/-BmParameters.htm
bricscad-cmdref.chm::/Mechanical/BmUpdate.htm
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Design Tables 

Commands: DESIGNTABLE, -DESIGNTABLEEDIT 

A design table allows BricsCAD users to evaluate several global parameters at once using the value 
of one configuration parameter. Design tables can be created from scratch in BricsCAD or imported 
from a .csv file (a comma-separated values text file), which can be created with any spreadsheet 

software or a text editor. 

Creating a Design Table from a .csv file 
The expected format of the .csv file is as follows: 

  

Size,Length,Width,Height 

Small,300,200,100 

Medium, 450,300,150 

Large,600,400,200 

  

The first row lists the parameter names separated by a comma. The first name should not coincide 
with the name of any global parameter persistent in your drawing. It is called the configuration 
name. Other names in the first row can (and usually do) coincide with the names of global 
parameters in your drawing. The next rows list possible values for these parameters, which can 

either be strings or numbers. 

Importing such .csv file into BricsCAD using te DESIGNTABLE command results in creating a 
special global parameter by the name of the first name in the first row in the .csv file (= Size in 
the above example), which is called the configuration parameter. It will drive the values of other 
parameters in the design table, which are then called configuration-driven parameters. 

  

NOTE BricsCAD does not keep the association with the .csv file, which was used to create a 
design table: if this file has been modified then the design table is not updated 

automatically. Use the -DESIGNTABLEEDIT command to replace a design table using a 
new or modified .csv file. 

Direct Lookup in a Design Table 
To evaluate a configuration parameter:  

Select it in the Mechanical Browser and type the desired value in its Expression field.  

bricscad-cmdref.chm::/D/DesignTable.htm
bricscad-cmdref.chm::/D/DesignTableEdit.htm
bricscad-cmdref.chm::/D/DesignTable.htm
bricscad-cmdref.chm::/D/DesignTableEdit.htm
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Select a value in the drop-down list of the Value field: 

 

  

Changing the value of a configuration parameter will result in automatic changing the values of all 
configuration-driven parameters of the corresponding design table. The values of these parameters 

are taken from the row in the design table, of which the first element coincides with the current 
value of the configuration parameter. 

 

Reverse Lookup in a Design Table 
Parameters, which are driven by a configuration parameter via a design table, can be evaluated 
independently. To do so, select the driven parameter and apply an expression to it. If the value of 
this expression matches one of the values for this parameter in the corresponding design table, 
then the configuration parameter and all driven parameters of the design table will be 
automatically set to the values specified in the corresponding row in the table. If several 
configurations are possible for a particular value of a driven parameter, BricsCAD selects the one, 

which is closest to the current values of other parameters. 

If you enter an expression of which the result is not available in the design table, or if you enter 
expressions for two or more design table parameters, of which the values cannot be found in a 
single configuration (= the values are not found in the same row in the design table), then the 

values of the configuration parameter are changed to 'Custom', and the values of the other driven 
parameters are not changed. This case corresponds to a configuration, which does not exist in the 
design table. 

 

Adding a New Configuration to a Design Table 
You can add any 'Custom' configuration to a design table under a particular name. To do so, right 
click the configuration parameter in the Mechanical Browser and select Save current configuration 
in the context menu. The configuration will be added to the design tableas 'Configuration_N', 
where 'Configuration' is the name of the configuration parameter, and 'N' is an index number, 

which is one more than the current number of configurations in the design table. 

If you want to save a configuration in the design table under a different name, launch the 
&endash;DESIGNTABLEEDIT command. 

bricscad-cmdref.chm::/D/DesignTableEdit.htm
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Creating an Empty Design Table 

Using the procedure described above (adding a new configuration to a design table), it is possible 
to start your design with an empty design table, and then fill it with desired values. 

To do so, use the 'Empty Design Table' tool, which asks you: 

The name of a new design table (which is also the name of the corresponding configuration 

parameter),  

The names of global parameters, which will be driven by this design table. 

 

Using a Parametric Component with Design Tables 

You can expose both configuration parameters and configuration-driven parameters to be uses in 
assemblies. If you then insert such a component into your drawing, its parameters will include the 

exposed parameters of design tables, for which drop-down lists of admissible values will be 
available. Both direct and reverse lookup actions are supported for such parameters. 

 

Other Actions with Design Tables 

The &endash;DESIGNTABLEEDIT command allows to: 

Delete a design table. 

Replace a design table. 

Link a new parameter to the design table or unlink an existing one.  

Add new configurations, remove an existing one, or export a design table into a .csv file. 

Global and Local Parameters 

Commands: -PARAMETERS, MECHANICALBROWSEROPEN, CLEANUNUSEDVARIABLES 

  

Parameters in BricsCAD can be global and local. Local parameters are attached to a particular 

entity: an associative array or a mechanical component. Global parameters are not attached to a 
particular entity; they are subdivided into three groups: 

parameters of 2D dimensional constraints (see User Guide/Drawing Accurately/Parametric 
Constraints/Using Dimensional Constraints to learn how to use 2D dimensional constraints), 

parameters of 3D dimensional constraints (see User Guide/Creating Entities/Direct Modeling/3D 

Constraints to learn more about 3D dimensional constraints), 

user-defined parameters, 

configuration parameters of design tables. 

To learn how to create 2D dimensional constraints, please read User Guide/Drawing 
Accurately/Parametric Constraints/Using Dimensional Constraints. 

To learn how to create 3D dimensional constraints, see User Guide/Creating Entities/Direct 
Modeling/3D Constraints. 

To create a user-defined parameter, follow the procedure described in User Guide/Drawing 

Accurately/Parametric Constraints/Using Dimensional Constraints/Creating a New Parameter. 

To create a configuration parameter for a design table, see User Guide/Creating 
Entities/Parametric Modeling/Design Tables. 

Setting an Expression to a Parameter 

You can set an expression to any parameter, being it global or local. A simplest expression is just a 

number of a name of a global parameter (local parameters cannot be referenced by names in 
expressions). A more complex expression can also include standard operators and functions (see 
below). 

To set an expression to a parameter, click on the parameter name in the Mechanical Browser, and 
fill out the Expression field: 

  

bricscad-cmdref.chm::/D/DesignTableEdit.htm
bricscad-cmdref.chm::/P/-Parameters.htm
bricscad-cmdref.chm::/Mechanical/MechanicalBrowserOpen.htm
bricscad-cmdref.chm::/C/CleanUnusedVariables.htm
file:///D:/BricsCAD%20Training/manuals/03_Drawing_Accurately/01_Parametric_Constraints/03_01_02_Using_Dimensional_Constraints.htm
file:///D:/BricsCAD%20Training/manuals/03_Drawing_Accurately/01_Parametric_Constraints/03_01_02_Using_Dimensional_Constraints.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/10_03_05_3D_Constraints.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/10_03_05_3D_Constraints.htm
file:///D:/BricsCAD%20Training/manuals/03_Drawing_Accurately/01_Parametric_Constraints/03_01_02_Using_Dimensional_Constraints.htm
file:///D:/BricsCAD%20Training/manuals/03_Drawing_Accurately/01_Parametric_Constraints/03_01_02_Using_Dimensional_Constraints.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/10_03_05_3D_Constraints.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/10_03_05_3D_Constraints.htm
file:///D:/BricsCAD%20Training/manuals/03_Drawing_Accurately/01_Parametric_Constraints/03_01_02_Using_Dimensional_Constraints.htm%23NewParameter
file:///D:/BricsCAD%20Training/manuals/03_Drawing_Accurately/01_Parametric_Constraints/03_01_02_Using_Dimensional_Constraints.htm%23NewParameter
bricscad-cmdref.chm::/Mechanical/MechanicalBrowserOpen.htm
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NOTE You can also set an expression to a parameter in command line using the -PARAMETERS 
command. 

  

You can use operators and functions to compose an expression. 

 

Driving and Driven Parameters 

In expressions, you can use not only numbers, but also the names of global parameters. Such 
expressions are called non-constant. If a non-constant expression is set to a parameter, its icon, 

an open padlock ( ) in the Mechanical Browser changes to the closed padlock ( ): 

 

bricscad-cmdref.chm::/P/-Parameters.htm
file:///D:/BricsCAD%20Training/manuals/03_Drawing_Accurately/01_Parametric_Constraints/03_01_02_Using_Dimensional_Constraints.htm%23Operators
file:///D:/BricsCAD%20Training/manuals/03_Drawing_Accurately/01_Parametric_Constraints/03_01_02_Using_Dimensional_Constraints.htm%23Functions
bricscad-cmdref.chm::/Mechanical/MechanicalBrowserOpen.htm
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This means that the parameter becomes driven by other (driving) parameters: its value will be 

automatically recalculated when the values of the driving parameters will be changed. 

You can create a chain of parameters, where every next element is driven by the previous ones. 
The length of such chain is not limited. Obviously you cannot create a loop, where the next 
element in a chain drives one of the previous elements, because it can result in infinite evaluation 
of expressions in the loop. BricsCAD automatically detects such expressions and therefore does not 

accept expressions, which lead to a parametric loop. 

Parameters and Associative Arrays 

Commands: ARRAY, ARRAYRECT, ARRAYPOLAR, ARRAYEDIT. 

  

Properties of associative arrays that can be controlled by an expression: 

Rectangular arrays: Number of columns, Column spacing, Number of rows, Row spacing, Row 

elevation increment, Number of levels, Level spacing, Axis angle. 

Polar arrays: Radius, Number of Items, Angle between items, Fill angle, Number of rows, Row 
spacing, Row elevation increment, Number of Levels, Level spacing.  

To set an expression to any of these properties, select the corresponding array entity, either in the 
drawing area or directly in the Mechanical Browser and enter the expression in the corresponding 
properties field in the Mechanical Browser or in the Properties bar. 

 

If an associative array contains entities constrained with 2D or 3D dimensional constraints, then 
parameters of these constraints can also be evaluated with expressions. These nested parameters 
are listed in the Mechanical Browser, and if you select any of them, you can set an expression to it: 

bricscad-cmdref.chm::/A/Array/Array.htm
bricscad-cmdref.chm::/A/ArrayRect.htm
bricscad-cmdref.chm::/A/ArrayPolar.htm
bricscad-cmdref.chm::/A/ArrayEdit.htm
bricscad-cmdref.chm::/Mechanical/MechanicalBrowserOpen.htm
bricscad-cmdref.chm::/Mechanical/MechanicalBrowserOpen.htm
file:///D:/BricsCAD%20Training/manuals/01_User_Interface/00_06_Properties_Bar.htm
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MCAD Tutorial 

Assembly Design and Kinematic Analysis Tutorial 

The source files for this tutorial are installed in the [BricsCAD Installation 

folder]\Samples\Mechanical\piston folder. 

Assembly design is a typical application where constraints are commonly used. BricsCAD Platinum 
allows users to assemble mechanisms and run kinematic analysis. 

This tutorial shows you how to start working with assemblies in BricsCAD.  You will learn how to 
assemble the different parts in a 3D model, which lets you control the final result. 

There are two approaches in MCAD (Mechanical Computer-Aided Design) to build an assembly: 

top-down and bottom-up. 

In the top-down approach, you start with an empty assembly and the geometry of each 
component is then created, one by one, in the assembly. 

In the bottom-up approach, each component is first created as a single entity. All components are 
then inserted into the assembly. The position of each component is controlled through 3D 
constraints. 

We will now assemble a simplified - in comparison with a real-world engine - model of a piston 

engine. 

  

 

Step 1: Preparing for the Exercise 

You need a BricsCAD Platinum license for this tutorial.  

Make sure the Asssembly and 3D Constraints toolbars are open. 

 

  
 

 
 
To open a toolbar: move the cursor over an open toolbar, then right click and select the required 
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toolbars from the toolbar list. 

Toolbars that are already open are marked in the list.  

Make sure that the Quad cursor menu is active. 
 

 
 
Click the Quad field in the Status bar if necessary.  

Make sure that the Exclude entities in Xrefs option of the PREVIEWFILTER system variable is 
switched off. 

 

 

Open the Mechanical Browser dialog box. 

Do one of the following:  

Click the Mechanical Browser tool button ( ) on the Mechanical | Tools panel in the 
ribbon.  

Click the Mechanical Browser tool button ( ) on the Mechanical toolbar.  

Choose Mechanical Browser in the Mechanical menu.  

Type bmbrowser in the command bar.  

file:///D:/BricsCAD%20Training/01_User_Interface/01_00_The_Bricscad_Application_Window.htm%23Working_with_the_status_bar
bricscad-sysvar.chm::/00_07_Settings_Manager.htm
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Make sure Selection Modes = 3 
Do one of the following: 

Type selectionmodes in the command bar, then type 3. 

Set the Selection Modes toolbar as indicated below. 
 

 

Step 2: Creating the Assembly Drawing 

Click the New Component tool button ( ) on the Mechanical | Create panel in the ribbon. 
A new drawing of the name Component_1.dwg is created and Component_1 is added in the 
Mechanical Browser.  

In the bottom part of the Mechanical Browser, click the Name field and rename the main 
component: Piston Engine.   

 
  

The drawing name automatically matches the main component name. 

Save the drawing.  
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Step 3: Adding the Components 

Click the Insert Component tool button ( ) on the Mechanical | Modify panel in the ribbon. 
The Insert Mechanical Component dialog displays: 
Open the [BricsCAD Installation folder]\Samples\Mechanical\piston folder. 
 

 

Select the crankshaft.dwg, then double click or click the Open button. 
The component is attached to the cursor with its origin point.  

Dynamic dimensions display: Distance from the origin of the current coordinate system.  

We will consider the crankshaft as the anchor component of the assembly, and therefore  insert it 
at the origin (0,0,0). 
Please make sure the insertion point is exactly at 0,0,0, otherwise the kinematic analysis in step 5 

might fail.  

 
Use the Look From widget to adjust the view orientation.  

Repeat the previous steps to insert the other components: cylinder (1), piston (2), pin (3) and 
connecting rod (4). 
Avoid visual intersection of the components.  

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/Assembly_Tutorial.htm%23Step5
file:///D:/BricsCAD%20Training/04_Viewing_your_drawing/04_05_View_Rotation.htm%23LookFrom
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Step 4: Positioning the Components 

Click the Fix tool button ( ) on the Solid | 3D Constraints panel in the ribbon. 
You are prompted: Select an edge, face or 3D solid:  

Move the cursor over the largest cylindrical face of the crankshaft. Click when the face highlights.  

Repeat the DmFix3d command. 

Move the cursor over the currently obscured circular face of the crankshaft. 

Hit the TAB key until the face highlights and click when the face highlights. 

 
 
The position of the selected faces of the crankshaft is now locked, as indicated in the Constraints 
tree in the Mechanical Browser. 

 

 
 
Clicking a constraint highlights the solid, face or edge it applies to.  

Place the connecting rod near the crankshaft.  

Click the Coincident tool button ( ) on the Solid | 3D Constraints panel in the ribbon. 
You are prompted:  

Select a pair of subentities or [Autoconstrain] <Autoconstrain>:  

bricscad-cmdref.chm::/DirectModeling/dmFix3d.htm
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Move the cursor over two planar faces of the crankshaft (1) and the connecting rod (2) as 

indicated in the image below. 
Click when the correct face highlights. Hit the TAB key to select the obscured face of the 
connection rod and click when the face highlights.  

 

Click the Concentric tool button ( ) on the Solid | 3D Constraints panel in the ribbon. 
You are prompted:  
Select the first entity:  

Move the cursor over two cylindrical faces of the crankshaft (1) and the connecting rod (2) as 

indicated in the image below. 
Click when the first face highlights, then select the second face.  

 

The connecting rod is automatically moved to the right position according to our design intent. 
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Click the Concentric tool button ( ) on the Solid | 3D Constraints panel in the ribbon. 
You are prompted:  
Select the first entity:  

Move the cursor over two cylindrical faces of the piston (1) and the pin (2) as indicated in the 
image below. 
Click when the first face highlights, then select the second face.  
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Click the Tangent tool button ( ) on the Solid | 3D Constraints panel in the ribbon. 
You are prompted:  
Select the first entity:  

Move the cursor over two cylindrical faces of the piston (1) and the pin (2) as indicated in the 
image below. 
Click when the first face highlights, then select the second face.  
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Click the Coincident tool button ( ) on the Solid | 3D Constraints panel in the ribbon. 
You are prompted:  
Select a pair of subentities or [Autoconstrain] <Autoconstrain>:    

Move the cursor over two planar faces of the connecting rod (1) and the piston (2) as indicated in 
the image below. 
Click when the first face highlights, then select the second face. 
Hit the TAB key to select the interior face of the piston.  

 

Click the Concentric tool button ( ) on the Solid | 3D Constraints panel in the ribbon. 
You are prompted:  
Select the first entity:  
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Move the cursor over two cylindrical faces of the connecting rod (1) and the pin (2) as indicated in 

the image below. 
Click when the first face highlights, then select the second face.  

 

 

Click the Concentric tool button ( ) on the Solid | 3D Constraints panel in the ribbon. 
You are prompted:  

Select the first entity:  

Move the cursor over two cylindrical faces of the piston (1) and the cylinder (2) as indicated in the 
image below. 
Click when the first face highlights, then select the second face.  
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Click the Distance tool button ( ) on the Solid | 3D Constraints panel in the ribbon. 
You are prompted:  
Select a first entity or specify [measurement Mode]:  

Move the cursor over the cylindrical faces of the crankshaft (1) and the planar bottom face of the 
cylinder (2) as indicated in the image below. 
Click when the first face highlights, then select the second face. 
Hit the TAB key to select the bottom face of the cylinder. 
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Type 120 in the dynamic distance field.  

(optional) Edit the Expression field of the distance constraint in the Mechanical Browser panel to 
adjust the vertical position of the cylinder.  

Click the Fix tool button ( ) on the Solid | 3D Constraints panel in the ribbon. 
You are prompted: Select an edge, face or 3D solid:  

Click the outside cylindrical face of the cylinder.  

Step 5: Kinematic Analysis 

In this assembly the crankshaft is the driving component. To run the kinematic analysis we will 
rotate the crankshaft around its axis, which in this case is the Y-axis of the WCS.  

Move the cursor over the crankshaft, then choose Rotate ( ) in the Model command group in the 

Quad cursor menu. 
 

 
 
You are prompted: Select axial entity or define axis by [2Points/Xaxis/Yaxis/Zaxis] <2Points>:  
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Do one of the following:  

Type Y, then press Enter.  

Choose Y axis in the prompt menu.  

You are prompted: Pick start point in the rotation plane: 

Pick a point in the drawing, then move the mouse to define the rotation angle. 
The piston and the connecting rod move dynamically along with the rotation of the crankshaft, 

while the cylinder stays at its fixed position.  
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BricsCAD Communicator 

Commands: COMMUNICATORINFO, EXPORT, IMPORT 

  

 

Assembly design using BricsCAD Communicator  

  

BricsCAD Communicator is an optional plug-in for the Pro and Platinum editions of BricsCAD that 
imports and exports 3D data between major CAD formats. Its high quality translations facilitate the 
re-use of 3D CAD data, thereby improving productivity and reducing project costs.  

Supported file formats 

Export 

STE, STP, STEP: Standard for Exchange of Product data. The following export protocols can be 
specified: AP203, AP214, AP242. 
 

 

IGS, IGES: Initial Graphics Exchange Specification 

CATIA V4 and V5: 

VDA: VDA-FS 

3D PDF 

You can export BricsCAD assembly with mechanical components as a STEP file with product 
structure. To do that set the desired value in Settings dialog: 

 

 

Import 

ACIS 

ASM, PRT: Creo Elements / Pro Engineer 

CATIA V4/V5/V6 

IAM, IPT: Inventor 

IGS, IGES: Initial Graphics Exchange Specification 

NX 

PARASOLID 

PAR, PSM: Solid Edge 

Pro/E/Creo 

bricscad-cmdref.chm::/C/CommunicatorInfo.htm
bricscad-cmdref.chm::/E/Export.htm
bricscad-cmdref.chm::/I/Import.htm
https://blog.bricsys.com/tutorials/
https://blog.bricsys.com/assembly-design-using-bricscad-communicator/
bricscad-sysvar.chm::/00_07_Settings_Manager.htm
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PRT: NXSTE, STP, STEP: Standard for Exchange of Product data 

SLDASM, SLDPRT: Solidworks 

VDA: VDA-FS 

XCGM 

When you import an assembly file, you can get its content as a plain geometry (a nonhierarchical 
set of entities) or map its product structure into native blocks or mechanical components.  

PMI (product and manufacturing information) is supported for the following file formats: ACIS, 
CATIA V5, NX, Pro/E / Creo, SolidWorks, XCGM (Communicator license is required). PMI 
annotations are imported as graphical elements grouped in blocks.  

If the assembly contains hidden parts, you can decide how to represent them in BricsCAD: import 
and hide, import and set visible, or just do not import.  

The desired behavior can be changed in the Settings dialog: 

  

 

  

You can also set other import options to automatically repair, stitch and simplify imported 
geometry. If you import a 3D model from SolidWorks, it makes sense to set an option to map Y 

axis into Z (because in SolidWorks the vertical axis is Y). 

For SolidWorks and other native CAD formats it is possible to specify alternate search path, which 
will be used to look for parts absent in the imported assembly folder. 

bricscad-sysvar.chm::/00_07_Settings_Manager.htm
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BIM 

 

BricsCAD BIM tutorials  

  

Instead of creating a set of dedicated BIM primitives like walls, slabs, columns, etc..., each with 
their own restricted behavior and properties, we opted for offering maximum flexibility. Any 3D 
Solid can be used in a BIM model, whether it is created and edited by using existing BricsCAD 
modeling tools, new powerful BIM commands, or even imported from 3rd party software or edited 

by 3rd party tools. 

At any stage one can decide to classify 3D Solid, or other entities, as Building Elements of type 
Wall, Slab, Column, etc... Classification can be done automatically and manually. 

The automatic classification tool analyzes and classifies entire buildings in a few seconds. 

Compositions can be assigned to the various solids of the BIM model. Compositions can be 
composed of either a single ply or a multiply material. Compositions and materials are saved in a 

project database, which is either embedded in the BIM model file or in an external library. 

IFC import/export ensures optimal cooperation with other disciplines and applications. 

  

 

Villa PM on BricsCAD by courtesy of Architrend Architecture - Italy 

 

Creating Walls 

In BricsCAD walls are created using the PolySolid command. 

When drawing walls it is recommended to use Dynamic Dimensions to specify the length of the 

wall and Polar Tracking to control the direction. 

  

 

Creating Walls  

  

https://blog.bricsys.com/category/tutorials/bim/
http://blog.bricsys.com/category/tutorials/bim/
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/Database/Materials.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/Database/Structure.htm
bricscad-cmdref.chm::/P/PolySolid.htm
file:///D:/BricsCAD%20Training/03_Drawing_Accurately/03_11_Dynamic_Dimensions.htm
file:///D:/BricsCAD%20Training/03_Drawing_Accurately/03_05_Polar_Tracking.htm
https://blog.bricsys.com/category/tutorials/bim/
https://blog.bricsys.com/bricscad-bim-create-walls/
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Creating a Single Wall 

Do one of the following:  

Click the PolySolid tool button ( ) on the 3D Solids toolbar.  

Choose Polysolid in the Model > 3D Solids menu.  

Type polysolid in the command bar.  

You are prompted: Start point or Height/Width/Justification/separateSolids/Dynamic/<Object>: 

Specify the start point of the wall. 
You are prompted: Arc/Distance/<Next point>: 
The footprint of the wall displays dynamically.  

Move the cursor in the desired direction until a polar tracking line displays. 
The current length displays in the Length dynamic entry field, 
Optionally hit the Shift key to lock the polar tracking line. Locked tracking lines turn red. Hit the 
shift key again to unlock.  

Do one of the following:  

Specify the endpoint.  

Type a value in the Length dynamic entry field, then press Enter.  

The footprint of the next wall displays dynamically. 

Right click or press Enter. 
The height of the wall displays dynamically in the Height field.. 

The default width of the wall is indicated in the Width field. 
The current justification of the wall is indicated in the Tips widget. 
 

 

Repeatedly hit the Ctrl key to cycle the justification options: Right, Center or Left. 
The justification of the wall is adjusted accordingly.  

(option) Hit the TAB key, then enter a value in the Width field then hit the TAB key again.  

Do one of the following to define the height of the wall:  

Press Enter to accept the default height.  

Type a value in the Height field, then press Enter.  

NOTE The previously used width and height of polysolids is saved to the PSOLWIDTH and 

PSOLHEIGHT system variables, which are saved in the drawing. The default values are 
used the next time the Polysolid command is executed. 

 

Creating a Chain of L-Connected Walls 

Do one of the following:  

Click the PolySolid tool button ( ) on the 3D Solids toolbar.  

Choose Polysolid in the Model > 3D Solids menu.  

Type polysolid in the command bar.  

file:///D:/BricsCAD%20Training/01_User_Interface/01_00_The_Bricscad_Application_Window.htm%23Tips:
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You are prompted: Start point or Height/Width/Justification/separateSolids/Dynamic/<Object>: 

Specify the start point of the wall. 
You are prompted: Arc/Distance/<Next point>: 
The footprint of the first wall displays dynamically.  

Move the cursor in the desired direction until a polar tracking line displays. 
The current length displays in the Length dynamic entry field, 

Optionally hit the Shift key to lock the polar tracking line. Locked tracking lines turn red. Hit the 
shift key again to unlock.  

Do one of the following:  

Specify the endpoint.  

Type a value in the Length dynamic entry field, then press Enter.  

The footprint of the next wall displays dynamically. 

Repeat steps 3 and 4 to create the next walls. 

The footprints of all walls display.  

Right click or press Enter to stop adding walls. 
The height of the walls displays dynamically in the Height field. 
The default width of the walls is indicated in the Width field. 
The current justification of the walls is indicated in the Tips widget. 
 

 

Repeatedly hit the Ctrl key to cycle the justification options: Right, Center or Left. 
The justification of all walls is adjusted accordingly.  

(option) Hit the TAB key, then enter a value in the Width field then hit the TAB key again.  

Do one of the following to define the height of the walls:  

Press Enter to accept the default height.  

Type a value in the Height field, then press Enter.  

  

NOTES The width and height of polysolids is saved to the PSOLWIDTH and PSOLHEIGHT 

system variables, which are saved in the drawing. The previously used values are 
remembered the next time the PolySolid command is executed. 

If Separate Solids is OFF, a single multisegment wall is created. If Separate Solids is 

ON a chain of bisector L-connected solids is created. 

The Separate Solids can be chosen in the initial command prompt of the PolySolid 
command. The setting is remembered the next time the PolySolid command is 
executed. 

 

file:///D:/BricsCAD%20Training/01_User_Interface/01_00_The_Bricscad_Application_Window.htm%23Tips:
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Connecting Solids 

Since solids, as any other BIM entity, are created as native 3D solids, any of the 3D Solids Editing 
commands or Direct Modeling commands can be used to modify solids. 

 

  

 

  

The BimConnect command ( ) creates an L-connection (bisector or parallel) between two solids. 

The BimDrag command ( ):  

 

drags major faces (1):  

: Drag Solid = move the entire solid 

: Drag Face = modify the thickness of the solid 

: Copy Solid = creates a parallel copy of a solid or copies part of a solid, defined by a detected 
boundary (if the Boundary Detection option of the SELECTIONMODES system variable is checked). 

Drags minor faces (2): 

: Drag face =  modify the length or height dynamically or by specifying a value 

: Connect = connect to the major face of another solid. Creates T-connections between solids; 
connects solids to floor and roof slabs. 

  

The procedures below use the Quad cursor menu. 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/10_03_03_Direct_modeling_operations.htm
bricscad-cmdref.chm::/BIM/BimConnect.htm
bricscad-cmdref.chm::/BIM/BimDrag.htm
file:///D:/BricsCAD%20Training/03_Drawing_Accurately/03_12_Quad.htm
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Creating L-Connections 

Make sure SELECTIONMODES = 0 
 

 

Select the first solid. 
The solid highlights.  

Hover over the second solid. 

When the solid highlights, choose BimConnect ( ) in the BIM command group of the Quad. 
The selected solids are connected: the default connection type is L-bisector. 
If TIPS is ON, the Tips widget displays.  

 

  
You are prompted: Accept connection <Ok>/Next 

Do one of the following:  

Press Enter or right click to accept the default L-bisector connection.  

Hit the Ctrl key to cycle between L-parallel and L-bisector connections and press Enter or 
right click when the desired connection displays. 
The 3D model updates dynamically when cycling the L-connection types.  

 

NOTE L-connections can also be created between between non-vertical solids such as roof 

slabs. 

   

Creating T-Connections 

The below procedure allows to connect minor faces of a solid to the major faces of other solids, 
regardless what the orientation of the faces is. As a result you can use this option of the BIMDRAG 
command to T-connect solids, to connect the top or bottom face of a solid to a roof or floor slab or 
to connect the side faces of a slab to solids. 

Make sure the Select Faces option of the SELECTIONMODES system variable is selected. 
 

 

Move the cursor over the minor face of the first solid at the end that needs to be connected. 
Hit the TAB key to highlight obscured faces. 
Click when the face highlights.  

Repeat the previous step to select more faces. 
To select the last face, go to the next step.  

Move the cursor over the face.  
If necessary, hit the TAB key to highlight an obscured face. 

When the face highlights, choose BimDrag ( ) in the BIM command group of the Quad. 
The selected face moves dynamically with the cursor. 
If TIPS is ON, the Tips widget displays.  

 

: Drag dynamically.  

bricscad-sysvar.chm::/00_07_Settings_Manager.htm
bricscad-cmdref.chm::/BIM/BimDrag.htm
bricscad-sysvar.chm::/00_07_Settings_Manager.htm
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: Connect  

Press the Ctrl key. 
Prompts you: Select one or more 3d solids to connect <ENTER to auto-select>:  

Select the solid(s) to connect to. 
The selected face is connected to the nearest face of the selected solid(s).  

 Right click or press Enter to accept the connection.  

TIP Hover over the minor face of the solid, then choose Connect with Nearest ( ) in the Model 
command group of the Quad. 

   

Creating T-connections ply-by-ply 

  

 

 

3D Model Calculated Section 

   

To control the connection of composition plies between solids and and between solids and slabs, 
you can execute BimDrag on a ply in a clipped BimSection if Display Composition of the solids is 

ON. 

  

To create a T-connection ply-by-ply in a section, do the following: 

Place the cursor over the face of the ply you want to connect. If necessary, repeatedly press the 
TAB-key to select an obscured face. 

When the ply face highlights, choose BimDrag ( ) in the Quad. 

Hit the Ctrl-key once. 
Prompts you: Select one or more 3d solids to connect <ENTER to auto-select>: 

Move the cursor over the sectioned multiply solid you want to connect to. The lines between the 
plies highlight. 

bricscad-cmdref.chm::/BIM/BimDrag.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/Sections/SectionPlanes.htm%23ClipDisplay
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Click when the desired line highlights. 

Right click to confirm. 
The ply of the first solid is connected to the ply of the second solid. The connected ply is subtracted 
from the second solid. 

 

Modifying the Thickness 

Make sure the Select Faces option of the SELECTIONMODES system variable is selected. 
 

 

Move the cursor over a major face of the solid.  

When the face highlights, choose BimDrag ( ) in the BIM command group of the Quad. 
If TIPS is ON, the Tips widget displays.  

 

: Drag Solid  

: Drag Face = modifying the thickness of the solid  

If necessary, hit the Ctrl key to select Major Faces = OFF ( ). 

The selected face of the solid is dragged. 
The dynamic dimension field displays the relative displacement of the face (= with respect to its 
original position).  

(option) To modify the thickness incrementally, move the face in the desired direction, then type a 
value and press Enter.  

(option) To set the new overall thickness of the solid, hit the TAB key, then type a value and press 
Enter. 
When hitting the TAB key, most likely, the other major face of the solid is selected as the reference 
face for the dynamic dimension. However, if a major face of another solid highlights, hit the TAB 

key again.  

NOTES When hitting the TAB key, most likely, the other major face of the solid is selected as 
the reference face for the dynamic dimension. However, if a major face of another solid 
highlights, hit the TAB key again. Repeatedly hitting the TAB key cycles all parallel 
major faces of all solids in the current view. 

If the thickness of solid, that has a composition with a locked thickness applied,  is 
modified, the solid solid displays in red. Execute the BimUpdateThickness command to 
re-apply the composition to such solid. 

bricscad-sysvar.chm::/00_07_Settings_Manager.htm
bricscad-cmdref.chm::/BIM/BimUpdateThickness.htm
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Modifying the Height of a single wall 

Make sure the Select Faces option of the SELECTIONMODES system variable is selected. 
 

 

Move the cursor over the top face of the wall. 
If necessary, hit the TAB key to highlight an obscured face.  

When the face highlights, choose BimDrag ( ) in the BIM command group of the Quad. 
The selected face moves dynamically with the cursor. 
If TIPS is ON, the Tips widget displays.  

 

: Drag dynamically.  

: Connect  

The dynamic dimension fields displays the incremental height. 

Do one of the following:  

Specify a point in the model, e.g. snap to a point.  

Type a value in the dynamic dimension field and press Enter.  

Hit the TAB key to use another reference face, e.g. the bottom face of the solid, then type a value 
in the dynamic dimension field.  

 

Modifying the height of multiple walls 

Using the SelectAlignedFaces command (Quad > Select: ) it is easy to select the top face of all 
solids that lie in the same horizontal plane. 

Make sure the Select Faces option of the SELECTIONMODES system variable is selected. 
 

 

Move the cursor over the top face of one of the walls. 
If necessary, hit the TAB key to highlight an obscured face.  

When the face highlights, choose Select Aligned Faces ( ) in the Solid/Face Selection command 
group in the Quad. 
All faces lying in the plane of the selected face are selected.  

Choose BimDrag ( ) in the BIM command group of the Quad. 
The selected faces move dynamically with the cursor. 
If TIPS is ON, the Tips widget displays.  

 

: Drag dynamically.  

: Connect  

bricscad-sysvar.chm::/00_07_Settings_Manager.htm
bricscad-cmdref.chm::/S/SelectAlignedFaces.htm
bricscad-sysvar.chm::/00_07_Settings_Manager.htm


BricsCAD V18  Help 

 

 687 

The dynamic dimension fields displays the incremental height. 

Do one of the following:  

Specify a point in the model, e.g. snap to a point.  

Type a value in the dynamic dimension field and press Enter.  

Hit the TAB key to use another reference face, e.g. the bottom face of the solid, then type 
a value in the dynamic dimension field.  

 

Modifying the height ply-by-ply 

When the Display Composition property of a solid is set, and the Select Faces option of the 
SELECTIONMODES system variable is selected, the height or length of the composition plies can be 
modified separately. 

Move the cursor over the ply you want to edit and choose BimDrag ( ) in the Model command 
group of the Quad when the ply highlights. 

 

 

Type value in the dynamic distance field. 
 

 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/Database/Compositions_Editor.htm%23DisplayComposition
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Press Enter to accept the distance. 

 

 

  

Setting the Distance between Parallel Solids 

Make sure the Select Faces option of the SELECTIONMODES system variable is selected. 

 

 

Move the cursor over a major face of the solid to be moved.  

When the face highlights, choose BimDrag ( ) in the BIM command group of the Quad. 
You are prompted: Select point for dragging or [Switch to copy solid] <drag solid>: 
If TIPS is ON, the Tips widget displays. 

 

 
 
The enitre solid moves. 
The dynamic dimension field displays the relative displacement of the solid (= with respect to the 
original position of the selected face).  

Repeatedly hit the TAB key until the desired reference face on a parallel solid highlights. 

Press and hold the Shift key while hitting the TAB key to cycle reference faces in reversed order. 
The dynamic entry field displays the distance with respect to the currently highlighted reference 

face. 

Type a value in the dynamic entry field, then press Enter. 

Creating a Parallel Copy of a Solid 

Make sure the Select Faces option of the SELECTIONMODES system variable is selected. 
 

 

Move the cursor over a major face of the solid to be copied. 

When the face highlights, choose BimDrag ( ) in the BIM command group of the Quad. 
You are prompted: Select point for dragging or [Switch to copy solid] <drag solid>: 

If TIPS is ON, the Tips widget displays. 

  

bricscad-sysvar.chm::/00_07_Settings_Manager.htm
bricscad-sysvar.chm::/00_07_Settings_Manager.htm
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Hit the Ctrl key twice to select the Copy Solid option ( ). 
You are prompted: Select point for dragging or [Switch to drag face] <copy solid>: 

Do one of the following: 

Specify a point. 

Repeatedly hit the TAB key until the desired reference face on a parallel solid highlights. 
Press and hold the Shift key while hitting the TAB key to cycle reference faces in reversed order. 
The dynamic entry field displays the distance with respect to the currently highlighted reference 

face. 
Type a value in the dynamic entry field, then press Enter. 

Creating a Partial Copy of a Solid 

Make sure the Enable boundary detection option of the SELECTIONMODES system variable is 
selected. 

 

 

Move the cursor over the part of the solid to be copied. 

When the face highlights, choose BimDrag ( ) in the BIM command group of the Quad. 
You are prompted: Select point to copy entity: 

Do one of the following: 

Specify a point. 

Repeatedly hit the TAB key until the desired reference face on a parallel solid highlights. 
Press and hold the Shift key while hitting the TAB key to cycle reference faces in reversed order. 
The dynamic entry field displays the distance with respect to the currently highlighted reference 
face. 
Type a value in the dynamic entry field, then press Enter. 

Creating Slabs 

Creating Floor Slabs 

Make sure that: 

The Enable Boundary Detection option of the SELECTIONMODES system variable is ON. 

The bottom faces of the surrounding walls are in the XY-plane of the current coordinate system. 
If necessary move the origin of the coordinate system. 

Dynamic dimensions are ON. 

Move the cursor inside the surrounding walls. 

When the boundary highlights, choose Extrude ( ) in the Model command group in the Quad. 
The slab is extruded dynamically. 

Do one of the following: 

Type the thickness of the slab in the dynamic dimension field. 

Pick a point. 

Creating Pitch Roof Slabs 

Make sure that: 

Dynamic UCS is ON. 

Dynamic dimensions (DYN) is ON; it is recommended to have the Tracking dynamic dimensions 
option of the DYNMODE system variable set. 

Entity Snap Tracking (STRACK) is ON. 

Endpoint entity snap ( ) is ON. 

file:///D:/BricsCAD%20Training/11_Modifying_Entities/01_Selecting_Entities/11_01_00_Selection_Settings.htm%23SELECTIONMODES
file:///D:/BricsCAD%20Training/03_Drawing_Accurately/03_07_User_Coordinate_Systems.htm%23MoveOriginUcs
file:///D:/BricsCAD%20Training/03_Drawing_Accurately/03_11_Dynamic_Dimensions.htm
file:///D:/BricsCAD%20Training/03_Drawing_Accurately/03_07_User_Coordinate_Systems.htm%23DynUCS
file:///D:/BricsCAD%20Training/03_Drawing_Accurately/03_11_Dynamic_Dimensions.htm
bricscad-cmdref.chm::/2/2dContext.htm
file:///D:/BricsCAD%20Training/03_Drawing_Accurately/03_06_Entity_Snap_Tracking.htm
bricscad-cmdref.chm::/E/Endpoint.htm
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Launch the POLYSOLID command. 

You are prompted: Start point or [Height/Width/Justification/Entity/Separate solids/Dynamic] 
<Entity>: 

Move the cursor over the outside face of a wall which is perpendicular to the roof slab you want to 
create. 

When the face highlights, hit the Shift key to lock the dynamic UCS. 

Do one of the following: 

To create the roof at the top edge of the wall, sna to the exterior top corner of the wall. 
  

To create a roof overhang (eave): 

Move the cursor over the exterior top corner of the wall to require a snap tracking point. 

When a small red cross indicates the tracking point is acquired, move the cursor to the outside and 
type the overhang distance in the dynamic entry field. 

  

Hit the TAB key to activate the Angle field, then type the pitch angle and hit the TAB key again to 
jump to the Distance field. 

 

Specify the the height of the roof slab, the press Enter twice: the first Enter creates the the 
footprint of the roofslab, the second Enter interrupts the creation a second solid. 

The roof slab is extruded dynamically. 

Specify a point to define the length of the extrusion. 
 

bricscad-cmdref.chm::/P/PolySolid.htm
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Repeat the previous steps to create more roof slabs. 

Use BIMDRAG to connect the roof slabs. 

bricscad-cmdref.chm::/BIM/BimDrag.htm
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Windows and Doors 

Commands: BIMINSERT, BIMWINDOWUPDATE, BIMREPOSITION, BIMWINDOWCREATE 

 The BimInsert command inserts windows and doors in any face of a 3D solid. Using Dynamic UCS, 
a window will automatically align with the 3D Solid Face it is inserted on. The BimInsert command 

also allows to insert a copy of an insert. 

The BimWindowUpdate command updates the opening made by a window or door in a solid, in 
case the definition changed in such way that the opening was not correctly updated automatically. 

The BimReposition command allows to reposition an insert in the face of a solid. 

The BimWindowCreate command creates a fully parametric window based on a closed contour. 

 Windows and doors are native .dwg files. A 3D Solid in the window drawing on a layer named 

BIM_SUBTRACT will be used to automatically create an opening in the 3D solid, keep the window 
in its position in the wall, and keep the opening associative with the window. All solids in the 

window/door model that extend the subtractor solid and overlap the wall solid, e.g. a sill or a lintel, 
will be subtracted from the wall solid also. 

  

 

Inserting Windows  

  

Inserting Windows and Doors 

To control the position of the window in the face of the solid (wall), you can use the following 
drawing aids: 

Dynamic Dimensions: During placement of a window or door on a 3D Solid face, dynamic 

dimensions are created, starting from the middle of each edge of the bounding rectangle of the 
opening to the nearest parallel edge on the face of the 3D Solid. Make sure Dynamic Dimensions 

are active by checking the DYN field in the status bar and Dynamic UCS is active by checking the 
DUCS field in the status bar.  
The Dynamic UCS aligns the window to the face of the solid. The edge of the face by which the 
cursor enters the face defines the orientation of the X-axis. Hit the Shift key to temporarily lock the 
UCS, which allows to use reference points outside the face of the solid. Hit the shift key again to 

unlock.  

Temporary Tracking points: Click the mouse wheel or press the Temporary Tracking Points tool 

button ( ) on the Entity Snaps toolbar to start specifying temporary points.  

OSNAPZ: If this system variable is ON, the Z-value of any entity snapping point is replaced by the 
current value of the ELEVATION system variable. If ELEVATION=0, entity snapping points are 
forced to lie in the face of the solid. OSNAPZ is toggled by the Ignore entity snap elevation tool 

button ( ) on the Entity Snaps toolbar. The state of the tool button (pressed or not)  indicates 
the current value of OSNAPZ.  

Entity snap to negative Z-values: Press the Entity snap to negative-z tool button ( ) on the 
Entity Snaps toolbar to enable entity snaps on points that lie behind the selected face. If OSNAPZ 
is ON, the point is projected onto the selected face.  

Do one of the following:  

Click the BimInsert tool button ( ) on the BIM toolbar.  

Choose BimInsert in the BIM menu.  

Type biminsert in the command bar.  

bricscad-cmdref.chm::/BIM/BimInsert.htm
bricscad-cmdref.chm::/BIM/BimWindowUpdate.htm
bricscad-cmdref.chm::/BIM/BimReposition.htm
bricscad-cmdref.chm::/BIM/BimWindowCreate.htm
file:///D:/BricsCAD%20Training/03_Drawing_Accurately/03_07_User_Coordinate_Systems.htm%23DynUCS
https://blog.bricsys.com/category/tutorials/bim/
https://blog.bricsys.com/inserting-windows-in-bricscad-bim/
file:///D:/BricsCAD%20Training/03_Drawing_Accurately/03_11_Dynamic_Dimensions.htm
file:///D:/BricsCAD%20Training/01_User_Interface/01_00_The_Bricscad_Application_Window.htm%23DynamicDimensions:
file:///D:/BricsCAD%20Training/03_Drawing_Accurately/03_07_User_Coordinate_Systems.htm%23DynUCS
file:///D:/BricsCAD%20Training/01_User_Interface/01_00_The_Bricscad_Application_Window.htm%23DynamicUCS
file:///D:/BricsCAD%20Training/03_Drawing_Accurately/03_03_Entity_Snaps.htm%23TemporaryTrackingPoints
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A file dialog box displays: 

 
Select file, then either double click or click the Open button. 
The selected insert is attached to the cursor. 
When you move over a face of solid, the insert aligns with the face under the cursor. 

 
The distances from the start-, end-, top- and bottom face of the wall to the placement rectangle of 
the insert display dynamically. 
 
If TIPS is ON, the Tips widget displays at the bottom of the screen: 
 

 

(option) Specify the size of the insert. 
 

file:///D:/BricsCAD%20Training/01_User_Interface/01_00_The_Bricscad_Application_Window.htm%23Tips:
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Do one of the following to switch to the Edit inserted entity mode ( ).  

Hit the Ctrl-key. 

Type E, then pres Enter. 

Choose Edit inserted entity in the prompt menu.  

The Width and Height field indicate the current dimensions of the insert. 

 

Specify the width and height of the insert. 

Hit the TAB key to switch between the dynamic dimension fields. 

When done, do one of the following to switch to the Select insertion point mode ( ): 

Hit the Ctrl-key. 

Type D, then press Enter. 

Choose Done in the prompt menu. 

The distances from the start-, end-, top- and bottom face of the wall to the placement rectangle of 
the insert display dynamically. 

Use one of the following methods to insert the window/door:  

 

Method 1: Use dynamic dimensions fields: 

Hit the TAB key to select one of the horizontal dynamic dimension fields, then type a value and hit 

the TAB key to lock the dimension. 
The locked dimension turns red. 

Hit the TAB key to select one of the vertical dynamic dimension fields, then type a value and hit 
the TAB key to lock the dimension. 
The locked dimension turns red. 
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Press Enter or click to place the window. 

 

Method 2: Specify a point 

Snap to a point using an Entity Snap or any other method to specify a point in the drawing (e.g. 

Entity snap tracking or Temporary tracking points). 
If OSNAPZ = ON, the point will be projected onto the face of the solid. 

Click the Entity snap to negative-z button ( ) on the Entity Snaps toolbar to snap to points that 
lie behind the selected face. 

Editing Parameters 

If parameters are defined in the window/door source drawing, these parameters can be used to 
edit each instance of a window/door separately. 

Select the door/window in the drawing. 
The current values of the various parameters display in Parameters section of the Properties Bar.  

file:///D:/BricsCAD%20Training/03_Drawing_Accurately/03_03_Entity_Snaps.htm
file:///D:/BricsCAD%20Training/03_Drawing_Accurately/03_06_Entity_Snap_Tracking.htm
file:///D:/BricsCAD%20Training/03_Drawing_Accurately/03_03_Entity_Snaps.htm%23TemporaryTrackingPoints
file:///D:/BricsCAD%20Training/01_User_Interface/00_06_Properties_Bar.htm
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In the sample windows, the following parameters are available: 

 

W: Width = width of the opening in the wall*; for interior doors the W parameter defines the width 
of the door leaf.  

H : Height = height of the opening in the wall*; for interior doors the H parameter defines the 
height of the door leaf.  

1: FrameThickness  

2: FrameDepth  

3: LeafThickness  

4: LeafDepth  

5: LeafOffset  

6: PaneDepth  

7: PaneOffset  

8: Placement Depth = distance between the face of the wall and the fixed window frame  

9: Rebate  
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* If the Rebate = 0 (zero), the overall width and height of the window equals the opening in the 

wall. 

Select a parameter, then type a value in the settings field.  

 

NOTE If multiple frames or doors are selected they can be edited simultaneously. 

Shared parameters only display in the Properties Bar.  

The settings field of parameters which have different values, reads *Varies*. 

Moving an insert 

The following methods are available to move an insert in the face of a solid. 

The BIMREPOSITION  command repositions an insert in the face of a solid. 

The BIMDRAG command allows to move an insert vertically or horizontally, if applied to an inner 
face of the opening made by the insert. 

When, for some reason, the opening in the solid is not healed automatically, the 

BIMWINDOWUPDATE command recalculates the opening for the selected insert(s). 

Repositioning an Insert 

Do one of the following: 

Click the Reposition Insert tool button ( ) on the BIM toolbar. 

Choose Reposition Insert in the BIM menu. 

Type bimreposition in the command bar. 

Hover over an insert and choose Reposition Insert ( ) in the Quad. 
(Except when launching the command from the Quad)  
Select an insert in the model. 

You are prompted: Select insertion point or [Edit inserted entity] : 

Move the cursor over the outside face of the wall, then press the Shift-key to lock the dynamic 
UCS to the face of the wall. 
Proceed with the Inserting Windows and Doors procedure from step 2 on. 

Moving an Insert Vertically 

Move the cursor over the top or bottom inner face of the opening made by the insert. 

 

 

When the face highlights, choose BimDrag ( ) in the BIM command group in the Quad. 
The insert moves vertically. 

Do one of the following: 

Specify a point. 

Type a distance in the dynamic dimension field. 
Optionally hit the TAB key to select a different reference face. 

bricscad-cmdref.chm::/BIM/BimReposition.htm
bricscad-cmdref.chm::/BIM/BimDrag.htm
bricscad-cmdref.chm::/BIM/BimWindowUpdate.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/Windows_and_Doors.htm%23InsertWindow
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Moving an Insert Horizontally 

Move the cursor over the left or right inner face of the opening made by the insert. 
 

 

When the face highlights, choose BimDrag ( ) in the BIM command group in the Quad. 
The insert moves horizontally. 

Do one of the following: 

Specify a point. 

Type a distance in the dynamic dimension field. 

Optionally hit the TAB key to select a different reference face. 

Copying Inserts 

Copying an insert in a solid 

Use the Copy command to place copies of an insert in the same solid. The Repeat option of the 
copy command can create a series of copies at the same interval. 

Make sure that the movement vector for the copy is parallel to the face of the wall. If the 
orientation of the wall, in which the source window or door is placed, is not parallel to either the X- 
or Y axis of the current UCS, use the Face option of the UCS command to align the UCS. 

 

Inserting a copy of an insert 

Hover over the insert. When the insert highlights, choose BimInsert ( ) in the BIM command 
group in the Quad. 

You are prompted: Select insertion point or [Edit inserted entity] : 

Proceed with the Inserting Windows and Doors procedure from step 2 on. 

 

Replacing Inserts 

Select the insert. 
The properties of the selected insert display in the Properties Bar. 

Select the File property in the Parameters group. 
 

 

Click the Browse button ( ). 

A File dialog displays. 

bricscad-cmdref.chm::/C/Copy.htm
bricscad-cmdref.chm::/U/Ucs.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/Windows_and_Doors.htm%23InsertWindow
file:///D:/BricsCAD%20Training/01_User_Interface/00_06_Properties_Bar.htm
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Select the replacement file for the insert, then double click or  click the Open button on the File 

dialog. 
The insert is replaced. 

Creating Windows and Doors 

The creation of custom BricsCAD BIM inserts, such as windows and doors, consists of the following 
steps: 

Creating the 3D geometry. 

Optionally add 2D entities. 

Add 3D constraints and parameters to modify the dimensions of the insert. 

The inserts are created in the XY plane of the WCS. 

Creating the 3D Geometry 

The 3D geometry is composed of: 

The subtractor solid (1) 

The window/door frame (2) 

The opening leaf(s) (3) 

(Glass) panes (4) 

2D stuff: opening indicators, 2D representation (5) 

 

Step 1: Create the file 

Choose New in the File menu. 

The Select Template dialog displays. 

Select the BIM-Window-metric.dwt or BIM-Window-imperial.dwt template drawing. 
The Bim-Window templates contain the layers needed to create the geometry of the window or 
door. 

Set the BIM_SUBTRACT layer current. 

Create a closed polyline (e.g. a rectangle) that represents the shape of the opening for the insert. 

Save the file in ..\Support\Bim\Windows subfolder of the Roamable Root folder. 

By default this is: 
C:\Users\<user_name>\AppData\Roaming\Bricsys\BricsCAD\V16x64\en_US\Support\Bim\Windo
ws  

Step 2. Create the subtractor solid 

The subtractor solid will be used to create the opening for the insert.  

Create the outline of the solid, e.g. a rectangle, in the XY plane of the World Coordinate System 

(WCS). 
The lower left corner of the rectangle lies at the origin (0,0,0) of the WCS. 

file:///D:/BricsCAD%20Training/manuals/01_Drawing_2D_Entities/10_01_11_Rectangles.htm
file:///D:/BricsCAD%20Training/03_Drawing_Accurately/03_07_User_Coordinate_Systems.htm
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Use the DMEXTRUDE command to extrude the rectangle in the negative Z direction. 

The extrusion height must be higher than the largest width of the wall solids you want to place the 
insert in. 

 

Step 3: Create the fixed frame 

The outline of the fixed frame coincides or is parallel (in case of a rebate) with the outline of the 

subtractor solid. 

Set the WINDOW_FRAME or DOOR_FRAME layer current. 

Use the DMEXTRUDE command to extrude the top face of the subtractor solid.  
Hit the Ctrl-Key to select the Create option. 

Create the extrusion in the negative Z-direction. 
The height of the extrusion equals to the thickness of the fixed frame. 

bricscad-cmdref.chm::/DirectModeling/dmExtrude.htm
bricscad-cmdref.chm::/DirectModeling/dmExtrude.htm
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Switch the display of the BIM_SUBTRACT layer off. 

Use the OFFSET command ( ) to create a parallel offset of the outline of the fixed frame. 
The distance of the offset equals the width of the fixed frame face. 

 

Use the DMEXTRUDE command to create an opening in the fixed frame. 
  

Step 4: Create the opening leaf 

The outline of the opening leaf coincides with the inside faces of the fixed frame. 

bricscad-cmdref.chm::/O/Offset.htm
bricscad-cmdref.chm::/DirectModeling/dmExtrude.htm
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Use the UCS command to set the XY-plane at the bottom (inside) face of the fixed frame. 

 

Set the Enable Boundary Detection option on the Selection Modes toolbar. 

 

 

Use the DMEXTRUDE command to extrude the inside boundary of the fixed frame.  
The height of the extrusion equals the thickness of the opening leaf. 

 

Use the OFFSET command ( ) to create a parallel offset of the outline of the opening leaf. 
The distance of the offset equals the width of the opening leaf face. 

 

bricscad-cmdref.chm::/U/Ucs.htm
bricscad-cmdref.chm::/DirectModeling/dmExtrude.htm
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Use the DMEXTRUDE command to create an opening in the opening leaf. 

 

  

Step 5: Create the glass panes 

Set the GLASS layer current. 

Use the DMEXTRUDE command to extrude the inside boundary of the opening leaf.  
The height of the extrusion equals the thickness of the glass pane. 

 

Restore the WCS (World Coordinate Sytem). 
  

(option) Move the solid in the negative Z-direction if the outside face of the fixed frame does not 
coincide with the outside face of the solid (wall) the insert will be placed in. 

 

bricscad-cmdref.chm::/DirectModeling/dmExtrude.htm
bricscad-cmdref.chm::/DirectModeling/dmExtrude.htm
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Adding 2D Entities 

Optionally, windows and doors drawings can contain 2D symbols. These 2D symbols will either 
replace the actual 3D Solid section of the window or door, or be added to the 3D Solid section, 

depending on their layer:  

symbols on a layer with prefix BRX_2D_ will be used to replace the geometry resulting from the 
actual section,  

symbols on a layer with prefix BRX_2D+_ will be added to the section result. Only those 2D 
entities in a plane parallel to the section plane are considered. 

Adding 3D Constraints 

See 3D constraints. 

Choose Enable selection of 3D solid faces in the Selection Modes toolbar. 
 

 

  

Open the Mechanical Browser to control and manage the 3D constraints and parameters. 

  

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/10_03_05_3D_Constraints.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Mechanical/Mechanical_Browser.htm


BricsCAD V18  Help 

 

 705 

 

  

The window we created in the above procedure is composed of three solids: subtractor, fixed 
frame, opening leaf, glass pane. 

To apply Fix constraints 

A FIX ( ) constraint is applied to the top, front and left face of the subtractor solid. 

 

Hover over the face you want to apply the constraint to. 
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Choose Add Fixation ( ) in the 3D Constraints command group in the Quad. 

 

To apply Coincident constraints 

Coincident constraints are applied to all coinciding faces of the composing solids, e.g. side faces of 
the fixed frame and the subtractor solid. 

Select the first face 
The face hightlights. 

Hover over the second face. 
Hit the TAB key to highlight an obscured face. 

When the second face highlights, choose Add Coincidence ( ) in the 3D Constraints command 
group in the Quad. 

 

To apply Distance constraints 

Distance constraints are used to control the overall dimensions (width and height) of the insert and 

the dimensions of the face and thickness of the fixed frame and opening leaf and the thickness of 
the glass pane. 

Select the first face 
The face hightlights. 

Hover over the second face. 
Hit the TAB key to highlight an obscured face. 

When the second face highlights, choose Add Distance ( ) in the 3D Constraints command group 
in the Quad. 

You are prompted: Enter distance value: 

Do one of the following: 

Press Enter or right click to accept the current value. 

Type a value in the command bar. 

 

Using Parameters 

Parameters are used to control: 

the width and height of the frame. 

the face and thickness of the fixed frame and the opening leaf. 

the thickness of the glass pane. 

the depth of the opening leaf with respect to the fixed frame. 

the depth of the fixed frame with respect to the outside face of the wall. 

... 

The value of the parameters can be edited for each insert separately (see Editing the parameters 
of an insert). 

 

To create a parameter 
Right click the Component name in the Mechanical Browser. 

Choose Add New Parameter in the context menu. 

Select the parameter, then edit its properties in the settings grid. 
 

 

Name: Parameter name 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/Windows_and_Doors.htm%23EditParameters
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/Windows_and_Doors.htm%23EditParameters
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Mechanical/Mechanical_Browser.htm
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Expression: Type a value or formula 

Value: The current value of the parameter. 

Description: An optional description of the parameter. 

Exposed: Controls whether the parameter is available in the properties grid when the window is 
inserted in a model. 
Choose an option: 

Off: not available 

On: always available 

Auto: available only if the Expression field contains a value, not an expression. 

Units: Specifies whether the parameter is linear, areal or volumetric. 
Select the field, then click the arrow button and select an option. 

Using parameters 

Select a distance constraint. 

Use the parameters to compose an expression in the Expression field in the settings grid of the 
constraint. 
 

 

 

Creating Standard Windows 

The BimWindowCreate command allows to create standard windows from a closed 2D entity, a 
boundary or an existing opening in a solid. 

The window style is selected in the Window Style dialog box: 
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To create a window using a closed 2D entity. 

Closed polylines, circles, ellipses and closed splines are accepted. 

Do one of the following: 

Click the BimWindowCreate tool ( ) on the BIM toolbar, then select a single or multiple 
closed 2D entities. 

Move the cursor over a closed 2D entity, then select BimWindowCreate tool ( ) in the 
Model command group in the Quad. 

The Window Style dialog displays. 

Pick a standard window style in the Window Style dialog. 
The window is created. 

(option) Edit the window parameters in the Properties Bar or the Mechanical Browser panel. 

 
 

To create a window using a boundary. 

Make sure the Enable Boundary Detection option on the Selection Modes toolbar is selected. 

 

Move the cursor inside an enclosed area in the XY-plane of the current UCS. 

When the boundary hightlights, select BimWindowCreate tool ( ) in the Model command group in 
the Quad. 
The Window Style dialog displays. 

Pick a standard window style in the Window Style dialog. 
The window is created. 

(option) Edit the window parameters in the Properties Bar or the Mechanical Browser panel. 

 

To create window in an existing opening. 

Make sure the  Enable Selection of 3D Solid Faces and Boundary Detection options on the 
Selection Modes toolbar are selected. 

file:///D:/BricsCAD%20Training/01_User_Interface/00_06_Properties_Bar.htm
bricscad-cmdref.chm::/Mechanical/BmBrowser.htm
file:///D:/BricsCAD%20Training/03_Drawing_Accurately/03_07_User_Coordinate_Systems.htm
file:///D:/BricsCAD%20Training/01_User_Interface/00_06_Properties_Bar.htm
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BricsCAD V18  Help 

 

 709 

 

Move the cursor over the face of the solid and choose Align UCS ( ) in the Model command group 
in the Quad. 
You are prompted: Enter an option [Flip/Xrotate/Yrotate] <accept>: 

Press Enter to accept the UCS. 

Move the cursor inside the opening. 
The boundary of the opening highlights. 

Select BimWindowCreate tool ( ) in the Model command group in the Quad. 
The Window Style dialog displays. 

Pick a standard window style in the Window Style dialog. 

The window is created. 

(option) Edit the window parameters in the Properties Bar or the Mechanical Browser panel. 

Editing Solids 

Splitting Solids 

Command: BIMSPLIT 

The BimSplit command either splits segmented solids into separated solids automatically or allows 
to split a solid using a selection of cutting faces. 

To split a solid automatically 
Make sure that the value of SELECTIONPREVIEW is 2 or 3. 

Do one of the following: 

Click the BimSplit tool button ( ) on the BIM toolbar. 

Choose Split in the BIM menu. 

Type bimsplit in the command bar, then press Enter. 

You are prompted: Select solid for auto splitting or cutting faces for manual splitting:  

Place the cursor over a face of the solid. 
The face highlights. 

Without moving the mouse, hit the TAB key until the complete solid highlights,  then click. 

You are prompted: 
Entities in set: 1 
Select solid for auto splitting or cutting faces for manual splitting:  

Right click. 
The selected solid is split. 

The number of parts is reported in the command window. 

 

Using the Quad 

Make sure the Select Faces option ( ) of the SELECTIONMODES system variable is switch off. 

Place the cursor over a face of the solid.  

When the solid highlights, choose Split ( ) in  the BIM command group of the Quad. 
The solid is split. 
The number of parts is reported in the command window. 

To split a solid using cutting faces 
Make sure that the value of SELECTIONPREVIEW is 2 or 3. 

Do one of the following: 

Click the BimSplit tool button ( ) on the BIM toolbar. 

Choose Split in the BIM menu. 

Type bimsplit in the command bar, then press Enter. 
You are prompted: Select solid for auto splitting or cutting faces for manual splitting:  

file:///D:/BricsCAD%20Training/01_User_Interface/00_06_Properties_Bar.htm
bricscad-cmdref.chm::/Mechanical/BmBrowser.htm
bricscad-cmdref.chm::/BIM/BimSplit.htm
bricscad-sysvar.chm::/00_07_Settings_Manager.htm
bricscad-sysvar.chm::/00_07_Settings_Manager.htm
bricscad-sysvar.chm::/00_07_Settings_Manager.htm
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Place the cursor over a face of the solid. 

Hit the TAB key to highlight an obscured face. 
When the face highlights, click to select the face. 
You are prompted: 
Entities in set: 1 
Select solid for auto splitting or cutting faces for manual splitting:  

(option) Repeat step 4 to select more faces. 
  

Right click to stop selecting faces. 
The solid is split using the selected faces as cutting planes. 
The number of parts is reported in the command window. 
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BIM Database 

Project Database and Library Database 
A BIM Project consists of dwg entities, classified as Building Elements, to which Compositions can 

be attached. All Compositions being used in a project, are stored in the Project database. The 
Project database can be stored inside a dwg file, or in a separate file with extension .bimlib: 

When the Project database is embedded in a dwg file, that dwg file contains the complete BIM 
Project.  

When the Project database is stored as an external file, the BIM Project can consist of multiple dwg 
files, all using the same Project database. 

To reuse compositions and building materials across multiple BIM Projects, a Library database can 
be specified, in addition to the Project database. The Library database is a .bimlib file, usually 
stored in a location which is common to several projects. When Compositions and Building 
Materials from the Library database are used in a BIM Project, they are automatically imported in 

the Project database. To maintain and extend BIM databases, users can drag Building Materials 
and Compositions from one database to the other, provided that they have write access to the 
destination database. 

  

NOTE Sample databases are installed in the Support\BIM subfolder the Roamable root folder. 
When a BricsCAD update is installed, the BricsCAD User File Manager will prompt you 
whether to overwrite the sample databases or not. Therefore it is recommended to 
rename your library databases and/or save them at a different location. The location of 

the library databases is defined in the Library DB tab of the BIM Project Info dialog. 

 

Materials and Compositions 
A BIM database consists of Building Materials and Compositions. A Building Material contains 

information about one specific material: its appearance, cost, manufacturer, etc. A Composition 

contains information about the structure of a building element, by defining Composition layers. 
Each Composition layer refers to a Building Material, and has a certain thickness. 

Flexibility 

The same flexibility you have in modelling is available in attaching building information. Although 
Compositions are grouped into Wall, Slab, Roof and Generic Compositions, any type of 

Composition can be attached to any dwg entity. When attached to a 3D Solid, with specific 
geometrical properties, the thickness of the Composition is used to define the thickness of walls 
and slabs, and the cross section will show the wall or slab structure by applying the hatch patterns 
from the various layers on the section geometry. When a 3D Solid is assigned a Composition with a 
fixed thickness or a minimal thickness, and this thickness can not be applied to the geometry, the 
section appears in red to indicate the incompatibility between the selected Composition and the 
geometry of the solid. 

BIM Compositions panel 

All BIM database features are accessible from the dockable BIM Libraries panel. 

Materials 

A Material definition describes the appearance and properties of a Building Material. 

 

file:///D:/02_Defining_your_preferences/02_00_Bricscad_User_Files.htm
file:///D:/02_Defining_your_preferences/02_10_User_Profile_Manager.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/Project_Info.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/Materials.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/Compositions_Editor.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/Libraries.htm
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Composition layers 

A Composition describes the structure of a building element by an ordered set of composition 
layers. Each composition layer has the following fields: 

Pattern and Material Name: The Building Material for this layer. 

Function: One of (None, Structure, Substrate, Insulation, Finish1, Finish2, Membrane). Currently 

this field serves for information purposes only. 

Thickness: Defines the thickness of the layer. 

To open the BIM Libraries panel 

Right click on any toolbar and choose BIM Libraries in the context menu. 

 

  

The  BIM Libraries panel is a dockable panel. 
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Search field 

Selection buttons 
Click a button to add the selected category to the In Project and In library compositions or profiles 
list. Click again to remove the selected category. 

Toolbar 

Compositions or profiles of the selected categories in the Project database. 

If the Filter button ( ) is pressed, the current filter is applied to the list. 

Compositions or profiles of the selected categories in the Library database. 

If the Filter button ( ) is pressed, the current filter is applied to the list. 

The BIM Libraries panel allows to: 

: Open the Physical Materials editor 

: Open the Compositions editor 

: Open the Profiles editor 

: Open the BIM Project Info dialog 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/Materials.htm
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: If pressed, lists the compositions that match at least one the selected tags in the Filter tab of 
the BIM Project Info dialog. 

: If pressed, includes Wall compositions in the list 

: If pressed, includes Slab compositions in the list 

: If pressed, includes Roof compositions in the list 

: If pressed, includes Generic compositions in the list 

: If pressed, includes Structural profiles in the list 

: If pressed, includes Generic profiles in the list 

Drag and drop compositions from the Project or Library database onto solids in the model. 

Drag and drop compositions between the Project or Library database. 

To copy compositions between the Project and Library databases. 

The following procedure can be used in both the BIM Libraries panel and the Compositions editor. 

Select the compositions(s) in the source database. 
Press and hold the Ctrl-key to select multiple compositions. 

Do one of the following: 

Drag the selection to the other database. 

Right click and choose Copy to Library in the context menu. 

If the value of the CopyOverwrite user preference is 0 (zero) a dialog box displays if the 
composition already exists in the target library: 

Optionally check the Apply to all compositions in this operation option. 

 

 

To Open the BIM Project Info Dialog  

Click the Project and Library Information tool button ( ) on the BIM Compositions panel. 

The BIM Project Info dialog has three tabs: 

Project DB: The location, properties and content of the Project database. 

Library DB: The location, properties and content of the Library database 

Filter: The currently selected composition tags used to filter the compositions list on the BIM 
Compositions panel and the Building Materials editor. 

  

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/Project_Info.htm
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To Set the Library Database 
Select the Library DB tab page on the BIM Project Info dialog box. 

Click the Browse button ( ) at the right-hand side of the Path field. 
A file dialog displays. 

Select a BIM database file (*.bsyslib), then press the Open button. 

(option) Check the Set as default option to set the selected database as default library database 
for new projects 

NOTE The name and location of the default library databases is saved to the DefaultLibraryMetric and 
DefaultLibraryImperial user preferences. 

Default libraries are used in new projects 

You can edit the user preferences in the Settings dialog under BIM/General. 

  

. 

  

bricscad-sysvar.chm::/00_07_Settings_Manager.htm
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To Set the Project Database 

Select the Project DB tab page on the BIM Project Info dialog box. 
 

 
(option) Select Embedded to save the project library in the drawing file. 

(option) Select External, then:  

Click the Browse button (  ) at the right-hand side of the Path field. 
A file dialog displays. 

Select a BIM database file (*.bsyslib), then press the Open button. 

 

To Set the Project Filter 
To each Building Material or Composition, any number of tags can be attached. Any string can be 
entered as a tag. 

Each of the tags can be used as a filter on the database. There is a button at the top of each list 

( ), to switch the filter on or off. If the filter is on, only Compositions and Building Materials that 

match at least one of the filter tags will be listed. 

The Filter button ( ) has three states: 

If the project filter is empty, the button is not active (BIM Compositions panel) or is not 
available (Materials and Compositions editors). 

The project filter is defined, but not active. 
 

 

The project filter is defined and active. 
 

 
A tooltip shows the current project filter. 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/Materials.htm
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To set the project filter 
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Physical Materials 

The Physical Materials dialog box allows to: 

Create new materials 

Edit materials 

Copy materials between the Project and Library databases 

Create single-ply compositions 

Delete materials 

 

To Open the Physical Materials Editor 

Do one of the following: 

Type blmaterials in the command bar. 

Click the Physical Materials button ( ) on the Compositions panel. 

Click thee Browse button ( ) of the Material property of a component in the Mechanical 
Browser. 
 

 

 

Adding Physical Materials 

Physical materials can be created in either the Project or the Library database. 

A new material can be created from scratch or as a copy of an existing material. 

 

Adding a physical material from scratch 

Click in either the In Project or the In Library material list. 

Do one of the following: 

Click the Add Material button ( ) on the Physical Materials dialog. 

Right click and choose Add Material in the context menu. 

A material named New is added in selected database. 

Edit the newly created material. 

 

Adding a physical material as a copy of an existing material 

Select a material in either the In Project or the In Library material list. 

Do one of the following: 

Click the Add Material button ( ) on the Physical Materials dialog. 

Right click and choose Add Material in the context menu. 

A material named <existing_material>_1 is added in selected database. 

Edit the newly created material. 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/Materials.htm%23AddMaterial
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Editing Physical Materials 

The various settings of a physical material definition are divided in three settings groups under 
three tabs on the Physical Materials dialog: 

Identity: Name, Class and description of the material. 

Appearance: The BIM Materials layers the composition is composed of. 

Properties: Properties of the buidling material such as Cost, Manufacturer, Thickness, ... . 

 

Select the material in either the In Project or the In Library list on the Physical Materials dialog. 
  

On the Identity tab page: 
 

 

Type a name for the material. 

Select a Class from the drop-down list. 

(option) Type a description. 

On the Appearance tab page: 
 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/Materials.htm%23OpenBuildingMaterialsDialog
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Section settings: 

Click the Hatch Type button, then select the type of the hatch: None, Solid, Linear, Predefined or 
Custom. 

Do one of the following to select a predefined or custom hatch pattern  

Click the Hatch preview, then select the pattern in the Hatch Pattern dialog box. 

Click the Hatch Pattern Name button, then select the pattern in the list. 

Define the Scale. 
The final pattern scale in a section is the product of the Scale setting of the physical 
material and the value of the Hatch Scale property of the section plane entity. 

Set the Rotation angle. 

In the Layer field, either type a name or click the arrow button and select a layer in the list. 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Sections/SectionPlanes.htm%23HatchScale
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3D settings: 

Double click the preview image, then select a material in the Render Material dialog box. 

On the Properties tab page: 
 

 

Edit the Tags field: tags are separated by commas. 

Tags are case sensitive. 

Click the  Browse button ( ) to open the Tags dialog. 
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Click the New Item button ( ) to add a new tag at the bottom of the list. 

Select a tag in the list then click a tool button: 

: edit the selected tag 

: delete the tag 

: move the tag up 

: move the tag down 

(option) Expand the Information properties and fill out the necessary fields. 
(option) Expand the Physical properties and edit physical properties of the material. 

Expand the BIM properties. 

Union Section: Select Yes to remove connection lines in sections between different solids of this 
material. Choose No to keep the connection lines. 

Select a Function from the drop-down list. 

Choose Yes or No whether or not to allow a variable thickness. 

Type a default thickness in the Thickness field. 

Click the OK button. 
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To copy materials between the Project and Library databases. 

Select the material(s) in the source database. 
Press and hold the Ctrl-key to select multiple materials. 
 

 
Drag the materials to the target database. 
The selection set is copied. 
 

If one or more materials already exist in the target database, an alert box displays: 
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Click the appropriate button to either overwrite, duplicate or skip the existing material. 
If the Apply to all materials in this operation option is checked, the option is applied to all existing 

materials. 
Duplicated materials have an index number added to their name: 
 

 
  

Deleting Physical Materials 

On the Physical Materials dialog box, select the material(s) in  the Project or Library database. 

Click the Delete button. 

 

NOTE Materials that are used in a composition or a mechanical component cannot be deleted. 
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Compositions 

To Open the Composition Editor 

Do one of the following: 

Type blcompositions in the command bar. 

Click the Compositions tool button ( ) on the BIM Libraries panel. 

Double click a composition in either the In Project or the In Library list on the BIM Libraries 
panel. 

 

 

1. Composition category selection button. Click the button, then select a category.  

The options are Wall, Slab, Roof or Generic. 

2. Compositions toolbar. 

3. Compositions of the selected category (Wall, Slab, Roof or Generic) in the Project 
database. 

If the Filter button ( ) is pressed, the current filter is applied to the compositions list. 

4. Compositions of the selected category (Wall, Slab, Roof or Generic) in the Library 

database. 

If the Filter button ( ) is pressed, the current filter is applied to the compositions list. 

5. Preview of the currently selected composition. 

6. Name Field. 

7. Composition category selection button. 

8. Ply grid. 

9. Ply toolbar. 

10. Property grid. 

11. Opens the Custom Properties dialog. 
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The Composition Thickness 

The overall thickness of a composition equals the sum of the thicknesses of the composing plies.  

The thickness of a ply is either locked or unlocked:  

Locked thickness ( ): the thickness of the ply is fixed. 

Unlocked thickness ( ): the thickness of the ply is variable.  

Only one ply in a composition can have an unlocked thickness.   
As a result the total thickness of a composition can be:  

fixed: all its plies have a locked thickness,  

minimal: the composition contains at least two plies and one ply has an unlocked 
thickness. The minimum thickness equals the sum of the thicknesses of the locked plies. 

free: a single ply composition with an unlocked thickness. 

The thickness of a ply can be unlocked only if the Allow Custom Thickness property of the 

material is Yes.   

   

When a Composition is attached to a 3D Solid, the thickness of the Composition is applied as 

follows:  

Detect the side faces of the solids. 

The side face at the outside of the building is marked as the reference face. 

The opposite face (inside face) is moved until the distance between the two side faces is equals the 
thickness of the Composition. 

The BIMFLIP command allows to flip the reference face.  

The BIMUPDATETHICKNESS allows to reapply the Composition thickness to the 3D solid.  

Sections created with VIEWSECTION will show the plies from the Composition. The reference face 
is used to indicate the top ply for Slab Compositions, and the exterior ply for other Compositions. 

Starting from the reference face, the 3D Solid is sliced by planes parallel to the reference face, at 
an offset equal to the ply thickness.  

Adding Compositions 

Compositions can be created in either the Project or the Library database. 

A new composition can be created from scratch or as a copy of an existing composition. 

Single-ply compositions can be created automatically from a material definition. 

Adding a composition from scratch 

Do one of the following: 

Place the cursor in either the In Project or the In Library list on the Compositions dialog 

then right click choose Add Composition in the context menu. 

Click the Add Composition tool button ( ).  

A composition named New is added in the selected database. 

Edit the composition. 

Adding a composition as a copy of an existing composition 

Select a composition in either the In Project or the In Library list on the Compositions dialog. 
Right click and choose Duplicate in the context menu. 

A composition named <existing_composition>-2 is added in the selected database. 

Edit the composition. 

Creating single-ply compositions 

Click the Materials button ( ) on the BIM Libraries panel. 

Select one or more materials in either the In Project or the In Library list. 

Right click and choose Make Composition in the context menu. 

bricscad-cmdref.chm::/BIM/BimFlip.htm
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Editing a Composition 

Select the composition in either the In Project or the In Library list on the Compositions dialog. 
The current settings of the selected composition display. 

Type a name in the Name field. 

Click the Category button, then select a composition category: Wall, Slab, Roof or Generic. 

Composition categories are used to filter the compositions list on the BIM Libraries panel and the 
Compositions dialog. 

Edit the composition plies in the Ply grid. 
Here you can: 

Modify the thickness of a ply. 

Change the material of a ply. 

Add a ply. 

Modify the order of the plies. 

Delete a ply. 

Edit the properties of the composition in the Properties grid. 
 
Edit the Tags field: tags are separated by commas. 
Tags are case sensitive. 

Click the  Browse button ( ) to open the Tags dialog. 

 

 

Click the New Item button ( ) to add a new tag at the bottom of the list. 

Select a tag in the list then click a tool button: 

: edit the selected tag 

: delete the tag 

: move the tag up 

: move the tag down 

Edit the Comments field. 

Click the OK button to save the changes. 

To modify the thickness of a ply. 

The thickness of a ply can be modified only if the Allow Custom Thickness property of the Material 
is Yes. 

Click the Thickness field in the Ply grid of the composition. 

Type a value and press Enter. 
The overall thickness of the composition is updated accordingly. 

 

NOTE When the thickness of one or more plies in a composition have been modified, the solids 
which have this composition applied are not updated automatically. 

The BimUpdateThickness command allows to re-apply the overall thickness of a 

composition to the solid. 
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file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/Compositions_Editor.htm%23ModifyThickness
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/Compositions_Editor.htm%23ChangeMaterial
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/Compositions_Editor.htm%23AddLayer
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To change the material of a ply. 

Double click either the Pattern or the Name field of the ply. 
The Materials dialog displays. 

On the Materials dialog double click a material in either the In Project or the In Library list. 
The selected material is applied to the ply. 

(option) Edit the thickness of the ply. 

 

To add a ply. 

A new ply will be added above the selected ply. You can drag the ply to a different position 
afterwards. 

Select a ply in the composition 

Click the Add Ply tool button ( ). 

The Materials dialog displays. 

On the Materials dialog double click a material in either the In Project or the In Library list. 
The selected material is applied to the new ply. 

(option) Edit the thickness of the ply. 

(option) Drag the ply to a different position. 

 

To modify the order of the plies. 

The plies of a composition are ordered from outside (top of the list) to inside (bottom of the list). 

Drag the ply number (first column in the ply grid) to the desired position. 

 

To delete a ply. 

Select the ply in the composition. 

Click the Delete tool button ( ). 

 

Deleting Compositions 

Select the compositions in the In Project or In Library list on the BIM Libraries panel or the 
Compositions editor. 

Do one of the following: 

Right click and choose Delete in the context menu. 

Click the Delete button ( ) (Compositions editor only). 

 

NOTE Compositions that are used in the project cannot be deleted in the project database. 
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Attaching a Composition to Solids 

Compositions can be attached to solids using the BimAttachComposition command or by dragging 
a composition from the BIM Libraries panel onto solids. 

Do one of the following: 

Click the Attach Composition tool button ( ) on the BIM toolbar. 

Choose Attach Composition in the BIM menu. 

Type bimattachcomposition in the command bar, then press Enter. 

You are prompted: Enter composition name or [Dialog] <Dialog>: 

Do one of the following: 

Type a composition name in the command bar, then press Enter. 
Composition names are case sensitive. 

Press Enter to display the Compositions dialog and double click a composition in the In Project or 

In Library list. 

You are prompted: Select entities to attach composition: 

Select one or more solids in the drawing, then press Enter. 
You are prompted:The composition has been assigned to <xxx> element(s). 

 

Dragging a composition onto a single solid 

Select the composition in the In Project or In Library list on the BIM Libraries panel. 

Press and hold the left mouse button and drag the composition onto the solid. 

Release the left mouse button to attach the composition. 
The thickness of the solid is adjusted if necessary. 

 

Dragging  a composition onto a selection of solids 

Select the solids in the drawing. 

Select the composition in the In Project or In Library list on the BIM Libraries panel. 

Press and hold the left mouse button and drag the composition onto one of the selected solids. 

Release the left mouse button to attach the composition. 
The thickness of the solids is adjusted if necessary. 

 

NOTES Library compositions are copied to the Project database upon attachment. 

Attaching a Wall composition to a solid automatically classifies the solid as a wall. 

Attaching a Slab or Roof composition to a solid automatically classifies the solid as a 
slab. 
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Displaying the composition plies 

Each building element which has a composition attached, has a Display Composition property. 
When switched ON, the composition plies display in the model, allowing to select and edit the ply 
faces separately. 

When Display Composition = ON the render material of each ply, which is defined in the 3D 

Render Material setting of the material definition, shows in the model for visual styles that have 
their Face Settings / Material Display set to Materials and Textures (e.g. BIM, Modeling and 
Realistic). When Display Composition = OFF the Material definition of the solid is used.  

  

 

Select the solid(s) in the model (make sure the entire solid is selected, not faces). 
The properties of the selection display in the Properties Bar. 

Select Display composition in the BIM settings group. 

Choose On. 
 

 
 
The plies of the selected solids display in the model. 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/Materials.htm%23RenderMaterial
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BIM Sections 

Defining BIM Sections 

In BricsCAD BIM 2D documentation drawings are generated from the 3D model using BimSection 

definitions. The drawings are managed using an automatically generated project sheetset. 

The BimSection command creates BIM section entities, which are SectionPlane entities, extended 
with the following properties: 

Type: plan, elevation, section or detail. 

Callout position: start, mid, end, start-and-end. Indicates the position where callout 
blocks are displayed along the section line. If desired, users can define their own callout 

blocks, for each section type. 

Scale: sets the scale of the paper space viewport generated to display the results of the 
drawing generation. The default scale for new Bim Section definitions is specified by the 

SectionScale user preference. 

Layerstate: Use this setting to define which layerstate shall be applied when the section 
drawing is (re)generated. 

Apply Layerstate: 

Yes: Entities on the visible layers, as defined in the assigned layerstate, will take 
part in the drawing generation only. 

No: All currently visible entities will take part in the drawing generation. 

BIM section entities are created on the current layer. It is recommended to create a dedicated 
layer for BIM sections, e.g. BIM_Sections. 

Only the section line and the callouts of a BIM Section entity display. When highlighted or selected 
the section plane, section boundary and/or section volume display. 

 

To launch the BIM Section command 

Do one of the following: 

Right click, then choose Define Section ( ) in the Model command group in the Quad*. 

Click the Define Section tool ( ) in the BIM toolbar. 

Choose  Define Section in the BIM menu. 

Type bimsection in the command bar. 

Prompts you: Specify section type [Other/Detail] <Other>: 

Do one of the following: 

Right click to create a Plan, Section or Elevation. 

Type D to create a Detail section. 

 

*Right click the Quad field in the Status Bar and choose Show Quad on right click option in the 
context menu. 

file:///D:/BricsCAD%20Training/manuals/10_03_06_Working_With_Sections.htm
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General Procedure to Create a BIM Section 

When defining a BIM section, the Section Tracker block is attached to the cursor: 
 

 

   

1. Section plane 

2. View direction 

The section plane (1) lies in the XY-plane of the current coordinate system (WCS or UCS). The 
view direction (2) is in the negative Z-direction of the current coordinate system. 

If Dynamic UCS (DUCS) is ON, the section plane aligns to the face of the 3D solid under the cursor. 
Hit the TAB-key to select an obscured face. 
Hit the Shift-key to lock the dynamic UCS, which allows to specify the definition point(s) for the 
BIM Section entity outside the face of the solid. 

The section line is parallel to the X-axis of the coordinate system (WCS, UCS or DUCS). In case of 
a DUCS the X-axis lies on the edge by which the cursor enters the 3D solid face. If this edge is 

vertical, the Y-axis lies on the edge and the X-axis is horizontal. 

To define a BIM section: 

Launch the BimSection command. 
 

You are prompted: Select a point to place section or [Detail/Scale]: 

Do one of the following: 

To create a plan section (or a section parallel to the XY-plane of the current UCS): click a 

point without using DUCS. 

Hover the cursor over the face of a 3D solid which is parallel to the section plane you want 
to create. 
The Section Tracker aligns to the face under the cursor, on condition DUCS is active. 
Optionally, hit the Shift-key to lock the DUCS, which allows to snap a point outside the 
selected 3D solid face. 
Click a point. 

The initial section plane displays dynamically and the 3D model is clipped accordingly. 
You are prompted: Specify distance: 

Do one of the following: 

Type the offset from the initial position. 

Specify a point. 

The BIM section entity  is defined. 

file:///D:/03_Drawing_Accurately/03_07_User_Coordinate_Systems.htm%23DynUCS
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The Section Type property is set to: 

Plan (1): for horizontal section planes. 

Section (2):  for vertical sections cutting through the model. 

Elevation (3): for vertical sections outside the model. 

The Clip Display property is enabled by default, except for elevations. As a result the display of the 
3D geometry is clipped by the newly defined section. 

 

 

Edit the BIM section entity properties. 
  

Defining the BIM Section Entity Properties 

The default properties of a BIM section entity are copied from the corresponding section type  in 
the _SectionSettings.dwg drawing in the Bim/Sections subfolder of the Support folder. Edit the 
properties of these source BIM section planes to customize the default properties. 

To open the Support folder: type SUPPORTFOLDER in the command bar. 

 

Defining the BIM Properties 

Select the BIM section entity (or entities) in the drawing. 
If multiple BIM Section entities are selected you can specify settings for the selection set 
simultaneously. 
The current properties display in the Properties Bar. 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/SectionPlanes.htm%23Properties
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Define the properties of the BIM section entity: 

Section Entity: 

Name: type a name. 
By default, the section name defines the name of the generated drawing. 

The Destination file property of the 2D Section settings of the BIM Section entity allows to set the 
location and file name of the calculated drawing otherwise. 

State: Click the field and select a state. The selected state determines how the section result will 
be clipped. 

Plane: The section is defined as an infinite plane. 
The section result is not clipped. 
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BIM Section 
entity 

3D Model Generated Drawing 

1. Start grip 
2. Flip view direction grip 
3. End grip 
4. Section call out 

 

Boundary: The section is defined as a boundary. 
The section result is clipped by an infinite tube through the section boundary. 

Drag the green triangular grips to modify the section boundary. 
 
  

 

 

 

BIM Section entity 3D Model Generated Drawing 

 

Volume: The section is defined as a volume. 
The section result is clipped by the section volume. 

Drag the green triangular grips to modify the vertical clipping planes. 

Drag the top and bottom grips to modify the horizontal clipping planes. 



BricsCAD V18  Help 

 

 737 

 

 
  

 

 

 

BIM Section entity 3D Model Generated Drawing 

 

Live Section: sets the Live Section property of the section plane. 
Use this mode for visual checking only, not for 3D modeling. 

Clip Display: clips the 3D model. Editing solids is possible in Clip Display mode. As different from 

Live Section, multiple sections can have this mode set simultaneously. 

Use Lids: closes the top faces of the clipped geometry. Solids that have a composition applied are 
hatched according to the materials in the composition. 

Plane Transparency: sets the transparency of the section plane in rendered Visual Styles. 

Plane Color: sets the fill color of the section plane in rendered Visual Styles. 

 

Geometry: 
Elevation: defines the Z-value of the start point of the section plane. 

Top Plane: defines the top plane of the section volume. 

Bottom Plane: defines the bottom plane of the section volume. 

Vertex: defines to coordinates of the start point of the section plane. 

file:///D:/BricsCAD%20Training/manuals/10_03_06_Working_With_Sections.htm%23LiveSection
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BIM: 

 

Section Type: Sets the BIM section type. 
Click the field, then select Plan, Section, Elevation, Detail or Interior Elevation. 

The section type defines the settings used to create the section drawing. 
Sections of the Section type generate a section line and callouts in Plan sections. 
 

 

Callout Position: Defines the position of the callout(s). Select an option: Start, Mid, End or 
StartEnd. 

    

Start Mid End StartEnd 

 

Scale: Sets the scale of the viewport in the generated drawing. 
The default scale is defined by SectionScale user preference. 

Layer State: Indicates the layer state to be used to calculate the section. 

Apply Layer State: Determines whether the layer state will be used to calculate the section or 
not. 
Select an option: Off or On. 

Click the green arrow ( ) to flip the view direction of the section.  

  

NOTE Only the section line and the callouts of a BIM Section entity display. When highlighted or 
selected the section plane, section boundary and/or section volume display. 

Defining the section entity properties 

The properties of a section plane entity apply to BIM Section entities as well. However, only the 2D 
Section /elevation block creation settings are used when generating a BIM section. 

Choose Drawing Explorer > Section Planes... in the Tools menu. 

Select the BIM Section(s) in the section plane list.. 
If multiple BIM Section entities are selected you can specify settings for the selection set 
simultaneously. 

file:///D:/BricsCAD%20Training/manuals/10_03_06_Working_With_Sections.htm%23EditProperties
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Destination 

The section result is placed as a block in a new drawing. If no specific name was set for the target 
drawing, the name of the BIM Section entity will be used and the drawing is saved in the same 
folder as the model drawing. 

Alternatively you can specify the file name using the Destination File property of the 2D Section 

settings of the BIM Section entity, which allows to send the section results of different BIM Section 
entities to the same destination file. 

Under 2D Section /elevation block creation settings > Destination, select the Destination file 
setting. 

Do one of the following: 

Type a name in the Destination file field. 

Click the Browse button ( ), then select the destination folder in the File dialog. 

Type a name in the File Name field and click the Open button. 

The specified folder and file name display in the Destination file field. The *.dwg extension is 
added automatically. 

 

  
Intersection Boundary 

The Intersection Boundary settings control the properties of the intersection lines. 

It is recommended to set the Color, Linetype, PlotStyle and Lineweight settings ByLayer. 

The Layer field is set to Boundary_*EntityLayer* by default. The *EntityLayer* part will be 

replaced by the Material name of the Composition of the sectioned solid. Multiply compositions 
generate a different  layer for each material. 
  

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/SectionPlanes.htm%23Properties
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(option) Click the Layer field and choose New layer name settings ... in the list. 

 

 

Do the following: 

 

Type a text in the text field 

Choose to add the text to the Material name as a prefix or a suffix. 

Click the OK button. 
Click the Layer field, then choose *EntityLayer*_IntersectionBoundary.   
The format of the generated layer names is: <MaterialName>_IntersectionBoundary, e.g. Facing 
Bricks_ Hand-formed_IntersectionBoundary 

 

Intersection Fill 
The Intersection Fill settings control the properties of the hatching of the intersection boundaries. 

The intersection fill hatching is set to Fill_*EntityLayer* by default (see also the Layer setting of 
the Intersection Boundary). 

It is recommended to set the Color, Linetype, PlotStyle and Lineweight settings ByLayer. 

The Face Hatch, Angle and Hatch spacing properties apply only to boundaries generated from 
solids that have no BIM Composition attached. 

Hatch scale:  this setting applies to the hatch pattern of physical materials also. 
The final pattern scale in a section is the product of the scale setting of the physical material and 
the value of the Hatch Scale property of the section plane entity. 
Since the dimensions of predefined patterns are expressed in mm, the value of the Hatch Scale 

property is must be set with respect to the Insertion Units (INSUNITS) system variable of the 
model file. 

  

INSUNITS Section Scale 

mm 10 

cm 1 

m 0.01 

  

Background Lines 

The Background Lines settings control the properties visible and hidden lines in the view direction 
of the BIM Section entity. 

Show: Choose Yes to generated the background lines. 

Hidden Line: Choose No to not show invisible lines. 

The background lines are placed on the Background_*EntityLayer* by default (see also the Layer 
setting of the Intersection Boundary). 

It is recommended to set the Color, Linetype, PlotStyle and Lineweight settings ByLayer. 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/SectionPlanes.htm%23Boundary
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Cut-away Geometry 

Choose No to not show the cut-away geometry. 

Curve Tangency Lines 

The Curve Tangency Lines settings control the display of the transition line between two tangent 
faces. It is an imaginary line between the two faces. In most cases tangential edges need to be 
removed. 

 
Tangency lines removed (left) or shown (right). 

If necessary, set the properties for the Curve Tangency Lines. 

 

To Define a Plan Section 

A plan section is best defined in the WCS (World Coordinate System). 

Launch the BimSection command. 
You are prompted: Select a point to place section or [Detail/Scale]: 
 

 

Place the Section Tracker near the 3D model and click. 

The initial section plane lies in the XY-plane (Z=0) of the current coordinate system (e.g. the 
WCS). 
The section plane displays dynamically and the 3D model is clipped accordingly. 
You are prompted: Specify distance: 
If Dynamic Dimensions is ON, the current distance displays in a dynamic dimension field. 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/SectionPlanes.htm%23LaunchBimSection
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Do one of the following: 

Move the cursor and click when the section plane is at the desired height. 

Use an Entity Snap to specify a point. 

Type a value to define the offset from the initial position of the section plane. 

The plan section is defined. 

(Option) Select the plan section entity and edit the Elevation property of the BIM section entity to 

adjust the vertical position of the section plane. 
 

 

Edit the BIM section entity properties. 
Horizontal sections get the Plan section type by default. 

To Define a Cross Section 

Make sure Dynamic UCS (DUCS) is enabled when defining a cross section. 

Launch the BimSection command. 
You are prompted: Select a point to place section or [Detail/Scale]: 
  

Place the section tracker over a 3D solid face which is parallel to the cross section to be defined. 
 

 
  

Click when the face highlights and move the section tracker inside the 3D model. 
The section plane displays dynamically and the 3D model is clipped accordingly. 

file:///D:/03_Drawing_Accurately/03_03_Entity_Snaps.htm
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You are prompted: Specify distance: 

If Dynamic Dimensions is ON, the current distance displays in a dynamic dimension field. 
 

 

Click when the section plane is at the desired location or specify a distance. 
The cross section is defined. 
Vertical sections get the Section section type automatically. 

(option) Drag the Start grip to move the section plane. 

(option) Drag the End grip to rotate the section. 

(option) Click the Arrow grip to flip the view direction. 

Edit the BIM section entity properties. 

To Define an Elevation 

Make sure Dynamic UCS (DUCS) is enabled when defining an elevation. 

Launch the BimSection command. 
You are prompted: Select a point to place section or [Detail/Scale]: 
  

Place the Section Tracker over a 3D solid face which is parallel to the elevation to be defined and 
click when the face hightlights. 
You are prompted: Specify distance: 
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Move the section tracker outside the 3D model and click to define the elevation. 

The elevation is defined. 
Vertical sections outside the model (no geometry is sectioned) get the Elevation section type 
automatically. 
  

Edit the BIM section entity properties. 

To Define a Detail Section 

Detail sections can be defined from scratch or based on an existing section. 

Detail sections are section planes which have the Volume state applied automatically. 

To define a detail section from scratch 
Launch the BimSection command with the Detail option. 

You are prompted: Select first corner of the volume box base rectangle or [Based on an existing 
section/Scale]: 

Place the section tracker over a 3D solid face which is parallel to the cross section to be defined. 
Specify a point when the face highlights. 
The volume box base rectangle displays dynamically. 
Your are prompted: Select the opposite corner of section box: 

Do one of the following: 

Specify a point. 

Type a value in the dynamic dimension fields. 
Hit the TAB key to go back and forth between the dynamic dimension fields. 
Type Enter to confirm the current values. 

The volume box displays dynamically. 
You are prompted: Select the height of volume box <xx.xx>: 

Do one of the following: 

Press Enter to accept the default height (= previously entered value). 

Specify a point. 

Type a value in the dynamic dimension field. 

Edit the BIM section entity properties. 

To define a detail section based on an existing section 
Launch the BimSection command with the Detail option. 
You are prompted: Select first corner of the volume box base rectangle or [Based on an existing 
section(Based)/Scale]: 

Type B. 
You are prompted: Select an existing section plane as base: 

Select the BIM section entity to base the detail section on. 
You are prompted: Select first corner of volume box base rectangle: 

Specify a point. 
The volume box base rectangle displays dynamically. 

Your are prompted: Select the opposite corner of section box: 

Do one of the following: 

Specify a point. 

Type a value in the dynamic dimension fields. 
Hit the TAB key to go back and forth between the dynamic dimension fields. 

Type Enter to confirm the current values. 

The volume box displays dynamically. 
You are prompted: Select the height of volume box: 

Do one of the following: 

Press Enter to accept the default height (= previously entered value). 

Specify a point. 

Type a value in the dynamic dimension field. 

Edit the BIM section entity properties. 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/SectionPlanes.htm%23Properties
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/SectionPlanes.htm%23VolumeState
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/SectionPlanes.htm%23LaunchBimSection
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/SectionPlanes.htm%23Properties
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/SectionPlanes.htm%23LaunchBimSection
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/SectionPlanes.htm%23Properties
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To Create a 2D Isometric Drawing 

Choose an isometric view from the Look From widget. 

Launch the UCS command and select the View option. 
The UCS is now aligned with the current view. 

Rotate the view about 90°. 

Launch the BimSection command. 
You are prompted: Select a point to place section or [Detail/Scale]: 

Move the section tracker outside the 3D model and above the XY-plane of the UCS and create an 
Elevation type section. 
 

 

Edit the BIM section entity properties. 

 

Turning a Section Plane into a BIM Section 

Section planes, created by the SectionPlane command can be turned into a BIM section entity 

using the BimClassify command. 

Do one of the following: 

Click the BimClassify tool button ( ) in the BIM toolbar. 

Choose Classify in the BIM menu. 

Type bimclassify in the command bar. 

You are prompted: Classify entities as: 
Wall/Column/Slab/Beam/wIndow/Door/buildingElement/Auto/Unclassify: 

Select the Auto option. 

You are prompted: Select entities to classify: 

Click the section plane, then press Enter. 
BricsCAD responds: 
BIM data assigned to 1 of 1 object(s) 
XXXX classified as BimSection 

Edit the BIM section entity properties. 

file:///D:/04_Viewing_your_drawing/04_05_View_Rotation.htm%23UseLookFromIsometric
bricscad-cmdref.chm::/U/Ucs.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/SectionPlanes.htm%23LaunchBimSection
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/SectionPlanes.htm%23Elevation
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/SectionPlanes.htm%23Properties
bricscad-cmdref.chm::/S/SectionPlane.htm
bricscad-cmdref.chm::/BIM/BimClassify.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/SectionPlanes.htm%23Properties
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Creating a Jogged BIM Section 
Create a jogged section plane. 

To create a vertical jogged section plane. 

To create a horizontal jogged section plane. 

Turn the section plane into a BIM section. 

Define the properties of the BIM section. 

Using Clip Display 

The Clip Display property of the BIM section allows to temporarily clip the 3D geometry. 

Different from the Live status, the Clip Display status allows to continue using all modeling and 
editing operations on all drawing content. 

  

  

  

 

3D model of the villa with a plan section for the ground floor plan. 

Clip Display = No 

To toggle Clip Display 
Do one of the following: 

Double click the section entity. 

Execute the CLIPDISPLAY command. 

Edit the Clip display property of a section in the Properties Bar. 

file:///D:/BricsCAD%20Training/manuals/10_03_06_Working_With_Sections.htm%23JoggedVertical
file:///D:/BricsCAD%20Training/manuals/10_03_06_Working_With_Sections.htm%23JoggedHorizontal
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/SectionPlanes.htm%23TurnSectionIntoBimSection
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/SectionPlanes.htm%23Properties
bricscad-cmdref.chm::/C/ClipDisplay.htm
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To edit the display properties of a section entity in the Properties Bar 
Select the section entity in the drawing 
The properties of the section entity display in the Properties Bar. 
 

 

Select the Clip Display property and choose Yes. 

 

 
 
Use Lids = Yes: The top faces of the clipped geometry are closed. 
Solids that have a composition applied are hatched according to the materials in the composition. 

(option) Select the Use Lids property and choose NO. 

 

file:///D:/01_User_Interface/00_06_Properties_Bar.htm
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Use Lids = No: The top faces of the clipped geometry are open. 

(option) Different from the Live Section property, Clip Display can be ON for multiple section 
entities simultaneously. 

  

 

Clip Display = ON for two BIM section entities with opposite view directions. 

file:///D:/BricsCAD%20Training/manuals/10_03_06_Working_With_Sections.htm%23LiveSection
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(option) Set the State property = Volume. 

 

  

Generating Drawings 

BimSectionUpdate generates section drawings from BIM Section entities. The command can be 

used either by selecting a BIM Section entity in the 3D model, or by selecting an existing section 
result in a generated drawing. The result is placed in a new drawing, saved in the same folder as 
the model drawing, unless a different folder is specified in the Destination File property of the BIM 

Section entity. 

BimSectionOpen allows to navigate between the model drawing containing a BIM Section entity 
and the corresponding generated drawing. The command works bi-directional: either from the 
section result back to the model or from the model to the section result, depending on what was 
selected: a BIM Section entity in the 3D model or a section block or a viewport in a generated 
drawing. 

To Generate or Update Sections 

Do one of the following: 

Place the cursor over a BIM Section callout or section line, then choose Update Section 

( ) in the Model command group in the Quad. 

Select one or more BIM Section entities, then choose Update Section ( ) in the Model 
command group in the Quad. 

Click the Update Section tool button  in the BIM toolbar, then select a BIM section entity or 
entities. 

Choose Update Section in the BIM menu, then select a BIM section entity or entities. 

BIM Section entities can be selected by its Callout(s) and section line only. 

BricsCAD reports the number of generated sections and their name(s) in the Command Window, 
e.g.: 

8 section(s) were generated 
D:\Bricsys Reports\V16\Villa\Elevations.dwg 
D:\Bricsys Reports\V16\Villa\Plans.dwg 
D:\Bricsys Reports\V16\Villa\Sections.dwg 

In the example above 2 plans, 4 elevations and 2 cross sections were generated and exported to 3 

drawings. 

Upon the calculation of the first BIM Section in a project, a new project sheetset is created, using 
the sheetset template pointed to by the SectionSheetSetTemplateMetric (default = BIM-section-

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/SectionPlanes.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/SectionPlanes.htm%23Destination
file:///D:/01_User_Interface/01_00_The_Bricscad_Application_Window.htm%23CommandLineProperties
bricscad-cmdref.chm::/S/SheetSet.htm


  User Guide 

 750 

metric.dst) or SectionSheetSetTemplateImperial (default = BIM-section-imperial.dst) user 

preference. The sheetset is stored in the same folder as the drawing.  

If the PROJECTNAME system variable in the model drawing is not empty, it is used as the name for 
the generated SheetSet, else the name of the model drawing is used. 

The template drawing for the drawing generation process is defined by the Sheet Template Layout 
setting of the project sheetset.. 

Paper space view definitions that correspond with the location of the viewport are created and used 
to set up sheet views. The generated sheetset offers view categories per section type: Plan, 
Section, Elevation or Detail. 

  

 

  

file:///D:/20_Managing_Drawings/02_11_Projects.htm
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NOTES BIM_SECTIONS_PREVIOUS layer: the result of the previous section generation is stored 

on the dedicated BIM_SECTIONS_PREVIOUS layer, which is frozen by default. Thawing 
the layer allows for a pragmatic and fast visual check of modifications 

BIM_VIEWPORTS layer: generated viewports are placed on the dedicated 

BIM_VIEWPORTS layer. If desired, this layer e.g. can be set as 'non-printing' in the 
template drawing. 

Using the same folder for the sheetset definition, models and generated drawings 
enables painless migration from one machine to the next: the SheetSet manager will 
automatically and silently adjust the file paths after the project folder has been 
relocated. 

 

To Open a Generated Drawing 

Do one of the following 

Place the cursor over a BIM Section callout or section line, then choose Open Section Model ( ) in 
the Model command group in the Quad. 

Double click the drawing in the sheet list in the SheetSet panel. 

To Update a BIM Section 

A red frame around the section result indicates that the BIM Section generated block is no longer 
in sync with the 3D model. Such section results can be updated without opening the 3D model. 
This can be done both in Model Space and in a Layout. 

Update a BIM section in Model Space 
Click the Model tab. 

Place the cursor over the section block that needs to be updated. 

Choose Update Section ( ) in the Model command group in the Quad. 

 

 

Update a BIM Section in a layout 
Click the Layout tab. 

Place the cursor over the viewport of the BIM Section that needs to be updated. 

Choose Update Section ( ) in the Model command group in the Quad. 

 

  
The result of the previous section generation is stored on the dedicated BIM_SECTIONS_PREVIOUS 
layer. Thaw the layer to check the modifications. 

The content of the BIM_SECTIONS_PREVIOUS layer displays in magenta. 
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Editing Drawings 

When a BIM Section is generated, a block containing the drawing generation result is added to the 
model space of the target drawing, as well as a paper space viewport looking onto this block. The 
block and the viewport initially are placed so they do not overlap with existing geometry contained 
in the drawing. You can move this block or viewport to a new location, which will be preserved on 

subsequent updates. 

In the default template drawing which is used to create the generated drawings a Viewlabel and 
NumberBubble blocks exist. You can place them associated to the selected sheet view. The Title 
block in this drawing contains attributes that will be filled in automatically when the associated 
Sheet Set properties are defined. 

A sheet list table can be placed on any sheet of the sheetset. In the current implementation the 
table content is not associative yet. 

Inserting the Title Block 

Open the Drawing Explorer - Blocks dialog. 

Double click the Title block. 
The Drawing Explorer dialog closes and the block is attached to the cursor. 
In a metric units project the size of the Title block fits the A1 paper size (594 x 841 mm) 
In an imperial units project the size of the Title block fits the Arch D paper size (24 x 36 inches) 

Click at the lower left corner of the paper sheet in the layout. 

Define the Project and custom properties in the Sheet Sets panel. 

Select the Title block, then click the Update Fields tool button ( ) in the Redraw/Regen toolbar. 
 

 

file:///D:/12_Blocks_Attributes_External_References/01_Blocks/00_03_Managing_Blocks.htm%23Open_the_Blocks_Explorer
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Inserting a View Label for a Sheet View 
Select the sheet view In the Sheet Sets panel. 

Right click the sheet view you want the view label block to insert for. 
 

 
  

Choose Place View Label Block in the context menu. 
Your are prompted: 
: VIEWLABEL 
Units: Millimeters    Conversion: 1 
Insertion point for block:  

Specify the insertion point. 

You are prompted: 
Scale factor for block <1.0>:  

Specify the scale factor or right click to accept the current scale. 
Your are prompted: 
Rotation angle for block <0>:  

Specify the rotation angle or right click to accept the current angle. 

The View Label block is inserted. 
The Sheet Number (1), Sheet View Number (2), Sheet View Title (3) and Viewport Scale (4) of the 

selected sheet view are filled in automatically. 
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Inserting a Number Bubble for a Sheet View 
Select the sheet view In the Sheet Sets panel. 

Right click the sheet view you want the number bubble block to insert for. 
 

 
  

Choose Place Callout Block > Number Bubble in the context menu. 
You are prompted: 
: ._CALLOUT 
Units: Millimeters    Conversion: 1 
Insertion point for block:  

Scale factor for block <1.0>:  

Rotation angle for block <0>:  

Specify the insertion point. 
You are prompted: 
Scale factor for block <1.0>:  

Specify the scale factor or right click to accept the current scale. 
Your are prompted: 

Rotation angle for block <0>:  

Specify the rotation angle or right click to accept the current angle. 
The Number Bubble block is inserted. 
The Sheet Number (1) and Sheet View Number (2) of the selected sheet view are filled in 
automatically. 
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Inserting a Sheet List Table 
A Sheet List table can be inserted on any sheet of the sheetset. In the current implementation the 
table content is not yet associative and therefore will not be updated automatically when sheets 
are added, removed or renamed. 

Right click the sheetset name in the Sheet Sets panel and choose Insert Sheet List Table in the 

context menu. 
You are prompted: Select insertion point. 

Specify a point in the drawing. 

 

Customizing Callout Blocks 

Source files of the various callout blocks and the section tracker exist in the 

..\Support\Bim\Sections subfolder of the Roamable Root folder.  

By default this is: 

C:\Users\<user_name>\AppData\Roaming\Bricsys\BricsCAD\Vxx\en_US\Support\Bim\Sections. 

 

You can edit these files to customize the layout of the callouts and the section tracker blocks. 

When a drawing is generated, the callout blocks needed are created from the callout blocks source 

file(s). When a BIM section is updated, the existing callout blocks in the target drawing are used. 
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Spatial Locations 

Assigning a Building and Story to a Building Element 

Command: BIMSPATIALLOCATIONS, BIMCLASSIFY 

  

The BimSpatialLocations command opens the Buildings & Stories manager, which allows to edit 
site properties, and edit and create buildings and stories. 

The BimClassify command classifies an entity as a Building Element and get a name and an 
internal GUID (= globally unique identifier). 

  

A BIM model file can contain one site and multiple buildings. A building contains multiple stories. 

Entities that are classified as a Building element have a Building and a Story property. 

Assigning a building and story to a building element 

Compose a selection set of building elements. 
The shared properties of the selected entities display in the Properties Bar. 

Expand the BIM node in the Properties Bar. 

 

 

Click the Building Field, then click again and select a building. 

Click the Story field, then click again and select a story. 

To examine the model in the Structure panel 

The Structure panel allows to examine the BIM model. By default, the structure of building 
elements is organized by spatial containment. Building elements are grouped first by Building, then 
by Story, then by BIM type, then by composition. This organization can be fully configured: any 
property, including all ifc properties, can be used as a grouping or sorting rule. 

bricscad-cmdref.chm::/BIM/BimSpatialLocations.htm
bricscad-cmdref.chm::/BIM/BimClassify.htm
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Sheet Metal 

Commands and Toolbars 

 

Sheet 

Metal 
Toolbar 

Icon 

Flyout 

Toolbar 
Icon 

 

Command Description 

 

 SmFlangeBase  Creates a base (initial) flange of a sheet metal 
part from a closed planar profile. 

 

 SmExtrude  Creates a sheet metal part by extruding a polyline 
 in the direction of the normal of the curve plane. 

Thickness is assigned with respect to the external 
dimensions of the polyline. 

 

 SmLoft Creates sheet metal part with lofted bends and 
flanges from two non-coplanar curves. 

 

 SmConvert  Automatically recognizes flanges, bends and lofted 
bends in a 3D solid. 

  

SmFlangeEdge  Creates one or more flanges on a sheet metal part 

by pulling one or more edges of an existing flange. 

 
 

SmFlip Changes the reference side for selected flanges 
with an optional shift of the flange geometry by 
thickness. 

 

 BmInsert  Inserts form features. 

 

 SmRibCreate Creates an associative rib form feature on a flange 
face from a planar 2D curve. 

 

 SmReplace Replaces form features (including recognized 
ones) in sheet metal parts with form features from 
a built-in or user library. 

  

SmBendCreate  Converts hard edges (sharp edges between flange 
faces) and junctions into bends. 

 
 

SmBendSwitch  Converts bends to lofted bends 

 
 

SmflangeBend  Bends an existing flange along a line, obeying k-

factor for given bend radius. 

  

SmJunctionCreate  Converts hard edges into junctions. 

 
 

SmJunctionSwitch  Changes a symmetrical junction feature to one 
with overlapping faces. 

 
 

SmFlangeConnect  Closes gaps between two arbitrarily oriented 
flanges. 

  

SmReliefCreate Makes proper corner and bend reliefs. Corner 
reliefs are built on corners which have three or 
more adjacent flanges. Bend reliefs are built on 
the start and end of a flange edge . 

 
 

SmReliefSwitch Converts a corner relief to a circular relief. 

 
 

SmReliefSwitch Converts corner reliefs to a rectangular relief. 

 
 

SmReliefSwitch Converts corner reliefs to a VType relief.  

 
 

SmReliefSwitch Converts corner reliefs to a Smooth relief.  

 
 

SmReliefSwitch Converts corner reliefs to a Round relief.  

bricscad-cmdref.chm::/SheetMetal/SmFlangeBase.htm
bricscad-cmdref.chm::/SheetMetal/SmExtrude.htm
bricscad-cmdref.chm::/SheetMetal/SmLoft.htm
bricscad-cmdref.chm::/SheetMetal/SmConvert.htm
bricscad-cmdref.chm::/SheetMetal/SmFlangeEdge.htm
bricscad-cmdref.chm::/SheetMetal/SmFlip.htm
bricscad-cmdref.chm::/Mechanical/BmInsert.htm
bricscad-cmdref.chm::/SheetMetal/SmRibCreate.htm
bricscad-cmdref.chm::/SheetMetal/SmReplace.htm
bricscad-cmdref.chm::/SheetMetal/SmBendCreate.htm
bricscad-cmdref.chm::/SheetMetal/SmBendSwitch.htm
bricscad-cmdref.chm::/SheetMetal/SmFlangeBend.htm
bricscad-cmdref.chm::/SheetMetal/SmJunctionCreate.htm
bricscad-cmdref.chm::/SheetMetal/SmJunctionSwitch.htm
bricscad-cmdref.chm::/SheetMetal/SmFlangeConnect.htm
bricscad-cmdref.chm::/SheetMetal/SmReliefCreate.htm
bricscad-cmdref.chm::/SheetMetal/SmReliefSwitch.htm
bricscad-cmdref.chm::/SheetMetal/SmReliefSwitch.htm
bricscad-cmdref.chm::/SheetMetal/SmReliefSwitch.htm
bricscad-cmdref.chm::/SheetMetal/SmReliefSwitch.htm
bricscad-cmdref.chm::/SheetMetal/SmReliefSwitch.htm
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SmReliefSwitch Converts corner reliefs to a Rip relief.  

  

SmFlangeSplit Splits a flange along a line drawn on its face. 

 
 

SmFlangeSplit Splits a flange by a single vertex in the corner. 

 

 SmImprint  Splits thickness faces of a sheet metal part by 
imprinted edges, according to adjacent flanges 
and bends. 

 

 SmDissolve Removes sheet metal data from the selected faces 
or entities. 

 

 SmDelete Removes a bend or a junction by restoring a hard 
edge between two flanges; removes a flange with 
all the bends adjacent to it. The adjacent flanges 
are extended up to a junction configuration with 
the flange being deleted. Removes miter by 

restoring geometry being cut by the feature. 

      

 

 SmFlangeRotate Rotates a flange. 

 

 SmSelect Same 
Form Features 

Selects all identical form features in the sheet 
metal model 

 

 SmSelect Hard 
Edges 

Selects all hard edges on sheet metal parts. 

 

 SmRepair Fixes problems specific to parts with lofted bend 
features: merges adjacent bends and provides 
tangential connection with flanges. 

 

 SmParametrize Creates a consist set of 3D constraints for the 

selected sheet metal part. 

  

SmUnfold  Unfolds the sheet metal body. 

 
 

SmExportOSM Exports a sheet metal solid to the .osm (Open 
Sheet Metal) file format. 

 
 

SmExport2d Exports the unfolded representation of a sheet 
metal body as a 2D profile in .dxf / .dwg file 
format. 

 
 

SmAssemblyExport  Performs a batch export of assembly components 
to unfolding, creating a .dxf per each 3D solid 
recognized as sheet metal part. 

 

 FEATURECOLORS  Toggles the FEATURECOLORS system variable. 

  

bricscad-cmdref.chm::/SheetMetal/SmReliefSwitch.htm
bricscad-cmdref.chm::/SheetMetal/SmFlangeSplit.htm
bricscad-cmdref.chm::/SheetMetal/SmFlangeSplit.htm
bricscad-cmdref.chm::/SheetMetal/SmImprint.htm
bricscad-cmdref.chm::/SheetMetal/SmDissolve.htm
bricscad-cmdref.chm::/SheetMetal/SmDelete.htm
bricscad-cmdref.chm::/SheetMetal/SmFlangeRotate.htm
bricscad-cmdref.chm::/SheetMetal/SmSelect.htm
bricscad-cmdref.chm::/SheetMetal/SmSelect.htm
bricscad-cmdref.chm::/SheetMetal/SmRepair.htm
bricscad-cmdref.chm::/SheetMetal/SmParametrize.htm
bricscad-cmdref.chm::/SheetMetal/SmUnfold.htm
bricscad-cmdref.chm::/SheetMetal/SmExportOSM.htm
bricscad-cmdref.chm::/SheetMetal/SmExport2d.htm
bricscad-cmdref.chm::/SheetMetal/SmAssemblyExport.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/Definitions.htm%23FeatureColors
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The Sheet Metal tools are available: 

In the Quad cursor menu (depending on the feature under the cursor): 
 

 

On the Sheet Metal toolbars: 

 

 
 

 
 

 
 

 
 

 
 

 
 

 

file:///D:/BricsCAD%20Training/03_Drawing_Accurately/03_12_Quad.htm
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In the Sheet Metal menu (Sheet Metal Workspace only): 

 

 

In the Sheet Metal tab of the Sheet Metal workspace Ribbon. 

 

 
 

 

See also Direct Modeling tools. 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/10_03_03_Direct_modeling_operations.htm
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SheetMetal Tutorials 

Batch Processing in BricsCAD Sheet Metal  

New Sheet Metal functions in BricsCAD V16  

Feature coloring in BricsCAD Sheet Metal  

Designing from scratch in BricsCAD Sheet Metal  

Lofted bends in BricsCAD Sheet Metal  

  

  

Sheet metal design allows you to model sheet metal parts and generate their unfolded 
representations with manufacturing information. 

 

 

  

https://blog.bricsys.com/batch-processing-in-bricscad-sheet-metal/
https://blog.bricsys.com/insights-stories/new-sheet-metal-functions-bricscad-v16/
https://blog.bricsys.com/feature-coloring-in-bricscad-sheet-metal/
https://blog.bricsys.com/designing-from-scratch-in-bricscad-sheet-metal/
https://blog.bricsys.com/lofted-bends-in-bricscad-sheet-metal/
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You can create complex sheet metal parts with BricsCAD easily and rapidly, because the design 
process is different from manufacturing process. Do not think in terms of a planar sheet that 

should be cut and bent, but model your part directly as you create solid bodies with Direct 
Modeling tools. 

You can create sheet metal parts in BricsCAD in four different ways (or in any combination of 
them): 

Create a base flange from a closed planar profile, then add flanges:  

Pull its edges to create additional edge flanges with bends.  

Create partial flanges with automatic creation of the corresponding bend reliefs.  

Pull several adjacent edges to create several flanges at once with automatic creation of corner 
reliefs and junctions between them.  

Bend a flange to create a new flange with a bend from its portion.  

Create a combination of flanges and lofted bends connecting two 3D profiles using Sheet Metal Loft 
tool.  

Create a combination of flanges and bends from planar profile using Sheet Metal Extrude tool.  

Create a shelled body from a 3D solid, using Shell option of the SolidEdit command with a desired 
thickness, then convert it to a sheet metal part, and create bends and junctions from its hard 
edges.  

Make holes by drawing closed profiles on faces of the flanges and pushing them through the 
flanges.  

Adjust material thickness and bend radius using pre-defined parameters.  

Apply Direct Modeling operations and 3D constraints to further adjust your design while always 

maintaining the design intent in terms of sheet metal features.  

Automatically generate unfolded representation of your part and send it to a CAM system by 
exporting the corresponding 2D drawing with bend annotations in a .dwg or .dxf file.  

You can further detail your sheet metal part using the following operations: 

Make holes by drawing closed profiles on faces of the flanges and pushing them through the 
flanges. 

Insert form features from a library. A library of parametric form features is installed with BricsCAD 

Sheet Metal and you can create your own form features. 

Create rib form features from a 2D curve lying on the flange by the SmRibCreate command. 

Adjust material thickness and bend radius using pre-defined parameters. 

Apply Direct Modeling operations and 3D constraints to further adjust your design while always 
maintaining the design intent in terms of sheet metal features. 

When your sheet metal part is ready, you can automatically unfold it and send the result to a 

manufacturing engineer by exporting the corresponding 2D drawing with bend annotations in a 
.dwg or .dxf file. 

bricscad-cmdref.chm::/SheetMetal/SmLoft.htm
bricscad-cmdref.chm::/SheetMetal/SmExtrude.htm
bricscad-cmdref.chm::/S/SolidEdit.htm#Shell
bricscad-cmdref.chm::/S/SolidEdit.htm
bricscad-cmdref.chm::/SheetMetal/SmRibCreate.htm
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Definitions and Settings 

Batch Processing in BricsCAD Sheet Metal  

New Sheet Metal functions in BricsCAD V16  

Feature coloring in BricsCAD Sheet Metal  

Designing from scratch in BricsCAD Sheet Metal  

Lofted bends in BricsCAD Sheet Metal  

  

  

Sheet Metal Features 

Form features are smart regions (groups of faces) of your 3D part. Each feature maintains specific 
spatial and parametric relationship between its faces and some adjacent faces. Form features allow 
you to embed design intent into your model. You do not create features by hand, they are created 

automatically depending on a particular geometric operation you apply. 

 

 

Flange 

https://blog.bricsys.com/batch-processing-in-bricscad-sheet-metal/
https://blog.bricsys.com/insights-stories/new-sheet-metal-functions-bricscad-v16/
https://blog.bricsys.com/feature-coloring-in-bricscad-sheet-metal/
https://blog.bricsys.com/designing-from-scratch-in-bricscad-sheet-metal/
https://blog.bricsys.com/lofted-bends-in-bricscad-sheet-metal/
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The main feature of any sheet metal part is a flange, which consists of two parallel planar faces. 

This distance between them is equal to the material thickness. When you modify the model, this 
distance relation is always maintained automatically. Other faces, which are adjacent to flange 
faces and do not belong to bends are called thickness faces. They are always perpendicular to 
flange faces. 

Flange features are created by SmFlangeBase, SmExtrude, SmLoft, SmFlangeEdge, SmFlangeBend 

and SmConvert commands. 

If the FEATURECOLORS system variable is ON, the display color distinguishes between the 
reference face of a flange and its opposite side. Parametric modifications of a sheet metal part, 
such as thickness change, do not move reference faces, if possible. The SmFlip command swaps 
sides of a selected flange so that reference faces are on the other geometric side of the flange; 
optionally the command shifts the flange over the thickness of the sheet metal part. 

The images below illustrate the color legend for the flange faces of the same part. 

  

 

 

Reference Faces Other Faces 

  

 Bend 

Two flanges are connected by a bend. A bend consists of two coaxial cylindrical faces, which are 
always tangent to the adjacent planar faces of the flanges. 

Bend features are created by SmFlangeBase, SmExtrude, SmFlangeEdge, SmFlangeBend and 

SmConvert commands. 

 Wrong Bend 

Wrong bend features are recognized by the SmConvert command and reflects assumptions on the 
user’s design intent. Like regular bends, wrong bends connect flanges, but the have geometrical 
failures, such as radii or angle mismatches which prevent using the geometry as regular bend 

features. Before unfolding the part all wrong bends must either be repaired by SmRepair or 
removed and recreated by SmBendCreate. 

 Lofted Bend 

Lofted bend represents an abstraction of the lofted surface, which for any point on the surface has 

a line which completely belongs to surface. The result of thickening of lofted surface is called lofted 
bend. Lofted bends can connect one or two flanges or be stand-alone, without flanges at all. Sheet 
metal part main contain flanges, bends, reliefs, junctions and lofted bends all together.  

Differences between bends and lofted bends: 

  

  Bends Lofted Bends 

Surface Cylindrical Cylindrical, conical or spline 

Unfolding Exactly The approximate unfolding of lofted bends is controlled by an 
adjustable number of bend operations, which are called the Number of 
Subdivisions. The more operations are performed, the smoother the 

real part will be produced and the better it approximates the initial 
design. 

  

Lofted bend features are created by the SmLoft and SmConvert commands. 

bricscad-cmdref.chm::/SheetMetal/SmFlangeBase.htm
bricscad-cmdref.chm::/SheetMetal/SmExtrude.htm
bricscad-cmdref.chm::/SheetMetal/SmLoft.htm
bricscad-cmdref.chm::/SheetMetal/SmFlangeEdge.htm
bricscad-cmdref.chm::/SheetMetal/SmFlangeBend.htm
bricscad-cmdref.chm::/SheetMetal/SmConvert.htm
bricscad-cmdref.chm::/SheetMetal/SmFlip.htm
bricscad-cmdref.chm::/SheetMetal/SmFlangeBase.htm
bricscad-cmdref.chm::/SheetMetal/SmExtrude.htm
bricscad-cmdref.chm::/SheetMetal/SmFlangeEdge.htm
bricscad-cmdref.chm::/SheetMetal/SmFlangeBend.htm
bricscad-cmdref.chm::/SheetMetal/SmConvert.htm
bricscad-cmdref.chm::/SheetMetal/SmConvert.htm
bricscad-cmdref.chm::/SheetMetal/SmRepair.htm
bricscad-cmdref.chm::/SheetMetal/SmBendCreate.htm
bricscad-cmdref.chm::/SheetMetal/SmLoft.htm
bricscad-cmdref.chm::/SheetMetal/SmConvert.htm
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 Bend Relief 

Group of faces representing a technological cut between two flanges of different width connected 
with a bend. The bend relief feature maintains the distance between two opposite faces of the cut. 

 

Bend relief features are created by SmFlangeEdge, SmBendCreate and SmReliefCreate commands. 

 Corner Relief 

Group of faces representing a cut in the corner where three flanges meet together. Corner relief 

feature maintains the form and size of this cut. 

 

Corner relief features are created by SmFlangeEdge, SmBendCreate and SmReliefCreate 

commands. 

 Junction 

Junction feature consists of two thickness faces of adjacent flanges, which are not connected via 
bend. 

 

Junction features are created by SmFlangeEdge, SmJunctionCreate and SmFlangeConnect 
commands. 

 Miter Feature 

Miter features represent a split between coplanar flanges which is created by SmFlangeEdge and 
SmFlangeSplit commands. 

 

  

 Form Feature 

Form and rib features represent a rich variety of shapes which are produced by punching and 
wheeling.  

Two representations of the form features are important: one in 3D and a 2D symbol in the 

unfolded geometry. In case of imported geometry the symbol is obtained by the projection of the 
3D faces of the form feature In case the form feature was inserted/replaced from Form Feature 

Library, the unfolding symbol is taken from the library file. 

bricscad-cmdref.chm::/SheetMetal/SmFlangeEdge.htm
bricscad-cmdref.chm::/SheetMetal/SmBendCreate.htm
bricscad-cmdref.chm::/SheetMetal/SmReliefCreate.htm
bricscad-cmdref.chm::/SheetMetal/SmFlangeEdge.htm
bricscad-cmdref.chm::/SheetMetal/SmBendCreate.htm
bricscad-cmdref.chm::/SheetMetal/SmReliefCreate.htm
bricscad-cmdref.chm::/SheetMetal/SmFlangeEdge.htm
bricscad-cmdref.chm::/SheetMetal/SmJunctionCreate.htm
bricscad-cmdref.chm::/SheetMetal/SmFlangeConnect.htm
bricscad-cmdref.chm::/SheetMetal/SmFlangeEdge.htm
bricscad-cmdref.chm::/SheetMetal/SmFlangeSplit.htm
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Form and rib features are created by BmInsert, SmRibCreate and SmConvert commands. 

K-Factor 

The material deformation properties for bending is based on the assumption that there is internal 
surface for the sheet metal part which is not deformed when the sheet is bent. From the variety of 
internal surfaces the one is selected, which is equidistant from one side of the bend. The surface is 

local for each bend, and for simple cases it can be propagated on entire part, like the one on the 
picture. We assume that this surface is not stretched stretch during bending. 

  

 

 

  

T: thickness of the sheet metal part 

R: internal radius of the bend 

The K-factor (k) is the ratio of the location of the neutral surface to the material thickness. As a 
result the neutral surface lies at a distance kT from the internal surface of the bend. The bend 
radius of the neutral surface equals R + kT. The K-Factor is a simple geometric calculation of the 
location of the neutral surface. Forming stresses and other unknown (error) factors are not taken 

into account. The K-Factor depends on many factors, including the kind of material, bending type, 
tools, etc ... The K-Factor typically lies between 0.3 and 0.5. The default K-Factor for a bend radius 
equal to the material thickness (T) is 0.27324. 

 

In the unfolded state of a sheet metal part, the flanges (L1 and L2) are not stretched. The bent 
part is indicated as BA: bend allowance. The BA equals the length of the unfolded neutral surface: 

BA = BendAngle * (R + kT) 

In real world practice it is hard to measure the K-Factor or the bend allowance. The following 
formula allows to calculate the tangential Bend Deduction (BD): 

BD = B1 + B2 - Unfolded Length = B1 + B2 - (L1 + L2 + BA) 

  

For simple cases the K-Factor value can be overridden in the browser, for maximal precision a 
bend table containing tangential bend deductions has to be provided. For each sheet metal part, 
you can either specify a K-factor or use the default one. 

To change the K-Factor for a sheet metal part: 
To change the K-Factor for a sheet metal part, select the root node in the Mechanical Browser and 

type a value in the K-Factor field. The value must lie in the range [0, 1], since the neutral surface 
is located inside the sheet metal part. In BricsCAD the K-Factor is defined for bend radius equal to 
the material thickness (R/T = 1); to compute the value of K-Factor for an arbitrary bend radius, 
BricsCAD uses a special interpolation technique which is proved to be valid for industrial sheet 
metal applications. The image below shows the interpolation strategy: for R/T < 1 the linear 
interpolation is done between 0 and 0.27324, for 1 < R/T < 4 the K-Factor is linearly interpolated 
between 0.27324 and 0.5 and if R/T is greater than 4, the K-Factor is constant and equals 0.5 . 

Physically it means that if the bend radius is much larger than the thickness (at least 4 times), the 
material stretch is can be neglected.  

bricscad-cmdref.chm::/Mechanical/BmInsert.htm
bricscad-cmdref.chm::/SheetMetal/SmRibCreate.htm
bricscad-cmdref.chm::/SheetMetal/SmConvert.htm
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The K-Factor parameter one can control in the browser is for R/T. I.e. if we set the value to 0.6, 
the interpolation law leads to the following result: 

 

The varying K-Factor in the browser. 

T = 2, R = 2, B1 = 100, B2 = 100 

  

Setting K=0 gives L1=L2=96, Unfolded Length = 96, thus BA is 3.14. 

  

This value fits the formula exactly: a straight angle in radians roughly equals 1.57 (PI/2). The 
default K-Factor 0.27324 gives an Unfolded Length = 196.  

Or: L1=L2=96 (flanges are not deformed), the BA = 4 as we can compute from the dimensions 
(196 - 2*96) or from the Bend Allowance formula: BA = BendAngle * (R + kT) = 1.57 * (2 + 
2*0.27324) = 4 

  

Finally, maximizing K-Factor results in an Unfolded Length = 198.28. This is the maximal value one 
can achieve in this example, since the neutral surface is taken from external side of the bend. 
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The Bend Deduction (BD) for k = 0.27324: 

BD = B1 + B2 - Unfolded Length = 100 + 100 - 196 = 4  

Bend Table 
Bend tables are a more reliable way to express material deformation properties. When you bend a 

flat sheet of a particular material, you can measure its length before and after this process. You 
repeat this procedure for different bend angles, bend radius, and sheet thickness and save the 
measurements in a bend table. Then these measurements can be taken into account to compute 

the correct unfolded length for all parts made of the same material. 

In a bend table, you can add the results for as many different bend angles as you want. However, 
in most cases it suffices to measure the length for a 90 degrees angle. BricsCAD will automatically 
compute the length for other bend angles using a reliable interpolation technique. 

Bend tables are stored in a *.csv (comma separated values) file format. You can create such a 
table in an ASCII text editor, such as Notepad, but a more reliable and easier way is to create a 
table in a spreadsheet, such as Microsoft Excel or LibreOffice and then export it to .csv file format. 

Bend tables in BricsCAD have the following structure: 

  

 

  

The following rules apply: 

The content of the first cell reads "BricsCAD”. 

Version:  currently supported version is 1. 
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AngleType:  Currently only internal bend angles are supported: 

 

LengthType: the semantics of the value in the cells of  the bend table corresponding to a particular 
bend angle and bend radius. Now only bend deduction measured from the tangent point is 
supported (”BendDeductionTangent”). Bend deduction (BD) is the difference between the sum of 

the lengths of two flanges measured to the tangent point on a 3D model and the length of the 
same fragment in the unfolded state: 

 

Within the defined header, several tables can exist. For each table, the first key is the of the sheet 
metal part, the second key, DieWidth, is optional. The Thickness / DieWidth pairs must be unique. 
If the DieWidth is not defined, only one unique Thickness value key is allowed, but multiple 
thickness values can be added. When a bend table is used to control the unfolding process, the 
Thickness and DieWidth, defined in the sheet metal part, must exist in the bend table. If the table 

is not found the default K-Factor policy is used. 

Once the bend table is found in the .csv, it will be used to unfold the sheet metal part. Using the 
sample bend table above, let’s have a look a few cases: 
T = Thickness, R = Internal Bend Radius, A = Bend Angle 
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1. T = 1, R = 2, A = 45. Then after unfolding it will obtain the BD = 0.466, because both R and A 

are found in the bend table for the given thickness. 

2. T = 1, R = 2.5, A = 45. A = 45 is found, but R = 2.5 is missing:  the interpolation of BD 
between R=2 and R=3 is used. 

3. T = 1, R = 2.5, A = 75. Neither R nor A is found in the table: the following cells are used to 
calculate the value of BD: (R=2, A=60), (R=3, A=60), (R=2, A=90) and (R=3, A=90).  

 
The top-of-the-edge algorithm is used to calculate the interpolation. For example, linear 
interpolation on adjacent BD values render unnatural results, which will not match the real bending 
results. Also keep in mind that for a given T, R and A not all BD values make sense: a random one 
might place the neutral surface outside the sheet metal part, or expressed in K-Factor (which can 
be deduced from BD), the K-Factor can be out of range [0, 1]. In this case, the BD for the default 
K-Factor will be used. 

If you produce your sheet metal parts with different tools, you can describe them in one bend table 
using DieWidth parameter.  

A sample bend table is provided for your convenience in the ..\Samples\Mechanical\bend_tables 
subfolder of  the BricsCAD program folder (e.g. C:\Program Files\Bricsys\BricsCAD V14 
en_US\Samples\Mechanical\bend_tables). Please notice that writing rights to this folder might be 
limited. In such case you need to copy the bend tables to a different folder in which you have full 

access rights. 

To set the bend table for your sheet metal part: 

Select the root node in the Mechanical Browser.  

Select the Bend table field. 
 

 

Click the Browse button ( ).  

Select the *.csv file then double click or press the Open button.  

To update the bend table set previously: 

Select the root node in the Mechanical Browser.  

Select the Bend table field.  

Press the Update button ( ).  

If the bend table is not assigned to the document or has no DieWidth secondary key, the DieWidth 
parameter can not to assigned to single bend or all the bends. In order to make the assignment, 
do the following steps: 

Select .csv file DieWidth secondary keys and thickness matching the current part. On given 
example we assume that part has thickness of 1 mm and bend radius also equals to 1. We will 

vary bend deduction to different tools: first subtable is when tool is not specified, second subtable 
is for case when tool DieWidth is equal to 20, and last one is for tool with DieWidth equal to 30. 
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Assign the bend table to the sheet metal part. 

Check that in the Mechanical Browser new fields appeared: 
 

 
 
In this global setting we can select any default DieWidth value suitable for the part thickness. The 
value will be assigned by default to the bends in the part, which can be checked by the property of 
the bend (click on the bend in the Mechanical Browser): 
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However, we can select a specific tool which will be used for the given bend by expanding the 
drop-down list: 

 

 

With the given selection, unfolding of Bend_1 will use a third subtable from our bend table for bend 
deduction and uses the value 1.8. For the rest of the bends, unless DieWidth is set for them, the 

default no-die-width value will be used, which will trigger first the bend table and uses value 2.1 
for 90-degrees with a bend radius equal to 1. 

  

NOTE After assigning the DieWidth to the bends and saving the document, the value is saved to 

the bends. However, next time the drawing is opened, in order to assign the DieWidth 
value to another bend, you have to reload the bend table first  (press the green arrow 
button), see To update the bend table set previously. After the reload the values from the 
bend table will be available. 

 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/Definitions.htm%23UpdateBendTable
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The Mechanical Browser for Sheet Metal 

All features of a sheet metal part are listed in the Mechanical Browser. 

When you select a feature in the Mechanical Browser, its faces are highlighted in the model area. 

  

  

  

The Mechanical Browser opens automatically when switching to the Sheet Metal or Mechanical 
workspace. 

To open the Mechanical Browser manually do the following: 

Move the cursor over a toolbar, then right click. 
A context menu displays: 
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Choose Mechanical Browser in the context menu.  

NOTE When you right click a feature in the browser, then select Dissolve from the context 
menu. the selected feature is removed from the part,  but it will keep its geometry. 
However, design intent (spatial and parametric relationships between the feature’s faces) 
associated with the geometry of a dissolved  feature is removed. 

 

Feature Colors 

For better experience and easy distinguishing between the features different colors are applied to 
the various features in the geometry. These colors are for visualization reasons only and will never 

show in generated documents, paper space views, block inserts, etc.  

The display of feature colors is controlled through the FEATURECOLORS system variable and a 
series of system variables, one for each feature color. Although the default feature colors are 
selected carefully to combine with each other, you can set them differently in the Sheet Metal 
settings group on the Settings dialog. 

  

bricscad-sysvar.chm::/00_07_Settings_Manager.htm
bricscad-sysvar.chm::/00_07_Settings_Manager.htm
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To toggle the display of feature colors: 

Click the Color Features tool button ( ) on the Sheet Metal toolbar. 

Click the Color Features tool button ( ) on the Sheet Metal ribbon bar. 

Choose Color Features in the Sheet Metal menu. 

Layer Properties of 2D Geometry 

The 2D geometry, generated by SMUNFOLD and SMEXPORT2D,  has different colors for contours, 
bend lines up, bend lines down, overall dimensions, form features up, form features down, bend 
annotations and attributes. 

Each entity type is placed on a dedicated layer of which the color is controlled trough a series of 
system variables: 

  

 

  

you can set the colors differently in the Sheet Metal/Layers for unfolding settings group on the 

Settings dialog. 

If the 2D geometry of a form feature was taken from library component, its properties are 
controlled by the properties of this component at the moment of insertion. If the 2D geometry was 
generated automatically, which is a case of unfolding of imported form features or library features 
when Unfolding Mode is set to Project or Contour. 

bricscad-cmdref.chm::/Mechanical/SmUnfold.htm
bricscad-cmdref.chm::/Mechanical/SmExport2d.htm
bricscad-sysvar.chm::/00_07_Settings_Manager.htm
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Managing Initial Parameters 

A set of initial parameters controls the default settings used by commands such as SmFlangeBase, 
SmExtrude, SmFlangeEdge, SmFlangeBend, SmLoft and SmConvert in a newly created model. The 
initial parameters are saved in the drawing, which allows to create a set of .dwt template drawings 
for each type of sheet metal models created in a company. 

  

 

bricscad-cmdref.chm::/SheetMetal/SmFlangeBase.htm
bricscad-cmdref.chm::/SheetMetal/SmExtrudehtm
bricscad-cmdref.chm::/SheetMetal/SmFlangeEdge.htm
bricscad-cmdref.chm::/SheetMetal/SmFlangeBend.htm
bricscad-cmdref.chm::/SheetMetal/SmLoft.htm
bricscad-cmdref.chm::/SheetMetal/SmConvert.htm
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Sheet Metal Operations 

Creating the Base Flange 

Start to design your sheet metal part with creating its base flange. To create a base flange, select 

a closed planar profile and call the SmFlangeBase command. 

Do one of the following: 

Click the Create Base Flange tool button ( ) on the Sheet Metal toolbar.  

Choose Create Base Flange  in the Sheet Metal menu.  

Choose Create Base Flange  in the Sheet Metal group of the Quad cursor menu:  

 

 

 

A base flange is a body created by extruding the selected profile to a height equal to the default 
value of the Thickness property of the sheet metal part 

To change the thickness of your sheet metal part, type the appropriate value in the Thickness field 
in the Mechanical Browser. 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/mechanical/Bricscad-CmdRef.chm::/Mechanical/SmFlangeBase.htm
file:///D:/BricsCAD%20Training/03_Drawing_Accurately/03_12_Quad.htm
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Creating Edge Flanges 

You can add an additional flange to your sheet metal part by pulling a linear edge of an existing 
flange. Select an edge and select the SmFlangeEdge command in the Sheet Metal section of the 
Quad cursor menu. 

Move your mouse pointer to define the desired length of the edge flange and the angle between 

two flanges. You can also use the corresponding dynamic dimensions to type the desired values.  

 

 

bricscad-cmdref.chm::/../mechanical/Mechanical/SmFlangeEdge.htm
file:///D:/BricsCAD%20Training/03_Drawing_Accurately/03_12_Quad.htm
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To create an edge flange of which the width is different from the width of the edge, select the 
Width option of SmFlangeEdge command and define offsets from both sides of the edge. 

 

bricscad-cmdref.chm::/../mechanical/Mechanical/SmFlangeEdge.htm
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Note that when you create an edge flange of different width, the corresponding bend reliefs are 
created automatically. 
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Creating Tapered Edge Flanges 

You can create trapezoidal edge flanges using Taper angle option of SmFlangeEdge  command: 

 

 

bricscad-cmdref.chm::/../mechanical/Mechanical/SmFlangeEdge.htm
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Creating Multiple Flanges 

You can create several flanges simultaneously.  

Do one of the following: 

Select multiple edges, then choose Create Flange Edge ( ) in the Sheet Metal command group in 
the Quad. 

Launch the SmFlangeEdge command and select multiple edges. 

 

Create the edges dynamically. 
Define the angle and the flange height using the dynamic entry fields. Hit the TAB-key to switch 
between the Angle and the Distance field. 

bricscad-cmdref.chm::/SheetMetal/SmFlangeEdge.htm


BricsCAD V18  Help 

 

 783 

 

 

Select the inside edges of the newly created flanges: 

 

 

Create the flanges. The command creates self-intersecting of the flanges and depending on the 
bend angle creates junction or miter features.  
At 90 degrees miters are created: 
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For other angles junctions are created: 

 

 
 

In all cases material conflicts are avoided: 
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To Bend a Sheet Metal Body 

The SmFlangeBend command allows to bend a sheet metal body using a line. You can either draw 
the line first, then start the command or us the New Line option of the command. 

To bend multiple flanges simultaneously 

Do one of the following: 

Click the Bend tool button ( ) on the Sheet Metal toolbar. 

Choose Bend > Flange Bend in the Sheet Metal menu. 

Choose Create Bend ( ) in the Modify panel of the Sheet Metal tab in the ribbon. 

Hover over the flange you want to bend and choose  Bend Flange in the Sheet Metal 
command group in the Quad. 

You are prompted: Select a flange face: 

Select the flange you wan to bend. 
You are prompted: Select line or edge to bend the solid or draw a [New line] <New line>: 

Do one of the following: 

Select a line that overlaps the flanges to be included in the bend. 

Choose the New Line option. 
You are prompted to pick two points to define the line. 
Draw a line on top of the flanges to be included in the bend. 

You are prompted: Pick a point on the side that will be moved: 

  

bricscad-cmdref.chm::/SheetMetal/SmFlangeBend.htm
file:///D:/BricsCAD%20Training/03_Drawing_Accurately/03_12_Quad.htm
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Pick a point at the side of the line you want to move. 
The selected part is bent dynamically. 
You are prompted: Enter bend angle or set [Radius/Switch side]: 
  

Do one of the following: 

Type a value to define the bend angle, using the default bend radius..  

Select the Radius option.  

You are prompted: Enter bend radius [Back] <Back>: 
Type a value to override the default bend radius and press Enter. 
You are promted: Enter bend angle or set [Radius/Switch side]: 
Type a value to define the bend angle.  
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Corner Relief and Junctions 

When you pull an edge of a flange that is adjacent to a bend edge to create a new flange with 
SmFlangeEdge command, a corner relief is created automatically in the corner where three flanges 
meet together: 

This operation also creates a junction between two flanges, which are not connected with a bend. 

   

  

   

To Rotate a Flange 

You can rotate a flange with DmRotate command ( ) , however, you will usually obtain a better 

result with SmFlangeRotate ( ). This command automatically selects the rotation axis to respect 
the design intent of your sheet metal part. 

Do one of the following:  

Click the Rotate Flange tool button ( ) on the Sheet Metal toolbar.  

Choose Rotate Flange in the Sheet Metal menu.  

Type smflangerotate in the command bar, then press Enter.  

You are prompted: Select a flange face to rotate: 

Flange faces highlight under the cursor. 

Click to select a flange face. 

The flange rotates dynamically. 
A dynamic dimension shows the current angle with respect to the base flange.  

Do one of the following:  

Select a point.  

Type a value in the dynamic dimension field.  

Press the TAB key, then specify the absolute rotation angle in the dynamic dimension field.  

  

NOTE If you apply DmRotate command to a flange, which is connected with other flanges via 
junction features, these features are automatically dissolved before the rotation. 

  

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/mechanical/Bricscad-CmdRef.chm::/DirectModeling/dmRotate.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/mechanical/Bricscad-CmdRef.chm::/Mechanical/SmFlangeRotate.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/mechanical/Bricscad-CmdRef.chm::/DirectModeling/dmRotate.htm
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Creating Lofted Bends 

Launch the SmLoft command. 
Do one of the following: 

Click the Create Lofted Bend tool button ( ) on the Sheet Metal toolbar. 

Click the Create Lofted Bend tool button ( ) on the Sheet Metal ribbon bar. 

Choose Create Sheet Metal Loft in the Sheet Metal menu. 

You are prompted: Select two cross sections: 

Select two profile entities. 

 

 
 
You are prompted: Set fillets Radius/Thickness/Single bend/<Flanges with bends> 

Press Enter to accept the default settings. 
A preview of the sheet metal part is created. 
You are prompted: Set fillets Radius/Thickness/Single bend/Flanges with bends or make thicken 
Both sides/Inside/<Outside>:  

 

bricscad-cmdref.chm::/SheetMetal/SmLoft.htm
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Hit the Ctrl-key to choose the position of the sheet metal part thickness with respect to the source 
profiles: Left, Center or Right. 
If TIPS = ON the tips widget displays. 

Press Enter to create the sheet metal part. 

 

 
 

If FEATURECOLORS = ON, you can distinguish between the two flanges ( ) and the lofted bend 

( ). 

The properties of the lofted bend display in the Mechanical Browser: 

file:///D:/BricsCAD%20Training/01_User_Interface/01_00_The_Bricscad_Application_Window.htm%23Tips:
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/Definitions.htm%23FeatureColors
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/Definitions.htm%23SM_MechanicalBorwser
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Optionally select the lofted bend feature to edit its properties: 

Number of subdivisions: the number of flat regions in the unfolded representation of a lofted bend 
feature (the greater the number, the more bend lines will be added to the unfolded view for the 
lofted bend).  

Force triangulation: lots of lofted bends can be unfolded using an intelligent algorithm of quad 
tessellation; however sometimes  it might produce non-optimal results. In such cases set this 

property to Yes.  

Converting Geometry to Sheet Metal 

You can create a sheet metal part from any existing 3D solid geometry, created in BricsCAD or 
imported from another CAD system. However, the geometry might be incorrect as a sheet metal 

model:missing bends and reliefs or thickness faces which are not orthogonal to the flange faces. 
BricsCAD Sheet Metal contains a dedicated toolset to convert such geometry to a valid sheet metal 
part and add all missing sheet metal features. 

Launch the SmConvert command. 
Do one of the following: 

Click the Convert to Sheet Metal  tool button ( ) on the Sheet Metal toolbar. 

Click the Convert to Sheet Metal tool button ( ) on the Sheet Metal ribbon bar. 

Choose Convert to Sheet Metal in the Sheet Metal menu. 

You are prompted: Select 3D solids/<Entire model>:  

Select the 3D solid to convert. 
You are prompted: Select 3D solids/<Entire model>:  

Press Enter to convert the 3D solid to sheet metal part. 
The properties of the sheet metal part display in the Mechanical Browser. 

 

NOTE Converted bodies can be unfolded or exported to .dxf or .osm file formats for processing 
by a CAM system.  

In some cases it might be necessary to fix converted bodies before unfolding/exporting: 

Create missing reliefs: SmReliefCreate command. 

Convert hard edges to bends or junctions: SmBendCreate and  SmJunctionCreate 
commands. 

Split flanges: SmFlangeSplit command. 

Repair sheet metal bodies: SmRepair command. 

 

bricscad-cmdref.chm::/SheetMetal/SmConvert.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/Definitions.htm%23SM_MechanicalBorwser
bricscad-cmdref.chm::/SheetMetal/SmReliefCreate.htm
bricscad-cmdref.chm::/SheetMetal/SmBendCreate.htm
bricscad-cmdref.chm::/SheetMetal/SmJunctionCreate.htm
bricscad-cmdref.chm::/SheetMetal/SmFlangeSplit.htm
bricscad-cmdref.chm::/SheetMetal/SmRepair.htm
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To Connect Flanges 

The SmFlangeConnect command closes gaps between two arbitrarily oriented flanges. 

Do one of the following:  

Click the Connect Flanges tool button ( ) on the Sheet Metal toolbar.  

Choose Connect Flanges in the Sheet Metal menu.  

Type smflangeconnect in the command bar, then press Enter.  

You are prompted: Select planar thickness faces of two flanges: 

Flange faces highlight under the cursor. 

Select the thickness face of the first flange. 
You are prompted: 
Entities/subentities in set: 1 
Select planar thickness faces of two flanges:  

Select the thickness face of the second flange. 

The selected thickness faces are connected.  

To Create Missing Reliefs 

Do one of the following:  

Click the Create Relief tool button ( ) on the Sheet Metal ribbon tab  

Choose Create Relief in the Sheet Metal menu  

Type smreliefcreate in the command bar  

You are prompted: Select a hard edge or bend face, flange face, 3D solid / <Entire model>: 

Select an item (see the note below) 
Enter relief size by bend radius ratio <1.0>:  

Do one of the following:  

Press Enter or right click to accept the 1.0 bend radius ratio.  

Type a value at the command prompt, then press Enter.  

The relief is created. 

  

 

 

Selected bend faces Created reliefs 

  

NOTE The selected items can be a 3D solid with sheet metal features, a face or a hard edge of 
the solid.  

To create a relief locally, you can select one or two hard edges, one or two bends or a 
bend and a hard edge.  

If a 3D solid is selected the command recognizes the places where corner or bend reliefs 

are needed and creates them automatically.  

If two hard edges or two bends or a bend and a hard edge at a corner are selected, the 
command tries to create a corner relief. 

 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/mechanical/Bricscad-CmdRef.chm::/Mechanical/SmFlangeConnect.htm
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Switching the Bend Relief Type 

The bend relief type can be switched between four types: 

  

 

 

 

 

Rectangular Smooth Round   Rip 

  

NOTES Rip relief has a very small width set to 0.001 * thickness. If you need to remove the 
relief completely, change its width to 0. This operation removes both the bend relief 

geometry and the bend relief feature. 

Smooth, Round and Rip bend relief types can be applied only if the current bend relief 
type is Rectangular. 

Using the ribbon, menu or toolbar 
To choose the desired relief type, do one of the following: 

Click the Relief drop down button in Sheet Metal / Modify panel on the ribbon and select 
Switch to Rectangular, Switch to Smooth, Switch to Round or Switch to Rip. 

Click a tool button on the Relief toolbar:  Switch to Rectangular Relief ( ), Switch to 

Smoot Relief ( ), Switch to Round Relief  ( ) or Switch to Rip Relief ( ). 

Choose the relief type in the Sheet Metal / Relief menu. 

You are prompted: Select face(s), 3d solid(s) to switch relief(s) to Rectangular 
[RECtangular/CIrcular/V-type/SMooth/RIp/ROund/Entire model] <Entire model>: 

Do one of the following: 

Press Enter to apply the selected relief type to the entire model. 

Click a neighboring flange or bend or a face of the bend relief. 
The bend relief is converted. 

You are prompted: Select face(s), 3d solid(s) to switch relief(s) to Rectangular 
[RECtangular/CIrcular/V-type/SMooth/RIp/ROund/Entire model] <Entire model>: 

Do one of the following: 

Click a neighboring flange or a face of another bend relief. 

Press Enter to apply the selected bend relief to the entire model. 

Press the Esc-key to stop. 
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Using the Quad 

Hover over neighboring flange or bend or a face of the bend relief. 
If the Select Faces option of the SELECTIONMODES system variable is selected, the flange 
or face highlights; otherwise hold the Ctrl-key down when hovering until the face 

highlights. 

Select the desired relief type in Sheet Metal command group in the Quad. 
 

 

Switching the Corner Relief Type 

The corner relief type can be switched between three types: 

  

   

Rectangular Circular V-type 

  

Using the ribbon, menu or toolbar: 
 

To choose the desired relief type, do one of the following: 

Click the Relief drop down button in Sheet Metal / Modify panel on the ribbon and select 
Switch to Circular, Switch to Rectangular or Switch to V-Type. 

Click a tool button on the Relief toolbar: Switch to Circular Relief ( ), Switch to 

Rectangular Relief ( ) or Switch to V-Type Relief ( ). 

Choose the relief type in the Sheet Metal / Relief menu. 

You are prompted: Select face(s), 3d solid(s) to switch relief(s) to circular 
[RECtangular/CIrcular/V-type/SMooth/RIp/ROund/SEttings/Entire model] <Entire model>: 

Do one of the following: 

Press Enter to apply the selected relief type to the entire model. 

Click a neighboring flange or bend or a face of the corner relief. 

The corner relief is converted. 

You are prompted: Select face(s), 3d solid(s) to switch relief(s) to circular 
[RECtangular/CIrcular/V-type/SMooth/RIp/ROund/SEttings/Entire model] <Entire model>: 

Do one of the following: 

Click a neighboring flange or a face of another corner relief. 

Press Enter to apply the selected corner relief to the entire model. 

Press the Esc-key to stop. 

bricscad-sysvar.chm::/00_07_Settings_Manager.htm
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Using the Quad: 
 

Make sure the Select Faces option of the SELECTIONMODES system variable is selected. 

Hover over neighboring flange or bend or a face of the corner relief. 

Select the desired relief type in Sheet Metal command group in the Quad. 

 

Converting hard edges to bends or junctions 

If adjacent flanges of a sheet metal part are not connected by a bend or junction, the part cannot 
be unfolded or exported to a CAM system. To fix this, each hard edge between adjacent flanges 
must be converted to a bend or a junction. 

Converting Hard Edges to Bends 
Do one of the following:  

Hover the mouse cursor over a hard edge and click the Create Bend ( ) tool in the Quad 
menu  

Click the Create Bend ( ) tool buttons in the Sheet Metal ribbon tab  

Choose  Create Bend in the Sheet Metal menu  

Type smbendcreate or the command bar.  

You are prompted: Select flange faces or hard edges: 

Select a flange face or a hard edge. 
You are prompted: 
Entities in set: 1 
Select flange faces or hard edges:  

Do one of the following:  

Select more faces or hard edges.  

Right click or press Enter to create the bends or junctions on the selected items.  

 

 

Selected hard edge Created bend 

  

bricscad-sysvar.chm::/00_07_Settings_Manager.htm
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Converting Hard Edges to Junctions 
Do one of the following:  

Hover the mouse cursor over a hard edge and click the Create Junction ( ) tool in the 
Quad menu  

Click the Create Junction ( ) tool buttons in the Sheet Metal ribbon tab  

Choose Create Junction in the Sheet Metal menu  

Type smjunctioncreate in the command bar.  

You are prompted: Select flange faces or hard edges: 

Select a flange face or a hard edge. 
You are prompted: 
Entities in set: 1 
Select flange faces or hard edges:  

Do one of the following:  

Select more faces or hard edges.  

Right click or press Enter to create the bends or junctions on the selected items.  

  

  

Selected hard edges Created junctions 

  

To Split a Flange 

In some cases a flange is better split to minimize the material consumption, e.g. when a flange has 
a large hole like on the image below: 
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Do one of the following:  

Click the Split Flange tool ( ) on the Sheet Metal ribbon tab 

Choose Split Flange in the Sheet Metal menu 

Type smflangesplit in the command bar 

You are prompted: Select a flange face: 

Select a flange face. 
You are prompted: Select lines, edges to split the flange or [use SMart split/draw a New 

line/Settings] <draw a New line>:  

If no line exists yet on the flange face, right click. 
You are prompted: Start point of the line:  

Specify the start point of the line. 
You are prompted: End point of the line:  

Specify the endpoint of the line: 

You are prompted: Make split Center/Left/Right/<Accept model>:  

To adjust the position of cut in relation to the line, do one of the following:  

Hit the Ctrl-key to toggle the Center/Left/Right options. 
If TIPS is ON the currently selected option is indicated in the Tips Widget. 

Select Center,  Left or Right in the Prompt Menu. 

Type an option in the command bar, then press Enter. 
 

 

The flange is cut by the line. 

Smart Tools to Split a Flange 

The scenario below illustrates the other capabilities of the SmFlangeSplit command:  

Smart split by selecting a single vertex in the corner.  

Split of the bend and conversion of its part adjacent to the corner into the junction. 

 

file:///D:/BricsCAD%20Training/01_User_Interface/01_00_The_Bricscad_Application_Window.htm%23Tips:
bricscad-cmdref.chm::/SheetMetal/SmFlangeSplit.htm
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Do one of the following: 

Click the Use Smart Split Flange tool (  ) on the Sheet Metal ribbon tab 

Choose Use Smart Split Flange in the Sheet Metal menu 

Type smflangesplit in the command bar 

You are prompted: Select a flange face: 

Select a flange face. 

You are prompted: Select lines, edges to split the flange or [use SMart split/draw a New 
line/Settings] <draw a New line>: 

Select use the Use Smart split option and select a corner vertex: 
 

 
 
You are prompted: Make split [Center/Left/Right/Accept] <Accept>: 
Possible variants for selected vertex are:  
 

    
 
Note: The conversion of part of the bend into the junction is unrelated to the Smart Split mode. 

  

To adjust the position of cut in relation to the line, do one of the following: 

Hit the Ctrl-key to toggle the Center/Left/Right options. 
If TIPS is ON the currently selected option is indicated in the Tips Widget. 

Select Center, Left or Right in the Prompt Menu. 

file:///D:/BricsCAD%20Training/01_User_Interface/01_00_The_Bricscad_Application_Window.htm%23Tips:
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Type an option in the command bar, then press Enter. 

The flange is cut by the line, a bend is partially converted into the junction: 
 

 
 

  

To Split a Thickness Face 

In order to extend a flange which shares the same thickness face with other flanges, the thickness 
face needs to be split. 

Launch the SmImprint command ( ). 
Prompts you: Select a thickness face: 

bricscad-cmdref.chm::/SheetMetal/SmImprint.htm
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Select the shared thickness face. 

 

 

Right click or press Enter to split the face. 
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The flanges can now be extended separately: 

 

 

Execute the DmSimplify command to remove the unneeded splits, thus unifying the coplanar 

thickness faces. 

To Repair a Sheet Metal Part 

A Sheet metal part may have inaccuracies in geometry and topology or sheet metal design issues, 
which is often the case for imported parts designed in geometrical kernels different from ACIS.  

Examples of such problems are:  

thickness faces, which are not perpendicular to the flange/bend faces;  

lofted bends are not-tangential to the adjacent flanges/bends;  

wrong bends;  

general ACIS issues.  

Such problems can prevent editing operations from being executed successfully.   

The recommended workflow to fix such problems is: 

Execute the DMAUDIT command  to fix general modeling issues. 

Execute the SMREPAIR command. 

To Repair a Sheet Metal Body 

If a sheet metal body has thickness faces, which are not perpendicular to the flange/bend faces, 
such a part cannot be correctly manufactured from a sheet of metal using traditional tools.  

Do one of the following:  

Click the Repair Sheet Metal tool ( ) on the Heal panel of the Sheet Metal ribbon tab 

Click the Repair Sheet Metal tool ( ) on the Sheet Metal toolbar. 

Choose Repair Sheet Metal in the Sheet Metal menu. 

Type smrepair in the command bar. 

You are prompted:  Select a face to repair: 

Select the face to be repaired.  

bricscad-cmdref.chm::/DirectModeling/dmSimplify.htm
bricscad-cmdref.chm::/DirectModeling/dmAudit.htm
bricscad-cmdref.chm::/SheetMetal/SmRepair.htm
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The same model before ... ... and after applying a repair operation: 

  

If model has wrong bends SmRepair transforms them to regular bends: 

  

  

Wrong bends, which have a non-
tangential connection with the  flanges. 

Correct bends after repairing. 

  

Form features are translated to the new repaired model: 

  

  

model before repairing form feature has not changed while hole, 
which is not a form feature, is 

orthogonalized 
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To Repair a Sheet Metal Body with Lofted Bends 

Do one of the following: 

Click the Repair Sheet Metal tool ( ) on the Heal panel of the Sheet Metal ribbon tab 

Click the Repair Sheet Metal tool ( ) on the Sheet Metal toolbar. 

Choose Repair Sheet Metal in the Sheet Metal menu. 

Type smrepair in the command bar. 

The command bar reads:  Select a face to repair. 

Select a face of a flange, bend or lofted bend. The selected face generates the surface to be 

thickened. 

 

 

Before: the lofted bend is not tangent to 
the flange. Unfolding is impossible. 

After: notice the difference in the 
connection of the blue lofted bend with the 

top flange, which is smooth now. Unfolding 
is possible. 

  

Option: The Merge lofted bends option in the SmRepair command allows to merge adjacent lofted 
bend into one. 

Changing the Thickness 

To change the thickness of a sheet metal part: 

Select the root node in the Mechanical Browser.  

Type a value in the Thickness field.  

bricscad-cmdref.chm::/SheetMetal/SmRepair.htm


BricsCAD V18  Help 

 

 803 

 

To change the overall bend radius: 

Select the root node in the Mechanical Browser.  

Find the Bend radius group in the bottom part of the Mechanical Browser.  

Do one of the following:  

Set Type to Absolute Value, then type the radius value in the Value field. 
The Bend Radius field changes accordingly.  

Set Type to Thickness ratio, then type a value in the Value field. 

The Bend Radius field is calculated as the product of the Thickness and the Thickness 
ratio.  

To change the bend radius for a particular bend: 

Select the bend node in the Mechanical Browser. 
The selected bend highlights in the model. 

The Bend Properties display in the bottom part of the Mechanical Browser.  

Do one of the following:  

Set  the Type to Global value. 
The current global bend radius is applied to the selected bend.  

Set  the Type to Absolute value, then type the radius value in the Value field. 
The Bend Radius field changes accordingly.  

Set the Type to Thickness Ratio and type a value in the value field.  

The Bend Radius field is calculated as the product of the Thickness and the Thickness 
ratio.  
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Changing the Junction Gap 

To change the overall junction gap: 
Select the root node in the Mechanical Browser.  

Find the junction gap group in the bottom part of the Mechanical Browser.  

Do one of the following:  

Set Type to Absolute Value, then type the gap value in the Value field. 
The junction gap field changes accordingly.  

Set Type to Thickness ratio, then type a value in the Value field. 
The junction gap field is calculated as the product of the Thickness and the Thickness 
ratio.  

To change the junction gap for a particular bend: 
Select the bend node in the Mechanical Browser. 
The selected bend highlights in the model. 

The Bend Properties display in the bottom part of the Mechanical Browser.  

Do one of the following:  

Set  the Type to Global value. 
The current global junction gap is applied to the selected bend.  

Set  the Type to Absolute value, then type the gap value in the Value field. 
The junction gap field changes accordingly.  

Set the Type to Thickness Ratio and type a value in the value field.  
The junction gap field is calculated as the product of the Thickness and the Thickness 
ratio.  

Changing the Junction Type 

By default, BricsCAD creates symmetric junctions, as shown in the image below: 

 

  

The SmJunctionSwitch command allows changing a symmetrical junction feature to one with 
overlapping faces. 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/mechanical/Bricscad-CmdRef.chm::/Mechanical/SmJunctionSwitch.htm


BricsCAD V18  Help 

 

 805 

To change the junction type using the Quad: 
 

Hover the cursor over one the thickness faces of this junction,  

Select Switch Junction Type in the Sheet Metal command group in the Quad. 
 

 
 
The selected thickness face is aligned with the flange face. 
 

 

 

To change the junction type in the Mechanical Browser 
Method 1: 

Select the corresponding junction in the tree. 
The junction properties display in the bottom part of the Mechanical Browser. 

Select the Connection type property. 

Choose the desired junction type.  
The options are: Symmetric, Aligned to Flange_X or Aligned to Flange_Y. 
 



  User Guide 

 806 

 
 

The junction is updated accordingly. 

Method 2: 

Select the corresponding junction in the tree. 
A context menu displays: 

 

 

Right click and choose Switch type of feature in the context menu. 

 

NOTE Both symmetric and aligned junctions maintain the same gap value between connected 

flanges. 

  

To Unfold the Sheet Metal Body 

To unfold your sheet metal body, select a start flange face and run the SmUnfold command. 
BricsCAD will automatically create a solid body corresponding to a flat sheet of metal needed to 

manufacture your sheet metal part using bending techniques. This sheet is placed on XY-plane and 
is oriented along the coordinate axes similarly to the orientation of the initial body in 3D space. To 
change the orientation of the unfolding in OZ axis, run SmUnfold command again and select the 
opposite face of the initial body.  

By default, form features are unfolded according to the value of the 
SMFORMFEATUREUNFOLDMODE system variable. 

The options are: 

Keep (0): allows to keep form features geometry on the unfolded representation 

  

 

 

3D model and unfolded body 2D 

 

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/mechanical/Bricscad-CmdRef.chm::/Mechanical/SmUnfold%20.htm
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Remove (1): allows to remove form features geometry from the unfolded representation  

  

 

 

3D model and unfolded body 2D 

Project (2): generates a form feature symbol by projecting the form feature edges on the flange 

plane 
  

 

 

3D model and unfolded body 2D 

Contour (3): generates a form feature symbol by projecting an external contour and holes of the 
form feature on the flange plane 

  

 

 

3D model and unfolded body 2D 

Symbol (4): copies the unfold symbol on  layer UNFOLD_SYMBOL_UP or layer 
UNFOLD_SYMBOL_DOWN depending on the form feature direction) to the unfolded representation  
  

 

 

3D model and unfolded body 2D 
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The unfold mode for current document can be set in Mechanical Browser or by selecting the 
appropriate option in the SmUnfold command: 

You are prompted: 

  

Select a flange or lofted bend face to start unfolding [Settings]: (type Settings) 

Select [lofted bend Tolerance/Form feature behaviour] <Form feature behaviour>: (type Form or 
press Enter) 

Select form feature behaviour [Keep/Remove/Project/Contour/Symbol] <Symbol>: (select 
required mode of form feature unfolding) 

  

The SmUnfold command prompts you to either: 

Keep the 3D solid in the model. 

Save the 3D solid in a separate drawing file. 

Convert the solid to a 2D drawing file (*.dwg or *.dxf) 

Overall dimension and bending annotations for manufacturing  are added to the exported drawing 
automatically. 

The SmUnfold command takes the deformation of the sheet metal material during bending into 
account. When a flat sheet of metal is bent into a 3D part with a bending tool (like a press break), 

the material is plastically deformed, it is compressed inside the bend and stretched outside of it. 
So the length of the part measured along its surface is different in flat and bend states. BricsCAD is 
able to automatically compute the proper unfolded length of your part based on the material 
deformation properties. These properties can be defined by setting the value of K-Factor parameter 
or by attaching a bend table. 

bricscad-cmdref.chm::/SheetMetal/SmUnfold.htm
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To Export the Sheet Metal Body 

Sheet metal parts created or edited in BricsCAD can be then processed by different CAM systems 
(such as JETCAM or CADMAN-B) to generate NC code for cutting and bending machines. 

The SMTARGETCAM system variable controls options in the SmUnfold command which customizes 
the .dxf file to be compatible with list of popular CAM systems. 

The SmExport2d command exports the unfolded representation of a sheet metal body as a 2D 
profile in .dxf / .dwg file format. 

The SmExportOSM command exports a sheet metal solid to the .osm (Open Sheet Metal) file 
format (native for CADMAN-B CAM system). 

To Export an Sheet Metal Assembly to DXF 
The SmAssemblyExport command automatically traverses the assembly tree and for each 3D solid 

tries to recognize sheet metal design and export it to .dxf. As a result a set of .dxf files sorted by 
thickness in different subfolders is created in the output folder. A HTML report generated by the 

command allows to control the results in clear way. Using this command most of the sheet metal 
parts are processed automatically, a minor number of poor sheet metal parts are detected and 
indicated by the command for manual rework. 

bricscad-sysvar.chm::/00_07_Settings_Manager.htm
bricscad-cmdref.chm::/SheetMetal/SmUnfold.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/mechanical/Bricscad-CmdRef.chm::/Mechanical/SmExport2d.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/mechanical/Bricscad-CmdRef.chm::/Mechanical/SmExportOSM.htm
bricscad-cmdref.chm::/SheetMetal/SmAssemblyExport.htm
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Working with Form Features 

Commands: SMFORM, SMCONVERT, SMREPLACE, SMRIBCREATE, BMINSERT 

  

SmForm: converts a selected set of faces to a form feature. A drawing file with a user-defined 

form feature can be saved and then inserted using the BMINSERT command. 

SmConvert: recognizes form features in imported geometry. 

SmReplace: allows replacing form features (including recognized ones) in sheet metal parts with 
form features from the built-in or user library. 

SmRibcreate: creates associative Rib form features on sheet metal parts from 2D profiles. The 
feature is updated automatically when its defining profile is changed. 

BmInsert: inserts an existing mechanical component  or sheet metal form feature into the current 
drawing. 

  

Form features a kind of sheet metal features, corresponding to the result of application of a 
forming tool to a sheet. Form features can be recognized in imported geometry or inserted from 
built-in or user-defined libraries. Form features can be edited directly and parametrically. Form 
features are listed in the Mechanical browser with their parameters. Parameters of form features 

are also displayed and can be edited in the Properties bar upon selection of one or several faces of 
one or several form features. 

A library of parametrized sheet metal form features has been added. It is available from the Form 
Features tab of the Tool Pallettes panel. The library contains most commonly used form feature 
types. To insert a form feature to a sheet metal 3D solid drag the form feature icon from the Tool 
Palettes panel  to a flange of the solid. 

A library of parametrized sheet metal form features has been added. It is available from the Form 

Features tab on the Tool Palettes panel. The library contains most commonly used form feature 
types. To insert a form feature to a sheet metal 3D solid drag the form feature icon from the Tool 

Palettes panel to a flange of the solid. 

  

SMFORMFEATUREUNFOLDMODE: system variable controls the appearance of the form features in 
2D and 3D unfolded model representations. 

To Insert a Form Feature 

Form features are added to sheet metal part by insertion on the existing flanges. The form 
features can be inserted by means of BmInsert command or by drag-and-drop process of required 
form feature from Form Features tab of Tool Palettes. 

Make sure Dynamic Dimensions (DYN) and Dynamic UCS (DUCS) are active. 

Do one of the following: 

Click the Form Feature tool button (  ) on the Sheet Metal toolbar. 

Click the Form Feature tool button ( ) on the Sheet Metal ribbon bar. 

Choose Insert Form Feature  in the Sheet Metal  menu. 

Type bminsert in the command bar, then press Enter. 

The Select file to insert dialog displays the FormFeatures folder 
C:\Users\<UserName>\AppData\Roaming\Bricsys\BricsCAD\V17x64\en_US\Support\DesignLibra
ry\SheetMetal\FormFeatures: 
 

bricscad-cmdref.chm::/SheetMetal/SmForm.htm
bricscad-cmdref.chm::/SheetMetal/SmConvert.htm
bricscad-cmdref.chm::/SheetMetal/SmReplace.htm
bricscad-cmdref.chm::/SheetMetal/SmRibCreate.htm
bricscad-cmdref.chm::/Mechanical/BmInsert.htm
bricscad-cmdref.chm::/Mechanical/BmInsert.htm
bricscad-cmdref.chm::/T/ToolPalettes.htm
bricscad-sysvar.chm::/00_07_Settings_Manager.htm
file:///D:/BricsCAD%20Training/03_Drawing_Accurately/03_11_Dynamic_Dimensions.htm
file:///D:/BricsCAD%20Training/03_Drawing_Accurately/03_07_User_Coordinate_Systems.htm%23DynUCS
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Select the desired form feature element from file list, then double click or press the Open button. 

Select the form feature on the Form Features tab of the Tool Palettes panel:  

 

Move the cursor over the flange face you want to insert the feature in.  
The dynamic UCS aligns to the selected face. 
The orientation of the UCS depends on the edge you enter the face. 

Dynamic dimensions display from the origin of the UCS to the insertion point of the form feature. 

The command bar reads:  Select insertion point or [Edit inserted entity/Rotate component/set Base 
point/Name/insertion Type/Flip/mUltiple] <0, 0, 0>: 

file:///D:/BricsCAD%20Training/02_Defining_your_preferences/02_05_Toolpalettes.htm
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(option) Choose an option (see the BmInsert command for more details): 

Edit: Allows to edit the parameters of the selected insert.  

Rotate: Allows to define the rotation angle of the component.  

Base Point: Allows to specify a different base point to insert the component.  

Name: Allows to define the insert name of the component.  

Insertion Type: Allows to specify the insertion type: Local or External  

Flip: Inserts the form feature in the opposite face of the flange.  

Multiple: Allows to insert multiple inserts of the same component or create an array.  

To insert a the form feature do one of the following: 

Specify a point.  

Type a distance in the dynamic dimension fields. Hit the TAB key to go back and forth between the 
entry fields.  

Repeat step 5 to insert another copy or press Enter to stop. 

Editing the Parameters of a Library Form Feature 

Form features in the form feature library are parametric components. Several parameters control 
their dimensions. Parameters to control the Length, Width, Height and Radius of the form feature 
are correspondingly named L, W, H and R. The thickness of the form feature is set equal to the 
 thickness of sheet metal part automatically. 

The parameters of a single form feature can be edited either in the Properties Bar or in the 

Mechanical Browser. Parameters of multiple form features can be edited in the Properties Bar only. 

 

Methods to select form features 

Check the Select Faces option of the SELECTIONMODES system variable, then click the feature(s) 
in the model. 

Select the feature(s) in the  Mechanical Browser, then press the space bar or right click and choose 

Select in the context menu. Press and hold the Ctrl-key to select multiple form features. 

A sheet metal part can have lots of different form features, which might complicate operations 
such as deletion or replacement, especially if only a selection of features, that meet certain 
conditions, need to be processed. In order to help you to select form features more easily, the 
SmSelect command allows to select form features that are either identical to a selected feature or 
similar. 

bricscad-cmdref.chm::/Mechanical/BmInsert.htm
file:///D:/BricsCAD%20Training/01_User_Interface/00_06_Properties_Bar.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Mechanical/Mechanical_Browser.htm
bricscad-sysvar.chm::/00_07_Settings_Manager.htm
file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Mechanical/Mechanical_Browser.htm
bricscad-cmdref.chm::/SheetMetal/SmSelect.htm
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Editing parameters in the Properties Bar 

Select the form feature(s). 

Select a parameter in the Parameters node in the Properties Bar. 
 

 
  

file:///D:/BricsCAD%20Training/manuals/BricsCAD_V18_Help/Source/SheetMetal_FormFeatures.htm%23SelectFormFeatures
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Editing parameters in the Mechanical Browser 

Select the form feature in Form node of the component structure tree. 
 

 

Select a parameters in the lower panel of the Mechancial Browser and type a new value. 
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Creating a Custom Form Feature 

Open a new drawing using Mechanical-metric.dwt as the template. 

Create the 3D geometry of the form feature. 
 

 

Execute the SmConvert ( ) command. 

Exectute the BmMech ( ) command. 
You are prompted: Name for mechanical component <Component_2>: 

Type a name for the form feature. 

You are promted: Convert blocks and external references to mechanical components? [Yes/No] 
<Yes>: 

Select the No option. 

In the Extension type field in Mechanical Browser select Sheet Metal Form Feature.  
 

 

bricscad-cmdref.chm::/SheetMetal/SmConvert.htm
bricscad-cmdref.chm::/Mechanical/BmMech.htm
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Select the Flange_1 and Form_1 features in the Bodies node, then right click and select Disable in 

the context menu. 
 

 

Create 2 new layers: UNFOLD_SYMBOL_UP and UNFOLD_SYMBOL_DOWN. 

Turn layers 0 and UNFOLD_SYMBOL_DOWN Off and set layer UNFOLD_SYMBOL_UP Current. 

Create the unfold symbol, which will be placed on the face the form feature is placed in. 
 

 

Turn off the UNFOLD_SYMBOL_UP layer and turn on the UNFOLD_SYMBOL_DOWN layer. Set the 
UNFOLD_SYMBOL_DOWN layer current. 

Create the unfold symbol, which will be placed on the opposite face the form feature is placed in. 

 

 

bricscad-cmdref.chm::/L/Layer/Layer.htm#New
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Turn on layer 0 and turn the UNFOLD_SYMBOL_UP and UNFOLD_SYMBOL_DOWN layers off. Set 

layer 0 current. 

Save the drawing. 

Creating a Custom Parametric form Feature 

We will now parametrize the custom form feature we created in the previous procedure.  

Two parameters are needed here: D for diameter of the bigger edge of the conical hole and A for 
angle of the face of the conical hole. In Sheet Metal we have a parameter _SM_THICKNESS which 
is equal to the thickness of the sheet metal part.  

  

We will first create an auxiliary body for constraining on a new CONSTRUCTION layer. Make this 
layer current and switch off all other layers. 

Create a Region on the CONSTRUCTION layer in the XY plane of the WCS. 

 

 

Apply a DmFix3D constraint ( ) to the region. 
 

 

Switch on layer 0. 

Apply a DmCoincident3D constraint ( ) between the region face and the flange top face. 
 

bricscad-cmdref.chm::/R/region.htm
bricscad-cmdref.chm::/DirectModeling/dmFix3d.htm
bricscad-cmdref.chm::/DirectModeling/dmCoincident3d.htm
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Apply a DmDistance3D constraint (  ) between the  flange top and bottom faces.  
First select the top face, then hit the TAB key to select the bottom face. 
Accept the default value in the dynamic dimension. 

bricscad-cmdref.chm::/DirectModeling/dmDistance3d.htm
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Type _SM_THICKNESS in the Expression field of the Distance_3 constraint. 

 

 

Since our Form Feature is conical we can modify the flange from parallelepiped to cylinder 
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In the Mechanical Browser right click the feature name and select Add new parameter in the 

context menu. 
Rename new parameter to D . 
Select mm for the Units field. 
Type 16 in the Expression field. 
 

 

Apply a DmRadius3D constraint (  ) to the top edge of the conical face. Accept the default value 
in the dynamic dimension. 

bricscad-cmdref.chm::/DirectModeling/dmRadius3d.htm
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Type D/2 in the Expression field of the Radius_5 constraint. 

 

 

In the Mechanical Browser right click the feature name and select Add new parameter in the 
context menu. 
Rename new parameter to A . 
Leave the Units field empty. 
Type 45 in the Expression field. 

Do one of the following to create a Cone Angle constraint to the conical face: 

Launch the DmAngle3d command ( ), then choose the Cone Angle constraint option, then select 
the conical face. 

Hover over the conical face, then choose Cone Angle constraint ( ) in the Constraints command 
group in the Quad. 

Accept the default value. 

bricscad-cmdref.chm::/DirectModeling/dmAngle3d.htm


  User Guide 

 822 

Type A in the Expression field of the ObjectAngle_6 constraint. 

 

 

Since our Form Feature is conical we will modify the flange from parallelepiped to cylinder: 

Draw a circle on top or the flange. The radius of the circle is 9 mm. 

Select Enable Boundary Detection in the Settings panel on the Home tab in the Ribbon. 

Place the cursor over the area between the circle and the square edge of the flange, then choose 

Extrude ( ) in the Quad and move the cursor downwards. 
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Apply a DmConcentric3D constraint ( ) between the circular edge of the region and the 
cylindrical face. 
 

 

bricscad-cmdref.chm::/DirectModeling/dmConcentric3d.htm
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Apply a DmRadius3D constraint (  ) to the cylindrical face. Accept the default value in the 
dynamic dimension. 

Type D/2+0.1*_SM_THICKNESS in the Expression field of the Radius_8 constraint. 
 

 

Set the Exposed field of both parameter A and D On. 
 

 

We will now create 2D constraints for the unfold symbols. 

Make layer UNFOLD_SYMBOL_UP current and switch off all other layers. 

Apply a GcFix constraint ( ) to both crossing lines indicating the center of the circles. 

Apply a GcHorizontal constraint ( ) to the horizontal center line. 

Apply a GcVertical  constraint ( ) to the vertical center line. 

Apply a GcConcentric constraint ( ) between the two circles. 

bricscad-cmdref.chm::/DirectModeling/dmRadius3d.htm
bricscad-cmdref.chm::/G/GcFix.htm
bricscad-cmdref.chm::/G/GcHorizontal.htm
bricscad-cmdref.chm::/G/GcVertical.htm
bricscad-cmdref.chm::/G/GcHorizontal.htm
bricscad-cmdref.chm::/G/GcConcentric.htm
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Apply a DcLinear constraint ( ) between the endpoints of the center lines. Accept the default 
value. 

 

Apply a DcDiameter constraint ( ) to both circles. Accept the default value for dia1 (= inner 
circle) and dia2 (= outer circle) . 

 
  

Adjust the Expression fields of the 2D constraints as follows: 

d1 = 1 

d2 = d1 

dia 1 = D - 2*_SM_THICKNESS/tan(A) 

dia 2 = D 

bricscad-cmdref.chm::/D/DcLinear.htm
bricscad-cmdref.chm::/D/DcDiameter.htm
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Switch off the display of all layers, but layer 0, then save the file. 
 

 

  

The form feature can now be used to make conical parametric openings in a sheet metal flange: 

Use the Insert Form Feature tool ( ), which launches the BmInsert command. 

  

bricscad-cmdref.chm::/Mechanical/BmInsert.htm


BricsCAD V18  Help 

 

 827 

 

  

Optionally: Add the form feature as a component to a tool palette. 

Creating a Rib Feature 

Rib features are created by SmRibCreate command from a 2D curve on flange face. 

Do one of the following: 

Click the Create Rib Feature tool button ( ) on the Sheet Metal toolbar. 

Click the Create Rib Feature tool button ( ) on the Modify panel of the Sheet Metal tab 
on the ribbon. 

Type smribcreate in the command bar, then press Enter. 

Prompts you: Select flange face: 

Select the flange face. 
Prompts you: Select curve or [Profile radius/Round radius]: 

Select a curve on the selected flange face. 

Lines, polylines, circles, arcs, ellipses, elliptical arcs and splines are accepted. The 2D curves can 
be open or closed but cannot intersect itself or other form features. 

file:///D:/BricsCAD%20Training/02_Defining_your_preferences/02_05_Toolpalettes.htm%23AddComponent
bricscad-cmdref.chm::/SheetMetal/SmRibCreate.htm
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After selection of the curve rib feature is created: 

  

 

Modifying a Rib Feature 

To modify a rib feature: 

Modify the generatrix curve using its grip points. 

Edit the Profile and Round radius in the Mechanical Browser. 

Modify the generatrix curve 

Select the curve. 

Because the curve is hidden by the rib feature, press the TAB key to select obscured entities, or 

select the curve in the Structure panel. 
  

Grip edit the curve.  
The Rib feature updates according to  the changes of the curve. 
  

After selecting of the flange face command prompts: Select curve or [Profile radius/Round radius]:. 

Select curve on selected flange side. 

bricscad-cmdref.chm::/S/StructurePanel.htm
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Edit the properties in the Mechanical Browser 
Select the rib feature in the Mechanical Browser 
The rib feature highlights in the model. 

Select the property in the Rib Properties grid. 
 

 

Type a value. 
The selected rib feature is updated. 
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